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1 Product Overview

1.1 Product Description

Introduction and Product Description

Merrick Advanced Remote Sensing (MARS
®

) Software

The Merrick Advanced Remote Sensing (MARS®) software suite is developed and sold by the

Geomatics division of Merrick & Company, a full-service engineering firm headquartered in Greenwood

Village, Colorado, USA.  MARS® is a production-grade, 64-bit, multi-threaded Windows application

designed to manage, visualize, process, and analyze LiDAR data.  Boasting powerful visualization

capabilities and unparalleled performance, MARS® is ready to support your LiDAR data processing

needs!  Visit our website at https://www.merrick.com/mars.

Designed to support only version 1.4 LAS files with Point Data Record Formats 6, 7, or 8 -

tools are included to up-convert the data from earlier versions, as well as export the v1.4 data

back to earlier versions if necessary.  Classification descriptions conform to the latest ASPRS

LAS Specification 1.4 - R15 (released July 9, 2019)

QC Module  (for Explorer QC and Production licenses only) for testing data compliance

against the USGS Lidar Base Specification 2022 rev. A  (August 2023), as well as all

earlier versions of the specification depending on the LAS version of the data

Support for GeoPackages as an additional reference vector data type

Enhanced Export  user experience with separate and cleaner interfaces for each Export

Type

Improved Voronoi Density Reporting  tool to provide an alternative, unbiased, lidar point

1219

1269

658

1534

https://www.merrick.com/mars
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density testing and reporting method

Raster QC  tool (for Explorer QC and Production licenses only) to report on the format,

structure, and contents of certain types of Cloud Optimized GeoTIFF raster products

Quick Classifications  64-bit tool for faster/easier batch filtering of ground, buildings, &

vegetation based on LAStools algorithms (requires separate license obtained directly from 

rapidlasso GmbH)

One-step 64-bit Ground Filter  using the 'Filter Region' tool (also based on LAStools

algorithms - requires the same license mentioned above for Quick Classifications)

Customizable Quick Access Toolbar  plus an optional Custom Tab  to gather the most-

used tools and functions in one place

Automated and manual data classification tools including batch data convert/export/extract/

filter functions

DEM and topographic data generation functions

3D coordinate transformation tools using Blue Marble Geographic's GeoCalc SDK v8.2

WMS (Web Map Service) image support (requires an Internet connection)

© 2000-2023 Merrick & Company. All Rights Reserved.

1.2 Important Notes & Disclaimers

Important Notes and Disclaimers

Merrick Advanced Remote Sensing (MARS
®

) Software

1. Since every version of MARS® beginning with 2018.0 requires lidar data to be in LAS v1.4, PDRF

6/7/8, all standalone tools and functions (meaning those that can be used without loading the lidar

data) will test for data compliancy before any processing begins.  If non-compliant data is found in the

list of files to be processed, the LAS up-conversion permission window will appear.  This is the same

1548

1198

1034

62 513
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interface that appears when loading data that does not meet the MARS® compliancy minimum

requirements.  For compliancy requirements and details on using this interface, see the Add LAS

Files sub-topic in the Project/Data Preparation Tab  section of this help file.

2. Commercial or production use of the Quick Classifications  and/or Ground Filter  tools requires

components of the LAStools software suite, as well as a separate license from rapidlasso GmbH,

publisher of LAStools.  See those help topics for more details.

3. USB key based (dongle) licensing is no longer available due to incompatibility between a
Windows 10 update released in 2019 and the Sentinel drivers required for the key to be detected.  If

you have a working USB key, you may continue to use it to authorize MARS®.  Otherwise, please

contact MARS® Technical Support  for alternative licensing options.

4. Note that the reserved XML characters <, >, %, &, ', " should not be used in the Description or
Comments boxes of any tools or windows, nor as part of any path or file name.  Unexpected results
may occur.

5. To get the most out of the MARS®software’s multi-threading capabilities, please follow these general
guidelines regarding the location of the data being processed.  Note that testing may be necessary to
achieve the best results for each particular case. 

Network disk server
o High speed Input/Output (I/O) – always use the maximum number of threads available

o Medium to lower speed I/O (or unknown) - single thread (1) is recommended

Internal drive
o SSD (solid state drive)

High end level (NVMe) – always use the maximum number of threads
Consumer level – using multiple threads should perform better than single thread but
experimenting on what maximum thread count to use for each process is encouraged

o HDD (hard disk [spinning] drive)

High RPM speed (e.g., 10,000 or 15,000) – lower multi-thread count is recommended,
testing is encouraged
Lower RPM speed (e.g., 5400 or 7200) – single thread is recommended

External drive
o USB 3.x (or later)

With a spinning drive (typical of many external drives) - single thread is recommended
With an SSD - using multiple threads should perform better than single thread but
experimenting on what maximum thread count to use for each process is encouraged

o USB 2.0 - single thread is strongly recommended

Note - Using temporary local disk space in the scenario where the input or output data is located on

a slower disk I/O location typically speeds up throughput if the local temp space drive is a high-

speed disk such as an SSD.

162

1198 1034

56

http://rapidlasso.com
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6. Availability of any WMS resources included with MARS® or referenced here  is subject to change

without notice.  None of these services is endorsed, provided, or otherwise guaranteed to be

functional by Merrick & Company.  Merrick neither hosts nor maintains any WMS (Web Map Service)

image layer sources and is therefore not responsible for the completeness, accuracy, or frequency of

updates of any WMS sources that may be accessed from within the MARS® program.

7. Some program windows and interfaces may 'hide' behind the main MARS® window, making it appear

as though the interface never opened or that it closed unintentionally.  This is caused by Microsoft's

implementation of Visual C++ (x64), which is used in the development of MARS®.

8. Some of the screen captures in this Help File may still show the 'Add MrSID Compressed LiDAR'

button on the Project/Data Preparation Tab  and the 'MrSID LiDAR' layer in the Table of Contents

.  Beginning with MARS® version 2023.0, all support for this layer has been dropped and a new

reference vector data type - GeoPackages - has been added.  See the Vectors  layer help topic for

more details.

9. Tools on the Quick Access Toolbar  (QAT) do not work in the Cross-Section/Profile window when it

has been floated (undocked).  See the MARS® Layout  topic for information on floating and

docking program windows.

10. Please Note:  Unless otherwise stated, all tools and functions that use pre-populated

measurements of any kind (length, height, area, etc.) are set for projects in U.S. Feet (a.k.a. U.S.

Survey Feet).  Since MARS is unit-less, it is up to the user to make the necessary adjustments and

conversions that are appropriate for the specific project data being used.

11.  MARS® does not display, process, or analyze full waveform data (auxiliary WDP files).

© 2000-2023 Merrick & Company. All Rights Reserved.

1716
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1.3 System Requirements (Operating System and Hardware)

System Requirements (Operating System and Hardware)

for MARS®

Merrick Advanced Remote Sensing (MARS
®

) Software

Minimum System Requirements:

Microsoft Windows 10 (64-bit), Server 2016 (64-bit), or a later 64-bit version of Windows (both

physical and virtual machines are supported).  Please note that Microsoft no longer supports

Windows 7, Server 2012 R2, or any operating systems released prior to these.

Microsoft .NET Framework 4.6.2 (typically present with the above operating systems, otherwise

available free from Microsoft's download site)

1.5 GHz 64-bit (x64) Processor

4 GB RAM 

10 GB available hard disk space 

SXGA (1280 x 1024) or higher-resolution graphics adapter/monitor; 256 MB of graphics memory 

(NOTE: nVidia GPU graphics adapter required for complete visual results with the QC

Module)

Internet connection (to use WMS imagery and Google Earth1 following)

USB 2.0 (or later) port if using a legacy USB hardware key (dongle) for licensing – note that this

licensing method is no longer offered for new licensing

Keyboard and 2-button mouse or compatible pointing device

 

Recommended System Configuration:

Microsoft Windows 10 (64-bit), Server 2019, or a later 64-bit version of Windows
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2.0 GHz or faster 64-bit (x64) multi-core Processor; Intel Core i7 or equivalent Processor preferred

with at least four discrete cores (or two hyper-threaded cores)

12 GB or more RAM

SXGA (1280 x 1024) or higher-resolution graphics adapter/monitor; nVidia graphics adapter with at

least 512 MB of graphics memory (NOTE: nVidia GPU graphics adapter required for complete

visual results with the QC Module)

Internet connection (to use WMS imagery, Google Earth1 following, and interpret some results in the

QC Module)

USB 2.0 (or later) port if using a legacy USB hardware key (dongle) for licensing – note that this

licensing method is no longer offered for new licensing

Keyboard and 2-button mouse with scroll wheel or compatible pointing device 

NOTE - 32-bit operating systems are NOT supported for MARS® v8.0.x, v2017.x, or later versions.

NOTE - Although MARS® may run in a non-Windows-based Virtual environment (such as a Windows

shell within MacOS or Linux), it is not officially supported in those environments.

NOTE - In a network licensing configuration, the computer acting as license server and running

Sentinel RMS License Manager can be either 64- or 32-bit Windows 10 or later (or Server versions

2016 or later) with a 1 GHz or faster processor and at least 2 GB of RAM.  It can be either a physical

or virtual machine.

Other Recommendations:

The graphics driver should always be updated to the latest version from the graphics card

manufacturer's (or computer manufacturer's) website.  Typically the graphics driver shipped with a

computer or graphics card is not current. 

Running Microsoft Windows Update is strongly recommended to install all available Service Packs, .

NET Framework updates, and other patches.
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Installing as much physical RAM as possible is recommended.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.
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1.4 MARS® License Agreement

MARS® License Agreement

Merrick Advanced Remote Sensing (MARS
®

) Software

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY

LICENSE AGREEMENT

Merrick & Company (“Merrick”) is willing to license certain Merrick software and documentation to

Licensee (you, together with any entity you represent, collectively, “Licensee”) only on the condition that

Licensee accepts all of the terms in this License Agreement (“Agreement”).

This  Agreement  is  a legal agreement  between Licensee and Merrick,  for  the  Software  (defined  below).

BY  CLICKING  THE  “I  AGREE”  BUTTON  BELOW,  OR  BY  USING  OR  ALLOWING  USE  OF  THE

SOFTWARE,  LICENSEE  ACKNOWLEDGES  LICENSEE  HAS  READ  THIS  AGREEMENT,

UNDERSTANDS IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS.  IF YOU ARE

ACCEPTING  ON  BEHALF  OF  AN  ENTITY,  YOU  HEREBY  REPRESENT  THAT  YOU  HAVE  THE

AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF SUCH ENTITY.  IF  LICENSEE  DOES

NOT AGREE WITH ANY  OF  THE  TERMS  AND CONDITIONS  OF  THIS  AGREEMENT,  MERRICK  IS

UNWILLING  TO  LICENSE  THE  SOFTWARE  TO  LICENSEE,  AND  LICENSEE  MUST  IMMEDIATELY

CEASE ALL USE OF THE SOFTWARE (IF ONLINE, CLICK THE “I DO  NOT AGREE”  BUTTON)  AND

PROMPTLY DELETE THE ENTIRE PACKAGE  (with  all  accompanying  items)  FROM  ALL  LICENSEE

SYSTEMS AND RETURN THE SOFTWARE TO MERRICK.  This  Agreement  is  effective when Licensee
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clicks the “I AGREE” button or first uses the Software, whichever is first to occur (the “Effective Date”).

1. Software. 

1.1 Software.  “Software” means the application(s) or computer software owned or licensed

by Merrick identified in the Software Quotation Form, in machine-readable, object code form to which

Licensee is granted a license by Merrick pursuant to this Agreement, including the media,

Documentation (Software user guides and manuals provided by Merrick) and Updates (as defined in

Section 2.5) therefor, together with any and all modifications, enhancements, updates, workarounds, and

improvements thereto.  All Software licensed pursuant to this Agreement shall be more specifically

identified in the Software Quotation Form.

1.2 Software License.  Merrick grants to Licensee, during the Term, a non-exclusive,  non-

transferable,  non-sublicensable license to copy and install  the Software on Licensee computers  and  to

use the Software for Licensee’s own internal use, subject to the terms and conditions of this  Agreement.

  Licensee’s right to use the Software under the license granted in this section is expressly limited to the

use of one copy of the Software on one computer at any time so that there are never concurrent  users  of

a single license of the Software at any time.

1.3 License  Restrictions.   Licensee  may  not  modify,  prepare  derivative  works,  transfer,

sublicense, or relicense the Software, or use the Software for third party  transactions,  commercial time-

sharing,  rental or service bureau use.   Licensee agrees not  to cause or permit  the  reverse  engineering

(except  to the extent  allowed  by  local  law),  disassembly  or  decompilation  of  the  Software.   Licensee

may make one copy the Software for archival or backup purposes.  The archival and backup copy of the

Software is subject to the terms of this Software Agreement.

2. Maintenance and Support Services.

2.1 Services.   If  Licensee  purchases  maintenance  and  support  services  for  the  Software

(“Services”),  Merrick  shall take reasonable steps to correct  material  nonconformities  with  the  Software

specifications in the applicable Documentation.   Services shall commence on the  initial  delivery  of  the

Software to Licensee and shall continue for a period of one (1) year.   Thereafter,  unless  terminated  as

provided herein,  Services shall be automatically  renewed for additional one (1) year terms unless  either

party  provides sixty  (60) days (prior to the expiration of the then-current  term)  to  the  other  party  of  its

intention not to renew.  Services will be provided from Merrick’s  offices  through the use of telephones or
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appropriate electronic means.  Licensee and Merrick may agree to provide on-site services at a Licensee

site,  provided  Licensee  pays  all  agreed  to  fees  and  expenses  pursuant  to  a  Professional  Services

Agreement executed by the parties for such on-site service.

2.2 Covered Software.  Merrick will provide Services for the most current release of the

Software and the immediately preceding release.  Once a release has been made generally available,

Licensee should convert to the latest release in order to insure uninterrupted service and continued

support. Merrick may determine that a reported item is not a malfunction of the Software, or Merrick may

release the correction as part of the next scheduled release.

2.3 Hours of Operation.  Services are available between the hours of 8:00 a.m. and 5:00 p.

m.,  U.S.  MST,  weekdays,  excluding  U.S.  holidays  observed  by  Merrick  (the  “Hours  of  Operation”).

 Licensee  may  receive  Services  by  calling  Merrick’s  Customer  Support  number  set  forth  in  the

Documentation.

2.4 Exclusions.  Merrick is not required to perform Services with respect to the following:  (i)

assistance in resolving problems due to Licensee modification of the Software; (ii) problems encountered

as a result  of non-Merrick  product  offerings co-resident  on the system hub machine;  (iii)  assistance  in

resolving  software  problems  other  than  those  associated  with  Software,  including,  but  not  limited  to,

problems  with  the  hardware  and  its  operating  system,  communications  and  system  administration-

related problems; (iv) assistance in migrating to new releases of other software products;  (v) assistance

in resolving problems due to using the Software in an operating environment  not  authorized by  Merrick;

(vi) Licensee failure to  use  the  Software  in  accordance  with  the  applicable  documentation;  and/or  (vii)

Licensee failure to use error corrections previously provided by Merrick.

2.5 Product  Updates.   Services  include  Updates  of  the  Software  and  any  associated

Documentation released during the  term  of  the  Services.  “Updates”  means  an  error  correction,  patch,

bug  fix,  minor  modification  or  new  release  of  the  Software.  Updates  shall  not  include  any  major

modifications,  options  or  future  products  that  Merrick  in  its  sole  discretion  determines  to  license

separately and charge a separate license fee.

2.6 Licensee  Responsibilities.   Licensee shall cooperate  fully  with  Merrick’s  reasonable

requests  for  information,  personnel  and  time  necessary  to  provide  Services,  including  providing

information for Merrick to reproduce the error(s) reported by  Licensee.   Licensee shall assign a point  of

contact (“Technical Contact”).  This Technical Contact  will  coordinate the reporting of issues to Merrick,
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and should be a Technical Analyst,  System Administrator or Project  Manager.   Licensee  may  change

its Technical Contact upon providing written notice to Merrick.

2.7 Maintenance and Support Lapse and Reinstatement.  If Licensee terminates or

interrupts Services, reinstatement of such Services and Updates that were made available by Merrick

during the interruption will be provided to Licensee only upon Licensee payment of a reinstatement fee,

with such fee calculated as the fees that would have been due had Services not been terminated or

interrupted (“Reinstatement Fee”).  If Licensee desires to renew Services after a period of non-coverage,

Licensee shall request such renewal from Merrick in writing and Merrick shall have the right to accept or

deny such request for renewal at its sole discretion.  In the event Merrick accepts such renewal request

and grants renewal of Services, Licensee shall (i) promptly update the Software to the most current

respective Update(s) of the Software, and (ii) pay Merrick the Reinstatement Fee to so update such

Software.  Reinstatement pursuant to this Section only entitles Licensee to Updates that were released

during the interruption of the Services, but in no event entitles Licensee to receive other Services

retroactively.

3. Fees,  Payment,  and  Taxes.   In  consideration  of  the  Software  and  Services  and  any

accompanying  licenses  provided  to  Licensee  by  Merrick  hereunder,  Licensee  shall  pay  Merrick  the

license fees, Services fees, expenses, and taxes set forth in the Software Quotation Form.  All  fees and

expenses  are  quoted  in  U.S.  dollars  and  Licensee  shall  pay  the  fees  and  expenses  in  U.S.  dollars.

 Merrick shall invoice Licensee for all fees due hereunder, and unless otherwise specified in the Software

Quotation Form, all amounts billed will be due and payable within thirty (30) days of date of invoice.   Any

payments not received by Merrick by the due date will be considered past due and interest will accrue at

the  rate  of  one  and  one-half  percent  (1.5%)  per  month  or,  if  less,  the  highest  rate  permitted  under

applicable law.  All fees and expenses specified in this  Agreement  are exclusive of,  and Licensee shall

be solely responsible for,  all  value-added,  sales,  use,  import,  duties,  customs or other taxes applicable

to the  transactions  contemplated  by  this  Agreement,  except  for  any  taxes  based  upon  Merrick’s  net

income.

4. Term.   The term of this  Agreement  shall  commence  on  the  Effective  Date  and  continue  until

terminated by either party in accordance with Section 10 (“Term”).

5. Intellectual Property.  Subject only to the licenses expressly granted in this Agreement and to

any agreement between Merrick and any third parties, as  between Merrick  and Licensee,  Merrick  is  the

sole owner of all  intellectual property  rights  in and to:  (i)  the  Software  (including  any  Updates);  (ii)  the
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user  guides  and  manuals  provided  by  Merrick  for  installation  and/or  use  of  the  Software

(“Documentation”);  and  (iii)  all  trademarks,  copyrights,  trade  secrets,  and  Confidential  Information.

 Merrick  may  utilize  all  ideas,  suggestions,  feedback,  improvements,  data,  reports  or  the  like  that

Licensee provides to Merrick  or otherwise make with respect  to the Software  without  any  obligation  to

Licensee.   Licensee shall not  remove any of Merrick’s  or its  licensor’s  copyright,  trademark  and  other

proprietary notices  contained on or in the Software,  and Licensee will  reproduce all  such notices  on all

copies permitted to be made by You under this Agreement. 

6. Confidential  Information.   “Confidential  Information”  means  (a)  the  Software  and  any

business,  financial,  or  technical  nonpublic  information  of  Merrick,  (b)  any  other  information  of  Merrick

that  is  specifically  designated  by  Merrick  as  confidential  or  proprietary  or  that  would  reasonably  be

understood  to  be  confidential  or  proprietary,  and  (c)  the  terms  and  conditions  of  this  Agreement.

 Licensee  shall  maintain  the  Confidential  Information  in  strict  confidence  during  the  Term  of  the

Agreement and for as long as such information continues to qualify as Confidential Information.  Licensee

shall  exercise  no  less  than  reasonable  care  with  respect  to  the  handling  and  protection  of  such

Confidential Information.   Licensee shall use the Confidential Information only  during the Term and only

as expressly permitted herein, and shall disclose such Confidential Information only  to its  employees as

is reasonably required in connection with the exercise of its  rights  and obligations under this  Agreement

(so long as those employees are subject to binding use and disclosure restrictions at  least  as  protective

as those set forth herein).  

7. Warranties and Disclaimers.  Merrick warrants that, for a period of ninety (90) days from initial

delivery of the Software to Licensee, the Software will, when properly installed and used in accordance

with the Documentation supplied to Licensee, perform substantially in accordance with the

specifications for the Software as described in the applicable Documentation.  As Licensee’s exclusive

remedy and Merrick’s sole obligation for breach of this warranty, Merrick shall use commercially

reasonable efforts to correct any reproducible error in the Software constituting a breach of the warranty

at no additional charge.  Merrick does not warrant that Licensee’s use of the Software will be error-free,

virus-free or uninterrupted.  Merrick also warrants that any media upon which Merrick provides the

Software to Licensee shall be free of defects in materials and workmanship for a period of ninety (90)

days from delivery of such media to Licensee.  As Licensee’s exclusive remedy and Merrick’s sole

obligation for breach of this warranty, Merrick shall provide Licensee with a new copy of such Software in

non-defective media at no additional charge.  Merrick makes no other warranty, express or implied, with

respect to any Services or Software provided by Merrick under this Agreement.  MERRICK HEREBY

DISCLAIMS ALL IMPLIED WARRANTIES, CONDITIONS AND OTHER TERMS, WHETHER
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STATUTORY, ARISING FROM COURSE OF DEALING, OR OTHERWISE, INCLUDING WITHOUT

LIMITATION TERMS AS TO QUALITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR

PURPOSE AND NONINFRINGEMENT.

8. Indemnification. 

8.1 By Merrick.  Merrick does NOT provide any indemnification relating to the Software and

Licensee is using the Software at its own risk.   In the event the Software is held or is believed by

Merrick to infringe, Merrick may, at its sole option and expense, elect to (a) modify the Software so that

it is non-infringing; (b) replace the Software with non-infringing Software which is functionally equivalent;

(c) obtain a license for Licensee to continue to use the Software as provided hereunder; or (d) terminate

the license for the infringing Software.  This Section 8 states Merrick’s entire liability and Licensee’s sole

and exclusive remedy for any infringement of third party proprietary rights of any kind.

8.2 By Licensee.  Except for claims covered by Section 8.1,  Licensee agrees to indemnify

and defend Merrick  from and against  all  third party  claims arising out  of or related to this   Agreement  

 (including Licensee use of the Software) or by  Licensee negligence,  willful misconduct  or breach of the

terms of this Agreement.

8.3 Indemnification  Procedure.   The  indemnifying  party’s  indemnification  obligations

under this Section 8 are conditioned upon the indemnified party  (a) giving prompt notice of the claim to

the indemnifying party; (b) granting sole control of the defense or settlement of the claim or action to the

indemnifying party, provided that the indemnifying party shall not enter into any settlement admitting fault

on behalf  of  the  indemnified  party;  and  (c)  providing  reasonable  cooperation  to  the  indemnifying  party

and,  at  the indemnifying party’s  request  and  expense,  assistance  in  the  defense  or  settlement  of  the

claim.

9. Limitation on Liability.  EXCEPT FOR BREACHES OF OBLIGATIONS IN SECTIONS 5, 6,

AND 8, IN NO EVENT SHALL EITHER PARTY BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE,

OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE WHATSOEVER, SUFFERED BY THE

OTHER PARTY, INCLUDING, WITHOUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTIONS

OR OTHER ECONOMIC LOSS ARISING OUT OF OR RELATED TO THIS AGREEMENT OR ANY USE

OF OR FAILURE TO BE ABLE TO USE THE SOFTWARE OR SERVICES.  MERRICK SHALL NOT BE

LIABLE FOR ANY DAMAGES ARISING OUT OF OR RELATED TO (i) TRANSACTIONS PERFORMED

USING THE SOFTWARE OR SERVICES; OR (ii) MODIFICATIONS TO THE SOFTWARE OR
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SERVICES BY LICENSEE, WHETHER SUFFERED BY LICENSEE OR ANY THIRD PARTY. 

Notwithstanding any provision herein to the contrary, Merrick’s total aggregate liability for any damages

arising out of or related to this Agreement will not exceed the fees paid by Licensee hereunder, for the

Software or Service that is the subject of the action.  The existence of one or more claims will not

enlarge this limit.  Licensee acknowledges that Merrick’s pricing reflects this allocation of risk and the

limitation of liability specified in this section will apply regardless of whether any limited or exclusive

remedy specified in this Agreement fails of its essential purpose.

10. Termination.  This Agreement and the license granted herein may be terminated immediately

upon written notice (a) by either party upon the material breach by the other party of any of its

obligations under this Agreement, which breach has not been cured within thirty (30) days after the

breaching party has received notice thereof, or (b) by Merrick if Licensee has violated Sections 1, 5, or 6

of the Agreement or if Licensee is past due on any payment of the fees under this Agreement for more

than 60 days.  Upon termination Licensee shall promptly return the Software to Merrick.  This

Agreement will terminate automatically if all or a substantial portion of the assets of the Licensee are

transferred to an assignee for the benefit of creditors, to a receiver or to a trustee in bankruptcy, a

proceeding is commenced by or against the Licensee for relief under bankruptcy or similar laws and

such proceeding is not dismissed within sixty (60) days, or the Licensee is adjudged bankrupt.  Upon

termination of this Agreement, any applicable fees owed by Licensee through the date of termination

shall become due and payable, and Licensee shall immediately cease using the Software and Services.

Each party shall promptly return to the other all Confidential Information of the other party that it may

have in its possession or control.  Notwithstanding the termination of this Agreement for any reason, the

rights and duties of the parties under Sections 1.3, 5, 6, 8, 9, 10, and 11 of this Agreement shall survive

such termination and remain in full force and effect. 

11. General Terms. 

11.1 Force Majeure.  If the performance of any obligation under this Agreement, except the

making of payments, is prevented or interfered with by a Force Majeure (any act or condition whatsoever

beyond the reasonable control of and not occasioned by the fault or negligence of the affected party), the

party so affected shall be excused from such performance to the extent of such prevention or

interference.

11.2 Export Control.   The Software and  deliverables  from  the  Services  may  be  subject  to

United  States  export  control  regulations.   Licensee  shall  obtain  at  Licensee  expense  all  necessary
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licenses, permits and regulatory approvals required by any and all governmental authorities and agencies

having jurisdiction over the  export  and  re-export  of  software  and  technical  data  in  accordance  with  all

applicable regulations of the Office of Export  Administration of the  U.S.  Department  of  Commerce  and

the U.S. Treasury Department Office of Foreign Asset Control.

11.3 Dispute Resolution.  Any unresolved disputes between the parties relating to or arising

from this Agreement shall be settled by  arbitration in accordance with the Commercial Arbitration Rules

of  the  American  Arbitration  Association  (the  “AAA  Rules”)  before  a  single  neutral  and  competent

arbitrator selected in accordance with the AAA Rules.  Such arbitration shall be held in Denver,  Colorado

and conducted in the English language.  The cost  and expense of arbitration shall be shared equally  by

the  parties  to  the  arbitration,  regardless  of  which  party  or  parties  prevail.  The  parties  agree  that  any

breach  of  a  party’s  confidentiality  obligations  and  the  license  grant  and  restrictions  set  forth  in  this

Agreement will result in irreparable injury to the other party for which there is no adequate remedy at law.

  Therefore, in the event of any breach or threatened breach of such obligations,  the nonbreaching party

will be entitled to seek equitable relief in addition to its  other available legal remedies  without  submitting

such matter to  arbitration.  Each  party  hereby  irrevocably  submits  to  the  jurisdiction  and  venue  of  the

state and federal courts located in Denver, Colorado for any action seeking injunctive relief hereunder.

 11.4 Miscellaneous.  The parties are independent contractors and nothing in this

Agreement shall be construed to create a partnership, joint venture or employment relationship between

the parties. This Agreement sets forth the entire agreement between the parties and supersedes any

and all prior proposals, agreements or communications, written or oral, of the parties with respect to the

subject matter hereof. This Agreement may not be modified, altered or amended, except by written

instrument duly executed by both parties. No failure or delay by either party in exercising any right

hereunder will operate as a waiver thereof.  If either party wishes to assign or otherwise transfer this

Agreement to anyone, it must obtain the other party’s prior written consent (which consent shall not be

unreasonably withheld), with the exception that Merrick shall be permitted to assign this Agreement

without the consent of Licensee in the event of a sale, merger, or change of control of Merrick, or a

purchase of substantially all the assets of Merrick related to this Agreement.  This Agreement will be

binding on the parties, their successors and permitted assigns.  This Agreement   will be construed

under the laws of the State of Colorado, without regard to its conflicts of law principles.  The parties

hereby disclaim the application of the 1980 U.N. Convention on Contracts for the International Sale of

Goods.  The English language version of this Agreement shall be controlling in the interpretation or

application of the terms of this Agreement. If any provision of this Agreement is, for any reason, held

invalid or illegal in any respect by an arbitrator or a court of competent jurisdiction, such inability or
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illegality shall not affect the validity of this Agreement itself and there shall be substituted for the affected

provision, a valid and enforceable provision which most closely approximates the intent and economic

effect of the invalid provision.  If such provision cannot be amended so as to be valid and enforceable,

then such provision is severable from this Agreement, and the remaining provisions of this Agreement

shall remain valid and enforceable.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5 MARS® Functionality Matrix

MARS® Functionality Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix

Product
Feature

MARS
®

FreeV
iew

MAR
S®

Explo
rer 

Evalu
ation

MAR
S® 

Expl
orer

MAR
S® 

Expl
orer
QC

MAR
S® 

Pro
duct
ion

Software
List Price

(US
Dollars)

Free
Free

for 30
days

$4,99
5*

$9,995
*

$11,9
95*

Project
Manageme

nt

X X1 X X X

26



MARS® v2023.1           User Manual24

© 2000-2023 Merrick & Company

Product
Feature

MARS
®

FreeV
iew

MAR
S®

Explo
rer 

Evalu
ation

MAR
S® 

Expl
orer

MAR
S® 

Expl
orer
QC

MAR
S® 

Pro
duct
ion

Software
List Price

(US
Dollars)

Free
Free

for 30
days

$4,99
5*

$9,995
*

$11,9
95*

Data
Navigation

X X X X X

Data
Visualizatio

n

X X X X X

Data
Generation

X X X X

Data
Export/

Extract

X2 X X X

Data
Classificati

on

X X X X

3D
Coordinate
Conversion

X X X X

Data QC X X X X

Data
Utilities

X X X X X

Tools X X X X

28

29

32

34

37

44

45

47

390



Product Overview 25

© 2000-2023 Merrick & Company

Product
Feature

MARS
®

FreeV
iew

MAR
S®

Explo
rer 

Evalu
ation

MAR
S® 

Expl
orer

MAR
S® 

Expl
orer
QC

MAR
S® 

Pro
duct
ion

Software
List Price

(US
Dollars)

Free
Free

for 30
days

$4,99
5*

$9,995
*

$11,9
95*

QC Module X X

Breaklines
Tab

X

Notes:

* These prices are for the U.S. and Canada only, and are in USD.  Please contact

MARSsales@merrick.com for pricing details in other countries.

1 MARS® Explorer Evaluation enforces a 1 GB total LAS file size limit.

2 MARS® Explorer Evaluation does not support the Extraction functions.

MARS® Explorer QC and MARS® Production support an unlimited number of threads for all Multi-
Threading operations;

MARS® Explorer and MARS® Explorer Evaluation support up to four (4) threads.

Tools and functions that are only available with a Production or Explorer QC license, or are not

available with an Evaluation or Academic license, are noted as such in this Help File.

All prices and specifications subject to change without notice.

© 2000-2023 Merrick & Company. All Rights Reserved.
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1.5.1 Project Management

Product Management Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Project
Managemen
t Functions

Description

File Tab This tab contains the commands that
control opening, saving, and closing

projects.

New
Launches a new project workspace for
the loading of LiDAR, imagery, and GIS

data.

Open Opens an existing MARS® project
document workspace (*.mpd).

Save
Saves the current project workspace

as a MARS® project document file (*.
mpd).

Save As
Saves the current MARS® project

document file (*.mpd) to a new path/file
name.

Exit
Closes current MARS® project

document file (*.mpd) and the MARS®

application.

Table of
Contents
Window

The Table of Contents window allows
the user to manage the raster, vector,

and elevation datasets currently loaded

within MARS®.

On
This button turns on the display of the

selected dataset(s).

Off
This button turns off the display of the

selected dataset(s).

Remove

This button removes the selected
dataset(s) from the Table of Contents

and the MARS® project document
workspace.

Shift
This tool shifts the selected LAS

dataset(s) by user-defined Easting,
Northing, and/or Elevation adjustments

Zoom To
This button zooms to the extent of the

selected dataset.

Breaklines
Window

The Break lines window allows the
various break line features to be

toggled on/off.

Overview
Window

The Overview window allows the user to
quick ly see what part of a project the
extent of the LAS Map View window

covers and do simple panning.

Project/Data
Preparation
Tab

This tab contains the functions that
control adding data, preparing data for

first use, and converting data from
other formats to LAS.

Add LAS Files

LAS files may be added individually, by
folder (and, optionally, sub-folder), or
from selected tiles (see 'Pick  Tiles'

below).

Add Float Grid
Float Grids (consisting of an FLT and

HDR file) can be added.

Add
GeoPackages

Point, line, and polygon GeoPackage
layers (including their attribute data)
can be added.

Add Images
Various raster types can be added

individually, or by folder (and,
optionally, sub-folder).

Add WMS
Images

Web Map Service images (such as
Bing layers) can be added through a

network or Internet connection.

Add Tile
Shapefile

A polygon shapefile can be added as a
tile layout.

Add Reference
Shapefiles

Point, polyline, and polygon shapefiles
can be added as reference features.

Add File GDB
Esri File GDB feature classes can be

added as reference features.

Add Breaklines
from Shapefile

3D breaklines in shapefile format can
be added to refine surface/contour

display and generation.

Add Check
Points Files

A check points file can be added (in
CSV or shapefile format) to allow a

Check Point Report to be run.

Add EO File
An EO (Exterior Orientation) file can be
added to allow hyperlinking to images

co-collected with LiDAR data.

Pick Tiles

Allows the selection of tiles from a
loaded tile layout shapefile for use with

the 'Add LAS Files' drop-down 'From
Selected Tiles.'

Add Spatial
Index

Add spatial indexing information to LAS

data for viewing and use in MARS®.

Convert

The Convert tool is used to translate
elevation data files to the LAS format,

which MARS® natively supports.
Supported elevation data formats are:
ASCII Text Files, Esri ASCII Grids,
Float Grids, GeoTIFF Grids (or TIFF

Grids with world files).
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1.5.2 Data Navigation

Data Navigation Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix

Data
Navigation
Functions

Description

Basic
Navigation

2D Displays data in 2D (orthographic)
mode (default setting).

3D Displays data in 3D (perspective)
mode.

Previous View Returns the LAS Map View window
to the last display view.

Next View Jumps ahead to the next display
view after using 'Previous View.'.

Fit to View Zoom to extent of dataset.

Pan Allows user to pan across the
dataset.

Zoom In
Window

Allows the user to define a
rectangular bounding box to zoom

to.

Zoom Out
Window

Allows the user to define a
rectangular bounding box to zoom

out to.
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Data
Navigation
Functions

Description

Zoom in 25% Allows the user to make a one-
click  zoom in.

Zoom out 25% Allows the user to make a one-
click  zoom out.

Jump to

Jump to X,Y Centers the LAS Map View window
on a user-defined X,Y coordinate.

Jump to Tile Centers the LAS Map View window
on a user-defined tile (plus a small

buffer).

Jump to
Check Point

Centers the LAS Map View window
on a user-defined check point.

Bookmarks

Save Saves a specific data extent to the
project file (*.mpd).

Visit Displays a previously saved
bookmark  (data extent).

Delete Deletes a previously saved
bookmark .

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.3 Data Visualization

Data Visualization Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Data
Visualization

Functions

Description

Data Display

Show Scale Bars Display scale bars on/off.

Show Breakline
Vertices

This tool symbolizes the vertices of all
loaded break lines and labels each with
the ID number stored in the shapefile

attribute table.

LiDAR Display

Color by Elevation Displays LiDAR points rendered by
elevation.

Color by Intensity Displays LiDAR points rendered by
intensity value.

Color by
Classification

Displays LiDAR points rendered by
classification.

Color by Return Displays LiDAR points rendered by
return value.

Color by Collection
Scan

Displays LiDAR points rendered by
collection scan.

Color by Ground
Color

Displays user-defined ground class(es)
by RGB values and all other points by

classification.

Color by RGB Displays LiDAR points rendered by
RGB values.

Color by Imagery
(Fusion)

Drapes imagery over the LiDAR points.

Blend with Intensity

Displays LiDAR points by intensity and
allows the user to blend this with

elevation, classification, collection
scan, return, user data, or Z Delta

data.

Color by Hillshade

This tool will color an elevation float
grid by hillshade on the fly. This tool is

only available when a float grid has

been loaded into MARS® and can be
used in 3D in conjunction with a float

grid (*.flt) file.

Color by Z Delta
This tool will color the points in the

LiDAR data by the vertical difference in
collection scans.

Color by User Data
Displays LiDAR points rendered by

User Data value.

Classifications
Display Settings

Allows the user to view all the LiDAR
data classifications. With this

interface, the user can control settings
for turning on/off a particular class, the
color representing an individual class,

the classification description, and
whether that class can be displayed as

a TIN or as points.

Return Selection
Allows the user to define which returns

are displayed in the LAS Map View
window.

Edit Collection
Scan Display

Allows the user to modify the color
assignment of the LiDAR points for

each unique collection scan value, and
the visibility of individual collection

scans.

Bit Flag Display
Settings

Allows the user to control display of
points based on various bit flag

settings - Synthetic, Model Key-point,
Withheld, Overlap, and Edge of

Collection Scan.

Points Displays LiDAR data as points. Also
known as a 'point cloud' display.

TIN Display LiDAR data as a TINned
surface model.

Lock to view 100%

This tool forces all points in the loaded
LAS files to be displayed and is

intended for hand editing purposes,
when using the Flood Fill utility, and

when displaying virtual contours.

Collection Scan
Direction

This tool allows the user to view the
direction in which each collection scan

was acquired.

Elevation
Coloration

Rescale

This setting renders the LiDAR points
by rescaling the elevation values within
the extents of the current display
window. (Default elevation setting)

Throughout
This setting hold the elevation coloring
constant throughout the entire LiDAR

dataset.

Repeat
This setting renders the LiDAR points

based on a repeating color cycle.

Intensity Coloration

Gray-scale Only
This setting renders the LiDAR points
in gray-scale based on their intensity

values. (Default intensity setting)

Color Extremes

This setting renders the LiDAR points
by the extreme intensity values.
Intensity values equal to 0 are

rendered  in blue; intensity values
equal to 255 are rendered in yellow.

Equalize

This setting renders the LiDAR points
based on an equalized intensity range

within the current display window
extents.

Slider Bar Tools

LiDAR/Image
Transparency

Allows the user to adjust the
transparency of the LiDAR points with 

respect to the imagery.

Point Density
This slider bar changes the point

density in the LAS Map View window.

Vertical Scale

This slider bar allows the user to
increase the vertical scale of the
LiDAR points. (Only when using

Perspective View)

Cross-Section/
Profile Display

Place Cross-
Section Line

Draws cross-sections and profiles with
fixed depth.

Place Adjustable
Cross-Section Line

Draws cross-sections and profiles with
an adjustable depth.

Rotate Profile

Activates the 'Rotate Profile' window
and allows the user to rotate the cross-

section/profiling area a specified
number of degrees.

Keep Profile
Centered

In Cross-Section/Profile window, the
'Keep Centered' tool keeps data
centered vertically in the window.

Keep Cut Area in
Map View Centered

This tool keeps the cut area box
centered vertically and horizontally in

the LAS Map View window.

Current Depth
Allows the user to define the cut depth
of the Cross-Section/Profile window.

Show Point Size
Resizes the point display within the

Cross-Section/Profile window. 

Profile Combined Displays a combined single-line profile
of all points.

Profile by
Collection Scan

Displays a profile line for each
collection scan..

Cross-Section
Display a cross-section view of the
LiDAR points in the Cross-Section/

Profile window.

Vertical Scale

Allows the user to adjust the vertical
scale by moving the slider bar back

and forth or by typing the desired scale
into the scale text box.

3D Visualization

Place Target Allows the user to define a target for
line-of-sight display.

Place Eye Allows the user to define a point-of-
origin for line-of-sight display.

Viewshed | Define
Area

This tool allows the user to generate a
viewshed for visualization purposes.

Viewshed | Display
Options

Allows the user to render viewsheds as
a TIN, turn visible and/or invisible

viewsheds on or off, or remove them
entirely.

Flood Fill This tool creates a flood fill to a
specified elevation.
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1.5.4 Data Generation

Data Generation Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix

Data
Generation
Functions

Description

Topographic
Production Tools

Options Allows the user to define the virtual
contour parameters from the 'Contour

Options' dialog.

Area to Display Allows the user to define an area for
virtual contour generation.

Clear Display Allows the user to delete all (virtual)
contours.

Toggle On/Off Toggles virtual contours on/off for the
LAS Map View window extent.

DEM (Grid)
Production Tools

Options Allows the user to define the gridding
parameters.

Build Elevation Allows the user to create a virtual
elevation grid.

Build Intensity Allows the user to create a virtual
intensity grid.
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Data
Generation
Functions

Description

Smooth Data Applies a smoothing algorithm to the
gridded surface.

Build Normals Allows the user to generate 'Normal'
vectors for each cell.

Clear Display Clears any grid from the data view.

Profile Line Tools

Save Profile Line
to 3D Shapefile

Allows the user to generate a 3D
shapefile from a Combined Profile line

in the cross-section/profile window. 

Advanced
Centerline/Profiler
Tools

Draw 2D
Centerline

Allows the user to draw a 2D centerline
with the loaded LiDAR data as a

reference.

Delete 2D Feature
Allows the user to delete one or more
drawn line or polygon features before

saving to a shapefile. 

Save 2D Shapefile
Allows the user to save the centerlines,
polygons, and/or points created in the

project to a 2D shapefile(s).

Advanced Profiler
This tool will create several profile lines

along a centerline at an 
interval specified by the user.

Polygon Creation
Tools

Draw 2D Polygon
Allows the user to draw a 2D polygon

with the loaded LiDAR data as a
reference.

Point Creation
Tools
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Data
Generation
Functions

Description

Draw 2D Point Allows the user to draw 2D points with
the loaded LiDAR data as a reference.

Tile Scheme Tools

Create Tile
Scheme

Allows the user to create a tile scheme

for use within a MARS® project
document.

Populate Statistics
on Tile Scheme

Generates statistics about LiDAR data
based on the loaded tile scheme.

Viewshed

Define Area/
Display Options

These tools allows the user to generate
LAS viewshed grid files from the user-
defined viewshed parameters. Output
viewshed grid files are rendered green
for visible areas and red for invisible

areas of the calculated viewshed.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.5 Data Export/Extract

Data Export/Extract Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Data Export/
Extract 

Functions

Description

Data Export

The MARS® export module allows the
user to export data as a single file,

based on an irregular shapefile, MBR,
tile scheme shapefile, or as individual

collection scans (LAS).

3D Image

Contours - Shapefile

Flightline Separation - JPEG 2000

Flightline Separation - Tiled GeoTIFF

Grid - Cloud Optimized GeoTIFF DEM

Grid - Cloud Optimized GeoTIFF
Intensity

Grid - ENVI (Elevation)

Grid - ENVI (Elevation + Classification)

Esri ASCII Grid

Grid - Float Grid

Grid - IMG

Grid - LAS

Grid - LiDAR Raster JPEG 2000

Grid - TIFF

Hillshade - JPEG 2000

LAS

LiDAR Point Density - Float Grid

LiDAR Spatial Distribution Verification
Grid - JPEG 2000
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Data Export/
Extract 

Functions

Description

PLS-CADD Code - ASCII

PLS-CADD Code - LAS

Shapefile

Text Files (ASCII)

Data
Extraction

Area by Slope

This Extraction tool is designed to
analyze the slope of the ground in any

particular area. This tool may be used to
determine areas meeting specific slope

criteria and output polygons to a 3D
shapefile. Uses include well pad sites,

landing zones, and other land base
applications that need to determine most
logical site given user specified criteria.

Building Polygons

This Extraction tool is designed to place
polygons around a specified class. The

difference between this tool and the
class polygons tool (below) is that the
building tool takes into account the

class and the elevation of the points,
whereas the class polygon tool is only

concerned with the class of the points in
the extraction. This tool may be used to
determine areas meeting specific criteria

and output user-defined polygons to a
3D shapefile.

Canopy Density

This Extraction tool is designed to
analyze canopy points above the ground
and provide a display of the density of a
vertical column. The tool does this by

counting the number of returns within a
user-defined voxel. The results can be

used to characterize canopy density and
other meaningful quantitative vegetation

metrics.
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Data Export/
Extract 

Functions

Description

Class Polygons

This Extraction tool is designed to place
polygons around any specific class in

any particular area. The difference
between the building polygons tool

(above) and this tool is that the building
tool takes into account the class and

the elevation of the points, whereas the
class polygon tool is only concerned with
the class of the points in the extraction.

This tool may be used to determine
areas meeting specific class criteria and
output polygons to a 3D shapefile. Uses

include placing polygons around tree
canopies, determining low-confidence
areas, and even using return value to

eliminate edge matching requirements in
ortho procedures.

Extraction Options
This tool allows the user to set various

parameters for the 
four (4) Data Extraction tools.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.6 Data Classification

Data Classification Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Data
Classification

Functions

Description

Manual Editing

Edit Digitized
Polygon (2D)

This tool is used to reclassify LiDAR
points within a user-defined polygonal

area.

Edit Selected
Polygons (2D)

This tool is used to reclassify LiDAR
points within one or more pre-selected

polygons (see 'Select Polygons').

Fast Massive
Reclass

This tool allows user-digitized polygons
to be saved on-the-fly, and improves
reclassification performance for large
areas for both digitized and selected

polygons.

Select Polygons
This tool allows the selection of one or

more loaded polygons for the 'Edit
Selected Polygons' tool to process.

Edit Paint Brush
(Small, Medium,

Large)

This tool is used to select the LiDAR
points to reclassify with three (3)

different sizes of the edit paint brush.

Edit Line String
(Above, Below)

This tool is used to reclassify LiDAR
points with two (2) different line string

editors (only functions in Cross-
Section/Profile window).

Edit Scrape
(Above, Below)

This tool is used to reclassify LiDAR
points with two(2) different line scrape

editors (only functions in Cross-
Section/Profile window).

Filter Region This tool allows the user to define a
rectangular region for filtering.

Filtering Options This tool allows the user to set various
parameters for each of the filters.

Filter Digitized
Polygon

This tool allows the user to define a
polygonal area for filtering.

Filter Selected This tool is used to filter LiDAR points
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Data
Classification

Functions

Description

Polygons within a pre-existing polygonal shapefile
(*.shp).

Undo Steps back in manual reclassification
process.

Redo Steps forward in manual reclassification
process.

Save cached points
to disk

Commits any edits made in RAM to
disk . (currently disabled, see Options

Tab )

Batch Processing

This function allows the user to batch
process a LiDAR dataset using a

macro script or discrete filter/extraction
tool.

Quick
Classifications

This tool allows the user to batch
process ground (and, optionally,

vegetation and buildings) within the
currently selected tiles. Use of this filter
requires a separate license that can be

purchased directly from rapidlasso
GmbH (https://rapidlasso.com/pricing).

Batch Process
Tiles

This tool allows the user to filter/extract
the LiDAR points within the currently

selected tiles.

Script Testing
(Debugging)

These tools allow the user to step
through batch scripts to support

iterative script testing and
modifications.

Batch Script Test
This tool allows the user to define a

rectangular region for script testing with
the loaded macro script.

Script Step
This tool allows the user to step

through each filter of a loaded macro
script.

Script Undo This tool rolls back the actions of the
last step within the macro script.

518



MARS® v2023.1           User Manual40

© 2000-2023 Merrick & Company

Data
Classification

Functions

Description

Script Go This tool allows the user to proceed
through the entire macro script.

Script Stop This tool will stop the current script
testing process while in step mode.

Script Restart This tool will restart the current script
testing process.

Script Edit
This tool will launch the edit dialog

window for modifications to the current
macro script.

Filter Algorithms

Building

The Building filter identifies buildings
by look ing at voids in the ground data

and analyzing the characteristics
(planes, height, area, etc.) of the non-

ground points in these areas.

Change Bit Flags

The Change Bit Flags filter allows
several of the bit flags for LAS v1.4

data to be modified (from set to cleared
or cleared to set), with an option to

reclassify the modified points.

Consistent Return

The Consistent Return filter reclassifies
LiDAR points based on their return

value. A point is reclassified if its return
value and the return values of all nearby

source points match the given return
value requirement. 

Ditch and Berm

The Ditch and Berm filter classifies
point to ground that may have been

incorrectly classified during automated
bare earth extraction routines.

Elevation
The Elevation filter reclassifies LiDAR

points based on their absolute
elevation (Z) value.

ENVI Reclass
The ENVI Reclass filter reclassifies

LiDAR points based on an ENVI
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Data
Classification

Functions

Description

classification dataset.

Extreme High
The Extreme High filter is intended to
reclassify LiDAR points that have a
uniquely different and high elevation.

Extreme Low
The Extreme Low filter is intended to
reclassify LiDAR points that have a
uniquely different and low elevation.

Ground

The Ground filter is a one-step tool that
uses the LAStools algorithms to
classify ground.  Use of this filter

requires a separate license that can be
purchased directly from rapidlasso

GmbH (https://rapidlasso.com/pricing).

Ground Distance

The Ground Distance filter reclassifies
LiDAR points when they are within a

specified ground distance of a point in
the reference classification set.

Height from
Surface

The Height From Surface filter
reclassifies LiDAR points that are a
specified elevation above or below a

surface.

Intensity
This filter reclassifies LiDAR points
based on the value of the intensity

attribute.

Isolated Point

The Isolated Point filter reclasses
points when there is no other point of a
reference class within a user-defined
spherical radius (X, Y, and Z axes)

Max Grid

The Max Grid filter finds the highest
point of each grid cell that matches the

source classification set. The filter
reclassifies the maximum elevation
point (one per grid cell) to the target

classification.

Median Grid
The Median Grid filter finds the median

elevation point of each grid cell that
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Data
Classification

Functions

Description

matches the source classification set.
The filter reclassifies the median

elevation point (one per grid cell) to the
target classification.

Min Grid

The Min Grid filter finds the lowest point
of each grid cell that matches the
source classification set. The filter
reclassifies the minimum elevation
point (one per grid cell) to the target

classification.

Model Key-point

The Model Key-point filter creates a
thinned dataset from ground (surface)

points by searching for the highest and
lowest points within a specified

elevation tolerance in a user-defined
area.

Percolate

The Percolate filter reclassifies LiDAR
points in the source classification set

that are relatively low without exceeding
limits on the steepness of a surface
made from the target classification.

Plane Analysis
The Plane Analysis filter reclassifies
groupings of LiDAR points that form

flat, planar surfaces.

Reclassify

The Reclassify filter reclassifies all
LiDAR points from the source

classification to the target
classification.

Return
The Return filter reclassifies LiDAR

points based upon the specified return
value requirement.

RGBNI Value

The RGBNI Value filter reclassifies
LiDAR points based on their color

values (and, optionally, Intensity values)
or the color values of a co-located

imagery file.

Scan Angle The Scan Angle Filter is made



Product Overview 43

© 2000-2023 Merrick & Company

Data
Classification

Functions

Description

specifically for use with the 'Convert
SBET to 3D Shapefile' tool. The

Scan Angle filter uses an SBET file
which has been converted into a 3D
shapefile to reclassify certain sets of

points.

Slope

The Slope filter reclassifies source
LiDAR points to a specified target

class based on them falling within a
user-definable range of minimum and
maximum angles for the slope they

occupy.

Smart Clip
The Smart Clip Filter will reclass

points at varying angles of the Field
of View while ensuring full coverage. 

Smooth Grid

The Smooth Grid Filter builds a grid
surface from the points of the source

classification. LiDAR points in the
source classification set are compared
to this grid surface and reclassified to
the target classification, if they meet
the elevation difference requirements

as specified by the min_diff and
max_diff parameters.

Smooth Max Grid

The Smooth Max Grid filter builds a grid
surface from the maximum elevation

points of the source classification set.
LiDAR points in the source

classification set are compared to this
grid surface and reclassified to the

target classification if they meet the
elevation difference requirements as

specified by the min_diff and max_diff
parameters.

Smooth Min Grid

The Smooth Min Grid filter builds a grid
surface from the minimum elevation

points of the source classification set.
LiDAR points in the source

classification set are compared to this
grid surface and reclassified to the

target classification if they meet the
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Data
Classification

Functions

Description

elevation difference requirements as
specified by the min_diff and max_diff

parameters.

Timestamp
The Timestamp filter reclassifies

LiDAR points based upon the
timestamp attribute value.

XY Distance

The XY Distance filter reclassifies
LiDAR points that are within a specific

horizontal distance of a point in the
reference classification set.

XYZ Distance

The XY Distance filter reclassifies
LiDAR points that are within a specific

spherical distance of a point in the
reference classification set.

Editing by Location

LiDAR Spatial
Reclass

The LiDAR Spatial Reclass tool
provides two (2) basic functions:     1.)

To reclass the interior of break line
polygons contained in a shapefile and

2.) To reclass a buffer around break line
polylines contained in a shapefile.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.7 3D Coordinate Conversion

3D Coordinate Conversion Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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3D Coordinate
Transformatio

n Functions

Description

GeoCalc

This tool allows the user to
transform LAS data to different

horizontal coordinate systems and/
or horizontal and vertical datums.

GeoEdit

This tool allows the user to define
custom coordinate systems,

horizontal datums, and vertical
datums.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.8 Data QC

Data QC Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Data QC
Functions

Description

Check Point
Report

This tool compares the accuracy of the
remotely collected data with the known
points on the ground, which can help

uncover data integrity issues within the
dataset.

Raster QC
Tool

This tool provides an automated
method for verifying the format,

structure, and contents of certain types
of raster products.

View Error
Thematically

Displays the Z error thematically from
the Check Point Report. Red

represents negative error and green
represents positive error.

Cross-Section/
Profile

Analysis

The cross-section/profile tool can be
used to evaluate LiDAR data for

calibration (collection scan, mission
alignment).

Contour by
Collection

Scan Analysis

This tool generates contour lines for
each overlapping collection scan, which
can help determine the overall accuracy

of the collection scans in relation to
each other.

Color by Z
Delta (∆)

This tool will color the LiDAR points by
the elevation difference in overlapping

collection scans.

Color by
Collection

Scan
Separation

This tool is useful for rapidly assessing
the consistency of the LiDAR dataset's

elevation and is highly useful in
boresighting.

Swipe Raster
Over LiDAR

Tool

This tool allows the user to move
imagery over LiDAR data for rapid

viewing of alignment between LiDAR
and imagery.

Coverage
Tracking Tools

These tools create a polygon
shapefile noting where the user has

been in the project.
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**NOTE: Tools shown in Blue are available only with a Production license.
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1.5.9 Data Utilities

Data Utilities Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix

Data Utilities
Functions

Description

Measure Allows the user to measure
between two points.

Inspect
Displays the LiDAR point, check

point, virtual contour, or
shapefile feature attributes.

Inspect RGB(N)
Displays the red, green, blue,
and near infrared (if present)

values from a pixel of imagery.

Pick Tiles

This tool is used to select a
single tile or multiple tiles 

for LAS file loading, data export,
or batch script processing.

Hyperlink

This tool allows the user to click
on a point from a previously-

loaded EO (Exterior Orientation)
text file and view the

corresponding still imagery.

Play Video

This tool allows playback of
video data collected during data

acquisition by click ing on a
location in a pre-loaded point

shapefile.
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Data Utilities
Functions

Description

Statistics by Area

This tool allows for a quick  LAS

statistics display for user-

defined areas.

Volumetrics

This tool allows for cut/fill
analysis comparing two

surfaces, a surface to a known
base elevation, or a surface to a

draped/3D polygon.

Miscellaneous
Options

Viewing
Allows the user to invert the
directional function of the

mouse's scroll wheel.

Measure Tool
Snapping

Allows the user to snap to the
nearest LiDAR point at both the

'from' and 'to' ends of the
Measure tool vector.

Point Size

Allows the user to choose the
pixel size of LiDAR points

displayed within the LAS Map
View window.

Default Cut Area
Depth

The default cut area depth is set
to 10 units and is only used with

the 'Place Profile Line' tool.

Cut Area Movement
Percentage

The forward/back percentage is
set to 75% by default.

Cross-Section/
Profile Window

Orientation

This option allows the user to tile
the cross-section/profile window 
either horizontally or vertically.

Cursor Location
Symbol in Main

View

This option displays a white 'X'
symbol in the cut area box in the

LAS Map View window
corresponding to the cursor

location in the Cross-Section/
Profile window.
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Data Utilities
Functions

Description

Editing Options

Allows the user to use 2 or 3
digit classifications when using
the keyboard accelerators in

editing mode.

Panning Options

Allows the user to set the
amount of the LAS map view

window that is moved during any
of the shortcut key pan

operations.

Check Point Report
Options

Number of
Significant Figures

Allows the user to set the
number of significant digits to
be used in the Check Point

Report.

Toolbar and Tab
Options

Change Button
Ordering in QAT

Allows the user to re-order
buttons on the Quick  Access

Toolbar.

Customization of
Custom Tab

Allows the user to create a
'Custom' tab on the ribbon with
buttons and controls from the

standard tabs.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.10 Tools

Tools Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software
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Tools Description

Tools Tab
The Tools Tab contains several data

utilities that support 
operational end-user requirements.

Snapshot

This utility creates a georeferenced
TIFF image file (with TFW- TIFF world
file) of the display in the LAS Map View

window, which is saved to a user-
defined directory.

MARS® Task
Manager

This tool allows the user to monitor

and/or end multiple MARS® processes
at once.

Class to Bit
Flag

This tool sets the v1.4-required bit
flags for identified class(es) of withheld

or model key-points.

Set Overlap Bit
Flag

This tool calculates overlap areas in a
folder of files and sets the bit flag to

'True' for the appropriate points.

Clear Bit Flags
This tool allows bit flags to be cleared

(set to 'False') for Synthetic, Model
Key-point, Overlap, and Withheld.

Change Bit
Flags

This tool modifies the status of several
of the bit flags that can be used with

LAS v1.4 data:  Synthetic, Model Key-
point, Withheld, and Overlap.  It can
optionally reclass those points whose

bit flag values have been modified, and
can be limited to a single collection

scan.

Withheld Point
Removal

This tool deletes specific Withheld-
flagged points from LAS swaths using
the following work flow:  Export tiles to
Collection Scans, process these to

remove and renumber specific returns/
classes, export back to tiles.

Reference
Reclass

This tool allows the user to reclassify
one set of LAS files based on the

classes  found in another set of LAS
files by using a series of user defined

parameters. This tool determines which
points will be reclassed based off of

the LAS point's recorded time.

Reference
Reclass
(Closest
Distance)

This tool allows the user to reclassify
one set of LAS files based on the

classes found in another set of LAS
files by using a series of user defined

parameters. This tool determines which
points will be reclassed based off of
the LAS point's recorded time and

position.

Reclass to
Withheld

This tool will reclass specified source
class(es) to 'withheld' class(es). Source

classes are 0-127; Withheld classes
are 128-255 (i.e., source class 5 would

be reclassed to class 133).

Change LAS
Date

This tool allows the user to alter the
Julian Day and Year as stored in an

LAS file's header and displayed in the
file's properties.

GPS Time
Conversion

This tool converts the stored time
format in LAS files from GPS Week

Time (if the GPS week number is
known) to GPS Adjusted Time and vice

versa.

LAS Splitting
This tool splits LAS files greater than 2
GB into multiple files, each less than 2

GB.

Remove
Duplicates in

LAS

This tool removes duplicate points in
an LAS file(s) by comparing X, Y, and

(optionally) Z values.

Return Info
This tool allows LAS files to be tested
for valid point family (discrete return)

information.

LAS Merging
This tool merges multi-channel LAS

v1.4 files from a single swath into one
LAS file.

LAS Separate
This tool separates merged multi-
channel LAS v1.4 files into their
individual scanner channel files.

Add System ID
This tool allows the 'System Identifier'

field in the header block  of LAS files to
be populated/edited.

Collection Scan
Renumbering

This tool allows the collection scan
number stored with each LiDAR point
in a single collection scan file (swath)

to be changed.

Single
Collection Scan

to Multiple

This tool will split a single collection
scan into multiple, smaller scans in

areas indicated by the collection scan
heading or angle, which is user defined.

LAS Up-
Conversion

This tool allows for up-conversion of
LAS files to a MARS-compliant format,
with options to convert classes to bit
flags and add or edit CRS WKT tags.

LAS Version
Converter

This tool allows for export of LAS files
back to older versions/formats when
needed, with options to convert bit

flags to classes and change GPS time
storage.

Float Grid to
Hillshade

This tool creates a hillshade image or
raster from a gridded, elevation float

grid (*.flt).

Float Grid to
TIFF

This tool converts float grids to
GeoTIFF format with an option to

include projection information.

Float Grid to
IMG

This tool converts a Float Grid (*.flt) to
an ERDAS Imagine compatible IMG

file with a user-specified NoData value.

GeoTIFFs to
JPEG 2000

This tool combines a folder of

GeoTIFF rasters into a single JPEG

2000 raster.

Swath shapes
to overlap JP2

This tool combines a folder of swath

footprint shapefiles into a JPEG 2000

raster to allow faster and more

complete coverage check ing.

TIFF Tag
Editing

This tool creates a CRS (coordinate

reference system) tag for TIFF files, or

replaces an incorrect or incomplete

tag.

TIFF Origin
Rounding

This tool rounds off raster extent

values to three decimal places,

allowing for better edge-matching with

adjacent rasters.

Tiff Nullifier

This tool finds clusters of connected
pixels with cell values of 1,1,1in one or
more 3-Band (RGB) TIFF images, and

re-writes those values to 0,0,0.

Float Grid
Merge

This tool allows the user to merge
multiple float grids into a 
single float grid file (*.flt).

Float Grid
Clipping

This tool allows a Float Grid to be
clipped to the extents of a polygon

shapefile clipping boundary.

Float Grid Tile
Cutting

This tool will create individual tile-
based Float Grids using a tile layout

shapefile.

Float Grid
Merge to Base

This tool allows a Float Grid 'patch' to
be merged into another grid to fill a

void area.

Merge
Shapefiles

This tool creates a new shapefile from
two or more input shapefiles of the

same geometry type.

Edge Match for
Shapefiles

This tool allows the user to match the
ends of contour lines in two (2)

adjacent shapefiles.

Contour Join
This tool allows the user to join several

different contour features into one
continuous contour.

Depression
Coder

This tool allows the user to find
depression contours with LAS data and
contour shapefiles and label them as

such in the contour shapefile's attribute
table.

Complex
Polygons to

Simple

This tool allows the user to create
separate files (simple polygons) from a

multiple file (complex polygon)
shapefile.

Assign Highest
Z to Polygon

This tool assigns X, Y, and Z values to
all polygons in a polygon shapefile

based on the values of the underlying
LiDAR point within each polygon that
has the highest Z-value (elevation).

Z Fix Using
Stream Rule

This tool checks for and fixes (if
necessary) hydrographic monotonicity

errors in 3D break line shapefiles.

Coordinate
Conversion
Tab

XYZ Shift
This tool shifts the selected LAS

dataset(s) by user-defined Easting,
Northing, and/or Elevation adjustments.

Report LAS
Shift

This tool creates a comma-delimited (*.
csv) report that stores the total

(cumulative)  X, Y, and Z shift for each
of the files chosen to be included in

the report.

Z Shift for LAS
files

This tool allows the user to batch shift
the Z-value, or level the elevation, of all
LAS files in a project by use of a *.csv

file.

Z Shift on
Intensity

This tool allows the user to shift LAS
data that matches a specific 
user-defined intensity value.

Z Shift on
Class

This tool is capable of shifting the Z-
value of LAS data by class.

Convert to
Modified EO

Files

This tool allows a 'Combined Factor' or
its reciprocal to be applied to one or
more EO (exterior orientation) files.

Add CRS Info
This tool allows the user to add or
update CRS (coordinate reference
system) information in an LAS file.

Add Geo Tags

This tool is a GeoTiff header tool
meant for use with georeferenced tiff
files and is capable of entering the

information contained in a tiff world file
(*.tfw) into the header information

contained by the accompanying tiff (*.
tif) file. The user may produce a *.tif
which can then function without the

accompanying *.tfw.

Verify/Remove
LAS Projection

Info

This tool allows the user to verify the
projection of a specific LAS file.

Vector Creation
Tab

Convert Check
Points CSV to
3D Shapefile

This tool creates a 3D shapefile from a
CSV file of Check Points.  The result
can be used to run the Check Point

Report or the QC Module USGS NGP -
Version 2.1 (or Version 1.3).

Collection Scan
Polygon

Generator

This tool allows the user to generate a
collection scan polygon shapefile from

LiDAR data.

Convert SBET
to Shapefile

This tool creates a 3D shapefile from
an SBET (Smoothed Best Estimated T

rajectory)  file, giving the user the
ability to visualize the SBET overlaid

on LiDAR data.

Convert Video
XML file to 3D

Shapefile

This tool converts the XML file of
coordinates created at the time of

video capture to a point shapefile that
can be loaded to allow synchronized

video playback.
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**NOTE: Tools shown in Blue are available only with a Production-level license.
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1.5.11 QC Module

QC Module Test Matrix

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix

**NOTE: This module requires an Explorer QC or Production license.

QC Module functions Purpose / Description

USGS NGP LBS - 2022 rev.
A

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification 2022 rev. A from

the USGS.

USGS NGP LBS - 2021 rev.
A

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification 2021 rev. A from

the USGS.

USGS NGP LBS - 2020 rev.
A

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification 2020 rev. A from

the USGS.

USGS NGP - Version 2.1

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification Version 2.1 from

the USGS.
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QC Module functions Purpose / Description

USGS NGP - Version 1.3

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification Version 1.3 from

the USGS.

USGS NGP - Version 1.2

This tool provides an automated
method for verifying compliance
of LAS v1.4 LiDAR point cloud

datasets to the Lidar Base
Specification Version 1.2 from

the USGS.

USGS NGP - Version 1.0

This tool provides an automated
method for verifying compliance
of LAS v1.0 - LAS v1.3 LiDAR

point cloud datasets to the Lidar
Base Specification Version 1.0

 from the USGS.

LiDAR Workflow QC - 1
LiDAR Data Checks

This tool provides an automated
method for verifying the
expected data attributes,

coverage, point density, and
relative accuracy of a LiDAR

point cloud dataset.

LiDAR Workflow QC - 2
LiDAR Calibration Checks

This tool provides an automated
method for verifying correct

LiDAR collection system
function by testing the relative

accuracy and channel
alignment (when applicable) of a

LiDAR point cloud dataset.

Voronoi Density Reporting
This tool tests and reports on
lidar point density using the
Voronoi polygon method.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.5.12 Breaklines Tab

Breaklines Tab Matrix
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Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® v2023.1 Functionality Matrix
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Breaklines
Functions

Description

Breaklines Tab

Breakline
Properties

Click ing on this button will allow the
user access to the 'Break line
Properties' window. With this

interface, the user can change the
color and description which represent

any break line, determine which
features will be displayed, insert new
features, rename features, and even
load an existing XML template with
saved features and assigned colors

and codes. The user may also search
for points to use in elevation

calculations, delete certain break line
classifications, and change the

distance between points in a segment
of a break line.

Place Breakline This tool allows the user to place a

new break line into a MARS® project.

Delete Breakline
as Selected

This tool allows the user to delete an
entire selected break line.

Partial Delete

This tool allows the user to partially
delete a selected area of a 

break line instead of deleting the
entire break line.

Delete by Fence

This tool allows the user to delete
break lines by using a fence. This tool

offers several different types of
fencing and the ability to delete inside

or outside the user defined fence.

Reverse
Breakline
Direction

This tool allows break line direction to
be identified and (optionally) reversed.

Check
Connection to

Neighbors

This tool will give the user more
information concerning how a

particular break line is connected to
neighboring break lines. This tool is

capable of check ing for the same Z-
value in two break lines or check ing to
make sure that two break lines were
compiled in the same direction. It is

also capable of joining two connecting
break lines to create one continuous

break line.

Add Vertex
This tool allows the user to add a
vertex to an existing break line.

Move Vertex
This tool allows the user to move a

vertex in an existing break line.

Delete Vertex
This tool allows the user to delete a

single vertex in an existing break line.

Change
Elevation for All

Points of
Breakline

This tool is capable of changing the
elevation of an entire break line.

Change
Elevation of Any

Vertex

The change elevation tool is capable
of changing the elevation of any

combination of vertices in a
break line.

Change
Elevation (Large

Increment)

The 'Change Elevation' tool is meant
to work  in unison with the above

mentioned elevation tool and make
the compilation of break lines easier

and quicker. This tool allows the user
to “step” the elevation of break line

down in large increments. By default,
the ‘Change Elevation (Large
Increment)’ button lowers the

elevation of an added break line by -
0.8 units.

Change
Elevation (Small

Increment)

The 'Change Elevation' tool is meant
to work  in unison with the above

mentioned elevation tool and make
the compilation of break lines easier

and quicker. This tool allows the user
to “step” the elevation of break line

down in small increments. By default,
the ‘Change Elevation (Small
Increment)’ button lowers the

elevation of an added break line by -
0.2 units.

Reassess
Points for

Ignored Ground
Classification

This tool will reclassify points
surrounding a break line (inside a

user-specified buffer zone) to a user-
definable ignored ground

classification.

Drape Polylines

This tool allows the user to select a *.
dgn file or a *.shp file containing
polyline break lines and drape the

break lines in the file to the LAS data
surrounding it. This tool will add a Z-
value (elevation) to the break lines in
the specified file by searching the
points surrounding the line for an

appropriate Z-value.

Drape Polygons

This tool allows the user to select a *.
dgn file or a *.shp file containing
polygon break lines and drape the

break lines in the file to the LAS data
surrounding it. This tool will add a Z-
value (elevation) to the break lines in
the specified file by searching the
points surrounding the line for an

appropriate Z-value.

Drape Selected
Breaklines

This tool allows the user to select a
specific break line and drape it to the

underlying LAS data. This tool will add
a Z-value (elevation) to the selected
break line by searching the points

surrounding the line for an appropriate
Z-value.

Double Hydro
Tool

This tool is meant for use on river or
stream break lines. The Double Hydro

Tool allows the user to reclass all
points within a virtual polygon which is

created between the two parallel
polylines representing the river/stream

banks. It also allows the user to
match the Z-value or elevation of the

two parallel break lines.

Force Double
Hydro

This tool allows the user to load a
break line shapefile and forces all
break lines down to even intervals
based off of elevation information
obtained during prior collection.

Copy Parallel This tool allows the user to move,
copy, or copy parallel to a selected

break line.

Change Feature
Code

This tool allows the user to change
the feature code of an 

existing break line.

Check for
Crossing

Breaklines

This tool will search for any crossing
break lines in a project. The resulting
'Break line Crossing' window will notify

the user of the total number of
break line crossings and allow the

user to pan to each instance by use
of the 'Previous' or 'Next' buttons.

Place Text This tool allows the user to add text to
the LAS Map View window.

Form Polygon This tool will allow the user to create a
polygon out of polylines.

Measure Area
This tool, only for pre-existing loaded
polygon features, displays the area of

a selected polygon.

Show Breakline
Vertices

This tool symbolizes the vertices of
all loaded break lines and labels each

with the ID number stored in the
shapefile attribute table.

Show Auto Pan
Edge Markers

This tool toggles the display of the
Auto-pan boundary markers that
indicate the area of the LAS Map

View window where an auto-pan (when
enabled) will occur if the cursor is

moved into it.

Reshape
Feature

This tool allows polyline and polygon
break line features to be reshaped by
'patching in' a new section of linework
rather than having to move, add, or

delete one vertex at a time.

Calculate Area
This tool allows a temporary polygon

to be digitized and displays the
enclosed area in acres.

New Feature
Elevation

This text box allows the user to enter
a new break line elevation

 directly on the Break lines Tab.

Undo Breakline

This button will undo the most recent
change to any break line. Depending
on the complexity of the change and
the computer's available RAM, it may
be possible to undo several changes.

Redo Breakline

This button will redo the most recent
change which was 'undone' by use of
the 'Undo' button. Depending on the
complexity of the change and the

computer's available RAM, it may be
possible to redo several 'Undo' steps.

Save Breaklines
to Shapefile(s)

This option allows the user to save

the break lines loaded into MARS® to
a shapefile(s).
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**NOTE: The Breaklines Tab tools are only functional with a Production-level license.

© 2000-2023 Merrick & Company. All Rights Reserved.

1.6 Technical Support Information

MARS® Technical Support Information

Technica l Support - Genera l Inform a tion

Please send all written correspondence regarding the MARS® software suite to:

MARS® Software Technical Support

Merrick & Company

5970 Greenwood Plaza Blvd.

Greenwood Village, CO  80111

United States

Technical Support Hours: Monday through Friday, 9:00 AM - 5:30 PM (U.S. Mountain Time Zone)

Toll Free Telephone: +1 (800) 544-1714

Email: MARSSupport@merrick.com

Web: http://www.merrick.com/MARS

mailto:MARSSupport@merrick.com
http://www.merrick.com/MARS
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Technical Support Contacts:

 Mark A. Stucky - MARS® Technical Support Specialist (United States, Canada)

Office: +1 (303) 353-3933

E-mail: mark.stucky@merrick.com

 Rogelio Aguayo, GISP - Latin American Support (Mexico, Central + South America)

Office: +1 (303) 353-3973

E-mail: rogelio.aguayo@merrick.com

Social Media

Please  follow  Merrick  &  Company  for  the  latest  MARS®  product  announcements,  feature
enhancements, and user tips!

MARS® is a Registered Trademark of Merrick & Company.

© 2000-2023 Merrick & Company. All Rights Reserved.

2 General Layout

General Layout

Merrick Advanced Remote Sensing (MARS
®

) Software

mailto:mark.stucky@merrick.com
mailto:rogelio.aguayo@merrick.com
http://www.twitter.com/
http://twitter.com/MerrickCompany
http://twitter.com/MerrickCompany
http://twitter.com/MerrickCompany
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The MARS® interface consists of the following components (top-to-bottom, left-to-right):  Quick Access

Toolbar , Tabs/Ribbon , Table of Contents , Breaklines Window , LAS Map View Window ,

Overview Window , and  Status Bar .  The Table of Contents, Breaklines, and Overview

windows can be floated (undocked) and moved to other locations including a second monitor.  When in

use, a Cross-Section/Profile Window  can share space with the LAS Map View window, or it can also

be floated.  The Project/Data Preparation Tab  is active when MARS® is first opened.

MARS® now supports drag-and-drop from Windows File Explorer for LAS files, SHP files (loaded in the

Reference Shapefiles layer), CSV-format Check Points files, and supported raster formats.  Files can be

dropped into the LAS Map View window or the Table of Contents window.

The MARS® v2023.1 interface:

62 158 64 142 145

155 158

238

162



General Layout 59

© 2000-2023 Merrick & Company

To float a window, right-click on its tab and choose 'Float'.  The window may now be dragged by its title

bar to a different location, including a second monitor.  To return it to its docked state, right-click

anywhere on the title bar and choose 'Dock as Tabbed Document'.

Example of windows layout when Table of Contents, Breaklines, and Overview windows are all floated:
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Note that on smaller displays - especially some laptops and monitors less than 20" diagonally that have

traditional 4:3 aspect ratios - the tab labels will be closer together and some tools may change their

button/icon appearance.  See the example below for the two tools at the far right side of the Cross-

Section/Profile tab.  This is an issue with Microsoft Visual Studio and is not fixable in MARS®.
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If icon and/or labeling text disappears (as in the example above), tool-tip pop-ups will be enabled when

hovering over those buttons, as shown below (upper-right).  Clicking an unlabeled button will present the

options for that button.  Always maximize the MARS® program window to allow as much space for icons

as possible.
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2.1 Quick Access Toolbar

Quick Access Toolbar

Merrick Advanced Remote Sensing (MARS
®

) Software

The Quick Access Toolbar:

The Quick Access Toolbar (QAT) contains commonly used tools that can be invoked without having to

change tabs.  When MARS® is first installed, the QAT is pre-loaded with the first eight tools from the

Navigation Tab , the 'Inspect ' tool, and the 'Measure ' tool.  Most other tools can be added - to232 943 956
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see if a tool is available to be added, right-click on it (in its normal tab location) and note whether 'Add

to Quick Access Toolbar' is enabled.  Tools that are added will initially appear at the end of the toolbar

and will be immediately saved for future MARS® sessions.

To re-order the tool buttons in the QAT, click the 'Change Button Ordering in QAT' button on the Options

Tab .  The 'Change Ordering in QAT' interface will appear, where tools may be moved up (to the left

on the toolbar) or down (to the right on the toolbar) in the list of existing tools.  Select the tool(s) to be

re-ordered, one at a time, and click either the 'Move Up' or 'Move Down' button.

When all moves are complete, click the 'OK' button to save the positions and close the interface, or
click 'Cancel' to quit without saving any changes.

518
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To remove a tool from the toolbar, right-click on it and choose 'Remove from Quick Access Toolbar.' 

The new layout will be automatically saved for future MARS® sessions. 

By default, the toolbar is located above the ribbon, but it can be moved to below the ribbon by right-

clicking on any part of it and choosing 'Show Quick Access Toolbar below the Ribbon.'  

Right-click and choose 'Show Quick Access Toolbar above the Ribbon' to move it back to its default

location.

© 2000-2023 Merrick & Company. All Rights Reserved.

2.2 Table of Contents

Table of Contents

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Table of Contents' is where raster, vector, elevation datasets, and other files are managed in

MARS®.  The Table of Contents consists of eight (8) file type groupings - known as layers - each of

which has a different functionality and contains different types of data.

 LAS      Float Grids       Rasters        WMS Images        Vectors        Tiles

      Check Points       Breaklines

These eight layers fall under the 'Data Layers' header which can be collapsed or expanded as

needed, and which controls the visibility of all the sub-layers with a single check box.  The 'Data

71 79 83 87 92

118 128 134
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Layers' header has two controls available when right-clicking on it: Projection and Properties.

Projection - allows a coordinate reference system (CRS) to be defined for the project if the

loaded data does not contain that information, or allows incorrect information to be

modified so that the proper CRS is displayed for the 'Data Layers'.  Note that

modifying the CRS here does not change the actual CRS of any of the loaded

data.

Properties - displays the currently defined CRS for the loaded data, unless none exists.  This

information is populated from the first defined shapefile (tile or reference) or the first

defined LAS file added to the Table of Contents.  Defined shapefiles provide only

limited CRS information, whereas an LAS file with a WKT-based CRS will fully

populate the projection system information.  If a defined shapefile is added first

followed by a defined LAS file, the Data Layer Properties will be updated with the

complete CRS information.  NOTE that adding additional LAS files with an

alternate CRS definition will NOT change what is stored in the Data Layer

Properties and is not recommended in the same MARS session.  MARS does

not re-project data on-the-fly as it is loaded.

MARS® now supports drag-and-drop from Windows File Explorer for LAS files, SHP files

(loaded in the Reference Shapefiles layer), CSV-format Check Points files, and supported

raster formats.  Files can be dropped into the LAS Map View window or the Table of

Contents window.  SHP-format (shapefile) Check Points files must be added using the 'Add

Check Points Files' button on the Project/Data Preparation Tab  - they will be loaded as

Reference Shapefiles (under the Vectors layer) if drag-and-drop is used.

Note  --  The 'Vectors' layer (expanded by default) is divided into five (5) sub-layers: EO Files,

Reference Shapefiles, MPD Vectors, File GeoDatabases, and GeoPackages.

162
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Display colors for most reference shapefile entries and other vector types can be modified by double-

clicking the display symbol between the checkbox and the entry name, or by right-clicking the entry

and selecting 'Properties'.

The total number of files of all types loaded (except WMS layers and breaklines in memory) will be

displayed immediately after the 'Data Layers' label at the top.  The Table of Contents also offers four

options at the top of the window:

1.) On/Off: The 'On' and 'Off' buttons allow the user to turn selected file displays on or off as needed. 

2.) Remove: The 'Remove' button will allow the user to remove highlighted files from MARS®. Using

the 'Shift' and 'Ctrl' keys on the keyboard, highlight multiple files which are to be removed.
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Click the 'Remove' button and all those files chosen by the user will be removed from MARS®.

3.) Shift: The shift tool is used to shift data east (a positive shift in the Translation East text box), west

(a negative shift in the Translation East text box), north (a positive shift in the Translation North

text box), or south (a negative shift in the Translation North text box). The shift tool is also

capable of shifting the elevation of the data by entering a positive shift value (to move data up

higher) or a negative shift value (to move data down lower). In the table of contents, it is possible

to select more than one LAS file at a time and apply the necessary shifts to them. Use the 

'Shift' key on the keyboard to select more than one file in a  row, or use the 'Ctrl' key on the

keyboard to select several files in random order. The selected files will all have the same shifts,

specified by the user in the 'MARS LAS Shifter' interface, applied to them.  Shifting of LAS data

produces a *.off file (one per shifted LAS file) which stores the pre-shift X, Y, and Z values read

from the LAS file header. These files are created in the same folder as the LAS files that were

shifted. The *.off files are used as a baseline by the 'Report LAS Shift'  tool to create a

comma-delimited (*.csv) report that stores the total (cumulative) shift for each of the files chosen

to be included in the report.  ** NOTE when using the MARS LAS Shifter: If multiple shifts

are applied to a single project, the effect is cumulative. Each shift is applied to the

existing XYZ offset in the header.  To shift all loaded LAS files without selecting them first,

use the 'XYZ Shift' tool on the Coordinate Conversion Tab .

              

572
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4.) Zoom To: To use this tool, data needs to be loaded into MARS®. This tool can function in two

ways: it can be used to zoom to particular files inside the LAS layer, or it can be used to zoom to

different layers  in the Table of Contents. Select the data or layer to zoom to using the ‘Shift’ or

‘Ctrl’ keys on the keyboard to make the selections if necessary. Then click the ‘Zoom to’ option

at the top of the Table of Contents, and MARS® will zoom to the extent of the data or layer(s)

selected. This tool will work on any dataset or file type loaded into the Table of Contents except

for breaklines which have been stored to memory. It will only function in 2D (orthographic) mode

and the option to 'Zoom to' will be disabled during 3D viewing.

In the example below, the user has chosen LAS files 1, 2, 4, and 5 and clicked the 'Zoom to' button at

the top of the Table of Contents.  To zoom to a single LAS file, this method can be used, or the

file can be right-clicked on and 'Zoom To' chosen from the context menu (below, right).
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If the Table of Contents window is not set wide enough, the ‘Zoom to’ button may be hidden.  Either

click the drop-down arrow to the right of the 'On Off | Remove | Shift' bar to access the 'Zoom to' button,

or expand the width of the Table of Contents window by dragging the right edge.

              

The MARS® Table of Contents will also alert the user when a loaded LAS file is no longer available for

use.  This scenario would occur if, for example, a file which was loaded into MARS® was deleted, moved

to a different folder, or renamed while still loaded.  MARS® will notify the user that the file is no longer

available with the following error message.  A red 'X' will also appear next to any such entries in the

Table of Contents.



General Layout 71

© 2000-2023 Merrick & Company

© 2000-2023 Merrick & Company. All Rights Reserved.

2.2.1 LAS

LAS Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

LAS Layer - The 'LAS' layer shows the LAS files that are currently loaded in MARS®. It also

allows the user to toggle display of files, remove files, zoom to a file, and view the properties of files.

Only *.las files can be added to this layer.
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Adding LAS Files: To add an LAS file, see the 'Add LAS Files' section in the Project/Data

Preparation Tab  topic.  Note that adding files that do not meet the minimum compliancy

requirements will prompt an up-conversion of those files as detailed in that same topic.

Expanding the LAS Layer: Click on the ' ' button to expand a list of all the files loaded under the

'LAS' layer. There are three ways to turn on/off the display of the files loaded under the ‘LAS’ layer: 1)

check/uncheck the 'LAS' layer box, 2) check/uncheck the box next to the file(s) to be turned on/off or,

3) click on the 'On' or 'Off' buttons at the top of the Table of Contents while the appropriate files are

highlighted. Use the 'Shift' and 'Ctrl' keys on the keyboard to select multiple files. Make sure the

'LAS' layer box is checked to view the files loaded beneath it; if this master box is not checked 'on'

the individual files will not be displayed.

Removing an LAS File: To remove a file from the LAS layer, click on the file that is to be removed to

162
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highlight it. Right-click on the file and choose 'Remove' to remove only the highlighted file. To remove

all LAS data, right-click and choose 'Remove All' - all LAS data currently loaded will be unloaded.

Another way to remove files from the layer is to highlight the file that needs to be removed, and click

on the 'Remove'  button found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys on the

keyboard to select multiple files which are to be removed. 

  

Zoom to an LAS File: There are two ways to zoom to an LAS file:

1. To zoom to a *.las file in the LAS layer, highlight the file and choose the 'Zoom to' button

found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys on the keyboard

to zoom to multiple LAS files at a time.
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2. To zoom to a specific LAS file, highlight that file in the LAS layer and right-click.

Choosing the 'Zoom to' option will fit that particular LAS file to the LAS Map View window

extent.

Save the Boundary of an LAS file to SHP:  Whenever an LAS file is spatially indexed - e.g., by

using the Add Spatial Index  tool, as part of Export to LAS  or Grid - LAS , when running LAS

Merging , etc. - the XY extent is stored in the file's header.  This information can be used to

generate a polygon shapefile of the file's 'footprint' for analysis.  Right-click on the file in the Table of

Contents and choose 'Save Boundary to SHP'.  The boundary shapefile will be created in the same

folder where the file exists with the name 'Boundary_<file name>.las', and will include a PRJ file if the

LAS file's Coordinate Reference System is defined.

904 710 696
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Viewing the Properties of LAS Files: To see the properties of any LAS file, first highlight (select)

the file, then right-click and choose 'Properties'. A listing of properties will be displayed for

informational purposes including: the complete path and file name, File Source ID, the Number of

Points, the Point Data Record Format, the Number of Bytes per point record, the GPS Time and WKT

Format (Global Encoding), the LAS Version, the System Identifier, the File Creation Day (Julian Day)

and Year, the Header Size, the Number of Variable Length and Extended Variable Length Records,

the Offset to Data Point (the first point record), and the Min, Max, Offset, and Scale of each of the

coordinates: X, Y, and Z. Coordinate reference system (CRS) data is displayed near the bottom if the

file has this information defined. The 'EVLRs' button presents a scrollable list of all the Extended

Variable Length Records that the file contains, showing the total record count as well as the 'user ID',

'description', 'record ID', and 'length after header' info (in that order) for each record.  It is also possible

to highlight, right-click, and copy data from the resulting 'LAS File Properties' window.
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Viewing the GSD and point density for all loaded LAS Files: To see the average GSD (ground

sample distance) and average point density for all loaded LAS files, right-click on the 'LAS' layer in the

Table of Contents and select 'GSD.'

     

The results are not an exact calculation of GSD/Density, but are based on a 20 x 20 unit sample area
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from each loaded LAS file, using all returns.  If, for example, 40 LAS files are loaded, the GSD/Density

values from the 40 sample areas are calculated and the median values are reported by this tool.

© 2000-2023 Merrick & Company. All Rights Reserved. 

2.2.2 Float Grids

Float Grids Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Float Grids Layer - The 'Float Grids' layer shows the Float Grid files that are currently loaded in

MARS®. It also allows the user to toggle display of files, remove files, zoom to a file, and view the

properties of files. Only *.flt files can be added to this layer.
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Adding Float Grid Files: To add a float grid, see the 'Add Float Grid' section in the Project/Data

Preparation Tab  topic.

Expanding the Float Grids Layer: Click on the ' ' button to expand a list of all the files loaded

under the 'Float Grids' layer. There are three ways to turn on/off the display of the files loaded under

the ‘Float Grids’ layer: 1) check/uncheck the 'Float Grids' layer box, 2) check/uncheck the box next

to the file(s) to be turned on/off or, 3) click on the 'On' or 'Off' buttons at the top of the Table of

Contents while the appropriate files are highlighted. Use the 'Shift' and 'Ctrl' keys on the keyboard to

select multiple files. Make sure the 'Float Grids' layer box is checked to view the files loaded beneath

it; if this master box is not checked 'on' the individual files will not be displayed.

Removing a Float Grid File: To remove a file from the Float Grids layer, click on the file that is to be

removed to highlight it. Right-click on the file and choose 'Remove' to remove only the highlighted file.

To remove all Float Grid files, right-click and choose 'Remove All' - all Float Grid files currently

loaded will be unloaded. Another way to remove files from the layer is to highlight the file that needs to

be removed, and click on the 'Remove'  button found at the top of the Table of Contents. Use the 

'Shift' and 'Ctrl' keys on the keyboard to select multiple files which are to be removed.

162
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Viewing the Properties of Float Grid Files: To see the properties of a Float Grid file, first highlight

the file. Then right-click and choose 'Properties'. The properties of the file will be displayed for

informational purposes only. Information provided includes: the source of the file, the number of

columns and rows, the cell size, the X and Y coordinates of the lower-left corner, and what value is

used to represent NODATA cells. It is also possible to highlight, right-click, and copy data from the

resulting 'Float File Properties' window.
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Zoom to a Float Grid File: To zoom to a *.flt file in the float grid layer, highlight the file and choose

the 'Zoom to' button found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys on the

keyboard to zoom to multiple files at a time.
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2.2.3 Rasters (Images)

Rasters Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Rasters Layer (for raster files and datasets) - The 'Rasters' layer shows the Raster files

that are currently loaded in MARS®. It also allows the user to toggle display of files, remove files, and

view the properties of files. The types of files which may be added to this layer are: ECW (Hexagon-

Intergraph), JPG, IMG (Hexagon-ERDAS), TIFF, DAT (ENVI Hyperspectral), NITF (USDoD), JP2, SID

(LizardTech), and PNG files.  Rasters are only displayed while in 2D (Orthographic) mode .232
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Adding Raster Files: To add a raster (image) file, see the 'Add Images' section in the Project/Data

Preparation Tab  topic. 

 

Expanding the Rasters Layer: Click on the ' ' button to expand a list of all the files loaded under

the 'Rasters' layer. The loaded images will appear under this layer. There are three ways to turn on/off

the display of the files loaded under the ‘Rasters’ layer: 1) check/uncheck the 'Rasters' layer box, 2)

check/uncheck the box next to the file(s) to be turned on/off or, 3) click on the 'On' or 'Off' buttons at

the top of the Table of Contents while the appropriate files are highlighted. Use the 'Shift' and 'Ctrl'

keys on the keyboard to select multiple files. Make sure the 'Rasters' layer box is checked to view

the files loaded beneath it; if this master box is not checked 'on' the files will not be displayed.

Removing a Raster File: To remove a file from the Rasters layer, click on the file that is to be

removed to highlight it. Right-click on the file and choose 'Remove' to remove only the highlighted file.

To remove all  raster files, right-click and choose 'Remove All' - all raster files currently loaded will be

unloaded. Another way to remove files from the layer is to highlight the file that needs to be removed,

and click on the 'Remove'  button found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl'

keys on the keyboard to select multiple files which are to be removed. 

162
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Viewing the Properties of a Raster File: To view the properties of a raster file, click on the file to

highlight it. Right-click on the file and choose 'Properties'. The window which comes up will contain

information on the the source of the file, the number of pixels and rows, the number of bands, and the

X and Y minimum and maximum coordinates.
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Zoom to a Raster Image: To zoom to an image file in the 'Rasters' layer, highlight the file and

choose the 'Zoom to' button found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys

on the keyboard to zoom to multiple files at a time.
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2.2.4 WMS Images

WMS Images Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

WMS (Web Map Service) Images Layer (for raster layers) - The 'WMS Images' layer

shows the WMS Image layers that are currently loaded in MARS®. It also allows the user to toggle

display of layers, refresh layers, and remove layers. MARS® has several pre-configured sources and

allows for user input and storage of other known WMS servers .

Adding WMS Raster Layers: An active Internet connection is required to use this service.  To add a

1716
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WMS image, see the 'Add WMS Images' section in the Project/Data Preparation Tab  topic and the

following information.

In the 'Default Server' drop-down box, either choose a listed server or enter the URL of a known server

(by choosing 'User Input').  If entering a new (non-listed) server, enter a name that is not already being

used - any free-form descriptive text will work.  To save a new entry for future use, click the 'Save

Server Info' button before continuing.  If a License Token is required for the particular server (such as

for the Bing Maps layers), enter it in the box and click 'Save Token.'  Saving will create an entry in the

Windows Registry that will automatically load the token on future WMS calls.  Next, click 'Get Server

Info' to bring up the available images for the chosen server. (When choosing a 'Bing Maps' server, if no

license token is listed and none is entered a pop-up with a link to obtain a token or a trial will appear.)

Finally, highlight the desired image in the left pane (labeled 'Data Information') and click 'Get Image.' 

The image will be re-projected on the fly to match the loaded LAS or shapefile data, as long as the

projection system is defined for that data.  To remove an entry from the server drop-down list, choose

it and click the 'Remove Server' button.

162
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If the 'Add WMS Images' button (on the Project/Data Preparation Tab ) is used before any

projection-defined data is loaded, MARS® will return an error message indicating that projection

information for the current project has not yet been defined.

162
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Expanding the WMS Images Layer: Click on the ' ' button to expand a list of all the images loaded

under the 'WMS Images' layer. The loaded images will appear under the layer name. There are three

ways to turn on/off the display of the images loaded under the ‘WMS Images’ layer: 1) check/uncheck

the 'WMS Images' layer box to control all loaded images, 2) check/uncheck the box next to the

individual image(s) to be turned on/off or, 3) click on the 'On' or 'Off' buttons at the top of the Table of

Contents while the desired image(s) are highlighted. Use the 'Shift' and 'Ctrl' keys on the keyboard

along with the mouse to select multiple images. Make sure the 'WMS Images' layer box is checked

to view the images loaded beneath it; if this master box is not checked the individual images will not

be displayed.

Refreshing a WMS Image: To refresh a loaded WMS image layer, right-click on the desired entry in

the Table of Contents and choose 'Refresh.'  This will also force an extent update if the view window

extent has changed since the image was last rendered.
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Removing a WMS Image: To remove a WMS image layer, click on the image layer that is to be

removed to highlight it. Right-click on the image layer and choose 'Remove' to remove only the

highlighted image layer. To remove all WMS layers, right-click and choose 'Remove All' - all image

layers currently loaded will be unloaded. Another way to images from the layer is to highlight the

image layer that needs to be removed, and click on the 'Remove'  button found at the top of the Table

of Contents. Use the 'Shift' and 'Ctrl' keys on the keyboard to select multiple image layers which are

to be removed.

NOTE:  Availability of any WMS resources included with MARS® or referenced here  is subject to

change without notice.  None of these services is endorsed, provided, or otherwise

guaranteed to be functional by Merrick & Company.  Merrick neither hosts nor maintains any

1716
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WMS (Web Map Service) image layer sources and is therefore not responsible for the

completeness, accuracy, or frequency of updates of any WMS sources that may be

accessed from within the MARS® program.

© 2000-2023 Merrick & Company. All Rights Reserved.

2.2.5 Vectors (EOs, SHPs, GDBs, GeoPackages)

Vectors Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Vectors Layer - The 'Vectors' layer shows the vector data (EO text files and/or shapefiles,

reference shapefiles, MPD vectors, file geodatabases, and/or geopackages) that are currently loaded

in MARS®.  It also allows the user to toggle display of sub-layers/files, remove vector files, and view or

change the attributes and properties of vector files.  The layer can be expanded (click the ' ' button to

the left of the layer) or collapsed (click the '-' symbol) as needed to access the five sub-layers.

Currently supported formats are EO (Exterior Orientation) text (*.txt) files or point shapefiles, Esri-

compatible point, polyline, and polygon shapefiles, Esri v10.0 or later file geodatabases, and

geopackages.  MPD vectors are user-drawn features that can be saved in a project file (*.mpd) for later

use, whether or not they have been saved as a shapefiles.  Tile layout  and Breaklines

shapefiles may be loaded under the 'Reference Shapefiles' sub-layer if they are needed only as

reference data.

118 134
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EO Files Sub-Layer

Adding an EO File: To add an EO (exterior orientation) file, see the 'Add EO File' section in the

Project/Data Preparation Tab  topic.

Expanding the sub-layer and viewing entries: Click on the ' ' button to expand a list of all the

files loaded under the 'EO Files' sub-layer.  The loaded EO files (TXT or shapefiles) will appear under

this sub-layer. There are four ways to turn on/off the display of the files loaded here: 1) check/uncheck

the 'Vectors' layer box which affects all vector types, 2) check/uncheck the 'EO Files' sub-layer box,

3) check/uncheck the box next to the EO file(s) to be turned on/off or, 4) click on the 'On' or 'Off'

buttons at the top of the Table of Contents while the appropriate files are highlighted.  Use the 'Shift'

and 'Ctrl' keys on the keyboard to select multiple files.  Make sure the 'Vectors' layer box is checked

to view any files in any sub-layers loaded beneath it; if this master box is not checked the files will not

be displayed.
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Removing an EO File: To remove a file from the 'EO Files' sub-layer, click on the file that is to be

removed to highlight it.  Right-click on the file and choose 'Remove' to remove only the highlighted

file.  To remove all EO files, right-click and choose 'Remove All' - all EO files currently loaded will be

unloaded.  Another way to remove files from the sub-layer is to highlight the file that needs to be

removed, and click on the 'Remove ' button found at the top of the Table of Contents.  Use the 'Shift'

and 'Ctrl' keys on the keyboard to select multiple files which are to be removed.

Export to Shapefile for EO Text Files: To export a loaded EO text file to an Esri-compatible point

shapefile, left-click on the desired file in the Table of Contents to highlight it, then choose 'Export to

shapefile'.  A 'Save As' dialog will open where the path and file name can be chosen.  Click the 'Save'

button to finish the export.  The new shapefile can be loaded as a reference shapefile, and the attribute

table may then be viewed and manipulated as described above.
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Changing EO (Exterior Orientation) Text File Properties: To change the EO text file properties,

left-click on the desired file in the Table of Contents to highlight it, then right-click and choose 

'Properties'.  The full name and path of the file is displayed, and point size, point color, label display,

and font size can be changed using the interface that appears.
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Zoom to an EO File: To zoom to an EO file (text or shapefile), highlight the file and choose the

'Zoom to' button found at the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys on the

keyboard to zoom to multiple shapefiles at a time.  Select the 'EO Files' sub-layer and choose 'Zoom

to' to zoom to the entire extent of all loaded EO files.

Reference Shapefiles Sub-Layer

Adding a Reference Shapefile: To add a reference shapefile, see the 'Add Reference Shapefiles'
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section in the Project/Data Preparation Tab  topic.  Display colors are assigned on a six-color

repeating cycle and can be changed as described in the Changing Reference Shapefile Display

Properties section, below .

Expanding the sub-layer and viewing entries: Click on the ' ' button to expand a list of all the

files loaded under the 'Reference Shapefiles' sub-layer. The loaded shapefiles will appear under this

sub-layer. There are four ways to turn on/off the display of the files loaded here: 1) check/uncheck the

'Vectors' layer box which affects all vector types, 2) check/uncheck the 'Reference Shapefiles' sub-

layer box, 3) check/uncheck the box next to the shapefile(s) to be turned on/off or, 4) click on the 'On'

or 'Off' buttons at the top of the Table of Contents while the appropriate files are highlighted. Use the

'Shift' and 'Ctrl' keys on the keyboard to select multiple files. Make sure the 'Vectors' layer box is

checked to view any files in any sub-layers loaded beneath it; if this master box is not checked the

files will not be displayed.

Removing a Reference Shapefile: To remove a file from the 'Reference Shapefiles' sub-layer,

click on the file that is to be removed to highlight it. Right-click on the file and choose 'Remove' to

remove only the highlighted file. To remove all reference shapefiles, right-click and choose 'Remove

All' - all reference shapefiles currently loaded will be unloaded. Another way to remove files from the

sub-layer is to highlight the file that needs to be removed, and click on the 'Remove ' button found at

the top of the Table of Contents. Use the 'Shift' and 'Ctrl' keys on the keyboard to select multiple files

which are to be removed.

162
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Viewing and/or Editing Reference Shapefile Attributes: To view a reference shapefile's attribute

table, click on the shapefile to highlight it.  Then right-click on the shapefile and select 'Attributes'.

 The attribute table and labeling fields will appear in a new window.  To edit the attributes, double-click

on the appropriate attribute and make the needed changes.  Click on the 'Save' header to save the file.

 The 'iShape' field cannot be edited.
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It is possible to edit the attribute table of a shapefile by adding new fields, or changing

the contents of those fields.  The only exception is the 'iShape' field, which cannot be

edited.  To add a new column or field to the attribute table, click on the 'Add Field'

button at the top of the window.  The 'Add Field' window will appear and the user may

specify the restrictions of the new field. 

Creating a New Field:

1) First, give the new field a name in the 'Field Name' text box.  The attribute

table will display up to ten (10) characters in the column heading.

2) Then define the 'Field Type' to be used in the new column. 

3) Define the 'Width' of the column.  The width defines how many characters

will fit inside the defined field.  For example, if the user chooses a 'Width' of

twenty (20), then only twenty characters will be saved in the newly defined

field.  If the user is creating a 'Comments' field, the width of the new field

should be larger to accommodate any needed characters for comments.  If

the user is creating a 'Date' field, which requires only ten characters at most,

then the width may be smaller.  When using the 'Logical' field type, the user-

specified width does not matter, as only one character (a check mark) is

used in this field. 

4) In the 'Number of Decimals' text box (only enabled for certain 'Field Type'

choices) the user may specify the number of decimals which will be allowed

in the newly defined field.  If the user chooses '0' then all numbers entered

into the newly created field will have to be integers. 

5) Click the 'OK' button when finished, and then click the 'Save' button in the

upper-left corner of the attribute table to make the new field permanent.

Editing a Field:
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To edit any attribute information, double-click on the appropriate attribute and

make the changes necessary.  When finished, click on the 'Save' button in the

upper-left corner to save the changed information.  The user will receive a

message confirming the data was saved inside the shapefile.  This ability may

be very useful when editing data to keep track of tiles or areas which have or

have not been edited.

It is also possible to view the statistics of attributes in a shapefile.  The user

may view the statistics of a single attribute, the statistics of an entire row or

column, or the statistics of an entire table.  Highlight the attributes for which

statistics are to be viewed, right-click and choose 'Statistics'.  The resultant

table will tell the user the following statistics: the row count, minimum,

maximum, sum, mean (average), and median of every attribute.  To select

multiple attributes for statistic viewing at once, use the 'Shift' or 'Ctrl' keys on

the keyboard.  In the example below, the user is choosing to view the statistics
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of the entire 'ALLPCOUNT' column.  The resulting statistics are also shown

below.

   

        

Lastly, it is possible to zoom to a particular feature (row) in an attribute table. 

To use this function, highlight a row and right-click anywhere on it.  Right-click

on the 'Zoom to' option and the highlighted feature will fit to the LAS Map View
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window.

Deleting a Field:

To delete an attribute field right-click on the column heading and choose

'Remove Field'.  NOTE: the 'iShape' field should never be deleted if the

shapefile is to be used in MARS® in the future.  All information contained in

this column, or attribute field, will be lost at this time.  Click 'Save' in the upper-

left to make this change permanent.
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Changing Reference Shapefile Display Properties: To change the shapefile properties, left-click

on the desired file in the Table of Contents to highlight it, then right-click and choose 'Properties'.

Alternatively, toggle the 'Inspect ' button on, then hold down the 'Shift' key and click on a shapefile

feature to display the 'Properties' window.  The full name and path of the file is displayed, and line

thickness, outline and fill (if the shapefile is polygonal) colors, labeling field, and font size can be

changed through the dialog that appears.  To label features with an attribute value, select that attribute

from the 'DB Field for Labeling' drop-down list and check the 'Display label' box.  The 'Font Size' of the

labels can also be set.  Font color will be the same as 'Outline Color.'  A transparency level can be set

if 'Fill' is checked.  To force the shapefile to be displayed on top of other layers, check the 'Display On

Top' box.

943
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Zoom to a Reference Shapefile: To zoom to a reference shapefile, highlight the file and choose the

'Zoom to' button found at the top of the Table of Contents.  Use the 'Shift' and 'Ctrl' keys on the

keyboard to zoom to multiple shapefiles at a time.  Select the 'Reference Shapefiles' sub-layer and

choose 'Zoom to' to zoom to the entire extent of all loaded reference shapefiles.
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MPD Vectors Sub-Layer

This sub-layer differs from the others under the 'Vectors' layer in that there are no separate files that

hold these features - they are stored only in memory or, optionally, in an MPD (project file).  There are

categories for the three types of vector geometries: 2D Points, 2D Polylines, and 2D Polygons. 

Please see the 'Draw 2D Point', 'Draw 2D Polygon', and 'Draw 2D Centerline ' topics in the Vector

Creation Tab  help section for information on drawing and storing these features.

Expanding the sub-layer and viewing the geometry categories: Click on the ' ' button to

expand a list of the three geometry types available under the 'MPD Vectors' sub-layer.  There are four

ways to turn on/off the display of these features: 1) check/uncheck the 'Vectors' layer box which

affects all vector types, 2) check/uncheck the 'MPD Vectors' sub-layer box, 3) check/uncheck the box

next to the geometry type(s) to be turned on/off or, 4) click on the 'On' or 'Off' buttons at the top of the

Table of Contents while the 'MPD Vectors' sub-layer is highlighted or while the appropriate geometry
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types are highlighted.  Use the 'Shift' and 'Ctrl' keys on the keyboard to select multiple files.  Make

sure the 'Vectors' layer box is checked to view any files in any sub-layers loaded beneath it; if this

master box is not checked the files will not be displayed.

Deleting all features from a geometry type: To delete all features from a geometry type in the '

MPD Vectors' sub-layer, click on the geometry type to highlight it.  Right-click on the geometry type

and choose 'Delete All'.  Be sure to save the MPD file if this is to be a permanent deletion.

Zoom to MPD Vectors: To zoom to MPD vectors, highlight the desired geometry type and choose the

'Zoom to' button found at the top of the Table of Contents.  Select the 'MPD Vectors' sub-layer and

choose 'Zoom to' to zoom to the entire extent of all MPD vectors of all geometry types.

File GeoDatabases Sub-Layer

The 'File GeoDatabases' sub-layer shows the Esri File GDB data that is currently loaded in MARS®.
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It also allows the user to toggle display of multiple file GDBs along with their datasets and feature

classes, remove File GDBs, view the attributes of feature classes, and view or change the properties of

feature classes.  Currently supported formats are v10.0 or later.  Any topologies must be removed from

the GDB before it can be loaded, and features must be 2D (no 'M' or 'Z' values present).

Adding a File GDB: To add a File GDB (including all datasets and feature classes within it), see the

'Add File GDB' section in the Project/Data Preparation Tab  topic.

Expanding the sub-layer and viewing entries: Click on the ' ' button to expand a list of all the file

GDBs loaded under the 'File GeoDatabases' sub-layer.  GDBs can be further expanded by clicking

the ' ' button next to them to reveal feature datasets and standalone feature classes.  Feature

datasets can be further expanded by clicking the ' ' button next to them to reveal feature classes

within the dataset.  There are five ways to turn on/off the display of the entries loaded here: 1) check/

uncheck the 'Vectors' layer box which affects all vector types, 2) check/uncheck the 'File

GeoDatabases' sub-layer box to control all  loaded GDBs, 3) check/uncheck the box next to the GDB
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(s) to be turned on/off, 4) check/uncheck the box next to the feature dataset(s) and/or feature class

(es) to be turned on/off or, 5) click on the 'On' or 'Off' buttons at the top of the Table of Contents while

the appropriate entries are highlighted.  Use the 'Shift' and 'Ctrl' keys on the keyboard to select

multiple entries.  Make sure the 'Vectors' layer box is checked to view any files in any sub-layers

loaded beneath it; if this master box is not checked the entries will not be displayed.

Removing a File GDB: To remove a File GeoDatabase from the project, click on the main (top-level)

GDB entry to highlight it.  Then right-click on the highlighted entry and select 'Remove', or choose

'Remove All' to empty the entire sub-layer if multiple File GDBs are loaded.  Another way to remove

data from the sub-layer is to highlight the entry that needs to be removed, and click on the 'Remove '

button found at the top of the Table of Contents.  Use the 'Shift' and 'Ctrl' keys on the keyboard to

select multiple entries which are to be removed.
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Viewing Feature Class Attributes: To view a feature class's attribute table, click on the feature class

entry to highlight it.  Then right-click on the entry and select 'Attributes'.  The attribute table and

labeling fields will  appear in a new window.  Editing of feature class attribute tables is not possible in

MARS®.
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Changing Feature Class Display Properties: To change the properties of a feature class, left-click

on the desired entry to highlight it, then right-click and select 'Properties'.  The feature class name
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and feature dataset it belongs to (if applicable) is displayed, along with several options for controlling

the display of the feature class, in the interface that appears.  Currently, only the 'Line Thickness' and

'Outline Color' can be set - the additional controls in the properties interface may be enabled in a future

release.

         

Zoom to a File GeoDatabase: To zoom to a file geodatabase, highlight the GDB and choose the
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'Zoom to' button found at the top of the Table of Contents.  Use the 'Shift' and 'Ctrl' keys on the

keyboard to zoom to multiple GDBs at a time.  Select the 'File GeoDatabases' sub-layer and choose

'Zoom to' to zoom to the entire extent of all loaded file geodatabases.

GeoPackages Sub-Layer

The 'GeoPackages' sub-layer shows the geopackage data that is currently loaded in MARS®.  It

allows the user to toggle display of multiple GeoPackage layers, remove layers, view the attributes of

feature classes, and view or change the properties of feature classes.  The latest version of the

GeoPackage standard currently supported is v1.3.1.

Adding a GeoPackage dataset: To add a GeoPackage dataset (including all layers within it), see

the 'Add GeoPackages' section in the Project/Data Preparation Tab  topic.

Expanding the sub-layer and viewing entries: Click on the ' ' button to expand a list of all the

162
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GeoPackage layers loaded under the 'GeoPackages' sub-layer.  Click on the ' ' button to the left of a

GeoPackage entry to expand a list of all the layers loaded as part of that GeoPackage.  There are five

ways to turn on/off the display of the entries loaded here: 1) check/uncheck the 'Vectors' layer box

which affects all vector types, 2) check/uncheck the 'GeoPackages' sub-layer box to control all

loaded GeoPackage datasets, 3) check/uncheck the box next to the individual GeoPackage(s) to be

turned on/off, 4) check/uncheck the box next to the layer(s) to be turned on/off or, 5) click on the 'On'

or 'Off' buttons at the top of the Table of Contents while the appropriate entries are highlighted.  Use

the 'Shift' and 'Ctrl' keys on the keyboard to select multiple entries.  Make sure the 'Vectors' layer

box is checked to view any files in any sub-layers loaded beneath it; if this master box is not checked

the entries will not be displayed.

Removing GeoPackages: To remove a GeoPackage from the project, click on an entry ending in '.

gpkg' immediately below the main (top-level) GeoPackages sub-layer to highlight it.  Then right-click

on the highlighted entry and select 'Remove', or choose 'Remove All' to empty all GeoPackage
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entries from the Table of Contents.  Another way to remove data from the GeoPackage sub-layer is to

highlight the entry that needs to be removed, and click on the 'Remove '  button found at the top of the

Table of Contents.  Use the 'Shift' and 'Ctrl' keys on the keyboard to select multiple entries which are

to be removed.

          

Viewing GeoPackage Layer Attributes: To view a GeoPackage layer's attribute table, click on the

layer entry to highlight it.  Then right-click on the entry and select 'Attributes'.  The attribute table and

labeling fields will appear in a new window.  Editing of layer attribute tables is not possible in MARS®.
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Changing GeoPackage Layer Display Properties: To change the properties of a GeoPackage

layer, left-click on the desired entry to highlight it, then right-click and select 'Properties'.  The layer



General Layout 117

© 2000-2023 Merrick & Company

name is displayed, along with several options for controlling the display of the layer, in the interface

that appears.  Currently, the 'Line Thickness' and 'Outline Color' can be set as well as labeling options

for the features in the layer.  To label features with an attribute value, select that attribute from the 'DB

Field for Labeling' drop-down list and check the 'Display label' box.  The 'Font Size' of the labels can

also be set.  Font color will be the same as 'Outline Color.'  The additional controls in the properties

interface may be enabled in a future release.
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2.2.6 Tiles (SHPs)

Tiles Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Tiles Layer (for polygon shapefiles or tile layouts) - The 'Tiles' layer allows the

loading of a tile shapefile or layout into a project.  It also allows the user to toggle display of the

shapefile, remove the file, zoom to the file, and view or change the attributes and properties of the file.  

Only ONE shapefile can be added to the 'Tiles' layer at a time, and only polygon shapefiles should be

loaded in the 'Tiles' layer.  If a second tile layout is added, it will replace the current loaded one. 

Adding a Tile Shapefile: To add a tile shapefile, see the 'Add Tile Shapefile' section in the Project/
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Data Preparation Tab  topic. 

Expanding the Tiles Layer: Click on the ' ' button to expand the 'Tiles' layer.  The loaded tile

shapefile will appear under this layer.  There are three ways to turn on/off the display of the file loaded

under the ‘Tiles’ layer: 1) check/uncheck the 'Tiles' layer box, 2) check/uncheck the box next to the

tile shapefile or, 3) click on the 'On' or 'Off' buttons at the top of the Table of Contents while the file is

highlighted.  Make sure the 'Tiles' layer box is checked to view the file loaded beneath it; if this

master box is not checked 'on' the file will not be displayed.

Removing the Tile File: To remove the shapefile from the Tiles layer, click on the file to highlight

(select) it.  Right-click on the file and choose 'Remove'.  Another way to remove the shapefile from the

layer is to highlight the file and click on the 'Remove'  button found at the top of the Table of Contents.
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Viewing or Editing Shapefile Attributes: To view or edit a shapefile's attribute table, click on the

shapefile in the table of contents to highlight it.  Then right-click on the shapefile and select 

'Attributes'.  The attribute table and labeling fields will appear in a new window.  It is possible to use

the attribute table to select tiles or polygons from the shapefile.  Use the 'Shift' and/or 'Ctrl' keys on

the keyboard the select the appropriate polygons/tiles.  There is a linked selection between the

polygons selected and the corresponding rows (features) in the attribute table.  Polygons or tiles

selected using the 'Pick Tiles' utility will show up as selected, or highlighted, inside the attribute table.

This linked selection also works vice versa.  The user may use the 'Shift' and 'Ctrl' keys on the

keyboard to select rows pertaining to specific tiles in the attribute table and those specified polygons/

tiles will be highlighted in the LAS Map View window. 
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It is possible to edit the attribute table of a shapefile by adding new fields, or changing

the contents of those fields.  The only exception is the 'iShape' field, which cannot be

edited.  To add a new column or field to the attribute table, click on the 'Add Field'

button at the top of the window.  The 'Add Field' window will appear and the user may

specify the restrictions of the new field. 

Creating a New Field:

1) First, give the new field a name in the 'Field Name' text box.  The attribute

table will display up to 10 characters in the column heading.

2) Then define the 'Field Type' to be used in the new column. 

3) Define the 'Width' of the column.  The width defines how many characters

will fit inside the defined field.  For example, if the user chooses a 'Width' of

20, then only twenty characters will be saved in the newly defined field.  If the
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user is creating a 'Comments' field, the width of the new field should be larger

to accommodate any needed characters for comments.  If the user is

creating a 'Date' field, which requires only ten characters at most, then the

width may be smaller.  When using the 'Logical' field type, the user-specified

width does not matter, as only one character (a check mark) is used in this

field. 

4) In the 'Number of Decimals' text box (only enabled for certain 'Field Type'

choices) the user may specify the number of decimals which will be allowed

in the newly defined field.  If the user chooses '0' then all numbers entered

into the newly created field will have to be integers. 

5) Click the 'OK' button when finished, and then click the 'Save' button in the

upper-left corner of the attribute table to make the new field permanent. 

Editing a Field:

To edit any attribute information, double-click on the appropriate attribute and

make the changes necessary.  When finished, click on the 'Save' button in the

upper-left corner to save the changed information.  The user will receive a

message confirming the data was saved inside the shapefile.  This ability may

be very useful when editing data to keep track of tiles or areas which have or

have not been edited.
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It is also possible to view the statistics of attributes in a shapefile.  The user

may view the statistics of a single attribute, the statistics of an entire row or

column, or the statistics of an entire table.  Highlight the attributes of which

statistics are to be viewed, right-click and choose 'Statistics'.  The resultant

table will tell the user the following statistics: the row count, minimum,

maximum, sum, mean (average), and median of every attribute.  To select

multiple attributes for statistic viewing at once, use the 'Shift' or 'Ctrl' keys on

the keyboard.  In the example below, the user is choosing to view the statistics

of the entire 'ALLPCOUNT' column.  The resulting statistics are also shown

below.
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Lastly, it is possible to zoom to a particular feature (row) in an attribute table. 

To use this function, highlight a row and right-click anywhere on it.  Right-click

on the 'Zoom to' option and the highlighted feature will fit to the LAS Map View

window.
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Deleting a Field:

To delete an attribute field right-click on the column heading and choose

'Remove Field'.  All information contained in this column, or attribute field, will be

lost at this time.  Click 'Save' in the upper-left to make this change permanent.
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Changing Tile Shapefile Display Properties: To change the tile shapefile properties, first expand

the 'Tiles' layer. (See the above instructions: 'Expanding the Tiles Layer'.) Left-click on the desired

file to highlight it,  then right-click and choose 'Properties'.  The GIS File Properties window will

display the full path and name of the tile shapefile, and allow the user to change the line thickness, the

outline and fill colors, the font size of the displayed label, and the labeling field (information which

comes from the shapefile's attribute table).  The user may choose whether or not to display a label by

checking or unchecking the box next to this option.  The labeling field can be changed in the 'GIS File

Properties' window, or it can be changed inside the Table of Contents.  After opening the 'Table of

Contents', right-click on the tile shapefile in question and choose 'Properties'.  Under the 'DB Field

for Labeling' drop-down box, choose 'TName' to show the tile names.  The user's preference for the

'DB Field for Labeling' option will be stored by this tool until the MARS® application is closed.  If the

'Tile Display Properties' window is re-opened, the default labeling field will reflect the most recent

selection.  The user may also choose to color fill the shapefile.  When the  'Fill' box is checked, the

transparency of the fill may be adjusted using the slider bar provided.  To force the tile shapefile to

display on top of other layers, check the 'Display On Top' box.
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Zoom to the Tile Shapefile: To zoom to the extent of the *.shp file in the 'Tiles' layer, highlight the

layer or the file and choose the 'Zoom to' button found at the top of the Table of Contents.  To zoom

to a specific tile in the shapefile, double-click within it when the cursor is in Pan  mode.825
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2.2.7 Check Points (CSVs and SHPs)

Check Points Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Check Points Layer (for *.CSV or *.SHP files) - The 'Check Points' layer allows the

loading of a check points file - in either CSV or point shapefile format - into a project.  If a shapefile is

to be used, it must  be created in MARS® using the 'Convert Check Points CSV to 3D Shapefile' tool

on the Vector Creation Tab  and it must follow the format described in the Check Point Report

topic.  This Table of Contents layer also allows the user to remove files, and view or change the

properties of the check points.  Only ONE check points file can be added into this layer at a time.  If a

second check points file is added, it will replace the current loaded one.

362 1221
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Adding a Check Points File: To add a Check Points file, see the 'Add Check Points Files' section in

the Project/Data Preparation Tab  topic.

Expanding the Check Points Layer: Click on the ' ' button to expand the 'Check Points' layer.  The

loaded check points file will appear under this layer.  There are three ways to turn on/off the display of

the file loaded under the ‘Check Points’ layer: 1) check/uncheck the 'Check Points' layer box, 2)

check/uncheck the box next to the check points file or, 3) highlight (select) the file entry and use the 

'On' or 'Off' buttons at the top of the Table of Contents.  Make sure the 'Check Points' layer box is

checked to view the file loaded in the layer; if this master box is not checked 'on' the file will not be

displayed. 

Removing the Check Points File: To remove the file from the Check Points layer, click on the file to

highlight (select) it.  Right-click on the file and choose 'Remove'. Another way to remove the check

points file  from the layer is to highlight the file and click on the 'Remove '  button at the top of the

162
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Table of Contents. 

Viewing and/or Editing Check Points Shapefile Attributes: To view a check points shapefile's

attribute table, click on the shapefile to highlight it.  Then right-click on the shapefile and select 

'Attributes'.  The attribute table and labeling fields will appear in a new window.
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While it is technically possible to modify the attribute table of a check points shapefile by

adding new fields or deleting fields, doing so may render the file incapable of being used in a

Check Point Report. 
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Editing a Field:

To edit attribute information, double-click on the appropriate attribute and make the

necessary changes.  The 'Include' boxes may be unchecked as needed to omit

certain check points from the report's calculations and results, without having to

actually remove the record(s).  The 'Z' attribute should never be changed as it

represents the actual elevation value of each check point when it was

established!  When finished, click on the 'Save' button in the upper-left corner to

save the changed information.  The user will receive a message confirming the data

was saved inside the shapefile.  Note that the 'iShape' field is internal to MARS®

and cannot be edited.

Viewing and Changing the Properties of the Check Points File: To view or change the properties

of the check points file, right-click on the file and choose 'Properties'.  The ID label of the check

points can be displayed, the font size for labels can be changed, and the display color and point size

can be modified.
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Zoom to the Check Points File: To zoom to the extent of the file in the 'Check Points' layer, highlight

the layer or the file and click the 'Zoom to' button at the top of the Table of Contents.

© 2000-2023 Merrick & Company. All Rights Reserved.
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2.2.8 Breaklines (SHPs)

Breaklines Layer

Merrick Advanced Remote Sensing (MARS
®

) Software

Breaklines Layer (for shapefiles) - The 'Breaklines' layer shows the breakline shapefiles

(.shp) that are currently loaded in MARS®, plus any breaklines being compiled ('Memory').  It also

allows the user to remove files, view or change the attributes of the breaklines, and view or change

some properties of the breaklines.  The 'Memory' entry is for turning on/off the display of compiled

breaklines before they are saved as a breakline shapefile.  Individual breakline types (codes) can be

toggled on/off using the Breaklines Window .

Adding Breaklines Files: To add a breaklines file, see the 'Add Breaklines from Shapefile' section in

142
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the Project/Data Preparation Tab  topic.  

     

Expanding the Breaklines Layer: Click on the ' ' button to expand a list of the files loaded under

the 'Breaklines' layer.  There are three ways to turn on/off the display of the file loaded under the

‘Breaklines’ layer: 1) check/uncheck the 'Breaklines' layer box, 2) check/uncheck the box next to

the breakline file(s) to be turned on/off or, 3) click on the 'On' or 'Off' buttons at the top of the Table of

Contents while the appropriate files are highlighted.  Use the 'Shift' and 'Ctrl' keys on the keyboard to

select multiple files.  Make sure the 'Breaklines' layer box is checked to view the files loaded

beneath it; if this master box is not checked 'on' the files will not be displayed.

Removing a Breakline File: To remove a file from the Breaklines layer, click on the file that is to be

removed to highlight it.  Right-click on the file and choose 'Remove' to remove only the highlighted

file.  To remove all breaklines files, right-click and choose 'Remove All' - all breaklines files currently

loaded will be unloaded.  Another way to remove data from the layer is to highlight the file that needs

to be removed, and click on the 'Remove' button found at the top of the Table of Contents.  Use the

'Shift' and 'Ctrl' keys on the keyboard to select multiple files which are to be removed.

162
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Viewing or Editing Breakline Attributes: To view a breakline shapefile's attribute table, click on the

shapefile to highlight it.  Then right-click on the shapefile and select 'Attributes'.  The attribute table

and labeling fields will appear in a new window.  It is possible to use the attribute table to select tiles or

polygons from the shapefile.  Use the 'Shift' and/or 'Ctrl' keys on the keyboard the select the

appropriate polygons.  This useful tool can be used vice versa, polygons or tiles selected using the '

Pick Tiles'  utility will show up as selected inside the respected attribute table.  To edit the

attributes, double-click on the appropriate attribute and make the needed changes.  Click on the 'Save'

button in the upper-left corner to save the file. The 'iShape' field cannot be edited.

959
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MARS® v2023.1           User Manual138

© 2000-2023 Merrick & Company

It is also possible to view the statistics of breakline attributes in a shapefile.  The user

may view the statistics of a single attribute, the statistics of an entire row or column, or

the statistics of an entire table. Highlight the attributes of which statistics are to be

viewed, right-click and choose 'Statistics'.  The resultant table will tell the user the

following statistics: the row count, minimum, maximum, sum, mean (average), median,

and mode of every attribute.  To select multiple attributes for statistic viewing at once,

use the 'Shift' or 'Ctrl' keys on the keyboard.  In practical use, the 'CODE' field is the

only useful attribute in a breakline shapefile, and the statistics that might be helpful

include 'Row Count', 'Min', 'Max', and 'Mode'.  In the example below, the user is choosing

to view the statistics of an entire row.  In the example below, the user is choosing to

view the statistics of the entire 'CODE' column.  An example of a resulting statistics

window is also shown below.
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Lastly, it is possible to zoom to a particular feature (row) in an attribute table. 

To use this function, highlight a row and right-click anywhere on it.  Right-click

on the 'Zoom to' option and the highlighted feature will fit to the LAS Map View
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window.

Changing Shapefile Display Properties: To change the breakline shapefile feature labeling

properties, left-click on the chosen file to highlight it.  Then, right-click and choose 'Properties'.  The

labeling field, font size, and the status of the 'Display Label' checkbox can now be changed through the

dialog that appears.  Other properties, such as line style, line thickness (weight), and color can be

changed using the 'Breakline Properties' tool on the Breaklines Tab .295
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Zoom to a Breakline Shapefile: To zoom to a *.shp file in the 'Breaklines' layer, highlight the file

and choose the 'Zoom to' button found at the top of the table of contents.  Use the 'Shift' and 'Ctrl'

keys on the keyboard to zoom to multiple files at a time.  This function will not work on breaklines

saved to memory. 
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2.3 Breaklines Window

Breaklines Window

Merrick Advanced Remote Sensing (MARS
®

) Software

The Breaklines window allows the user to quickly and easily access control over the color, Z mode, and

display of individual breakline feature types. To access the Breaklines window, choose the ‘Breaklines’

tab at the top of the Table of Contents .

After choosing the ‘Breaklines’ tab, a list of the breakline types (feature names) currently defined in the

Breakline Properties will become available in place of the layers in the Table of Contents area. The

display of individual features can be controlled by checking or unchecking the boxes.

64
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To make any changes to the breakline features listed in the window, right-click on any one of the

features and choose 'Edit'.  The 'Breakline Properties' interface will open. With this interface, the user

may change the display thickness (weight) and color of the features, change, add, or delete feature

names, or change the tolerance, ZMode, or style of any of the breakline features.  Many other

parameters are also available to be edited in this interface.  Please see the 'Breakline Properties' section

of the Breaklines Tab  topic for details.

When any changes are made to the breakline features in the 'Breakline Properties' interface, the change

will automatically be reflected in the Breaklines window. The example below shows the addition of a

breakline feature. The corresponding screen shot then shows those changes automatically updated in

the Breaklines window. 

In the example below, 'Sample Feature' has been added to the break line feature list.

295
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The changes made above have been reflected in the Break lines window.

  

© 2000-2023 Merrick & Company. All Rights Reserved.
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2.4 LAS Map View Window

LAS Map View Window

Merrick Advanced Remote Sensing (MARS
®

) Software

The LAS Map View window is where all data loaded into MARS® and checked on in the Table of

Contents  will be displayed.  Its width can be re-sized by dragging the separator line between it and

the Table of Contents left or right.  The window is identified by a tab at its upper-left corner labeled 'LAS

Map View.'

MARS® supports drag-and-drop from Windows File Explorer for LAS files, SHP files (loaded in

the Reference Shapefiles layer), CSV-format Check Points files, and supported raster formats. 

Files can be dropped into the LAS Map View window or the Table of Contents window.

64
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2.5 Cross-Section/Profile Window

Cross-Section/Profile Window

Merrick Advanced Remote Sensing (MARS
®

) Software

The Cross-Section/Profile window will appear any time either the 'Place Cross-Section/Profile Line' or

'Place Adjustable Cross-Section/Profile Line' tools are used.  These buttons are found on the Cross-

Section/Profile Tab .  The window may be undocked by right-clicking on its tab (yellow area at upper-

left of image, below) and choosing 'Float.'  The window may then be dragged by its title bar to any

location, including a second monitor.  To re-dock, right-click on the title bar and choose 'Dock as

Tabbed Document.'  An optional edit toolbar can be enabled at the top of the window by checking the

238
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'Show toolbar in cross-section window' box in the 'Miscellaneous Options' interface on the Options Tab

.  This makes it easier to access the most commonly used tools without having to keep the 'Cross-

Section/Profile Tab' active.

The Edit Toolbar: 

 Cut Area Depth: The current cut depth will be displayed on the edit toolbar in the

cross-section/profile window. This tool is for informative purposes only. To change the default

depth of the 'Place Cross-Section Line' tool, go to the 'Miscellaneous Options' interface on

the Options Tab  and make the appropriate changes in the 'Cross-Section/Profile Window'

section. To change the current depth of the cross-section/profiling tool without changing the

default value, enter the new value in the text box for 'Current Depth' on the Cross-Section/Profile

Tab  or use the shortcut key 'D' on the keyboard.

 Show Scale Bar: Toggles the display of the Elevation scale bar in the Cross-Section/Profile

window on/off. The values shown (along the left side) are in the loaded data's vertical units.

Clicking in the  Cross-Section/Profile window will cause a label to be displayed showing the

518
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cursor's elevation.

 Source Classification: This allows the user to pick from ALL

classes, a selected set of classes (see below), or any one of the 256 individual LiDAR classes

to be the source class(es) for manual editing actions. During editing, the source class(es) will

become re-classified to the target class.

Edit Selected Set: This function allows the user to make a selected set comprised of any

combination of LiDAR classes to be used when the '- Selected -' option is chosen in the 'From

Class' drop-down list.

 Target Classification: This allows the user to pick from any one of

the 256 individual LiDAR classes to be the target class for manual editing actions. During

editing, the source class(es) will become re-classified to the target class.

 Keep Profile Centered: This tool keeps data centered vertically in the cross-section/profile

window by estimating a ground elevation and automatically adjusting the window to center that

elevation.  In steep terrain or near tall buildings this feature can produce unexpected results.  To

shut this off and allow the cross-section/profile to move without automatic centering, click the

'Keep Profile Centered' button to toggle it off.  When the 'Keep Profile Centered' tool is not

active, the cross-section/profile window can be dragged with the 'Pan'  tool to the

user's area of interest.
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 Edit Paint Small: Reclassifies points (referenced in the 'From' drop-down list) selected by the

small paint brush in the Cross-Section/Profile window.  Drag the cursor box over the desired

points and they will turn white.  To commit them to the target class, press the 'Space Bar' or

'Enter' key on the keyboard.  To cancel and unselect the points, right-click the mouse.

 Edit Paint Medium: Reclassifies points (referenced in the 'From' drop-down list) selected by the

medium paint brush in the Cross-Section/Profile window. Drag the cursor box over the desired

points and they will turn white.  To commit them to the target class, press the 'Space Bar' or

'Enter' key on the keyboard.  To cancel and unselect the points, right-click the mouse.

 Edit Paint Large: Reclassifies points (referenced in the 'From' drop-down list) selected by the

large paint brush in the Cross-Section/Profile window.  Drag the cursor box over the desired

points and they will turn white.  To commit them to the target class, press the 'Space Bar' or

'Enter' key on the keyboard.  To cancel and unselect the points, right-click the mouse.

 Edit Line String Above: Reclassifies all points (referenced in the 'From' drop-down list) above a

user-drawn vector in the Cross-Section/Profile window only.

 Edit Line String Below: Reclassifies all points (referenced in the 'From' drop-down list) below a

user-drawn vector in the Cross-Section/Profile window only.

 Edit Scrape Above: Reclassifies all points (referenced in the 'From' drop-down list) above the

scrape tool cursor in the Cross-Section/Profile window only.
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 Edit Scrape Below: Reclassifies all points (referenced in the 'From' drop-down list) below the

scrape tool cursor in the Cross-Section/Profile window only.

  Undo/Redo: These buttons allow the user to undo or redo manual edits made in the cross-

section/profile window or the LAS Map View window.

 Profile Combined: Displays a combined single line profile of all points for the displayed

collection scans.

 Profile by Collection Scan (not available with Evaluation license): Displays a profile line for

each displayed collection scan.

 Cross Section: Displays a cross-section view of the LiDAR points for the displayed collection

scans.

 Save Profile Line: This tool can create either a 3D shapefile, or a CSV file of XYZ values, for a

combined profile (see above).  The output file will be created from whatever profile is currently

shown in the Cross-Section/Profile window.  When a profile line shapefile is saved, a *.prj

(projection definition file) is created if the projection information is known for the source LAS

data.  For shapefile output, the resulting shapefile can be loaded back into MARS® using the

'Add Reference Shapefiles' button on the Project/Data Preparation Tab , and displayed in 3D

View .  For CSV output, the resulting file of XYZ values can be opened in Excel.  This tool is

only available when the profile is rendered with the 'Profile Combined' button .  For more

information on the 'Profile Combined' tool, please visit the Cross-Section/Profile Tab  topic.

162
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In the example below, the resultant 3D shapefile has been loaded into MARS® as a reference

shapefile. It is shown below in 3D as the black  line which profiles two of the four large buildings

shown.
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 Inspect: This tool allows individual inspection of LiDAR points in the Cross-Section/Profile

window.  See the Inspect  tool topic for details.

 Measure: This tool makes measurements in the Cross-Section/Profile window based on the

project’s data units.  See the Measure  tool topic for details.

 Vertical Scale Slider Bar: This vertical scale

slider is only for use with cross-sections and profiles, and is synchronized with the vertical slider

on the Cross-Section/Profile Tab .  It can exaggerate or smooth the vertical data shown by

943
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using the slider or by entering the desired scale factor in the scale text box between the label

and the slider bar.  The minimum value is 0.01 and the maximum is 1000.  To return to the

data's true scale, click the  button, or slide the bar until the exaggeration is shown to be 1.0

as in the example below. 

See three examples of the Vertical Scale Slider working inside the Cross-Section/

Profile window below:

 Notice the vertical exaggeration is at

1x - the true scale (1.0).
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 Notice the vertical exaggeration is at 5.66

times the true scale.

 Notice the vertical exaggeration is at 0.51

times the true scale.
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2.6 Overview Window

Overview Window

Merrick Advanced Remote Sensing (MARS
®

) Software

The Overview window is located in the lower-left corner of the MARS® interface (as seen below), and is

identified by a tab in its upper-left corner labeled 'Overview.'  It provides a locator function by

superimposing a  LAS Map View  window extent box (white color) over a snapshot of the loaded

LiDAR data (rendered by elevation).  It can also be used as a simple navigation tool (panning only), by

left-clicking and dragging the white extent box to a new location.  The LiDAR graphics can be turned off

by unchecking the box labeled 'Display LiDAR graphics in Overview window' found in the 'Miscellaneous

Options' interface on the Options Tab .  The window can be re-sized vertically by dragging the

separator line between it and the Table of Contents  window up or down.  The Overview window's width

will be the same as the width of the Table of Contents.  Note that regardless of the Bit Flag Display

Settings , points flagged as Withheld will not be displayed in this window.
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The shape and position of the LAS Map View extent box will change as the user pans, zooms in/out,

pans, or forces a Fit to View .  See the examples below:

After panning to the

southwest:

                  

822
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After
zooming in:
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2.7 Status Bar

Status Bar

Merrick Advanced Remote Sensing (MARS
®

) Software

The Status Bar: 

The Status Bar has several sections that can display the scale of viewing extent, percentage of points

(density) being displayed at a given zoom level, progress of a particular operation, the step number and

description of a filter within a batch script -- OR -- number of tiles picked out of total number of tiles,

the status of 'Fast TIN' and 'Measure Tool Snapping' options, and the X and Y coordinates of the cursor

location in the LAS Map View window.  NOTE that the scale display (far left on the Status Bar) my not

be displayed when remoting in to a computer running MARS®, depending on the type of remote

display adapter being used.

© 2000-2023 Merrick & Company. All Rights Reserved.

3 Tab and Ribbon Layout

Tab and Ribbon Layout
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Merrick Advanced Remote Sensing (MARS
®

) Software

Overview of the Tab layout:

Note:  The Quick Access Toolbar  can be located above (default position) or below the ribbon.

To minimize the ribbon and show only the tabs, right-click anywhere on it and choose 'Minimize the

Ribbon.'  In this mode, choosing a tab will present the ribbon temporarily until a button is clicked on it, or

until clicking away from the ribbon.

To restore the ribbon back to its full size, right-click on it and choose 'Minimize the Ribbon' again.

Detailed information about the individual tabs can be found by following these links:

File  - Project/Data Preparation  - View  - Navigation  - Cross-Section/Profile  - Coordinate

Conversion  - Edit/Filter  - Breaklines  - Vector Creation  - Tools  - QA/QC  - Export/

Extract  - Analysis  - Custom  - Options  - Help

© 2000-2023 Merrick & Company. All Rights Reserved.
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3.1 File Tab

File Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The File Tab:

New: The user can open a new MARS® document by clicking on this option. MARS® will open only

one project document per application. If the user needs to have more than one MARS® project

document open at a given time, an additional session of MARS® will need to be started. The hot key

combination associated with starting a new MARS® document is Ctrl+N. If a MARS® project is open

at the time a new document is started, MARS® will prompt the user to save the open project

document before closing it and bringing up a new, empty document window.

Open: The user can load an existing MARS® Project Document (*.mpd) by clicking on this option.
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The hot key combination associated with opening a MARS® project is Ctrl+O. If a MARS® project is

already open at the time this command is used, MARS® will prompt the user to save the open

project document before closing it and opening another one. To load data (rather than a project

document), see the Project/Data Preparation Tab .

Save: The user can save any open project as a MARS® Project Document (*.mpd) by choosing the

'Save' option or by using the hot key combination Ctrl+S. If the project has not been previously

saved, the user will be prompted to give the file a name. If the file has been saved previously,

choosing the 'Save' option will overwrite the original file. Projects are saved with relative paths to the

loaded layers.  Additional information that is stored in the .mpd includes: the current rendering

method (elevation, class, intensity, etc.), the current settings for the Classification Display Settings

interface (colors, descriptions, Point/TIN rendering, which classes are being displayed, etc.), the

LAS Map View window extent, the 'Data Layer' properties (CRS info), the ‘From Class’ and ‘To

Class’ settings on the Edit/Filter Tab , and any Bookmarks that were created.

Save As: By choosing the 'Save As' option, the user can choose a new path and file name for the

open project. Using 'Save As' avoids overwriting an original project document. Projects are saved

with relative paths to the loaded layers.

Exit: Choosing the 'Exit' option on the File tab will prompt the user to save changes and then close

the MARS® application.

© 2000-2023 Merrick & Company. All Rights Reserved.
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3.2 Project/Data Preparation Tab

Project/Data Preparation Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Project/Data Preparation Tab:

Add LAS Files: Beginning with version 2018.0 of MARS®, there are minimum requirements for any

LAS files being loaded in the Table of Contents, or pathed out for processing with any of the

standalone tools where LAS data does not need to be loaded first.  A 'permission to up-convert'

prompt will appear if the LAS data does not meet these minimums.  The LAS requirements are:

LAS version 1.4 with Point Data Record Format (PDRF) 6, 7, or 8 -- version 1.0 through 1.3

(PDRFs 0-3) will be up-converted to version 1.4, PDRF 6 or 7, depending on its current

version/PDRF.

16-bit (native or normalized) Intensity values -- 8-bit or 12-bit values will be normalized to 16-bit

during up-conversion.

16-bit (native or normalized) RGB(N) values, if the data is in PDRF 7 or 8 and these values are

present in the data -- 8-bit or 12-bit values will be normalized to 16-bit during up-conversion.

Coordinate Reference System (CRS) info, if present, written as Well-Known Text (WKT) tags

-- older, readable GeoTIFF-style CRS info will be re-written as WKT during up-conversion.

Extended Variable Length Record (EVLR) format for any existing variable length records --

Variable Length Records (VLRs) will be re-written as EVLRs during up-conversion.



Tab and Ribbon Layout 163

© 2000-2023 Merrick & Company

The only exception to the minimum requirements is when running the USGS 1.0 QC Module , which

can test older version (LAS v1.0 through v1.3) data.

NOTE: If any of the files to be loaded do not meet the minimum requirements for MARS® (as detailed

in the example interface graphics below), a prompt will appear requesting permission to up-convert the

files.

  

1465
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A 'No' answer to this prompt will close the interface without converting or adding any files, even ones

that may already be fully compliant.  It is expected that all files selected for loading will share the

same LAS version and characteristics.

A 'Yes' response will bring up the LAS Up-Conversion tool interface.  This tool has several options

including: 1) output to a different folder than the files currently reside in, 2) bit flag mapping to convert

user-defined classes of points to any of the four changeable bit flags used in version 1.4 LAS files - 

Synthetic, Key-point (also referred to as Model Key-point), Withheld, and Overlap, and 3)

assignment of a WKT tag for Coordinate Reference System definition.  Existing bit flags (except, in

some cases, the v1.4-only Overlap flag) can be carried over from the files being converted, or a class

or classes can be specified that represented the bit flag types in older version files.

NOTE that when the LAS Up-Conversion interface appears as the result of running certain tools and

functions that don't require LAS files to be loaded in MARS®, the particular tool will dictate whether

the Bit Flag Mapping and/or WKT tabs are available.  For example, when using the 'Add CRS Info'
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tool with input data that is not yet MARS®-compliant, the permission window shown above will appear

when the 'Run' button is clicked.  If 'Yes' is clicked, the LAS Up-Conversion interface that opens will

not have the WKT tab because the coordinate reference system entry hase already been defined in

the 'Add CRS Info' tool.

On the 'Input Files / Output Folder' tab, navigate to the files to be up-converted using either the 'Add' or

'Add From Folder' button.  Individual files can be cleared from the input list by highlighting the

appropriate file and clicking the 'Remove Selected' button, or the entire list can be cleared by clicking

the 'Remove All' button.  The input files will be overwritten unless an Output Folder is selected.

On the 'Bit Flag Mapping' tab, check the boxes in the left column for any bit flag types that need to

exist in the up-converted files.  If the existing files have bit flags set for Synthetic (rare), Model Key-

point, and/or Withheld, select the appropriate 'Use bit flag' radio buttons to carry over the bit flag

status.  Otherwise, keep the default 'Use Classes' radio buttons selected and use the 'Select'

buttons in the 'Source' section to choose one or more classes in the existing files that are



MARS® v2023.1           User Manual166

© 2000-2023 Merrick & Company

representing a bit flag type.  The pre-populated 'Source' classes were chosen as defaults because

they are commonly used in LAS files older than version 1.4.  Optionally, a new 'Target Class' can be

selected for the points once their bit flags are set.  Class 2 is the default 'Target Class' for Model

Key-point since it is a sub-set of ground (which is typically stored as Class 2).

For the 'WKT' tab, any existing Coordinate Reference System information that is readable will be

shown as a WKT format tag which can then be edited for correctness and/or completeness.
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The tool can be multi-threaded ('Number of threads to use ') for faster processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.  When all settings have been made, click 'Run' to start the up-conversion and load the files,

or 'Cancel' to dismiss the interface without modifying or loading any files.  This tool can also be run

on known non-MARS®-compliant LAS data before attempting to load it (see 'LAS Up-Conversion' on

the Tools Tab ).

For files that do not need to be up-converted, there are four (4) tools to determine, set, and clear

various bit flags found under the 'Bit Flag Settings' drop-down on the Tools Tab .  There is also a

tool to add or edit coordinate reference system information in WKT format - see the Add CRS Info

sub-topic in the Coordinate Conversion Tab  section of the help file.

LAS data that meets all the minimum requirements except the one for EVLRs will trigger a simpler up-

390
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conversion prompt:

 

Clicking the upper-half of the button  will present a standard Windows 'Open' interface to

load one or more LAS files using established Windows selection methods - click, Ctrl-click, Shift-

click, Ctrl-A, etc.  All LAS files added will be found under the LAS  layer in the Table of Contents

.  The loaded LiDAR data may be viewed in either 2D View  mode or 3D View  mode in the

LAS Map View window.

Note: If any of the files to be loaded do not meet the minimum requirements for MARS® (as

described above ), a prompt will appear requesting permission to up-convert the files.

Add LAS Files | From Folder: Clicking the lower-half of the button and choosing the 'From Folder'

option will open a window to load an entire folder of LAS files and, optionally, its sub-folders.  All LAS

files included in the folder(s) chosen will be loaded into MARS®.  Any LAS files added will be found

under the LAS  layer in the Table of Contents .  The loaded LiDAR data may be viewed in either

2D View  mode or 3D View  mode in the LAS Map View window.
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Note: If any of the files to be loaded do not meet the minimum requirements for MARS® (as

described above ), a prompt will appear requesting permission to up-convert the files.

Add LAS Files | From Selected Tiles: Clicking the lower-half of the button and choosing the 'From

Selected Tiles' option will allow the user to load LAS files based on tiles selected from a loaded

shapefile tile layout.  Matching LAS files in the chosen directory will be loaded into MARS® and any

LAS files added will be found under the LAS  layer in the Table of Contents .  For example, if

tiles with 'TNAME' attribute field values of '11', '12', and '15' have been selected using the 'Pick Tiles'

tool (see below), and LAS files with those names exist in the chosen LAS Directory (as shown below),

then only those files will be loaded.  The selection made for the 'DB Field for File Name' option will be

stored by this tool until the MARS® application is closed.  The loaded LiDAR data may be viewed in

either 2D View  mode or 3D View  mode in the  LAS Map View window.
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Note: If any of the files to be loaded do not meet the minimum requirements for MARS® (as

described above ), a prompt will appear requesting permission to up-convert the files.

Add Float Grid: This button will present a standard Windows 'Open' interface to load float grids (*.flt)

into MARS®.  Click the 'Add Float Grid' button and then navigate to the location of the float grid(s) to

be loaded.  Select the desired float grid(s) and choose 'Open' to load into MARS®.  The loaded float

grid(s) may be viewed in either 2D View  mode or 3D View  mode in the LAS Map View window.

Any float grid(s) added will be found under the Float Grids  layer in the Table of Contents .

163
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Add GeoPackages: This button will present a standard Windows 'Open' interface to load a

GeoPackage file (*.gpkg) as a reference vector layer.  GeoPackage is an open format for storing and

transforming geospatial information (via  an SQLite database) that can incorporate point, line, and

polygon vector data, as well as attribute data, metadata, and tile data (rasters).  At this time,

metadata and tile data are not yet supported in MARS®.  The most recent version of GeoPackage is

1.3.1 as of the MARS® v2023.1 release date.

 

Add Images: Clicking the upper-half of the button  will present a standard Windows 'Open'

interface to load any supported images (raster files) using standard Windows selection methods -

click, Ctrl-click, or Shift-click.  Supported raster types are: ECW (Hexagon-Intergraph), JPG, IMG

(Hexagon-ERDAS), TIFF, DAT (ENVI Hyperspectral), NITF (USDoD), JP2, SID (LizardTech), and

PNG.  Any images added will be found under the Rasters  layer in the Table of Contents .

Add Images | From Folder: Clicking the lower-half of the button and choosing 'From Folder' will open

a window to load an entire folder of images and, optionally, its sub-folders.  All images included in the

folder(s) chosen will be loaded into MARS®.  Any images added will be found under the Rasters

layer in the Table of Contents .

                                  

83 64

83

64



MARS® v2023.1           User Manual172

© 2000-2023 Merrick & Company

Add WMS Images: Clicking the 'Add WMS Images' button will open a window to load an image from

a WMS server (Internet or network connection required).  Any images loaded will be found under the 

WMS Images  layer in the Table of Contents .

NOTE:  Availability of any WMS resources included with MARS® or referenced here  is subject to

change without notice.  None of these services is endorsed, provided, or otherwise guaranteed to be

functional by Merrick & Company.  Merrick neither hosts nor maintains any WMS (Web Map Service)

image layer sources and is therefore not responsible for the completeness, accuracy, or frequency of

updates of any WMS sources that may be accessed from within the MARS® program.

Add Tile Shapefile: This button will present a standard Windows 'Open' interface to load any

polygonal tile shapefile.  Only Esri compatible *.shp files can be loaded as tile layouts.  Any tile

shapefile added will be found under the Tiles  layer in the Table of Contents , but only one tile

layout can be loaded at a time (other layouts may be added as Reference Shapefiles, see below). 

Tools such as Jump to Tile  and 'Pick Tiles' (see below) will only work on shapefiles loaded under

the Tiles  layer in the Table of Contents .  When a shapefile is added to the 'Tiles' layer, MARS®

will check and silently remove it first from the 'Reference Shapefiles' or 'Breaklines' layers if the same

path/file exists in either of those layers.

Add Reference Shapefiles: This tool will present a standard Windows 'Open' interface to load

shapefiles as reference data under the 'Reference Shapefiles' sub-layer of the Vectors  layer in the

87 64
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Table of Contents .  Reference shapefiles can be point, polyline, or polygon geometry.  Click the

'Add Reference Shapefiles' button and then navigate to the location of the shapefile(s) to be loaded. 

Select the desired shapefile(s) and choose 'Open' to load into MARS®.  This tool also allows the user

to load breakline shapefiles, although they cannot be edited and will not modify the loaded surface or

any exports when added this way.  They can, however, be used as a 'target' for snapping new and

existing true breakline features.

Add File GDB: This tool allows the user to load Esri v10.0 or later File GeoDatabases as reference

data.  Any feature classes loaded will be found under the 'File GeoDatabases' sub-layer of the Vectors

 layer in the Table of Contents .  Personal GeoDatabases are not supported in MARS®.  All

Feature Classes found in the File GeoDatabase - whether inside of or outside of a Feature Dataset -

will be loaded.  The data is for reference only, and cannot be edited within MARS®.  Features must be

in 2D - no 'M' or 'Z' values present.  Click the 'Add File GDB' button and then navigate to the location of

the File GeoDatabase to be loaded.  Select it, click 'OK', and click 'OK' again in the 'Select

Geodatabase' window to finish the process.

Add Breaklines from Shapefile: This tool allows the user to load breakline shapefiles into MARS®

under the Breaklines  layer in the Table of Contents .  The 'Add Breaklines from Shapefile'

window also gives the user the option to load the breaklines as a reference breakline shapefile rather

than a standard breaklines shapefile.  When loaded as reference, these breaklines cannot be edited
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and will not affect grid and contour exports.  To use this option, make sure the 'As Reference

Breaklines' box is checked.  The 'Point Delete Buffer' is set to '5' units by default, but may be modified

for each breakline shapefile loaded.  This value will be stored as a 'virtual' attribute to be honored when

the 'Reassess Points for Delete Classification' tool is used (Breaklines Tab ).

Breaklines loaded as reference files do not need the accompanying LiDAR data to be viewed in the

Cross-Section/Profile window.  If a breakline file is loaded as a reference file, its symbol will be shown

in neon green in the Table of Contents.  If the file is marked with a neon green line, this file is loaded

as a polyline reference file.  If the file is marked with a neon green box, this file is loaded as a polygon

reference file. 

Add Check Points Files: This button will present a standard Windows 'Open' interface to load either a

CSV-format or SHP-format (shapefile) check points file.  CSV or SHP files added using this option will

be found under the Check Points  layer in the Table of Contents .  Only a single check points file

can be loaded at any time.

Add EO File: This button allows the user to load one or more EO, or Exterior Orientation, files into

MARS®.  This tool adds point shapefile (*.shp) or text (*.txt) files only.  Added files will appear under

the 'EO Files' sub-layer of the Vectors  layer in the Table of Contents .  The tool is meant for use
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with the Hyperlink  tool which may be found on the View Tab .  The purpose of the 'Hyperlink'

tool is to display the imagery associated with each event in the EO file(s).  To use this tool, first an

EO file must be loaded into MARS®.  The user may add a shapefile or text file by choosing the

appropriate file type in the 'Input EO File Format' section.  Depending on the choice made, either the

'Input Original EO File' or the 'Input EO Shapefile' section will become available to specify the location

of the desired EO file.  Under the 'Image Parameters' section, navigate to the folder with the

associated JPEG (*.jpg) or TIFF (*.tif) image files.  Be sure to designate the image file extension type

in the drop-down box next to 'Image File Extension'. 

The EO file is displayed as a 3D point shapefile (even when a TXT file is loaded) and each point, or

event, in the file is associated with imagery.  Because it is displayed as a shapefile, it is also

possible to change the display settings of each EO file by right-clicking on the file inside the Table

of Contents  and choosing 'Properties'.  The resulting 'EO File Properties' window will allow the

user to change the color and size of the point shapefile and will also allow the user to display

labels. 

192
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A text (*.txt) format EO file may be exported to a point shapefile by right-clicking on the entry in the 

Table of Contents  and choosing 'Export to shapefile.'  In the resulting dialog box, choose the

desired path and file name, then click 'Save.'

To remove an EO file from the Table of Contents , right-click on it and choose 'Remove'.

Pick Tiles: This tool is used to select a single tile or multiple tiles for Project/Data Preparation ,

Export/Extract , or Edit/Filter  activities.  This tool is inactive until a polygonal shapefile (ex. a tile

layout) is loaded into MARS®.  The 'Pick Tiles' tool will only work on data loaded as a tile shapefile.

See the 'Add Tile Shapefile' section of the Project/Data Preparation Tab  topic for information on

loading a tile layout. This tool works only in 2D View . 

The 'Pick Tiles' tool allows the user to load a tile layout shapefile and then select a single tile or

multiple tiles to be processed.  The selected tiles will then appear selected in the attribute table

representing the shapefile.  To view the attribute file, right-click on the file in the 'Tiles' layer of the Table

of Contents  and choose 'Attributes'.  Conversely, it is possible to use the attribute table to select

tiles from the shapefile.  Use the 'Shift' and/or 'Ctrl' keys on the keyboard to select the appropriate tile

(s).  The selected tile(s) will then appear selected in the LAS Map View window on the tile layout itself.

64
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'Pick Tiles': To use the 'Pick Tiles' tool, select the  button. Move the cursor over tiles to be

exported and left-click.  Using the tool, draw a box over many tiles and they all will be selected, or use

the 'Ctrl' key on the keyboard to select single tiles without losing the ones already selected. 

The above image shows an example of three selected tiles, which are outlined in bold. MARS® will

keep a count of the tiles being chosen and the total number of tiles in the tile layout and display them

as a ratio. Please see the screen shot of the Status Bar  below:

The following image displays the selected tiles and tile names.  To see the tile name attributes, right-

click on the file in the Table of Contents  and select 'Properties', then choose the appropriate name

attribute (ex. TName) in the 'DB Field for Labeling' drop-down box.  Check the box which says 'Display

Label', change the 'Font Size' if desired, and click 'OK'.  The labels will be displayed in the same color

158
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as the tile outlines, and the selected tiles will remain outlined in bold.  The user's preference for the 'DB

Field for Labeling' option will be stored by this tool until the MARS® application is closed.  The field

chosen will be synced with the same parameter in the 'Load LAS Files on Selected Tiles' option when

adding LAS data.  To read more concerning the 'Add LAS Files on Selected Tiles' option, please view

the Project/Data Preparation Tab  topic.  Once the desired tiles are selected, they can also be

exported by clicking the 'Export' button on the Export/Extract Tab .

 

Tile Selection Methods

Individual: To select an individual tile, use the ‘Pick Tiles’ tool to click on the desired tile.

Multiple: To select multiple tiles, depress the CTRL key and use the ‘Pick Tiles’ tool to choose

the desired tiles.

Drag Box: For large areas, use the ‘Pick Tiles’ tool to click and drag a box.  All tiles touched by

the drag box will be selected.  Additional tiles can be added to the selection set by holding down

the CTRL key and clicking within the desired tile(s).

162
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To unselect tiles: In some cases, it may be easier to use the drag box to select a large area of

tiles and unselect the few that are not needed.  To unselect tiles, make sure the 'Pick Tiles'

button is active, then hold the 'Ctrl' button on the keyboard and click individually on the tiles to

be unselected.  To unselect all tiles, click outside of any tiles while the 'Pick Tiles' button is

active.

Add Spatial Index: This tool performs a spatial index on one or more LAS files to enable MARS® to

read and display the point data.  It can add spatial index information, remove it, or mark any existing

spatial index records as superseded.  Either of the last two uses may be necessary for using the files

in other software.

NOTE:  For best stability and faster performance, LAS files that have been spatially indexed in an

older version (v2019.3 or earlier) should be re-indexed using version 2020.0 or later of MARS®.

This can be done quickly in two steps using the multi-threaded 'Add Spatial Index' tool - the 'Fast

Remove Index' option followed by the 'Add Spatial Index' option.  See the paragraph immediately

before the screen shot of the tool interface for more information.  Also note that issues may occur

with LAS files if they are spatially indexed in a newer version of MARS® and then have their

index records removed in an older version.

Using the Add Spatial Index interface - This method will modify the LAS files when spatial index

information is added, removed, or superseded.

Navigate to the files to be processed by clicking on the 'Add' button.  Files may be

removed from the list by highlighting them and clicking on the 'Remove Selected' or

'Remove All' buttons.

If adding spatial indexing. choose one of the 'Collection scan options':
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Incremental: Assigns sequential collection scan numbers to each LAS

file in the list to be spatially indexed.  Using this option will overwrite any

existing collection scan numbering in the LAS files.  Enter the desired

starting number in the 'Starting collection scan number' text box, keeping

in mind that LAS version 1.4 files are limited to collection scan numbers of

1 to 65,535.  If multi-channel files are being processed, check the 'Group

Multi-Channel LAS files (one number per group)' box to have the same

collection scan number assigned to each file in the group.  The tool

requires that files in a multi-channel group be named identically

starting with the letter 'L' except for a unique digit denoting the

channel number following the mandatory letter 'C' - for example, 'L1-

1-140324_A-C1_r.las and 'L1-1-140324_A-C2_r.las' - for this collection

scan numbering method to work.

No Assign - Keep the collection scan number of every point: No

changes are made to collection scan numbering that may exist in the LAS

files.  This is the default.

Set all files to one collection scan number: Assigns only one

collection scan number to all listed files.  This option will overwrite any

existing collection scan numbering in the LAS files.  Enter the desired

number in the 'Starting collection scan number' text box, keeping in mind

that LAS version 1.4 files are limited to collection scan numbers of 1 to

65,535.

WKT: This area shows any existing WKT-based coordinate reference system

definition for the added files and allows the information to be edited.  Changes made

here will be applied only when adding spatial indexing.  See the procedure outlined in

the 'Add CRS Info (to LAS Files)' topic in the Coordinate Conversion  section of252
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this help file for details.

Multi-Threading: The 'Add Spatial Index' tool is capable of multi-threading the indexing

process.  To multi-thread (which may shorten the processing time), enter the desired

number of threads up to the maximum available for the computer in the text box.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not

just installed) per thread.  Multi-threading the Spatial Indexing functions across a

USB 2.0 connection is not recommended as the intensive file reads/writes (disk I/O)

may cause hangs or slower overall performance than single-threading.  USB 3.0 or

later can be used, but may be limited in performance depending on the access speed

of the external drive.

Class options: This option allows a second spatial index to be created based on all

classes EXCEPT the one(s) listed in the 'Majority Classes' box.  Click the 'Select'

button to choose the desired majority classes.  When one or more of the chosen

classes are turned off using the Classification   button on the

View Tab , performance is increased during display-related operations such as pan

and zoom.  In addition, a higher percentage of the available point cloud will be

displayed for a given window extent.  If more than one class was chosen as a

majority class during 'Add Spatial Index', the performance boost will be highest when

all majority classes are turned off.

VLR/EVLR options: The 'Remove all VLRs/EVLRs before spatial indexing' option

(unchecked by default) can be used to completely remove all Variable Length and/or

Extended Variable Length Records (not just indexing records) from the LAS files

listed in the 'Files to spatial index' box during the 'Add Spatial Index' process.  This

function works only when adding indexing, not when using the 'Remove Spatial Index'

or 'Fast Remove Index' buttons.

Note:  All files will be tested for empty 'System Identifier' header fields and, if found,

192
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will have this field populated with 'OTHER' (see the LAS file specifications on the 

ASPRS LAS File Format website).  Files with values already in place will not have

this field modified.

Click 'Add Spatial Index' to index the data, or 'Remove Spatial Index' to delete any

existing spatial index records.  Removal will make LAS file sizes a little smaller, but

will cause the files to be unloadable in future MARS sessions unless they are re-

indexed.  The 'Fast Remove Index' button will mark all indexing records as

superseded (ignored) without actually deleting them.  As with complete removal, this

makes the files unreadable in future MARS sessions unless they are re-indexed, but

the re-indexing process will be much faster.  Either of the removal options may be

helpful in loading data into other lidar software.  Neither the 'Remove Spatial Index'

function nor the 'Fast Remove Index' function will make any changes to collection

scan numbering.

https://www.asprs.org/committee-general/laser-las-file-format-exchange-activities.html
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When 'Add Spatial Index', 'Remove Spatial Index', or 'Fast Remove Index' is

successfully completed, MARS® will alert the user with the following messages:
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Clicking the 'Clear' button near the bottom of the interface will empty the 'Status' area so

that more files can be spatially indexed.

Convert: This tool is used to translate elevation data files to the LAS file format, which MARS®

natively supports.  Specifically, MARS® is capable of converting ASCII Text files (*.txt, *.dat, *.csv,

*.xyz, *.grd),  Esri ASCII Grids (*.asc), Float Grids (*.flt), and GeoTIFF Grids or TIFF Grids with

world files (*.tif, *.tif/*.tfw) to the LAS file format.

NOTE:  When the above-listed Grid-based types of elevation data are converted into a version 1.4

LAS file, the resulting LiDAR points will be bit-flagged as 'Synthetic.'  Converted ASCII Text files will

have the 'Synthetic' bit flag set based on the status of the 'Treat as actual collected returns'
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checkbox.  This box is unchecked by default.

For more information on the LAS specification, please visit the following link at the ASPRS Online

Website.

The following steps outline how to use the Convert tool:

Click the ‘Convert’ button  .

The following image shows the MARS® Convert dialog. 

http://www.asprs.org/Committee-General/LASer-LAS-File-Format-Exchange-Activities.html
http://www.asprs.org/Committee-General/LASer-LAS-File-Format-Exchange-Activities.html
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Text File Options: When either a *.txt or *.csv text file is selected to be converted, the 'Text File

Options' dialog becomes available.  Text files can be comma, space, or tab delimited.  If the 'Use

Default Format' box is checked, the default fields will be used in the format.  The default text format

is XYZ with a space delimiter.  If the file contains header information (i.e., a header row), select the 

‘File Contains Header’ check box, which causes the convert module to skip the first line of the file

when creating point records.
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To further specify the format settings for the text file conversion, select the 'Choose Text File

Format' button.  The X, Y, and Z fields are in the fields in order dialog box by default.  If additional

fields are necessary to convert the text file, the user can select the desired attributes one at a time

from the right window of the dialog (Available fields) and click the '<<' button to add it to the file format

definition in the left window.  The user can also reorder the convert file format definition by selecting a

field in the left window and using the ‘Up’ or ‘Down’ arrow buttons to match the text file format.  In

addition, the ‘Ignore’ option from the attribute field list (left side of dialog) allows the user to disregard

specific data values in the input file for translation.  The ‘Ignore’ field may be used as many times as

necessary.  If there is an existing record format file to be used on the data, select the 'Choose

Existing Format from File' button, browse to where the format file is kept, and click 'Open'. 
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The user can bring in saved format settings ('Choose Existing Format from File'), and any unique

settings described in the dialog box by the user can also be saved for use at a later time.  Once the

file definition to be used is complete, these values can be saved to an external file for reuse by clicking

on the ‘Save Format’ button.  The target directory and file name for the file definition format can then

be assigned.  When all the dialog settings are complete, click 'OK' to return to the previous convert

window.

By using the ‘Test File’ function on a selected (highlighted) file, the user can quickly verify that the

inputted file format matches the actual contents of the target file.  The ‘Test File’ dialog is displayed

to the user and provides a file status of ‘PASSED’ or ‘FAILED’, and also displays the first several

lines of the file for review purposes.
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Boundary: The ‘Boundary’ section of the MARS® Convert module allows the user to clip the converted

data with a polygon shapefile.  The result of this process is that only the points within each feature in

the shapefile will be converted into an LAS file.  The names of the input files must exactly match

values in the shapefile's chosen attribute field (TName in the image below).  The created LAS files will

have the same names as the input files.

LAS Options: The ‘LAS Options’ section of the MARS® Convert module allows the user to create the

new v1.4 LAS files using Point Data Record Formats of 6, 7, or 8 (depending on whether RGB(N)

values are available in the input files).
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LAS File: The ‘LAS File’ section of the MARS® Convert dialog allows the user to modify the output

LAS file and choose its output location.

Note: If the output directory is not specified by the user, the new LAS files will be generated in the

same directory as the input file location.  To specify another location for the output LAS files, the user

can click  the ‘Browse’ button and navigate to the desired directory or key in a path.

Override Classification: The ‘Override Classification’ check box is used to assign a specific data

classification to the converted dataset.  For example, when converting “bare-earth” ASCII files to LAS,

the user may choose to override the data classification to 2, which represents ‘Ground (All)’. The

default override classification value is 0 (zero).
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Assign unique collection scan per file: During the conversion process, the user may assign a

unique collection scan number per file during LAS file creation, which is useful if each file contains

only one (1) collection scan.  This function is not necessary if the input files already contain collection

scan information and the 'Collection Scan' field is used appropriately in the file-to-LAS mapping.  This

tool can also be implemented when converting TIFF files.

Treat as actual collected returns: This checkbox is available when converting ASCII Text files to

LAS.  The default is unchecked, since most text files of XYZ points do not represent actual LiDAR

points.  It should be checked if the coordinates in the file are known to represent actual collected

returns.

Significant Figures (LAT-LONG values need 8 places 0.00000001):  The 'Significant Figures'

section of the Convert module should be utilized when the user is converting LAS files.  The default

value is set to 0.001 to retain the accuracy of any type of projected data (UTM, State Plane, etc.).  In

some cases where the 'X' and/or 'Y' extent of the data is very large, the tool may fail to make a valid

LAS file.  In this scenario, try reducing the default 'X' and/or 'Y' Significant Figures value(s) to '0.01'. 

This will reduce the decimal precision of the resulting data slightly, but will still provide two decimal

places for the point values.  If the user is converting latitude/longitude data in decimal degrees, another

five decimal places (0.00000001- eight total decimal places) will need to be added to the default value

to preserve the accuracy of the data.

Multi-threading: To help speed up 'Convert', multi-threading is available for this function.  Enter any

number of threads from 2 to the maximum number available in the text box on the right side of the

interface.  If ‘1’ is entered inside this text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per
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thread.

Convert: To complete the file convert process, the user must click the ‘Convert’ button after all of the

necessary data convert parameters have been defined.  To follow the progress of the conversion,

please see the progress bar, which will display the percentage of the conversion completed, the

elapsed time, and the estimated time remaining to complete.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.3 View Tab

View Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The View Tab:

 Color by Elevation: Displays LiDAR points rendered by relative elevation  value. (See also

Elevation Repeat , Elevation Rescale , and Elevation Throughout )

 Color by Intensity: Displays LiDAR points rendered by intensity  value. (See also Intensity

877
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Gray-scale Only , Intensity Color Extremes , and Intensity Equalize )

 Color by Classification: Displays LiDAR points rendered by classification  value.

 Color by Return: Displays LiDAR points rendered by return  value.

 Color by Collection Scan: Displays LiDAR points rendered by collection scan  (Point

Source ID value).

 Color by Ground Color: Displays user-defined ground class(es) by RGB values and all other

points by classification.  RGB values stored with the points will be used if no imagery is loaded.

 Color by RGB : Uses the R(ed), G(reen), B(lue) values stored for each LiDAR point to render

the point cloud or TIN as a 3-band  pseudo-image. 

Beginning with the LAS v1.2 specification, RGB values can be stored in an LAS file on a point-

by-point basis.  The Near Infrared (NIR) band values can also be stored beginning with LAS v1.4.

 When the 'Color by RGB' rendering method is used, those visible color values are used in the

display.  The data can then be viewed in 2D or 3D, and in either point cloud or TIN display.  If no

RGB(N) values exist within the loaded LiDAR data and imagery is available (either traditional

rasters or WMS imagery), a new set of LiDAR data can be exported using the RGB(N) values

from the imagery as follows:

 

1.) To be able to use this tool properly, first the user must have BOTH an image and an

892 889 890
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LAS file loaded into MARS®. 

2.) Next, the user must export the data.

3.) See the screen shot below for the parameters needed to use the 'Color by RGB' tool.

Designate an output directory for the LAS file. 

Make sure the 'Type' of export is 'LAS'. 

In the 'LAS Options' section, choose a 'Point Data Record Format' that

can store RGB(N) values: either 7 or 8 (if the imagery is 4-band).

In the 'Write RGB(N) Values from' section, select the button labeled

'Image'. This option will allow the RGB(N) values of the image(s) to be stored

with the exported

LAS point data.

Click on the 'Layout' tab and create a name for the exported data in the

'File' text box.

Click 'Export' at the bottom of the dialog box.

4.) To properly view the RGB data, close the current project in MARS® and open a new,
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empty project, or unload the current data.

5.) Open the newly exported file by clicking the top half of the 'Add LAS Files' button on

the Project/Data Preparation Tab , and navigate to the output folder that was chosen

for the export.  Select the file and click 'Open'. 

6.) Now select the 'Color by RGB'  button and the LAS file will appear rendered by

the RGB values stored for the points. To view the data more easily, click the 'TIN'

 button. This data can also be viewed in 3D as shown below.

 Color by Imagery (Fusion): Drapes imagery over the LiDAR points.  There must be imagery

loaded for this option to be enabled.

162
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 Blend with Intensity: This tool displays LiDAR points by intensity and allows the user to blend

 this with other 'color by' views.  Intensity may be blended with elevation, classification,

return, collection scan, ground color, or user data.  There is no terrain relief when viewing LiDAR

data by intensity alone, but the ability to view intensity along with another rendering option may

allow the data to be viewed more efficiently. Please see the examples below for further

explanation. 

In the example below, the LiDAR data is being viewed by return only.  By viewing only

the return values, it is impossible to know which characteristics in the terrain the first

return (blue) and second return (red) data correspond to. 

The example below is of the same area, but the ‘Blend with Intensity’ tool has been

utilized with the return values in the LiDAR data.  It is now easy to see that the first

return data (blue) corresponds to areas with roads and buildings whereas the second

return data (red) corresponds to areas containing trees.

843
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 Color by Hillshade: This tool will color an elevation float grid by hillshade  on the fly and

allows for user settings of sun azimuth and altitude.  This tool is only available when a Float Grid

(*.flt) has been loaded into MARS® and can be used in 3D (perspective) mode .  For more

information on loading a float grid into MARS®, please see the Convert Float Grid  section of

the MARS® Help file.  To read more about the Color by Hillshade  tool, please select the link

to this topic.

 Color by Z Delta (not available with Evaluation license): This tool will color the points in the

LiDAR data by the vertical difference between adjacent collection scans.  To see how this tool is

used for QA/QC procedures, please see the Color By Z Delta Analysis  section.

Clicking the 'Color by Z Delta' button will bring up the 'Z Delta Colors Options' window. 
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Increment: Specify here how many elevation units should be between each of the four

principal colors.

Complete color cycle: This text box will automatically update to tell the user how many total

vertical units will be included in the complete color cycle (four colors).

Using average TIN: If this check box is used, the Z-Delta will be determined using the

average TIN value of all collection scans. 

Pick a collection scan as reference: This drop-down box is automatically populated with

the collection scan numbers of the collection scans shown in the LAS Map View at the time

the 'Color by Z Delta' button was clicked.  If the user would like to have the Z-Delta be

determined for the overlap areas of collection scans adjacent to one particular collection scan,

then this option should be used.  Make sure the 'Using average TIN' check box is unchecked if
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using this option.

Display cut off value: The user has the option of entering a Z-Delta value in this text box

which would be considered out of the realm of possibility.  For example, in one collection scan

a car may have been parked beside the road when the LiDAR points were collected, causing

some of the returns to be from the top of the car.  In the next (adjacent) collection scan the

car is absent, and LiDAR points were collected from the road which was beneath the car. 

Because the two collection scans collected slightly different data, they will vary vertically in

this area.  The 'Color by Z Delta' tool will bring this discrepancy to the user's attention.  An

entry in the 'Display cut off value' text box tells the process to ignore data areas with a greater

Z-Delta.  By entering a value of '4' for example, the Z-Delta between a car on the side of the

road vs. no car on the side of the road will be ignored and no data coloration will be applied in

this area.

Example: The data in the screen shot below has been properly boresighted.  The user has chosen a

collection scan as a reference compared to any overlapping collection scans, and an increment of

0.15 units.  The results show that most of the ground points are green - this means that the Z-Delta in

these overlap areas is less than or equal to 0.15 units.  The areas of yellow show a Z-Delta between

0.15 and 0.30 units, the areas of orange show a Z-Delta between 0.30 and 0.45 units, and the red

areas show a Z-Delta between 0.45 and 0.60 units.  These areas of yellow, orange, and red should be

QC'ed carefully to make sure that the larger Z differences are explainable. 
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 Color by User Data: Displays LiDAR points rendered by values stored in the 1-byte 'User Data'

 field which can contain any type of data at the user's discretion.  This field has often been

used to store Auto-Gain Control values at the time the particular point in question was recorded

in the system. These AGC values, specific to Leica sensors, tell the user how the system was

attempting to center the intensity histogram at the time of collection.

Below is an example of an area of data colored by User Data when AGC values are

stored.

865
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--

The Inspect button  can show the user the User Data value of a particular point.  Click on

the 'Inspect' button and click on the point for which information is needed.  The chosen point

will flash twice and then remain highlighted in white using a larger symbol size to identify itself. 

See more on the Inspect  tool below in the Miscellaneous Tools section.220
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Coloration Options:

 Elevation: The Color by Elevation  tool  displays the LiDAR points by

relative elevation value.  When this rendering option is used, the following Elevation Coloration

Options are available:

Rescale (default): When using this option, the elevation display will be rescaled for

the current viewing extent every time the user moves around the project, zooming in

192
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and out or panning.  In other words, each window extent will have its own relative

high and low elevations.  Please see the Elevation Rescale  topic for further

information.

Throughout: This option uses every loaded point's elevation - visible in the current

extent or not - in determining the elevation color to be assigned to each point. 

Please see the Elevation Throughout  topic for further information.

Repeat: This option allows for adjustments to the color repeat cycle for different

elevations in both the LAS Map View window and the Cross-Section/Profile window.

 Please see the screen shot below and the Elevation Repeat  topic for further

information.  The settings on this interface will be stored when an MPD is created or

saved.

Please see the Elevation  rendering section for more information.
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 Intensity: The Color by Intensity  tool  displays the LiDAR points by

intensity value.  When this rendering option is used, the following Intensity Coloration Options

are available:

Gray-scale Only: Gray-scale is a quantitative measure of the intensity for each

return.  For 16-bit data the intensity values range from 0 to 65535, where 0

represents the darkest reflections (ex. new asphalt) and 65535 represents the

brightest reflections (ex. white rooftop).  Please see the Gray-scale Only  topic

for further information.

Color Extremes: This setting allows all extreme low and high intensity values to be

displayed in color.  When selected, a control pops up to allow the low and high

thresholds to be entered.  For example, if 58000 is entered as the 'High threshold'

and 10 is entered as the 'Low threshold', all points with intensity values of 58000 or

higher will be rendered in blue and all points with intensity values of 10 or lower will

be rendered in yellow.  Please see the Color Extremes  topic for further

information.

Equalize: By default the intensity color display is set to 'Equalize'.  Using this

option, the intensity display will be equalized every time the user moves around the

project, zooming in, or out, or viewing different areas.  This tool will take the

intensity ranges within the LAS Map View window and use a histogram stretch on

192
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the data so the data can be viewed more easily.  Please see the Intensity Equalize

 topic for further information.

Display Selection:

 Classification: There are two different versions of the interface - one when the LAS

Map View window is active, and one when the Cross-Section/Profile window is active.  Settings on

each will affect the display only for its corresponding window.  Note that the interface's Class/

Description combinations are correct for LAS v1.4, Point Data Record Format (PDRF) 6 or

higher per the latest ASPRS specification (1.4 - R15, dated July 9, 2019).  Custom settings files

can be made as described in the last paragraph of this topic.

The LAS Map View version of the interface allows the user to choose specific classifications for

visibility and for rendering method.  Check/uncheck the 'Display' boxes for the classes to be viewed/

hidden.  The shortcut buttons at the bottom of the interface offer quick settings: The 'All

Classifications On/Off' buttons will turn all classes on/off.  The 'Ground (All)' button will turn on

Class 2 only and will, by default, include those ground points that are bit-flagged as Model Key-points.

 The 'Apply' button will show the effect of the current settings without closing the interface.  Separate

Bit Flag display settings for all bit flag types can be found in the 'Bit Flag' display settings tool 

 (below).

Individual classes can be set for how they are displayed (as 'Point' or 'TIN') when the LAS Map View

window is using the TIN Rendering Method (see separate topic below).  For Point/TIN rendering, the

individual boxes may be checked per class, or the shortcut buttons 'All Classes as Points' and 'All

Classes as TINs' may be used.

890



MARS® v2023.1           User Manual206

© 2000-2023 Merrick & Company

Any of the settings representing a class can be changed to make custom settings files without

affecting the default values by following these instructions: For 'Display' status, check or uncheck the

boxes as desired.  For 'Color' changes, double-click on a color box - the standard Windows color

dialog will appear.  For 'Description' changes, highlight the text and then click on it - a new

description can then be entered.  For Point/TIN rendering status, ('Save Settings to File' and 'Load

Settings from File').  These files can save the display status, class color and description, and Point/

TIN status for each class.  For more information, please see the Color by Classification  and the

Displaying Data  topics.

When the Cross-Section/Profile window is active, the interface will appear as in the screen shot

below right.  This version includes only the class display checkboxes and a reduced set of shortcut

buttons.

When the LAS Map View window is active

When the Cross-Section/Profile window is active

845
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 Return: This two-part interface offers the user the opportunity to choose specific returns

for viewing when using the 'Color by Return' rendering option.  On the 'traditional' part of the interface

(see below), check the returns which are to be viewed, and uncheck those which are not to be viewed.

 The short-cut radio buttons at the left side of the interface offer exclusive settings.  Use these short



Tab and Ribbon Layout 209

© 2000-2023 Merrick & Company

cuts to choose the returns for viewing or manually choose the returns for viewing by checking the

boxes on the right side of the interface.  This part of the interface handles up to eight returns, which is

the current limit for  most commercial LiDAR sensors.  Changes cannot be made to this interface

unless the loaded data has valid point family (discrete return) information.  For more information,

please see the data viewing by Return  topic and the Return Information Testing (Return Info) tool

topic in the LAS Tools  section of this help file.

To make more granular selections up to the LAS v1.4 specification limit of 15 returns, click the button

at the top labeled 'Go to extended return selection dialog'.  The interface will switch to the second

part, which uses a column in the center to list the currently selected returns (see below).  The same

short-cut buttons are available on the left side, and their selection will affect the list shown in the

column.  On the right side, there are various buttons for more control of the listed (to be displayed)

return values.  By default, all return values are listed for display.  Values may be removed by selecting

them in the list, either individually or using the 'Shift' or 'Ctrl' keys while clicking to make multiple

selections.  Click the 'Remove Selected' button once the selections are made to remove those
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values from the list.  To clear the entire list, use the 'Clear' button.  Use the 'Add Unknown' button

to add returns that don't have proper point family information - when inspected, these may appear as

'0' or '1 of 0', for example, indicating  a possible sensor malfunction.  Entering values in the 'Return

Number' and 'Total Returns' boxes and clicking the 'Add' button will populate the list with just that

value - second of eight (2/8) for example.  All third returns can be added by entering '3' in the 'Return

Number' box and clicking 'Add All for This Return'.  To add all returns in point families consisting of

nine returns, enter '9' in the 'Total Returns' box and click 'Add All for This Total'.  With these

detailed options, any and all combinations of return values can be set for display.  Note that each of

the two selection windows has its own independent 'OK' and 'Clear' buttons to confirm and remove all

selections, respectively.  The 'Apply' button will show the effect of the current settings without closing

the interface.  To go back to the traditional interface, click the button labeled 'Go to return selection

dialog for <= 8 returns'.

 Collection Scan: The 'Edit Collection Scan Display' interface allows the user to

choose which collection scans are displayed and change the colors assigned to each collection scan

loaded into MARS®.  The settings in this interface affect the display when the 'Color by Selection

Scan' and/or 'Collection Scan Direction' tools are used.  Only those collection scans that are actually

loaded into MARS® will appear in the interface.  Enter the number of the collection scan to be edited

in the 'Collection Scan' text box. Click the color button which appears to the right of the text box to

bring up a color palette and change the color associated with that particular collection scan. Click on

the 'Update' button to update the color change in the master list to the left side of the interface.  To

change which collection scans are to be displayed, check or uncheck the boxes in the 'Display'

column.  All collection scans can be toggled on or off using the 'All ...' buttons, and selected

(highlighted) collection scans can be toggled on or off using the 'Selected ...' buttons.  Clicking the

'Make Default' button will create an XML file that MARS® will read each time it is opened.  The 'Apply'
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button allows changes to be made and viewed while leaving the interface open.  The dialog box may

be left open during pan/zoom, editing, etc.  Please see the Color by Collection Scan  topic for more

information.

 Bit Flag: The 'Bit Flag Display Settings' interface allows for LiDAR point rendering to be

controlled by the point-level status of several bit flags: Synthetic, Model Key-point, Withheld, Overlap

849
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(also referred to as 'Overage'), Edge of Collection Scan, Scanner Channel, and Scan Direction.  By

default, points flagged as 'Withheld' are not displayed ('Off').  All other bit flag types are initially set to

'Ignore Status' -  meaning that the points will be displayed whether or not the bit flag for that particular

type is set to 'True' - or, in the case of Scanner Channel and Scan Direction, all possible values are

checked on.  For the upper portion of the interface, if 'Only On' is chosen only the points with that bit

flag set to 'True' will be visible.  If multiple bit flag types are set to 'Only On', only points with all

corresponding bit flags set to 'True' will be displayed.  For example, if 'Model Key-point' and 'Overlap'

are both set to 'Only On', only those points with both bit flags set to 'True" will be visible.  The 'Off'

option is used to turn off those points that have the corresponding bit flags set to 'True'.  Unlike 'Only

On', however, points will be turned off when any one of the bit flags is set to 'True' for types using the

'Off' option.  For example, if both 'Synthetic' and 'Overlap' are set to the 'Off' option, any points with

either of those bit flags set to 'True' will be turned off.  The 'Scanner Channel' and Scan Direction'

settings operate independently of the other bit flag settings - they simply toggle certain channels and/

or directions on or off regardless of the other bit flag settings.

Only those points that are visible will participate in the 'Rendering Method' (Point or TIN) or the

'Perspective" (2D or 3D) view.  These settings can be made independently in both the LAS Map View

and Cross-Section/Profile windows, except for the 'Scanner Channel' and 'Scan Direction' settings

which are ignored in the Cross-Section/Profile window.  To view by the new settings after making

changes without closing the tool, click the 'Apply' button.  To save a display configuration beyond the

current MARS® session, click the 'Make Defaults' button.
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Rendering Method: Here, the user can choose how the data is rendered. There are two ways to look

at data loaded into MARS®: Point rendering and TIN rendering.

Points: To view the data as points, click the 'Points' button .  The screen shot below

is an example of LiDAR data rendered by Points.
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TIN: To display LiDAR data as a TINned surface, click the 'TIN' button . The TIN is

generated on the fly and, therefore, may slow down navigation noticeably. It is recommended

to switch to Points mode, as described above, before navigating around the project. Use TIN

mode only at zoomed-in levels. The TIN rendering method may also be used in 3D view.  The

screen shot below is an example of LiDAR data rendered by TIN.
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Perspective:

 2D View: Displays data in 2D, or orthographic, mode (default setting).  For more information

on 2D navigation, see the 2D View  topic. 

 3D View: Displays data in 3D, or perspective, mode.  For more information on 3D navigation,

see the 3D View  topic.
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Miscellaneous Tools:

 Lock to view 100%: This tool forces all points in the loaded LAS files to be displayed and is

intended for hand editing purposes, when using the Flood Fill utility, and when displaying virtual

contours.  The density percentage on the left side of the Status Bar  tells the user the

percentage of points which are currently being displayed. 

 

Hand editing should ONLY be done when viewing points at 100% density.  It is easy for the

editor to zoom in/out or lose/gain point density frequently throughout the hand editing process

by maneuvering around the project, and this tool allows the editor to lock the point density of the

display at 100% regardless of zoom level.

If navigation is slowed too much with this tool enabled, toggle it off, move to the desired area, and re-

enable the tool.  The tool will reset to the 'off' mode when all loaded LAS files are removed and must be

manually toggled back on (if desired) after new data is loaded.

 Collection Scan Direction: The Collection Scan Direction tool allows the user to view the

direction in which each collection scan was acquired. When the button is active (orange), the

collection scan  direction will be indicated with arrows pointing in the direction of acquisition. Each

arrow is also color-coded to match the color of the corresponding collection scan data.  See the

section titled 'Display Selection - Collection Scan' earlier in this topic for information on changing

collection scan colors.

158
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The example below shows five collection scans color-coded in white, pink, yellow, purple, and

green.

This example shows the same five color-coded collection scan direction arrows without the

LiDAR data displayed. 

 Show Scale Bars: Toggles the display of Easting and Northing scale bars in the MARS® LAS

Map View window on/off. The values shown are in the loaded data's coordinate system and

units. This allows the user to gauge the horizontal distance of a project in the LAS Map View.



MARS® v2023.1           User Manual218

© 2000-2023 Merrick & Company

 Lock to view 1%: This tool locks on only the 'thinned points,' the minimum set of points that can

be displayed for loaded LAS files.  This can speed up panning and zooming operations while the

area of interest is being determined.  The density percentage indicator on the left side of the 

Status Bar  shows the percentage of points which are currently being displayed.

 

Note that the actual percentage of points displayed may be less than 1% depending on the data

loaded.

.

Line-of-Sight Display: MARS® supports the display of a source/target line-of-sight display (while in

3D perspective viewing mode only) for analysis purposes.

 Place Target: Allows the user to define a target location for an 'on-the-fly' line-of-sight display.

With LAS data rendered in a 3D (Perspective) view, click on the 'Place Target' button and then

click on a location in the data display.  The data display will re-center around that point.  Next,

click on the 'Place Eye' button (see below) and then click on a location in the data display that

will be the observer's location.

 Place Eye: Allows user to define a point of origin (viewer location) for an 'on-the-fly' line-of-sight

display after a target location has been established (see above).  With LAS data rendered in a

3D (Perspective) view and a target location already chosen, click on the 'Place Eye' button and

then click on a location in the data display that will be the observer's location.

Example:

The user must select an area of interest and then change to 3D View  mode to use this tool. First,

158
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the user must define the line-of-sight target by clicking the ‘Place Target’ button  on the View

Tab  and defining a target location by clicking the mouse. The user must then define the point of

origin (source) for the line-of-sight display by clicking the ‘Place Eye’ button  and selecting a

location by clicking the mouse. Once both locations have been defined, the LAS Map View display will

update to show the view from 'eye' to 'target.'

 Measure: Allows for length, heading, and slope measurements, depending on whether it is used

in the LAS Map View window or in an active Cross-Section/Profile window.  Please see the

detailed Measure  topic for more information.
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 Inspect - Click on this tool, and then click on the displayed LiDAR point that is to be inspected. 

The chosen point will flash twice and then remain highlighted in white at a larger symbol size to

identify itself.  Any number of displayed points can be inspected, one at a time.  If a Cross-

Section/Profile window is open, the point may be chosen in either view, and will be highlighted in

both views.  The one exception to this is in the Cross-Section/Profile window, the Inspect tool will

identify the file name and collection scan number rather than a point when the data is viewed in

Profile by Collection Scan mode.

The tool displays the point's parent file path and point source ID (PSID), X, Y, and Z coordinates,

timestamp (including Seconds of GPS Week, GPS Week Number, and Julian day), intensity

value, classification, bit flag status, return number, user data, scan angle/scan angle rank, scan

direction flag, edge of collection scan flag, scanner channel flag, and RGB(N) values (see Inspect

 for details of these attributes).  The tool works in 2D (orthographic) and Cross-Section/Profile

views.  Note that for LiDAR data, some fields are dependent on the data collected and the post-

processing software used, as well as the LAS version and Point Data Record Format.

943
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To select a displayed check point for inspection, click on the desired check point (the LAS data

may need to be turned off to avoid selecting a LiDAR point instead).  The window that opens will

display the point's ID, XYZ values and (if stored), a description, the point's NVA / VVA type, and

the survey date of the point.

Holding down 'Ctrl' on the keyboard and clicking on a virtual contour line, or displayed reference

or breakline shapefile feature while the 'Inspect' tool is toggled on will allow the user to inspect

that feature rather than the closest LiDAR point.

Windows copy-and-paste controls can be used in the resulting pop-up window.  To unselect the

'Inspect' tool and return the chosen feature to its original symbol and/or color, right-click the



MARS® v2023.1           User Manual222

© 2000-2023 Merrick & Company

mouse.  See the Inspect  tool topic for more details.

 Inspect RGB(N) Tool: This utility allows the user to select and display the RGB(N) - Red-Green-

Blue and, if present, NIR - values from the loaded imagery data.  This tool is normally used to define

RGB(N) values for the RGBNI Value Filter .  This tool will only work on RGB or RGB(N) imagery

(not ENVI rasters) and is only available to use when imagery is loaded into MARS®.

To use this tool, click in the desired location on the imagery.  Once the user has selected a target, the

‘Inspect RGB(N)' dialog (see below) will be displayed, showing the RGB(N) values from the selected

pixel.  Additional locations can be selected without closing the pop-up.  3-band imagery will display 'N/

A' for the 'N' field.

 Swipe Raster Over LiDAR: This tool allows the user to move imagery over LiDAR data for rapid

viewing of the alignment between the two. Both a raster image (or images) and LiDAR data must

be loaded to use this tool. When checking the alignment of these two data types, it is most

advantageous to have the LiDAR data in TIN mode.

The MARS® window below shows the Swipe Raster Over LiDAR tool work ing between imagery

and LiDAR.
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 Show Breakline Vertices (available with Production license only): This tool symbolizes the

vertices for all loaded breaklines, and labels each with the ID number stored in the

shapefile attribute table.
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 Hyperlink: The Hyperlink tool is associated with the 'Add EO File' tool which is located on the

Project/Data Preparation Tab  tab. In order to use the Hyperlink tool, an EO file must be loaded

into MARS® along with its associated imagery path.  For more information concerning adding an

EO file, please see the Project/Data Preparation Tab  topic.  Once an EO file is loaded into

MARS® the Hyperlink button will become enabled. The purpose of the Hyperlink tool is to provide

the user with a way to display an aerial image associated with a particular EO event point.  The

EO file is displayed as a 3D point shapefile and each point, or event, in the EO shapefile is

associated with imagery.  Because it is displayed as a shapefile, it is also possible to change the

display settings of an EO file by right-clicking on the file inside the Table of Contents and

choosing 'Properties'.  The resulting 'EO File Properties' window will allow the user to change the

color and size of the point shapefile and will also allow the user to display labels. 

 When the user selects a point with the Hyperlink button toggled on, the associated image is then

brought up in the Windows default viewing program.  Below is an example of the imagery which

will appear when an EO event point is selected.  If the user selects a point from an EO file linked

to RGB nadir imagery, this is the imagery which will be displayed.  The same methodology

applies for linking to CIR nadir, forward-facing, and aft-facing imagery.
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It is possible to display multiple EO files at once in MARS®.  The Hyperlink tool will only display

imagery with an associated EO file which is currently displayed in MARS®.  For example, if the

user has a separate EO file loaded for the CIR nadir, RGB nadir, forward-facing, and aft-facing

imagery, it can be difficult to select the proper EO event file to bring up only one type of imagery. 

By using the options within the Vectors  layer of the Table of Contents  to turn off the display

of EO files which are not currently needed, it is much easier to select the proper point for display. 

It is possible to save all loaded EO files, paths to imagery, and any raster files which may be

loaded to a MARS® project file (*.mpd) for use at a later time.

92 64



MARS® v2023.1           User Manual226

© 2000-2023 Merrick & Company

LiDAR/Image Transparency slider bar: Allows the user to adjust the transparency of the LiDAR

points with respect to the imagery.  This slider bar can only be used in the LAS Map View window

while in 2D View . 

See the examples below:

Ex: Viewing the data with LiDAR points favored over the imagery: 

 

835
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Ex: Viewing the data with the imagery favored over the LiDAR points: 

Point Density slider bar: This control changes the point density in the LAS Map View window. The

user must be zoomed in to at least 4% before the slider bar will work. The point density slider bar

does not work inside the Cross-Section/Profile  window. To TIN  the data being viewed, the

slider bar must be set to 0 (far left). If the bar is not set to 0 before the TIN button is clicked, an error

window will appear.

238
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Ex: Points set at 0 to allow user to TIN  the data. 

 The Point Density slider bar is set at '0' (far left) in this position.

Ex: Points Set at 'More': The highest point density option
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 The Point Density slider bar is set at its highest point density in this

position. 

The percentage of points being displayed (point density) can also be found in the bottom left corner of

the LAS Map View window. As the Point Density slider bar is moved left or right, this percentage will

change accordingly. 

In the example below, the slider bar is set to display fewer points. The percentage of points being

displayed can be found on the left side of the Status Bar . In this case, 6% of points are being158
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displayed.

In the example below, the slider bar is set to display more points. The percentage of points being

displayed can be found on the left side of the Status Bar . In this case, 33% of points are being

displayed.

158
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Vertical Scale slider bar:  MARS® is capable of vertically rescaling data while in

3D View  mode in the LAS Map View window.  Above the slider bar is a vertical scale text box that

allows entry of an exact scale value.  Type in the scale (relative to horizontal) at which the data is to

be viewed and press 'Enter' on the keyboard.  The minimum value is 0.01 and the maximum is 1000. 

The '1x ' button will revert back to a 1:1 scale.

See Also

Displaying Data

© 2000-2023 Merrick & Company. All Rights Reserved.
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3.4 Navigation Tab

Navigation Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Navigation Tab:

 Fit to View: This tool will zoom out to display the project extent of all loaded data in the LAS

Map View window only.

 Previous View: Allows the user to return to the last display view.

 Next View: Allows the user to jump to the next display view. (Note: the user can only jump to

the next display view if the previous button was used prior)

 Pan: Allows user to pan (move without zooming in/out) across the dataset.  When the tool is

active, click and hold the left mouse button while moving the mouse.  Panning can also be

done in most situations by using a push-and-hold technique with the mouse wheel and then
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moving the mouse.  See additional panning methods in the 'Miscellaneous' section of the 

Options Tab .

 Zoom In: When active, left-click and drag the mouse to define the area that will fill the LAS

Map View window.  Click and hold right mouse button and pull mouse backward to zoom in. Or

roll the scroll wheel on the mouse towards the computer (forward) to zoom in on the data.

 Zoom Out: Click and hold right mouse button and push mouse forward to zoom out. Or

roll the scroll wheel on the mouse away from the computer (backward) to zoom out on the data.

 Zoom in 25%: Using this tool, the software will zoom in 25% to the center of what is

displayed in the LAS Map View window.

 Zoom out 25%: Using this tool, the software will zoom out 25% from the center of what is

displayed in the LAS Map View window.

'Jump to' buttons: These tools allow navigation based on a specific coordinate pair, tile (in a loaded

layout), or check point ID.  Each method will put the chosen value or feature in the center of the LAS

Map View window.  See also the Jump To  topic.
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  Use this tool to jump to a precise XY coordinate location, based on the Easting

and Northing values of the project.

  Use this tool to jump to a particular tile. There must be a tile shapefile loaded

to use this tool. The user can choose to search from the ID attribute field or the TName (tile

name) attribute field. The user must know the value of the TName or the ID field to use this tool.

  Use this tool to jump to an individual check point. There must be a

check point (.csv or .shp) file loaded to use this tool. Use the drop-down box to choose a

particular point from the check points available.
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Bookmarks: Bookmarks can be used to mark a certain place in the data. By saving a bookmark,

the user will be able to click on the bookmark name in the future and be taken to the location in the

data that the particular bookmark was placed. Bookmarks are convenient when editing to be able to

pick up editing in a particular spot, to save a place where re-work needs to be done, or as a point of

reference for another user.  See also the Bookmarks  topic.

  To create or save a bookmark for future reference, choose this option. The

user will be shown a Bookmark Creation interface to name and save the bookmark.  Click on the

'OK' button or press the 'Enter' key on the keyboard to commit the save.

  To visit a saved bookmark, use this option. A list of saved bookmarks will

appear. Choose the needed bookmark and click 'OK' to view the bookmark placement. 

814
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  To delete a saved bookmark, use this option. A list of all saved

bookmarks will appear.  Choose the bookmark to be deleted by highlighting it and choose'

Delete' at the bottom of the window.
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 Link to Google Earth: If either Google Earth© or Google Earth Pro© is installed, it will

open in a separate window and auto-navigate to the location that is displayed in the LAS Map View

window.

When the tool is enabled, it will check to see if Coordinate Reference System (CRS) information is

defined for either the loaded LAS data or in the 'Data Layer' properties.  If not, the following message

will appear:
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Google Earth and Google Earth Pro are copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.5 Cross-Section/Profile Tab

Cross-Section/Profile Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Cross-Section/Profile Tab:

From Class drop-down list: This allows the user to pick from ALL classes, a selected set of classes

(see below), or any one of the 256 individual LiDAR classes to be the source class(es) for manual

editing actions.

Edit Selected Set: This function allows the user to make a selected set comprised of any
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combination of LiDAR classes to be used when the '- Selected -' option is chosen in the 'From Class'

drop-down list. More details about using and saving selected sets can be found in the Manually

Editing LiDAR Data  tutorial. 

To Class drop-down list: This allows the user to pick from any one of the 256 individual LiDAR

classes to be the target class for manual editing actions.

Edit Paint Small: This paint utility is the smallest paint tool. It reclassifies visible points (referenced

in the 'From Class' drop-down list) selected in the Cross-Section/Profile window. Drag the cursor box

over the desired points and they will turn white.  To commit them to the 'To Class' class, press the

Space Bar on the keyboard. To cancel and unselect the points, right-click the mouse.  More detailed

information on editing in the Cross-Section/Profile window can be found in the Manually Editing LiDAR

Data  and Cross-Sections and Profiles  topics.

Edit Paint Medium: This paint utility is a medium-sized paint tool. It reclassifies visible points

(referenced in the 'From Class' drop-down list) selected in the Cross-Section/Profile window. Drag the

cursor box over the desired points and they will turn white.  To commit them to the 'To Class' class,

press the Space Bar on the keyboard. To cancel and unselect the points, right-click the mouse.  More

detailed information on editing in the Cross-Section/Profile window can be found in the Manually

Editing LiDAR Data  and Cross-Sections and Profiles  topics.

Edit Paint Large: This paint utility is the largest paint tool. It reclassifies visible points (referenced in

the 'From Class' drop-down list) selected in the Cross-Section/Profile window. Drag the cursor box

over the desired points and they will turn white.  To commit them to the 'To Class' class, press the

Space Bar on the keyboard. To cancel and unselect the points, right-click the mouse.  More detailed

information on editing in the Cross-Section/Profile window can be found in the Manually Editing LiDAR

1661
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Data  and Cross-Sections and Profiles  topics.

Edit Line String Above: Reclassifies all visible points (referenced in the 'From Class' drop-down list)

above a user-drawn vector in the Cross-Section/Profile window only.

Edit Line String Below: Reclassifies all visible points (referenced in the 'From Class' drop-down list)

below a user-drawn vector in the Cross-Section/Profile window only.

Edit Scrape Above: Reclassifies all visible points (referenced in the 'From Class' drop-down list)

above the scrape tool cursor in the Cross-Section/Profile window only.

Edit Scrape Below: Reclassifies all visible points (referenced in the 'From Class' drop-down list)

below the scrape tool cursor in the Cross-Section/Profile window only.

Undo: This tool will undo an edit process each time it is selected. This tool is useful when an edit

process is not done correctly. It can be undone and the user can attempt the edit process again. 

Redo: This tool will redo an edit process each time it is selected. This tool can be used only after the

'Undo' tool has been used - it will 'redo' an undone process.

Please see the examples below to see the functions of the 'Undo' and 'Redo' tools.

In this first example, a bit of vegetation next to a river has been incorrectly classified as ground.

1661 1634
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In the next example, the misclassified ground point has been changed to vegetation. However, the

editor has made a mistake and has accidentally classified the ground below the vegetation as

vegetation. By click ing on the 'Undo'  button, this mistake is easily reversed and the point

classifications that were changed  to vegetation will go back to their original ground value as if the edit

was never made. To reverse an 'undo' action, click  on the 'Redo'  button and the edit that was

made will reappear.
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Save cached points to disk: This button is currently disabled.  Due to LAS datasets becoming

increasingly larger in file size (frequently surpassing the available RAM in a computer) as well as the

possibility of lost work caused by an unexpected shutdown of MARS prior to a save operation, the

‘Cache points into available RAM’ option has been disabled.  LAS data will be read from disk and ‘live’

edit changes (such as hand filtering) are committed to disk as soon as they occur.  Additionally, with

newer, faster hard drives such as SSD, the performance difference between disk-based and RAM-

based operations is constantly shrinking.

Move Cut Ahead: This tool moves the cross-section box ahead as defined in the 'Forward/back

percentage' setting (Options Tab , 'Miscellaneous' button).  The cross-section/profile window display

will update automatically.

Move Cut Back: This tool moves the cross-section box back as defined in the 'Forward/back

518



Tab and Ribbon Layout 243

© 2000-2023 Merrick & Company

percentage' setting (Options Tab , 'Miscellaneous' button).  The cross-section/profile window display

will update automatically.

Place Cross-Section Line: Creates cross-sections with a fixed cut depth.  Works only in 2D View

.  The tool uses two-point compilation: to start, click once to place one side of the cross-section,

click again to place the other side of the cross-section - this determines the cut depth (width).  The

first time either this or the 'Place Adjustable Cross-Section Line' tool is used a new Cross-Section/P

rofile window will automatically open.  A new cross-section (replacing the previous one) may be

created at any time this window is open.  LiDAR point display may be turned off in the LAS Map View

window without affecting the point display in the Cross-Section/Profile view by unchecking the LAS

layer in the Table of Contents .  There are adjustable default settings and special controls for this

tool:

Default #1 - The LAS Map View and cross-section/profile windows will tile

automatically; the default is for the cross-section/profile window to appear to the right

of the LAS Map View window. To change the default go to the Options Tab  and

click the 'Miscellaneous' button. The setting may be changed in the 'Arrange Cross-

Section/Profile window' section.

Default #2 - The cross-section/profile width defaults to 10 units. To change the

default go to the Options Tab  and click the 'Miscellaneous' button. Entering a

new value into the 'Default cut area depth' text box will change the default depth.

Default #3 - The cross-section/profile cut area can be moved forward and backward

('broomed') in the 2D View window. The default value of this movement is 75%,

meaning that the forward motion will be  75% of the cross-section/profile's width,

leaving a 25% overlap. This percentage can be changed by going to the Options Tab

 and clicking the 'Miscellaneous' button. The 'Forward/back percentage' radio
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buttons available are 25%, 50%, 75%, 90%, or 100%.

Cross-Section/Profile Movement #1 - The cross-section/profile cut area can be

dragged to a new location. Select and drag the cut area in the 2D View window.

Cross-Section/Profile Movement #2 - For stepping the cross-section/profile cut

area forward and back ('brooming'), use the UP  and DOWN  arrows. The step

size movement is controlled by Default #3.

Cross-Section/Profile Movement #3 - If the 2D View window is selected, the 'Keep

Cut Area in Map View Centered'  tool will

keep the Cross-Section/Profile cut area centered in the middle of the LAS Map View

window. To disable this and allow the cut area to move independently from the

window, click the 'Keep Cut Area in Map View Centered' tool to toggle it off while

the 2D View window is active. If the cross-section/profile window is the active window,

the 'Keep Profile Centered'  tool will try to estimate a

ground elevation and automatically adjust the window to that elevation. In steep

terrain or near tall buildings this feature can fail. To disable this and allow the cross-

section/profile to move without automatic elevation adjustment, click the 'Keep

Profile Centered' tool to toggle it off while the cross-section/profile window is active.

Cross-Section/Profile Movement #4 - The cross-section/profile cut area can be

rotated in the 2D View window. The cut area will rotate around its center node. Rolling

the mouse scroll wheel rotates the cross-section/profile.

Place Adjustable Cross-Section Line: Creates cross-sections with an adjustable depth. Works only

in 2D (orthographic) mode .  The tool uses three-point compilation; to start, click once to place one

side of the cross-section, click again to place the other side of the cross-section (width), and click a

third time to set the depth of the cross-section.  The first time either this or the 'Place Cross-Section

835
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Line' tool is used a new Cross-Section/Profile window will automatically open.  A new cross-section

(replacing the previous one) may be created at any time this window is open.  LiDAR point display

may be turned off in the  LAS Map View window without affecting the point display in the Cross-

Section/Profile view by unchecking the LAS  layer in the Table of Contents .  The same

adjustable default settings and special controls that are available for the 'Place Cross-Section Line'

tool (above) are also available for this tool, except that the default cut depth setting is ignored.

Rotate Profile: This tool works only when the cross-section/profile window is open and allows the

user to rotate the cross-section/profiled area a specified number of degrees in a clockwise direction.

90 degrees is the default value, but any numerical value may be entered. Entering a negative value (ex:

-90 degrees) will cause the cross-section/profile view to rotate in a counter clockwise direction. Select

'OK' to see the results in both the LAS Map View window and the cross-section/profile window. This

window has a keyboard accelerator. To bring up the window below without using the button, select the

letter 'R' on the keyboard when the cross-section/profile window is active.

Keep Profile Centered: This tool keeps data centered vertically in the cross-section/profile window

by estimating a ground elevation and automatically adjusting the window to center that elevation.  In

steep terrain or near tall buildings this feature can produce unexpected results.  To shut this off and

allow the cross-section/profile to move without automatic centering, click the 'Keep Profile Centered'

button to toggle it off.  When the 'Keep Profile Centered' tool is not active, the cross-section/profile

71 64
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window can be dragged with the 'Pan'  tool to the user's area of interest.

Keep Cut Area in Map View Centered: This tool keeps the cut area box centered vertically and

horizontally in the LAS Map View window.  To shut this off and allow the cut area box to move

independently from the window, click the 'Keep Cut Area in Map View Centered' button to toggle it off.

 When the 'Keep Cut Area in Map View Centered' tool is not active, the cross-section/profile window

can be dragged with the 'Pan'  tool to the user's area of interest.

Inspect: Click on this tool, and then click on the displayed LiDAR point that is to be inspected. The

chosen point will flash twice and then remain highlighted in white at a larger symbol size to identify

itself. Any number of displayed points can be inspected, one at a time. If a Cross-Section/Profile

window is open, the point may be chosen in either view, and will be highlighted in both views. The one

exception to this is in the Cross-Section/Profile window, where the Inspect tool will identify the file

name and collection scan number rather than a point when the data is viewed in Profile by Collection

Scan mode. The tool displays the point's parent file path and point source ID (PSID), X, Y, and Z

coordinates, timestamp, intensity value, classification, bit flag status, return number, user data (often

AGC values), scan angle/scan angle rank, scan direction flag, edge of collection scan flag, scanner

channel flag, and RGB(N) values (see Inspect  for details of these attributes).  The tool works in 2D

(orthographic) and Cross-Section/Profile views.

To unselect the 'Inspect' tool and return the chosen feature to its original symbol and/or color, right-

click the mouse.  See the Inspect  tool topic for more details including other uses for this tool.

943
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Measure: Measures distance (in project units) and heading between two locations in the 2D View, or

distance and slope angle (in degrees) in the Cross-Section/Profile window.  Please see the detailed 

Measure  topic for more information.

Show Scale Bar: Toggles the display of the Elevation scale bar in the Cross-Section/Profile window

on/off. The values shown (along the left side) are in the loaded data's vertical units. Clicking in the

Cross-Section/Profile window will cause a label to be displayed showing the cursor's elevation.

Current Depth: This entry box allows the user to adjust the depth of an existing cut by typing in a

new value and hitting the 'Enter" key. the current value is also shown on the Cross-Section/Profile

window tab. To change the default cut depth for newly-created cross-sections using the 'Place Cross-

Section Line' tool , go to the 'Miscellaneous Options' interface on the Options Tab  and

make the appropriate changes in the 'Cross-Section/Profile Window' section.

Show Point Size: Resizes the point display proportionally within the cross-section/profile window.

When toggled on, the LiDAR points nearest to the viewer side of the cut area are slightly larger, and

points on the far side are slightly smaller.

956
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 Profile Combined: Displays a combined single line profile of all points for the displayed collection

scans. This 'profile combined' example is rendered by classification.

 Profile by Collection Scan (not available with Evaluation license): Displays a profile line for
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each displayed collection scan. This profile example is rendered by collection scan color.

 Cross Section: Displays a cross-section view of the LiDAR points for the displayed collection

scans in the cross-section/profile window. This cross-section example is rendered by elevation.

Vertical Scale slider bar:  MARS® is capable of vertically rescaling data in the

Cross-Section/Profile window. Above the slider bar is a vertical scale text box that allows entry of an
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exact scale value.  Type in the scale (relative to horizontal) at which the data is to be viewed and

press 'Enter' on the keyboard. The minimum value is 0.01 and the maximum is 1000.  The '1x '

button will revert back to a 1:1 scale.  This slider is synchronized with the vertical scale slider on the

optional Cross-Section/Profile Window  toolbar.

A separate vertical scale control is located on the View Tab  for data being displayed in 3D View

 in the LAS Map View window.

Save Profile Line: This tool can create either a 3D shapefile, or a CSV file of XYZ values, for a

combined profile (see above).  The output file will be created from whatever profile is currently shown

in the Cross-Section/Profile window.  When a profile line shapefile is saved, a *.prj (projection

definition file) is created if the projection information is known for the source LAS data.  For shapefile

output, the resulting shapefile can be loaded back into MARS® using the 'Add Reference Shapefiles'

button on the Project/Data Preparation Tab , and displayed in 3D View .  For CSV output, the

resulting file of XYZ values can be opened in Excel.  This tool is only available when the profile is

rendered with the 'Profile Combined' button .  For more information on the 'Profile

Combined' tool, please visit the Cross-Section/Profile Tab  topic.
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In the example below, the resultant 3D shapefile has been loaded into MARS® as a reference

shapefile. It is shown below in 3D as the black  line which profiles two of the four large buildings

shown.
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© 2000-2023 Merrick & Company. All Rights Reserved.

3.6 Coordinate Conversion Tab

Coordinate Conversion Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Coordinate Conversion Tab:

For any LAS tools (including 'GeoCalc') that allow files to be pathed out without loading them in
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the Table of Contents in MARS®, an up-conversion prompt will appear when executing the tool if

the LAS files do not meet the minimum MARS® compliancy requirements.  This prompt is

described in the Project/Data Preparation Tab  topic.

GeoCalc: This tool allows the user to transform LAS data to different horizontal coordinate systems,

horizontal and/or vertical datums, height models, and units.  For more information on the use of this

tool, please see the GeoCalc  section.  This tool, as well as many other coordinate system related

functions, requires that the Blue Marble Geographics shift files be installed.  See Page 23 of the 

Installation and Licensing Guide for download and installation details.

GeoEdit: The GeoEdit tool allows the user to define custom coordinate systems, horizontal and vertical

datums, and height models, as well as test re-projections for the expected results on a single set of 2D

or 3D coordinates.  For more information on the use of this tool, please see the GeoEdit  section.

This tool, as well as many other coordinate system related functions, requires that the Blue Marble

Geographics shift files be installed.  See Page 23 of the Installation and Licensing Guide for download

and installation details.

XYZ Shift: This tool is used to shift LAS data in all loaded files in six different directions:

1. East (a positive shift in the Translation East text box) 

2. West (a negative shift in the Translation East text box) 

3. North (a positive shift in the Translation North text box)

4. South (a negative shift in the Translation North text box)

5. Higher in Elevation (a positive shift in the Elevation Adjustment box)

6. Lower in Elevation (a negative shift in the Elevation Adjustment box)

All loaded files will have the same shifts, specified by the user in the 'MARS LAS Shifter' interface,

applied to them.  To shift only selected (highlighted) files, use the 'Shift' button at the top of the Table of
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Contents . 

 ** NOTE: If multiple shifts are applied to a single project, the effect is cumulative. Each shift

is applied to the existing XYZ offset in the header.**

            

An OFF file (*.off) will be created for each file that is shifted storing the X, Y, and Z offsets that existed

in the file before the shift was processed.  These 'offset' files will be created with the same name and in

the same folder as their corresponding LAS file(s).  They are used with the 'Report LAS Shift' tool

(below) as a baseline.  If the *.off files are moved, renamed, or deleted, they will be recreated the next

time the MARS LAS Shifter is run, but with the then-current offsets used as baselines.

Report LAS Shift: Shifting LAS data using the Table of Contents  'Shift' button or the 'XYZ Shift' tool

(see above) produces a *.off file (one per shifted LAS file) which stores the pre-shift X, Y, and Z offset

64
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values read from the LAS file header.  These files are created in the same folder as the LAS files that

were shifted.  The *.off files are used as a baseline by the 'Report LAS Shift' tool to create a comma-

delimited (*.csv) report that stores the total (cumulative) shift for each of the files chosen to be included

in the report.  To use the tool, add one or more shifted LAS files using the 'Add' button, or add an entire

folder of shifted LAS files using the 'Add From Folder' button.  Choose a path and file name for the

output CSV file - click on the ellipse  button, then navigate to the desired output folder and enter a

filename and finish by clicking 'Save.'  To create the report, click the 'Run' button at the bottom of the

tool interface.

Z Shift for LAS files (available with Production license only): The 'Z Shift for LAS files' tool is
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located under the 'Z Shift' drop-down button. It will allow the user to batch shift the Z-value (level the

elevation) of all LAS files in a project by use of a comma-delimited *.csv file. This tool is meant for use

after boresighting has been completed. The corresponding *.csv file must include a header row (as

shown in the sample below), followed by the file names of the LAS files to be shifted and the adjustment

value to be made to each file. It is important to note that the adjustment values to be made to each file

need to be in the project units unique to that particular project. A sample *.csv file may be seen inside

the 'Z Shift for LAS files' interface. To use this tool, point to the LAS files by clicking on the 'Add' button

in the upper-right corner and add the LAS files which need shifting. To remove single or multiple files,

highlight the file(s) to be removed and click on the 'Remove' button. Specify the corresponding *.csv file

in the 'Spec File (CSV)' section and (optionally) designate an output folder. If no Output Folder is

specified, the input LAS files will be overwritten.

Z Shift On Intensity (available with Production license only): The 'Z Shift On Intensity' tool is located

under the 'Z Shift' drop-down button. This tool is capable of shifting LAS data that matches a specific
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user defined intensity value. The ‘Z Shift Value’ (amount and direction of shifting) is also defined by the

user. 

After the LAS data is added into the ‘Z Shift On Intensity’ tool, the 'Intensity Requirement' text boxes are

used to specify an ‘Intensity’ value that will be used to identify which points should be shifted, and the ‘Z

Shift Value’ to apply to those intensities. Multiple entries can be made in this section. An output folder

can be designated and progress can be tracked in the ‘Z Shift On Intensity’ interface. If no Output

Folder is specified, the input LAS files will be overwritten.

Z Shift On Class (available with Production license only): The 'Z Shift On Class' tool is located under

the 'Z Shift' drop-down button. This tool is similar to the 'Z Shift On Intensity' tool, but uses

classifications to determine which points will be shifted.

After the LAS data is added into the ‘Z Shift On Class’ tool, the 'Class Requirement' text boxes are used
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to specify a ‘Class’ value that will be used to identify which points should be shifted, and the ‘Z Shift

Value’ to apply to those classes. An output folder can be designated and progress can be tracked in the

‘Z Shift On Class’ interface. If no Output Folder is specified, the input LAS files will be

overwritten.

Convert to Modified EO Files: This tool allows a 'Combined Factor' or its reciprocal to be applied to

one or more EO (exterior orientation) files.  The EO files must be in a text (*.txt) format.  To use the tool,

navigate to a file or folder with the 'Add' or 'Add From Folder' buttons, then enter the 'Combined Factor'

value in the text box found in the middle section of the interface.  Choose the desired calculation method

- either 'Combined Factor' or 'Reciprocal of Combined Factor' - and click the 'Run' button.  A new file or

files will be created with '_mod' appended to the original name(s), along with a log file storing the value

used.  These will be located in the same folder as the original file(s).
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Add CRS Info (to LAS Files): This tool allows the user to add or update coordinate reference system

(CRS) information in an LAS file.  For LAS version 1.4 files, the tag is written as WKT (Well-Known Text)

in an Extended Variable Length Record (EVLR).  Running the tool with no information entered in either

the Horizontal or Vertical sections will result in any existing info being cleared.  This tool is capable of

processing an entire folder of LAS files ('Add From Folder'), or the user may specify one or more

individual files ('Add').  Files already added can be removed by using the 'Remove Selected' or 'Remove

All' buttons.
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After choosing the desired file(s) or folder, select the coordinate reference system that the data is in by

clicking the 'Edit' button beside the 'Projection Definition (WKT)' text box. The 'CRS Info (Projection

Definition) Written as WKT' window will then appear.
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Click the browse button ('...') next to the 'Horizontal Projection Description' text box to bring up the

'Coordinate System' selection interface, and choose the horizontal coordinate system of the data. The

user may either navigate to the system which defines the data and click 'OK', or the 'Find' search

engine at the bottom of the interface may be used to help find the desired coordinate system.
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Next, click the browse button ('...') next to the 'Vertical Projection' text box to bring up the 'Vertical

Coordinate System' selection interface, and choose the vertical coordinate system of the data in a

similar manner.

Be sure that both the 'Horizontal Unit' and 'Vertical Unit' boxes are correctly populated on the 'CRS Info

(Projection Definition) Written as WKT' interface.
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The 'Height Model', if known, can be selected by using its browse button and choosing the appropriate

model from the 'Vertical Transformation' selection interface.

When all information has been entered on the 'CRS Info (Projection Definition) Written as WKT' interface,

click the 'OK' button to return to the original 'Add CRS Info (to LAS Files)' tool.
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Like many other MARS® tools, this tool is capable of multi-threading to decrease processing time.  The

'Number of threads to use' text box at the bottom of the interface will automatically be populated with

the maximum number of threads available on the particular computer in use.  A lower number of threads

can be entered as needed.  A value of '1' is equivalent to single-thread processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

 Click on the 'Run' button at the bottom of the interface to start the processing.  The file or files that

were defined will appear in the 'Results' section, and a completed message will indicate when all

processing is finished.  The 'Clear' button can be used to remove 'Input LAS Files' and 'Results'

information to prepare for additional processing.

Add Geo Tags (to Tiff Files):  This tool is a GeoTiff header tool meant for use with georeferenced tiff
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files.  By navigating to the *.tif file to be converted and specifying all of the needed information, the user

can produce a *.tif which will function on its own without the accompanying tiff world file (*.tfw).  To

produce a single GeoTiff file, start by navigating to the file which is to be defined.  The *.tif and

accompanying *.tfw must both reside in the same folder.  If only a single file is to be defined, it is easiest

to use the 'Single TIFF to process' text box.  If an entire folder of tiff files is to be defined, using the

'Folder to process' text box will be faster.  For the folder option, navigate to the folder which contains the

tiff files to be defined.  As the tiff images are loaded into the interface, the 'Image Description' and 'GT

Citation' sections of the interface will automatically populate.  If the user wishes to add a prefix or a suffix

to the tiff file name(s), these can be specified under the 'Document Name' section.  Lastly, specify the

projection of the tiff file in the 'Projection' section.  The user may choose the projection from a list by

choosing the '...' button and either navigating to or running a search for the needed projection.  Once the

projection has been chosen, the 'EPSG Code' will automatically populate.  Make sure to choose the

correct horizontal unit, and the tiff file(s) will be ready to be defined.  Click the appropriate 'Convert'

button at the top of the interface and the 'Running Status' section of the interface will show the progress

of the tool.  The new tiff file(s), with georeferenced information in the header, will be found in the same

folder in which the original tiff files were found.  The original tiff file(s) will be replaced.
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Verify/Remove LAS Projection Info: This tool allows the user to verify the projection definition

(coordinate system) information for an LAS file or an entire folder of files and, optionally, save the

displayed output to a Results File.  The user can navigate to an individual LAS file or a folder of LAS files

depending on the browse button used.  Clicking on the corresponding 'Verify' button will start the

process and the results will be shown in the 'Results:' box.  If the user wishes to clear (remove)

projection information from an LAS file or folder of files, click on the corresponding 'Remove' button.

The 'Repair' button fixes certain errors in superseded WKT-based coordinate system tags in LAS v1.4

files.  The function will search all EVLRs or VLRs containing superseded WKT tags and fix incorrect

'Record ID' values of '0' (zero) to the correct value of '7'.  It will also fix incorrect values of the 'User ID'

field - 'LAS_Spec' and 'LASF_Projection' - to the correct 'LASF_Spec' for superseded records, so that

the files will be in compliance with ASPRS specifications.
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In addition, an option - 'Include all header information' - exists that will display and, optionally, save

the header contents (similar to metadata) as well as the projection information.
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The 'Clear' button can be used to remove 'Input/Output' and 'Results' information to prepare for

additional processing.

 

© 2000-2023 Merrick & Company. All Rights Reserved.

3.7 Edit/Filter Tab

Edit/Filter Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software
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The Edit/Filter Tab:

From Class drop-down list: This allows the user to pick from ALL classes, a selected set of classes

(see below), or any one of the 256 individual LiDAR classes to be the source class(es) for manual

editing actions.

Edit Selected Set: This function allows the user to make a selected set comprised of any

combination of LiDAR classes to be used when the '- Selected -' option is chosen in the 'From Class'

drop-down list. More details about using and saving selected sets can be found in the Manually

Editing LiDAR Data  tutorial. 

To Class drop-down list: This allows the user to pick from any one of the 256 individual LiDAR

classes to be the target class for manual editing actions.

Edit Paint Small: This paint utility is the smallest paint tool. It reclassifies visible points selected by

clicking or dragging the cursor box over them (in both 2D and 3D Views).  To make edits in 3D the

user must be either zoomed in to 100% point density or have the 'Lock to view 100%' button toggled

on - the paint brush buttons will not be available otherwise.  Also while in 3D, if TIN rendering is used

only those classes being displayed as Points (see the Display Selection | Classification section of

the View Tab  topic) can be edited.  It is possible (but not recommended) to edit in 2D View at less

than 100% point density, but some points may be missed this way.  Changes are made

immediately to the loaded data.

Edit Paint Medium: This paint utility is a medium-sized paint tool. It reclassifies visible points

selected by clicking or dragging the cursor box over them (in both 2D and 3D Views).  To make edits

1661
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in 3D the user must be either zoomed in to 100% point density or have the 'Lock to view 100%' button

toggled on - the paint brush buttons will not be available otherwise.  Also while in 3D, if TIN rendering

is used only those classes being displayed as Points (see the Display Selection | Classification

section of the View Tab  topic) can be edited.  It is possible (but not recommended) to edit in 2D

View at less than 100% point density, but some points may be missed this way.  Changes are made

immediately to the loaded data.

Edit Paint Large: This paint utility is the largest paint tool. It reclassifies visible points selected by

clicking or dragging the cursor box over them (in both 2D and 3D Views).  To make edits in 3D the

user must be either zoomed in to 100% point density or have the 'Lock to view 100%' button toggled

on - the paint brush buttons will not be available otherwise.  Also while in 3D, if TIN rendering is used

only those classes being displayed as Points (see the Display Selection | Classification section of

the View Tab  topic) can be edited.  It is possible (but not recommended) to edit in 2D View at less

than 100% point density, but some points may be missed this way.  Changes are made

immediately to the loaded data.

Edit Digitized Polygon: Allows the user to create a polygon in the LAS Map View window (only while

in 2D View  mode) for reclassification of visible points.  Left-click the mouse to place polygon

vertices, and right-click to close the polygon and re-class the points inside, based on the settings of

the 'From Class' and 'To Class' drop-downs.  See the Fast Massive Reclass topic (below) for details

on optionally saving the digitized polygon for later use.  Changes are made to the loaded data.

Edit Selected Polygons: This tool starts the edit process for visible points within any polygon(s)

selected with the 'Select Polygons' tool (see below).  Before using, first render the LAS Map View data

using 'Color by Classification' by clicking the  button on the View Tab , or use the 'CTRL-C'

shortcut key (this will allow a visual confirmation as each selected polygon is processed).  Then,

192
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choose a 'From' class (or classes) and a 'To' class.  Changes are made to the loaded data.  This

option is only available for editing while in 2D View  mode.  If the 'Edit Selected Polygons' button is

clicked before any polygons have been selected, the following message will appear:

 

Fast Massive Reclass: When this tool is toggled on (highlighted in orange), the performance of both

the 'Edit Digitized Polygon' and 'Edit Selected Polygons' manual reclassification methods (see above)

is improved.  In addition, each time the 'Edit Digitized Polygon' tool is invoked while 'Fast Massive

Reclass' is toggled on, a prompt appears asking if the polygon about to be digitized should be saved

to a polygon shapefile.

A 'No' answer will switch to the digitizing cursor and a temporary polygon can be created.  A 'Yes'

answer will display an additional prompt as to whether the polygon about to be digitized should be

appended to an existing polygon shapefile.

835
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A 'Yes' answer allows the user to navigate to an existing polygon shapefile to which the new polygon

feature will be added.  After choosing the pre-existing shapefile, digitization can begin.  A 'No' answer

allows the user to path out and name a new polygon shapefile for storing the newly-created polygon after

which digitization can begin.

Select Polygons:  Use this tool to select any pre-existing polygon(s) for visible point reclassification.

A polygon shapefile must be loaded as a Reference Shapefile to use this tool. Use the 'Add

Reference Shapefiles' button  on the Project/Data Preparation Tab  to load the

polygons.  When a shapefile is added this way, the user can reclassify points within polygons of any

shape.  This tool is used to select a single polygon or multiple polygons for use with the 'Edit Selected

Polygons' tool (see above), and works only in 2D View .  To use, left-click and drag the cursor over

the polygon(s) to be reclassed - they will be highlighted in a thicker line weight.  Additional polygons

can be selected by holding down the 'Ctrl' key on the keyboard and clicking on a polygon(s).

Individual polygons can be removed from the selected set using the same 'Ctrl' key/mouse-click

combination.  Note that if multiple polygon shapefiles are loaded, all polygons from all shapefiles that

fall within the selection area will be selected.  If this tool is used when no polygon shapefile is loaded

as a Reference Shapefile, a prompt will appear allowing the user to load one.

162
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 Undo: This tool will undo an edit process each time it is selected. This tool is useful when an

edit process is not done correctly. It can be undone and the user can attempt the edit process again. 

 Redo: This tool will redo an edit process each time it is selected. This tool can be used only

after the 'Undo' tool has been used - it will 'redo' an undone process.

Please see the examples below to see the functions of the 'Undo' and 'Redo' tools.

In this first example, a bit of vegetation next to a river has been incorrectly classified as ground.

In the next example, the misclassified ground point has been changed to vegetation. However, the
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editor has made a mistake and has accidentally classified the ground below the vegetation as

vegetation. By click ing on the 'Undo'  button, this mistake is easily reversed and the point

classifications that were changed  to vegetation will go back to their original ground value as if the edit

was never made. To reverse an 'undo' action, click  on the 'Redo'  button and the edit that was

made will reappear.

Save cached points to disk: This button is currently disabled.  Due to LAS datasets becoming

increasingly larger in file size (frequently surpassing the available RAM in a computer) as well as the

possibility of lost work caused by an unexpected shutdown of MARS prior to a save operation, the

‘Cache points into available RAM’ option has been disabled.  LAS data will be read from disk and ‘live’

edit changes (such as hand filtering) are committed to disk as soon as they occur.  Additionally, with

newer, faster hard drives such as SSD, the performance difference between disk-based and RAM-

based operations is constantly shrinking.
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Create/Edit Script: The user can create, edit, and save macros (a sequence of filters and/or

extraction tools) in a batch script using this tool. The user may also add comments to each filter/

extraction tool, which will be shown after the filter/extraction tool in the 'Create/Edit Batch Script'

window.  Note that the reserved XML characters <, >, %, &, ', " cannot be used in the Comments box

for any filters/extraction tools.

1.) To create a batch script, first create a name for the macro which will contain the list

of steps in the 'Macro Name' text box (the default name is Test, but has been changed

to Macro_1 by overwriting Test and clicking the 'Update' button). Then choose the

desired filter/extraction tool from the list of 'Available Filters' on the left side of the

window. To learn more about the types of filters and extraction tools, please see the 

Filter Action  and Extraction Tools  topics.

2.) After choosing the first filter/extraction tool to be added, click either 'Insert Before' or

'Insert After' to insert it into the list under the macro name in the center area of the

986 1172
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interface.

3.) Continue making a list of filters/extraction tools to complete the macro. Highlight an

existing filter/extraction tool and use the 'Insert Before' or 'Insert After' buttons to place

the filters/extraction tools in a particular order. If the user wishes to move one already

placed into a list as a macro is being created, or move one or more in a previously-

created batch script (XML) file, select the filter/extraction tool to be moved and choose

either the 'Move Up' or 'Move Down' button (as appropriate) located on the right side of

the window.

4.) After adding all the filters/extraction tools that will make up the macro, double-click

on any entry in the list (or select an entry in the list and click the 'Edit' button on the

right side of the window) to bring up the first 'Filter Options' window (below, left).  Use

the 'Previous' and 'Next' buttons to navigate to the filter/extraction tool whose

parameters need to be set or edited, then click the 'Edit Options' button to bring up the

specific 'Filter Options' interface for the chosen filter/extraction tool (below, right).
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In the screen shot above (right), the Intensity filter parameters have been brought up for

editing. The user may enter comments in each filter which will then be seen in the

'Create/Edit Batch Script' interface.  Remember that the reserved XML characters <, >,

%, &, ', " cannot be used in the Comments box for any filters/extraction tools.  For

more information on how to set the parameters of a specific filter/extraction tool, please

see the lists under the Filter Action  and Extraction Tools  topics.

5.) Unneeded steps can be removed from a macro by selecting them (one at a time)

and clicking the 'Delete' button on the right side of the window. 

6.) When all the filters/extraction tools have been added and/or edited, save the batch

script file by clicking on the 'Save as' button and browsing to an output folder. Now that

the file (in XML format) has been saved, it can be loaded at any time for further editing or

use.

7.) To create multiple macros inside a single XML script file, type a new macro name in

the 'Macro Name' text box of the 'Create/Edit Batch Script' window and click on the

'New Macro' button. A new macro header (Macro_2, above) will appear in the center

area of the window and filters may be added to this macro as described above. 

986 1172
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Load Script: If a batch script XML file has previously been created, it can be loaded into MARS® with

this command.  Only one XML script can be loaded at a time - a subsequent load will replace the

previous XML file.  Browse to the folder which contains the .xml file, choose it, and click 'Open' to load

it into MARS®.  Upon loading the script, all macros within it will be added to the list of available filters

in the 'Filter Action' drop-down (see next topic), with the first macro appearing automatically at the

top of the list.  All macros within a script can be accessed by scrolling down to the bottom of the

drop-down, immediately following the list of discrete ('built-in') filters. Once a macro is selected, it can

be edited by using the 'Script Edit'  button located on the Edit/Filter Tab .  Edits made while

the script file is loaded are saved immediately.  If a MARS® project file (*.mpd) is created or saved

with a macro from a batch script loaded, the macro will be saved in that project. See the Filter Action

 topic for more information on how to use filters.

Quick Classifications:  This filtering method - written, distributed, and licensed by rapidlasso GmbH

- uses algorithms and routines that are part of the LAStools software suite to classify ground and,

optionally, high vegetation and buildings.  Its use requires that at least part of the LAStools suite ('

lasground_new.exe' and 'lasground_new64.exe' at a minimum) be present on the local computer or in

an accessible network location that can be pathed out.  The minimum required version of LAStools for

use in MARS® will contain a 'CHANGES.txt' file dated November 8, 2018, or later.  The LAStools suite

can be downloaded at no charge, but licensing is required to use the classification routines in a

commercial, government, or production environment.  Unlicensed use in any setting may cause data

corruption!  As taken from the rapidlasso GmbH website, "Note that the output of the unlicensed

version can be slightly distorted after certain point limits are exceeded."  Please contact rapidlasso

GmbH by e-mail directly at info@rapidlasso.com for general information including questions about

licensing and allowable use, or see the rapidlasso GmbH website for details.  For pricing information,
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go to http://rapidlasso.com/pricing.  Licenses are available for the entire LAStools suite, or the

components needed for the 'Quick Classifications' tool can be licensed separately at a reduced cost. 

All licensing, pricing, and payment is handled directly between the end user and rapidlasso GmbH -

Merrick & Company has no involvement at this level.

If the vegetation and building filtering option will be used:

Either two or four additional executable files (*.exe) - depending on the license status - from the 

LAStools suite must be in the path entered as in the example shown in the first graphic following the '

License Status' table.  Both 'lasclassify.exe' and 'lasclassify64.exe' are needed with or without a

license, while 'lasheight.exe' and 'lasheight64.exe' are additionally required when no license is present.

 Remember that unlicensed use is limited (by rapidlasso GmbH) to testing and/or evaluation only.  A

license purchased for this tool will authorize the Ground Filter  tool as well.

License Status:

Licensed Unlicensed

lasground_new.exe and lasground_new64.exe files
needed:

lasclassify.exe and lasclassify64.exe files needed: 1 1

lasheight.exe and lasheight64.exe files needed: N/A 1

   1 - required only

if the vegetation and building filtering option is used.License Status:

As implemented in MARS®, 'Quick Classifications' is used to produce tiled, classified LAS files based

on an existing tile layout shapefile.  The tool takes unclassified or partially classified data as the input

and creates  tiled files with ground points and unclassified points, with an option to also classify

buildings and high vegetation once ground is known.  The input data will not be altered with this tool.

1034
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The LAS data to be re-classified must be loaded along with a polygonal tile shapefile that has the

same coordinate reference system definition.  Once these are loaded, click the 'Quick Classifications'

button  to get started.  A window will appear where both the data units and the

path to the LAStools executable files and the license file (if purchased) must be set.  The LAStools

software suite can be downloaded from a link on this interface.  The minimum required version of 

LAStools for use in MARS® contains a 'CHANGES.txt' file dated November 8, 2018, or later.  

 

The data units must be set each time the tool is used - a correct entry is critical to the operation and

results of the classification routines.  The path to the LAStools files will be stored for future use, but

can be updated if the location of the files is ever changed.  If the units are not selected, or the path

entered to the LAStools folder does not exist, or the path entered does not contain the minimum

required LAStools files, the following messages will appear when the 'OK' button is clicked:
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When the data units are entered and a valid LAStools path exists, click 'OK' to bring up the main
'Quick Classifications' interface.  The interface consists of four tabs:
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Filter Settings tab:  The Source and Target classes are selected here.  By default, all 256 classes

are included in the 'Source Classifications', but this can be changed by clicking the 'Select'

button.  Likewise, defaults are set for the 'Target Ground Class' as well as the optional 'Target

Vegetation Class' and 'Target Building Class'.  These are based on the ASPRS standard

classes for these features, but they can be modified by clicking the appropriate 'Select' button

(s).  For info regarding the 'Ground Filter Options' and 'Vegetation and Building Filter Options'

tabs, see below.

Output tab:

Field for Tile Name: Select an attribute field with unique values for the output tile naming.

Suffix: Optionally, specify a suffix to be appended to the tile name for the output files.
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        NOTE:  The naming convention selected will be applied to all output LAS files.  

Output Directory: Browse to select an output folder where the final processed tiled LAS files

will be stored.

Save to Local Option: When the 'Output Directory' is a network location, temporary local disk

space can be used to speed up processing.  Select this option by checking the box and then

specify a temporary local folder with sufficient free space.  The 'Temporary Folder' specified 

WILL NOT be the final output folder, but rather is a local directory which can be used to speed

up the processing.  The output data will be moved to the 'Output Directory' when all processing

is complete.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that a sub-folder be used for

this option.

Tiles tab:

Tiles Selection: The 'Use selected tiles' check box is checked on by default. Keep this box

checked if the tiles which are to be processed have been selected in the tile layout.  If the user

would like to run 'Quick Classifications' on other (specified) tiles, enter those tile names (using

the 'Field for Tile Name' attribute) into the 'Tile Names' text box separated by commas.

Options tab:

Tile Edge Buffer: The default value, as recommended by rapidlasso GmbH, is '30' when the

data units have been set to 'Meters'.  When 'US Survey Feet or International Feet' is set, the

value is automatically converted to 98.424 units.  In either case, this value can be modified. 

This buffer will be added during processing to improve the results, and cut back to the original

tile boundary when processing is finished.

Existing Files: The 'Skip' radio button can used as a safeguard if for some reason processing

is stopped (e.g., power failure, computer shuts down, an error occurs, etc.).  When the user

starts processing again, checking this button will cause the software to skip any tiles which

already exist in the specified output folder.  Tiles which have already been processed will not
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be run again and the software will process only those tiles which are not found in the output

folder.  (For this reason it is suggested that if processing stops for any reason, the user should

go into the output folder and delete the last tile that was processed based on the timestamp. 

This tile may not be complete, but since the tile name exists in the output folder it would

otherwise be skipped.)  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

Upon completion, unload input data and load output data: This option is self-explanatory.

General interface options:

'Multi-Threading' section: To help speed up processing, multi-threading is available for this

tool.  Enter any number of threads from 1 to the maximum number available in the text box.  If

‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed)

per thread.

The 'Filter Settings' tab is further divided into 'Source/Target Classes' (see description and upper-left

graphic, above), 'Ground Filter Options', and 'Vegetation and Building Filter Options'.  By default, the

'Perform vegetation and building filter classification processing' box is checked on the ''Vegetation and

Building Filter Options' tab.  To use this option, 'lasclassify.exe' (as described near the top of this

topic) must exist in the specified LAStools path.  The latter two interfaces (shown below) have 'Help'

links in the upper-left corners that go directly to the LAStools read-me files for 'lasground' and

'lasclassify', respectively.  The parameters on these tabs are explained in those read-me files, which

are updated and maintained solely by rapidlasso GmbH.  The 'lasground' read-me file is based on an

earlier (but very similar) iteration of the ground classification executable.  As of the release date of this

version of MARS®, LAStools was not yet hosting a read-me file for the 'lasground_new.exe'

executable that is used in this batch filter tool.  However, it is available in the downloaded LAStools

suite package as 'lasground_new_README.txt'.  All the controls and entries within the red boxes (see
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below) feed directly into the arguments of the LAStools executables.  When all settings have been

made, click the 'Run' button in the lower-right corner of the interface.
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If a license for LAStools has not been purchased or is not present in the path to the executable files,

the following warning message will appear immediately after clicking 'Run':
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The following message will appear when the 'Quick Classifications' routine is finished:

Filter Action Selection List: This drop-down list contains the 31 filters included with MARS®, plus

any macros within a script file loaded with the 'Load Batch Script' button (see above). Use this list to

choose from the filters: Building, Change Bit Flags, Consistent Return, Ditch and Berm, Elevation,

ENVI Reclass, Extreme High, Extreme Low, Ground, Ground Distance, Height from Surface,

Intensity, Isolated Point, Max Grid, Median Grid, Min Grid, Model Key-point, Percolate, Plane

Analysis, Reclassify, Return, RGBNI Value, Scan Angle, Slope, Smart Clip, Smooth Grid, Smooth

Max Grid, Smooth Min Grid, Timestamp, XY Distance, or XYZ Distance.  Detailed information about

using these filters can be found in the Filter Action  topic and its sub-topics.

Filtering Options: Allows the user to specify the filter parameters. A unique filtering options interface

will appear for each different filter. Please click on the following link(s) for more information on how to

use the 'Filtering Options' dialog for the filters included with MARS®.

Filter Action Tools:

• Building  • Change Bit Flags  • Consistent Return  • Ditch and Berm  • Elevation  •

ENVI Reclass  • Extreme High  • Extreme Low  • Ground  • Ground Distance  • Height

from Surface   • Intensity  • Isolated Point  • 

986

987 993 1000 1007 1012

1017 1024 1029 1034 1043

1051 1058 1062



MARS® v2023.1           User Manual290

© 2000-2023 Merrick & Company

Max Grid  • Median Grid  • Min Grid  • Model Key-point  • Percolate  • Plane Analysis

 • Reclassify  • Return  • RGBNI Value  • Scan Angle  • Slope  • Smart Clip  •

Smooth Grid  • Smooth Max Grid  • 

Smooth Min Grid  • Timestamp  • XY Distance  • XYZ Distance  •

Filter Region: Once the desired filter or macro has been chosen and the filtering options have been

specified, this button initiates the processing for a selected area of the project. This tool provides the

user with a ‘drag box’ to graphically define a rectangle for the desired area. The tool will remain active

to allow multiple areas to be processed - right-click the mouse or use the 'Esc' key to dismiss the

tool.  This is the only reclassification method that can be used for the Ground Filter .  The loaded

LAS data is modified with this tool.

Filter Digitized Polygon: Use to run a filter or macro on a user-created polygon in the LAS Map

View window.  Left-click to create the vertices of the polygon, and right-click to close and start the

processing.  Before closing the polygon, the 'Ctrl-Z' shortcut key can be used to delete the most

recently placed vertex.  The 'N' shortcut key allows re-use of the last polygon created.  The loaded

LAS data is modified with this tool. 

Filter Selected Polygons: Use to run a filter or macro based on the area of a pre-existing polygon

(or multiple polygons) in the LAS Map View window.  The polygon shapefile must be loaded as a 'Tile

Shapefile' and the desired polygon(s) must first be chosen using the 'Pick Tiles' tool (see below).  The

loaded LAS data is modified with this tool.

LiDAR Spatial Reclass: The LiDAR Spatial Reclass tool provides two basic functions: 1.) To reclass

the interior points of breakline polygons contained in a shapefile and, 2.) To reclass points in a buffer

area around breakline polylines contained in a shapefile. For example, if the user were to select a
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shapefile containing polygons representing water bodies in the 'Candidate Shapefile' section of the

tool, the points bounded by the polygons would be reclassed to Class 9: Water in the example below.

Additionally, if a shapefile of polyline breaklines were to be used as the candidate shapefile in the

LiDAR Spatial Reclass tool, the ground points within a specified buffer distance around each breakline

would be reclassified to an ignored classification such as Class 20: Ignored Ground in the same

example. The shapefiles specified for use in the tool do not need to be loaded into MARS® for this

tool to process them.  When run, the loaded LAS data is modified with this tool. 

            

Shapefile: Used to path out to the candidate shapefile(s). This will be a shapefile containing

either polygon breaklines or polyline breaklines which need points to be reclassified within or
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around them 'Buffer').  Multiple entries may be made here (see 'Add to List', below).  Either a

2D or 3D shapefile can be used.

Source Classifications: The user will specify here which class(es) of points will be used to

determine candidates for reclassification.  This is done separately for each shapefile added.

Target Class: The points chosen as the 'Source Classifications' will be reclassified to the

'Target Class' if they meet the conditions set by the 'Buffer' value (below).

Buffer: This option allows the user to define a buffer area around each breakline contained in

the source shapefile(s).  A buffer will most often be used with a shapefile of breakline

polylines, but may also be used with a polygon shapefile to reclass a buffer around the

outside of the polygon(s).  The larger the buffer around each breakline, the more data that will

be reclassified.  The user may determine how many units on each side of the breakline that

source points will be reclassed by entering an integer into this text box. If no buffer is

specified, there will be no buffer run on the data. 

Add to List: This button allows the user to add the candidate shapefile and specific

parameters pertaining to that shapefile to the table in the LiDAR Spatial Reclass tool.  Once a

shapefile and its specifications have been entered, the 'Candidate Shapefile' section will clear

allowing the user to add another shapefile and its particular parameters.  If the user does not

click on the 'Add to List' button to load the shapefile and settings into the interface, the tool

WILL NOT process that particular shapefile. 

'Added Shapefiles' section: The table in this section shows the user a list of the shapefiles

and the unique specifications for each that will be processed.  The user may enter several

different shapefiles in this area and each shapefile will be run separately (and consecutively)

with its own unique, user-defined specifications.  Please see the example above to view two

separate shapefiles loaded to be processed with two different sets of parameters.

Count: This display at the bottom of the 'Added Shapefiles' section is informational only and

keeps a count of the number of files loaded into the 'Added Shapefiles' area. 
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Remove All: The 'Remove All' button will allow the user to clear the 'Added Shapefiles' table

of all shapefiles which have been added for processing.

Step Size: The user may specify here how much data the tool will work on at a time.  For

example, a step size of 2500 causes a 2500 unit x 2500 unit area to be processed at a time.

In general, the larger the step size the faster the process will run, but more available RAM is

needed for larger step sizes.  The tool will not function without a step size entered.

Save Settings to File: This tool is capable of saving the user-defined settings to an *.xml

file. To use, click the 'Save Settings to File' button, save the file with a unique name, and a

*.xml will be created that can be loaded for later use.

Load Settings from File: If settings inside the 'LiDAR Spatial Reclass' interface have been

saved previously, they can be loaded by clicking the 'Load Settings from File' button and

navigating to a saved *.xml file. 

'Multi-threading' section: To help speed up processing, multi-threading is available for this

tool.  Enter any number of threads from 1 to the maximum number available in the text box. 

This option requires that a tile layout (polygonal shapefile) be loaded and some (or all) tiles

picked to cover the area to be processed.  The Pick Tiles  tool can be found on the Project/

Data Preparation , Edit/Filter , or Export/Extract  tabs.   If ‘1’ is entered in the text

box, it is equivalent to single-threading the process.  For best performance, there should be a

minimum of eight (8) GB of RAM available (not just installed) per thread.

Batch Process Tiles: This option (commonly known as Auto-Filter) allows the user to run a single

filter or filter macro script by tile and will output the results to a new v1.4 LAS file(s). Choose the tile

(s) to filter with the 'Pick Tiles' tool (see below) before clicking the 'Batch Process Tiles' button.  For

more information, see the Batch Filter/Extraction Processing  topic.

959
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: The purpose of this and the following "Script Debug" tools is to allow the user to

run through filters in a macro step by step (manually) rather than running the macro in batch process

mode. This button allows a box to be dragged over a test area - filters can then be run one at a time

and the user can easily distinguish the breaks between filters. This allows the user to stop

processing at any point to see the effects an individual filter may have on the data as well as to edit

the parameters of the filter. While debugging, the Status Bar  will display a short summary of the

filters found in the loaded macro. The first number tells the user which filter of the total number of

filters in the macro the software is running. (ex: 6/18: the software is currently processing the sixth

filter in a macro which has a total of 18 filters). The name of the filter currently running will be shown

next to these numbers, along with the name of the next filter in the macro. This is to let the user

know which filter is running if it should need to be edited or deleted from the macro. This manual

method is slower than batch processing, so this method should only be used for testing. Batch

processing is run in RAM, so it can run behind the scenes more quickly for high performance.  See

'Load Batch Script" (above) for information on loading a macro script to use in debugging.

: This tool allows the user to step through each filter of a batch macro script. Clicking

this button once will only run through the next single filter in the macro script.

: This tool rolls back the actions of the last filter process.

: Proceed through the macro to the end of the macro script.

: Stop filtering process after clicking 'Script Debug Go'. This tool is especially useful

when the user has started a large batch auto-filter and needs to stop the process of the filter without
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canceling the action entirely.

: Restart the filtering process.

: Will bring up the edit dialog window to modify the loaded macro.  Changes made here

will be immediately saved in the XML file.

Pick Tiles: This tool is used to select a single tile or multiple tiles for batch processing functions.

The button is disabled until a polygonal shapefile is loaded into MARS® as a tile layout.  See the

'Add Tile Shapefile' section of the Project/Data Preparation Tab  topic for information on loading a

tile layout.  This tool works only in 2D View . To use, left-click and drag the cursor over the tiles to

be exported - they will be highlighted in a thicker line weight. Additional tiles can be selected by

holding down the 'Ctrl' key on the keyboard and clicking on a tile(s). Individual tiles can be removed

from the selected set using the same 'Ctrl' key/mouse combination.  Selected tiles will also be

highlighted in the tile shapefile's attribute table.  To view the attribute table, right-click on the tile

shapefile in the Table of Contents and choose 'Attributes'.  Alternatively, the attribute table can be

used to select tiles - use the 'Shift' and/or 'Ctrl' keys on the keyboard the select the desired tile(s)

by row.  The selected tile(s) will then appear highlighted in the LAS Map View window display.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.8 Breaklines Tab

Breaklines Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software
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The Breaklines Tab:

All breaklines tools on this tab are available only with a Production license.

All newly created breaklines and breaklines loaded as regular (meaning editable) or reference

breaklines files will be seen in both the LAS Map View  window and the Cross-Section/Profile

window.  If a file is loaded in MARS® as a reference breakline file, it will be shown with a neon green

symbol in the Table of Contents  - a line for a polyline file, and a filled square for a polygon file.

There are two files loaded into the Table of Contents as seen below.  The file named

'MARS_Sample_Breaklines.shp' (polyline) is shown with a neon green line next to it.  This means the

file is a polyline shapefile loaded as a reference breakline file (non-editable).  The file loaded below it in

the Table of Contents ('sample_Pond_Polygon.shp') is loaded as a regular breakline file - it is a

polygonal shapefile that can be edited.
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MARS® will automatically pan (by default) across the data as the user digitizes breaklines.  This

makes it easier to continue drawing breaklines without having to stop and move the view window to a

different extent.  For example, if the user is adding a breakline and moves the mouse cursor close to

the right side of the LAS Map View window, MARS® will assume the user would like to continue

digitizing to the right.  The window will pan to the right and allow the user to continue drawing without

having to end the current breakline and begin a new one.  This functionality can be disabled and a

manual pan option used as described in the Keyboard shortcuts  section at the bottom of this page.

If any breaklines have been added, modified, or deleted since the last save (see Save Breaklines to

Shapefile(s) , below), a prompt to save will appear when closing MARS®.

NOTE:  Changes to vertex elevation values only (e.g., with tools such as 'Change Elevation for All

Points of Breakline' and 'Change Elevation of Any Vertex') will not prompt a save message when

opening a new project or exiting MARS®.  A manual save must be done first using the 'Save

Breaklines to Shapefile(s)' button (see below ).

 Breakline Properties: Any breakline shapefile which can be loaded into or created in
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MARS® can be edited to fit the user's needs.  With this interface, the user can change the color and

description which represent any breakline, change the style and weight of each feature type,

determine which features will be displayed, define whether or not a particular breakline feature will

affect the TIN edges, insert new features, rename features, toggle 'Fast TIN' on and off, and even load

an existing XML template with saved features and assigned colors and codes.  Feature labeling

options can be accessed by right-clicking on a loaded breakline shapefile and choosing 'Properties

'.  Note that the reserved XML characters <, >, %, &, ', " cannot be used in the Feature Name or

Update Feature Name fields or boxes.  The compilation options are also only for use with breaklines

which have been loaded into MARS®.  With this section of the interface, the user can search for points

to use in elevation calculations, delete certain breakline classifications, and change the distance

between points in a segment of a breakline.

1.) To add a new feature, select a node under which the new feature will belong in the

upper-left corner of the window, name the feature in the 'Feature Name' text box, and
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then click on the  'Add Feature' button to add it to the list of features.  The new feature

will initially be assigned the next highest unused code (which would be 65 in the

example above), a Type of 'LineString', a ZMode of 'TIN', a Color of black, a Style of '0', a

Weight of '0', a Snap Mode of 'Vertex', and a Tolerance of '2'.  All fields can be modified

as needed, but Code values cannot be duplicated.  The new feature will stay present for

the remainder of the current session only, unless the 'Make Default' button is clicked. 

Another option is to save the settings to a user-named settings file that can be called at

any time for a specific need.  This is done by clicking the 'Save Settings to File' button.

Clicking the 'Load Template' button allows the user to choose a previously-saved

settings file.

2.) To change the name of a feature, highlight it by selecting in the list of breakline

feature names (upper-left of 'Breakline Properties' interface), and replace the existing

name with the desired name in the 'Update Feature Name' text box near the lower-left

corner.  Click 'Update' to apply the changes.  The 'Make Default', 'Save Settings to

File', and 'Load Template' functions may be used as described above (item 1).

3.) To move a feature up or down in the list (in both the tree view and the detailed listing

area), select it with a single click and click the 'Up' or 'Down' button at the top left.  The

'Make Default', 'Save Settings to File', and 'Load Template' functions may be used as

described above (item 1).

4.) To change the color of a feature, double-click on the 'Feature Name' or the 'Color'

box in the upper-right section of the interface.  A color palette interface will then be

available to choose a new feature color.  The user can choose from one of the pre-

existing colors, or create a custom color by clicking the 'Define Custom Colors' button. 
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After creating a custom color, click the 'Add to Custom Colors' button.  Make sure the

box representing the custom color is selected and click 'OK' to assign that color to the

chosen feature.  The 'Make Default', 'Save Settings to File', and 'Load Template'

functions may be used as described above (item 1).

5.) To change the line-type (style) of a polygon or linestring feature, click in the 'Style'

box for that feature and enter a value from 0 through 7.  See below for samples of the

eight available styles:

               

Note: Entering any number other than 0 through 7 will result in a solid (0) Style.

6.) Line thickness (weight) can be changed by clicking in the feature's 'Weight' box and

entering a new integer value. 

7.) The 'Tolerance' value sets the maximum snapping distance (in project units) for the

beginning and/or end of a breakline being compiled to snap to an existing breakline

while using the 'Nearest Point' connection option (see Snap Mode Drop-Down ,

below).  The 'Tolerance' value only pertains to the type of breakline being compiled, not

the types that it will be snapped to.  The 'Shift' key must be held down when creating
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the first and/or last point in a breakline to force a snap.

8.) Check (default) or uncheck the boxes labeled 'TIN' to control which breakline

features will have an effect on the TIN surface.

9.) Click 'OK' to make the changes take effect for the current MARS® session only.

See item 1 , above, for details on making the changes permanent, or saving settings

files for later use.

TIN Options: The 'Fast TIN' option will completely disable the effect that all breakline

features have on a rendered TIN surface, regardless of the 'TIN' settings described in 

item 8  in the 'Breakline Properties' section, above.  When on, rendering speed

during pan and zoom operations will be increased, but changes to the TIN surface

caused by breaklines will not be visible.  'Fast TIN' should always be turned off

(unchecked) during breakline compilation.  This checkbox is synced with the shortcut

key option 'Ctrl-T'.

Compilation Options: The 'Search Radius' option allows the user to set the distance

from a new breakline point (vertex) from which to search for LiDAR points to use in

breakline elevation (Z-value) calculations.  The default setting is a 5 unit search radius. 

The 'Ground Classifications' selection determines which class(es) will be used to find

points within the 'Search Radius'.  The 'Reclassed Points' drop-down allows the user to

select the target class for 'Ground Classifications' points that are within the 'Reclass

Buffer Width' (in project units) of compiled breaklines.  This prevents them from being

used as any part of the ground surface during subsequent processing.
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Reset to Default: This button will delete any custom 'MARSBreaklineProperties.xml'

file created in the 'C:\MARS\' folder by using the 'Make Default' button.  The next time

MARS® is opened, the Feature Names, Colors, and other settings will appear as they

did when MARS® was first installed (see interface screen shot, above).  A new default

file can be created, or other saved settings files can be used as described in item 1 ,

above.

 Feature Code Drop-Down: The user may choose the breakline feature code to

be added when placing a new breakline in a MARS® project.  The user may choose to add a breakline

from the following default codes: 3- LiDAR Delete, 6- Road Centerline, 11- Road Edge, 24- Stream, 25-

Pond, 26- River, and 62- Breakline.  By default, the code '3- LiDAR Delete' and '25- Pond' breaklines

are collected as polygons while all other codes listed are collected as polylines.  Additional features

may be added to this list - see item 1  in the 'Breakline Properties' section, above.

 Z Mode Drop-Down: The user may choose the method of elevation assignment

of a collected breakline with this drop-down list.  There are 10 different options:

1. Zero: Choosing this option will lock the elevation of an entire breakline at zero.

2. TIN: This option will place the vertices of the newly created breakline on a virtual TIN

between the two nearest LiDAR points and adopt the elevation of the TIN at each

vertex's XY location. 

3. MinLock: The MinLock option will collect the entire breakline at the lowest elevation

of any LiDAR point found inside the search radius of the first breakline vertex.

4. Lock: Choosing the Lock option will collect the entire breakline at the user specified
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elevation found in the 'Enter a different elevation to use for Z value of new features'

text box.

5. MedOnVertex: This option will place a breakline vertex at the average (or median)

elevation of the LiDAR points which fall within the user-defined search radius.

6. MinOnVertex: This option will place a breakline point at the lowest elevation of the

LiDAR points which fall within the user-defined search radius at any given breakline

point.  The elevation of the resulting breakline may increase or decrease in any

given area of the breakline depending on the lowest available elevation found in a

LiDAR point inside the search area.

7. MinDecreasing: The MinDecreasing option will force the newly collected breakline to

decrease in elevation as it is collected.  This is accomplished using the search

radius specified by the user.  The software will search for a LiDAR point within the

specified search radius that has an elevation that is equal to or lower than the last

elevation assigned to a breakline point.  When a LiDAR point that is equal or lower

in elevation is found within the search radius, the nearest point providing an

elevation with the specifications listed above will be used to assign an elevation to

the newest breakline collection point.  The overall elevation of this breakline will

decrease intermittently through breakline compilation and will never rise in elevation.

8. MaxOnVertex: This option will place a breakline point at the highest elevation of the

LiDAR points which fall within the user-defined search radius. 

9. Grid: The Grid option is most useful in areas with low penetration of ground points

and is similar in function to the GridDecreasing option (below).  The Grid option will

find an elevation to be assigned to a breakline by using a search radius as defined

by the user and a virtual grid.  The elevation chosen to be assigned to each

breakline point will come from an average of the points inside the search radius. 

The elevation of the most recent breakline point collected will also help determine
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the elevation of the next point.  The virtual grid will be used to find LiDAR points with

similar elevations and create a gently sloping breakline in an area of low penetration

of ground points.  Without this grid, the user may witness a 'stair stepping' effect in

which the breakline elevation from one point to the next will drop or rise in elevation

quickly.  With the use of a virtual grid, this effect is minimized and gently sloping

breaklines may be created.

10. GridDecreasing: This option is most useful in areas with low penetration of ground

points and is similar in function to the MinDecreasing option.  The GridDecreasing

option will force the newly collected breakline to decrease in elevation as it is

collected.  This is accomplished using the search radius specified by the user and

a virtual grid.  Using the search radius, the software will search for a LiDAR point

within the specified area that has an elevation that is equal to or lower than the last

elevation assigned to a breakline point.  When a LiDAR point that is equal or lower

in elevation is found within the search radius, the nearest point providing an

elevation with the specifications listed above will be used to assign an elevation to

the newest breakline collection point.  A virtual grid will be made when collecting

each breakline point to assist in creating a more correct breakline with a gradually

decreasing elevation.  Without this grid use in areas of low penetration, the user

may see a 'stair-stepping' effect in which the breakline drops in elevation suddenly. 

This is due to a low penetration of ground points for the breakline to assign an

elevation from.  The virtual grid will help keep this 'stair-stepping' effect from

occurring and will allow the breaklines to decrease in elevation in a more gradual

manner. 

 Geometry Type Drop-Down: Determines the geometry of breakline features.

This drop-down allows the user to choose from a linestring breakline (which does not need to be
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connected to anything at either end), a polygon breakline (which must form an enclosed polygon), or a

break point.

 Snap Mode Drop-Down: The user may choose the breakline connection point

option which will be applied when choosing to snap a new breakline to an existing breakline.  The user

may choose from the following codes and their purposes: the 'StartEndVertex' option will snap the

breakline which is being compiled to the nearest start or end point of another breakline.  The 'Vertex'

option will snap the breakline which is being compiled to the nearest vertex - start, end, or

intermediate - of another breakline.  The 'NearestPoint' option will snap the breakline which is being

compiled to the nearest location of an existing breakline, but only if within the tolerance value set in

the 'Breakline Properties' options (see item 7 , above) and only if the 'Shift' key is held down while

the first and/or last point of the breakline is compiled.  Lastly, the 'MidPoint' option will snap the

breakline which is being compiled to the nearest mid-point between two breakline points.

 Place Breakline: This tool allows the user to place a new breakline into a MARS® project.

When the tool is activated, the breakline will be added to the project with the

specifications of the feature code drop-down options which are chosen.  For example,

if the 'Stream', 'MinDecreasing', and 'LineString' options are chosen in the feature

code drop-downs, then the resulting breakline will be added to the project with these

specifications.  To use, left-click where the breakline is to start. Hold down the 'Shift'

key before left-clicking to force the starting vertex to snap to the nearest existing

breakline, based on the 'Snap Mode' option set in the 'Breakline Properties' interface

(see above) for the pre-existing breakline feature.  Continue left-clicking along the path

that the breakline is to follow.  To create a three-point arc within a breakline, left-click

where the arc section is to begin and then press the 'A' key on the keyboard.  The
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next left-click will place the center of the arc and the following left-click will finish the

arc.   Additional 'normal' vertices can then be placed by left-clicking.  During

compilation, 'Ctrl-Z' can be used to back up one vertex at a time.  When the breakline

is complete, right-click to end it.  If the 'Shift' key is held down for the last vertex, the

new breakline will snap to the nearest existing breakline as described above.  At this

time, the breakline will turn the color assigned to it.

MARS® offers an auto-pan option when collecting breaklines.  This feature will

automatically pan across data in the user-defined direction when the cursor is placed

close to one edge of the LAS Map View window.  To turn auto-pan off and manually

pan across the data, press the 'B' key on the keyboard.  To toggle the auto-pan

feature back on, press the 'B' key on the keyboard a second time.  An indicator on

the LAS Map View window Status Bar shows whether the Auto Pan function is

enabled.  Holding the 'Alt' key down while in collection mode will allow the user to

pan across the data when auto-pan is turned off.  The cursor will temporarily turn from

collection tool to pan tool while the 'Alt' key is pressed.  Alternatively, pressing and

holding the scroll wheel button on most mice while moving the mouse will perform a

panning operation, with compilation paused until the button is released. 

 Delete Breakline as Selected: This tool allows the user to delete an entire selected breakline.

 To use this tool, first select the breakline to be deleted by left-clicking on it.  When

the breakline is selected, it will change to the selected features color.  Left-click

anywhere in the project to delete the breakline.  To deselect a selected breakline,

right-click anywhere in the project. 
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 Partial Delete: This tool allows the user to partially delete a selected segment of a breakline

instead of deleting the entire breakline.  To use, click on the breakline which will be

partially deleted.  The selected breakline will change to the selected features color. 

Left-click on the location in which the partial delete is to start and hold the left mouse

button down, dragging the cursor to the location where the partial delete is to end.  A

white line from the cursor will enable the user to see which areas of the breakline are

being selected for deletion and the breakline will disappear in that area.  Please see

the example of a partial delete on a stream line below.  The green line represents a

stream breakline, and the white line represents the area of the stream breakline which

is being selected for deletion.

 Delete by Fence: This tool allows the user to delete breaklines by using a fence.  This tool
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offers several different types of fencing and the ability to delete inside or outside the user

defined fence.  To use this tool, first select the 'Delete by fence' button.  The 'Fence

Delete Options' interface will then become available.  The user may choose which fence

shape will work best for their purpose (either a box shape or an irregular shaped fence),

and the user may also choose from several delete options such as inside, inside with

overlap, inside clip, outside, outside with overlap, or outside clip.  The 'Box' fence shape

is a drag-box which can be positioned around the breaklines in question.  The 'Irregular

Shape' fence shape option allows the user to create a polygon of any shape by left-

clicking around the area in question, then using a right mouse click to close the fence. 

Once a fence is in place, the user may choose a delete option as listed below.  The tool

can be re-used by clicking the 'Clear Fence' button after a deletion, and drawing a new

fence.

Inside: This option will only delete breaklines which are completely contained within the

user defined fence.  This option will NOT delete any breaklines which are

outside the fence or partially contained by the fence. 

Example: In the example below, Break line #1, which is completely contained

inside the user defined box, will be deleted.  Break lines # 2  & 3 will NOT be

deleted because they are only partially contained in the box.
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Outside: This option will only delete breaklines which are completely outside the user

defined fence.  This option will NOT delete any breaklines which are inside the

fence or partially contained by the fence.

Example: The 3 break lines which are either completely or partially enclosed by

the user defined fence will NOT be deleted.
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Inside with Overlap: This option will delete all breaklines which are completely inside

the user defined box and will also delete any breaklines (in their entirety)

which are only partially contained in the user defined box.

Example: The tool will delete 3 break lines as seen in the case below.  It will

delete the break line which is entirely contained by the user defined box, but it

will also delete the 2 other break lines which are only partially contained in the

user defined box.  All 3 break lines are deleted in their entirety as seen in the

second example. 
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Outside with Overlap: This option will delete all breaklines except those completely

contained by the user defined box.  Any breaklines which are only partially

contained within the user defined  box WILL also be deleted.

Example: In the example below, the only break line which will remain after the

use of this tool is the break line which is completely contained by the user

defined box.  Break lines which are only partially contained in the box will also

be deleted. 
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Inside Clip: This option allows the user to delete only EXACTLY what is found inside

the user defined box.  This may include clipping breaklines which are only

partially included in the user defined area.

Example: This tool will delete exactly what is contained inside the user defined

box.  In this case, it has deleted a break line which was completely enclosed

inside the user defined area, but it has also made two small partial deletes to

two break lines which were also enclosed in the user defined area.
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Outside Clip: This option allows the user to keep only EXACTLY what is found inside

the user defined box.  Everything outside the box will be deleted.  This may

include clipping breaklines which are only partially included in the user defined

area.

Example: This tool will delete everything that is NOT contained inside the user

defined box.  In this case, it has deleted every break line which was completely

outside the user defined area, but it has also made clips to two break lines

which were enclosed in the user defined area.
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 Reverse Breakline Direction: This tool is used to identify, and (optionally) reverse, the

direction of loaded breaklines.  After clicking on the button, left-click the mouse to

choose a breakline to inspect.  The selected feature will change to the selected

features color and display directional arrows indicating the 'from' and 'to' ends.  If no

change is needed, right-click the mouse to dismiss the selected breakline. 

Otherwise, a second left-click anywhere in the LAS Map View window will reverse the

line direction.  Subsequent left-clicks will continue to alternate the direction until the

selected breakline is dismissed by right-clicking.  The button will remain active and

another breakline may then be selected.
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 Check Connections to Neighbors: This tool provides information concerning how a particular

breakline is connected to neighboring breaklines.  The connections (nodes) that are

tested must have only two breakline segments snapped together at each location. 

The user may choose which specific types of connections the tool should look for by

checking or unchecking the options available in the interface - the tool is capable of

checking for the same Z-value in two or more connected breaklines, or checking to

make sure that two or more connected breaklines were compiled in the same

direction.  It is also capable of joining multiple connected breaklines to create one

continuous breakline.  This tool is particularly useful in areas which were compiled by

different editors.  The breaklines in each area may be joined and breaklines which

cross through the editors' areas may be checked for the same elevation and

compilation direction.

Same Z value: This option will check for two neighboring, connected breaklines that

have the same elevation, or Z-value.  This tool will not work with breaklines

which have not been snapped together and connected.  To use this tool, make

sure the 'Same Z Value' option is selected.  Click on one of the two breaklines

which are being checked for elevation.  Then click on the second breakline to

be checked for the same Z-value.  If it is possible to highlight both breaklines

simultaneously, then the Z-value is the same in both breaklines.  If both

breaklines will not become selected, or highlighted, at the same time then the

Z-values differ. 

Same direction: This tool will check for two neighboring, connected breaklines that
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have the same compilation direction.  This tool will not work with breaklines

which have not been snapped together and connected.  To use this tool, make

sure the 'Same Direction' option is selected.  Click on one of the two breaklines

which are being checked for compilation direction.  Then click on the second

breakline to be checked for the same compilation direction.  If it is possible to

highlight both breaklines simultaneously then the compilation direction is the

same in both breaklines.  If both breaklines will not become selected, or

highlighted, at the same time then the compilation directions differ.  The user

may view compilation direction by noting the direction of the arrows on selected

breaklines.  The direction of the arrows indicate the compilation direction. 

Perform join: This tool will join all connected breaklines.  The tool will not work with

breaklines which have not been snapped together.  To use this tool, make sure

the 'Perform Join' option is selected.   Click on one of the breaklines which is to

be joined together with its snapped neighbors.  The breakline the user selects

first will override the connected breaklines' elevations and/or compilation

directions if any of the values differ.  Then click again near the first breakline to

confirm the join - the connected breaklines will be joined at this time.  Clicking

once more will select the single, newly joined breakline, showing the user it is

now one breakline rather than multiple separate segments.  To cancel the

joining operation, press the 'Esc' key before performing the confirmation click.

Select and join: This tool will join user-selected connected breaklines (i.e., dissolve

them into one continuous breakline).  The tool will not work with breaklines

which have not been snapped together.  To use this tool, first make sure the

'Select and join' option is selected.  Click on one of the breaklines which is to

be joined together with one or more of its snapped neighbor(s).  The breakline

the user selects first will override the additional chosen breaklines' elevations
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and/or compilation directions if any of the values differ.  Then click on the

additional breakline(s) to be joined - one at a time - until the desired set of

breaklines is selected.  Hold down the 'Shift' key and left-click anywhere in the

main MARS® window to perform the join.  To cancel the joining operation,

press the 'Esc' key before completing the 'Shift' key/left-click operation.

This tool operates in 11 different ways depending on the options chosen at the time of

use:

1. Using the 'Same Z value ' option only: Used alone, this option will highlight

connected breaklines of the same Z-value regardless of compilation direction. 

No joining is performed.

2. Using the 'Same direction' option only: Used alone, this option will highlight

connected breaklines of the same compilation direction regardless of Z-value. 

The user may view compilation direction by noting the arrows on the connected

breaklines.  No joining is performed.

3. Using the 'Perform join' option only: Used alone, this option will join all

connected breakline segments regardless of Z-values or compilation direction. 

The user may choose which elevation/compilation direction will override the

others in the final, joined breakline by selecting the breakline segment with the

desired elevation/compilation direction FIRST when joining the connected

breaklines.

4. Using the 'Select and join' option only: Used alone, this option will join selected

breakline segments that are connected regardless of Z-values or compilation

direction.  The user may choose which elevation/compilation direction will

override the others in the final, joined breakline by selecting the breakline

segment with the desired elevation/compilation direction FIRST when joining the
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connected breaklines.

5. Using the 'Same Z value ' and 'Same direction' options together: Used

together, this combination highlights all connected breaklines which have the

same Z-values and the same compilation direction.  The user may view

compilation direction by noting the arrows on the connected breaklines. 

6. Using the 'Perform join' and 'Same Z value ' options together: Used together,

this combination joins all connected breakline segments only if they have the

same Z-values.  The breakline selected FIRST will determine the compilation

direction of the final joined breakline. 

7. Using the 'Perform join' and 'Same direction' options together: Used together,

this combination joins all connected breakline segments only if they have the

same compilation direction.  The user may view compilation direction by noting

the arrows on the connected breaklines.  The breakline selected FIRST will

determine the Z-value of the final joined breakline.

8. Using the 'Perform join', 'Same Z value ', and 'Same direction' options

together: Used together, this combination joins all connected breakline

segments only if they have the same Z-values and the same compilation

direction.  The user may view compilation direction by noting the arrows on the

connected breaklines.  The breakline selected FIRST will determine the Z-value

and compilation direction of the final joined breakline.

9. Using the 'Select and join' and 'Same Z value ' options together: Used

together, this combination joins user-selected connected breakline segments

only if they have the same Z-values.  The breakline selected FIRST will

determine the compilation direction of the final joined breakline. 

10. Using the 'Select and join' and 'Same direction' options together: Used

together, this combination joins user-selected connected breakline segments
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only if they have the same compilation direction.  The user may view

compilation direction by noting the arrows on the connected breaklines.  The

breakline selected FIRST will determine the Z-value of the final joined breakline.

11. Using the 'Select and join', 'Same Z value ', and 'Same direction' options

together: Used together, this combination joins user-selected connected

breakline segments only if they have the same Z-values and the same

compilation direction.  The user may view compilation direction by noting the

arrows on the connected breaklines.  The breakline selected FIRST will

determine the Z-value and compilation direction of the final joined breakline.

 Add Vertex: This option allows the user to add a vertex to an existing breakline.  To use this

tool, select the 'Add Vertex' button, then left-click on the breakline in the area in which a

new vertex needs to be added.  The cursor will then drag the new vertex as it is moved.

When the cursor is in the desired location, left-click again to add the vertex.
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 Move Vertex: This option allows the user to re-locate a vertex in an existing breakline.  After

selecting the vertex to be moved by left-clicking on it, the breakline in which the vertex

exists will change to the selected features color and every vertex in that breakline will

be highlighted.  The vertex selected for re-location will be connected to the cursor. 

Please see the screen shots below as an example.  To move the selected vertex, left-

click and place the vertex in the desired area.  To deselect the vertex, right-click

anywhere in the project. 
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 Delete Vertex: This tool allows the user to delete a single vertex in an existing breakline.  After

selecting the vertex to be deleted by left-clicking on it, the breakline in which the vertex

exists will change to the selected features color and every vertex in that breakline will

be highlighted.  The vertex selected for deletion will be highlighted in a contrasting color.

 Please see the screen shots below as an example.  To delete the selected vertex, left-

click anywhere else in the project.  To deselect the vertex, right-click anywhere else in

the project. 

In the first example below, the break line containing the selected vertex is highlighted

purple.  Every vertex in the break line is highlighted in orange, and the single vertex

selected for deletion is shown in brown.  Left-click ing in the project area deletes the

chosen vertex (in the corner of the break line), as shown in the second screen shot.
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 Change Elevation for All Points of Breakline: This tool is capable of changing the elevation of

an entire breakline.  To use this tool, click on the breakline which will have its

elevation changed.  The breakline will change to the selected features color when

selected.  Left-click once more to bring up the 'Delta Change to Breakline Elevations'

window.  Enter the change in elevation to be applied in the 'Change' text box.  A

negative value will lower the selected breakline and a positive value will raise the

selected breakline.
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 Change Elevation of Any Vertex: This change elevation tool is capable of changing the

elevation of any vertices of an existing breakline.  With this tool, the user may change

the elevation of an entire breakline, sections above or below a selected vertex, or within

a selected range of vertices.  The tool is also capable of viewing the X, Y, and Z

coordinates of each vertex in a selected breakline.  To use this tool, select the button,

then left-click on the desired breakline.  After the breakline has been selected and is

highlighted, left-click in any other area to bring up the 'Breakline Elevation Edit' window.

The vertex closest to the original selection point (first left-click) will appear in red on the

breakline and its corresponding row will be highlighted in the table.  The selected

vertex's Z-value is listed in the 'Elevation' box near the top.  At the very top of the table,

the number of the selected vertex and the total number of vertices in the breakline are

shown.  The direction that the breakline was compiled is shown with a white arrow in

the display.

Once open, the 'Breakline Elevation Edit' window will allow the user to make elevation

changes.  In example A.) below, the Z-value of the entire breakline is '5186.7'.  The user

wishes to change the Z-value of every vertex from ID 15 up to ID 1 in the table, inclusive.

 Select/highlight the vertex ID number '15' - that vertex changes to red in the display. 

Enter the desired elevation value into the 'Elevation' text box - '5201.3' in this example -
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then click the 'Update Above' button.  The results are shown in example B.). The

elevation of every vertex numbered from 15 to the top of the list (Above) has been

changed to the desired elevation of 5201.3 units.  The 'Breakline Elevation Edit' window

is capable of updating every vertex Above or Below the selected vertex ID, updating

every vertex in a breakline with the same elevation ('Update All'), or updating a selected

range of vertices.  To select a range, use the 'Shift' or 'Ctrl' keys while clicking in the far-

left column with the mouse (standard Windows selection procedures), or drag a box

through the left column to include the vertices to be changed.  Once the range is

selected, enter a new value in the 'Elevation' text box and click 'Update Selection' as

shown in example C.).  In addition, the elevation of a single vertex can be changed by

clicking in the 'Z' cell for that vertex and entering a new value directly in that cell.  The

'Previous' and 'Next' buttons can be used to select and highlight the row above or below

(respectively) the current selection and the corresponding vertex in the display will

change to red.  To save the changes which are currently shown in the 'Breakline

Elevation Edit' window, click the 'Save Changes' button before exiting the interface.

A.)

B.)
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C.)
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 Change Elevation (Large Increment): The 'Change Elevation' tool is meant to work in unison

with the 'Elevation ' tool and make the compilation of breaklines easier and quicker.

This tool allows the user to “step” the elevation of breakline up or down in large

359
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increments.  By default, the ‘Change Elevation (Large Increment)’ button lowers the

elevation of an added breakline by -0.8 units.  The user may change this default value

by opening the ‘Breakline Properties’ window and entering the desired unit change in

the ‘Locked Elevation Change’ area as seen below.  Values can be positive or

negative.

 Change Elevation (Small Increment): This tool works exactly like the Large Increment tool

(above), but with a different (smaller) increment value.  By default, the ‘Change

Elevation (Small Increment)’ button lowers the elevation of an added breakline by -0.2

units.  The user may change this default value by opening the ‘Breakline Properties’

window and entering the desired unit change in the ‘Locked Elevation Change’ area as

seen below.  Values can be positive or negative.

 Reassess Points for Ignored Ground Classification: This tool will reclassify points surrounding

a modified breakline, or where a breakline was deleted (inside a user-specified drag-

box).

1.) Create or locate the breakline (or former breakline area) on which this tool will be

used. In the example below, a breakline has been created around a building, but has

one corner of the building accidentally omitted.  When the collection of the misshapen

breakline was complete, the points which were inside the user-defined buffer around

the breakline were reclassified from Class 2: Ground (All) (shown in orange) to Class
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20: Ignored Ground (light gray in this example).

     

The specifications which decide the buffer width, points to be reclassed, and ground

classification to use in the reclass are made inside the 'Compilation Options' section

of the 'Breakline Properties' interface.  The settings in the interface shown below are

set to reclass any point from Class 2 to Class 20 within a 5 unit buffer around the

specified breakline during compilation.  The results of these settings may be seen in

the image above.

2.) The misshapen breakline is then corrected by using the 'Modify Vertex' tool  .

Once the vertex has been moved, the breakline is now correctly drawn.  However, the

buffer zone around the new corner of the breakline has not yet been reclassified. 
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3.) To reclass the buffer zone around the modified breakline, click on the 'Reassess

Points for Ignored Ground Classification' tool  .  Left-click and drag a box over the

area which has been modified. This tool will classify the new buffer zone around the

modified breakline.  When this tool is used, the buffer zone that is honored is based on

the 'Point Delete Buffer' value entered when the breakline shapefile was loaded (see

the 'Add Breaklines from Shapefile' topic in the Project/Data Preparation Tab

section of this Help File).

If the buffer zone has previously reclassed points which should be returned to their

162
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original value after a modification of a breakline, these points will also be corrected.  

a.) In the example below (left), a breakline has reclassed all ground points within a

buffer zone surrounding it to Class 20: Ignored Ground (light gray in this example).  b.)

The user then modifies a vertex of the breakline (middle).  The points which were

reclassed in the buffer zone based on the original breakline shape are no longer

correctly classified.  c.) Points around the newly modified breakline need to be

reassessed using the 'Reassess Points for Ignored Ground Classification' tool (as in

step 3., above).  This tool will not only reclass the points within the new buffer area

(below, right) surrounding the modified breakline to Class 20, but will also return the

previously reclassed buffer points from Class 20 back to their original ground class

(orange).  Note that modified breaklines will not have their vertex elevation values

changed automatically with this tool.  It will be necessary to drape those breaklines

that were modified using the 'Drape Selected Breaklines' tool.

a.)     b.)

c.)
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 Drape Polylines: This tool allows the user to select a *.dgn file or a *.shp file containing polyline

breaklines and drape those breaklines to the LAS data surrounding it.  This tool will add

a Z-value (elevation) to the breaklines in the specified file by searching the points

surrounding the line for an appropriate Z-value.  If the shapefile or DGN file indicated only

contains stream or river breaklines, this tool will also has the option of enforcing the

downhill stream rule if the user chooses.

Enforcing stream rule (downhill): By checking this option, the tool will force the selected

breakline to flow downhill.  This option is useful when draping the 'Stream' feature code. 

Reference Classes: The user may choose one class or multiple classes to act as a

reference.  The draping tool will search the area surrounding the selected breakline (the

specified search radius) for this specified class only.  Only this class will be used in finding

an appropriate Z-value for draping the selected breakline.

'Input' section: The user may choose which type of input file will be used to drape

polylines.  The user may choose from either a 'DGN' or a 'Shapefile' input type. Either type

of file should contain polyline breaklines.  If the user chooses a DGN input type, select the

'DGN' radio button and the 'Input DGN File' browse box will become available (see example 

a., below).  If the user chooses a shapefile input type, select the  'Shapefile' radio button

and the 'Input Shapefile' browse box will become available (see example b., below).

Browse to the appropriate input file and move on to the 'Output' section of the interface.

'Output' section: The 'Output' section will also change options based on the user's choice
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between 'DGN' and 'Shapefile' in the 'Input' section.  If the user chooses a DGN file as the

input file, the first three options available in the 'Output' section will become available.  The

user must specify a 'DGN Seed File', the 'Output DGN' location and name, and a name for

the 'Error DGN' file which will be created.  This error file will be created if draping of any

polyline is not possible.  A DGN will be created marking the location of each error (see

example a., below).  If the user chooses a shapefile as the input file, the last two options

available in the 'Output' section will become available.  The user must specify an 'Output

Shapefile' name and location and a name for the 'Error Shapefile' which will be created. 

Similar to the 'Error DGN' file, this error file will be created if draping of any polyline is not

possible.  A shapefile will be created marking the location of each error (see example b.,

below).

Search Radius: The user may specify the size of the search radius (in project units), or

area surrounding each breakline, in which the tool will look for appropriate Z-values in the

reference class specified.   Please see the reference to 'search radius' in the above

explanation of 'Reference Classes'.

Algorithm: The user may select an algorithm to search for surrounding Z-values which will

be used to assign an elevation to the selected breakline.  Choose from: Median, Average,

Min, Max, and TIN.

Maximum triangle edge length: This text box is only available when the user chooses

the 'TIN' option as the algorithm to search by.  When 'TIN' is the selected algorithm, the

user may then specify the maximum triangle edge length which will be allowed in the

search.

    a. Options available if the user chooses a DGN as the input file type:

b. Options available if the user chooses a shapefile as the input file type:
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 Drape Polygons: This tool allows the user to select a *.shp file containing polygon breaklines

and drape those breaklines to the LAS data surrounding it.  This tool will add a Z-value

to the breaklines in the specified file by searching the points surrounding the line for an

appropriate Z-value.  This tool also allows the user to choose the percentage of the

lowest points found within the search radius which will be included in determining the Z-

value of the draped breakline.

Reference Classes: The user may choose one class or multiple classes to act as a
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reference.  The draping tool will search the area surrounding the selected breakline (the

specified search radius) for these specified classes only.  Only these classes will be used

in finding an appropriate Z-value for draping the selected breakline.

Input Shapefile: Select the ellipsis '...' button and use the following window to navigate to

the desired input shapefile containing breakline polygons to be draped.

Output Shapefile: Select the ellipsis '...' button and use the following window to navigate

to the desired output folder where the newly created, draped breakline shapefile will be

placed.  Also give the new output shapefile a name.

Search Radius: The user may specify the size of the search radius (in project units), or

area surrounding each breakline, in which the tool will look for appropriate Z-values in the

reference class(es) specified. Please see the reference to 'search radius' in the above

explanation of 'Reference Classes'.

Percentage of Low Candidates (%): This option allows the user to choose what

percentage of the lowest points (in the specified reference classes) surrounding the polygon

will be used in determining a Z-value for the selected breakline.

Algorithm: Draping can be based on a Median, Average, Min, or Max Z-value using the

previous two parameters.
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 Drape Selected Breaklines: This tool allows the user to select a specific breakline or set of

breaklines and drape to the surrounding LAS data.  The tool will add Z-values to the

selected breakline(s) by searching the surrounding points for appropriate elevations. 

This tool is capable of performing a drape on a single, selected breakline or on multiple

breaklines at a time.  Results are rounded to three (3) decimal places, regardless of the

project's vertical units.

'Feature Code Change' section: To change the feature code of the selected breaklines,

check the 'Change feature code' box.  When checked, the 'Change code to:' drop-down

box will become available and the user may choose which feature code to change the

breaklines to.

'Common Options' section

Reference Classes: The user may choose one class or multiple classes to act as a

reference.  The draping tool will search the area surrounding the selected breaklines (the

specified search radius) for the specified classes only.  Only these classes will be used in

finding appropriate Z-values, or elevations, for the selected breaklines.

Search Radius: The user may specify the size of the search radius, or area surrounding the

selected breaklines, in which the tool will look for appropriate Z-values in the reference

classes specified.  Please see the reference to 'search radius' in the above explanation of

'Reference Classes'.

Algorithm: The user may select an algorithm to search for surrounding Z-values which will be

used to assign elevations to the selected breaklines.  Available choices are: Median, Average,

Min, Max, and TIN.

Maximum triangle edge length: This text box is only available when the user chooses the

'TIN' option as the search algorithm.  If 'TIN' is selected, the user may then specify the

maximum triangle edge length which will be allowed in the search.
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Densify: This option will allow the user to densify the selected breaklines by adding more

points to them. 

Gap: This option is only available when the 'Densify' option is chosen.  The user may specify

how much more dense to make the selected breaklines.  For example, if the user enters a

value of '2' into the 'Gap' text box, the tool will make sure that a point exists at every 2 units

along the breaklines.

'Polyline Options' section (only for use with polyline breaklines) 

Enforcing stream rule (downhill): By checking this option (on by default), the tool will force

the selected breaklines to flow downhill.  This option is particularly useful when draping the

'Stream' feature code.

Set all z values to same elevation: By checking this option, every point in the selected

breaklines will be set to the same Z-value, and the 'Percentage of low candidates (%)' option

will become available.  This option allows the user to choose what percentage of the lowest

points (in the specified reference classes) surrounding the polylines will be used in

determining Z-values for the selected breaklines.

'Polygon Options' section: This section of options is only for use with polygonal breaklines

(e.g., ponds or lakes).  By checking the 'Set all z values to the same elevation' check box,

every point in the selected breaklines will be set to the same Z-value, and the 'Percentage of

low candidates (%)' option will become available.  This option allows the user to choose what

percentage of the lowest points (in the specified reference classes) surrounding the polygons

will be used in determining Z-values for the selected breaklines.
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When all parameters are set, click the 'Draping' button to start the processing.

 Double Hydro Tool: This tool is meant for use on rivers or double-line streams.  In order to use

this tool, the user must have already collected breaklines along each edge of a river or
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stream, and these breaklines must have been compiled in the same direction.  The

Double Hydro Tool allows the user to reclass all points within a virtual polygon (which is

created between the two parallel polylines representing the water's edge).  It also allows

the user to match the Z-value of the two breaklines representing the edges of the river or

stream. To use this tool:

1. Compile breaklines along the edge of a stream or river.  Make sure the

breaklines are both compiled in the same direction or the Double Hydro Tool

will not function.  In the example below, the breaklines collected have both

been collected in the direction the red arrows are pointing.  Stream and river

breaklines should be compiled in the direction of decreasing elevation

(direction of water flow).  This is why the 'MinDecreasing' feature collection

type is used.  Also, the breaklines in this example have reclassed the

ground in a small buffer around each line to Class 20 - Ignored Ground,

which is colored light gray in this example (see step 4a for more information

on changing the class of reclassed points).

2. Next click on the 'Double Hydro Tool'  button.



Tab and Ribbon Layout 341

© 2000-2023 Merrick & Company

3. Click once on each breakline following the river or stream's edge.  Both

breaklines will change to the selected features color.  Also, small arrows will

show the direction of compilation for each breakline.  In the example shown

below, the LAS points have been turned off for easier viewing.

4. Now that the two breaklines which will serve as a boundary for the Double

Hydro Tool have been selected, make a third mouse click inside the LAS

Map View window to activate the tool.  At this time, the tool will create a

virtual polygon and reclassify the points inside the polygon. 

a.) The user may select the class to which the points are reclassed by

selecting the 'Breakline Properties'  button.  Inside this

interface, the user may choose the class which the points inside the

virtual polygon will be reclassed to.
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b.) The points on the river (inside the virtual polygon) in this example

have been reclassed to Class 20 - Ignored Ground. 

c.) As well as reclassing the points to the interior of the breaklines

selected, the Double Hydro Tool will make sure the elevations of the

two selected breaklines match at vertices which are perpendicular to

one another.  The elevation of the left-hand breakline will always be

used to override the breakline elevation of the right-hand breakline. 

The user may check to make sure the breaklines match by using

the Inspect tool .   Click on the 'Inspect' button, hold down the

'Ctrl' key on the keyboard, and click on the breakline in question.

The polyline properties of the two separate breaklines may be seen

below.  Vertices 30 (ex. 1) and 15 (ex. 2) are perpendicular to each

other in the breakline examples shown above.  The Z-value of both

breaklines at perpendicular vertices is the same.

1.)

2.)
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5. When the Double Hydro tool is finished, a prompt will appear.
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 Force Double Hydro: This option allows the user to load a breakline shapefile and forces all

breaklines down to even intervals based off of elevation information obtained during prior

collection.  The user may choose to force breaklines down to half-foot or one foot

intervals.  To use this tool, specify an input shapefile, or breaklines shapefile.  Next,

specify the folder in which the output file should be placed and name the new shapefile.

This tool will create a status, or summary, when finished processing and alert the user

with a window prompt.
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 Copy Parallel: The 'Copy Parallel' tool allows the user to move, copy, or copy a breakline

exactly parallel to an existing breakline.  To use this tool, click on the 'Copy Parallel'

button.  At this time, the 'Move/Copy/Parallel Copy Options' window will appear.  The

user may choose which action they want performed: move, copy, or parallel copy, on an

existing breakline.  When using the 'Copy Parallel' option, the user may also choose to

use the 'Distance from the original' option by checking the box called 'Use distance' and

entering a distance in units into the text box.  The newly created breakline will be copied

the specified distance from the original breakline if this option is chosen.  Another

available option to the user when the  'Copy Parallel option is chosen is the 'Delta

Elevation' option.  The user may choose this option by placing a check mark in the box

named 'Apply Delta Elevation'.  This option allows the user to give the newly created

breakline(s) a separate elevation from the original breakline.  Enter the change in

elevation for the new breakline into the text box available.  For example, if the user

would like the new breakline to be created exactly 50 units lower than the original

breakline, then -50 should be entered into the 'Apply Delta Elevation' text box.  To raise

the elevation of the newly created breakline above that of the original breakline, enter a

positive unit change.  Once the parameters of the window have been set, left-click near

the existing breakline.  This breakline will appear as bold and in the color currently set
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for selected features.  Left-click again to either move, copy, or copy parallel the selected

breakline.

Example: Create a new break line 100 units away from and parallel to the original

break line (shown in bold purple and in the center), and 100 units higher than the original

break line on both sides of the original.
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Example: To move a break line, choose 'Move' in the 'Move/Copy/Parallel Copy Options'

window and click  on the break line to be moved.  The original placement of the

break line is shown in bold purple, and the cursor and white break line show the

placement of the break line as it is being moved. 

     

Example: To copy a break line choose the 'Copy' option.  This option is similar to the

'Move' option, but keeps the original break line (shown in bold purple).  The placement of

the copy break line appears in white and attached to the cursor for positioning.
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 Change Feature Code: This tool allows the user to change the feature code of an existing

breakline.  When this tool is selected, the 'Breakline Code Change' window will appear. 

Click on the breakline which is to have its code changed to highlight it, and then select

the desired feature code from the drop-down list contained in the 'Breakline Code

Change' window.  Left-click anywhere in the project to set the change, and the breakline

color will change to reflect the new feature code.  Exit the interface to deactivate the
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tool.

 Check for Crossing Breaklines: This tool will search for any crossing breaklines in a project.

The user will be prompted to choose the code or codes that will participate in the

crossing check (the 'Ctrl' and 'Shift' keys can be used in selecting codes).  Breaklines

loaded as 'Reference Breaklines' will also be included in the crossing check.  The

software will only recognize crossings in which the Z-value of both lines does NOT

match.  If the Z-value of both breaklines is the same or if the breakline points have been

snapped together the crossing will be considered an intersection and will not be

counted.  The resulting 'Breakline Crossing' window will notify the user of the total

number of breakline crossings and allow the user to pan to each instance by use of the

'Previous' or 'Next' buttons.  The crossing locations will be marked with an X.  The

'Breakline Crossing' window also allows the user to choose the color and size of the X

markers.  The user may choose from a set of pre-defined colors or create a unique color

from a palette.  The font size of the X markers can range from 1 to 30.  The 'Clear'

button allows the user to clear the number of recorded crossings and the X markers

shown in the LAS Map View window display.   In the 'Breakline Crossing' window seen

below, the user has chosen to view the 1st crossing found out of 4 total crossings.
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 Place Text: This tool allows the user to add text to the LAS Map View window.  To use this tool,

click on the 'Place Text' button, then left-click in the LAS Map View window where the

text should  appear.  At this time, a 'Text' window will appear.  Enter the desired text

into the window and choose the 'OK' button to place the text in the project.  Choosing

'Cancel' will cancel the place text action.

       

 Form Polygon: The 'Form Polygon' tool will allow the user to create a polygon out of polylines.

The tool will take two or more polylines and connect them, forming a single enclosed

polygon.  In the example below, the user has created two polylines and has failed to

completely close them to create a polygon.  To close the polygon using this tool, follow

the directions below:

1. Select the 'Form Polygon' button  to close the polygon.
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2. Select the first polyline by left-clicking on it.  This first polyline selected

should be the polyline with the most correct elevation.  The elevation gathered

from the first polyline will be transferred to the second polyline selected to

create a polygon with a single elevation.

3. Left-click on the second polyline which is to be connected with the first to

create the new polygon.  There should be no selected polylines after this step

because the polylines have now been joined in a polygon.  Note that the area

in which the polygon was not closed previously is now closed. 
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4. Another left mouse click inside the newly formed polygon shows the user

that there is only a single, uninterrupted breakline forming the polygon.

If the user attempts to use the 'Form Polygon' tool on a polygon which is already closed,

the following prompt will appear:

 Measure Area: This tool works only with pre-existing loaded polygon features.  To use, click on
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the 'Measure Area' button and then left-click inside the appropriate polygon area.  Left-

click once more anywhere in the LAS Map View window to see the resulting window

which will display the area of the selected polygon.

 Show Breakline Vertices: This tool symbolizes the vertices for all loaded breaklines, and

labels each with the ID number stored in the shapefile attribute table.  Best practice is

to zoom in on the area of interest before enabling this tool - it can take a significant

amount of time to render if hundreds or thousands of breaklines are visible in the LAS

Map View extent.
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 Show Auto Pan Edge Markers: This tool toggles the display of the Auto-pan boundary

markers that indicate the area of the LAS Map View window where an auto-pan (when

enabled) will be done if the cursor is moved into it during breakline compilation.  Auto-

pan is active by default during breakline compilation as well as when creating 2D

polygons and centerlines (polylines) using the 'Draw' tools on the Vector Creation

tab.  See the Keyboard Accelerators  section for info on the 'B' key used to toggle

auto panning on/off.

 Reshape Feature: This tool allows existing polyline and polygon breakline features to be

reshaped by 'patching in' a new section of linework rather than having to move, add, or

delete one vertex at a time or re-compile the entire breakline.  To use this tool, click

once on the breakline to be reshaped to highlight it.  It will temporarily be displayed in

white with a thicker than normal line weight and an arrowhead to indicate the direction

in which it was compiled.  If the wrong breakline is accidentally selected, use the 'Esc'

key to unselect it and exit the tool.  Restart the tool and re-select the desired

breakline.

For polyline breaklines:  Once the breakline has been selected, left-click once

near the part of the breakline that will be reshaped to begin the patch, then cross

the line with the mouse cursor and begin clicking in each location where a new

vertex will be added in the reshape patch.  Finish compiling the new linework by

crossing back over the original breakline, left-clicking to add a final vertex and

then right-clicking to end the reshaping.  Only the section of the breakline

between the crossing locations will be kept for the new line shape.  The edited

362
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breakline will return to its original color and line weight and the tool will remain

active for another breakline to be selected.  Use the 'Esc' key to exit the tool.  At

this time, the Reassess Points for Ignored Ground Classification  tool can be

used to set ground points within the Breakline Properties 'Reclass Buffer Width'

value to the ignored ground class (see the Compilation Options  section,

above).  The 'Reassess ...' tool will also reclassify ignored ground points back to

ground (Class 2) for points that are no longer within the 'Reclass Buffer Width'

distance.

   NOTE that any reshaped polylines will need to be re-draped to ground (see the

Drape Selected Breaklines  tool, above).

For polygon breaklines:  Once the breakline has been selected, left-click once

near the part of the breakline that will be reshaped to begin the patch, then cross

the line with the mouse cursor and begin clicking in each location where a new

vertex will be added in the reshape patch.  The patch can be started either inside

or outside of the polygon, but must finish on the same side as the starting

location (first vertex).  Finish compiling the new linework by left-clicking to add a

final vertex and then right-clicking to end the reshaping.  The edited breakline will

return to its original color and line weight and the tool will remain active for

another breakline to be selected.  Use the 'Esc' key to exit the tool.  At this time,

the Reassess Points for Ignored Ground Classification  tool can be used to set

ground points within the Breakline Properties 'Reclass Buffer Width' value to the

ignored ground class (see the Compilation Options  section, above).  The

'Reassess ...' tool will also reclassify ignored ground points back to ground

(Class 2) for points that are no longer within the 'Reclass Buffer Width' distance.  

NOTE that only the longest original piece of the reshaped polygon will be

328
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kept.  For example:
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 Calculate Area: This tool allows a temporary polygon to be digitized and displays the enclosed

area in acres.  To ensure that the correct project units-to-acres conversion is applied,

the Data Layers  properties must be populated with a full Coordinate Reference

System (CRS) using the Well Known Text (WKT) format that is part of a fully

compliant LAS v1.4, PDRF 6+ file.  This can be done by loading one or more LAS files

that contain this information.  If the Data Layer is not fully defined, acreage

measurements will be based on the conversion from horizontal units of meters.  If a

measurement based on feet is needed and the Data Layer info cannot be set, a

manual conversion will be required.  For reference, one acre is equal to 43,560 USft2 or

approximately 4047 m2.

To use, left-click with the mouse to add vertices to the polygon being created.  Right-

click to complete the drawing and the area pop-up will appear.  

64
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When the horizontal units are unknown, the following pop-up will appear:

 

 Elevation: This text box allows the user to enter a new breakline elevation directly

into the Breaklines Toolbar. Access directly to the toolbar makes compiling breaklines

quicker and easier with fewer steps.  The user can click in the text box named

'Elevation' and type in the desired elevation followed by the 'Enter' key, or use the two

'Locked Elevation Change' tools (see above) to make incremental adjustments to the

displayed elevation.  Every new breakline placed using a 'Z Mode' drop-down value of

'Lock' (see above) will have this elevation assigned to it.

 Undo Breakline: This button will undo the most recent change to any breakline.  Depending on

the complexity of the change and the computer's available RAM, it may be possible to
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undo several changes.

 Redo Breakline: This button will redo the most recent change which was 'undone' by use of the

'Undo' button.  Depending on the complexity of the change and the computer's

available RAM, it may be possible to redo several 'Undo' steps.

 Save Breaklines to Shapefile(s): This button allows the user to save the

breaklines compiled or modified in MARS® to one or more shapefiles, depending on the

changes made.  Click on the 'Save Breaklines to Shapefile(s)' button and the 'Save

Breaklines' window will appear. Navigate to the folder to which the shapefile(s) should be

output and choose a seed name for the shapefile(s).  Click 'OK' when the appropriate

selections have been made.  A shapefile will be saved with the user-supplied name and

'_polyline' appended to that name for any breaklines compiled as polylines (e.g., along

retaining walls).  For any polygonal breaklines (e.g., pond/lake shorelines), '_polygon'

will be appended to the name for that saved shapefile.  For any break points, '_point' will

be appended to the name for that saved shapefile.  For any saved shapefiles, a *.prj

(projection definition file) is also created if the projection information is known for the

source LAS data.  If the specified name for the new file already exists in the defined

folder, a prompt will appear warning the user that the “Files already exist, are you sure

you want to overwrite?”. 
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When the 'Save Breaklines to Shapefile(s)' button is used and two or more regular (not

reference) breaklines files are loaded in the Table of Contents , a prompt will

appear:

“There is more than one breakline file loaded.  Do you want to save all

loaded breaklines into one file?”

Clicking ‘No’ will close the prompt and do nothing.  Any breaklines other than the

set being edited can then be removed before clicking the 'Save Breaklines to

Shapefile(s)' button again.  If   'Yes' is clicked, the ‘Save Breaklines’ dialog will

open as shown above.

    

Keyboard shortcuts which apply to breakline compilation: 

1. The 'Esc' key: Using the ‘Esc’ key will exit the user from any tool or dialog window which is

opened or activated from the breaklines tab. 

2. The 'Shift' key: The ‘Shift’ key will allow the user to snap a breakline which is currently being

compiled to another breakline.  To use this tool, the user must hold the ‘Shift’ key down

while clicking the mouse in the near vicinity of the desired snap point.  The user may

specify which point the new breakline should snap to by using the 'Snap Mode' drop-

down list on the breaklines tab.  The user may choose to have the newest breakline

snap to ‘StartEndVertex’, ‘Vertex’, ‘NearestPoint’, or ‘MidPoint’.  If either 'NearestPoint'

or 'MidPoint' are chosen, a vertex will be created in the existing breakline upon snapping

134
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completion.

3. The 'Ctrl' key: The 'Ctrl' key shortcut allows the user to copy or “borrow” a Z-value from an

existing breakline and use this Z-value as the beginning of a new breakline.  To do this,

the user must hold down the ‘Ctrl’ key while using the mouse to left-click on the

breakline which has the desired Z-value.  Then, while still holding the ‘Ctrl’ key down,

left-click the mouse where the new breakline is to begin. At this time the compilation of

a new breakline will continue with the “borrowed” Z-value.

4. The 'B' key: Toggle on/off the auto-pan mode that is triggered during breakline compilation

when the cursor nears the edge of the LAS Map View window.

5. The 'V' key: Toggle on/off the auto-pan edge markers.

6. The 'Alt' key: Holding the 'Alt' key down while in breakline compilation mode allows the user to

pan across the data when auto-pan is toggled off.  The cursor will temporarily change

from the compilation symbol (cross-hair) to a pan symbol (hand) when the left mouse

button is clicked and dragged.  Release the 'Alt' key to resume compilation.

7. The 'Ctrl-B' key: Toggle display of breaklines on/off.

8. The 'Ctrl-M' key: Allow display of only the ground point classification (2) and the ignored

ground classification (20).

9. The 'Ctrl-T' key: Toggle Fast TIN on/off.

10. The 'Ctrl-Z' key: Undo the last vertex drawn when placing a breakline.

11. The 'Shift-B' key: Quick save of breaklines without confirmation (when path/name has

previously been established).

© 2000-2023 Merrick & Company. All Rights Reserved.

3.9 Vector Creation Tab

Vector Creation Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Vector Creation Tab:
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For any LAS tools (including 'Collection Scan Polygon Generator') that allow files to be pathed

out without loading them in the Table of Contents in MARS®, an up-conversion prompt will

appear when executing the tool if the LAS files do not meet the minimum MARS® compliancy

requirements.  This prompt is described in the Project/Data Preparation Tab  topic.

 Create Tile Scheme: This option allows the user to create a unique tile layout.  The newly

created tile layout will be found under the 'Tiles'  layer in the Table of Contents where only one

shapefile can be loaded at a time.  If a tile shapefile is already loaded under the 'Tiles' layer, it will be

removed and the new tile layout will be loaded in its place automatically.

162
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Output Shapefile: Click the 'Browse' button to designate an output folder and name

for the tile shapefile being created.  Once this is completed, click 'Save'.  When a tile

shapefile is generated, a *.prj (projection definition file) is created if the projection

information is known for the source LAS data. 

Tile Size: Specify an X and Y length for the sides of each tile.  A larger number in

either text box will denote a larger tile.

Tile Starting Number: Choose a number for the Tile Name labeling to start at.  The

tiles will be named upward from the number specified (for example, if 100 is the

starting number, tiles numbered 101, 102, 103, 104... will follow).

Start Coordinate: If the user would like to specify the coordinate at which the tile

layout should start, check the 'Specify the start coordinate' check box.  The X and Y

coordinates may be specified in the text boxes following this option.  After specifying
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the coordinates, the user may further define which corner of the created tile layout

that the coordinates will represent.  The user may choose from: Lower Left, Upper

Left, Upper Right, Lower Right.

Add the Result to Project: Checking this box option will load the new tile layout to

the project after it is created.  If a tile shapefile is already loaded into MARS® under

the 'Tiles' tab and this option is checked, the shapefile already in MARS® will be

removed and the new tile shapefile will take its place under the 'Tiles' tab.  If this box

is left unchecked, the new shapefile will not be loaded into MARS® upon creation, but

it can be found in the output folder.

Tile numbering from top to bottom: If this box is checked, the tiles will be labeled

starting at the top left tile of the tiling layout and count upward, labeling tiles from left

to right.  When the end of the row is reached, the labeling will continue on the second

row from the top on the left most tile and continue from left to right.  If this box is left

unchecked, tile labeling will begin in the bottom right tile in the tiling layout.  Tiles will

be labeled counting upward from left to right.  When the end of the row is reached,

labeling will continue in the second row from the bottom in the left most tile and count

upward from the left end tile to the right end tile.  See the screen shots below for

visual examples.

EX: The following is an example of tile labeling with the 'Tile numbering from top to bottom'

option chosen.
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EX: The following is an example of tile labeling without the 'Tile numbering from top to bottom'

option chosen.
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Use extents rather than points: Checking this option will produce an MBR

rectangular tile layout that incorporates the extents of the data.  In this case, some

tiles in the tile layout that is produced may be empty tiles.  To create a tile layout

which only creates tiles which carry data, uncheck this option. 

Ex. Tile layout created with the 'Use extents rather than points' option checked.  Some empty

tiles are produced to make the tiling layout rectangular.
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Ex. Tile layout created with the 'Use extents rather than points' option unchecked.  Empty tiles

are avoided and the tiling layout is produced based on LiDAR points instead of the data extents.
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Calculate LAS Statistics, and save to Attribute Table: This option allows the user

to create statistics for each LAS tile.  By choosing this option, the user will make the

'Class Statistics' option available - the classes to be included in the statistics can

then be selected.  This option will populate the following statistics in the output tile

shapefile attribute table:

ID: A uniquely generated ID number for each tile created.

TName: The TName is a uniquely-generated tile name with a starting

number specified by the user.

AREA: The area in square project units of a particular tile.

ALLPCOUNT: A count of the total number of points within a particular

tile.

DENSITY: The point density in points per square unit (using first



MARS® v2023.1           User Manual370

© 2000-2023 Merrick & Company

returns only).

AVG_GSD: The average GSD (ground sample distance).

X_MIN: The x axis (easting) minimum within a particular tile.

X_MAX: The x axis (easting) maximum within a particular tile.

Y_MIN: The y axis (northing) minimum within a particular tile.

Y_MAX: The y axis (northing) maximum within a particular tile.

Z_MIN: The z axis (elevation) minimum within a particular tile.

Z_MAX: The z axis (elevation) maximum within a particular tile.

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular

tile.

COLL_SCAN: A listing of the different collection scan numbers which

overlay a particular tile.

GPS_MIN: The GPS time (timestamp) minimum found within a

particular tile.

GPS_MAX: The GPS time (timestamp) maximum found within a

particular tile.

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various

intensity value statistics.

RETURN_0: The number of ‘other’ returns found within a particular tile

(returns that are missing or have incorrect point family info).

RETURN_1 through RETURN_15: The number of first returns through

fifteenth returns (listed in individual attribute fields) found within a

particular tile.

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found

within a particular tile.

MKP: The number of points bit-flagged as ‘Model Key-point’ found
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within a particular tile.

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within

a particular tile.

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a

particular tile.

Class0 through Class255: The number of points in each class (listed in

individual attribute fields) is recorded per tile.

ClassWH0 through ClassWH255: The number of Withheld bit-flagged

points in each class (listed in individual attribute fields) is

recorded per tile.

iShape: A MARS®-specific value that is not relevant for the user.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every tile will be omitted from the final attribute table to simplify

analysis.

It is also possible to view the statistics of attributes in a shapefile.  The user may view

the statistics of a single attribute, the statistics of an entire row or column, or the

statistics of an entire table. Highlight the attributes of which statistics are to be

viewed, right-click and choose 'Statistics'.  The resultant table will tell the user the

following statistics: the row count, minimum, maximum, sum, mean (average),

median, and mode of every attribute.  To select multiple attributes for statistic viewing

at once, use the 'Shift' or 'Ctrl' keys on the keyboard.  In the example below, the

user is choosing to view the statistics of six rows of data for the 'ALLPCOUNT' field. 

The resulting statistics are also shown below.
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 Draw 2D Point: Allows the user to create 2D points using the loaded LiDAR, vector,

and/or image data as a reference.  Multiple points can be created after the tool has been clicked

- use a right-click, press the 'Esc' key, or choose another tool button to dismiss the tool.  The

keyboard shortcut 'Ctrl-Z' can be used to 'undo' placed points.  The points are created in

memory, but will be stored in a project file (MPD) when a new one is created or a loaded one is

saved.  To save the points created with this tool as a shapefile, use the 'Save 2D Shapefile '
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button (see below).

 Draw 2D Polygon: Allows the user to draw a 2D polygon using the loaded LiDAR,

vector, and/or image data as a reference.  Multiple polygons can be created be clicking the tool

before drawing each one.  The keyboard shortcut 'Ctrl-Z' can be used to 'undo' placed vertices.

Polygons are created in memory, but will be stored in a project file (MPD) when a new one is

created or a loaded one is saved.  To save the polygons created with this tool as a shapefile,

use the 'Save 2D Shapefile ' button (see below).

When drawing with the 'Draw 2D Polygon' tool, MARS® is equipped with an auto-pan

feature to aid in drawing a large polygon that exceeds the window extent.

To turn off the auto-pan feature, select the 'B' quick key on the keyboard.  To toggle

auto-pan back on, select this key again.

To pan while auto-pan mode is turned off, hold down the 'Alt' key on the keyboard

which will temporarily turn the cursor from collection mode to pan mode and allow the

user to move the data across the display to a new location.

 Draw 2D Centerline: Allows the user to draw a 2D centerline (polyline) using

the loaded LiDAR, vector, and/or image data as a reference.  Multiple polylines can be created

be clicking the tool before drawing each one.  The keyboard shortcut 'Ctrl-Z' can be used to

'undo' placed vertices.  Polylines are created in memory, but will be stored in a project file

(MPD) when a new one is created or a loaded one is saved.  To save the polylines created with

this tool as a shapefile, use the 'Save 2D Shapefile ' button (see below).

When drawing with the 'Draw 2D Centerline' tool, MARS® is equipped with an auto-

pan feature to aid in drawing a long polyline that exceeds the window extent.

To turn off the auto-pan feature, select the 'B' quick key on the keyboard.  To toggle
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auto-pan back on, select this key again.

To pan while auto-pan mode is turned off, hold down the 'Alt' key on the keyboard

which will temporarily turn the cursor from collection mode to pan mode and allow the

user to move the data across the display to a new location.

Please see the Vectors  topic under the Table of Contents  section for more information on storing

vectors in an MPD.

 Save 2D Shapefile: Allows the user to save the points, polygons, and centerlines created in

the project to 2D shapefiles - one file per geometry type.  Navigate to the folder in which each

shapefile is to be saved, and click the 'Save' button once the new shapefile has been named.  

When the shapefile is saved, a *.prj (projection definition file) is created if the projection

information is known for the loaded LAS data.  Once the point, polygon, or centerline data has

been saved as shapefiles, it will be unloaded from MARS®.  To reload any newly saved shapefile

(s), click the 'Add Reference Shapefiles' button on the Project/Data Preparation Tab  and

the shapefile(s) can be loaded as vector data to MARS® for further use. 

92 64
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  Delete 2D Feature: Allows the user to delete drawn 2D Point, Polygon, and/or Centerline

features before they are saved in an MPD or to a shapefile.  Features can also be deleted from a

loaded MPD.  After clicking the tool, left-click once on a feature to highlight it (it will change to

the selected features color), then left-click again to delete it.  While highlighted, right-clicking

will de-select it.

More information about editing shapefiles can be found in the 'Show Shapefiles' section of the Displaying

Data  tutorial.1609
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   Convert Check Points CSV to 3D Shapefile: Allows a CSV file of check points

to be converted to a 3D point shapefile.  The shapefile format provides for easier and more

complete analysis of the check points in GIS software.  The source CSV must be in the

following format before the conversion tool can be run:

The first row of the CSV file must contain column headers and not actual check point values. 

The headers do not have to be named as shown in the example above, but the information must

be in that order.  The fifth and sixth columns are required if the file is to be converted to a

shapefile, but values for those columns are optional.  The fifth column is for a description (such

as park ing lot, intersection, etc.) and the sixth column is for the NVA (Non-Vegetated Vertical

Accuracy) and/or VVA (Vegetated Vertical Accuracy) status of the points.  For the sixth column

(NVA / VVA status), any value that is not stored exactly as VVA or vva (not case specific) or is

empty will be interpreted as NVA.

To convert, browse to and select the CSV file, then browse to the desired path and enter a file

name (without the .shp extension).  Next, browse to and select the horizontal projection system

- this will allow the proper PRJ file to be written when the shapefile is generated.  The same

interface that is used for other coordinate reference system tools will appear (below, right).  See

the GeoCalc  and GeoEdit  help topics for more information on selecting a system.1585 1591
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Only one CSV file can be converted at a time.  When the settings are complete, click the

'Convert' button.

If an incomplete input CSV file is pathed out (i.e., one or more required columns is missing), a

warning prompt appears:
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No output will be produced until corrections are made and the tool is re-run.

The completion message will appear when processing is finished.

After loading the resulting shapefile in the Check Points  layer of the Table of Contents, the

attribute table can be viewed and edited by right-clicking the entry and selecting 'Attributes'.

 

128
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The Check Points shapefile can now be used in running a Check Point Report , or as input to

the USGS QC Module  beginning with version 2.1.

  Collection Scan Polygon Generator: This tool creates a polygonal shapefile based

on LAS collection scan (swath) extents.  Each collection scan file will result in one

polygon feature in the final, merged shapefile.

Input and Running Options: 

Navigate to a folder containing the LAS files to be used in generating swath

footprint polygons by clicking the browse button to the right of the 'Folder to process' entry

box.

'Perform full statistics': When this box is checked (default), full statistics per

collection scan will be calculated on the classes which are specified in the 'Class Statistics'

1221
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section.  Choose classes by clicking on the 'Select' button.Attribute

fields will be added to each swath record to hold these values.  By default, all classes are

used.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every swath record will be omitted from the final attribute table to

simplify analysis.

 When using the 'Perform full statistics' option, either the 'TIN' or 'Grid' algorithm

can be used for edge detection:

'TIN': With this option, the edges of the polygonal shapefile(s) will be

created based on the edge of the virtual TIN which is created.  MARS®

will use 3 points to create a TIN and the edges of the TIN will determine

the extents of the polygonal shapefile. 

'Grid': With this option, the edges of the polygonal shapefile(s) will be

created based on the edges of a virtual grid (created in RAM) to cover

the input data.  A cell size is entered - the default is 3 (3 ground units by

3 ground units).  The cell size should be greater than or equal to the

ground sample distance (GSD) of the input data.  MARS® looks for

points within the virtual grid cells and establishes the edges of the

collection scan data by determining whether or not points exist in a cell.

When points are no longer located, the edge of the collection scan is

confirmed.

This tool can be multi-threaded ('Number of threads to use ') for faster

processing.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.
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For the 'Output Shapefile', navigate to the folder in which the newly generated shapefile

should be stored and give it a name.  When all settings have been made, click the 'Generate'

button and the progress bar will display the processing status.  A completion message will

appear when the process has finished.

The newly created shapefile may then be brought back into MARS® as a reference Shapefile.

Right-click on the shapefile in the Table of Contents and choose 'Attributes' to view a table

specific to that shapefile.  At a minimum, the attribute table will have a 'FILENAME' field with

the name of the LAS file(s) processed, and a 'COLL_SCAN' field with the Point Source ID

listed that created each attribute table record.  If the 'Perform full statistics' option was

checked on for processing, the fields stored in the resulting shapefile will be similar to those

listed in the Create Tile Scheme topic at the top of this help section (when the 'Calculate

LAS Statistics' option is checked), except that ‘TName’ is replaced by ‘FILENAME’ to

indicate the collection scans processed.
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Below is an example result loaded as a Reference Shapefile into MARS®.  The shapefile

outlines each of the collection scans contained in the LAS files chosen.  This can be a useful

tool in checking the overlap between collection scans and making sure there are no gaps in

the data. 

 Convert SBET to Shapefile: This tool is used to convert a raw SBET, or Smoothed B
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est Estimate of Trajectory file, into a point shapefile.  This is often the final step in a typical workflow -

computing the tightly integrated position and orientation solution using the correction observations, the

raw GPS, and inertial data extracted from the project.  The data is processed in both the forward and

backward directions in order to produce the optimal solution, smoothing the effect of GPS outages and

other aberrations in the data.  This results in the best possible position and orientation solution for a

given data set, usually maintaining centimetric accuracy for significantly more time and at longer

distances than would be possible with traditional GPS processing.  The output from this process is

referred to as an SBET. The 'Convert SBET to Shapefile' tool will create a 3D shapefile (including a *.prj -

projection definition file) from an SBET file, giving the user the ability to visualize the SBET overlaid on

top of LiDAR data.  This tool requires some previous knowledge of geodesy.  Among many purposes,

the 'Convert SBET to Shapefile' tool can be used to see how centered in the scan the SBET is, and the

resultant shapefile can be used in the Scan Angle Filter .

'Translate Files' section: The user will load the SBET (*.out) file into this text box by

choosing the 'Add' button and navigating to the location of the SBET file to be

converted.  To remove an SBET file in this section, highlight it by clicking at the far

left of the row and press 'Delete' on the keyboard. 

Subsample Rate (Hz) (1-200): The Subsample Rate allows the user to choose how

much data from the SBET will be converted and displayed in MARS®.  The user may

choose any subsample rate from 1 to 200 and enter the chosen rate into the text box

provided.  For example, if the user chooses a subsample rate of 1, MARS® will use 1

sample of the total samples taken in one second to create the 3D shapefile.  If a flight

was 3 hours long, then 10,800 samples (1 per second) will be used to create the 3D

shapefile of the SBET.  The higher the subsample rate the more accurate the 3D

shapefile representing the SBET will be, but the longer it will take to convert the file. 

Higher rates may also cause "Out of Memory" errors depending on the computer.  A

subsample rate of 1 (the default value) is detailed enough for most purposes. 

1116
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'Input Coordinate System' section: The Input Coordinate System is the horizontal

reference that the SBET was created in.  The user will need to enter the proper

Geodetic system, with Lat/Long in degrees, which was used to create the SBET in

this section.  Examples include NAD83(NSRS2007) and NAD83(2011).

'Input Vertical Reference' section: The user will need to enter the vertical references

used to create the SBET in this section of the interface.  This includes the vertical

reference name, the height model, and the units in which the SBET was processed. 

Typical *.out SBET files are in Ellipsoidal Height meters.

'Output Coordinate System' section: The Output Coordinate System, in most

cases, will be the horizontal reference that the corresponding LiDAR data is in. In

most cases the user will want to view the 3D shapefile created from the SBET over

the matching LiDAR data.  In order to do this the shapefile will need to be created

with the same vertical and horizontal coordinate systems as the LiDAR data. The

user will need to enter the coordinate system, datum, units, and epoch date of the

related LiDAR data.

'Output Vertical Reference' section: The user will need to enter the vertical

references that the corresponding LiDAR data is in.  In most cases the user will want

to view the 3D shapefile created from the SBET over the matching LiDAR data.  In

order to do this the shapefile will need to be created with the same vertical and

horizontal coordinate systems as the LiDAR data.  The user will need to enter the

vertical reference name, the height model, and the units of the related LiDAR data.

Link to Atmospheric Data Set: When checked, allows the user to set the path to

related meteorological data by clicking the ellipse  button to the right of the 'Path

to Atmospheric Data Set' text box and navigating to the desired folder.

Output File Folder: Navigate or key in the path to the folder which is to be the

destination of the newly created 3D shapefile.  The output file (or 3D shapefile created
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from the SBET) will be given same name as the SBET file loaded into the 'Translate

Files' section, but will have the file extension *.shp. 

Once all the data has been entered into the 'Convert SBET File to 3D Shapefile' interface, the

user may click on the 'Convert' button.  There can be a substantial amount of wait time while

MARS® reads the file and begins converting it.  Once conversion has started, the user may

watch the progress of the current file as well as the overall (total number of files to be converted)

progress on the progress bars at the bottom of the interface.  When the process is complete a

prompt window, as seen below, will appear.
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At this time, the user may add the newly converted 3D shapefile to MARS®.  Do this by going

to the Project/Data Preparation Tab  and clicking the 'Add Reference Shapefiles' button.

Navigate to the output folder which was specified in the 'Convert SBET to 3D Shapefile' interface

and select the *.shp file which matches the name of the SBET used to create it. Open this file. 

In this example, an SBET has been used to create a shapefile and has been loaded into MARS

®.  The SBET shapefile represents the path of the plane in space and time as it flew a

particular project.  The shapefile is being viewed in 2D.

In this example, the corresponding LiDAR data has also been loaded into MARS® and is colored

by collection scan.  The SBET shapefile can be viewed layered over the LiDAR data.

162
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In the example below, the 3D shapefile representing the SBET file is shown in white.  It may be

difficult to select the white shapefile points for inspection among the LiDAR data.  To select the

3D shapefile (SBET) or any other reference file among LiDAR data with the Inspect  tool, hold

the 'Ctrl' key on the keyboard while using the 'Inspect' tool.  This instructs MARS® to select

any nearby feature, other than a LiDAR point, for inspection.  It is possible to copy from the

properties window resulting from use of the 'Inspect' tool.

943
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Right-click on the shapefile entry in the Table of Contents and choose 'Attributes" to see the

entire table of values.
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 Convert Video XML file to 3D Shapefile (not available with Academic or

Evaluation license): The 'Convert Video XML file to 3D Shapefile' tool will convert any XML coordinates

video file to a 3D shapefile.  A projection definition (*.prj) will be created if the projection system is known

for the video data.

1. To use this tool, add *.xml files by choosing the 'Add' button.  The specified files will

appear in the 'Translate Files' area and may be removed by highlighting and clicking on

the 'Remove' button. 

2. Define the desired output video file type by choosing *.mts, *.wmv, *.avi, or *.mpg

from the drop-down under 'Video File Extension'.

3. Specify the input coordinate systems including both horizontal and vertical

references.

4. Define the output coordinate systems including both horizontal and vertical

references.

5. Enter a 'Combined Factor' or 'Reciprocal of Combined Factor' if required for the

particular coordinate conversion. 

6. Choose the output folder where the new shapefile will be created.

7. Click the 'Convert' button to start the process.
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3.10 Tools Tab

Tools Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Tools Tab:

For any LAS tools that allow files to be pathed out without loading them in the Table of Contents
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in MARS®, an up-conversion prompt will appear when executing the tool if the LAS files do not

meet the minimum MARS® compliancy requirements.  This prompt is described in the Project/

Data Preparation Tab  topic.

Snapshot: This utility creates a screen capture of the display in the LAS Map View window, which is

saved to a user-defined folder.  Format options include: georeferenced TIFF (with TFW world file),

georeferenced JPEG (with JGW world file), BMP, GIF, PNG, or WMF.  This tool works while in 2D View

 or 3D View .  'Snapshot' is also a quick way to determine what graphics card is installed in the

computer.  To see more information about the Snapshot utility, see the Snapshot  section of this Help

manual. 

MARS® Task Manager: The task manager will allow the user to monitor and/or end multiple

MARS® processes at once. To end a process, highlight it and it will appear in the 'Process Name to

End' text box. Click on the 'End Process' button to end the chosen process. The session (instance) of

MARS® that is running the Task Manager cannot be ended.  The 'Refresh' button allows the user to

refresh the 'MARS® Task Manager' without closing and re-opening the tool - ending a process will cause

an automatic refresh.

162
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Class to Bit Flag: This tool, found under the 'Bit Flag Settings' drop-down, sets the bit flag for

Withheld points or Key-points (a.k.a. Model Key-points) that are in unique classes, in compliance with

LAS version 1.4 specifications.  For example, if a dataset has withheld points in Class 0 (Created, Never

Classified), those points must have the withheld bit flag set to 'True'.  In this case, navigate to the file or

folder to be processed, set the 'Input Class(es)' to Class 0, and click the 'Set Withheld Bit Flag'

button.  For key-points, the process is very similar except that a final 'Ground Class' must also be set.

For this case, set the 'Input Class(es)' to Class 8 (or other class holding only key-points) and choose

the desired 'Ground Class' that the key-points will be re-classed to after they have their key-point bit

flag set to 'True'.  Since ground is typically Class 2, that is the default, although another class can be

selected.  Withheld points and key-points should be in separate classes, so it will be necessary to run

the tool once for each bit flag setting.  The tool can be run on a single file or an entire folder of files.
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Set Overlap Bit Flag: This tool, found under the 'Bit Flag Settings' drop-down, analyzes the

overlapping (overage) areas of a folder of swath (collection scan) or tiled files and sets the Overlap bit flag

to 'True' for those points that fall within the overage area for each file.  This flag is specified by ASPRS

only for LAS v1.4 files.  Only those points in a collection scan that are farthest from the single-

coverage part of the scan and within the overlapping area (between collection scans) will be flagged.

Points flagged as ‘Overlap’ in one collection scan will never share space with points flagged in any other

collection scan.  Even though a bit flag status of ‘True’ signifies these points as ‘Overlap’ per the ASPRS

specification, note that the USGS refers to them as ‘Overage’ points in its NGP Lidar Base Specification

2.1 published in October 2019.
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Navigate to the folder containing the files to be processed by using the browse button ( ) in the

'Input Option | Folder' section.  Choose the appropriate data type - 'Swath' (the default) or 'Tiled'. 

'Swath Data' assumes only one collection scan per file, and 'Tiled Data' assumes the files contain

data from one or more collection scans (swaths) per tiled file.  Individual multi-channel swath files must

be merged into a single swath containing all points from all channels before processing (see the LAS

Merging  tool).  When the settings have been made, click the 'Detect Overage Points' button to

start the processing.  This tool overwrites the original files.

The following screen shots show examples of the 'Set Overlap Bit Flag' results on Swath Data:

                             All points displayed                                                              Overlap flagged
points (only) displayed                                               Overlap flagged points turned off

572
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Clear Bit Flags: This tool, found under the 'Bit Flag Settings' drop-down, allows any of the bit flags

that are not set by the LiDAR sensor to be cleared (set to 'False').  The tool can be run on a single file or

an entire folder of files.  Navigate to the file or folder by choosing the appropriate radio button and using

the browse button to the right of the entry box that is enabled.  Check the boxes for the flag(s) to be

cleared and click the 'Clear Bit Flags' button.  Optionally, the cleared points can be reassigned to a new

Target Class to keep them separate from previously non-flagged points in the same original class.  Note

that if more than one category of bit flag is checked and the reassign option is used, all the cleared

points from any classes will be assigned to the Target Class.  To avoid this, run the tool separately for

each category of bit flag and select a unique target Class each time.  The 'Status' area will display the

files that have been processed.  This tool overwrites the original files.
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Change Bit Flags: This tool, found under the 'Bit Flag Settings' drop-down, modifies the status

(set/on or clear/off) of several of the bit flags that can be used with LAS v1.4 data:  Synthetic, Model

Key-point, Withheld, and Overlap.  It can optionally reclass those points whose bit flag values have been

modified, and can be (optionally) limited to a single specified collection scan.  The tool can be multi-

threaded ('Number of threads to use ') for faster processing.  For best performance, there should be a

minimum of eight (8) GB of RAM available (not just installed) per thread.  Navigate to the files to be

modified using either the 'Add' or 'Add From Folder' button.  Individual files can be cleared from the input

list by highlighting the appropriate file and clicking the 'Remove Selected' button, or the entire list can be

cleared by clicking the 'Remove All' button.  In the 'Input Shapefile' section, browse to a pre-existing

polygon shapefile containing one or more polygons - these polygons will be used to define the area to be

processed.  The 'Set Change Bit Flags Filter' button will open the options interface where the specific

parameters of the tool can be set - see the Change Bit Flags Filter  help topic for details on these

settings.  Choose an 'Output Folder' where the modified files will be stored, and then click the 'Run'

button.

993
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Withheld Point Removal: This tool, found under the 'Bit Flag Settings' drop-down, permanently

removes specific points flagged as Withheld in the input LAS files and renumbers the remaining point

family returns accordingly.  The workflow is: input tiles  -->  export to swaths  -->  Withheld point

deletion  -->  export to final tiled files.  The tool uses two rules for determining candidate points to be

deleted:  1) Withheld-flagged points in any class that are either a single return or the first return of many

in a point family and; 2) Withheld points that are in Class 7 Low Point (Noise) and are the second of two

returns in a point family.  When Withheld-flagged points are deleted, any remaining points in the same

point family will have their return numbers modified so as not to break the return numbering protocol.  For

the first case above, if a first of three returns point (1 of 3) is selected for deletion, the second return in

that point family is renumbered as '1 of 2' and the third return is renumbered as '2 of 2'.  In the second

case above, when a Class 7 second of two returns point (2 of 2) is selected for deletion, the remaining

first return in that point family is renumbered as '1 of 1' (single return).  Note that if the input data is not

classified, only the first rule will be applicable.

To use the tool, navigate to a folder containing tiled, classified LAS files using the browse control to the

right of the 'Input LAS Files (Tiles) Folder' box.  Navigate to the corresponding tile layout shapefile using

the 'Tile Scheme' control and select a unique-value attribute (e.g., 'Tilename') to be used for naming the

finished output tiles.  Choose a 'Swath Output Folder' that will hold the exported swaths produced from

the input tile files - during processing, these swaths will be overwritten by the completed swaths after the

Withheld points are removed.  Finally, an optional 'Finished Tiles Output Folder' can be selected to hold

the final tiled files made from the processed swaths.  If no entry is made here, the input tiled files ('Input

LAS Files (Tiles) Folder') will be overwritten with the final results.
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Click the 'Run' button at the bottom of the interface to begin the processing.  The results will be
displayed in the 'Result - Withheld Point Removal per Swath' window followed by a completion message.

Reference Reclass (available with Production license only): This tool, found under the 'Reclass'

drop-down, allows the user to reclassify one set of LAS files (the 'Unclassified' input files) based on the

classes found in another set of LAS files (the 'Classified' input files), by using a series of user-defined

parameters found in the LAS files.  In addition to reclassification, any existing bit flags (Synthetic, Model

Key-point, Withheld, and/or Overlap) will be carried over to the output as well.  The tool determines

possible candidate points to be reclassed based on the LAS points' recorded time and other optional

attributes. Because this tool finds possible matches based on their recorded time, the two folders of
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input files ('Classified' and 'Unclassified) must contain files in the same time format (e.g., GPS Week

Time or Adjusted GPS Time).  See the 'GPS Time Conversion' topic in this section for a description of

the tool that can convert between the two time storage methods.

Classified:  Browse to a folder containing LAS files that have one or more

classifications in each file. Like features must have like classes in all files - i.e.,

buildings must be classed the same in all files if the building class will be used

as a Reference Class.  Only those classes listed as Reference Classes will be

used to identify possible candidate points in the Unclassified files for

reclassification in the final Output.  In the example below, classes 20 and 15

are being used from the Classified files.  The Classified files are usually in a tile

layout form, but other files can be used.

Unclassified:  Browse to a folder containing one or more LAS files that will be used as

a source of points for the final Output file.  The points in the Source Classes

entered in the interface - 5 and 6 in the example below - will be matched to

points of the Reference Classes entered from the Classified files to create the

candidate points.  Those that match the values for the boxes checked at the

bottom of the interface will be copied to the Output file and assigned the Target

Class (12 and 10 in the example below).  These files are usually in collection

scan form, but other files can be used.

Output:  Browse to an output folder or key in the desired path to store the results of

this LAS classification reassignment. This selection choice is optional - if the

user does not choose an Output folder, the Unclassified input data is

overwritten with the newly reclassified data based on this reference reclass

function.

Tile Option:  Optionally, the Output data can be tiled upon completion based on a

user-selected polygon shapefile tile layout.  The 'DB Field' chosen will be used
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to name the Output LAS files.

Class Requirement:  In this section, the user specifies a Source Class, Reference

Class, and Target Class for the specific classification sets to be used in the

reclassification.  Click on the appropriate box, and enter the class to be used.

Source Fields That Must Match Reference:  This area of the interface allows the user

to force a match of the values present in the Classified files to those in the

Unclassified files in determining candidate points to be reclassed during

processing.

Speed Up Option:  When checked with a value entered in project units, this setting

improves performance by limiting the pool of possible candidate points to be

matched.
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Click the 'Reclassify' button to begin the processing.

Reference Reclass - Closest Distance (available with Production license only): This tool,

found under the 'Reclass' drop-down, is similar to the Reference Reclass tool (see above). It allows the
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user to reclassify one set of LAS files (the 'Unclassified' input files) based on the classes found in

another set of LAS files (the 'Classified' input files), by using a series of user-defined parameters found

in the LAS files.   In addition to reclassification, any existing bit flags (Synthetic, Model Key-point,

Withheld, and/or Overlap) will be carried over to the output as well.  The tool determines which points

will be reclassed based on the LAS point's recorded time and position. This is a special version of the

Reference Reclass Tool: (1) Time will be used to determine possible candidate points, and (2) X, Y, Z

will be used to determine the closest candidate point. This tool can process LAS data when the two

inputs are in different time formats (e.g., GPS Week Time and Adjusted GPS Time) because it also

takes into account the position of an LAS point.

Classified:  Browse to a folder which contains LAS files that have one or more

classifications in each file. These files are usually in a tile layout form, but other

files can be used.

Unclassified:  Browse to a folder which contains one or more files that have all points

classified as a single default value. These files are usually in collection scan

form, but other files can be used.

Output:  Browse to an output folder or key in the desired path to store the results of

this LAS classification reassignment. This selection choice is optional - if the

user does not choose an output folder, the unclassified input data is overwritten

with the newly classified data based on this reference reclass function.

Tile Option:  Optionally, the data can be tiled upon completion based on a user-

selected polygon shapefile tile layout.  The 'DB Field' chosen will be used to

name the output LAS files.

Class Requirement:  This option is currently hard-coded to use every classification

existing in the 'Classified' data to reclass points in the 'Unclassified' data.

Source Fields That Must Match Reference:  This area of the interface gives the user

the ability to use the values offered from the Classified to the Unclassified LAS
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files as a reference. 

Cache Unclassified LAS:  Checking this option will cache all of the points specified in

the 'Unclassified' input path to RAM per file, if there is sufficient available RAM

to do so. This will make the tool process more quickly than it would working

from two separate locations (specified by the 'Classified' and 'Unclassified' input

paths) on a network. 

Virtual Tile Size:  The virtual tile size sets the size of the area which the tool will

process at any one time.  Computers with more RAM can process larger areas

resulting in a shorter time to completion.
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Click the 'Reclassify' button to begin the processing.
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Change LAS Date (available with Production license only): This tool, found under the 'Edit Date/

Time' drop-down, allows the user to alter the Julian Day and Year as stored in an LAS file's header and

displayed in the file's properties.  To use the tool, enter a date in the 'File Creation Date' text box (format

must be mm/dd/yyyy).  Navigate to either a single file or a folder of files using the ellipse  button,

then click 'Convert.'

GPS Time Conversion: This tool, found under the 'Edit Date/Time' drop-down, allows the user to

convert how time is stored in LAS files from GPS Week Time to GPS Adjusted Time (when the GPS

Week number is known) and vice versa.  An output folder may be optionally defined to create a new set

of files; otherwise the input files will be overwritten.  Navigate to the desired file(s) using the 'Add' button.

Individual files can be cleared from the list by highlighting the appropriate file and clicking the 'Remove'

button.  The link provided on the interface can help in determining the correct GPS Week number.  A

valid value between 1 and 2600 (inclusive) must be entered before the 'GPS Week Time to Adjusted
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Time' option can be used.

 

LAS Splitting: This tool splits LAS files into multiple, smaller files based on a user-specified size

limit.  Navigate to the desired file(s) using either the 'Add' or 'Add From Folder' button.  Individual files can

be cleared from the list by highlighting the appropriate file and clicking the 'Remove Selected' button, or

the entire list can be cleared by clicking the 'Remove All' button.  The default size limit is 2 GB per file,

but any value can be entered in the 'File Size Limit (Gigabytes)' text box.  After choosing an 'Output

Folder,' click 'Run' to start the process.  Files that are split will have '-a', '-b', etc. (as necessary)

appended to the original file name and the new files will be placed in the output folder.  The original input

file(s) will remain unchanged.  All files that are made from a single original file will maintain that parent's

Point Source ID (PSID) value.
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Remove Duplicates in LAS (available with Production license only): This tool will remove

duplicate LAS points in a dataset based on X, Y, Z, coordinates and timestamp.  The tool can be run on

a single LAS file or an entire folder of files, and can be multi-threaded ('Number of threads to use ') for

faster processing.  For best performance, there should be a minimum of eight (8) GB of RAM available

(not just installed) per thread.  Navigate to the input file or folder to be processed, and choose an output

folder.  Duplicate weeding will be based on exactly matching X, Y, Z, and timestamp values.  In addition

to the new cleaned files, separate files of only the removed points will be created in a 'Duplicates' sub-

folder of the chosen output folder.  They will have the original file name with '_dup' appended to the end. 

Data must be spatially indexed before it can be processed with this tool - a prompt will appear if the data
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does not yet have spatial index records.

Return Information Testing: This tool will test all points of all input files for proper return (point

family) information.  It should be used anytime a point family error message appears while displaying,

filtering,  or exporting LAS data; or while running tests C-2 or DPH-1 of the USGS 2.1 , 1.3 , or 1.2

 QC Modules, or tests 1.1 or 2.9 of the USGS 1.0 QC Module .  The tool can be run on a single

LAS file or an entire folder of files.  Navigate to the input file or folder to be processed, and also choose

an output folder.  Input files are not modified in any way during testing.  Click the appropriate "Start"

button depending on the input method chosen.  During processing, separate LAS files will be created in

the output folder.  They will have the original file name with 'Valid_' and/or 'Invalid_' as a prefix, as

appropriate.  For example, if file '123456.las' contains some points with invalid return information, both a

'Vaild_123456.las' and 'Invalid_123456.las' file will be generated in the output folder.  If all points in a

given file have valid return information, only the 'Valid_' version of the file will be generated.  Likewise, if

all points in a given file have invalid return information, only the 'Invalid_' version of the file will be

generated.  Note that invalid return information cannot be changed once the data is collected and the

original 'raw' LAS file is created.

1370 1404

1436 1465
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LAS Merging (not available with Evaluation license): This tool merges individual channel LAS v1.4

files (typically made from a multi-channel LiDAR sensor's collection) into a single swath (collection scan)

LAS file.  For example, the separate channel 1 and 2 files produced by Teledyne Optech's LMS post-

processing software from data collected by that company's Pegasus sensor can be merged into a single

LAS file containing all returns from the two channels.  Other sensors can produce up to four individual

channel files, typically numbered 0, 1, 2, and 3.  The individual files must follow a naming convention in

order to be grouped together – following a leading alpha character, the same number or numbers must

exist before the next instance of either an alpha character or a separator ('-' or '_').  There must also be

unique channel indicators at the end of each file name in a group to be merged, such as '-C0' and '-C1',

or '_C1' and '_C2'.  Examples of file naming that produces a properly merged output file include:

‘L3-1-123456-C1.las’ and ‘L3-1-123456-C2.las’  --  the merged output file will be named
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‘L3_M.las’ (the final 'M' means merged)

‘L42B-1-123456_C0.las’ and ‘L42B-1-123456_C1.las’  --  the merged output file will be

named ‘L42_M.las’

'S456-4-789-C0.las', 'S456-4-789-C1.las', 'S456-4-789-C2.las', and 'S456-4-789-C3.las'

--  the merged output file will be named 'S456_M.las'

‘3A-1-123456-C1.las’ and ‘3A-1-123456-C2.las’  --  the merged output file will be named

'3_M.las'

'L45-1-K-333444-C0.las' and 'L45-1-K-333444-C1.las'  --  the merged output file will be

named 'L45_M.las'

Examples of file naming that will result in improperly merged output files include:

‘L3-1-123456-C1.las’ and ‘L4-1-123456-C2.las’  --  the result will be copies of one or

both of the input files

'8B-1-M-987654-C1.las' and '9B-1-M-987654-C2.las'  --  the result will be copies of one

or both of the input files

Proper file naming is critical to a successful merge!  Each set of individual channel files to be merged

must begin with a naming scheme that is unique to that set. 

Once the files to be merged have been properly named, navigate to the folder containing them using

either the 'Add' or 'Add From Folder' button.  Individual files can be cleared from the input list by

highlighting the appropriate file and clicking the 'Remove Selected' button, or the entire list can be

cleared by clicking the 'Remove All' button.  Choose an 'Output Folder' where the merged files will be

stored and then click the 'Run' button.  The status of each swath merge will be shown in the 'Result'

area.  The File Source ID assigned to each final merged file will be taken from the first individual file of
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the group as listed in the 'Input LAS Files' box of the tool's interface. 

LAS Separate (not available with Evaluation license): This tool separates merged multi-channel

LAS v1.4 files into separate individual channel files, one file for each scanner channel value found in the

original merged file.  The Scanner Channel bit flag values must be present in the original merged

file for this tool to work - possible bit flag values are 0, 1, 2, and 3.  For example, a file containing

points from both channels of a dual-channel system  (stored as Scanner Channel bit flag values 0 and 1)

will be separated into a channel 0-only file and a channel 1-only file.  In this example, if the original

merged file is named 'L3-123456-M1.las', the new individual channel files will be named ‘L3-123456-M1-

C0.las’ and ‘L3-123456-M1-C1.las’.  Navigate to the files to be separated using either the 'Add' or 'Add
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From Folder' button.  Individual files can be cleared from the input list by highlighting the appropriate file

and clicking the 'Remove Selected' button, or the entire list can be cleared by clicking the 'Remove All'

button.  Choose an 'Output Folder' where the individual channel  files will be stored and then click the

'Run' button.  The status of each file separation will be shown in the 'Result' area.  The File Source IDs

assigned to each individual channel file will be the same as the ID from the original merged file.

Add System ID: This tool allows the System Identifier field in the Public Header Block of LAS files to

be populated or edited.  Note that 'System Identifier' is sometimes referred to as 'System ID' or 'Sys ID'. 

Per the ASPRS LAS v1.4 specification, there are several entries that are valid for this field, and it can

hold up to 32 bytes (characters) of information.  MARS® defaults to 'OTHER', but this can be changed as
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needed in the tool's interface.  If a value is already present in the file header(s), it will be silently

overwritten by the tool.  This tool will not allow complete removal of existing entries.  To use, navigate to

the files to be populated/edited using either the 'Add' or 'Add From Folder' button.  Individual files can be

cleared from the input list by highlighting the appropriate file and clicking the 'Remove Selected' button,

or the entire list can be cleared by clicking the 'Remove All' button.  Click the 'Update' button to begin

processing.  The status of each file's updating will be shown in the 'Result' area.

Collection Scan Renumbering: This tool, found under the 'Collection Scans' drop-down, is

designed for use with original collection scans (swath files), and allows the collection scan number

stored with each LiDAR point to be changed using one of several methods:  On the 'Manual' tab, a new

number can be assigned on a file-by-file basis (below, left), or sequential numbers can be assigned to a
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folder of files by specifying a non-zero starting number in the 'Starting collection scan number' text box

(below, center).  An option to use existing Point Source IDs to set the File Source ID numbers is

available for either of these methods.  In 'Manual - Folder' mode, the tool can be multi-threaded ('Number

of threads to use ') for faster processing.  For best performance, there should be a minimum of eight (8)

GB of RAM available (not just installed) per thread.

On the 'CSV' tab, a CSV file with multiple mapped changes can be read in for an entire folder of LAS

files (below, right).  When the CSV file option is used, it must be formatted as two columns: the first is a

listing of the original collection scan numbers (one per row), and the second column lists the new

desired collection scan numbers.  For example, 5 would become 105, 6 would become 106, etc.  A

header row is optional and will be ignored during processing.  File Source IDs will be changed to match

the new collection scan numbering for each file.  Please note that LAS version 1.4 files are limited to

collection scan numbers of 1 to 65,535.  Original values (first column) of zero (0) will not be changed.
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Single Collection Scan to Multiple (available with Production license only): This tool, found

under the 'Collection Scans' drop-down, will split a single collection scan into multiple, smaller collection

scans at locations  indicated by deviations in the flight heading, or angle, which is user defined.  Having
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multiple, smaller collection scans rather than a single larger scan may help in boresighting as well as

measuring height differences in overlapping collection scans. 

1. To use this tool, first add the LAS collection scan data to be split up.  After adding

the scans, individual files can be removed from the list by selecting them and clicking

the 'Remove' button to the right of the 'LAS Files' section.

2. Next, add the SBET shapefile which is associated with the loaded LAS file(s).

Only one SBET shapefile can be loaded per run.

3. Specify the sampling rate used to determine flight path angle changes by entering

an integer into the 'Use every __ points in the shapefile' text box.  This feature of

the tool allows the user to reduce the sampling rate of (or thin out) the heading

data from the SBET file by allowing the user to define a time range.  By default,

data points are usually one second apart.

The examples shown below compare a 1 second sampling rate (left) and 30 second
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sampling rate (right).

  

4. The 'Match date stamp in SBET file name and LAS file name' option (checked by

default) improves performance by matching the SBET with only those LAS files

that are named with the same mission identifier.  Other missions' LAS files that

may have been included in the 'LAS Files' box will be ignored to save time.  A

specific naming convention must be used for this option: the SBET must have a

six-digit date stamp in the 6th through the 11th positions of the file name, and the

LAS file(s) must have the exact same six-digit date stamp in the 1st through 6th
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position of the file name(s).  For example, an SBET named 'Proj_210401_East.shp'

would match up with LAS filenames such as '210401_L100.las' and '210401_L101.

las'.  That same SBET would not match up with an LAS file named '040121_L100.

las' or '20210401_L100.las', and no splitting would be performed. 

5. Define an output folder for the newly-generated collection scans.

6. Choose a starting collection scan number for the new collection scans which will

be produced.

7. Choose an angle at which collection scans will be separated.  Whenever the angle

specified here is found in the original, single collection scan, the process will

generate a new collection scan.

8. When all specifications have been made, click the 'Run' button.

9. When the process is complete the user will be notified with a prompt as seen

here:

In the first example shown below the LAS data is shown colored by collection scan. 

There is only a single, long collection scan loaded.  The SBET shapefile is shown as

the pink  point shapefile.  In the second example, the collection scan shown

previously has been converted to multiple collection scans with the collection scan

angle specified for separation at 90 degrees.  The new data below is also colored by

collection scan.
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LAS Up-Conversion: This tool allows batch conversion of pre-LAS v1.4 files, or version 1.4 files

with the following characteristics:  a legacy Point Data Record Format of 0-5, less than 16-bit Intensity

values, less than 16-bit RGB(N) values (if present), GeoTIFF tags containing Coordinate Reference

System info, and/or presence of Variable Length Records.  It is the same tool that appears when loading
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LAS files that are not compliant with this version of MARS® (if 'Yes' is chosen in response to the up-

conversion prompt).

This tool has several options including: 1) output to a different folder than the files currently reside in, 2)

bit flag mapping to convert user-defined classes of points to any of the four changeable bit flags used in

version 1.4 LAS files - Synthetic, Key-point (also referred to as Model Key-point), Withheld, and

Overlap, and 3) assignment of a WKT tag for Coordinate Reference System definition.  Existing bit flags

(except, in some cases, the v1.4-only Overlap type) can be carried over from the files being converted,

or a class or classes can be specified that represented the bit flag types in older version files.

On the 'Input Files / Output Folder' tab, navigate to the files to be up-converted using either the 'Add' or

'Add From Folder' button.  Individual files can be cleared from the input list by highlighting the appropriate

file and clicking the 'Remove Selected' button, or the entire list can be cleared by clicking the 'Remove

All' button.  The input files will be overwritten unless an output folder is selected.
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On the 'Bit Flag Mapping' tab, check the boxes in the left column for any bit flag types that need to exist

in the up-converted files.  If the existing files have bit flags set for Synthetic (rare), Model Key-point,

and/or Withheld, select the appropriate 'Use bit flag' radio buttons to carry over the bit flag status.

Otherwise, keep the default 'Use Classes' radio buttons selected and use the 'Select' buttons in the

'Source' section to choose one or more classes in the existing files that are representing a bit flag type.

 The pre-populated 'Source' classes were chosen as defaults because they are commonly used in LAS

files older than version 1.4.  Optionally, a new 'Target Class' can be selected for the points once their

bit flags are set.  Class 2 is the default 'Target Class' for Model Key-point since it is a sub-set of

ground (which is typically stored as Class 2).

For the 'WKT' tab, any existing Coordinate Reference System information that is readable will be shown

as a WKT format tag which can then be edited for correctness and/or completeness.
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The tool can be multi-threaded ('Number of threads to use ') for faster processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

 When all settings have been made, click 'Run' to start the up-conversion and load the files, or 'Cancel'

to dismiss the interface without modifying or loading any files.

LAS Version Converter: This tool allows batch back-conversion (export) of LAS files to older

versions (or version 1.4 with legacy Point Data Record Formats).  Some loss of information is

unavoidable when converting data back to older versions and/or lower PDRF values, depending on the

specific version/PDRF of the resulting files.  See the LAS File Specifications  topic for details.

This tool has several options including: 1) LAS version to be created, 2) how existing bit flags will be

stored (as is, or converted to classes) and, 3) conversion of Adjusted GPS Time to GPS Seconds of the

Week.

1716
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For option 1, PDRF values for the output are determined by the 'Target LAS Version' chosen, as well as

whether the input LAS v1.4 files are PDRF 6, 7, or 8.  The following table lists the possibilities:

PDRF 6  --  if back-converted to LAS v1.0, LAS v1.1, LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF <

6), resulting PDRF will be 1.

PDRF 7  --  if back-converted to LAS v1.0 or LAS v1.1, resulting PDRF will be 1.  These LAS

versions cannot store point-level RGB values.

PDRF 7  --  if back-converted to LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6), resulting PDRF

will be 3.

PDRF 8  --  if back-converted to LAS v1.0 or LAS v1.1, resulting PDRF will be 1.  These LAS

versions cannot store point-level RGB or near-infrared (NIR) values.

PDRF 8  --  if back-converted to LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6), resulting PDRF

will be 3.  These LAS versions and legacy PDRFs cannot store point-level near-infrared (NIR) values.

For option 2, mapping of existing bit flags to the output files depends on the 'Target LAS Version'

selected.  In LAS v1.0, there is no provision for bit flag storage as such, so unique classes must be used

to represent bit flag values that the user wants to save.  The default classification values shown in the

tool interface can be changed as needed.  In LAS v1.1 through LAS v1.4 (PDRF < 6), it is possible to

keep the bit flag status of all but the 'Overlap' bit flag.  Optionally, the user can map those bit flags to

unique classes in the output files by selecting the corresponding radio button(s) and either accepting the

default classes or changing them as needed.  Any existing 'Overlap' bit flags must be converted to a

unique class for all back-conversion scenarios.

For option 3, back-conversion to LAS v1.0 or LAS v1.1 requires timestamps to be stored as GPS

Seconds of the Week - therefore, that option will be checked on and disabled.  Back-conversion to LAS

v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6) allows the timestamps to be optionally converted to GPS

Seconds of the Week.  Note, however, that this time storage method does not maintain the actual

collection date.
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When converting back to LAS v1.4 (PDRF < 6), any existing CRS info record (in WKT format) will remain

in an EVLR and all spatial indexing records will be written to VLRs.  When converting back to LAS v1.0

through v1.3, all EVLRs will be written as VLRs.

In the 'Input Files' section, navigate to the files to be back-converted using the 'Add' button.  Individual

files can be cleared from the input list by highlighting the appropriate file and clicking the 'Remove

Selected' button, or the entire list can be cleared by clicking the 'Remove All' button.

This tool requires the use of an 'Output Folder' - the input files cannot be overwritten.  When all settings

have been made, click 'Convert' to start the back-conversion, or 'Cancel' to dismiss the interface

without creating any new files.

Float Grid to Hillshade: This tool, found under the 'Format Conversion' drop-down, allows the user

to create a hillshade image or raster from a gridded, elevation float grid (*.flt).  This tool inputs a float grid
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and is capable of outputting a JPEG 2000 file, BMP file, IMG file, or float grid file.  It is important to

understand that the output file created by this tool is an image or raster.  It is meant to display quickly,

similar to the performance of a compressed .ecw file.  Because this tool creates an image file, the

resulting file may only be viewed in 2D (orthographic) view  and CANNOT be seen in 3D.

Output folder: Click on the '...' button and navigate to or key in an output folder for

the finished image or raster product.  There must be an output folder specified to use

this tool.  If an output folder is not  designated, the following prompt will appear:

 

FLT File: By clicking on the corresponding '...' button, the user may navigate to a

single input *.flt file.  This is the file that will be used to create an image or raster. 

Either the 'FLT File' specification or the 'Folder to Process specification' must be filled

to use this tool. If the 'FLT File' is not specified and the user attempts to click on the

corresponding 'Convert' button, the following prompt will appear:

Folder to Process: By clicking on the corresponding '...' button, the user may

navigate to a folder. Every *.flt file inside the specified folder will be converted to an

image or raster if this option is chosen. Either the 'FLT File' specification or the 'Folder

835
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to Process specification' must be filled to use this tool.  If the 'Folder to Process' is

not specified and the user attempts to click on the corresponding 'Convert' button,

the following prompt will appear:

No Data Value:  If there is a data void in the data set (no information within the cell),

a 'No Data' value is assigned.  Cells with null values will be given a default value of -

999.00 unless otherwise specified. Enter an integer in the text box for the No Data

Value if another value is preferred.  Note: Water does not reflect LiDAR points, so

water should be considered a No Data area.

Output File Type: The user may specify here which type of product the tool should

output.  The user may choose from outputting a JPEG 2000 file, float grid, IMG file, or

BMP file.  Click on the drop-down to display the choices.

Angles: Allows the user to specify the sun azimuth and altitude to achieve the

desired shading effect.

Result: The 'Result' text box will show the user the processing of the tool.  When the

file has been converted, the result text box will display that the specified *.flt file(s)

were processed. 

The example below shows the 'Convert Elevation Float Grid to Hillshade' window:



MARS® v2023.1           User Manual430

© 2000-2023 Merrick & Company

After the conversion has taken place, go to the output directory which was specified and

load the resulting image or raster file into MARS®.  The file will be renamed with the same

name as the float grid file which was the input *.flt along with '_Hillshade' appended to the

end of the file name.  For example, the 'sample.flt' file which was the input *.flt in the

example above was output as a JPEG 2000 file and named 'sample_Hillshade.jp2'.  Load

the newly converted file to MARS® to view it.

Below is a sample of the newly created 'sample_Hillshade' JPEG 2000 file.  Because the

resulting file is an image file, panning and moving around the data is much quicker than
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using the corresponding float grid with hillshade created 'on the fly'.

Float Grid to TIFF (available with Production license only): This tool, found under the 'Format

Conversion' drop-down, will convert an existing Float Grid or folder of Float Grids to the GeoTIFF format.

To use, choose a Float Grid file or folder using the appropriate browse button and browse to or key in an

'Output Folder.'  Please note that the source *.FLT and *.HDR files must be in the same folder. 

Projection definition information may (optionally) be applied to the new TIFF(s) by selecting the

horizontal system name (the browse button will bring up the GeoCalc  interface where a selection can

be made) and entering the Horizontal and Vertical Units from the drop-down boxes.  Click the

appropriate 'Convert' button to begin the process.

1585
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Float Grid to IMG (available with Production license only): This tool, found under the 'Format

Conversion' drop-down, converts a Float Grid (*.flt) to an ERDAS Imagine compatible IMG file.  The

conversion can be done by file or folder, and the No Data Value can be specified by the user.
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GeoTIFFS to JPEG 2000: This tool, found under the 'Format Conversion' drop-down, combines a

folder of GeoTIFF rasters into a single JPEG 2000 raster (JP2) with a user-specified name and output

folder location.  The compression ratio can be modified to find the best balance of quality and file size.

The default compression value is '5' on a scale of 1 (lowest compression, highest quality) to 10 (highest

compression, lowest quality).  An assumption is made that all input GeoTIFFs are in the same

coordinate system and have the same cell sizes.
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Swath shapes to overlap JP2: This tool, found under the 'Format Conversion' drop-down,

converts a folder of swath footprint shapefiles into a JPEG 2000 raster to allow faster and more complete

coverage checking.  Browse to and select the folder containing the swath footprint shapefiles (these

must be polygons), and select the output file name and location.  The 'Required ANPD' (Aggregate

Nominal Pulse Density) must be input, and the 'Horizontal Units' (e.g., Meters or US Survey Feet) must

be selected from the drop-down list to ensure the proper cell size is used in the raster creation.
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The output raster uses the same color coding as the 'Flight Line Overlap' raster in test DC10.1 of the 

Lidar Data Checks  tool:

TIFF Tag Editing (available with Production license only): This tool, found under the 'Format

Conversion' drop-down, creates a CRS (coordinate reference system) tag for TIFF files, or replaces an

incorrect or incomplete tag.  Click on the ‘Edit’ button to the right of the ‘WKT’ entry box to open a CRS

selection window.  Make the appropriate selections in the ‘Horizontal’ and ‘Vertical’ entry boxes in the

top half of that window and click ‘OK’ (see the 'Add CRS Info (to LAS Files)' topic in the Coordinate

Conversion Tab  help section for details).  Then browse to the TIFF (‘Single TIFF to process’) or TIFFs

(‘Folder to process’) that need their tags edited and click the corresponding ‘Fix’ button.  The ‘Clear’

button can be clicked to remove the results from the ‘Running Status’ box if another operation needs to

be done.  There is no output folder for this tool - the input TIFF or TIFFs are silently overwritten with the

new versions.

1494
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TIFF Origin Rounding (available with Production license only): This tool, found under the

'Format Conversion' drop-down, rounds off raster extent values to three decimal places, allowing for

better edge-matching with adjacent rasters and better agreement with tile boundary coordinates. 

Browse to the TIFF (‘Single TIFF to process’) or TIFFs (‘Folder to process’) that need rounding and click

the corresponding ‘Fix’ button.  The ‘Clear’ button can be clicked to remove the results from the ‘Running

Status’ box if another operation needs to be done.  There is no output folder for this tool - the input TIFF

or TIFFs are silently overwritten with the new versions.
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Tiff Nullifier (available with Production license only): This tool finds clusters of connected pixels

with cell values of 1,1,1in one or more 3-Band (RGB) TIFF images, and re-writes those values to 0,0,0. 

The minimum number of connected pixels can be set, along with the search area parameters.  When

'Small Area' is selected, the tool will be expecting only a single area to be modified, and the process will

terminate after locating and re-writing that area.  If 'Entire Image' is selected, the tool will search the

entire TIFF for areas meeting the minimum cluster size before stopping.  This tool will benefit from Multi-

Threading when the 'Folder to process' option is used.  For best performance, there should be a

minimum of eight (8) GB of RAM available (not just installed) per thread.
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Float Grid Merge: The 'Float Grid Merge' tool, found under the 'Float Grid Operations' drop-down,

allows the user to combine multiple float grids into a single file.  The files being merged inside this tool

do not need to be loaded into MARS® prior to being merged. To use this tool: 

1. Place the singular float grids which will be combined to create the

merged float grid into the same folder.

2. Specify this folder in the 'Input: Folder to process' text box. The

user may navigate to the folder by clicking the '...' button.

3. Next, specify the output folder and name the new float grid file.

Clicking on the '...' button will allow the user to navigate to the

designated output folder where the merged float grid will be placed

after creation, or the path may be keyed in. The user must also

name the new, merged file here. In the example below, the user has

named this file 'Merged'. 
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4. Click the 'Merge' button to begin the process. The progress of the

tool (by file) may be monitored in the bottom window of the interface.

To view the result, the user must add the newly created float grid file by clicking the 

'Add Float Grid' button on the Project/Data Preparation Tab  and choosing the

merged float grid file.

Float Grid Clipping: This tool, found under the 'Float Grid Operations' drop-down, allows a Float

Grid to be clipped to the extents of a polygon shapefile.  To use, click on the ellipse button to the right of

the 'FLT File' text box and navigate to the Float Grid file to be clipped.  Then choose the polygon

shapefile to be used as a clipping boundary by clicking the ellipse button to the right of the 'Clipping

Boundary' text box.  Click on the 'Clipping' button to begin the process.  A message will appear in the

162
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'Result' box when the clipping is complete.  NOTE: The existing file will be overwritten with the new

result and only that grid data within the polygon(s) of the shapefile will be kept.

Float Grid Tile Cutting: This tool, found under the 'Float Grid Operations' drop-down, allows a Float

Grid to be cut into individual areas based on a tile layout shapefile.  To use, click on the ellipse button to

the right of the 'FLT File' text box and navigate to the Float Grid file to be tiled out.  Next, click on the

ellipse button to the right of the 'Tile Shapefile' text box and navigate to the tile layout.  All polygons in

the tile shapefile will be used to cut the original Float Grid into individual areas.  Choose a unique-value

attribute field ('DB Field') that will be used to name the output Float Grids.  Optionally, a 'Prefix' and/or

'Suffix' can be added to further define the new grid names.  Click on the 'Tiling' button to begin the

process.  A message will appear in the 'Result' box when the tiling is complete.  The new tile-based

Float Grids will be output in the same folder as the original Float Grid, and the original will not be altered

in any way.
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Float Grid Merge to Base: This tool, found under the 'Float Grid Operations' drop-down, can be

used to replace a re-processed area of an existing Float Grid with corrected grid data.  It is particularly

useful when only a small portion of a large area single-file Float Grid needs to be replaced, and can save

a considerable amount of time over re-exporting the entire project area.  A typical workflow would be as

follows:  1. After identifying a mis-classified area of a Float Grid, use a tile layout shapefile to determine

which tile or tiles are affected.  2. Create a new tile shapefile with those tiles deleted.  3. Use the 'Float

Grid Clipping' tool (above) to make a new Float Grid using the new tile shapefile as the Clipping

Boundary - this will eliminate the bad area(s) from the original Float Grid.  4. Re-classify the LAS data as

needed and export a Float Grid using only the tiles that encompass the modified area(s) - this export will

be used as the 'patch.'

To use this tool, click on the ellipse button to the right of the 'Base FLT File' text box and

navigate to the Float Grid that needs to be patched.  Next, click on the ellipse button to the

right of the 'FLT to Merge to Base' text box and navigate to the new Float Grid data that will

be used to fill the void in the base grid.  Click the 'Merge' button to begin the process.  A
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message will appear in the 'Result' box when the merge is complete.  NOTE: The existing

base Float Grid will be overwritten by the new merged grid data. 

Merge Shapefiles (available with Production license only): This tool creates a new merged

shapefile from two or more input shapefiles.  All input files must be of the same geometry type (i.e.,

point, polyline, or polygon), and must reside in the same folder.  After clicking on the tool, the 'Open'

dialog box appears.  Navigate to the folder where the shapefiles to be merged are located, then choose

two or more shapefiles by using the left mouse button with 'Ctrl' or 'Shift' (standard Windows selection

methods).  Click 'Open' and the dialog box will change to a 'Save As' box.  Enter an output folder and file

name for the new merged shapefile and click 'Save.'  A pop-up message will indicate when the tool has

completed processing.  If the input data has defined projection, then a PRJ file with that projection

information will be created for the merged shapefile.  The newly created shapefile can now be loaded

into MARS® as a Reference Shapefile (or Tile Shapefile, as appropriate).



Tab and Ribbon Layout 443

© 2000-2023 Merrick & Company

 

  



MARS® v2023.1           User Manual444

© 2000-2023 Merrick & Company

Edge Match for Shapefiles (available with Production license only): This tool allows the user

to match the endpoints of shapefile contour lines in two (2) separate folders. Because the tool will only

match contours with the exact same elevation, it is important that both shapefiles contain an elevation

attribute field labeled 'ELV'. This attribute field must contain the elevations of each contour line.

Folder of Shapefiles to Move: Navigate to the folder which contains the shapefiles

of contour lines which are to be moved in the edge match process. The contour lines

in these shapefiles will be moved to match the endpoints of the contour lines in the

Reference Shapefiles folder. The contour lines will only be moved horizontally

according to the tolerance the user defines. The elevation of the contour lines will not

be changed in the edge match process. For this reason, the shapefiles must have an

attribute field labeled 'ELV' which contains the elevations of every contour line in each

shapefile. Only contour lines which are within the tolerance defined and which match
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the exact elevation of the reference shapefiles' contour lines will be moved.

Folder of Reference Shapefiles (Hold): Navigate to the folder which contains the

shapefiles of reference contour lines to be used. The reference shapefile contour lines

 will not be moved during the edge match process. The reference shapefile contour

lines will be used to measure the tolerance as defined below, and contour lines in the

'Shapefiles to Move' set will be moved to match these contour lines. The reference

shapefiles must have an attribute field labeled 'ELV' which contains the elevations of

every contour line in each shapefile.

Tolerance: Enter a number (in project units) here to set a maximum search radius

for finding matching-elevation contour lines in the 'Move' and 'Hold' folders. In the

example below, the tolerance is set at 2.0 units. If a contour line endpoint with a

matching elevation is found within 2.0 horizontal units of the contour line endpoint in a

reference shapefile, the endpoint will be snapped to the endpoint of the reference

shapefile contour.



MARS® v2023.1           User Manual446

© 2000-2023 Merrick & Company

Contour Join: This tool allows the user to join several different contour features into one continuous

contour.  For example, the screen shots below show a single contour line which was broken apart into

several different features (or separate contour lines) by tile. This line, which represents only one contour,

is now several contour lines. The contour line breaks into separate contour lines at every tile boundary.
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In the example below, the 'Contour Join' tool has been run on the same contours as shown

above. The contour which was cut at the edges of each tile now runs continuously for its

entire length until the project boundary.
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Depression Coder (available with Production license only): The 'Depression Coder' tool allows

the user to find depression contours and label them as such in a newly-generated contour shapefile's

attribute table. This tool is meant for use over an entire project-wide area, preferably using a single,

merged shapefile of contours.  This makes the processing more accurate by allowing the tool to locate

large depressions spread over several tiles which would have otherwise been missed if processing was

done over a smaller area or run by tile.  The tool searches through the data looking for closed contours

which form 'polygons', indicating a depression or rise in the earth's surface.
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To use, navigate to the folder containing the contour shapefiles for the entire project in the 'Folder of

Contour Shapefiles' text box.  Navigate to the folder containing the accompanying LAS data for the

entire project in the 'Folder of LAS Files' text box.  Ideally, use the same LAS data that the contours

were generated from.  The 'Depression Coder' tool will not make any changes to the LAS data.  The LAS

information is only used as a reference to help find depression contours and ignore rising contours.  For

example, contours generated over a dry lake bed (depression contours) are very similar in appearance to

contours created over a large hill (rising contours) when viewing only the linework and not the elevation

values.  Since the LAS data contains elevation information (Z-values) for each point, it will help in

assessing whether the closed contours are depression or rising contours.  This is done by specifying the

class (or classes) that contain ground points and setting a 'Search Radius' value that is equal to (or

slightly larger than) the cell size used in making the original contours or the gridded surface they were

generated from.  This radius is the distance inside each closed contour that the tool will search for

ground points.  If points are found with lower elevation values, the contour will be labeled a depression. 

When all the necessary entries to the 'Depression Coder' interface have been made, click the 'Run'

button.  The progress of the tool may be monitored via the status bar.  A new shapefile containing the

depression-coded contours will be created in the 'Folder of Contour Shapefiles', with '_Processed'

appended to the input shapefile's name.

Please see the Contours Tab  for information on expected level attribute values for proper

operation of this tool.  Depressions will be given a value one number higher than non-depression

contours.  For example, if Index contours are level 50 and Intermediate contours are level 51, then their

depression equivalents will be assigned levels 52 and 53, respectively.

806
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When the 'Depression Coder' tool has completed its task, the user will receive a prompt
reporting the total original polygons, nodes, and newly formed polygons. 

Complex Polys to Simple (available with Production license only): This tool allows the user to

create separate files (simple polygons) from a multiple file (complex polygon) shapefile. This tool  may

be useful when the user wishes to export data by tile clipped to a boundary. If this boundary separates a
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particular tile into multiple parts, the user may end up with duplicate tile numbers. Duplicate tile numbers

often may cause overwriting of needed data. The example below shows a boundary (in white) which cuts

the two (2) indicated tiles in the tile shapefile (in blue) into multiple parts.

If the user loads a tile shapefile (similar to the one above in blue) that contains complex

polygons, MARS® will notify the user. This prompt will ONLY appear when the user is loading

the complex shapefile AS A TILE SHAPEFILE, not as a reference shapefile. This window

appears only for information and as a suggestion to apply the 'Complex Polys to Simple' tool

to avoid lost or overwritten data.  If a complex shapefile (a shapefile containing multi-part

polygons) has been loaded as a tile shapefile the following prompt will appear:

The file loaded must be a complex shapefile for this tool to work. If the user loads a tile

shapefile which has been 'exploded' (separating multi-part features into single part features)
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then MARS® will not be able to recognize a single tile in multi-parts but only recognize two

individual tiles. For this reason, any tile shapefile containing complex polygons must not be

exploded for the 'Polygons From Complex to Simple' tool to work. If the file is 'exploded', a

warning message will show upon export, but this file will no longer be functional in the

'Polygons From Complex to Simple' tool.

In the example below, MARS® is recognizing a tile shapefile which is complex. Tiles 151 and

152 have been cut into multiple parts by a boundary. A prompt was received when this

shapefile was loaded. If the user were to export the data by tile at this point in time MARS®

would export the data in one part of tile 151 then overwrite that data with the data in the other

part of tile 151. The same would happen with tile 152. Thus, the user would lose some data in

each tile causing gaps. To avoid this situation, use the 'Complex Polys to Simple' tool. 
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The Input Shapefile should be the complex shapefile which contains multi-part tiles. The user

may choose the Attribute Field to Modify from the drop-down box. This list is created based

on the attributes which are currently found in the attribute table for that particular shapefile. In

most cases the user will be choosing 'TName' or the tile name of the attribute ('ET_ID' in this

example). The output shapefile will be the simple polygon shapefile created.  Navigate to a

location for the new file and name the new file. Choose 'Run' to start processing. When

processing is complete a prompt will notify the user. The Status box will give the user a short

summary on the number of polygons found in the shapefile and how many new tiles it created.

In the example below, the tool found one polygon (tile) and it was complex. Thus, the final

output shapefile contains two polygons (tiles). 

The new, simple polygon shapefile has distinguished between the multiple parts of a single

tile. In order to avoid any overwritten data, the tiles have been named using an a, b, c...

sequence. This way, each multiple part of a tile is perceived as a unique set of data and will
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not be overwritten or replaced. The tiles previously named 151 and 152 are now named 151a,

151b, 152a, and 152 b. An example may be viewed below:

Assign Highest Z to Poly: This tool assigns X, Y, and Z values to all polygons in a polygon

shapefile based on the values of the underlying LiDAR point within each polygon that has the highest  Z-

value(elevation).  The shapefile must already have three fields defined as follows: Field Names - MAX_X,

MAX_Y, and MAX_Z, all with the parameters Data Type - Double, Precision - 18, and Scale - 8.  When

the completed shapefile is loaded into MARS®, the new fields will be populated as shown in the

example table (below). 
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Z Fix Using Stream Rule (available with Production license only): This tool will test and fix (if

necessary) a 3D breakline shapefile to maintain monotonicity.  In a hydrography context, monotonicity

is the principle that elevations (Z-values) must decrease, or at least stay flat, as a breakline goes from

uphill to downhill.
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No data needs to be loaded to use the tool.  Path out the 3D breakline shapefile to be tested in

the ‘Input’ section and the new (corrected) output shapefile in the ‘Output’ section.  Then choose

either the ‘Run’ button (Z-values rounded to three decimal places) or the ‘Run (EDH Drape)’

button (no rounding done) to start the tool.  If a Z-value is detected that is higher than the

previous uphill value, that previous value is copied to the 'bad' vertex.  When the input shapefile

has polyline geometry but contains both unclosed and closed features, two output files will be

generated -- <name>.shp and <name>_Polygon.shp.  The original input shapefile is never

altered with this tool.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.11 QA/QC Tab

QA/QC Tab Items
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Merrick Advanced Remote Sensing (MARS
®

) Software

The QA/QC Tab:

Check Point Report: Please see the Check Point Report  topic for information on using this

tool.

QC Module (available with Explorer QC or Production license only): Please see the USGS

2022 rev. A QC Module , USGS 2021 rev. A QC Module , USGS 2020 rev. A QC Module ,

USGS 2.1 QC Module , USGS 1.3 QC Module , USGS 1.2 QC Module , USGS 1.0 QC

Module , LiDAR Workflow QC , and Voronoi Density Reporting  topics for information on using

the various tools found in the QC Module.

Raster QC (available with Explorer QC or Production license only): Please see the Raster QC

 topic for information on using this tool.

Coverage Tracking Tools (available with Production license only):

The Coverage Tracking function makes a polygon shapefile noting where the user has been in the

project.  This helps to document which areas of a project have editing coverage.  For example, when

going into coverage check, the user would be able to distinguish what areas have been checked versus

not checked.  These tools work like a recorder in that the user is capable of starting recording, leaving

the tool running while performing coverage checks to record movement, and then stopping recording. 

The user can also save the recorded data for later use.
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 Start Coverage Tracking: Use this tool when coverage checking, editing, or during

any other activity where it is useful for the user to track movements across the project.  Clicking

the ‘Start Recording’ button will start the process of recording the user's movements across the

data.

 Stop Coverage Tracking: Select this button to stop the recording process.  At this

time, the user’s movements across a project will no longer be noted in the shapefile created

when the tracking path is saved.

 Save Tracking to Shapefile: When the user has started and stopped a recording

tracking the movements across a project, the recording can then be saved as a polygon

shapefile.  When a tracking   shapefile is saved, a *.prj (projection definition file) is created if the

projection information is known for the source LAS data.  This shapefile will show the areas in

which the user has visited.  This can be useful in double checking that a project area has been

fully examined. .

Ex: Each rectangle represents an area of the LAS Map View window and the data that was viewed

inside that area.  With this coverage check ing tool, it is easy to see that all of the data below has

been viewed and no area was left unchecked.
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© 2000-2023 Merrick & Company. All Rights Reserved.

3.12 Export/Extract Tab

Export/Extract Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Export/Extract Tab:
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For any LAS tools that allow files to be pathed out without loading them in the Table of

Contents in MARS® (including 'Export' when the 'Export without loading LAS files into Map

View' option is used),  an up-conversion prompt will appear when executing the tool if the LAS

files do not meet the minimum MARS® compliancy requirements.  This prompt is described in

the Project/Data Preparation Tab  topic.

 Export: Opens the export type drop-down list with 'LAS' as the default export type.  The

available export types are listed in item '1.' below.  For more information on the different types of

exports, please review the Data Export  topic and sub-topics.

When a type is selected and the 'OK' button is clicked, a dedicated window opens that controls

all parameters and formatting options for that export type.  All interfaces share several tools and

functions in common: 'Save Settings to File', 'Load Settings from File', a progress bar, a display of

'Elapsed Time' and 'Estimated Time to Complete', buttons for 'Help', 'Export', and 'Cancel', and an

option labeled 'Only Displayed Files Will Be Exported'.  Please note that all loaded data will be

exported unless the 'Only Displayed Files Will Be Exported' box is checked.  This option is not

available when the 'Export without loading LAS files into Map View' option is checked on

the Options Tab  (see the Export Options  topic for details).  Also, most export types have

a 'Multi-Threading' control to improve performance by using the processing computer's resources

more efficiently.

1. Export Types:

3D Image: This option exports a specially-colorized 'hybrid' LAS file - a mix of high-

density gridded data to represent ground and non-gridded data to represent above
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ground features.

Contours - Shapefile:  This option exports contours in an Esri-compatible shapefile

(*.shp) format.

Flightline Separation - JPEG 2000:  This option exports a JPEG 2000 (*.jp2) raster

depicting collection scan (flightline) separation Z difference values using a color ramp.

Flightline Separation - Tiled GeoTIFF:  This option exports GeoTIFF rasters

based on a loaded tile layout, depicting collection scan (flightline) separation Z

difference values using a color ramp. 

Grid - Cloud Optimized GeoTIFF DEM:  This option exports an elevation raster in

GeoTIFF format with internally stored CRS (coordinate reference system) information

for both horizontal and vertical.  This GeoTIFF is recognized by GDAL as cloud-

optimized to improve streaming performance.

Grid - Cloud Optimized GeoTIFF Intensity:  This option exports an intensity-based

raster in GeoTIFF format with internally stored CRS (coordinate reference system)

information for horizontal.  This GeoTIFF is recognized by GDAL as cloud-optimized

to improve streaming performance.

Grid - ENVI Elev:  This option exports an interpolated ENVI elevation grid (*.dat, *.

hdr, and auxiliary *.xml).

Grid - ENVI Elev/Class:  This option exports an interpolated ENVI elevation grid (*.

dat, *.hdr, and auxiliary *.xml) and a classification grid (*.dat and *.hdr). 

Grid - Esri ASCII Grid:  This option exports an interpolated Esri ASCII elevation or

intensity grid (*.asc) containing cell values in a row and column array; its auxiliary

reference file (*.hdr) contains the number of rows and columns, x and y lower-left

corner coordinates, the grid cell size, and the no-data value. 

Grid - Float Grid:  This option exports an elevation or intensity float grid (*.flt with

auxiliary *.hdr)) based on gridding specifications set up on the 'Grid' tab.
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Grid - IMG:  This option exports an ERDAS-compatible elevation or intensity grid (*.

img).

Grid - LAS:  This option exports data to an interpolated, evenly spaced gridded LAS

file (PDRF 6 only) with all points flagged as 'Synthetic'.

Grid - LiDAR Raster JPEG 2000:  This option exports a JPEG 2000 (*.jp2) raster of

the LiDAR points colored by Class, Intensity, Elevation, or RGB values. 

Grid - TIFF:  This option exports data to an interpolated, evenly spaced elevation or

intensity gridded file, either in a GeoTiff (*.tif) format or as a TIFF format with an

auxiliary World File (*.tif and *.tfw). 

Hillshade - JPEG 2000:  This option exports a JPEG 2000 (*.jp2) raster with user-

selectable sun azimuth and angle.

LAS:  The standardized LiDAR binary format containing: X, Y, Z, intensity,

classification, collection scan, timestamp, and return information, as well as other

fields.

LiDAR Point Density - Float Grid:  This option exports a float grid with the raster

cells colored by relative point density, using the same color scheme as 'Color by

Elevation' rendering on the View Tab .

LiDAR Spatial Distribution Verification GRID - JPEG 2000:  This option exports a

JPEG 2000 (*.jp2) raster using a two-color display for QC.

PLS-CADD Code - ASCII:  This option exports PLS-CADD compatible delimited

(CSV) files.

PLS-CADD Code - LAS:  This option exports LAS files for each class (or group of
classes) that relate to a particular PLS-CADD feature code.

Shapefile:  This option exports LAS data to a point shapefile (.shp).  The settings on

the 'Layout' tab can select attribute fields to populate from the point records.

Text - ASCII:  The settings on the 'Layout' tab can select fields and delimiters for the

output. ASCII text has grid output options.

192
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2. Output tab -  - The 'Output Directory' path is set here for all export types.  Use the 'Browse'

button or key in the desired path to set the path for the exported files.  Most types also have

an option for using temporary local disk space to speed up exports that are being written to a

network drive.  Some types have additional settings on this tab that are detailed in that help

topic for that type in the Data Export  section.

3. Layout tab - Contains tools for formatting, naming, tiling, and clipping the export data.

Format Section: There are eight different format types for controlling the shape (Layout)

of the exported data.  Not all are available (or visible) for all export types.

Single File -  Exports all currently loaded data as a single output file.  No tile layout

is used, even if one is loaded.  Choose this layout type if tiled export is not needed

but, instead, one single file is  required.  This layout type is most commonly used

when exporting a grid-based product.

All Tiles using MBR - Exports all currently loaded data by creating a minimum

bounding rectangle for each tile in the loaded shapefile tile layout.  Choose this

layout type to export all tiles found in the loaded shapefile tile layout in the fastest

manner possible.  This layout type will determine the minimum bounding rectangle of

each tile - for example, if the loaded tile layout consists of circles, the output data

would be in the shape of a square circumscribed about each circle.  Often, township/

range shapefiles are used as tiles.  These are usually slanted in orientation and could

take more time to process as an export tile layout.  If having overlapping exported

data is not a concern, choose the MBR format to speed up the export. 

All Tiles - Exports data as separate tiles clipped to the loaded tile layout.  Tiles can

be any shape (square, rectangular, circular, even irregular-shaped) as long as they

are polygons.  This method of exporting will perform a point-in-polygon analysis and
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therefore will typically be slower than the MBR option (above).  Choose this export

layout if the tiles are non-rectangular, such as in a jurisdictional boundary shapefile. 

Single File From Selected Tiles - Exports a single file (LAS and shape) from one

or more selected input tiles.  This export layout is available only with the 'LAS' and

'Shapefile' export types.

Selected Tile(s) - Exports one or more tiles that are pre-selected in the MARS®

window from a loaded tile shapefile, using the Pick Tiles  tool.  Use this option if

only some (not all) tiles from a loaded tile layout are to be exported.

User-defined Box - Exports only the data within a user defined (dragged) box using

the Export Area  tool.

By Collection Scan - Exports the loaded data by actual collection scans that are

defined internally in the LAS file(s).  Available only for the 'LAS' and 'Text - ASCII'

export types.

By Collection Scan From User-defined Box - Exports from the loaded data by

actual collection scans that are defined internally in the LAS file(s), when the 'Export

Area' tool is used.  Available only for the 'LAS' and 'Text - ASCII' export types.

'File Name' Section:

File - If a user-defined area is being exported, enter a specific file name in this box.

Not enabled when the Layout type is either 'By Collection Scan' or 'By Collection

Scan From User-defined Box'.

Prefix - Add an optional alphanumeric prefix to each file being exported.

Suffix - Add an optional alphanumeric suffix to each file being exported.

Existing Files - 'Overwrite' will replace all files in the output directory, while 'Skip' will

ignore those with the exact same name that already exist in the output directory.
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'Tile Shapefile' Section: This will be enabled if either the 'All Tiles using MBR' or 'All

Tiles' export layout is selected.  Use the 'Browse' button to select the shapefile if one

is not already referenced in the project's .mpd file.  Once the shapefile is referenced,

choose the 'DB Field' in the drop-down menu that contains the tile naming attribute.

When a tile layout is loaded and one or more tiles are picked, the loaded layout will

automatically appear with the option to choose the 'DB Field' as above. 

'Clipping' Section: This option allows only the data within a bounding polygon to be

exported.  Check the 'Clipping Data' box and then select the 'Browse' button to

navigate to the boundary shapefile.        Buffer settings on the 'Options' tab (see item

5., below) do not apply to a clipping boundary.  NOTE that this option is disabled when

the 'Export Area' tool has been used to initiate the export process.

'Record Format' Section: The 'Record Format' section of the 'Layout' tab is only visible

when the 'PLS-CADD Code - ASCII,' 'Shapefile,' or 'Text - ASCII' export types are

selected. 

Choose how the text document or attribute table is to be exported by making

specifications in this area.

Record Format: Select the fields or attributes which are to be included in export.
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 If an attribute field is unchecked, it will not be included in export.  By default, all

fields are selected. 

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.

All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be

made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used

to separate fields in the output text file.

ASCII File Extension: The user may choose the file extension with which the

text file is output.  For example, the user may choose to export out a *.csv or a *.

txt file.  Enter the desired extension into the available text box.

User Field Value: This text box is valid only when the user has selected the

'User Field' attribute for inclusion.  A value entered here will be applied to all

records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are

used in the X, Y, and Z values during export.  The default setting is 2, but values

of 1 to 16 can be entered.

4. Filters tab  - Select the classifications, returns, collection scans, and/or bit flag status

being used for export by checking the box next to 'Using classification set', 'Using return set',

and/or 'Using collection scans', and by checking/unchecking the 'Include' boxes for the

various bit flags.  Note that collection scans can be selected/unselected only for the 

'Flightline Separation - JPEG 2000' and 'LAS' export types.  Next, click on the 'Select ...'

buttons one at a time as needed to make the selections.  Individual interfaces, similar to

those used for filtering what is visible in the LAS Map View window (see View Tab ), will
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allow for control over exactly what is included in export.  Due to the hybrid nature of the '3D

Image' export type, there are two class selection sections.  Note that certain export types

will default to pre-selected return sets and the inclusion/exclusion of bit-flagged points that are

appropriate for that type.  Bit flag options allow for inclusion of Synthetic, Withheld, Overlap,

and Edge of Collection Scan (each controllable individually), with an overall option to export

only bit-flagged points for the selected categories.

5. Options tab  - Add a buffer to the exported data by checking the 'Use Buffer' box and by

typing an integer value into the 'Buffer Size' text box. If the 'Buffer Size' text box = 0 or the

'Use Buffer' box is not checked, then no buffer will be exported.  Any buffer set on this tab will

be ignored when a clipping boundary is used (see the 'Clipping' Section in item 3. above). 

Also, a checkbox is available to force loading of the newly exported data (for most types)

back into the current project.  In addition, an option exists here to export data by pathing out

to it rather than loading it into the LAS Map View.

6. Transforms tab  - This tab is visible only for the 'Contours - Shapefile', 'LAS', and 'Text

- ASCII' export types.  Transforms the exported data by multiplying/dividing (Multiplier) and/or

adding/subtracting (Shift) by a user-definable amount.  Enabled by checking the box(es) - 'X

Transform', 'Y Transform', or 'Z Transform' - for the coordinate(s) to be transformed and

entering the desired vale(s).  If only a Multiplier or a Shift is to be performed for any or all

coordinates, leave the other entry box empty.  If both a Multiplier and a Shift are to be

performed, make entries in both boxes.  For both, the order of operations is Multiplier first,

then Shift.  

7. Grid tab  - The 'Grid' tab is visible if any of the following export types are selected:  3D

Image, Flightline Separation - JPEG 2000, Flightline Separation - Tiled GeoTIFF, Grid - Cloud
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Optimized GeoTIFF DEM, Grid - Cloud Optimized GeoTIFF Intensity, Grid - ENVI Elev, Grid -

ENVI Elev/Class, Grid - Esri ASCII Grid, Grid - Float Grid, Grid - IMG, Grid - LAS, Grid -

LiDAR Raster JPEG 2000, Grid - TIFF, Hillshade - JPEG 2000, LiDAR Point Density - Float

Grid, and LiDAR Spatial Distribution Verification GRID - JPEG 2000. 

Cell Size: Enter an integer for the spacing of the export grid data.

Grid Smoothing Count: Runs a Gaussian filter over the grid after initial values have

been determined. Increasing the smoothing count will increase the number of passes

the filter will perform.

NODATA Value: If the data is void in the data set (no information within the cell), a

NODATA value is assigned. Enter an integer in the text box for the NODATA value.

Auto Calculate Virtual Tile Size: Used to optimize internal ('virtual') processing of

manageable data sizes in RAM, based on Point Density or Ground Sample Distance

(GSD), horizontal units (i.e., feet or meters), available RAM, and the number of

threads to be used during the export.  The function can be disabled and manually set

in the 'Virtual Tile Size' box.

Grid Type: Select 'Elevation' for a grid comprised of Z-value data or 'Intensity' for a

grid derived from LiDAR intensity returns.  The 'Color by Collection Scan Separation',

'LiDAR Spatial Distribution Density Verification', and 'Color By for LiDAR Raster' grid

types are automatically selected when the corresponding export types are used.

Data Type: MARS® is capable of 32-bit Float, 32-bit Signed Integer, 16-bit Unsigned

Integer, and 8-bit Unsigned Integer formats for export, depending on the Grid Type

being exported.  'Float 32' is the only option for the 'Elevation' Grid Type.  'Unsigned

16' is the default for the 'Intensity' Grid Type (exception:  when the export type is

'Grid - Cloud Optimized GeoTIFF Intensity', the 'Data Type' defaults to 'Unsigned

8').  'Int 32' is the only option available for 'Flightline Separation - JPEG 2000'

exports (which use the 'Color by Collection Scan Separation' Grid Type), and the 
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'LiDAR Spatial Distribution Verification GRID - JPEG 2000' Grid Type.

Lower Left (LL) Coordinate Shift: When checked, forces the coordinates of the

lower-left origin of an exported Float Grid to be a value that is evenly divisible by the

chosen Cell Size (see above).

Algorithm: Initial grid values can be calculated using 'Closest Point to Cell Centroid',

'Grid from TIN', 'Min Point of Cell,' 'Max Point of Cell,' or 'Median Point of Cell',

depending on the grid type being exported.

Fill Gap: Depending on the export type, the user has the option on how (or whether)

to fill voids which are found in the LiDAR data.  Both the 'Fast Fill' and 'TINned

Surface Fill' options are used to prevent NODATA values.  If the 'Fast Fill' radio button

is selected, MARS® will use horizontal 'striping' from the last known elevation value of

the input class points (see Filters tab ) for each row of cells in the void area.  The

'TINned Surface Fill' option aids in hydro-flattening by spanning across data voids to

find points in the input classes.  These points are used to create a flat TIN across the

void.   The 'Maximum distance to fill' option sets a maximum distance (in project

units) for spanning a void when either of the fill options is selected.  For the 'TINned

Surface Fill' option, an additional value called 'Internal Buffer Size for TINned Surface'

should be set to mitigate tinning errors across Virtual Tiles (see Auto Calculate

Virtual Tile Size sub-topic, above).  NODATA values will exist beyond this distance.

Input Data Type (Auto boundary algorithm): The boundary of the LiDAR data will

be automatically detected and a NODATA value will be assigned to the raster cells

that fall outside the boundary.  The detection methods vary depending on whether the

input LAS data is in 'Swath' or 'Tile' (the default) format.  Swath data is assumed to

have only one Point Source ID (PSID), also called collection scan number, per file,

and adjacent swaths will overlap each other.  Tile data may have one or more PSIDs

per file, and adjacent tiles will not have any overlap.  Note that there may be overlap 
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within a tile, as when two or more swaths fall within a tile's boundary.  The correct

choice of input type is important in avoiding gaps in the exported grids within the

project area.

8. Contours tab  - The 'Contours' tab is visible only when selecting the 'Contours-

Shapefile' export type.

Algorithm / 'TIN': Builds a grid for generating contours from the TIN.

Algorithm / 'Grid': Generates the contours directly from a grid.  The grid cell size

can be specified and the number of passes of the Gaussian smoothing filter can also

be specified.

Algorithm / 'Use Max TIN Edge Length': Sets a maximum TIN triangle leg length

that will be allowed in TIN creation.  Gaps in the TIN that this setting may cause will

not have contours generated for them. 

Contour Interval: How often a contour is generated (i.e., a value of '2' would create

contours every 2 vertical units).

Minimum Contour Length: For projects in feet, enter 25 as a good starting point.

For metric projects, start with a value of 7.  This minimum will be honored when the

'Perform cleanup' box is checked in the 'Line Cleanup' section (see below).

Index Contour: Select the indexing required for the project.  Index contours appear

in the LAS Map View as thicker, or bolder, contour lines to for easier identification.

Shapefile Format: Choose either the 2D or 3D radio button to control the structure

of the output contours.

Line Cleanup: When 'Perform cleanup' is checked, moves incomplete or

topologically incorrect contours lines to a 'Removed' folder in the output directory. 

These can later be merged back into the main shapefile.  'Clean tolerance' (similar to

fuzzy tolerance in GIS programs) and 'Edge-tie tolerance' (for edge-matching across
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tile boundaries) can also be set.  When checked, does not generate and export

contours less than the 'Minimum Contour Length' (see above).

DGN/Shapefile Attributes: Allows the level, group, and color attribute values of

Normal (Intermediate) and Index contours to be set to facilitate conversion to either of

those CAD formats.

Edge-tie directory of existing shapefile: This option uses an existing folder

containing contour shapefiles for edge-matching purposes.  This folder cannot be the

same as the output folder - if a different folder is not specified, a warning message

will be displayed.  The existing contours MUST contain an 'Elv' attribute field with the

elevation values populated for each contour.  This allows the program to 'edge-tie'

each contour line being exported to equal-elevation contours in previously-created

shapefiles.

9. Projection tab  - The 'Projection' tab is visible only when selecting the '3D Image', 'Grid -

Cloud Optimized GeoTIFF DEM', 'Grid - Cloud Optimized GeoTIFF Intensity', 'Grid - IMG',

'Grid - LAS', 'Grid - TIFF', or 'LAS' export types.  See the procedure outlined in the 'Add CRS

Info (to LAS Files)' topic in the Coordinate Conversion  section of this help file for more

details.

Projection Description - This text box will describe the projection to be used.  Click

on the browse button ('...') next to the text box to choose the needed projection if it is

not already populated.

EPSG Code - Each horizontal projection system is identified by a unique EPSG

Code.  If the EPSG code of the particular projection to be used is known, it may be

entered here.  If the code is not known, this text box will be automatically populated

when choosing a projection description through the 'Select Coordinate System from

Datasource'.  For more information on the Projection  tab, please see the
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associated section of the help topics.

Horizontal Unit - Choose the horizontal units to be exported in Meters, US Survey
Feet, International Feet, or Degrees with this drop-down box.

Vertical Projection - This text box will describe the vertical projection to be used.

Click on the '...' button next to the text box to browse to the needed projection.

EPSG Code (Datum) - Each vertical datum is identified by a unique EPSG Code.  If

the EPSG code of the particular datum to be used is known, it may be entered here.

If the code is not known, this text box will be automatically populated when choosing

a datum through the 'Select Vertical Coordinate System from Datasource'.  For more

information on the Projection  tab, please see the associated section of the help

topics.

EPSG Code (Vertical CS) - Each vertical projection system is identified by a unique

EPSG Code.  If the EPSG code of the particular projection to be used is known, it

may be entered here.  If the code is not known, this text box will be automatically

populated when choosing a projection description through the 'Select Vertical

Coordinate System from Datasource'.  The code for Vertical CS will typically

determine the 'EPSG Code (Datum)' described above.  For more information on the

Projection  tab, please see the associated section of the help topics.

Vertical Unit - Choose the vertical units to be exported in Meters, US Survey Feet,

or International Feet with this drop-down box.

Height Model - Choose the appropriate height model (e.g., US Geoid of 2018) to be

used as part of the vertical definition when the projection info is written as WKT (Well-

Known Text) for LAS version 1.4 exports.

 

WKT (Horizontal) - This box shows the horizontal projection info as it will be stored

in WKT format when exporting to LAS version 1.4.  Changes made to the 'Horizontal'

section in the top half of the tab will be carried down to the WKT (Horizontal) box.  All

other LAS version exports will disable this box and write a GeoTIFF tag from the
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information provided at the top.

WKT (Vertical) - This box shows the vertical projection info as it will be stored in

WKT format when exporting to LAS version 1.4.  Changes made to the 'Vertical'

section in the top half of the tab will be carried down to the WKT (Vertical) box.  All

other LAS version exports will disable this box and write a GeoTIFF tag from the

information provided at the top.

 Export Area: Exports data within a user-defined area.  After clicking the 'Export Area' button,

drag a box to surround the area to be exported.  Once the area is chosen, the MARS® Export

Type Selection drop-down list will appear.   Select an export type and the interface will open, just

as it does when using the 'Export'  button.  However, with this method the 'Format'

selected on the 'Layout' tab will be 'User-defined Box' by default.  Note that the 'Clipping' option on

the 'Layout Tab' of the export interface will be disabled for all export types when using 'Export

Area.'  For more information on the different types of exports, please review the Data Export

topic and sub-topics.

Extraction Tool Selection List (not available with Evaluation license): This drop-down list contains

the four extraction tools included with MARS® - Area by Slope , Building Polygons , Canopy

Density , and Class Polygons .  Detailed information about using these tools can be found in the

Extraction Tools  topic and its sub-topics.

Extraction Options (not available with Evaluation license): Allows the user to specify the filter

parameters.  A unique filtering options interface will appear for each different filter.  Please click on the
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following link(s) for more information on how to use the 'Extraction Options' dialog for the extraction

tools included with MARS®.

Extraction by Region (not available with Evaluation license): Once the desired extraction tool has

been chosen and the extraction options have been specified, this button initiates the processing for a

selected area of the project.  This tool provides the user with a ‘drag box’ to graphically define a

rectangle for the desired area.  The tool will remain active to allow multiple areas to be processed -

right-click the mouse to dismiss the tool.

The loaded LAS data is immediately modified with this tool if the 'Reclass Interior Points' option

is checked ('Area by Slope' and 'Building Polygons' extraction tools only).

Extraction by Polygon (not available with Evaluation license): Use to run an extraction tool on a

user-created polygon in the LAS Map View window.  Left-click to create the vertices of the polygon, and

right-click to close and start the processing.

The loaded LAS data is immediately modified with this tool if the 'Reclass Interior Points' option

is checked ('Area by Slope' and 'Building Polygons' extraction tools only). 

Extraction from Selected Polygons (not available with Evaluation license): Use to run an

extraction tool based on the area of a pre-existing polygon (or multiple polygons) in the LAS Map View

window.  The polygon shapefile must be loaded as a 'Tile Shapefile' and the desired polygon(s) must

first be chosen using the 'Pick Tiles' tool.  The result will be one shapefile appended together from all the

polygons that were selected. 

The loaded LAS data is immediately modified with this tool if the 'Reclass Interior Points' option

is checked ('Area by Slope' and 'Building Polygons' extraction tools only).

NOTE:  When using this option with the 'Canopy Density' extraction tool, only one polygon can be
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selected before beginning the processing.  The result will be a raster-based *.DAT file that can be used

with ENVI or ArcGIS.

 Batch Process Tiles: This option (commonly known as Auto-Filter) allows the user to run a single

extraction tool by tile and will output the results to feature-bounding shapefiles and (optionally) new LAS

files.  Choose the tile(s) to extract from with the 'Pick Tiles' tool before clicking the 'Batch Process Tiles'

button.  For more information, see the Batch Filter/Extraction Processing  and the Extraction Tools

 topics.

 Advanced Profiler: This tool will create equally-spaced profile lines along a centerline at an

interval specified by the user.  This tool will perform on any polyline shapefile loaded into MARS

®.  There are three ways to use this tool: 1) Using and showing only the centerline with no

profile lines, 2) using and showing both the centerline and profile lines, and 3) using and

showing only the profile lines with no centerline.

Parameters:

Centerline Shapefile: Click 'Browse' to navigate to the centerline file to be used.  This

centerline file may be any polyline shapefile (.shp); for example - a road centerline, a stream

centerline, or a river centerline.

Source Classifications: Choose the 'Select' button to define which classifications will be

used when creating the profile lines.  To create an advanced profile line based on the ground

surface, choose only those classes that represent the ground - typically Class 2 (Ground). 

Keep in mind that ground may exist in other classes, depending on the project data.

Interval along the Centerline: The interval between profile lines (lines perpendicular to the
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original centerline shapefile) can be defined by the user here.  A larger number indicates more

space (horizontal units) between profile lines.

Profile Distance from the Centerline: The user may specify the distance the profile line

(which is perpendicular to the centerline) will extend from the centerline on both the right and

left sides.

Draping Algorithm: The user may choose to show and create the advanced profile by TIN or

Grid.  Using the Grid option allows the user to further define the grid cell size and to apply a

Gaussian smoothing mechanism to the grid if need be.

Save Draped Centerline: Checking this option will save the draped centerline as well as the

perpendicular profiles which lie along that line.  When this option is not checked, MARS®

saves only the profiles perpendicular to the centerline and not the draped centerline itself.

Cut Depth: This is the total width of the buffer (in project units) used to check for LiDAR

points around the profile lines.  Smaller values will speed processing and allow for longer input

centerlines, but accuracy may suffer if there are not enough points in the Source

Classifications in this buffer area.

Output Options: Choose the output type - 'Save As Shapefile' for a 3D shapefile, 'Save As

CSV' for a file of XYZ values that can be opened in Excel, or 'Save As DXF (2D Cross Section

and Centerline)' for engineering use in a CAD program.  Use the 'Browse' button to the right of

the 'Output Shapefile', 'Output CSV file', or 'Output DXF File' text box and navigate to the

output folder the advanced centerline shapefile, CSV file, or DXF file should be saved in. 

Name the new file, and click 'Save'. For the 'DXF' option, make the appropriate entries in the

'Number of Columns', 'X Step', 'Z Step', 'Vertical Exaggeration', and 'Beginning Station Number'

text boxes.  The effect of these five parameters can be seen in the examples at the bottom of

this page.

Using the Advanced Profiler tool:
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1) First use the 'Draw 2D Centerline' tool to create a 2D shapefile centerline line along an area

which is to be profiled.  Do this by selecting the 'Draw 2D Centerline'

 button and then left-clicking along an area.  Right-click to end the

centerline.  In the examples below, the 2D centerline was drawn along a river.

2) To save this 2D centerline for use in the Advanced Profiler tool, click on the 'Save 2D

Shapefile'  button.  At this time, the 2D centerline just created will be unloaded

from MARS®, but will be saved in the output folder which was specified by the user.

3) Click on the 'Advanced Profiler'  button to bring up the 'Advanced Profiler' dialog.  The

parameters inside the interface are described above.  Choose the particular settings which

are needed and click 'OK' when finished.  When an advanced profile is saved, a *.prj

(projection definition file) is created if the projection information is known for the source LAS

data, and if the output type is Shapefile.  Please see the bottom of this section for more

information on the three (3) different uses of this tool. 

4) When the advanced profile has been created, the user will be notified with one of the following

pop-up messages (depending on the output type):

    for shapefile or CSV       -- or --        
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   for DXF

5) The advanced profiler has now created a 3D shapefile, CSV file of XYZ values, or 2D DXF file

and stored it in the folder, and with the name, designated by the user.  To load a newly

created shapefile in MARS®, click the 'Add Reference Shapefiles' button on the Project/

Data Preparation Tab .  The shapefile will appear in the Table of Contents under the

'Vectors' layer, and can be viewed in either 2D or 3D.  To open the CSV file, use Excel or a

text editor.  To view the output of the 2D DXF file option, load the file in any CAD or GIS

program that can read DXF files.

6) To remove a loaded shapefile from MARS®, right-click on the file in the Table of Contents and

choose 'Remove'. 

The three uses of the Advanced Profiler tool:

1) Below is an example of the advanced profiler being used in 3D and showing only the

centerline with no profile lines.  The corresponding settings are also shown in the 'Advanced

Profiler' interface.  The most important settings are to enter a '0' in both the 'Left Side' and 'Right

Side' text boxes.  This tells MARS® to create profile lines with a length of '0' (zero), which would

create no profile lines at all.  Make sure the 'Save Draped Centerline' option is chosen to create

the 3D centerline shapefile.
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2) Below is an example of the advanced profiler being used in 3D and showing both a centerline

and the profile lines associated with it.  The corresponding settings are also shown in the

'Advanced Profiler' interface.  The most important settings in this case are to enter an integer in

both the 'Left Side' and 'Right Side' text boxes and in the 'Interval Along the Centerline' text box.

This will create the profile lines perpendicular to the centerline.  Make sure the 'Save Draped

Centerline' option is chosen to also create the 3D centerline.
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3) Below is an example of the advanced profiler tool being used in 3D and showing only the

profile lines with no centerline.  The corresponding settings are also shown in the 'Advanced

Profiler' interface.  The most important settings in this example are to enter an integer in both

the 'Left Side' and 'Right Side' text boxes and in the 'Interval Along the Centerline' text box.  This

will create profile lines.  Make sure the 'Save Draped Centerline' option is unchecked so a 3D

centerline will not be created.
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CSV Output: 

The table excerpt below shows the formatting of the CSV file output.  The first column is the

feature number, then X, Y, and Z in the last column.  Feature number is based on start to end of

the centerline used to generate the profile info.  For example, if only the centerline is saved

(example 1 of 'The three uses of the Advanced Profiler tool:' topic, above), the feature

number will be the same for all XYZ values of the centerline.  If both the centerline and the

transects (profile lines) are saved (example 2, above), the transects will be numbered from the

beginning of the centerline to its end (as it was compiled) and the final feature number will be

the centerline itself.  If only the transects are saved (example 3, above), they will be numbered

from the beginning of the centerline to its end as mentioned above.
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DXF Output:

Below are examples of the output when the 'Save As DXF' option is chosen.  The first image

shows the complete DXF with the profiles drawn at every 10 feet along the centerline ('Interval

Along the Centerline' setting), starting in the lower left corner and proceeding to the right.  Note

the ten columns of profiles as per the 'Number of Columns' setting in the interface.
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A detail view of one profile from the above DXF is shown below.  As per the parameters in the

interface, the 'X Step' is 10 units (vertical tan-colored lines with blue annotation), the 'Z Step' is 2

units (horizontal tan-colored lines with green annotation), and the 'Vertical Exaggeration' is set

to 1 (one vertical unit per one horizontal unit).  The blue vertical line represents the position of

the centerline, and the 'Left Side' and 'Right Side' values in the interface are set to 75 units.  The

red line shows the actual elevations of the profile line at this particular station (K0+000.00 units

along the centerline - this is the beginning of the centerline where the first profile was created). 

The 'Beginning Station Number' can be set as needed, and the calculated values will be shown

in the lower-right of each profile.
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 Pick Tiles: This tool is used to select a single tile or multiple tiles for export or batch

processing functions.  The button is disabled until a polygonal shapefile is loaded into MARS® as a tile

layout.  See the 'Add Tile Shapefile' section of the Project/Data Preparation Tab  topic for information

on loading a tile layout.  This tool works only in 2D View .  To use, left-click and drag the cursor over

the tiles to be exported - they will be highlighted in a thicker line weight.  Additional tiles can be

selected by holding down the 'Ctrl' key on the keyboard and clicking on a tile(s).  Individual tiles can be

removed from the selected set using the same 'Ctrl' key/mouse combination.  Selected tiles will also be

highlighted in the tile shapefile's attribute table.  To view the attribute table, right-click on the tile

shapefile in the Table of Contents and choose 'Attributes'.  Alternatively, the attribute table can be

used to select tiles - use the 'Shift' and/or 'Ctrl' keys on the keyboard the select the desired tile(s) by

row.  The selected tile(s) will then appear highlighted in the LAS Map View window display.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.13 Analysis Tab

Analysis Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Analysis Tab:
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For any LAS tools that allow files to be pathed out without loading them in the Table of

Contents in MARS® (including 'Volumetrics'), an up-conversion prompt will appear when

executing the tool if the LAS files do not meet the minimum MARS® compliancy requirements.

This prompt is described in the Project/Data Preparation Tab  topic.

Populate Statistics on Tile Scheme: To use this tool, the user must already have lidar data and a

matching tile layout loaded in MARS®.  Another way to populate statistics on a tile layout is to have the

statistics generated at the same time a tile layout is generated.  To populate statistics in this way,

please see the Create Tile Scheme  topic. 

This tool will create a new shapefile in the same folder as the input tile layout, and it will contain newly

calculated attribute fields for statistics including first returns, tile area, average GSD (ground sample

distance), point density (points per square unit), and many more.  An interface will appear where the

classes to be included in the statistics calculations can be selected.  Multi-threading is also available to

shorten the processing time.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.  Clicking 'OK' will start the process, and the status can be

tracked with the progress bar at the left side of the Status Bar .

162
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When the processing is complete, a pop-up window will appear showing the complete path and file name

of the new tile layout (with statistics included).  The new shapefile will have the same name as the

original shapefile, except that appended onto the end of the file name will be  “…_With_LAS_Statistics”.

When the new tile shapefile is generated, a *.prj (projection definition file) will be created if the projection

information is known for the source LAS data.  The original shapefile will not be overwritten.  Once the

user has run the ‘Populate Statistics on Tile Scheme’ tool, the newly created shapefile will need to be

loaded into MARS® - it is not loaded automatically. 

The following statistics will be generated for each tile layout when the 'Populate Statistics on Tile
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Scheme' tool is used, and they may be viewed in the attribute table of the resulting tile shapefile:

ID: A uniquely generated ID number for each tile.

TName: A uniquely created tile name (or number) used for many

program functions.

AREA: The area in square project units of a particular tile.

ALLPCOUNT: A count of the total number of points within a particular

tile.

DENSITY: The point density in points per square unit (using first

returns only).

AVG_GSD: The average GSD (ground sample distance).

X_MIN: The x axis (easting) minimum within a particular tile.

X_MAX: The x axis (easting) maximum within a particular tile.

Y_MIN: The y axis (northing) minimum within a particular tile.

Y_MAX: The y axis (northing) maximum within a particular tile.

Z_MIN: The z axis (elevation) minimum within a particular tile.

Z_MAX: The z axis (elevation) maximum within a particular tile.

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular

tile.

COLL_SCAN: A listing of the different collection scan numbers which

overlay a particular tile.

GPS_MIN: The GPS time (timestamp) minimum found within a

particular tile.

GPS_MAX: The GPS time (timestamp) maximum found within a

particular tile.

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various

intensity value statistics.
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RETURN_0: The number of ‘other’ returns found within a particular tile

(returns that are missing or have incorrect point family info).

RETURN_1 through RETURN_15: The number of first returns through

fifteenth returns (listed in individual attribute fields) found within a

particular tile.

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found

within a particular tile.

MKP: The number of points bit-flagged as ‘Model Key-point’ found

within a particular tile.

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within

a particular tile.

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a

particular tile.

Class0 through Class255: The number of points in each class (listed in

individual attribute fields) is recorded per tile.

ClassWH0 through ClassWH255: The number of Withheld bit-flagged

points in each class (listed in individual attribute fields) is

recorded per tile.

ClassMK0 through ClassMK255: The number of Model Key-Point bit-

flagged points in each class (listed in individual attribute fields) is

recorded per tile.

iShape: A MARS®-specific value that is not relevant for the user.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every tile will be omitted from the final attribute table to simplify

analysis.
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Please see the Populate Statistics on Tile Scheme  topic for additional information.

Statistics by Area: This tool allows the user to drag a box or create a user-drawn polygon over an

area of LAS data to display statistics for that area.  To use 'Normal dragbox' mode, left-click for a

starting location, drag the mouse to define the opposite corner, and release the mouse button to

define the area.  For 'User-drawn polygon' mode, left-click to create the vertices of the polygon, and

right-click to close from the last vertex placed back to the starting vertex.  The results, which include

most of the categories found in a full statistical analysis (see Populate Statistics on Tile Scheme ),

appear in a scrollable pop-up window with an option for saving to a text file.  All results and statistics

compiled are limited to only those classes, returns, collection scans, and bit flag types that are

displayed at the time the area of interest is defined.  To check multiple areas, close the results

window and drag or draw a new area.  To switch between the drag-box and user-drawn polygon

methods, close the results window and click on the tool button to be prompted for the desired method.

 The tool remains active until dismissed by pressing the 'Esc' key on the keyboard, so multiple areas

can easily be checked and the results saved if desired.  

963
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Inspect: Click on this tool, and then click on the displayed LiDAR point that is to be inspected. The

chosen point will flash twice and then remain highlighted in white at a larger symbol size to

identify itself. Any number of displayed points can be inspected, one at a time. If a Cross-Section/

Profile window is open, the point may be chosen in either view, and will be highlighted in both

views. The one exception to this is in the Cross-Section/Profile window, the Inspect tool will

identify the file name and collection scan number rather than a point when the data is viewed in

Profile by Collection Scan mode.
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The tool displays the point's parent file path and point source ID (PSID), X, Y, and Z coordinates,

timestamp (including Seconds of GPS Week, GPS Week Number, and Julian day), intensity

value, classification, bit flag status, return number, user data (often AGC values), scan angle/scan

angle rank, scan direction flag, edge of collection scan flag, scanner channel flag, and RGB(N)

values (see Inspect  for details of these attributes). The tool works in 2D (orthographic) and

Cross-Section/Profile views.  Note that for LiDAR data, some fields are dependent on the data

collected and the post-processing software used, as well as the LAS version and Point Data

Record Format.

To select a displayed check point for inspection, click on the desired check point (the LAS data

943
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may need to be turned off to avoid selecting a LiDAR point instead).  The window that opens will

display the point's ID, XYZ values and (if stored), a description, the point's NVA / VVA type, and

the survey date of the point.

Holding down 'Ctrl' on the keyboard and clicking on a virtual contour line, or displayed reference

or breakline shapefile feature while the 'Inspect' tool is toggled on will allow the user to inspect

that feature rather than the closest LiDAR point.

Windows copy-and-paste controls can be used in the resulting pop-up window.  To unselect the

'Inspect' tool and return the chosen feature to its original symbol and/or color, right-click the

mouse.  See the Inspect  tool topic for more details.

Virtual Contours: Contours can be created 'on the fly' for quick visual analysis, but only when the LAS

Map View window is displaying point density of 100%. To see the current point density, check the left

side of the Status Bar . 100% density can be achieved by either zooming in or by using the 'Lock to

view 100%' tool on the View Tab .

Options: This button allows the user to set the default contour settings. Enter the

desired settings in the 'Contour Options' window. After the desired settings have been entered,

(optionally) select the 'Make Default' button to save the settings as the future default settings.

Please click the following link for a tutorial on contour generation: Viewing and Generating

Contours  

943
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Algorithm: The user has the option to use a virtual, RAM based smooth grid to create

contours, or can create contours that are TIN-based. When using the grid option, the grid cell

size and the number of Gaussian grid smoothing passes can be specified. The option to

create a virtual grid inside this MARS® function allows the user to create a smooth grid file

which, in turn, will create aesthetically pleasing smooth contour lines. The RAM based, virtual

grid also allows for quicker production.

Contour Interval: Choose the unit value of the interval between contour lines. For example, a

value of 2 will place contour lines every 2 units. Units can be measured in meters, feet or be

left unspecified.
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Minimum Contour Length: Set a minimum contour length for contour generation. Longer

contour lengths can minimize noise in the contour data. Shorter contour lengths, while more

accurate, can show contours where there is noise in the LiDAR data. 

Ex: Minimum contour length set to show very short contours. Notice the 'noise' in the contour

data. Here the minimum contour length is set to 1.

Ex: Minimum contour length set to show only longer length contours. Notice the reduction in

noise in the contour data. Here the minimum contour length is set to 200.
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Contour by Collection Scan (not available with Evaluation license): Checking this box

will display each individual contour line color coded by collection scan.

Depression Coder: This box should be checked when the user would like to uniquely

symbolize contours on depressions (areas where water cannot escape) in the data surface.

Color: The user may click on the colored box and a color palate will appear. Choose a color

from the pre-made palate, or design a custom color for display in the 'Define Custom Colors'

area. The color selected here will be the color in which contours will be displayed. The default

setting is white. 

Use Maximum TIN Edge Length: The maximum TIN edge length to be used in creating/

viewing contours may be specified by the user here.

Index Contours: An index contour is marked by the thickness of the contour line. This

makes it easier for the user to see the change in elevation by contour line. With this option,

the user can choose to mark the index contours every 2nd, 5th, or 10th index contour line or

not mark index contours at all.
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Classifications Included: Choose the classifications to be included in the contour generation

by clicking the 'Select' button. Classes whose box is checked will be included in the

generation of contours. Use the 'All Classifications On', 'All Classifications Off', 'Ground (All)',

or 'Ground (Model Key-points Only)' buttons to simplify the selection of the desired classes. 

Make Default: This option will allow the user to save the settings in the 'Contour Options'

window for future use. The settings will be saved as shown to be used as the future default

settings. 

 ‘Area to Display’: Allows the user to draw a box to define the area to be

contoured.

 ‘Clear Display’: Click to remove contour lines from the LAS Map View display.

Another way to toggle contours on/off within the visible extent is to press 'C' on the keyboard.

 ‘Toggle On/Off': This button toggles the contour lines on and off. Another way to

toggle contours on/off within the visible extent is to press 'C' on the keyboard. Contours can only

be viewed when the area for contour generation has been zoomed into at 100% density. Any

area larger than this is too large for 'on the fly' contour generation. To see the density

percentage, see the left side of the Status Bar .

See the Displaying Contours  topic for more information.

Virtual Grids:

 'Options': Allows the user to define the gridding parameters.

158
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Grid Spacing: This will be the cell size for each cell in the gridded area.

Grid Generation: The user can specify here whether the grid should be built from a virtual

TIN, from the minimum Z point of each cell, or from the maximum Z point of each cell.

Classifications Included: Click the 'Select' button to choose which classifications will be

included in the grid generation. Typically, only ground classes are used.

 'Build Elevation': Allows the user to create an elevation grid.

 'Build Intensity': Allows the user to create an intensity grid.

 'Smooth Data': Applies a smoothing algorithm to the gridded surface.

 'Build Normals': Allows the user to generate normal vectors for each cell. Also

known as a surface normal, a normal vector is a three-dimensional vector which is perpendicular

to the surface.

 'Clear Display': Clears any virtual grid from the LAS Map View window.

See the Displaying Grids  topic for more information.

Volumetrics: This tool performs cut-and-fill analysis on a LiDAR dataset using various user-defined

surfaces or values for reference.  It is designed to be used on datasets where ground has been classified

874
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separately from other points.

See the Volumetrics  topic for more information.

Viewshed Grid generation: Viewsheds are available for use with LAS data and MrSID Compressed
LiDAR data while in 2D mode only.

   Define Area: Create a viewshed by clicking on the 'Viewshed - Define Area' button. Left-click

979
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inside the LAS Map View window (2D view only) where the viewshed is to start. While holding

the left button, drag the mouse to the place where the viewshed is to end and release. The

Viewshed options window will appear and give the user the ability to change the properties of the

viewshed and, optionally, to save it. By checking the 'Field of View' box, the user can switch

the field of view from 'Azimuth' (if the box remains unchecked) to 'Degrees' and 'Direction' (if

the box is checked). The user can specify a radius, grid cell size, and can even specify an

invisible or visible output file name to save. The Viewshed tool displays a 2-color grid to indicate

the visibility of the user-defined field of view.  Once generated, the viewshed may be viewed in 2D

or 3D. The red areas of the viewshed represent areas which the 'viewer' would not be able to see

from the starting point that was defined. The green areas represent areas which the 'viewer'

would be able to see from the starting point that was defined. This color-coded display helps the

user to understand where elevation changes, trees, or buildings may be. This tool is commonly

used for security purposes, but can also be applied to land development and urban visualization

activities.  Note that the maximum distance (radius) that can be generated depends on

available RAM, density of LAS data, field of view, and grid cell size.

Parameters

• Field Of View:  When checked, enables manual entry of the 'Degrees' and 'Direction' of the

desired field of view.

• Degrees:  Enabled when 'Field Of View' is checked. This value defines the angular width of

the area to be studied.  Valid values are 1 - 360.

• Direction:  Enabled when 'Field Of View' is checked. This value represents the azimuth of

the viewshed centerline in degrees. The width of the view ('Degrees') will be centered

around this vector.  It is automatically populated in the Viewshed options dialog (but can be

modified) once the user has defined the vector for the viewshed.

• Azimuth Start: Enabled when 'Field Of View' is unchecked.  This is the starting value for the
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horizontal component of the user-defined viewshed direction. Valid values range from 0 –

360, with 0 as the default value.

• Azimuth End: Enabled when 'Field Of View' is unchecked.  This is the ending value for the

horizontal component of the user-defined viewshed direction. Valid values range from 0 –

360, with 360 as the default value.

• Radius: This value represents the radius length of the viewshed. This value is automatically

populated in the Viewshed options dialog (but can be modified) once the user has defined

the vector for the viewshed.

• View Point X & Y: These values represent the XY origin of the defined viewshed. This value is

automatically populated in the Viewshed options dialog (but can be modified) once the user

has defined the vector for the viewshed.

• View Point Height: The height value above the surface for the XY origin.  A higher value will

allow the 'viewer' to see more area within the viewshed.

• Grid Cell Size: This value represents the grid cell size of the displayed viewshed grid and the

saved grids (both visible and invisible).

• Save results into files:  When checked, allows the user to save the results of the viewshed

analysis as LAS grids.

• Output Viewshed Grid File: This parameter allows the user to specify where the output files

will be written.

Viewshed Options Dialog:
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In the Viewshed display below, the data which would be visible to the viewer if standing in the area

defined as the center of the viewshed is colored green. The areas which would be invisible to the

viewer if standing in the center of the viewshed are represented by red. The display shown below is in

3D and is rendered in TIN.



Tab and Ribbon Layout 509

© 2000-2023 Merrick & Company

Display Options: By clicking the 'Viewshed - Display Options' button, the user has the option of

displaying both visible and invisible data, only visible data, only invisible data, and viewing any of

the data choices by TIN rendering. The user can also remove the viewshed grid completely and

release it from memory. In the Viewshed display, the data which would be visible to the viewer if

standing in the area defined as the center of the viewshed is colored green. The areas which would

be invisible to the viewer if standing in the center of the viewshed are represented by red. 
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Flood Fill: This tool creates a virtual flood fill graphic that allows the user to view areas of the loaded

LAS data which would be inundated during a flood.  To use this tool, click on the 'Flood Fill' button and

the 'Flood Fill' dialog box will appear.  The user may specify the water elevation (MSL) to analyze by

entering a value in the 'Elevation' text box or by using the 'Elevation' slider to simulate different flood

levels.  The user may also choose the color and transparency of the flood fill graphic.  When all the

selections have been made or when changing any of the parameters, click 'Display' to see the results.  If

the data is not already being rendered in TIN mode, the tool will change to, and stay in, that mode.  The

density of the LiDAR data currently being displayed, as shown on the left side of the Status Bar

, will affect the accuracy of the TIN and, therefore, the flood fill.  To obtain the most

accurate results, the data should be viewed at 100% density.  In 2D viewing mode, imagery may be

used to aid in the flood analysis, but will be temporarily toggled off when switching to 3D viewing mode.

It is also possible to save the flood fill shoreline to a 3D shapefile. Check this option and choose a

shapefile path and name to create a 3D shapefile, then click 'Save.'  To dismiss the flood fill graphic,

click 'Cancel' in the dialog box.

The examples below show the difference in flooding effects that can be expected at different water

158



Tab and Ribbon Layout 511

© 2000-2023 Merrick & Company

surface elevations. The top example is flooding up to an elevation of 5264 feet. The bottom example

shows flooding up to 5279 feet.
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Another example of the Flood Fill tool in a 3D view:
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Inspect RGB(N): This utility allows the user to select and display the RGB(N) - Red-Green-Blue and, if

present, NIR - values from the loaded imagery data. This tool is normally used to define RGB(N) values

for the RGBNI Value Filter . This tool will only work on RGB or RGB(N) imagery (not ENVI rasters)

and is only available to use when imagery is loaded into MARS®.

To use this tool, click in the desired location on the imagery. Once the user has selected a target, the

‘Inspect RGB(N)' dialog (see below) will be displayed, showing the RGB values from the selected pixel.

Additional locations can be selected without closing the pop-up.  3-band imagery will display 'N/A' for

the 'N' field.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.14 Custom Tab (optional)

Custom Tab (optional)

Merrick Advanced Remote Sensing (MARS
®

) Software

The Custom Tab:
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The Custom Tab is an optional component of the ribbon that can be added if desired.  This tab can

contain almost any tool that is found on any of the standard tabs that are part of the ribbon - the

screen shot above is just one example of a possible Custom Tab.  The collection of tools can be

customized individually for any computer, and the XML file that contains the layout of tools can be

shared with other computers.  The tool buttons can be placed in any order along the tab and can be

added, deleted, or moved at any time.  Unlike the Quick Access Toolbar  (QAT), the buttons placed

on the Custom Tab look identical to their versions on the  standard tabs, with any accompanying text

labels retained.

Initial creation of the tab requires that at least one tool from the pre-existing tabs be added.  Only

those tools that are enabled for the license level being used will be available to be added to the Custom

Tab.

To create or edit the Custom Tab, begin by clicking the 'Customization of Custom Tab' button on the 

Options Tab .  If no 'MARSCustomTab.xml' file exists in the MARS® installation folder (C:\MARS\

by default), the column named 'Tools in Custom Tab' on the interface will initially be empty.
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In the upper-left of the interface, choose the tab (from the 'Ribbon Tabs' drop-down list) that contains a

tool to be added.  Either double-click or select and click the 'Add Tool' button at the upper-right to

place the tool in the 'Tools in Custom Tab' column.  Continue adding tools from the various tabs until

finished.  The order of the tools can be modified by selecting any tool and using the 'Move Up' or 'Move

Down' buttons to the right of the list.  'Move Up' will move a tool to the left on the Custom Tab, and

'Move Down' will move it to the right.  Separators (vertical bars, as seen in the example at the top of

this page) can be added and moved as needed.  There is no limit to the number of Separators that can

be added, but each tool can be placed on the Custom Tab only once.
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When the drop-down list is set to 'Cross-Section/Profile', many of the available tools are listed with an

'(X)' after the tool name.  These are variations of tools with the same name found on other tabs and can

be added even if the identically-named tool from another tab has already been added.  For example,

both the 'Edit Paint Medium (X)' tool from the 'Cross-Section/Profile' tab and the 'Edit Paint Medium'

tool from the 'Edit/Filter' tab can be added to the Custom Tab and exist at the same time.  The '(X)'

version of the tool allows reclassification in the Cross-Section/Profile window only, while the other

version allows reclassification in either the LAS Map View or Cross-Section/Profile window.
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When all tools and separators have been placed, click the 'Save to Default XML' button to create an

XML file in the installation folder that will be read each time MARS® is opened.  After saving, the

Custom Tab will be added between the 'Analysis' and 'Options' tabs, and it will become the active tab. 

The tools on it are duplicates of those same tools on the standard tabs, and will function the same

way.

To make changes to an existing 'Custom Tab' design, click the 'Customization of Custom Tab' button

on the Options Tab  and add or move tools as previously described.  Tools and Separators can be

removed from the 'Custom Tab' by selecting them (one at a time) from the 'Tools in Custom Tab'

column and clicking the 'Remove' button to the right of the list.  Click the 'Save to Default XML' button

to write any changes to the XML file, otherwise those changes will be in effect for the current MARS®

session only.

To hide the 'Custom Tab', uncheck the box labeled 'Show Custom Tab'.  To permanently remove the

518
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tab from the ribbon layout, delete the 'MARSCustomTab.xml' file from the installation folder - it can be

re-created at any time by following the instructions above.

An XML file of 'Custom Tab' settings can be shared with other MARS®-installed computers by copying

and pasting it into the installation folder.  If a computer with a lower license level (e.g., Explorer) uses

an XML file copied from a higher license level computer (e.g., Production), only those tools that are

enabled for the lower license level will be available.  Conversely, if an XML file from a computer running

an Explorer license is copied to a computer running Production (for example), Production-level tools

may then be added to the 'Custom Tab'.

© 2000-2023 Merrick & Company. All Rights Reserved.

3.15 Options Tab

Options Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Options Tab:

Performance: Due to LAS datasets becoming increasingly larger in file size (frequently surpassing

the available RAM in a computer) as well as the possibility of lost work caused by an unexpected

shutdown of MARS prior to a save operation, the ‘Cache points into available RAM’ option has been

disabled.  LAS data will be read from disk and ‘live’ edit changes (such as hand filtering) are
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committed to disk as soon as they occur.  Additionally, with newer, faster hard drives such as SSD,

the performance difference between disk-based and RAM-based operations is constantly shrinking.

Read LAS points from disk: Allows practically unlimited amounts of LAS data (tested beyond 1

Terabyte) to be loaded by reading the points directly from disk - either a local (internal or external)

disk, or a network drive location.  Changes made to the LAS files are automatically saved.

Fast TIN: This option allows the user to improve the display performance of MARS® over small areas

of data when panning and zooming with TIN rendering enabled.  It is intended for use in hand filtering.

 This tool will speed up the display performance of point data only and is intended for hand filtering

purposes.  Break lines will NOT be respected while the 'Fast TIN' option is selected and it should

NOT be used during break line editing.  The shortcut key combination for toggling Fast TIN is 'Ctrl-T.'

Display: The upper portion of the 'Display Options' interface is meant for use with LiDAR data and

the Color by Elevation tool, and allows users to choose custom display options which best fit their

needs. This interface may be used to prevent color skewing, which may occur when a small quantity

of point values do not match values which are popular among the majority of points being displayed.
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The display options allow the user to apply histogram clipping and stretching, as well as standard

deviation stretching so that the resulting display is the most correct. If the user wishes to make any

of the custom settings the new default settings, choose the 'Make Defaults' button and these

custom settings will be saved and available to the user the next time the 'Display Options' window is

opened, even if the MARS® application is closed. There are three methods available to the user:

Minimum/ Maximum: With this option, the user may specify a minimum and maximum color

range stretch for a histogram. 
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Standard Deviation: With this option, the user may specify a number of sigmas to include in the

display for both the left and right hand sides of a standard bell curve for a standard deviation

stretch.
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Histogram: With this option, the user may specify a percentage cut off for both the left and right

hand sides of a histogram clip.
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Additionally, there are options in the lower portion of the interface to change the color and line weight

(or point size) of selected features (e.g., for inspection), the background color of the LAS Map View

and Cross-Section windows, and to force a program window resize to improve the user experience

when drawing cross-sections/profiles across a Remote Desktop Connection (when checked, this will

correct incomplete data displays that may occur with some RDC/hardware configurations).  Also,

entering a new integer value in the 'Line Weight (Size)' box will change the display of selected
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polyline and polygon features, and the 'Point Size' setting will control the size of selected point

features.  Features that will not be affected by the 'Selected Vector Highlighting' settings include

polygon shapefiles loaded as tile layouts, and breaklines selected by the 'Add Vertex', 'Move Vertex',

or 'Delete Vertex' tools on the Breaklines Tab  (color is honored for these tools but not line weight,

so that vertices can be more easily seen).  Click on the symbolized 'Color' or 'Background Color'

buttons to bring up the Windows color palette to make changes.

Any changes can be made 'permanent' by clicking on the 'Make Defaults' button.

295
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Miscellaneous: These settings control display and tool options, including inverting the directional

function of the scroll wheel, LiDAR point size, Cross-Section/Profile window depth and overlap, and

many more.
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Viewing: The 'Invert zoom directional function of scroll wheel' option allows the user to

choose the zoom direction which is associated with the scroll wheel. Default settings (when

this option is unchecked) are to zoom in when the mouse wheel is rolled away from the user

and out when the mouse wheel is rolled toward the user. To invert these settings (zooming in

when the mouse wheel is rolled toward the user, and out when the mouse wheel is rolled

away from the user), please check the 'Invert zoom directional function of scroll wheel' box.

The options to double-click within a tile boundary to zoom in to that tile's extent, and

displaying LiDAR data in the Overview window  are also set here.

Snapping Option: This option (enabled by default) allows the user to snap to the nearest

LiDAR point at both the 'from' and 'to' ends of the Measure  tool vector. The current status

of the function is displayed on the Status Bar .

Drawing: Choose the pixel size that the points will be viewed at in the LAS Map View and in

155
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the Cross-Section/Profile view. The default setting for both windows is 2.

     Ex: In the example below the pixel size has been changed to 10. Ex:

In the example below the pixel size is on the default setting of 2.

The 'Blend Points with imagery' option (on by default) keeps a balanced mix between LiDAR

points and any loaded imagery, especially when zoomed out, so the user can easily see both. If

this option is unchecked, the LiDAR becomes more dominant as the display is zoomed out, and

imagery becomes difficult to see.

     Ex: In the example below the 'Blend Points with imagery' option is checked on.

Ex: In the example below, the 'Blend Points with imagery' option is unchecked.
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Cross-Section/Profile Window: The 'Default cut area depth' (set to 10 ground units by

default) is used with the 'Place Cross-Section Line'  tool. Increasing the cut depth will

increase the number of points the cross-section/profiling tool shows in the cross-section/

profile window and vice versa. To change the current depth of the cross-section/profile window

but not the default value, enter a new value in the 'Current Depth' text box on the Cross-

Section/Profile Tab , or use the shortcut key 'D' on the keyboard to open a cut depth

settings window.

238
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The current cut depth will also be displayed on the Cross-Section/Profile window tab and

the optional Cross-Section/Profile window  Edit Toolbar.

 

Ex. In the screen shot below, the cut depth is set at 10. Notice the density of points in

the cross-section/profile window (right) as well as the size of the cut area box (left).

       

Ex: In the example below the cut depth has been increased to 50. Notice the increase

in visible points in the cross-section/profile window (right).

146
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The 'Forward/back percentage' (set to 75% by default) determines the amount of movement

(and therefore, overlap) of the cut depth box.  When using either of the cross-section/profiling

tools ('Place Cross-Section Line'  or 'Place Adjustable Cross-Section Line'  ) it

is possible to use the arrow keys on the keyboard (  and ) to move the cross-section/profiling

line forward and backward for a slightly different view of the data.

The 'Arrange Cross-Section/Profile Window' option allows the user to arrange the cross-

section/profile window either horizontally or vertically in reference to the LAS Map View window.

Ex. Cross-Section/Profile window arranged vertically.
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Ex. Cross-Section/Profile window arranged horizontally.
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The 'Turn on location cursor X in main view' option displays a white 'X' symbol in the cut

area box in the LAS Map View window.  This can be helpful in relating the cursor location in

the Cross-Section/Profile window to the data in the LAS Map View.  If the cursor is moved out

of the Cross-Section/Profile window the 'X' will stop moving, but will begin again at the correct

location when the cursor re-enters the window.

The 'Show toolbar in cross-section window' checkbox controls a supplemental toolbar of

the most commonly used editing functions while in a Cross-Section/Profile window .

When on, the toolbar is docked at the top edge of the window so it is always convenient

regardless of the arrangement of the Cross-Section/Profile window.

Editing Options: The 'Enable two or three digit class keyboard input' option allows the

user to enter 2- or 3-digit classes when using the keyboard accelerators in editing. If LiDAR

data contains classes with 2 or 3 digits, this option can be useful during editing.  Enter the 2-

or 3-digit class, choose 'Enter' on the keyboard, and the points highlighted will be changed to

the classification entered by the user. It is also possible to enter one digit classes while the

'Enable two or three digit class keyboard input' option is chosen.  Highlight the points to have

their classification changed, press the keyboard number representing the one digit class, and

then choose 'Enter' on the keyboard. The points will then be reclassified. When the 'Enable

two or three digit class keyboard input' option is NOT chosen, points selected cannot be

reclassified to a 2- or 3-digit classes because as soon as one number is entered

(representing a one digit class) the points are automatically reclassified without hitting the

'Enter' key. For example, the user can select certain LiDAR points needing to be reclassified

and choose '15' in interest of reclassifying the points to class 15. Without the 'Enable two or

three digit class keyboard input' option chosen, the points selected will be reclassified to

146
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class 1 because this was the first key chosen to reclassify data. To reclass selected LiDAR

points to a class with 2 or 3 digits using the keyboard accelerators, choose the 'Enable two or

three digit class keyboard input' option, select the points to be reclassified, enter the class

number, and choose 'Enter' on the keyboard.

Check Point Report Options: 

Number of Significant Figures: The user can set the number of significant figures to be

used in the check point report. To learn more about the check point report and its settings,

please visit the Check Point Report  section.  In addition, it controls the number of

significant figures that are used in reporting for the USGS 2.1 QC Module , USGS 1.3

QC Module , USGS 1.2 QC Module , LiDAR Data Checks , and LiDAR Calibration

Checks .  This value also affects the coordinate display shown in the lower-right corner

of the LAS Map View window.

Panning Options: When using the 'Ctrl- ', 'Ctrl- ', 'Ctrl- ', or 'Ctrl- ' shortcut keys ,

the amount of movement is determined by the radio button selected - '50%', '75%',

'85%' (default setting), or '95%'.  For example, when 85% is selected, using the 'Ctrl- '

shortcut key will pan to the left with 85% of the window extent now displaying a new area and

the remaining 15% showing part of the previous extent.

Folder Dialog Option:

Remember last folder location: Allows last folder used to be stored within a MARS®

session when a standard Microsoft Windows 'Open', 'Save', or 'Save As' dialog is not being

used. Examples are: when using the 'Add From Folder' or 'Folder to process' option for

input on many tools and functions, and when pointing to a folder to add LAS files, images,

or an Esri File GDB.
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Temp Folder:

Change Button Ordering in QAT: To re-order the tool buttons in the QAT, click the 'Change Button

Ordering in QAT' button.  The 'Change Ordering in QAT' interface will appear, where tools may be

moved up (to the left on the toolbar) or down (to the right on the toolbar) in the list of existing tools. 

Select the tool(s) to be re-ordered, one at a time, and click either the 'Move Up' or 'Move Down'

button.

When all re-ordering is complete, click the 'OK' button to save the positions and close the interface,
or click 'Cancel' to quit without saving any changes.
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Customization of Custom Tab: An optional Custom Tab can be created and populated with many

of the most commonly used tools and functions.  On the customization interface, the drop-down at

the far left lists all standard tabs on the ribbon, except 'File' and 'Help'.  Choose the tab from which a

tool is to be added, and the list of 'Available Tools' for that tab will appear.  Select a tool from that list

and click the 'Add Tool' button to place it in the 'Tools in Custom Tab' list.  Continue to create the

custom list one-by-one, choosing any available tool from any selected tab in any order.  Separators

may be added to give a 'grouped' appearance to the final tab layout.  Any tool or separator in the

'Tools in Custom Tab' list can be moved up (to the left on the tab) or down (to the right on the tab) to

create the desired layout.  There is no limit to the number of separators that may be added, but each

tool can be placed only once on the Custom Tab.

When all the selections and/or re-ordering are complete, click the 'OK' button to save and close the

interface.  If no Custom Tab has been previously created, it will be generated between the 'Analysis'

tab and the 'Options' tab.  Click 'Cancel' to quit without saving any changes.
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3.16 Help Tab

Help Tab Items

Merrick Advanced Remote Sensing (MARS
®

) Software

The Help Tab:

   

Help Topics: The help file is a hyper-linked document of how-to guides, reference material, and
tutorials. To see the help topics, use the 'Help Topics' button on the Help tab, or use the hot-key
'F1'.

Release Notes: Opens the Release Notes PDF, which details changes and fixes since the previous

version was released. This document is also available from the MARS program group in Windows.

System Information: Displays a pop-up with various details about the user's computer environment.

The information can be saved to a text file, and may be requested by MARS® Tech Support.  Note

that even if the 'OS Name' value is listed as 'unknown', the OS Version Number will still report

correctly.
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About MARS: Displays information concerning the Version number, platform (64-bit), Build Number,

and License Type. See the screen shot below as an example (MARS Version and Build Number may

vary):
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4 Tools and Functions

Tools and Functions

Merrick Advanced Remote Sensing (MARS
®

) Software

Note:  Please see individual Tools Tab  help topics for details on which tools are only available

with a Production license.

390
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For any LAS tools that allow files to be pathed out without loading them in the Table of Contents

in MARS®, an up-conversion prompt will appear when executing the tool if the LAS files do not

meet the minimum MARS® compliancy requirements.  This prompt is described in the Project/

Data Preparation Tab  topic.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.1 Vector Tools

Vector Tools

Merrick Advanced Remote Sensing (MARS
®

) Software

Merge Shapefiles (available with Production license only): This tool, found on the

Tools Tab , creates a new merged shapefile from two or more input shapefiles.  All input

files must be of the same geometry type (i.e., point, polyline, or polygon), and must reside in

the same folder.  After clicking on the tool, the 'Open' dialog box appears.  Navigate to the

folder where the shapefiles to be merged are located, then choose two or more shapefiles by

using the left mouse button with 'Ctrl' or 'Shift' (standard Windows selection methods).  Now

click 'Open' and the dialog box will change to a 'Save As' box.  Enter an output folder and file

name for the new merged shapefile and click 'Save.'  A pop-up message will indicate when the

tool has completed processing.  If the input data has defined projection, then a PRJ file with

that projection information will be created for the merged shapefile.  The newly created

shapefile can now be loaded into MARS® as a Reference Shapefile (or Tile Shapefile, as

appropriate).

162
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Edge Match for Shapefiles (available with Production license only): This tool, found

on the Tools Tab , allows the user to match the endpoints of shapefile contour lines in two

(2) separate folders. Because the tool will only match contours with the exact same elevation,

it is important that both shapefiles contain an elevation attribute field labeled 'ELV'. This

attribute field must contain the elevations of each contour line.

Folder of Shapefiles to Move: Navigate to the folder which contains the shapefiles

of contour lines which are to be moved in the edge match process. The contour lines

in these shapefiles will be moved to match the endpoints of the contour lines in the

Reference Shapefiles folder. The contour lines will only be moved horizontally

according to the tolerance the user defines. The elevation of the contour lines will not

be changed in the edge match process. For this reason, the shapefiles must have an

attribute field labeled 'ELV' which contains the elevations of every contour line in each

390
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shapefile. Only contour lines which are within the tolerance defined and which match

the exact elevation of the reference shapefiles' contour lines will be moved.

Folder of Reference Shapefiles (Hold): Navigate to the folder which contains the

shapefiles of reference contour lines to be used. The reference shapefile contour lines

 will not be moved during the edge match process. The reference shapefile contour

lines will be used to measure the tolerance as defined below, and contour lines in the

'Shapefiles to Move' set will be moved to match these contour lines. The reference

shapefiles must have an attribute field labeled 'ELV' which contains the elevations of

every contour line in each shapefile.

Tolerance: Enter a number (in project units) here to set a maximum search radius

for finding matching-elevation contour lines in the 'Move' and 'Hold' folders. In the

example below, the tolerance is set at 2.0 units. If a contour line endpoint with a

matching elevation is found within 2.0 horizontal units of the contour line endpoint in a

reference shapefile, the endpoint will be snapped to the endpoint of the reference

shapefile contour.
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Contour Join: This tool, found on the Tools Tab , allows the user to join several

different contour features into one continuous contour.

For example, the screen shots below show a single contour line which was broken apart into

several different features (or separate contour lines) by tile. This line, which represents only

one contour, is now several contour lines. The contour line breaks into separate contour lines

at every tile boundary.

390
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In the example below, the 'Contour Join' tool has been run on the same contours as shown

above. The contour which was cut at the edges of each tile now runs unobstructed for its

entire length until the project boundary.
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Depression Coder (available with Production license only): The 'Depression Coder'

tool, found on the Tools Tab , allows the user to find depression contours and label them as

such in a newly-generated contour shapefile's attribute table.  This tool is meant for use over

an entire project-wide area, preferably using a single, merged shapefile of contours.  This

makes the processing more accurate by allowing the tool to locate large depressions spread

over several tiles which would have otherwise been missed if processing was done over a

smaller area or run by tile.  The tool searches through the data looking for closed contours

390
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which form 'polygons', indicating a depression or rise in the earth's surface.

To use, navigate to the folder containing the contour shapefiles for the entire project in the 

'Folder of Contour Shapefiles' text box.  Navigate to the folder containing the

accompanying LAS data for the entire project in the 'Folder of LAS Files' text box.  Ideally,

use the same LAS data that the contours were generated from.  The 'Depression Coder' tool

will not make any changes to the LAS data.  The LAS information is only used as a reference

to help find depression contours and ignore rising contours.  For example, contours generated

over a dry lake bed (depression contours) are very similar in appearance to contours created

over a large hill (rising contours) when viewing only the linework and not the elevation values. 

Since the LAS data contains elevation information (Z-values) for each point, it will help in

assessing whether the closed contours are depression or rising contours.  This is done by

specifying the class (or classes) that contain ground points and setting a 'Search Radius'

value that is equal to (or slightly larger than) the cell size used in making the original contours

or the gridded surface they were generated from.  This radius is the distance inside each

closed contour that the tool will search for ground points.  If points are found with lower

elevation values, the contour will be labeled a depression.  When all the necessary entries to

the 'Depression Coder' interface have been made, click the 'Run' button.  The progress of the

tool may be monitored via the status bar.  A new shapefile containing the depression-coded

contours will be created in the 'Folder of Contour Shapefiles', with '_Processed' appended

to the input shapefile's name.

Please see the Contours Tab  for information on expected level attribute values for

proper operation of this tool.  Depressions will be given a value one number higher than non-

depression contours.  For example, if Index contours are level 50 and Intermediate contours

are level 51, then their depression equivalents will be assigned levels 52 and 53, respectively.

806
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When the 'Depression Coder' tool has completed its task, the user will receive a prompt
reporting the total original polygons, nodes, and newly formed polygons. 

Complex Polys to Simple (available with Production license only): This tool, found

on the Tools Tab , allows the user to create separate files (simple polygons) from a multiple

file (complex polygon) shapefile.  This tool may be useful when the user wishes to export data

390
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by tile clipped to a boundary.  If this boundary separates a particular tile into multiple parts,

the user may end up with duplicate tile numbers.  Duplicate tile numbers often may cause

overwriting of needed data.  The example below shows a boundary (in white) which cuts the

two (2) indicated tiles in the tile shapefile (in blue) into multiple parts.

If the user loads a tile shapefile (similar to the one above in blue) that contains complex

polygons, MARS® will notify the user. This prompt will ONLY appear when the user is loading

the complex shapefile AS A TILE SHAPEFILE. If the shapefile is loaded as a reference

shapefile, the user will not receive a prompt. This window appears only for the user's

knowledge and as a suggestion to apply the 'Polygons from Complex to Simple' tool to avoid

lost or overwritten data.  If a complex shapefile (a shapefile containing multi-part polygons) has

been loaded as a tile shapefile the following prompt will appear:
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The file loaded must be a complex shapefile for this tool to work. If the user loads a tile

shapefile which has been 'exploded' (separating multi-part features into single part features)

then MARS® will not be able to recognize a single tile in multi-parts but only recognize two (2)

individual tiles. For this reason, any tile shapefile containing complex polygons must not be

exploded for the 'Polygons From Complex to Simple' tool to work. If the file is 'exploded', a

warning message will show upon export, but this file will no longer be functional in the

'Polygons From Complex to Simple' tool.

In the example below, MARS® is recognizing a tile shapefile which is complex. Tiles 151 and

152 have been cut into multiple parts by a boundary. A prompt was received when this

shapefile was loaded. If the user were to export the data by tile at this point in time MARS®

would export the data in one part of tile 151 then overwrite that data with the data in the other

part of tile 151. The same would happen with tile 152. Thus, the user would lose some data in

each tile causing gaps. To avoid this situation, use the 'Polygons From Complex to Simple'

tool. 
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The Input Shapefile should be the complex shapefile which contains multi-part tiles. The user

may choose the Attribute Field to Modify from the drop-down box. This list is created based

on the attributes which are currently found in the attribute table for that particular shapefile. In

most cases the user will be choosing 'TName' or the tile name of the attribute. The output

shapefile will be the simple polygon shapefile created.  Navigate to a location for the new file

and name the new file. Choose 'Run' to start processing. When processing is complete a

prompt will notify the user. The Status box will give the user a short summary on the number

of polygons found in the shapefile and how many new tiles it created. In the example below,

the tool found four (4) polygons or tiles of which two (2) were complex. Thus, the final output

shapefile contains six (6) polygons or six (6) separate tiles. 
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The new, simple polygon shapefile has distinguished between the multiple parts of a single

tile. In order to avoid any overwritten data, the tiles have been named using an a, b, c...

sequence. This way, each multiple part of a tile is perceived as a unique set of data and will

not be overwritten or replaced. The tiles previously named 151 and 152 are now named 151a,

151b, 152a, and 152 b. An example may be viewed below:
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Assign Highest Z to Poly: This tool, found on the Tools Tab , assigns X, Y, and Z

values to all polygons in a polygon shapefile based on the values of the underlying LiDAR

point within each polygon that has the highest Z-value (elevation).  The shapefile must already

have three fields defined as follows: Field Names - MAX_X, MAX_Y, and MAX_Z, all with the

parameters Data Type - Double, Precision - 18, and Scale - 8.  When the completed

shapefile is loaded into MARS® , the new fields will be populated as shown in the example

table (below). 

390
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Z Fix Using Stream Rule (available with Production license only): This tool, found

on the Tools Tab , will test and fix (if necessary) a 3D breakline shapefile to maintain

monotonicity.  In a hydrography context, monotonicity is the principle that elevations (Z-

values) must decrease, or at least stay flat, as a breakline goes from uphill to downhill.

No data needs to be loaded to use the tool.  Path out the 3D breakline shapefile to be tested

in the ‘Input’ section and the new (corrected) output shapefile in the ‘Output’ section.  Then

choose either the ‘Run’ button (Z-values rounded to three decimal places) or the ‘Run (EDH

Drape)’ button (no rounding done) to start the tool.  If a Z-value is detected that is higher than

the previous uphill value, that previous value is copied to the 'bad' vertex.  When the input
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shapefile has polyline geometry but contains both unclosed and closed features, two output

files will be generated -- <name>.shp and <name>_Polygon.shp.  The original input

shapefile is never altered with this tool.

Convert to Modified EO Files: This tool, found on the Coordinate Conversion Tab ,

allows a 'Combined Factor' or its reciprocal to be applied to one or more EO (exterior

orientation) files.  The EO files must be in a text (*.txt) format.  To use the tool, navigate to a

file or folder with the 'Add' or 'Add From Folder' buttons, then enter the 'Combined Factor' value

in the text box found in the middle section of the interface.  Choose the desired calculation

method - either 'Combined Factor' or 'Reciprocal of Combined Factor' - and click the 'Run'

button.  A new file or files will be created with '_mod' appended to the original name(s), along

with a log file storing the value used.  These will be located in the same folder as the original

file(s).

252
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Convert Check Points CSV to 3D Shapefile: This tool, found on the Vector

Creation Tab , allows a CSV file of check points to be converted to a 3D point shapefile.

The shapefile format provides for easier and more complete analysis of the check points in

GIS software.  The source CSV must be in the following format before the conversion tool can

be run:

362
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The first row of the CSV file must contain column headers and not actual check point values. 

The headers do not have to be named as shown in the example above, but the information

must be in that order.  The fifth and sixth columns are required if the file is to be converted, but

values for those columns are optional.  The fifth column is for a description (such as park ing

lot, intersection, etc.) and the sixth column is for the NVA (Non-Vegetated Vertical Accuracy)

and/or VVA (Vegetated Vertical Accuracy) status of the points.  For the sixth column (NVA /

VVA status), any value that is not stored exactly as VVA or vva (not case specific) or is left

empty will be interpreted as NVA.

To convert, browse to and select the CSV file, then browse to the desired path and enter a file

name (without the .shp extension).  Next, browse to and select the horizontal projection

system - this will allow the proper PRJ file to be written when the shapefile is generated.  The

same interface that is used for other coordinate reference system tools will appear (below,

right).  See the GeoCalc  and GeoEdit  help topics for more information on selecting a

system.

    

1585 1591
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Only one CSV file can be converted at a time.  When the settings are complete, click the

'Convert' button.

If an incomplete input CSV file is pathed out (i.e., one or more required columns is missing), a

warning prompt appears:

               

No output will be produced until corrections are made and the tool is re-run.

 

The completion message will appear when processing is finished.
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After loading the resulting shapefile in the Check Points  layer of the Table of Contents, the

attribute table can be viewed and edited by right-clicking the entry and selecting 'Attributes'.

 

128
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The Check Points shapefile can now be used in running a Check Point Report , or as input

to the USGS QC Module  beginning with version 2.1.

Collection Scan Polygon Generator: This tool, found on the Vector Creation Tab

, creates a polygonal shapefile based on LAS collection scan (swath) extents.  Each

collection scan file will result in one polygon feature in the final, merged shapefile.

Input and Running Options:

Navigate to a folder containing the LAS files to be used in generating swath

footprint polygons by clicking the browse button to the right of the 'Folder to process' entry

box.

'Perform full statistics': When this box is checked (default), full statistics per

collection scan will be calculated on the classes which are specified in the 

'Class Statistics' section.  Choose classes by clicking on the 'Select' button.

Attribute fields will be added to each swath record to hold these values.  By

default, all classes are used.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every swath record will be omitted from the final attribute table to

simplify analysis.

 When using the 'Perform full statistics' option, either the 'TIN' or 'Grid' algorithm

can be used for edge detection:

'TIN': With this option, the edges of the polygonal shapefile(s) will be

created based on the edge of the virtual TIN which is created.  MARS®

1221
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will use 3 points to create a TIN and the edges of the TIN will determine

the extents of the polygonal shapefile.

'Grid': With this option, the edges of the polygonal shapefile(s) will be

created based on the edges of a virtual grid (created in RAM) to cover

the input data.  A cell size is entered - the default is 3 (3 ground units by

3 ground units).  The cell size should be greater than or equal to the

ground sample distance (GSD) of the input data.  MARS® looks for

points within the virtual grid cells and establishes the edges of the

collection scan data by determining whether or not points exist in a cell.

When points are no longer located, the edge of the collection scan is

confirmed.

This tool can be multi-threaded ('Number of threads to use ') for faster

processing.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.

For the 'Output Shapefile', navigate to the folder in which the newly generated shapefile

should be stored and give it a name.  When all settings have been made, click the 'Generate'

button and the progress bar will display the processing status.  A completion message will

appear when the process has finished.

The newly created shapefile may then be brought back into MARS® as a reference Shapefile.

Right-click on the shapefile in the Table of Contents and choose 'Attributes' to view a table

specific to that shapefile.  At a minimum, the attribute table will have a 'FILENAME' field with

the name of the LAS file(s) processed, and a 'COLL_SCAN' field with the Point Source ID

listed that created each attribute table record.  If the 'Perform full statistics' option was
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checked on for processing, the fields stored in the resulting shapefile will be similar to those

listed in the Create Tile Scheme topic at the top of this help section (when the 'Calculate

LAS Statistics' option is checked), except that ‘TName’ is replaced by ‘FILENAME’ to

indicate the collection scans processed.

Below is an example result loaded as a Reference Shapefile into MARS®.  The shapefile

outlines each of the collection scans contained in the LAS files chosen.  This can be a useful

tool in checking the overlap between collection scans and making sure there are no gaps in

the data. 
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Convert SBET to Shapefile: This tool, found on the Vector Creation Tab , is used

to convert a raw SBET, or Smoothed Best Estimate of Trajectory file, into a point shapefile.

This is often the final step in a typical workflow - computing the tightly integrated position and

orientation solution using the correction observations, the raw GPS, and inertial data

extracted from the project.  The data is processed in both the forward and backward

directions in order to produce the optimal solution, smoothing the effect of GPS outages and

other aberrations in the data.  This results in the best possible position and orientation

solution for a given data set, usually maintaining centimetric accuracy for significantly more

362



Tools and Functions 565

© 2000-2023 Merrick & Company

time and at longer distances than would be possible with traditional GPS processing.  The

output from this process is referred to as an SBET.  The 'Convert SBET to Shapefile' tool will

create a 3D shapefile (including a *.prj - projection definition file) from an SBET file, giving the

user the ability to visualize the SBET overlaid on top of LiDAR data.  This tool requires some

previous knowledge of geodesy.  Among many purposes, the 'Convert SBET to Shapefile' tool

can be used to see how centered in the scan the SBET is, and the resultant shapefile can be

used in the Scan Angle Filter .

'Translate Files' section: The user will load the SBET (*.out) file into this text box by

choosing the 'Add' button and navigating to the location of the SBET file to be

converted.  To remove an SBET file in this section, highlight it by clicking at the far

left of the row and press 'Delete' on the keyboard. 

Subsample Rate (Hz) (1-200): The Subsample Rate allows the user to choose how

much data from the SBET will be converted and displayed in MARS®.  The user may

choose any subsample rate from 1 to 200 and enter the chosen rate into the text box

provided.  For example, if the user chooses a subsample rate of 1, MARS® will use 1

sample of the total samples taken in one second to create the 3D shapefile.  If a flight

was 3 hours long, then 10,800 samples (1 per second) will be used to create the 3D

shapefile of the SBET. The higher the subsample rate the more accurate the 3D

shapefile representing the SBET will be, but the longer it will take to convert the file. 

Higher rates may also cause "Out of Memory" errors depending on the computer.  A

subsample rate of 1 (the default value) is detailed enough for most purposes. 

'Input Coordinate System' section: The Input Coordinate System is the horizontal

reference that the SBET was created in.  The user will need to enter the proper

Geodetic system, with Lat/Long in degrees, which was used to create the SBET in

this section.  Examples include NAD83(NSRS2007) and NAD83(2011).

'Input Vertical Reference' section: The user will need to enter the vertical references

1116
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used to create the SBET in this section of the interface.  This includes the vertical

reference name, the height model, and the units in which the SBET was processed. 

Typical *.out SBET files are in Ellipsoidal Height meters.

'Output Coordinate System' section: The Output Coordinate System, in most

cases, will be the horizontal reference that the corresponding LiDAR data is in.  In

most cases the user will want to view the 3D shapefile created from the SBET over

the matching LiDAR data.  In order to do this the shapefile will need to be created

with the same vertical and horizontal coordinate systems as the LiDAR data.  The

user will need to enter the coordinate system, datum, units, and epoch date of the

related LiDAR data.

'Output Vertical Reference' section: The user will need to enter the vertical

references that the corresponding LiDAR data is in.  In most cases the user will want

to view the 3D shapefile created from the SBET over the matching LiDAR data.  In

order to do this the shapefile will need to be created with the same vertical and

horizontal coordinate systems as the LiDAR data.  The user will need to enter the

vertical reference name, the height model, and the units of the related LiDAR data.

Link to Atmospheric Data Set: When checked, allows the user to set the path to

related meteorological data by clicking the ellipse  button to the right of the 'Path

to Atmospheric Data Set' text box and navigating to the desired folder.

Output File Folder: Navigate or key in the path to the folder which is to be the

destination of the newly created 3D shapefile.  The output file (or 3D shapefile created

from the SBET) will be given same name as the SBET file loaded into the 'Translate

Files' section, but will have the file extension *.shp.
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Once all the data has been entered into the 'Convert SBET File to 3D Shapefile' interface, the

user may click on the 'Convert' button.  There can be a substantial amount of wait time while

MARS® reads the file and begins converting it.  Once conversion has started, the user may

watch the progress of the current file as well as the overall (total number of files to be converted)

progress on the progress bars at the bottom of the interface.  When the process is complete a

prompt window, as seen below, will appear.

At this time, the user may now add the newly converted 3D shapefile to MARS®.  Do this by

going to the Project/Data Preparation Tab  and clicking the 'Add Reference Shapefiles'162
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button.  Navigate to the output folder which was specified in the 'Convert SBET to 3D Shapefile'

interface and select the *.shp file which matches the name of the SBET used to create it. Open

this file. 

In this example, an SBET has been used to create a shapefile and has been loaded into MARS

®.  The SBET shapefile represents the path of the plane in space and time as it flew a

particular project.  The shapefile is being viewed in 2D.

In this example, the corresponding LiDAR data has also been loaded into MARS® and is colored

by collection scan.  The SBET shapefile can be viewed layered over the LiDAR data.
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In the example below, the 3D shapefile representing the SBET file is shown in white.  It may be

difficult to select the white shapefile points for inspection among the LiDAR data.  To select the

3D shapefile (SBET) or any other reference file among LiDAR data with the Inspect  tool, hold

the 'Ctrl' key on the keyboard while using the 'Inspect' tool.  This instructs MARS® to select

any nearby feature, other than a LiDAR point, for inspection.  It is possible to copy from the

properties window resulting from use of the 'Inspect' tool.

943
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Right-click on the shapefile entry in the Table of Contents and choose 'Attributes" to see the

entire table of values.
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Convert Video XML file to 3D Shapefile (not available with Academic or

Evaluation license): This tool, found on the Vector Creation Tab , will convert any XML

coordinates video file to a 3D shapefile.  A projection definition (*.prj) will be created if the

projection system is known for the video data.

1. To use this tool, add *.xml files by choosing the 'Add' button.  The specified files will

appear in the 'Translate Files' area and may be removed by highlighting and clicking on

the 'Remove' button. 

2. Define the desired output video file type by choosing *.mts, *.wmv, *.avi, or *.mpg

from the drop-down under 'Video File Extension'.

3. Specify the input coordinate systems including both horizontal and vertical

references.

4. Define the output coordinate systems including both horizontal and vertical

references.

5. Enter a 'Combined Factor' or 'Reciprocal of Combined Factor' if required for the

particular coordinate conversion. 

6. Choose the output folder where the new shapefile will be created.

7. Click the 'Convert' button to start the process.

362
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© 2000-2023 Merrick & Company. All Rights Reserved.

4.2 LAS Tools

LAS Tools

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The majority of standalone tools in MARS®  (i.e., those tools that can be

run without loading the LAS files in MARS®) will check the files that are pathed

out in the tool's interface to ensure they are in a compatible version/format (see
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the 'Add LAS Files' sub-topic in the Project/Data Preparation Tab  help topic).

If they are not, the user will be prompted to up-convert the files before the tool

can continue.

Class to Bit Flag: This tool, found on the Tools Tab  under the 'Bit Flag Settings' drop-down,

sets the bit flag for Withheld points or Key-points (a.k.a. Model Key-points) that are in unique classes,

in compliance with LAS version 1.4 specifications.  For example, if a dataset has withheld points in

Class 0 (Created, Never Classified), those points must have the withheld bit flag set to 'True'.  In this

case, navigate to the file or folder to be processed, set the 'Input Class(es)' to Class 0, and click the

'Set Withheld Bit Flag' button.  For key-points, the process is very similar except that a final

'Ground Class' must also be set.  For this case, set the 'Input Class(es)' to Class 8 (or other legacy

class holding only key-points) and choose the desired 'Ground Class' that the key-points will be re-

classed to after they have their key-point bit flag set to 'True'.  Since ground is typically Class 2, that

is the default, although another class can be selected.  Withheld points and key-points should be in

separate classes, so it will be necessary to run the tool once for each bit flag setting.  The tool can be

run on a single file or an entire folder of files.

162
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Set Overlap Bit Flag: This tool, found on the Tools Tab  under the 'Bit Flag Settings' drop-

down, analyzes the overlapping (overage) areas of a folder of swath (collection scan) or tiled files and

sets the Overlap bit flag to 'True' for those points that fall within the overage area for each file.  Only

those points in a collection scan that are farthest from the single-coverage part of the scan and within

the overlapping area (between collection scans) will be flagged.  Points flagged as ‘Overlap’ in one

collection scan will never share space with points flagged in any other collection scan.  Even though a

bit flag status of ‘True’ signifies these points as ‘Overlap’ per the ASPRS specification, note that the

USGS refers to them as ‘Overage’ points in its NGP Lidar Base Specification 2.1 published in October

2019.

390
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Navigate to the folder containing the files to be processed by using the browse button ( ) in the

'Input Option | Folder' section.  Choose the appropriate data type - 'Swath' (the default) or 'Tiled'. 

'Swath Data' assumes only one collection scan per file (or per set of multi-channel files), and 'Tiled

Data' assumes the files contain data from one or more collection scans (swaths) per tiled file.

Individual multi-channel swath files must be merged into a single swath containing all points from all

channels before processing (see the 'LAS Merging' tool, below).  When the settings have been made,

click the 'Detect Overage Points' button to start the processing.  This tool overwrites the original

files.

The following screen shots show examples of the 'Set Overlap Bit Flag' results on Swath Data:

                             All points displayed                                                              Overlap flagged
points (only) displayed                                               Overlap flagged points turned off
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Clear Bit Flags: This tool, found on the Tools Tab  under the 'Bit Flag Settings' drop-down,

allows any of the bit flags that are not set by the LiDAR sensor to be cleared (set to 'False').  The tool

can be run on a single file or an entire folder of files.  Navigate to the file or folder by choosing the

appropriate radio button and using the browse button to the right of the entry box that is enabled. 

Check the boxes for the flag(s) to be cleared and click the 'Clear Bit Flags' button.  Optionally, the

cleared points can be reassigned to a new Target Class to keep them separate from previously non-

flagged points in the same original class.  Note that if more than one category of bit flag is checked

and the reassign option is used, all the cleared points from any classes will be assigned to the Target

Class.  To avoid this, run the tool separately for each category of bit flag and select a unique target

Class each time.  The 'Status' area will display the files that have been processed.  This tool

overwrites the original files.

390
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Change Bit Flags: This tool, found on the Tools Tab  under the 'Bit Flag Settings' drop-down,

modifies the status (set/on or clear/off) of several of the bit flags that are used with LAS data: 

Synthetic, Model Key-point, Withheld, and Overlap.  It can optionally reclass those points whose bit

flag values have been modified, and can be (optionally) limited to a single specified collection scan. 

The tool can be multi-threaded ('Number of threads to use ') for faster processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.  Navigate to the files to be modified using either the 'Add' or 'Add From Folder' button. 

Individual files can be cleared from the input list by highlighting the appropriate file and clicking the

'Remove Selected' button, or the entire list can be cleared by clicking the 'Remove All' button.  In the

'Input Shapefile' section, browse to a pre-existing polygon shapefile containing one or more polygons -

these polygons will be used to define the area to be processed.  The 'Set Change Bit Flags Filter'

button will open the options interface where the specific parameters of the tool can be set - see the 

Change Bit Flags Filter  help topic for details on these settings.  Choose an 'Output Folder' where

the modified files will be stored, and then click the 'Run' button.

390
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Withheld Point Removal: This tool, found on the Tools Tab  under the 'Bit Flag Settings'

drop-down, permanently removes specific points flagged as Withheld in the input LAS files and

renumbers the remaining point family returns accordingly.  The workflow is: input tiles  -->  export to

swaths  -->  Withheld point deletion  -->  export to final tiled files.  The tool uses two rules for

determining candidate points to be deleted:  1) Withheld-flagged points in any class that are either a

single return or the first return of many in a point family and; 2) Withheld points that are in Class 7 Low

Point (Noise) and are the second of two returns in a point family.  When Withheld-flagged points are

deleted, any remaining points in the same point family will have their return numbers modified so as

not to break the return numbering protocol.  For the first case above, if a first of three returns point (1

of 3) is selected for deletion, the second return in that point family is renumbered as '1 of 2' and the

third return is renumbered as '2 of 2'.  In the second case above, when a Class 7 second of two returns

point (2 of 2) is selected for deletion, the remaining first return in that point family is renumbered as '1

390



MARS® v2023.1           User Manual582

© 2000-2023 Merrick & Company

of 1' (single return).  Note that if the input data is not classified, only the first rule will be applicable.

To use the tool, navigate to a folder containing tiled, classified LAS files using the browse control to the

right of the 'Input LAS Files (Tiles) Folder' box.  Navigate to the corresponding tile layout shapefile using

the 'Tile Scheme' control and select a unique-value attribute (e.g., 'Tilename') to be used for naming the

finished output tiles.  Choose a 'Swath Output Folder' that will hold the exported swaths produced from

the input tile files - during processing, these swaths will be overwritten by the completed swaths after the

Withheld points are removed.  Finally, an optional 'Finished Tiles Output Folder' can be selected to hold

the final tiled files made from the processed swaths.  If no entry is made here, the input tiled files ('Input

LAS Files (Tiles) Folder') will be overwritten with the final results.

Click the 'Run' button at the bottom of the interface to begin the processing.  The results will be
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displayed in the 'Result - Withheld Point Removal per Swath' window followed by a completion message.

Reference Reclass (available with Production license only): This tool, found on the Tools Tab

 under the 'Reclass' drop-down, allows the user to reclassify one set of LAS files (the 'Unclassified'

input files) based on the classes found in another set of LAS files (the 'Classified' input files), by using

a series of user-defined parameters found in the LAS files. In addition to reclassification, any existing

bit flags (Synthetic, Model Key-point, Withheld, and/or Overlap) will be carried over to the output as

well.  The tool determines possible candidate points to be reclassed based on the LAS points'

recorded time and other optional attributes. Because this tool finds possible matches based on their

recorded time, the two folders of input files ('Classified' and 'Unclassified) must contain files in the

same time format (e.g., GPS Week Time or Adjusted GPS Time).  See the 'GPS Time Conversion'

topic in this section for a description of the tool that can convert between the two time storage

methods.

Classified:  Browse to a folder containing LAS files that have one or more

classifications in each file. Like features must have like classes in all files - i.e.,

buildings must be classed the same in all files if the building class will be used

as a Reference Class.  Only those classes listed as Reference Classes will be

used to identify possible candidate points in the Unclassified files for

reclassification in the final Output.  In the example below, classes 20 and 15

are being used from the Classified files.  The Classified files are usually in a tile

layout form, but other files can be used.

Unclassified:  Browse to a folder containing one or more LAS files that will be used as

a source of points for the final Output file.  The points in the Source Classes

entered in the interface - 5 and 6 in the example below - will be matched to

points of the Reference Classes entered from the Classified files to create the

candidate points.  Those that match the values for the boxes checked at the

390
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bottom of the interface will be copied to the Output file and assigned the Target

Class (12 and 10 in the example below).  These files are usually in collection

scan form, but other files can be used.

Output:  Browse to an output folder or key in the desired path to store the results of

this LAS classification reassignment. This selection choice is optional - if the

user does not choose an Output folder, the Unclassified input data is

overwritten with the newly reclassified data based on this reference reclass

function.

Tile Option:  Optionally, the Output data can be tiled upon completion based on a

user-selected polygon shapefile tile layout.  The 'DB Field' chosen will be used

to name the Output LAS files.

Class Requirement:  In this section, the user specifies a Source Class, Reference

Class, and Target Class for the specific classification sets to be used in the

reclassification.  Click on the appropriate box, and enter the class to be used.

Source Fields That Must Match Reference:  This area of the interface allows the user

to force a match of the values present in the Classified files to those in the

Unclassified files in determining candidate points to be reclassed during

processing.

Speed Up Option:  When checked with a value entered in project units, this setting

improves performance by limiting the pool of possible candidate points to be

matched.
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Click the 'Reclassify' button to begin the processing.

Reference Reclass - Closest Distance (available with Production license only): This

tool, found on the Tools Tab  under the 'Reclass' drop-down, is similar to the Reference Reclass390
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tool (see above). It allows the user to reclassify one set of LAS files (the 'Unclassified' input files)

based on the classes found in another set of LAS files (the 'Classified' input files), by using a series of

user-defined parameters found in the LAS files. In addition to reclassification, any existing bit flags

(Synthetic, Model Key-point, Withheld, and/or Overlap) will be carried over to the output as well.  The

tool determines which points will be reclassed based on the LAS point's recorded time and position.

This is a special version of the Reference Reclass Tool: (1) Time will be used to determine possible

candidate points, and (2) X, Y, Z will be used to determine the closest candidate point. This tool can

process LAS data when the two inputs are in different time formats (e.g., GPS Week Time and

Adjusted GPS Time) because it also takes into account the position of an LAS point.

Classified:  Browse to a folder which contains LAS files that have one or more

classifications in each file. These files are usually in a tile layout form, but other

files can be used.

Unclassified:  Browse to a folder which contains one or more files that have all points

classified as a single default value. These files are usually in collection scan

form, but other files can be used.

Output:  Browse to an output folder or key in the desired path to store the results of

this LAS classification reassignment. This selection choice is optional - if the

user does not choose an output folder, the unclassified input data is overwritten

with the newly classified data based on this reference reclass function.

Tile Option:  Optionally, the data can be tiled upon completion based on a user-

selected polygon shapefile tile layout.  The 'DB Field' chosen will be used to

name the output LAS files.

Class Requirement:  This option is currently hard-coded to use every classification

existing in the 'Classified' data to reclass points in the 'Unclassified' data.

Source Fields That Must Match Reference:  This area of the interface gives the user

the ability to use the values offered from the Classified to the Unclassified LAS
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files as a reference. 

Cache Unclassified LAS:  Checking this option will cache all of the points specified in

the 'Unclassified' input path to RAM per file, if there is sufficient available RAM

to do so. This will make the tool process more quickly than it would working

from two separate locations (specified by the 'Classified' and 'Unclassified' input

paths) on a network. 

Virtual Tile Size:  The virtual tile size sets the size of the area which the tool will

process at any one time.  Computers with more RAM can process larger areas

resulting in a shorter time to completion.
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Change LAS Date (available with Production license only): This tool, found on the Tools Tab
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 under the 'Edit Date/Time' drop-down, allows the user to alter the Julian Day and Year as stored in

an LAS file's header and displayed in the file's properties.  To use the tool, enter a date in the 'File

Creation Date' text box (format must be mm/dd/yyyy).  Navigate to either a single file or a folder of files

using the ellipse  button, then click 'Convert.'

GPS Time Conversion: This tool, found on the Tools Tab  under the 'Edit Date/Time' drop-

down, allows the user to convert how time is stored in LAS files from GPS Week Time to GPS

Adjusted Time (when the GPS Week number is known) and vice versa.  An output folder may be

optionally defined to create a new set of files; otherwise the input files will be overwritten.  Navigate to

the desired file(s) using the 'Add' button.  Individual files can be cleared from the list by highlighting the

appropriate file and clicking the 'Remove' button.  The link provided on the interface can help in

determining the correct GPS Week number.  A valid value between 1 and 2600 (inclusive) must be

entered before the 'GPS Week Time to Adjusted Time' option can be used.

390
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LAS Splitting: This tool, found on the Tools Tab , splits LAS files into multiple, smaller files

based on a user-specified size limit.  Navigate to the desired file(s) using either the 'Add' or 'Add From

Folder' button.  Individual files can be cleared from the list by highlighting the appropriate file and

clicking the 'Remove Selected' button, or the entire list can be cleared by clicking the 'Remove All'

button.  The default size limit is 2 GB per file, but any value can be entered in the 'File Size Limit

(Gigabytes)' text box.  After choosing an 'Output Folder,' click 'Run' to start the process.  Files that

are split will have '-a', '-b', etc. (as necessary) appended to the original file name and the new files will

be placed in the output folder.  The original input file(s) will remain unchanged.  All files that are made

from a single original file will maintain that parent's Point Source ID (PSID) value.

390
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Remove Duplicates in LAS (available with Production license only): This tool, found on the

Tools Tab , will remove duplicate LAS points in a dataset based on X, Y, Z, coordinates and

timestamp.  The tool can be run on a single LAS file or an entire folder of files, and can be multi-

threaded ('Number of threads to use ') for faster processing.  For best performance, there should be a

minimum of eight (8) GB of RAM available (not just installed) per thread.  Navigate to the input file or

folder to be processed, and choose an output folder.  Duplicate weeding will be based on exactly

matching X, Y, Z,  and timestamp values.  In addition to the new cleaned files, separate files of only

the removed points will be created in a 'Duplicates' sub-folder of the chosen output folder.  They will

have the original file name with '_dup' appended to the end.  Data must be spatially indexed before it
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can be processed with this tool - a prompt will appear if the data does not yet have spatial index

records.

Return Information Testing: This tool, found on the Tools Tab , will test all points of all

input files for proper return (point family) information.  It should be used anytime a point family error

message appears while displaying, filtering,  or exporting LAS data; or while running tests C-2 or DPH-

1 of the USGS 2.1 , 1.3  or 1.2  QC Modules, or tests 1.1 or 2.9 of the USGS 1.0 QC Module

.  The tool can be run on a single LAS file or an entire folder of files.  Navigate to the input file or

folder to be processed, and also choose an output folder.  Input files are not modified in any way

during testing.  Click the appropriate "Start" button depending on the input method chosen.  During

processing, separate LAS files will be created in the output folder.  They will have the original file name

with 'Valid_' and/or 'Invalid_' as a prefix, as appropriate.  For example, if file '123456.las' contains

some points with invalid return information, both a 'Vaild_123456.las' and 'Invalid_123456.las' file will be

generated in the output folder.  If all points in a given file have valid return information, only the 'Valid_'

version of the file will be generated.  Likewise, if all points in a given file have invalid return information,

only the 'Invalid_' version of the file will be generated.  Note that invalid return information cannot be

changed once the data is collected and the original 'raw' LAS file is created.

390
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LAS Merging (not available with Evaluation license): This tool, found on the Tools Tab ,

merges individual channel LAS v1.4 files (typically made from a multi-channel LiDAR sensor's

collection) into a single swath (collection scan) LAS file.  For example, the separate channel 1 and 2

files produced by Teledyne Optech's LMS post-processing software from data collected by that

company's Pegasus sensor can be merged into a single LAS file containing all returns from the two

channels.   Other sensors can produce up to four individual channel files, typically numbered 0, 1, 2,

and 3.  The individual files must follow a naming convention in order to be grouped together – following

a leading alpha character, the same number or numbers must exist before the next instance of either

an alpha character or a separator ('-' or '_').  There must also be unique channel indicators at the end

of each file name in a group to be merged, such as '-C0' and '-C1', or '_C1' and '_C2'.  Examples of file

naming that produces a properly merged output file include:

‘L3-1-123456-C1.las’ and ‘L3-1-123456-C2.las’  --  the merged output file will be named
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‘L3_M.las’ (the final 'M' means merged)

‘L42B-1-123456_C0.las’ and ‘L42B-1-123456_C1.las’  --  the merged output file will be

named ‘L42_M.las’

'S456-4-789-C0.las', 'S456-4-789-C1.las', 'S456-4-789-C2.las', and 'S456-4-789-C3.las'

--  the merged output file will be named 'S456_M.las'

‘3A-1-123456-C1.las’ and ‘3A-1-123456-C2.las’  --  the merged output file will be named

'3_M.las'

'L45-1-K-333444-C0.las' and 'L45-1-K-333444-C1.las'  --  the merged output file will be

named 'L45_M.las'

Examples of file naming that will result in improperly merged output files include:

‘L3-1-123456-C1.las’ and ‘L4-1-123456-C2.las’  --  the result will be copies of one or

both of the input files

'8B-1-M-987654-C1.las' and '9B-1-M-987654-C2.las'  --  the result will be copies of one

or both of the input files

Proper file naming is critical to a successful merge!  Each set of individual channel files to be merged

must begin with a naming scheme that is unique to that set. 

Once the files to be merged have been properly named, navigate to the folder containing them using

either the 'Add' or 'Add From Folder' button.  Individual files can be cleared from the input list by

highlighting the appropriate file and clicking the 'Remove Selected' button, or the entire list can be

cleared by clicking the 'Remove All' button.  Choose an 'Output Folder' where the merged files will be

stored and then click the 'Run' button.  The status of each swath merge will be shown in the 'Result'

area.  The File Source ID assigned to each final merged file will be taken from the first individual file of
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the group as listed in the 'Input LAS Files' box of the tool's interface.

LAS Separate (not available with Evaluation license): This tool, found on the Tools Tab ,

separates merged multi-channel LAS v1.4 files into separate individual channel files, one file for each

scanner channel value found in the original merged file.  The Scanner Channel bit flag values must

be present in the original merged file for this tool to work - possible bit flag values are 0, 1, 2,

and 3.  For example, a file containing points from both channels of a dual-channel system (stored as

Scanner Channel bit flag values 0 and 1) will be separated into a channel 0-only file and a channel 1-

only file.  In this example, if the original merged file is named 'L3-123456-M1.las', the new individual

channel files will be named ‘L3-123456-M1-C0.las’ and ‘L3-123456-M1-C1.las’.  Navigate to the files to

be separated using either the 'Add' or 'Add From Folder' button.  Individual files can be cleared from the
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input list by highlighting the appropriate file and clicking the 'Remove Selected' button, or the entire list

can be cleared by clicking the 'Remove All' button.  Choose an 'Output Folder' where the individual

channel files will be stored and then click the 'Run' button.  The status of each file separation will be

shown in the 'Result' area.  The File Source IDs assigned to each individual channel file will be the

same as the ID from the original merged file.

Add System ID: This tool, found on the Tools Tab , allows the System Identifier field in the

Public Header Block of LAS files to be populated or edited.  Note that 'System Identifier' is sometimes

referred to as 'System ID' or 'Sys ID'.  Per the ASPRS LAS v1.4 specification, there are several entries

that are valid for this field, and it can hold up to 32 bytes (characters) of information.  MARS® defaults
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to 'OTHER', but this can be changed as needed in the tool's interface.  If a value is already present in

the file header(s), it will be silently overwritten by the tool.  This tool will not allow complete removal of

existing entries.  To use, navigate to the files to be populated/edited using either the 'Add' or 'Add

From Folder' button.  Individual files can be cleared from the input list by highlighting the appropriate

file and clicking the 'Remove Selected' button, or the entire list can be cleared by clicking the 'Remove

All' button.  Click the 'Update' button to begin processing.  The status of each file's updating will be

shown in the 'Result' area.

Collection Scan Renumbering: This tool, found on the Tools Tab  under the 'Collection

Scans' drop-down, is designed for use with original collection scans (swath files), and allows the

collection scan number stored with each LiDAR point to be changed using one of several methods: 
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On the 'Manual' tab, a new number can be assigned on a file-by-file basis (below, left), or sequential

numbers can be assigned to a folder of files by specifying a non-zero starting number in the 'Starting

collection scan number' text box (below, center).  An option to use existing Point Source IDs to set

the File Source ID numbers is available for either of these methods.  In 'Manual - Folder' mode, the tool

can be multi-threaded ('Number of threads to use ') for faster processing.  For best performance,

there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

On the 'CSV' tab, a CSV file with multiple mapped changes can be read in for an entire folder of LAS

files (below, right).  When the CSV file option is used, it must be formatted as two columns: the first is

a listing of the original collection scan numbers (one per row), and the second column lists the new

desired collection scan numbers.  For example, 5 would become 105, 6 would become 106, etc.  A

header row is optional and will be ignored during processing.  File Source IDs will be changed to

match the new collection scan numbering for each file.  Please note that LAS version 1.4 files are

limited to collection scan numbers of 1 to 65,535.  Original values (first column) of zero (0) will not be

changed.
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Single Collection Scan to Multiple (available with Production license only): This tool,

found on the Tools Tab  under the 'Collection Scans' drop-down, will split a single collection scan

into multiple, smaller collection scans in areas indicated by the flight heading, or angle, which is user
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defined. Having multiple, smaller collection scans versus a single, large collection scan may help in

boresighting and in measuring height differentiations between collection scan overlaps. 

1. To use this tool, first load the LAS data which is the single, large collection scan

by clicking the 'Add' button and navigating to the file(s).

2. To remove added LAS files, select (highlight) the file to be removed and click the

'Remove' button.

3. Next, navigate to the SBET shapefile which is associated with the loaded LAS file

(s) by clicking 'Add'.

4. Specify the sampling rate at which to produce the new collection scans by

entering an integer into the 'Use every __ points in the shapefile' text box. This

feature of the 'Single Collection Scan to Multiple' tool allows the user to reduce

the sampling rate of (or thin out) the heading data from the SBET file by

allowing the user to define a time range.
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The examples shown below compare a 1 second sampling rate (left) and 30 second

sampling rate (right).

  

5. Define an output folder for the multiple new collection scans.

6. Choose a starting collection scan number for the naming convention of the multiple

new collection scans which will be produced.

7. Choose an angle at which collection scans will be separated. Whenever the angle

specified here is found in the original, single collection scan, the process will

start a new collection scan.
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8. When all specifications have been made, choose the 'Run' button.  Multi-Threading

may be used to speed up the processing.  For best performance, there should

be a minimum of eight (8) GB of RAM available (not just installed) per thread.

9. When the process is complete the user will be notified with a prompt as seen

here:

In the first example shown below the LAS data is shown colored by collection scan.

There is only a single, long collection scan loaded. The SBET shapefile is shown as

the pink  point shapefile. In the second example, the collection scan shown previously

has been converted to multiple collection scans with the collection scan angle

specified for separation at 90 degrees. The new data below is also colored by

collection scan.
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LAS Up-Conversion: This tool, found on the Tools Tab , allows batch conversion of pre-LAS

v1.4 files, or version 1.4 files with the following characteristics:  a legacy Point Data Record Format of

0-5, less than 16-bit Intensity values, less than 16-bit RGB(N) values (if present), GeoTIFF tags

containing Coordinate Reference System info, and/or presence of Variable Length Records.  It is the
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same tool that appears when loading LAS files that are not compliant with this version of MARS® (if

'Yes' is chosen in response to the up-conversion prompt).

This tool has several options including: 1) output to a different folder than the files currently reside in,

2) bit flag mapping to convert user-defined classes of points to any of the four changeable bit flags

used in version 1.4 LAS files - Synthetic, Key-point (also referred to as Model Key-point), Withheld,

and Overlap, and 3) assignment of a WKT tag for Coordinate Reference System definition.  Existing

bit flags (except, in some cases, the v1.4-only Overlap type) can be carried over from the files being

converted, or a class or classes can be specified that represented the bit flag types in older version

files.

On the 'Input Files / Output Folder' tab, navigate to the files to be up-converted using either the 'Add' or

'Add From Folder' button.  Individual files can be cleared from the input list by highlighting the

appropriate file and clicking the 'Remove Selected' button, or the entire list can be cleared by clicking

the 'Remove All' button.  The input files will be overwritten unless an output folder is selected.
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On the 'Bit Flag Mapping' tab, check the boxes in the left column for any bit flag types that need to

exist in the up-converted files.  If the existing files have bit flags set for Synthetic (rare), Model Key-

point, and/or Withheld, select the appropriate 'Use bit flag' radio buttons to carry over the bit flag

status.  Otherwise, keep the default 'Use Classes' radio buttons selected and use the 'Select' buttons

in the 'Source' section to choose one or more classes in the existing files that are representing a bit

flag type.  The pre-populated 'Source' classes were chosen as defaults because they are commonly

used in LAS files older than version 1.4.  Optionally, a new 'Target Class' can be selected for the

points once their bit flags are set.  Class 2 is the default 'Target Class' for Model Key-point since it

is a sub-set of ground (which is typically stored as Class 2).
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For the 'WKT' tab, any existing Coordinate Reference System information that is readable will be

shown as a WKT format tag which can then be edited for correctness and/or completeness.
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The tool can be multi-threaded ('Number of threads to use ') for faster processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.  When all settings have been made, click 'Run' to start the up-conversion and load the files,

or 'Cancel' to dismiss the interface without modifying or loading any files.

LAS Version Converter: This tool allows batch back-conversion (export) of LAS files to older

versions (or version 1.4 with legacy Point Data Record Formats).  Some loss of information is

unavoidable when converting data back to older versions and/or lower PDRF values, depending on the

specific version/PDRF of the resulting files.  See the LAS File Specifications  topic for details.

This tool has several options including: 1) LAS version to be created, 2) how existing bit flags will be

stored (as is, or converted to classes) and, 3) conversion of Adjusted GPS Time to GPS Seconds of

the Week.

1716
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For option 1, PDRF values for the output are determined by the 'Target LAS Version' chosen, as well

as whether the input LAS v1.4 files are PDRF 6, 7, or 8.  The following table lists the possibilities:

PDRF 6  --  if back-converted to LAS v1.0, LAS v1.1, LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF <

6), resulting PDRF will be 1.

PDRF 7  --  if back-converted to LAS v1.0 or LAS v1.1, resulting PDRF will be 1.  These LAS

versions cannot store point-level RGB values.

PDRF 7  --  if back-converted to LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6), resulting PDRF

will be 3.

PDRF 8  --  if back-converted to LAS v1.0 or LAS v1.1, resulting PDRF will be 1.  These LAS

versions cannot store point-level RGB or near-infrared (NIR) values.

PDRF 8  --  if back-converted to LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6), resulting PDRF

will be 3.  These LAS versions and legacy PDRFs cannot store point-level near-infrared (NIR) values.

For option 2, mapping of existing bit flags to the output files depends on the 'Target LAS Version'

selected.  In LAS v1.0, there is no provision for bit flag storage as such, so unique classes must be

used to represent bit flag values that the user wants to save.  The default classification values shown

in the tool interface can be changed as needed.  In LAS v1.1 through LAS v1.4 (PDRF < 6), it is

possible to keep the bit flag status of all but the 'Overlap' bit flag.  Optionally, the user can map those

bit flags to unique classes in the output files by selecting the corresponding radio button(s) and either

accepting the default classes or changing them as needed.  Any existing 'Overlap' bit flags must be

converted to a unique class for all back-conversion scenarios.

For option 3, back-conversion to LAS v1.0 or LAS v1.1 requires timestamps to be stored as GPS

Seconds of the Week - therefore, that option will be checked on and disabled.  Back-conversion to

LAS v1.2, LAS v1.3, or LAS v1.4 (PDRF < 6) allows the timestamps to be optionally converted to GPS

Seconds of the Week.  Note, however, that this time storage method does not maintain the actual

collection date.
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When converting back to LAS v1.4 (PDRF < 6), any existing CRS info record (in WKT format) will

remain in an EVLR and all spatial indexing records will be written to VLRs.  When converting back to

LAS v1.0 through v1.3, all EVLRs will be written as VLRs.

In the 'Input Files' section, navigate to the files to be back-converted using the 'Add' button.  Individual

files can be cleared from the input list by highlighting the appropriate file and clicking the 'Remove

Selected' button, or the entire list can be cleared by clicking the 'Remove All' button.

This tool requires the use of an 'Output Folder' - the input files cannot be overwritten.  When all

settings have been made, click 'Convert' to start the back-conversion, or 'Cancel' to dismiss the

interface without creating any new files.

XYZ Shift: This tool, found on the Coordinate Conversion Tab , is used to shift LAS data in all

loaded files in six different directions:

252
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1. East (a positive shift in the Translation East text box) 

2. West (a negative shift in the Translation East text box) 

3. North (a positive shift in the Translation North text box)

4. South (a negative shift in the Translation North text box)

5. Higher in Elevation (a positive shift in the Elevation Adjustment box)

6. Lower in Elevation (a negative shift in the Elevation Adjustment box)

All loaded files will have the same shifts, specified by the user in the 'MARS LAS Shifter' interface,

applied to them.

 ** NOTE: If multiple shifts are applied to a single project, the effect is cumulative. Each shift

is applied to the existing XYZ offset in the header.**

            

An OFF file (*.off) will be created for each file that is shifted storing the X, Y, and Z offsets that existed

in the file before the shift was processed.  These 'offset' files will be created with the same name and
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in the same folder as their corresponding LAS file(s).  They are used with the 'Report LAS Shift' tool

(below) as a baseline.  If the *.off files are moved, renamed, or deleted, they will be recreated the next

time the MARS LAS Shifter is run, but with the then-current offsets used as baselines.

Report LAS Shift: Shifting LAS data using the Table of Contents  'Shift' button or the 'XYZ

Shift' tool on the Coordinate Conversion Tab  produces a *.off file (one per shifted LAS file) which

stores the pre-shift X, Y, and Z offset values read from the LAS file header.  These files are created in

the same folder as the LAS files that were shifted.  The *.off files are used as a baseline by the 

'Report LAS Shift' tool to create a comma-delimited (*.csv) report that stores the total (cumulative)

shift for each of the files chosen to be included in the report.  To use the tool, found on the Coordinate

Conversion Tab , add one or more shifted LAS files using the 'Add' button, or add an entire folder of

shifted LAS files using the 'Add From Folder' button.  Choose a path and file name for the output

CSV file - click on the ellipse  button, then navigate to the desired output folder and enter a

filename and finish by clicking 'Save.'  To create the report, click the 'Run' button at the bottom of the

tool interface.

64
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Z Shift For LAS files: (available with Production license only): The 'Z Shift For LAS files' tool

is located on the Coordinate Conversion Tab  under the 'Z Shift' drop-down button. It will allow the

user to batch shift the Z-value (level the elevation) of all LAS files in a project by use of a comma-

delimited *.csv file. This tool is meant for use after boresighting has been completed. The

corresponding *.csv file must include a header row (as shown in the sample below), followed by the file

names of the LAS files to be shifted and the adjustment value to be made to each file. It is important

to note that the adjustment values to be made to each file need to be in the project units unique to

that particular project. A sample *.csv file may be seen inside the 'Z Shift For LAS files' interface. To

use this tool, point to the LAS files by clicking on the 'Add' button in the upper-right corner and add the

LAS files which need shifting. To remove single or multiple files, highlight the file(s) to be removed and

252
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click on the 'Remove' button. Specify the corresponding *.csv file in the 'Spec File (CSV)' section and

(optionally) designate an output folder. If no Output Folder is specified, the input LAS files will be

overwritten.

Z Shift On Intensity (available with Production license only): The 'Z Shift On Intensity' tool is

located on the Coordinate Conversion Tab  under the 'Z Shift' drop-down button. This tool is capable

of shifting LAS data that matches a specific user defined intensity value. The ‘Z Shift Value’ (amount

and direction of shifting) is also defined by the user. 

After the LAS data is added into the ‘Z Shift On Intensity’ tool, the 'Intensity Requirement' text boxes

are used to specify an ‘Intensity’ value that will be used to identify which points should be shifted, and

the ‘Z Shift Value’ to apply to those intensities. Multiple entries can be made in this section. An output

folder can be designated and progress can be tracked in the ‘Z Shift On Intensity’ interface. If no

Output Folder is specified, the input LAS files will be overwritten.

252
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Z Shift On Class (available with Production license only): The 'Z Shift On Class' tool is located

on the Coordinate Conversion Tab  under the 'Z Shift' drop-down button. This tool is similar to the 'Z

Shift On Intensity' tool, but uses classifications to determine which points will be shifted.

After the LAS data is added into the ‘Z Shift On Class’ tool, the 'Class Requirement' text boxes are

used to specify a ‘Class’ value that will be used to identify which points should be shifted, and the ‘Z

Shift Value’ to apply to those classes. An output folder can be designated and progress can be

tracked in the ‘Z Shift On Class’ interface. If no Output Folder is specified, the input LAS files

will be overwritten.

252
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Add CRS Info (to LAS Files): This tool, found on the Coordinate Conversion Tab , allows

the user to add or update coordinate reference system (CRS) information in an LAS file.  For LAS

version 1.4 files, the tag is written as WKT (Well-Known Text) in an Extended Variable Length Record

(EVLR).  Running the tool with no information entered in either the Horizontal or Vertical sections will

result in any existing info being cleared.  This tool is capable of processing an entire folder of LAS files

('Add From Folder'), or the user may specify one or more individual files ('Add').  Files already added

can be removed by using the 'Remove Selected' or 'Remove All' buttons.

252
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After choosing the desired file(s) or folder, select the coordinate reference system that the data is in by

clicking the 'Edit' button beside the 'Projection Definition (WKT)' text box. The 'CRS Info (Projection

Definition) Written as WKT' window will then appear.
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Click the browse button ('...') next to the 'Horizontal Projection Description' text box to bring up the

'Coordinate System' selection interface, and choose the horizontal coordinate system of the data. The

user may either navigate to the system which defines the data and click 'OK', or the 'Find' search

engine at the bottom of the interface may be used to help find the desired coordinate system.
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Next, click the browse button ('...') next to the 'Vertical Projection' text box to bring up the 'Vertical

Coordinate System' selection interface, and choose the vertical coordinate system of the data in a

similar manner.

Be sure that both the 'Horizontal Unit' and 'Vertical Unit' boxes are correctly populated on the 'CRS Info

(Projection Definition) Written as WKT' interface.
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The 'Height Model', if known, can be selected by using its browse button and choosing the appropriate

model from the 'Vertical Transformation' selection interface.

When all information has been entered on the 'CRS Info (Projection Definition) Written as WKT' interface,

click the 'OK' button to return to the original 'Add CRS Info (to LAS Files)' tool.
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Like many other MARS® tools, this tool is capable of multi-threading to decrease processing time.  The

'Number of threads to use' text box at the bottom of the interface will automatically be populated with

the maximum number of threads available on the particular computer in use.  A lower number of threads

can be entered as needed.  A value of '1' is equivalent to single-thread processing.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

 Click on the 'Run' button at the bottom of the interface to start the processing.  The file or files that

were defined will appear in the 'Results' section, and a completed message will indicate when all

processing is finished.  The 'Clear' button can be used to remove 'Input LAS Files' and 'Results'

information to prepare for additional processing.
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Verify/Remove LAS Projection Info: This tool, found on the Coordinate Conversion Tab ,

allows the user to verify the projection definition (coordinate system) information for an LAS file or an

entire folder of files and, optionally, save the displayed output to a Results File.  The user can navigate

to an individual LAS file or a folder of LAS files depending on the browse button used.  Clicking on the

corresponding 'Verify' button will start the process and the results will be shown in the 'Results:' box.

 If the user wishes to clear (remove) projection information from an LAS file or folder of files, click on

the corresponding 'Remove' button.  The 'Repair' button fixes certain errors in superseded WKT-

based coordinate system tags in LAS v1.4 files.  The function will search all EVLRs or VLRs

containing superseded WKT tags and fix incorrect 'Record ID' values of '0' (zero) to the correct value of

'7'.  It will also fix incorrect values of the 'User ID' field - 'LAS_Spec' and 'LASF_Projection' - to the

correct 'LASF_Spec' for superseded records, so that the files will be in compliance with ASPRS

specifications.

In addition, an option - 'Include all header information' - exists that will display and, optionally,

save the header contents (similar to metadata) as well as the projection information.

252
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The 'Clear' button can be used to remove 'Input/Output' and 'Results' information to prepare for

additional processing.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.3 Raster Tools

Raster Tools

Merrick Advanced Remote Sensing (MARS
®

) Software
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Float Grid to Hillshade: This tool, found on the Tools Tab  under the 'Format Conversion' drop-

down, allows the user to create a hillshade image or raster from a gridded, elevation float grid (*.flt). 

This tool inputs a float grid and is capable of outputting a JPEG 2000 file, BMP file, IMG file, or float

grid file.  It is important to understand that the output file created by this tool is an image or raster.  It

is meant to display quickly, similar to the performance of a compressed .ecw file.  Because this tool

creates an image file, the resulting file may only be viewed in 2D (orthographic) view  and CANNOT

be seen in 3D.

Output folder: Click on the '...' button and navigate to or key in an output folder for

the finished image or raster product.  There must be an output folder specified to use

this tool.  If an output folder is not  designated, the following prompt will appear:

 

FLT File: By clicking on the corresponding '...' button, the user may navigate to a

single input *.flt file.  This is the file that will be used to create an image or raster. 

Either the 'FLT File' specification or the 'Folder to Process specification' must be filled

to use this tool.  If the 'FLT File' is not specified and the user attempts to click on the

corresponding 'Convert' button, the following prompt will appear:

390
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Folder to Process: By clicking on the corresponding '...' button, the user may

navigate to a folder.  Every *.flt file inside the specified folder will be converted to an

image or raster if this option is chosen. Either the 'FLT File' specification or the 'Folder

to Process specification' must be filled to use this tool. If the 'Folder to Process' is not

specified and the user attempts to click on the corresponding 'Convert' button, the

following prompt will appear:

No Data Value:  If there is a data void in the data set (no information within the cell),

a 'No Data' value is assigned.  Cells with null values will be given a default value of -

999.00 unless otherwise specified. Enter an integer in the text box for the No Data

Value if another value is preferred.  Note: Water does not reflect LiDAR points, so

water should be considered a No Data area.

Output File Type: The user may specify here which type of product the tool should

output.  The user may choose from outputting a JPEG 2000 file, float grid, IMG file, or

BMP file.  Click on the drop-down to display the choices. 

Result: The 'Result' text box will show the user the processing of the tool.  When the

file has been converted, the result text box will display that the specified *.flt file(s)

were processed. 

The example below shows the 'Convert  Elevation Float Grid to Hillshade' window:
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After the conversion has taken place, go to the output directory which was specified and

load the resulting image or raster file into MARS®.  The file will be renamed with the same

name as the float grid file which was the input *.flt along with '_Hillshade' appended to the

end of the file name.  For example, the 'sample.flt' file which was the input *.flt in the

example above was output as a JPEG 2000 file and named 'sample_Hillshade.jp2'.  Load

the newly converted file to MARS® to view it.

Below is a sample of the newly created 'sample_Hillshade' JPEG 2000 file.  Because the

resulting file is an image file, panning and moving around the data is much quicker than
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using the corresponding float grid with hillshade created 'on the fly'.

Float Grid to TIFF (available with Production license only):  This tool, found on the Tools Tab

 under the 'Format Conversion' drop-down, will convert an existing Float Grid or folder of Float Grids

to the GeoTIFF format.  To use, choose a Float Grid file or folder using the appropriate browse button

and select or key in an 'Output Folder.'  Please note that the source *.FLT and *.HDR files must be in

the same folder.  Projection definition information may (optionally) be applied to the new TIFF(s) by

selecting the horizontal system name (the browse button will bring up the GeoCalc  interface where

a selection can be made) and entering the Horizontal and Vertical Units from the drop-down boxes. 

Click the appropriate 'Convert' button to begin the process.

390
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Float Grid to IMG (available with Production license only): This tool, found on the Tools Tab

 under the 'Format Conversion' drop-down, converts a Float Grid (*.flt) to an ERDAS Imagine

compatible IMG file.  The conversion can be done by file or folder, and the 'No Data Value' can be

specified by the user.

390
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GeoTIFFS to JPEG 2000: This tool, found on the Tools Tab  under the 'Format Conversion'

drop-down, combines a folder of GeoTIFF rasters into a single JPEG 2000 raster (JP2) with a user-

specified name and output folder location.  Browse to and select the folder containing the individual

GeoTIFFs, and select the output file name and location.  The compression ratio can be modified to

find the best balance of quality and file size. The default compression value is '5' on a scale of 1

(lowest compression, highest quality) to 10 (highest compression, lowest quality).  An assumption is

made that all input GeoTIFFs are in the same coordinate system and have the same cell sizes.

390
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Swath shapes to overlap JP2 (available with Explorer QC and Production licenses only):

This tool, found on the Tools Tab  under the 'Format Conversion' drop-down, converts a folder of

swath footprint shapefiles into a JPEG 2000 raster to allow faster and more complete coverage

checking.  Browse to and select the folder containing the swath footprint shapefiles (these must be

polygons), and select the output file name and location.  The 'Required ANPD' (Aggregate Nominal

Pulse Density) must be input, and the 'Horizontal Units' (e.g., Meters or US Survey Feet) must be

selected from the drop-down list to ensure the proper cell size is used in the raster creation.

390
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The output raster uses the same color coding as the 'Flight Line Overlap' raster in test DC10.1 of the 

Lidar Data Checks  tool:

TIFF Tag Editing (available with Production license only): This tool, found on the Tools Tab

under the 'Format Conversion' drop-down, creates a CRS (coordinate reference system) tag for TIFF

files, or replaces an incorrect or incomplete tag.  Click on the ‘Edit’ button to the right of the ‘WKT’

entry box to open a CRS selection window.  Make the appropriate selections in the ‘Horizontal’ and

‘Vertical’ entry boxes in the top half of that window and click ‘OK’ (see the 'Add CRS Info (to LAS

Files)' topic in the Coordinate Conversion Tab  help section for details).  Then browse to the TIFF

(‘Single TIFF to process’) or TIFFs (‘Folder to process’) that need their tags edited and click the

corresponding ‘Fix’ button.  The ‘Clear’ button can be clicked to remove the results from the ‘Running

Status’ box if another operation needs to be done.  There is no output folder for this tool - the input

TIFF or TIFFs are silently overwritten with the new versions.

1494
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TIFF Origin Rounding (available with Production license only): This tool, found on the Tools

Tab  under the 'Format Conversion' drop-down, rounds off raster extent values to three decimal

places, allowing for better edge-matching with adjacent rasters and better agreement with tile

boundary coordinates.  Browse to the TIFF (‘Single TIFF to process’) or TIFFs (‘Folder to process’)

that need rounding and click the corresponding ‘Fix’ button.  The ‘Clear’ button can be clicked to

remove the results from the ‘Running Status’ box if another operation needs to be done.  There is no

output folder for this tool - the input TIFF or TIFFs are silently overwritten with the new versions.

390
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TIFF Nullifier (available with Production license only):  This tool, found on the Tools Tab ,

finds clusters of connected pixels with cell values of 1,1,1in one or more 3-Band (RGB) TIFF images,

and re-writes those values to 0,0,0.  The minimum number of connected pixels can be set, along with

the search area parameters.  When 'Small Area' is selected, the tool will be expecting only a single

area to be modified, and the process will terminate after locating and re-writing that area.  If 'Entire

Image' is selected, the tool will search the entire TIFF for areas meeting the minimum cluster size

before stopping.  This tool will benefit from Multi-Threading when the 'Folder to process' option is used.

 For best performance, there should be a minimum of eight (8) GB of RAM available (not just installed)

per thread.

390
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Float Grid Merge: The 'Float Grid Merge' tool, found on the Tools Tab  under the 'Float Grid

Operations' drop-down, allows the user to combine multiple float grids into a single file.  The files being

merged inside this tool do not need into be loaded to MARS® prior to being merged. To use this tool: 

1. Place the singular float grids which will be combined to create the

merged float grid into the same folder.

2. Specify this folder in the 'Input: Folder to process' text box. The

user may navigate to the folder by clicking the '...' button.

3. Next, specify the output folder and name the new float grid file.

Clicking on the '...' button will allow the user to navigate to the

designated output folder where the merged float grid will be placed

after creation. The user must also name the new, merged file here.

In the example below, the user has named this file 'Merged'. 

4. Click the 'Merge' button to begin the process. The progress of the

390
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tool (by file) may be monitored in the bottom window of the interface.

To view the result, the user must add the newly created float grid file by clicking the 

'Add Float Grid' button on the Project/Data Preparation Tab  and choosing the

merged float grid file.

Float Grid Clipping:   This tool, found on the Tools Tab  under the 'Float Grid Operations' drop-

down, allows a Float Grid to be clipped to the extents of a polygon shapefile.  To use, click on the

ellipse button to the right of the 'FLT File' text box and navigate to the Float Grid file to be clipped. 

Then choose the polygon shapefile to be used as a clipping boundary by clicking the ellipse button to

the right of the 'Clipping Boundary' text box.  Click on the 'Clipping' button to begin the process.  A

message will appear in the 'Result' box when the clipping is complete.  NOTE: The existing file will

162
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be overwritten with the new result and only that grid data within the polygon(s) of the shapefile

will be kept.

Float Grid Tile Cutting:   This tool, found on the Tools Tab  under the 'Float Grid Operations'

drop-down, allows a Float Grid to be cut into individual areas based on a tile layout shapefile.  To use,

click on the ellipse button to the right of the 'FLT File' text box and navigate to the Float Grid file to be

tiled out.  Next, click on the ellipse button to the right of the 'Tile Shapefile' text box and navigate to

the tile layout.  All polygons in the tile shapefile will be used to cut the original Float Grid into

individual areas.  Now choose a unique-value attribute field that will be used to name the output Float

Grids.  Optionally, a 'Prefix' and/or 'Suffix' can be added to further define the new grid names.  Click on

the 'Tiling' button to begin the process.  A message will appear in the 'Result' box when the tiling is

complete.  The new tile-based Float Grids will be output in the same folder as the original Float Grid,

and the original will not be altered in any way.

390
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Float Grid Merge to Base:   This tool, found on the Tools Tab  under the 'Float Grid

Operations' drop-down, can be used to replace a re-processed area of an existing Float Grid with

corrected grid data.  It is particularly useful when only a small portion of a large area single-file Float

Grid needs to be replaced, and can save a considerable amount of time over re-exporting the entire

project area.  A typical workflow would be as follows:  1. After identifying a mis-classified area of a

Float Grid, use a tile layout shapefile to determine which tile or tiles are affected.  2. Create a new tile

shapefile with those tiles deleted.  3. Use the 'Float Grid Clipping' tool (above) to make a new Float

Grid using the new tile shapefile as the Clipping Boundary - this will eliminate the bad area(s) from the

original Float Grid.  4. Re-classify the LAS data as needed and export a Float Grid using only the tiles

that encompass the modified area(s) - this export will be used as the 'patch.'

To use this tool, click on the ellipse button to the right of the 'Base FLT File' text box and

navigate to the Float Grid that needs to be patched.  Next, click on the ellipse button to the

right of the 'FLT to Merge to Base' text box and navigate to the new Float Grid data that will

be used to fill the void in the base grid.  Click the 'Merge' button to begin the process.  A

390
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message will appear in the 'Result' box when the merge is complete.  NOTE: The existing

base Float Grid will be overwritten by the new merged grid data. 

Add Geo Tags (to Tiff Files):  This tool is a GeoTiff header tool meant for use with

georeferenced tiff files.  By navigating to the *.tif file to be converted and specifying all of the needed

information, the user can produce a *.tif which will function on its own without the accompanying tiff

world file (*.tfw).  To produce a single GeoTiff file, start by navigating to the file which is to be defined. 

The *.tif and accompanying *.tfw must both reside in the same folder.  If only a single file is to be

defined, it is easiest to use the 'Single TIFF to process' text box.  If an entire folder of tiff files is to be

defined, using the 'Folder to process' text box will be faster.  For the folder option, navigate to the

folder which contains the tiff files to be defined.  As the tiff images are loaded into the interface, the

'Image Description' and 'GT Citation' sections of the interface will automatically populate.  If the user

wishes to add a prefix or a suffix to the tiff file name(s), these can be specified under the 'Document

Name' section.  Lastly, specify the projection of the tiff file in the 'Projection' section.  The user may



Tools and Functions 639

© 2000-2023 Merrick & Company

choose the projection from a list by choosing the '...' button and either navigating to or running a

search for the needed projection.  Once the projection has been chosen, the 'EPSG Code' will

automatically populate.  Make sure to choose the correct horizontal unit, and the tiff file(s) will be

ready to be defined.  Click the appropriate 'Convert' button at the top of the interface and the 'Running

Status' section of the interface will show the progress of the tool.  The new tiff file(s), with

georeferenced information in the header, will be found in the same folder in which the original tiff files

were found.  The original tiff file(s) will be replaced.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.4 Data Convert

Converting Elevation Data to LAS

Merrick Advanced Remote Sensing (MARS
®

) Software

The MARS® Convert tool, found on the Project/Data Preparation Tab , is used to translate elevation

data files to the LAS format, which MARS® natively supports. Specifically, MARS® is capable of

converting ASCII Text files (*.txt, *.dat, *.csv, *.xyz, *.grd),  Esri ASCII Grids (*.asc), Float Grids

(*.flt), and GeoTIFF Grids or TIFF Grids with world files (*.tif, *.tif/*.tfw) to the LAS format.

NOTE:  When the above-listed types of elevation data are converted into an LAS format 1.4 file, the

resulting LiDAR points will be bit-flagged as 'Synthetic.'

For more information on the LAS specification, please visit the following link at the ASPRS Online

Website.

The following steps outline how to use the MARS® Convert tool:

Click the ‘Convert’ button  on the Project/Data Preparation Tab .

The following image shows the MARS® Convert dialog.

162
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Text File Options: When either a *.txt or *.csv text file is selected to be converted, the 'Text File

Options' dialog becomes available. Text files can be comma, space, or tab delimited. If the 'Use

Default Format' box is checked, the default fields will be used in the format. The default text format is

XYZ with a space delimiter. If the file contains header information (i.e., a header row), select the ‘File

Contains Header’ check box, which causes the convert module to skip the first line of the file when

creating point records.
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To further specify the format settings for the text file conversion, select the 'Choose Text File

Format' button. The X, Y, and Z fields are in the fields in order dialog box by default. If additional fields

are necessary to convert the text file, the user can select the desired field from the right window of the

dialog and click the '<<' button to add it to the file format definition in the left window. The user can

also reorder the convert file format definition by selecting a field in the left window and using the ‘Up’

or ‘Down’ arrow buttons to match the text file format. In addition, the ‘Ignore’ option from the

attribute field list (left side of dialog) allows the user to disregard specific data values in the input file for

translation. The ‘Ignore’ field may be used as many times as necessary. If there is an existing record

format file to be used on the data, select the 'Choose Existing Format from File' button, browse to

where the format file is kept, and click 'Open'. 
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The user can bring in saved format settings ('Choose Existing Format from File'), and any unique

settings described in the dialog box by the user can also be saved for use at a later time. Once the file

definition to be used is complete, these values can be saved to an external file for reuse by clicking on

the ‘Save Format’ button.  The target directory and file name for the file definition format can then be

assigned.  When all the dialog settings are complete, click 'OK' to return to the previous convert

window.

By using the ‘Test File’ function on a selected (highlighted) file, the user can quickly verify that the

inputted file format matches the actual contents of the target file. The ‘Test File’ dialog is displayed to

the user and provides a file status of ‘PASSED’ or ‘FAILED’, and also displays the first several lines

of the file for review purposes.
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Boundary: The ‘Boundary’ section of the MARS® Convert module allows the user to clip the converted

data with a polygon shapefile. The result of this process is that only the points within each feature in

the shapefile will be converted into an LAS file. The names of the input files must exactly match

values in the shapefile's chosen attribute field (TName in the image below).  The created LAS files will

have the same names as the input files.

LAS Options: The ‘LAS Options’ section of the MARS® Convert module allows the user to create the

new v1.4 LAS files using Point Data Record Formats of 6, 7, or 8 (depending on whether RGB(N)

values are available in the input files).
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LAS File: The ‘LAS File’ section of the MARS® Convert dialog allows the user to modify the output

LAS file and choose its output location.

Note: If the output directory is not specified by the user, the new LAS files will be generated in the

same directory as the input file location. To specify another location for the output LAS files, the user

can click  the ‘Browse’ button and navigate to the desired directory or key in a path.

Override Classification: The ‘Override Classification’ check box is used to assign a specific data

classification to the converted dataset. For example, when converting “bare-earth” ASCII files to LAS,

the user may choose to override the data classification to 2, which represents ‘Ground (All)’. The

default override classification value is 0 (zero).
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Assign unique collection scan per file: During the conversion process, the user may assign a

unique collection scan number per file during LAS file creation, which is useful if each file contains

only one (1) collection scan. This function is not necessary if the input files already contain collection

scan information and the 'Collection Scan' field is used appropriately in the file-to-LAS mapping. This

tool can also be implemented when converting TIFF files.

Treat as actual collected returns: This checkbox is available when converting ASCII Text files to

LAS.  The default is unchecked, since most text files of XYZ points do not represent actual LiDAR

points.  It should be checked if the coordinates in the file are known to represent actual collected

returns.

Significant Figures (LAT-LONG values need 8 places 0.00000001):  The 'Significant Figures'

section of the Convert module should be utilized when the user is converting LAS files.  The default

value is set to 0.001 to retain the accuracy of any type of projected data (UTM, State Plane, etc.).  In

some cases where the 'X' and/or 'Y' extent of the data is very large, the tool may fail to make a valid

LAS file.  In this scenario, try reducing the default 'X' and/or 'Y' Significant Figures value(s) to '0.01'. 

This will reduce the decimal precision of the resulting data slightly, but will still provide two decimal

places for the point values.  If the user is converting latitude/longitude data in decimal degrees, another

five decimal places (0.00000001- eight total decimal places) will need to be added to the default value

to preserve the accuracy of the data.

Multi-threading: To help speed up Convert, multi-threading is available for this function. Enter any

number of threads from 2 to the maximum number available in the text box on the right side of the

interface. If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per
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thread.

Convert: To complete the file convert process, the user must click the ‘Convert’ button after all of the

necessary data convert parameters have been defined. To follow the progress of the conversion,

please see the Progress Bar, which will display the percentage of the conversion completed, the

elapsed time, and the estimated time remaining to complete.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.4.1 Convert ASCII Text

Convert ASCII Text Files

Merrick Advanced Remote Sensing (MARS
®

) Software

To convert an ASCII Text file to LAS for use in MARS®, open the convert dialog by clicking on the

'Convert'  button on the Project/Data Preparation Tab .162
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To add a file(s) for conversion, click the ‘Add’ button in the MARS® Convert window, which opens the

following dialog:
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Change the file type drop-down to 'Text files (*.txt, *.dat, *.csv, *.xyz, *.grd)', navigate to the desired

directory and select the file(s) to be converted into MARS®. Click the ‘Open’ button to add them to the

MARS® Convert dialog.

The user may add multiple files and may also remove a file from the dialog by highlighting the file and

clicking the ‘Remove Selected’ button or the 'Remove All' button.
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Next, the user can define the input file format by clicking on the ‘Choose Text File Format’ button,

which launches the ‘Text File Format’ dialog. The default text format is XYZ with a space delimiter.

To further specify the format settings in which the text file is to be converted, select the 'Choose Text

File Format' button. The X, Y, and Z fields are in the fields in order dialog box by default. (Checking on
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the 'Use Default Format' box will use these default settings during conversion.) If the file contains

header information, select the ‘File Contains Header’ check box, which causes the convert module to

skip the first line of the file. If additional fields are necessary to convert the text file, the user can select

the necessary attributes one at a time from the right window (Available fields) of the dialog and click the

'<<' button to add it to the file format definition in the left window. The user will also need to define the

file delimiter, which can be a space, comma or tab. The user can also reorder the convert file format

definition by selecting a field in the left window and using the ‘Up’ or ‘Down’ arrow buttons to match

the text file format. In addition, the ‘Ignore’ option from the attribute field list (left side of dialog) allows

the user to disregard specific data values in the input file for translation. The ‘Ignore’ field may be used

as many times as necessary. If there is an existing record format file to be used on the data, select

the 'Choose Existing Format from File' button, browse to where the format file is kept, and click

'Open'.

Once the user has completed the convert file definition, these values can be saved to an external file for
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reuse by clicking on the ‘Save Format’ button. The user can define the target directory and file name

for the file definition format.

By using the ‘Test File’ function, the user can quickly verify that the inputted file format matches the

actual contents of the target file. The ‘Test File’ dialog is displayed to the user and provides a file status

of ‘PASSED’ or ‘FAILED’, and also displays the first several lines of the file for review purposes.
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After the File has passed the ‘Test File’ function, review the settings in the Data Convert  section

above and click 'Convert' to convert the file to LAS.  (Note: If the output directory was not specified by

the user, the new LAS files were generated in the same directory as the input file location. To specify

another location for the output LAS files, the user can click  the ‘Browse’ button and navigate to or key

in the desired folder.)

Now load the file(s) for viewing by following the procedure for the 'Add LAS Files' button in the Project/

Data Preparation Tab  topic. 

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.4.2 Convert Esri ASCII Grid

Convert Esri ASCII Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

To convert an Esri ASCII Grid file to LAS for use in MARS®, open the convert dialog by clicking on the

'Convert'  button on the Project/Data Preparation Tab .

To add a file(s) for conversion, click the ‘Add’ button in the MARS® Convert window, which launches

the following dialog:

Change the file type drop-down to 'Esri ASCII Grid (*.asc)', navigate to the desired directory and select

the file(s) to be converted into MARS®. Click the ‘Open’ button to add them to the MARS® Convert

162
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dialog.

The user may add multiple files and may also remove a file from the dialog by highlighting the file and

clicking the ‘Remove Selected’ button or the 'Remove All' button.

Review the settings in the Data Convert  section above and click 'Convert' to convert the file(s) to

LAS.  (Note: If the output directory was not specified by the user, the new LAS files were generated in

the same directory as the input file location. To specify another location for the output LAS files, the

user can click  the ‘Browse’ button and navigate to or key in the desired folder.)

Now load the file(s) for viewing by following the procedure for the 'Add LAS Files' button in the Project/

Data Preparation Tab  topic.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.4.3 Convert Float Grid

Convert Float Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

To convert a Float Grid into MARS®, open the convert dialog by clicking on the 'Convert' 

button on the Project/Data Preparation Tab .

Click on the 'Add' button and browse to the file. Click the file type drop-down box at the bottom of the

window and select 'Float Grid (*.flt)' as the file type. Click 'Open'.
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The user may add multiple files and may also remove a file(s) from the dialog by highlighting the file and

clicking the ‘Remove Selected’ button or the 'Remove All' button.

Review the settings in the Data Convert  section above and click 'Convert' to convert the file(s) to

LAS.  (Note: If the output directory was not specified by the user, the new LAS files were generated in

the same directory as the input file location. To specify another location for the output LAS files, the

user can click  the ‘Browse’ button and navigate to or key in the desired folder.)

Now load the file(s) for viewing by following the procedure for the 'Add LAS Files' button in the Project/

Data Preparation Tab  topic.  

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.4.4 Convert TIFF Grid

Convert TIFF Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

To convert a TIFF Grid file (GeoTIFF or TIFF with world file) to LAS for use in MARS®, open the convert

dialog by clicking on the 'Convert'  button on the Project/Data Preparation Tab .

To add a file(s) for conversion, click the ‘Add’ button in the MARS® Convert window, which launches

the following dialog:
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Change the drop-down to 'GeoTIFF files (*.tif)', navigate to the desired directory and select the file(s) to

be converted into MARS®. Click the ‘Open’ button to add them to the MARS® Convert dialog.

The user may add multiple files and may also remove a file(s) from the dialog by highlighting the file and

clicking the ‘Remove Selected’ button or the 'Remove All' button.

Review the settings in the Data Convert  section above and click 'Convert' to convert the file(s) to

LAS.  (Note: If the output directory was not specified by the user, the new LAS files were generated in

the same directory as the input file location. To specify another location for the output LAS files, the

user can click  the ‘Browse’ button and navigate to or key in the desired folder.)

Now load the file(s) for viewing by following the procedure for the 'Add LAS Files' button in the Project/

Data Preparation Tab  topic. 

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5 Data Export

Data Export

Merrick Advanced Remote Sensing (MARS
®

) Software

For any LAS tools that allow files to be pathed out without loading them in the Table of

Contents in MARS® (including 'Export' when the 'Export without loading LAS files into Map

View' option is used),  an up-conversion prompt will appear when executing the tool if the LAS

files do not meet the minimum MARS® compliancy requirements.  This prompt is described in
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the Project/Data Preparation Tab  topic.

'Data Export' allows the user to export LAS, LAS Grid, 3D Image, Text (ASCII), 3D point

shapefiles, Esri ASCII Grids, Float Grids (both elevation and LiDAR Point Density), Shapefile

contours, PLS-CADD (both ASCII and LAS), ENVI (elevation) Grids, ENVI (elevation and

classification) Grids, LiDAR Spatial Distribution Verification Grid JPEG 2000s, LiDAR Raster

JPEG 2000s, Flightline Separation JPEG 2000s, Tiled Flightline Separation GeoTIFFs,

Hillshade JPEG 2000s, ERDAS IMAGINE Grids, and various types of TIFF Grids from loaded or

pathed-out LAS data.  When 3D point shapefiles and 2D or 3D contour shapefiles are exported, a *.prj

(projection definition file) is created if the projection information is known for the source LAS data.

All export type interfaces share several tools and functions in common: 'Save Settings to File', 'Load

Settings from File', a progress bar, a display of 'Elapsed Time' and 'Estimated Time to Complete',

buttons for 'Help', 'Export', and 'Cancel', and an option labeled 'Only Displayed Files Will Be Exported'.

 Please note that all loaded data will be exported unless the 'Only Displayed Files Will Be Exported'

box is checked.  This option is not available when the 'Export without loading LAS files into

Map View' option is checked on the Options Tab  (see the Export Options  topic for details).

 Also, most export types have a 'Multi-Threading' control to improve performance by using the

processing computer's resources more efficiently.

Please note: When a tile-based export is canceled by the user (by using the 'Cancel' button on the

export interface), files that have been created in the output folder will be deleted based on their

creation time.  Anything with a creation date/time after the export was started will be removed - any

pre-existing files with older date/time creation information will be left in the folder.

Also note that all loaded data will be exported unless the 'Only Displayed Files Will Be

162
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Exported' box at the bottom of the interface is checked.  This option is not available when the

'Export without loading LAS files into Map View' option is used (see the Export Options

topic).

Each export type is further explained in its particular subtopic.  Expand the 'Export Types' help topic

and find the type of file to be exported in the subtopics listed.  Follow the instructions specific to each

file type for export.  While all Export Types will have 'Output ', 'Layout', and 'Options ' tabs, other

tabs will appear that are specific to the type of export chosen.  These tabs are: Filters , Transforms

, Contours , Grid , and Projection .

There are several ways to export data from MARS®:

 'Export': The 'Export' button, found on the Export/Extract Tab , opens a drop-down list of

export types, allowing data to be exported based on a single file (from all loaded data or selected tiles

only), MBR (minimum bounding rectangle) shapefile, irregular shapefile, or selected tiles from a loaded

tile layout shapefile.  This export format can also be used to export separate files based on collection

scan numbers (Point Source IDs) for the 'LAS' or 'Text - ASCII' export types only.  Not every Export

Type supports every Layout format, so all formats may not be visible on the Layout tab. 

 'Pick Tiles': The 'Pick Tiles' button allows the user to load a tile layout shapefile and then

select a single tile or multiple tiles to be exported. The selected tile(s) will then appear selected in the

attribute table representing the shapefile. (To view the attribute file, right-click on the appropriate file

inside the Table of Contents and choose 'Attributes'.) Conversely, it is possible to use the attribute

table to select tiles from the shapefile.  Use the 'Shift' and/or 'Ctrl' keys on the keyboard the select

780
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the appropriate tile(s). The selected tile(s) will then appear highlighted in the LAS Map View window on

the tile layout itself. (Please see the Pick Tiles  utility for further instructions on the use of this tool.)

 'Export Area': Also found on the Export/Extract Tab , this tool allows a rectangular area of

selected data to be exported by clicking and dragging a box (can be used only while in 2D View  ).

Immediately after creating the drag box, a drop-down list of export types appears for selection.  This

export method also allows data to be exported to separate files based on collection scan numbers

within the dragged area. (Collection scans can be exported only as 'LAS' or 'Text - ASCII' types.) 

Note: There are system limits for 'NO DATA' areas and very large areas.  Not every export type

supports this method of exporting.

Every export process in MARS® will generate an XML file containing the settings used in the export.

This file will be output to the same designated folder as the exported data.  Each unique *.xml file

name will contain the date and time of export as seen in the example below.  For example, this

particular export took place at 3:22:56 pm on November 28, 2011.

This file can be renamed as needed and loaded for future exports to cut down on data entry and ensure

consistency between export runs.  After selecting an export type to open its interface, click the 'Load

Settings from File' button and navigate to an existing settings file to be used.  Any individual

parameters on any of the the interface tabs can be changed before starting the export processing.  In

addition, a settings file can be created and saved for future use without actually running an export. 

Make all the parameter entries on the various tabs and click the 'Save Settings to File' button when

finished.  Navigate to a folder to store the file as it will not be stored in the chosen 'Output Directory'
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automatically like it is when the export is actually run.

Please note that not all export/layout types can take advantage of multi-threading and/or

temporary local disk space,  In addition, not all layout formats (e.g., Single File) are supported

for all export types.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1 Export Types

4.5.1.1 3D Image

Export 3D Image (LAS Grid Hybrid)

Merrick Advanced Remote Sensing (MARS
®

) Software

The '3D Image' export type is a variation of the 'Grid - LAS ' export type that creates a specially-

colorized 'hybrid' LAS file - a mix of high-density gridded data to represent ground (typically) and non-

gridded data to represent above-ground features.  Other classes of points such as buildings can be

added to the set of classes to be output as high-density gridded points.  At a minimum, the input LAS

data must have ground classified separately from non-ground.  The output file will have Class 2

assigned to all gridded points.  Because of this, class alone can no longer be used to differentiate

types of features in the final gridded points.  The remaining above-ground points will retain their original

classifications.  

In addition to LAS data, imagery must also be loaded to use this export type.  Each point in the output

file has RGB values attached to it - the gridded ground data gets its RGB values from the loaded

imagery, and the above ground data gets its values from Custom Colorization by classification.  For

more on using Custom Colorization in export, see the LAS Export  topic.  This export type requires
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that a tile layout shapefile be loaded.

Exporting '3D Image' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.

To export a 3D Image file, select it from the drop-down list.  On the Output Tab , specify an Output

Directory where the file should be exported.  The user may choose which Point Data Record Format - 7

or 8 - will be used, depending on whether RGB or RGB(N) values are present in the imagery.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

The Point Data Record Format will default to 7, but can be changed to 8 if desired.  **NOTE that all

points in the exported '3D Image' LAS file will be bit-flagged as 'Synthetic'.
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.2 Contours - Shapefile

Export 2D/3D Contour Shapefiles

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Contours - Shapefile' (2D or 3D): Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a

drag box be created first before the drop-down list appears.

To export a Contours - Shapefile, select it from the drop-down list.  On the Output Tab , specify an

Output Directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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'Single File' Layout  is not available for this export type.  'Export Area '  may be used to

define an area, or at least one polygon (e.g., tile) must be selected for export.  If an unsupported

layout type is selected, or if tiles are loaded but none is selected, an error message will pop up as

seen below:

         

 

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

742 658



MARS® v2023.1           User Manual668

© 2000-2023 Merrick & Company

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.   When 2D or 3D contour shapefiles are exported, a *.prj (projection

definition file) is created if the projection information is known for the source LAS data.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.3 Flightline Separation - JPEG 2000

Export Flightline Separation JPEG 2000
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Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Flightline Separation - JPEG 2000' files: Start by clicking on the 'Export'  button

or the 'Export Area'  button to see the drop-down list of export types.  'Export Area' requires

that a drag box be created first before the drop-down list appears.

To export a Flightline Separation - JPEG 2000 file, select it from the drop-down list.  On the Output

Tab , specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical
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situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

An option exists for creating a Measurable RMSDz (Z difference) raster and results file for Collection

Scan (flightline) Separation.  This option creates a much more accurate representation of collection

scan separation by limiting the results to areas away from obstructions.  A results *.TXT file is created

based on the RMS-derived vertical separation difference between adjacent files in overlap/sidelap areas

where Single Return points are clustered at a minimum horizontal distance from other return types. 

This radius distance is entered manually - a value of 10 times the NPS (nominal pulse spacing) for the

data being exported is a good starting point.  This will ensure that the LiDAR data used for the export

are in open areas, but not so far from obstructions that the number of points used is insufficient for an

accurate result.  In this way, the data that is tested and exported is much more likely to be ground in

open areas, especially if the ‘Display cutoff value’ (see the 'Grid Type' section of the Grid Options 783
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tab) is small enough to weed out non-system anomalies but large enough to ignore differences caused

by targets in one collection scan not being present in an adjacent scan (a car, for example).  A good

starting point is 10 times the ‘Elevation increment’ (also explained in the 'Grid Type' section of the Grid

Options  tab).  Only the points that meet all of these criteria are used in the RMSDz calculation.

See the Consistent Return Filter  topic for more information on how these points are determined.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per
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thread.

Move through the remaining tabs to continue making specifications for the export.

On the 'Filters' tab in the export dialog, the default settings of the 'Flightline Separation - JPEG 2000'

export type are set to include export of the 'Last returns' only.  If the ‘Measurable RMSDz FSR’ option

is used (see above), then Single Returns are used instead.  Any 'Overlap' bit-flagged points will be

forced on as part of this export type as they often delineate the area to be measured.  If these

specifications are not sufficient for the user's export, changes can be made on the 'Filters' tab for most

options.  There are also options with this export type to include/exclude specific classes, returns,

collection scans, and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for

more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.4 Flightline Separation - Tiled GeoTIFF

Export Flightline Separation Tiled GeoTIFFs

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Flightline Separation - Tiled GeoTIFF' raster files: Start by selecting one or more tiles

from a loaded tile layout shapefile, then click the 'Export'  button.

To export a Flightline Separation - Tiled GeoTIFF raster file, select it from the drop-down list.  On

the Output Tab , specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported raster(s)

to be written to the specified 'Output Directory', but uses local disk space to speed up processing.  A

typical situation for this option is when the 'Output Directory' is a network location.  To use this option,

check the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder

which has available space - the export interface will display how much space is required and how much

free space is in the selected folder.  If there is enough disk space, the export process will use the local

space to speed up processing.  If the 'Use temporary local disk space to speed up processing' box is

checked but a temporary folder is not specified, an error message will appear as seen below.  NOTE: 

Most versions of Windows prohibit an application's output of files to the root directory of drives.

 It is strongly recommended that an actual folder be used for this option.

The 'Multi-Threading' option is available for this export type.  It speeds up export by using a specified

amount of a computer’s CPU processing power.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.
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On the 'Filters' tab in the export dialog, the default settings of the 'Flightline Separation - Tiled GeoTIFF'

export type are set to include export of the 'Last returns' only.  Any 'Overlap' bit-flagged points will be

forced on as part of this export type as they often delineate the area to be measured.  If these

specifications are not sufficient for the user's export, changes can be made on the 'Filters' tab for most

options.  There are also options with this export type to include/exclude specific classes, returns,

collection scans, and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for

more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.5 Grid - Cloud Optimized GeoTIFF DEM

Export Cloud Optimized GeoTIFF DEM Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software
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Exporting 'Grid - Cloud Optimized GeoTIFF DEM' raster files: Start by selecting one or more tiles

from a loaded tile layout shapefile, then click the 'Export'  button.

To export a Grid - Cloud Optimized GeoTIFF DEM file, select it from the drop-down list.  On the

Output Tab , specify an output directory where the file(s) should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files
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to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

The multi-threading option is available for this export type.  It speeds up export by using a specified

amount of a computer’s CPU processing power.  The multi-threading option can be found at the lower-

right corner of the export interface.  By default, the text box will show the maximum number of threads

the computer has available for processing.  Leave as is, or enter a lower number of threads to be used.

If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best performance,

there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.
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When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.6 Grid - Cloud Optimized GeoTIFF Intensity

Export Cloud Optimized GeoTIFF Intensity Grid

Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Grid - Cloud Optimized GeoTIFF Intensity' raster files: Start by selecting one or more

tiles from a loaded tile layout shapefile, then click the 'Export'  button.

To export a Grid - Cloud Optimized GeoTIFF Intensity file, select it from the drop-down list.  On

the Output Tab , specify an output directory where the file(s) should be exported.740
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If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.
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The multi-threading option is available for this export type.  It speeds up export by using a specified

amount of a computer’s CPU processing power.  The multi-threading option can be found at the lower-

right corner of the export interface.  By default, the text box will show the maximum number of threads

the computer has available for processing.  Leave as is, or enter a lower number of threads to be used.

If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best performance,

there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.7 Grid - ENVI Elev

Export ENVI Elev Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Grid - ENVI Elev' export type creates a *.dat format file to be used by software that loads and

interprets ENVI compatible raster data.  The exported raster is an interpolated ENVI elevation grid (

<name>.dat, <name>.hdr, and <name>.dat.aux.xml) whose cells are populated with the elevation

values from the underlying lidar points.  See also the Grid - ENVI Elev/Class  export type.

Exporting 'Grid - ENVI Elev' files: Start by clicking on the 'Export'  button or the 'Export

Area'  button to see the drop-down list of export types.  'Export Area' requires that a drag box

be created first before the drop-down list appears.

To export a Grid - ENVI Elev file, select it from the drop-down list.  On the Output Tab , specify an

output directory where the file should be exported.
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If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.
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When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.8 Grid - ENVI Elev/Class

Export ENVI Elev/Class Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Grid - ENVI Elev/Class' export type creates two (2) *.dat format files to be used by software that

loads and interprets ENVI compatible raster data.  The two exported files are an interpolated ENVI

elevation grid (<name>.dat, <name>.hdr, and <name>.dat.aux.xml) whose cells are populated with

elevation values of the underlying lidar points, and a classification grid (<name>_class.dat and 

<name>_class.hdr) whose cells are populated with the majority classification of the underlying lidar

points that were included in the export.  See also the Grid - ENVI Elev  export type.

Exporting 'Grid - ENVI Elev/Class' files: Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a
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drag box be created first before the drop-down list appears.

To export a Grid - ENVI Elev/Class file, select it from the drop-down list.  On the Output Tab ,

specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files
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to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

                               

 

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export. 

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.774
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When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface.  The following window will appear where the classes to be included in the classification 

output raster can be selected:

Click the 'OK' button when the selection has been made to start the export process.

When the export is complete, the following message will appear.
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4.5.1.9 Grid - Esri ASCII Grid

Export Esri ASCII Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Grid - Esri ASCII Grid' files: Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a

drag box be created first before the drop-down list appears.

To export a Grid - Esri ASCII Grid file, select it from the drop-down list.  On the Output Tab ,

specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

 

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be
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found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.5.1.10 Grid - Float Grid

Export Float Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Grid - Float Grid' files: Start by clicking on the 'Export'  button or the 'Export

Area'  button to see the drop-down list of export types.  'Export Area' requires that a drag box

be created first before the drop-down list appears.

To export a Grid - Float Grid file, select it from the drop-down list.  On the Output Tab , specify an

output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be
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found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.  

When the export is complete, the following message will appear.  The resulting float grid (*.flt) file may

be viewed in MARS® in 3D (perspective) mode  as well as in 2D.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.5.1.11 Grid - IMG

Export IMG Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Grid - IMG' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.

To export a Grid - IMG format file, select it from the drop-down list.  On the Output Tab , specify an

output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.
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Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.12 Grid - LAS

Export LAS Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software
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Exporting 'Grid - LAS' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.

To export a Grid- LAS file, select it from the drop-down list.  On the Output Tab , specify an output

directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

The user may choose which Point Data Record Format the output files are saved in - 6, 7, or 8 -

although the default will be 6 since this type of LAS file does not typically have RGB(N) values stored in

it.

**NOTE that all points in the exported LAS Grid file will be bit-flagged as 'Synthetic' and

classed as 0 (zero).

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export
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by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

See also:

3D Image  
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4.5.1.13 Grid - LiDAR Raster JPEG 2000

Export LiDAR Raster JPEG 2000 Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Grid - LiDAR Raster JPEG 2000' files: Start by clicking on the 'Export'  button to

see the drop-down list of export types.  'Export Area' is not available for this export type.

To export a Grid - LiDAR Raster JPEG 2000 file, select it from the drop-down list.  On the Output Tab

, specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

740



Tools and Functions 701

© 2000-2023 Merrick & Company

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per
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thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.14 Grid - TIFF

Export TIFF Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software
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Exporting 'Grid - TIFF' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.

To export a Grid - TIFF file, select it from the drop-down list.  On the Output Tab , specify an output

directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

There are two 'Geolocation Options' to choose from for this export type.  Select either the 'Use World

File' option or the 'Use GeoTiff tags' option.  The world file option will create a *.tfw file for each

exported TIFF in the Output Directory. 
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.15 Hillshade - JPEG 2000

Export Hillshade JPEG 2000

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Hillshade - JPEG 2000' files: Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a

drag box be created first before the drop-down list appears.

To export a Hillshade - JPEG 2000 file, select it from the drop-down list.  On the Output Tab ,

specify an output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

On the Output tab, set the desired sun 'Azimuth' and 'Altitude' values.  Azimuth is the direction of the

sun (in degrees) - for example, an Azimuth value of 0 (zero) would mean that the sun is due north,

whereas a value of 235 would represent a southwest sun.  Altitude is the angle (in degrees) of the sun
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above the horizon.  For example, an Altitude value of 0 would place the sun directly on the horizon,

while a value of 90 would place it directly overhead.  These values control the shading effect in the

exported rasters.  The default values are Azimuth 315 and Altitude 45.

Example 1 - Hillshade export with Azimuth set to 90 (east sun) and Altitude set to 65 (high sun angle).

Example 2 - Hillshade export with Azimuth set to 235 (southwest sun) and Altitude set to 40 (low sun

angle).
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.
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There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.16 LAS

Export LAS Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'LAS' files: Start by clicking on the 'Export'  button or the 'Export Area' 

button to see the drop-down list of export types.  'Export Area' requires that a drag box be created first

before the drop-down list appears.  This is one of two Export Types (the other is Text - ASCII ) that

supports the By Collection Scan  and By Collection Scan From User-defined Box  layout formats.
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To export an LAS file, select it from the drop-down list.  On the Output Tab , specify an output

directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

740
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to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

 

Point Data Record Format (PDRF) 6, 7, or 8 can be selected for the exported data.

PDRF 6 stores no color values at the point level.  PDRF 7 stores RGB values and PDRF 8 stores RGB

(N) values at the point level.  If the LAS data to be exported is either PDRF 7 or 8 and PDRF 6 is

selected for the export, the exported data will no longer store any color values.

For PDRF 7, three options for 'Write RGB Values from' are enabled: 'Image', 'LAS', and 'Custom

Colorization'.  When choosing the 'Image' option (only available when co-located raster and LAS data

are both loaded into MARS®), the image pixel RGB values will be written to the exported LAS file.

Choosing the 'LAS' option allows existing RGB values to be carried over from the input data to the

exported files.  Choosing the 'Custom Colorization' option enables the ellipse button  which will

open a selection interface.  One of five methods for coloring each class of points can be selected:

current classification color, intensity, class blended with intensity, RGB values from displayed images,

or RGB values from the input LAS file.  This allows each class in the exported LAS file to have RGB

values assigned from different sources.  When the newly-exported LAS file with RGB values is then
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loaded into MARS®, the Color by RGB   tool can be used on the data.

For PDRF 8, two options for 'Write RGB(N) Values from' are enabled:  'Image' and 'LAS' ('Custom

Colorization' is disabled for this export option).  When choosing the 'Image' option (only available when

co-located RGBN (4-band) raster and LAS data are both loaded into MARS®), the image pixel RGBN

values will be written to the exported LAS file.  When the newly-exported LAS file with RGBN values is

then loaded into MARS®, the Color by RGB   tool can be used on the data to see the three

visible color bands.
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When exporting by tiles or collection scans, the multi-threading option is available for this export type. 

It speeds up export by using a specified amount of a computer’s CPU processing power.  The multi-

threading option can be found at the lower-right corner of the export interface.  By default, the text box

will show the maximum number of threads the computer has available for processing.  Leave as is, or

enter a lower number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-

threading the process.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.17 LiDAR Point Density - Float Grid

Export LiDAR Point Density - Float Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

This export type creates a relative point density grid using first returns only.  The result is a color-coded

raster using a blue to red color ramp - deep blue cells are the least dense and red cells are the most

dense.  The only options on the 'Grid' tab that can be set are 'Cell Size' and 'Auto Calculate Virtual Tile

Size' / 'Virtual Tile Size' (see top section of Grid  tab topic for explanations).

Exporting 'LiDAR Point Density - Float Grid' files: Start by clicking on the 'Export'  button

or the 'Export Area'  button to see the drop-down list of export types.  'Export Area' requires

that a drag box be created first before the drop-down list appears.

To export a LiDAR Point Density - Float Grid file, select it from the drop-down list.  On the Output

Tab , specify an output directory where the file should be exported.

783

740



MARS® v2023.1           User Manual716

© 2000-2023 Merrick & Company

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.
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When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.18 LiDAR Spatial Distribution Verification Grid - JPEG 2000

Export LiDAR Spatial Distribution Verification

Grid Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'LiDAR Spatial Distribution Verification GRID - JPEG 2000' files: Start by clicking on

the 'Export'  button or the 'Export Area'  button to see the drop-down list of export

types.  'Export Area' requires that a drag box be created first before the drop-down list appears.

To export a LiDAR Spatial Distribution Verification GRID - JPEG 2000 file, select it from the drop-

down list.  On the Output Tab , specify an output directory where the raster file and the auxiliary text

file should be exported.

740
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If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.
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Additional details on running this export: This export type is to used create a grid that

contains values representing the presence (value=1) or void (value=0) of a first (of any) return LiDAR point

within any portion of a predefined grid cell size.

The 'Number of points required in cell' text box is now enabled.  The user may define the number of

points required within each cell with this text box.  The default number of points in a cell will remain at

‘1’, unless the user specifies differently, to meet USGS specifications.

The 'Exclusion Shapefile' option is meant for use with a polygon shapefile.   A typical polygon

shapefile for use with this tool will contain polygons around all water bodies which may cause the

resulting output grid file to produce a '0' (zero) value.  A '0' value would indicate that no LiDAR point was

discovered inside that particular cell and that cell would then 'fail' the test as described above.  If all the

cells found inside a body of water record a '0' value, it could cause the entire project area to fall below

the 90% pass rate of cells containing a value of 1 (cells which contain at least one point).  Because

LiDAR is absorbed by water, water should be excluded from the test results.  The 'Exclusion Shapefile'

option allows the user to place polygons around any water bodies which may result in a '0' value and

exclude those polygons from the results.  Using this parameter when producing a LiDAR Spatial

Distribution Verification grid is optional.
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The 'Minimum Zero Count to set NODATA value' option may be applied in areas where a large

number of '0' value cells is anticipated, as in the case of a water body.  This option implements a

maximum number of contiguous '0' cells and changes the value of those '0' cells to a value of 'NULL'. 

This will automatically delineate large data void areas such as water bodies.  This option can be used as

an alternative to the 'Exclusion Shapefile' option and accomplishes the same general purpose.  After

checking the 'Minimum Zero Count to set NODATA value' option, the user may enter an integer in

the adjacent text box.  As an example, if the user entered '3' into this text box, the process would look

for three contiguous cells containing a '0' value and change all three to a 'NULL' value.  The purpose of

this option is to create a more accurate pass percentage if no exclusion shapefile exists.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.
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Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all the parameters of the export have been set, click the 'Export' button at the bottom of the

interface to export the file.

When the export has completed successfully, a prompt, as seen below, will appear.

Below is  an example result  of  the LiDAR Spatial  Distribution  Verification  Grid  tool.   The  green  areas

represent cells with a value of '1',  meaning they have at  least  one LiDAR point  within the cell.   The red

areas  represent  cells  with  a  value  of  '0',  meaning  they DO  NOT  contain  any  LiDAR  points.   In  the

example below it  is  easy to see that  there is  a  body of  water  running  through  this  area,  which  is  the

cause of  the red cells  with a '0' value.   If  the user were to implement  the 'Minimum Zero Count' option

when running this  tool,  the  areas  of  contiguous  '0'  cells  (the  water  body)  would  return  a  'NULL'  value

instead of a '0' value.
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The 'LiDAR Spatial Distribution Verification Grid' tool will also output a results text file (*.txt) every time

the tool is used.  This text file will be output to the same location as the JPEG 2000 (the location

specified by the user in the output directory browse box).  The text file will be named beginning with the

date, time, and '...LiDAR_Spatial_Distribution_Verification_Results.txt'.  This allows each *.txt created

to be unique.  For example, the file seen in the screen shot below was produced on February 2, 2011 at

2:45 pm.

The text file will contain the following information: the number of cells with a '0' value, the number of

cells with a '1' value, and the number of value '1' cells as a percentage of the total number of cells.  This

last value will be the percentage of passing cells.  This percentage needs to be 90% or above to be in

compliance with the USGS specifications mentioned above.  The screen shot below shows an example

of the information contained in the text file.
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.

4.5.1.19 PLS-CADD Code - ASCII

Export PLS-CADD Code - ASCII Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'PLS-CADD Code - ASCII' files: Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a

drag box be created first before the drop-down list appears.

To export a PLS-CADD Code - ASCII file, select it from the drop-down list.  On the Output Tab ,

specify an output directory where the file should be exported.
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If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the
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export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

After setting an output directory (and, optionally, a temp folder), move on to the Code Specification

(CSV file) text box.  A *.csv seed file MUST be used in export.  Please specify a code file to be used

by browsing to the appropriate directory.  The PLS-CADD program's codes (often called feature codes)

are related to MARS® classifications.  The only way to reclass or assign multiple PLS-CADD codes to

multiple different MARS® classifications is by use of a *.csv file that 'maps' certain point classes to

specific feature codes.  This file will specify which PLS-CADD code should be assigned which MARS®

point classification(s).  For example, in the CSV file below, the PLS-CADD code '100 Ground Point

Thin' has been assigned the MARS® classification '2', which is typically a ground classification.  If the

PLS-CADD code is to be assigned to more than one MARS® classification, the classifications in

column 'A' need to be separated in the CSV file by a pipe ( '|' ) - a vertical line character created by

holding down the SHIFT key while pressing the backslash ( '\' ) key.  For example, in the CSV file

below, the PLS-CADD code '10000 Ground Point All' has been assigned the MARS® classifications '2 |

8' (2 and 8).  Column B ('PLSCAD CODE' in this example) cannot contain any duplicate values.  The

'Folder' column tells MARS® what to name the sub-folders that will be created in the output directory -

almost any name can be used as long as it is unique within the output folder.  Note that several
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reserved ASCII characters are not allowed as part of a folder name, and cannot be present in the

'Folder' column of the CSV file:  <   >   /   %   &   '   ".  Each sub-folder will contain one (1) CSV file of

the results of a particular class-to-code mapping.

The PLS-CADD Code - ASCII export type allows tiles to be exported by collection scan.  Check the

box labeled 'Output Tiles By Collection Scan' to enable this option (see below).  This export type uses

only the 'Single File' or 'Selected Tile(s)' layout types with the 'Export' tool, or the 'User-defined Box'

layout type with the 'Export Area' tool.

The 'Record Format' section of the 'Layout' tab is available when this export type is chosen. 
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Choose how the text document is to be exported by making specifications in this area.

Record Format: Choose settings in this box that are unique to the PLS-CADD Code - ASCII export

by selecting the attributes which are to be included in export.  If an attribute field is unchecked, it

will not be included in the export.  By default, all fields are selected.

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.

All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used to separate fields in

the output text file.

ASCII File Extension: The user may choose the file extension with which the text file is output.  For

example, the user may choose to export a *.csv or a *.txt file.  Enter the desired extension into

the entry box.

User Field Value: This text box is valid only when the user has selected the 'User Field' attribute for

inclusion.  A value entered here will be applied to all records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are used in the X, Y, and Z

values during export.  The default setting is 2, but values of 1 to 16 can be entered.

When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.
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Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters on every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.1.20 PLS-CADD Code - LAS

Export PLS-CADD Code - LAS Files

Merrick Advanced Remote Sensing (MARS
®

) Software
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Exporting 'PLS-CADD Code - LAS' files: Start by clicking on the 'Export'  button or the

'Export Area'  button to see the drop-down list of export types.  'Export Area' requires that a

drag box be created first before the drop-down list appears.

To export a PLS-CADD Code - LAS file, select it from the drop-down list.  On the Output Tab ,

specify an output directory where the file should be exported.  The output folder will have subfolders

created that are named by two attributes in a polygon shapefile used in the export.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

740
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The 'Use temporary local disk space to speed up processing' option allows the exported file to be

written to the specified 'Output Directory', but uses local disk space to speed up processing.  A typical

situation for this option is when the 'Output Directory' is a network location.  To use this option, check

the 'Use temporary local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is required (for Single File layout

raster exports) and how much free space is in the folder selected.  If there is enough disk space, the

export process will use the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified, an error message will

appear as seen below.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that an actual folder be used for this

option.

After setting an output directory (and, optionally, a temp folder), move on to the Code Specification

(CSV file) text box.  A *.csv seed file MUST be used in export.  Please specify a code file to be used

by browsing to the appropriate directory.  The PLS-CADD program's codes (often called feature codes)

are related to MARS® classifications.  The only way to reclass or assign multiple PLS-CADD codes to
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multiple different MARS® classifications is by use of a *.csv file that 'maps' certain point classes to

specific feature codes.  This file will specify which PLS-CADD code should be assigned which MARS®

point classification(s).  For example, in the CSV file below, the PLS-CADD code '100 Ground Point

Thin' has been assigned the MARS® classification '2', which is typically a ground classification.  If the

PLS-CADD code is to be assigned to more than one MARS® classification, the classifications in

column 'A' need to be separated in the CSV file by a pipe ( '|' ) - a vertical line character created by

holding down the SHIFT key while pressing the backslash ( '\' ) key.  For example, in the CSV file

below, the PLS-CADD code '10000 Ground Point All' has been assigned the MARS® classifications '2 |

8' (2 and 8).  Column B ('PLSCAD CODE' in this example) cannot contain any duplicate values.  The

'Folder' column tells MARS® what to name the sub-folders that will be created in the output directory -

almost any name can be used as long as it is unique within the output folder.  Note that several

reserved ASCII characters are not allowed as part of a folder name, and cannot be present in the

'Folder' column of the CSV file:  <   >   /   %   &   '   ".  Each sub-folder will contain one (1) CSV file of

the results of a particular class-to-code mapping.
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When exporting by tiles, the multi-threading option is available for this export type.  It speeds up export

by using a specified amount of a computer’s CPU processing power.  The multi-threading option can be

found at the lower-right corner of the export interface.  By default, the text box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Move through the remaining tabs to continue making specifications for the export.  This export type

uses only the 'Selected Tile(s)' layout type with the 'Export' tool, or the 'User-defined Box' layout type

with the 'Export Area' tool. 

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters on every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.
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4.5.1.21 Shapefile

Export Point Shapefiles

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Shapefile' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.

To export a Shapefile file (points), select it from the drop-down list.  On the Output Tab , specify an

output directory where the file should be exported.

740
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If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

There is an option with this export type to create a separate shapefile for each selected class that

exists in the loaded LAS data.

The 'Record Format' section of the 'Layout' tab is available when this export type is chosen. 
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Choose how the shapefile attribute table is to be designed by making specifications in this area.

Record Format: Choose settings in this box that are unique to the Shapefile export by selecting the

attributes which are to be included in export.  If an attribute field is unchecked, it will not be

included in the export.  By default, all fields are selected and will be added to the attribute table

in the order listed.

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.

All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be made.

Delimiter: Not used for Shapefile export.

ASCII File Extension: Not used for Shapefile export.

User Field Value: Not used for Shapefile export.

Number of Significant Figures: Not used for Shapefile export.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, and bit-flagged

points from the exported LAS file(s).  Please see the Filters Tab  for more details.774
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When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.  When Shapefiles are exported, a *.prj (projection definition file) is

created if the projection information is defined for the source LAS data.

When the export is complete, the following message will appear.
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4.5.1.22 Text - ASCII

Export Text ASCII Files

Merrick Advanced Remote Sensing (MARS
®

) Software

Exporting 'Text - ASCII' files: Start by clicking on the 'Export'  button or the 'Export Area'

 button to see the drop-down list of export types.  'Export Area' requires that a drag box be

created first before the drop-down list appears.  This is one of two Export Types (the other is LAS )

that supports the By Collection Scan  and By Collection Scan From User-defined Box  layout

formats.

710
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To export a Text - ASCII file, select it from the drop-down list.  On the Output Tab , specify an

output directory where the file should be exported.

If no Output Directory is specified, a prompt will appear as seen below when trying to run the export.

When exporting by tiles or collection scans, the multi-threading option is available for this export type. 

It speeds up export by using a specified amount of a computer’s CPU processing power.  The multi-

threading option can be found at the lower-right corner of the export interface.  By default, the text box

will show the maximum number of threads the computer has available for processing.  Leave as is, or

enter a lower number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-

threading the process.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.

740
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The 'Record Format' section of the 'Layout' tab is available when this export type is chosen. 

Choose how the text document is to be exported by making specifications in this area.

Record Format: Choose settings in this box that are unique to the Text - ASCII export by selecting

the attributes which are to be included in export.  If an attribute field is unchecked, it will not be

included in the export.  By default, all fields are selected.

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.

All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used to separate fields in

the output text file.

ASCII File Extension: The user may choose the file extension with which the text file is output.  For

example, the user may choose to export a *.csv or a *.txt file.  Enter the desired extension into

the entry box.

User Field Value: This text box is valid only when the user has selected the 'User Field' attribute for

inclusion.  A value entered here will be applied to all records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are used in the X, Y, and Z
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values during export.  The default setting is 2, but values of 1 to 16 can be entered.

Move through the remaining tabs to continue making specifications for the export.

There are options with this export type to include/exclude specific classes, returns, collection scans,

and bit-flagged points from the exported LAS file(s).  Please see the Filters Tab  for more details.

When all of the parameters of every tab have been specified, click the 'Export' button at the bottom of

the interface to export the file.

When the export is complete, the following message will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.2 Output tab

Output Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Output tab is where an 'Output Directory' for any export type is selected.  Other options for
specific export types may be found on this tab as well.

774
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Most export types include the 'Save to Local Option' to improve performance when writing the export

to a network drive (for example).  Checking the 'Use temporary local disk space to speed up

processing' box  allows the exported file to be written to the specified 'Output Directory', but uses local

disk space to speed up processing.  Browse to any local folder which has available space - the export

interface will display how much space is required (for Single File layout raster exports) and how much

free space is in the folder selected.  If there is enough disk space, the export process will use the local

space to speed up processing.  NOTE:  Most versions of Windows prohibit an application's output

of files to the root directory of drives.  It is strongly recommended that an actual folder be used

for this option.

Several export types include additional controls and settings on this tab that are unique to the export

being created.  See the Data Export  section of the Help Topics for more information.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.5.3 Layout tab

4.5.3.1 Single File

Single File Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The first option is the 'Single File' format:

'Single File' Export: Exports all data loaded into MARS®
 as a single output file.  No tile layout is

used, even if one is loaded.  Choose this option if tiled output is not desired, but instead, one

single file is needed.  This option is most commonly used with outputting a grid-based surface.  

This Layout format is not available for the 'Contours - Shapefile' export type.

If settings inside the export window have been previously saved, they can be loaded by clicking

the 'Load Settings from File' button and navigating to the saved *.xml file.  To save new

settings, click the 'Save Settings to File' button and an *.xml can be created for later use.
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'File Name' section: Enter a name for the exported file.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will

cause the software to skip exporting of any files which already exist in the specified

output folder.  The software will pick up processing on the first file which is not found

in the output folder.  For this reason it is suggested that if processing stops for any

reason, the last file exported should be deleted from the output folder.  This file may

not have completed, but since the file name exists in the output folder it will be

sk ipped.  Deleting the last file (based on date/time) ensures that it gets exported

correctly and completely.  The 'Overwrite' radio button will cause the software to start
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processing from the beginning and silently overwrite all the files in the output folder.

'Clipping' section:  If the user would like to clip the exported file to a boundary file,

check the 'Clipping Data' check box as shown in the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to

the boundary file to be used in clipping.  The boundary file must be a polygon shapefile.

If the user checks the 'Clipping Data' check box but does not browse to a boundary

file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used.

The screen shot below shows a boundary file (white) loaded into MARS® along

with the sample LAS data before export.
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When the export is complete, the user may then load the new, clipped LAS file

into MARS®.  The newly exported data will be clipped to the boundary shapefile

as seen below. 
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'Record Format' Section: Choose how the text document or attribute table is to be

exported by making specifications in this area.  The 'Record Format' section of the

'Layout' tab is only visible when the 'PLS-CADD Code - ASCII,' 'Shapefile,' or 'Text -

ASCII' export types are selected. 

Record Format: Select the fields or attributes which are to be included in export.

 If an attribute field is unchecked, it will not be included in export.  By default, all

fields are selected. 

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.

All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be

made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used

to separate fields in the output text file.

ASCII File Extension: The user may choose the file extension with which the

text file is output.  For example, the user may choose to export out a *.csv or a *.

txt file.  Enter the desired extension into the available text box.

User Field Value: This text box is valid only when the user has selected the
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'User Field' attribute for inclusion.  A value entered here will be applied to all

records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are

used in the X, Y, and Z values during export.  The default setting is 2, but values

of 1 to 16 can be entered.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters.  When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.2 All Tiles using MBR

All Tiles using MBR Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The second option is the 'All Tiles using MBR' format:

'All Tiles using MBR' Export: Exports all data loaded into MARS® by creating a minimum bounding

rectangle (MBR) for each tile (polygon) in the loaded shapefile tile layout. The user would

choose this option if they wanted to export all of the polygons that are found in the loaded

shapefile tile layout, but in the fastest manner possible.  This choice determines the minimum

bounding rectangle of each polygon; for example, if the user loaded a shapefile of circles as the

tile layout, the output data would be square shaped.  Frequently, township/range shapefiles are
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used as tiles - these are often slanted from true north and could take more time to process as

an export tile layout.  If the user does not mind overlapping data, they may want to choose the

MBR layout to speed up this export process since exporting to a slanted tile layout can be

slower.

The multi-threading option is available for most export types when using the 'Selected Tile(s)'

layout format.  It speeds up export by using a specified amount of a computer’s CPU

processing power.  The multi-threading options can be found at the lower-right corner of the

export interface.  By default, the text box will show the maximum number of threads the

computer has available for processing. Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

If settings inside the export window have been previously saved, they can be loaded by clicking

the 'Load Settings from File' button and navigating to the saved *.xml file.  To save new

settings, click the 'Save Settings to File' button and an *.xml can be created for later use.
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'File Name' section: Output files will be named based on the 'DB Field' chosen in the

'Tile Shapefile' section, below.  An optional 'Prefix' and/or 'Suffix' may be added to the

name.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will

cause the software to skip exporting of any files which already exist in the specified

output folder.  The software will pick up processing on the first file which is not found

in the output folder.  For this reason it is suggested that if processing stops for any

reason, the last file exported should be deleted from the output folder.  This file may

not have completed, but since the file name exists in the output folder it will be
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sk ipped.  Deleting the last file (based on date/time) ensures that it gets exported

correctly and completely.  The 'Overwrite' radio button will cause the software to start

processing from the beginning and silently overwrite all the files in the output folder.

'Tile Shapefile' section:  Browse to the tile shapefile to be used for export. Use the

'DB Field' drop-down box to specify which attribute field should be used to name the

tiles in the new shapefile. See the example below:

If the user attempts to export data using the 'All Tiles using MBR' format and no tile

shapefile has been specified, the user will be prompted to point to a tile shapefile by

a window as seen below:

'Clipping' section:  If the user would like to clip the exported tiles to a tile boundary
or irregularly shaped boundary file, check the 'Clipping Data' check box as shown in
the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to
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the boundary file to be used in clipping. The boundary file must be a polygon shapefile.

If the user checks the 'Clipping Data' check box but does not browse to a boundary

file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used.  

'Record Format' Section: Choose how the text document or attribute table is to be

exported by making specifications in this area.  The 'Record Format' section of the

'Layout' tab is only visible when the 'PLS-CADD Code - ASCII,' 'Shapefile,' or 'Text -

ASCII' export types are selected. 

Record Format: Select the fields or attributes which are to be included in export.

 If an attribute field is unchecked, it will not be included in export.  By default, all

fields are selected. 

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.
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All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be

made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used

to separate fields in the output text file.

ASCII File Extension: The user may choose the file extension with which the

text file is output.  For example, the user may choose to export out a *.csv or a *.

txt file.  Enter the desired extension into the available text box.

User Field Value: This text box is valid only when the user has selected the

'User Field' attribute for inclusion.  A value entered here will be applied to all

records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are

used in the X, Y, and Z values during export.  The default setting is 2, but values

of 1 to 16 can be entered.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.3 All Tiles

All Tiles Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being
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performed.  The third option is the 'All Tiles' format:

'All Tiles' Export: Exports data to the exact shape of each tile in the loaded tile layout.  This choice

can be used with any type of polygon (irregular shaped, rectangular, square, circular, etc.).  This

method of exporting will perform a point-in-polygon analysis so it will typically be slower than the

'All Tiles using MBR' format.  A user would choose this export type if they had specific, non-

square or non-rectangular shapefile tiles such as a jurisdictional boundary shapefile.

The multi-threading option is available for most export types when using the 'Selected Tile(s)'

layout format.  It speeds up export by using a specified amount of a computer’s CPU

processing power.  The multi-threading options can be found at the lower-right corner of the

export interface.  By default, the text box will show the maximum number of threads the

computer has available for processing. Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

If settings inside the export window have been previously saved, they can be loaded by clicking

the 'Load Settings from File' button and navigating to the saved *.xml file.  To save new

settings, click the 'Save Settings to File' button and an *.xml can be created for later use.
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'File Name' section: Output files will be named based on the 'DB Field' chosen in the

'Tile Shapefile' section, below.  An optional 'Prefix' and/or 'Suffix' may be added to the

name.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will cause

the software to skip exporting of any files which already exist in the specified output

folder.  The software will pick up processing on the first file which is not found in the

output folder.  For this reason it is suggested that if processing stops for any reason,

the last file exported should be deleted from the output folder.  This file may not have

completed, but since the file name exists in the output folder it will be sk ipped. 
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Deleting the last file (based on date/time) ensures that it gets exported correctly and

completely.  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

'Tile Shapefile' section:  Browse to the tile shapefile to be used for export. Use the

'DB Field' drop-down box to specify which attribute field should be used to name the

tiles in the new shapefile. See the example below:

If the user attempts to export data using the 'All Tiles' format and no tile shapefile has

been specified, the user will be prompted to point to a tile shapefile by a window as

seen below:

'Clipping' section:  If the user would like to clip the exported tiles to a tile boundary
or irregularly shaped boundary file, check the 'Clipping Data' check box as shown in
the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to
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the boundary file to be used in clipping. The boundary file must be a polygon shapefile.

If the user checks the 'Clipping Data' check box but does not browse to a boundary

file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used. 

'Record Format' Section: Choose how the text document or attribute table is to be

exported by making specifications in this area.  The 'Record Format' section of the

'Layout' tab is only visible when the 'PLS-CADD Code - ASCII,' 'Shapefile,' or 'Text -

ASCII' export types are selected. 

Record Format: Select the fields or attributes which are to be included in export.

 If an attribute field is unchecked, it will not be included in export.  By default, all

fields are selected. 

Up: Moves the highlighted field higher in the list.

Down: Moves the highlighted field lower in the list.
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All On: Selects all fields for inclusion in the export.

All Off: Unselects all fields so that individual selections can more easily be

made.

Delimiter: The options are: SPACE, TAB, and COMMA (the default) to be used

to separate fields in the output text file.

ASCII File Extension: The user may choose the file extension with which the

text file is output.  For example, the user may choose to export out a *.csv or a *.

txt file.  Enter the desired extension into the available text box.

User Field Value: This text box is valid only when the user has selected the

'User Field' attribute for inclusion.  A value entered here will be applied to all

records in the export.  The default value is 1.

Number of Significant Figures: Specifies how many significant figures are

used in the X, Y, and Z values during export.  The default setting is 2, but values

of 1 to 16 can be entered.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.4 Single File From Selected Tiles

Single File From Selected Tiles Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being
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performed.  The fourth option is the 'Single File From Selected Tiles' format:

'Single File From Selected Tiles' Export: Exports a single file from selected input tiles or polygons

chosen with the 'Pick Tiles'  button.  This Layout format is only available with the 'LAS' and

'Shapefile' export types.  The user would choose this export type if they wanted to export only a single

file from the selected tile(s).  This export type is available when one or more tiles are selected for

export using the Pick Tiles  tool.

Select the 'Pick Tiles' tool as shown in the screen shot above and then click on the tile(s) to be

exported. (See the Pick Tiles  topic for more information on how to pick a single, or multiple, tiles.)

When the tiles have been chosen, click the 'Export'  button and select an export type from the

drop-down list that appears.  Click the 'OK' button and the export interface will appear:

959

959
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To help speed up export, use the multi-thread options found at the bottom of the export window.  Note

that not all export types allow multi-threaded processing.  If the user chooses to multi-thread the

export process, a text box will become available populated with the maximum amount of threads

available for processing.  Enter the number of threads to be used.  For best performance, there should

be a minimum of eight (8) GB of RAM available (not just installed) per thread.

 

If settings inside the export window have been previously saved, they can be loaded by clicking the
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'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.

'File Name' section: Designate a new name for the exported file.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will cause

the software to skip exporting of any files which already exist in the specified output

folder.  The software will pick up processing on the first file which is not found in the

output folder.  For this reason it is suggested that if processing stops for any reason,

the last file exported should be deleted from the output folder.  This file may not have

completed, but since the file name exists in the output folder it will be sk ipped. 

Deleting the last file (based on date/time) ensures that it gets exported correctly and

completely.  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

'Clipping' section:  If the user would like to clip the exported file to a boundary file,
check the 'Clipping Data' check box as shown in the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to

the boundary file to be used in clipping. The boundary file must be a polygon shapefile.

If the user checks the 'Clipping Data' check box but does not browse to a boundary
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file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used.  

When exporting data by tile when the shapefile contains complex polygons (multi-part polygons), the

'Complex Polys to Simple' tool may be useful. To learn more about this tool visit the Tools Tab

topic and see the appropriate section.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.5 Selected Tile(s)

Selected Tile(s) Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The fifth option is the 'Selected Tile(s)' format:

390
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'Selected Tile(s)' Export: Exports one or more tiles at a time that are preselected in the MARS®

window from a loaded tile shapefile using the Pick Tiles  tool. A user would choose this export type

if they only wanted to export some, and not all, tiles from a loaded tile layout.

To use the 'Selected Tile(s)' method of export, the user must first load a tile shapefile. Next, the tile(s)

for export must be defined. The user may do this by using the 'Pick Tiles'   tool. 

Select the 'Pick Tiles' tool as shown in the screen shot above and then click on the tile(s) to be

exported. (See the Pick Tiles  topic for more information on how to pick a single, or multiple, tiles.)

When the tiles have been chosen, click the 'Export'  button and select an export type from the

drop-down list that appears.  Click the 'OK' button and the export interface will appear:

959

959
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The multi-threading option is available for most export types when using the 'Selected Tile(s)' layout

format.  It speeds up export by using a specified amount of a computer’s CPU processing power.  The

multi-threading options can be found at the lower-right corner of the export interface.  By default, the text

box will show the maximum number of threads the computer has available for processing. Leave as is, or

enter a lower number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-

threading the process.  For best performance, there should be a minimum of eight (8) GB of RAM 

available (not just installed) per thread.
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If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click the

'Save Settings to File' button and an *.xml can be created for later use. 

'File Name' section: Output files will be named based on the 'DB Field' chosen in the

'Tile Shapefile' section, below.  An optional 'Prefix' and/or 'Suffix' may be added to the

name.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will cause

the software to skip exporting of any files which already exist in the specified output

folder.  The software will pick up processing on the first file which is not found in the

output folder.  For this reason it is suggested that if processing stops for any reason,

the last file exported should be deleted from the output folder.  This file may not have

completed, but since the file name exists in the output folder it will be sk ipped. 

Deleting the last file (based on date/time) ensures that it gets exported correctly and

completely.  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

'Tile Shapefile' section:  Since a tile shapefile has to be loaded in order to select a

tile for this export, the tile shapefile should be automatically populated in the 'File' text
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box in this section. Use the 'DB Field' drop-down box to specify which attribute field

should be used to name the tiles in the new shapefile.

'Clipping' section:  If the user would like to clip the exported tiles to a boundary file,
check the 'Clipping Data' check box as shown in the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to

the boundary file to be used in clipping. The boundary file must be a polygon shapefile.

If the user checks the 'Clipping Data' check box but does not browse to a boundary

file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used. 

When exporting data by tile when the shapefile contains complex polygons (multi-part polygons), the

'Complex Polys to Simple' tool may be useful. To learn more about this tool, visit the Tools Tab

topic and see the appropriate section.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.
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4.5.3.6 User-defined Box

User-defined Box Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The sixth option is the 'User-defined Box' format (selected by default when using the

Export Area  tool):

'User-defined Box' Export: Exports data from a user-defined rectangle using the Export Area  tool.

A user would choose this if they do not want to manage the exported data by a tile layout, nor do they

want to export all of the loaded data as a single file, but they may have a specific area that they want

exported.

To use the 'User-defined Box' method of export, the user must first define the area for export. This is

done by using the 'Export Area'  tool. 

Select the tool and drag a box over the area to be exported by left-clicking in the upper-left corner of

the area and dragging a rectangular box to the lower-right corner of the area.  The Export Type

Selection drop-down list will appear when the mouse button is released.  Select a type and click the

'OK' button to open the export interface.  Notice the default Format selection on the 'Layout' tab is

'User-defined Box'.

658
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If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.

'File Name' section: Designate a new name for the exported file.  The default name

is 'ExportArea'.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error
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occurs, etc.).  When the user starts processing again, selecting this button will cause

the software to skip exporting of any files which already exist in the specified output

folder.  The software will pick up processing on the first file which is not found in the

output folder.  For this reason it is suggested that if processing stops for any reason,

the last file exported should be deleted from the output folder.  This file may not have

completed, but since the file name exists in the output folder it will be sk ipped. 

Deleting the last file (based on date/time) ensures that it gets exported correctly and

completely.  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

'Clipping' section:  Disabled for this Layout format for all export types.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.7 By Collection Scan

By Collection Scan Export

Merrick Advanced Remote Sensing (MARS
®

) Software
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The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The seventh option is the 'By Collection Scan' format:

'By Collection Scan' Export: Exports the loaded data by actual collection scans that are defined

internally in the LAS file(s).  The result will be one file for each collection scan number. If settings

inside the export window have been previously saved, they can be loaded by clicking the 'Load

Settings from File' button and navigating to the saved *.xml file.  To save new settings, click the

'Save Settings to File' button and an *.xml can be created for later use.

(Note: The 'By Collection Scan' Layout format is available only when the 'LAS' or 'Text - ASCII' types

are chosen from the Export Type Selection drop-down list.  For collection scan exports on user defined

areas, see By Collection Scan From User-defined Box .)772
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'File Name' section: Manual entry of a File Name is disabled for this layout type. 

Output files will be named based on the internally-stored collection scan number with

an optional Prefix and Suffix.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will

cause the software to skip exporting of any files which already exist in the specified

output folder.  The software will pick up processing on the first file which is not found

in the output folder.  For this reason it is suggested that if processing stops for any

reason, the last file exported should be deleted from the output folder.  This file may

not have completed, but since the file name exists in the output folder it will be
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sk ipped.  Deleting the last file (based on date/time) ensures that it gets exported

correctly and completely.  The 'Overwrite' radio button will cause the software to start

processing from the beginning and silently overwrite all the files in the output folder.

'Clipping' section:  If the user would like to clip the exported files to a tile boundary
or irregularly shaped boundary file, check the 'Clipping Data' check box as shown in
the example below: 

Checking this box will enable the 'Boundary File' text box, and the user can browse to

the boundary file to be used in clipping.  The boundary file must be a polygon shapefile.

 If the user checks the 'Clipping Data' check box but does not browse to a boundary

file to be used, the user will be prompted by the window seen below.  Any buffer set on

the 'Options' tab will be ignored when a clipping boundary is used.  

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.



MARS® v2023.1           User Manual772

© 2000-2023 Merrick & Company

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.3.8 By Collection Scan From User-defined Box

By Collection Scan From User-defined Box

Export

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Layout' tab has many different export format options, depending on the Export Type being

performed.  The eighth and final option is the 'By Collection Scan From User-defined Box' format

(available only when using the Export Area  tool):

'By Collection Scan From User-defined Box' Export: Exports the loaded data by actual collection

scans that are defined internally in the LAS file(s).  The result will be one file for each collection scan

number in the dragged area.

If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.

(Note: The 'By Collection Scan From User-defined Box' Layout format is available only when the 'LAS'

or 'Text - ASCII' types are chosen from the Export Type Selection drop-down list.  For collection scan

exports from all loaded data, see By Collection Scan .)
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'File Name' section: Manual entry of a File Name is disabled for this layout type.

Output files will be named based on the internally-stored collection scan number with

an optional Prefix and Suffix.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some

reason processing is stopped (e.g.: power goes out, computer shuts down, an error

occurs, etc.).  When the user starts processing again, selecting this button will

cause the software to skip exporting of any files which already exist in the specified

output folder.  The software will pick up processing on the first file which is not found

in the output folder.  For this reason it is suggested that if processing stops for any

reason, the last file exported should be deleted from the output folder.  This file may

not have completed, but since the file name exists in the output folder it will be
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sk ipped.  Deleting the last file (based on date/time) ensures that it gets exported

correctly and completely.  The 'Overwrite' radio button will cause the software to start

processing from the beginning and silently overwrite all the files in the output folder.

'Clipping' section:  Disabled for this Layout format for all export types.

Once all the parameters in the 'Layout' tab have been defined, move to the other tabs to further

specify the export parameters. When all parameters have been set, click on the 'Export' button to

start the exporting process.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.4 Filters tab

Filters Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Filters tab allows the user to specify which classes, returns, and bit-flagged points should be

used in export.  Many export types have specific default settings for these parameters.  For the 'LAS'

 and 'Flightline Separation - JPEG 2000'  export types, there is also a section to select specific

collection scans to be included.

'Filters' tab: Select which classes are to be included in the new file. Do this by clicking on the

710 668
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'Select Classes' button. If there are specific classes to be used in the export, make sure the 'Using

classification set' box is checked to include the classes chosen in export. 

For the '3D Image ' export type, two sets of classes can be selected - one set for ground and/or

other classes that need to be represented as high-density gridded points (LAS Grid Export), and one

set for any remaining above-ground classes (LAS Point Export).

662



MARS® v2023.1           User Manual776

© 2000-2023 Merrick & Company

The user can select which returns will be used in the export by checking the 'Using return set' box

and clicking the 'Select Returns' button.  Some export types will have pre-selected returns set:  for

example, when exporting a 'Flightline Separation - JPEG 200' file returns are set to 'Last' by default

(but can be modified).  See the 'Display Selection: Return' section of the View Tab  help topic for

information on making selections for this interface.

192
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For the 'LAS' and 'Flightline Separation - JPEG 2000' export types (only), the user can select

which collection scans will be included in the export.  See the 'Display Selection: Collection Scan'

section of the View Tab  help topic for information on making selections for this interface.192
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Finally, a 'Bit Flags' section is available to select which bit-flagged points will be included in the

export.  Bit flag options are Synthetic, Withheld, Overlap, and Edge of Collection Scan.  An option,

'Flagged points only' exists to limit the export to only those points that have the included bit flags set

to 'on'.  The possible export scenarios regarding bit flags are:

1. If the ‘Include’ box is unchecked, only non-flagged points will be exported that meet the
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other criteria (class, return, and collection scan).
2. If the ‘Include’ box is checked and the ‘Flagged points only’ box is unchecked, all points

that meet the other criteria will be exported regardless of bit flag status.
3. If the ‘Include’ box is checked and the ‘Flagged points only’ box is checked, only bit-

flagged points will be exported that meet the other criteria (class, return, and collection
scan).

Some export types have the various checkboxes pre-set, but these can be modified as needed.

 

If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.  Move on to the

'Options' tab.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.5 Options tab

Export Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Options' tab has three functions:

1. It allows the user to define a buffer area around the area to be exported.  The larger the buffer

around the exported area the more precisely the data can be exported, but the larger the buffer the

longer the export     process will take.  If a buffer is desired, check the 'Use Buffer' box and enter

the 'Buffer Size' value (in project units) to be used.  Buffer settings do not apply to a clipping boundary

(if used).

2. A checkbox allows most exported data, rasters, or vectors (shapefiles) to be automatically

loaded into the LAS Map View  window upon completion.  The two PLS-CADD Code export types145
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as well as the 'Grid -     Esri ASCII Grid' export type do not allow this option since the loading of their

outputs is not supported by MARS®.  In addition, the *.dat files created by the 'Grid - ENVI Elev' and

'Grid - ENVI Elev/Class' export     types are not automatically loaded, but can be manually loaded as

Rasters .

3. There is an option to export without loading the LAS data into the LAS Map View window first.

 A source file list can be built and modified when the 'Export without loading LAS files into Map View'

box is     checked.  This option will ignore any loaded LAS files when producing the

export.  Be sure to select the desired output LAS and Point Data Record Format choices on the

'Export Type' tab as they are not     read from the listed data!

If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.  Move on to the

'Transforms' tab if applicable.

83



MARS® v2023.1           User Manual782

© 2000-2023 Merrick & Company

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.6 Transforms tab

Transformation Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Transforms tab is used to apply a multiplier and/or shift to the X, Y, and/or Z coordinate values of

the exported data.  This tab is available only for the 'Contours - Shapefile', 'LAS', and 'Text - ASCII'

export types.

'Transforms' tab: The exported data can be transformed by multiplying/dividing (Multiplier) and/or

adding/subtracting (Shift) by user-definable values.  The functions are enabled by checking the box(es)

- 'X Transform', 'Y Transform', or 'Z Transform' - for the coordinate(s) to be transformed and entering the

desired vale(s).  If only a Multiplier or a Shift is to be performed for any or all coordinates, leave the

other entry box empty.  If both a Multiplier and a Shift are to be performed, make entries in both boxes

- the order of operations will be Multiplier first, then Shift.  If settings inside the export window have

been previously saved, they can be loaded by clicking the 'Load Settings from File' button and

navigating to the saved *.xml file.  To save new settings, click the 'Save Settings to File' button and

an *.xml can be created for later use.  After moving through all the tabs in the Export window, click 

'Export' to export the data.
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4.5.7 Grid tab

Grid Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Grid tab allows for control of the parameters relevant to grid-based exports.

'Grid' tab: Enter the desired grid settings.  If settings inside the export window have been previously

saved, they can be loaded by clicking the 'Load Settings from File' button and navigating to

the saved *.xml file.  To save new settings, click the 'Save Settings to File' button and an *.

xml can be created for later use.  When the options of every tab in the Export window have been

set, click the 'Export' button at the lower-right of the interface.
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'Cell size' - The cell size represents the size of the grid cells produced. (EX. 3 = 3 unit grid, 10 = 10

unit grid)

'Grid Smoothing Count' - Sets a Gaussian smoothing factor. (EX. a smaller number will use less
smoothing and a larger number will use more smoothing.)

'NODATA Value' - Cells with null values will be given a default value of -9999 unless otherwise

specified.  See the Intensity 'Grid Type' section below for exceptions.
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'Auto Calculate Virtual Tile Size' / 'Virtual Tile Size' - Used to allow processing of manageable

data sizes in RAM. A computer with less available RAM needs smaller virtual tile sizes to complete

the export, whereas one with more available RAM can use larger virtual tile sizes to speed up the

export . This optional tool can optimize internal processing based on average Point Density, available

RAM, and the number of threads chosen to be used during the export.  If unchecked, a virtual tile size

(in project units) can be entered manually (virtual tile sizes must be evenly divisible by the cell size).

Note that entering a value too large for the computer's capabilities may cause the export to hang or

crash.

'Grid Type'- There are five (5) basic grid types, depending on the export type selected:

1) Elevation: Populates the cell values of the grid from the LiDAR dataset's elevation values.

This is the default option for most grid-based export types, and the only option when the

export type is 'Grid - Cloud Optimized GeoTIFF DEM'.

2) Intensity (of LIDAR return): Populates the cell values of the grid from the LiDAR dataset's

intensity values.  This is the only option for 'Grid Type' when 'Grid - Cloud Optimized

GeoTIFF Intensity' is selected as the export type.  Typically used as an option with the

'Grid - TIFF' and 'Grid - IMG' export types, but can also be selected for 'Grid - Esri ASCII

Grid' and 'Grid - Float Grid' raster exports.

There is one exclusive option associated with the Intensity Grid Type - the intensity can

be stretched over an entire exported dataset area (this is the default).  When enabled, a
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selection can be made between stretching methods: 'Standard Deviation (2x)' or 'Simple

Min/Max'.  In addition, the following applies to 'Grid - IMG' and 'Grid - TIFF' export types

when the 'Grid Type' is Intensity:

a.)  If the ‘Data Type’ selected is ‘Unsigned 8’ and the ‘Stretch intensity’ box is

checked, the NODATA Value will default to ‘255’ but can be changed to ‘0’.  If NODATA

is set to 

‘255’, cell values will be stretched between 0 and 254.  If NODATA is set to

‘0’, values will be stretched between 1 and 255.

b.)  If the ‘Data Type’ selected is ‘Unsigned 16’ and the ‘Stretch intensity’ box

is checked, the NODATA Value will be set to ‘65535’ and cannot be modified.  Cell

values will be 

stretched between ‘0’ and 65520’ (the highest value that can exist when

normalizing 12-bit intensity data).

3) Color by Collection Scan Separation: This grid type is available when either the 'Flightline

Separation - JPEG 2000' or 'Flightline Separation - Tiled GeoTIFF' export type is chosen. 

These export types produce rasters based on the relative height (Z) differences between

LiDAR data in overlapping/sidelapping areas.  The overlap area differences are color coded,

allowing immediate detection of relative vertical accuracy problems.  The non-overlapping

areas will show Intensity  gridded data for reference purposes only.  These export types

are useful for rapidly assessing the consistency of the LiDAR dataset's height and can be

useful in boresighting.  Over hard surfaces (such as roads) the user can expect the vertical

height (elevation) of points within the same 'cell' to be very similar regardless of the LiDAR

collection scan from which the data originates.  Differences are an indicator of a potential

mission anomaly (typically a GPS/IMU problem) or a post-processing data adjustment issue.

 In areas such as forests or fields, where vegetation growth varies according to the time of
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year, understandable error may be seen.  The overlaid collection scan separation coloration

will have a 50% transparency set so that the output raster will still have some feature

definition visibility from the background Intensity layer.  For more information on these tools

and to see them being used in the QA/QC process, please visit the Color By Collection Scan

Separation  topic.

i. 'Flightline Separation - JPEG 2000' export type:

a) With the lidar data and tile layout shapefile loaded, click either the 'Export' button

 (Single File export of the entire loaded dataset), or the 'Export Area'

button  (User-defined Box) to select the area which will be colored by

collection scan separation. (For more information on the use of these tools,

please see the Data Export  section.)  Select 'Flightline Separation - JPEG

2000' from the drop-down list of export types and click the 'OK' button.

b) When the export interface opens, click on the 'Output' tab and browse to an 'Output

Directory' to specify where the raster should be exported. The 'Use temporary

local disk space to speed up processing' option allows the exported raster to

be written to the specified 'Output Directory', but uses local disk space to

speed up processing.  A typical situation for this option is when the 'Output

Directory' is a network location.  To use this option, check the 'Use temporary

local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is

required (for Single File layout raster exports) and how much free space is in

the selected folder.  If there is enough disk space, the export process will use

the local space to speed up processing.  If the 'Use temporary local disk space

1555
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to speed up processing' box is checked but a temporary folder is not specified,

an error message will appear as seen below.  NOTE:  Most versions of

Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that an actual folder be used for this

option. 

An additional option in the lower part of the 'Output' tab allows for producing a

measurable vertical separation value (RMSDz) for the collection scan

separation by limiting the analysis to areas of single returns.  See the Flightline

Separation - JPEG 2000  export topic for more details).  

c) Select the classifications, returns, and collection scans for export on the 'Filters' tab.

At least one class, return type, and collection scan must be selected for export

to take place.  By default, all classes and collection scans are used, but only

Last Return points.  If the ‘Measurable RMSDz FSR’ option is used (see the

Flightline Separation - JPEG 2000  topic), then Single Returns are used

instead.  Note that 'Withheld' bit-flagged points are excluded by default from

this export type.

d) The 'Multi-Threading' option is available for this export type.  It speeds up export by

using a specified amount of a computer’s CPU processing power.  By default,

the text box will show the maximum number of threads the computer has

available for processing.  Leave as is, or enter a lower number of threads to be

668
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used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of

RAM available (not just installed) per thread.

e) There are several settings and options on the 'Grid' tab.  The user also has the

option to 'Create Z Diff TIFF file used to calculate RMSDZ' by checking the

labeled box.  This option creates an elevation TIFF grid of the resulting RMSD
Z

calculation.  Click on the 'Colors Options' button to define the elevation

increment and color representation options as seen in the screen shots below,

then click 'OK.'
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Elevation increment: Specify here how many elevation units should be between

principal colors.  To test against the USGS LiDAR specification (for example, less

than or equal to 8cm Z difference), a value of '0.08' should be entered for projects in

meters so that green raster cells would show compliance with the specification -

yellow, orange, and red would not.  Projects in feet should use a value of '0.26'.

Use Intensity Threshold: Check this box to set high and low intensity value ranges.

Pixels meeting these criteria will be rendered in magenta and blue, respectively, and

will be displayed on top of collection scan separation rendered pixels.

Stretch Intensity: Uncheck to disable intensity stretching for the background image

of the raster. 

Display cutoff value: The user has the option of entering a unit value in this text box

which would be considered out of the realm of possibility.  For example, in one
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collection scan a car may have been present from which LiDAR returns were

collected.  In the next collection scan the car is absent, and LiDAR points were

collected from the road which was beneath the car.  Because the two collection

scans collected slightly different data, they will vary vertically in this area.  The

'Display cutoff value' text box will tell the software to ignore data outside this value

range.  In this way entering a value of '1.0' meters, for example, the vertical

discrepancy between a car versus no car will be ignored.  A good starting point for

this value is 10 times the ‘Elevation increment’.

Transparency (0-100): The user can set the transparency of the collection scan

separation coloration over the output raster.  The default value is set to 50. As stated

in the interface itself, a value of 0 would show no intensity image and only show the

collection scan separation coloration.  A value of 100 would show the intensity image

only and show no collection scan separation coloration.

By default, a TIN will be created from which the final raster is made.  As noted on the

interface, this method is the most accurate but also the slowest.  Using the Grid option

can save time but may produce false excess-separation values depending on the area's

terrain.

When all settings have been made on all tabs, click on the 'Export' button to export the

data by collection scan separation.  

Example: The Color by Collection Scan Separation grid type has been used on the data

below which is shown as a JPEG 2000 raster image.  The collection scan overlap is

represented by the colored sections of data.  There is a cross scan included in this

example which runs East-West rather than the North-South pattern of the main
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collection scans.  The areas between overlaps are shown in intensity-only (gray-scale)

rendering.  

Example: As defined by the user in the 'Collection Scan Separation Colors Options'

window, the colors in the example below represent varying amounts of elevation (Z)

difference.  Green represents areas with the least amount of Z difference between the

collection scans, whereas red areas indicate the largest amounts of Z difference. 

These red (and even orange) areas are indicators of possible problems with the GPS,

IMU, or post-processing data adjustment.  In this example, the Color by Collection Scan

Separation tool has colored a lake red.  For this particular project, the East-West cross

scan was flown a month after the other collection scans and the red coloration is

explained by the water level of the lake being different for each flight date.  On the other

hand, the road by the lake should be at the same elevation in both collection scans. 

The road is green, indicating that the cross scan and overlapping North-South collection

scan are properly boresighted. 
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There will be one raster file exported to the specified output folder unless the 'Create Z

Diff TIFF file used to calculate RMSDZ' option was checked for export, in which case

an elevation TIFF grid and a TXT file (with numeric results) will also be saved:

1.) A JPEG 2000 raster image, or *.jp2, which will allow the user to

access the collection scan separation results as a raster image.  The

user must remember that this thematic rendering represents values of

separation between two collection scans and is not representative of

distance values.  An example of a JPEG 2000 raster image may be

seen above.

2.) An Elevation TIFF Grid, or *.tif, file which will contain the EXACT

values of separation for each colored cell in the collection scan

separation export (JPEG 2000, above).  This file is only saved if the

user has checked the 'Create Z Diff TIFF file used to calculate

RMSDZ' option on the 'Grid' export tab.

3.) A *.txt (or text) file, which will contain the numerical results of the

collection scan separation export including the calculated RMSDZ
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value.  Below is a screen shot of a sample .txt file. This file is only

created if the user has checked the 'Create Z Diff TIFF file used to

calculate RMSDZ' option on the 'Grid' export tab.  This TXT file is

always created and saved when the 'Measurable RMSDz FSR' option

(on the "Export Type' tab) is used (see the Flightline Separation - JPEG

2000  topic).

The resulting JPEG 2000 raster file can be automatically loaded in MARS® when the

export is complete if the box for that option has been checked on the Options  tab.

ii.  'Flightline Separation - Tiled GeoTIFF' export type:

a) With the lidar data and tile layout shapefile loaded, click the 'Export' button 

to see the drop-down list of export types.  Select 'Flightline Separation - Tiled

GeoTIFF' from the drop-down list of export types and click the 'OK' button.

b) When the export interface opens, click on the 'Output' tab and browse to an 'Output

Directory' to specify where the tiled raster(s) should be exported. The 'Use

temporary local disk space to speed up processing' option allows the exported

raster(s) to be written to the specified 'Output Directory', but uses local disk

space to speed up processing.  A typical situation for this option is when the

'Output Directory' is a network location.  To use this option, check the 'Use

temporary local disk space to speed up processing' box.  Browse to any local

folder which has available space - the export interface will display how much

space is required and how much free space is in the selected folder.  If there is
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enough disk space, the export process will use the local space to speed up

processing.  If the 'Use temporary local disk space to speed up processing' box

is checked but a temporary folder is not specified, an error message will appear

as seen below.  NOTE:  Most versions of Windows prohibit an application's

output of files to the root directory of drives.  It is strongly recommended

that an actual folder be used for this option. 

c) Select the classifications, returns, and collection scans for export on the 'Filters' tab.

At least one class, return type, and collection scan must be selected for export

to take place.  By default, all classes and collection scans are used, but only

Last Return points.  Note that 'Withheld' bit-flagged points are excluded by

default from this export type.

d) The 'Multi-Threading' option is available for this export type.  It speeds up export by

using a specified amount of a computer’s CPU processing power.  By default,

the text box will show the maximum number of threads the computer has

available for processing.  Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of

RAM available (not just installed) per thread.
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e) There are several settings and options on the 'Grid' tab.  Click on the 'Colors

Options' button to define the elevation increment and color representation

options as seen in the screen shots below, then click 'OK.'

Elevation increment: Specify here how many elevation units should be between
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principal colors.  To test against the USGS LiDAR specification (for example, less

than or equal to 8cm Z difference), a value of '0.08' should be entered for projects in

meters so that green raster cells would show compliance with the specification -

yellow, orange, and red would not.  Projects in feet should use a value of '0.26'.

Use Intensity Threshold: Check this box to set high and low intensity value ranges.

Pixels meeting these criteria will be rendered in magenta and blue, respectively, and

will be displayed on top of collection scan separation rendered pixels.

Stretch Intensity: Uncheck to disable intensity stretching for the background image

of the raster. 

Display cutoff value: The user has the option of entering a unit value in this text box

which would be considered out of the realm of possibility.  For example, in one

collection scan a car may have been present from which LiDAR returns were

collected.  In the next collection scan the car is absent, and LiDAR points were

collected from the road which was beneath the car.  Because the two collection

scans collected slightly different data, they will vary vertically in this area.  The

'Display cutoff value' text box will tell the software to ignore data outside this value

range.  In this way entering a value of '1.0' meters, for example, the vertical

discrepancy between a car versus no car will be ignored.  A good starting point for

this value is 10 times the ‘Elevation increment’.

Transparency (0-100): The user can set the transparency of the collection scan

separation coloration over the output raster.  The default value is set to 50. As stated

in the interface itself, a value of 0 would show no intensity image and only show the

collection scan separation coloration.  A value of 100 would show the intensity image

only and show no collection scan separation coloration.

By default, a Hybrid of TIN (for ground points) and Grid (for non-ground points) is used
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in creating the final rasters to give the best combination of usability and speed.  TIN and

Grid can also be selected individually.  As noted on the interface, the TIN method is

generally the most accurate but also the slowest.  However, it may introduce some

undesirable raster artifacts if there are outlier points from a swath that are at a greater-

than-normal-spacing distance from the rest of the swath they belong to.  Using the Grid

option can save time but may produce false excess-separation values depending on the

area's terrain.

When all settings have been made on all tabs, click on the 'Export' button to export the

data by tiled collection scan separation.

4) LiDAR Spatial Distribution Density Verification: This option is enabled only when the

'LiDAR Spatial Distribution Verification GRID - JPEG 2000' export type is chosen.  It creates

a grid containing values representing the presence (value=1) or void (value=0) of a first (of

any) return LiDAR point within any portion of a predefined grid cell size.  See the LiDAR

Spatial Distribution Verification GRID - JPEG 2000  Help Topic for more details.

To use the 'LiDAR Spatial Distribution Verification GRID - JPEG 2000' export:

1) Start by loading the LAS data for the project to be analyzed.  For more information on
loading LAS data, please see the LAS Files  section of the Help Topics. 

2) Select the 'Export'  button or 'Export Area'  button to see the drop-

down list of export types.  'Export Area' requires that a drag box be created first

before the drop-down list appears.  Select the 'LiDAR Spatial Distribution

Verification GRID - JPEG 2000' export type and click the 'OK' button.

3) When the export interface appears, specify an Output Directory.  This will be the
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folder where the final JPEG 2000 (*.jp2) and auxiliary text file will be exported to when

processing is complete.

4) The 'Use temporary local disk space to speed up processing' option allows the

exported file to be written to the specified 'Output Directory', but uses local disk

space to speed up processing.  A typical situation for this option is when the 'Output

Directory' is a network location.  To use this option, check the 'Use temporary local

disk space to speed up processing' box.  Browse to any local folder which has

available space - the export interface will display how much space is required (for

Single File layout raster exports) and how much free space is in the folder selected. 

If there is enough disk space, the export process will use the local space to speed up

processing.  If the 'Use temporary local disk space to speed up processing' box is

checked but a temporary folder is not specified, an error message will appear as seen

below.  NOTE:  Most versions of Windows prohibit an application's output of

files to the root directory of drives.  It is strongly recommended that an actual

folder be used for this option.

5) This export type is intended for use with either the 'Single File' (when using the

'Export' button) or 'User-defined Box' (when using the 'Export Area' button) layout

types.  On the 'Layout' tab of export, specify a File Name for the newly created .jp2

file in the 'File' text box. 

6) The 'Grid' tab contains a few options to control the export.  The 'Number of points
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required in cell' option sets a minimum point count required within each cell.  The

default value is '1' (to meet USGS specifications), but it can be changed as needed. 

The 'Exclusion Shapefile' option is meant for use with a polygon shapefile.  A

typical polygon shapefile for this use will contain polygons around all water bodies

which may cause the resulting output grid file to produce a '0' (zero) value.  A '0'

value would indicate that no LiDAR point was found inside that particular cell, and

that cell would then 'fail' the test as described above.  If all the cells found inside a

body of water record a '0' value, it could cause the entire project area to fall below the

90% pass rate of cells containing a value of 1 (cells which contain at least one

point).  Because LiDAR is absorbed by water, water areas should be excluded from

the test results.  The 'Exclusion Shapefile' option allows the user to place polygons

around any water bodies which may result in a '0' value and exclude those polygons

from the results.  Using this option when producing a LiDAR Spatial Distribution

Verification Grid is optional.

The 'Minimum Zero Count to set NODATA value' option may be applied in areas

where a large number of '0' value cells is anticipated, as in the case of a water body.

This option implements a maximum number of contiguous '0' cells and changes the

value of those '0' cells to a value of 'NULL'.  This will automatically delineate large

data void areas such as water bodies.  This option can be used as an alternative to

the 'Exclusion Shapefile' option and completes the same general purpose.  After

checking the 'Minimum Zero Count to set NODATA value' option, the user may
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enter an integer in the adjacent text box.  As an example, if the user entered '3' into

this text box, the process would look for three contiguous cells containing a '0' value

and change all three to a 'NULL' value. The purpose of this option is to create a more

accurate pass percentage if no exclusion shapefile exists.

At the bottom of the 'Grid' tab is the 'Auto boundary algorithm' option.  The boundary

of the LiDAR data will be automatically detected and a NODATA value will be

assigned to the raster cells that fall outside the boundary.  The detection methods

vary depending on whether the input LAS data is in 'Swath' or 'Tile' (the default)

format.  Swath data is assumed to have only one Point Source ID (PSID), also called

collection scan number, per file, and adjacent swaths will overlap each other.  Tile

data may have one or more PSIDs per file, and adjacent tiles will not have any

overlap.  Note that there may be overlap within a tile, as when two or more swaths

fall within a tile's boundary.  The correct choice of input type is important in avoiding

gaps in the exported grids within the project area.

 

7) The multi-threading option is available for this export type.  It speeds up export by

using a specified amount of a computer’s CPU processing power.  The multi-

threading option can be found at the lower-right corner of the export interface.  By

default, the text box will show the maximum number of threads the computer has

available for processing.  Leave as is, or enter a lower number of threads to be used.

If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not

just installed) per thread.
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8) If any other parameters of the export need to be set, please make those entries on

the rest of the tabs located on the export interface.

9) When all of the parameters of every tab have been specified, click the 'Export'

button to export the file.

10) When the export is complete a prompt, as seen below, will appear. 

Below is  an example  result  of  the  LiDAR Spatial  Distribution  Verification  export  type.

 The green areas represent cells with a value of '1', which have at least  one LiDAR point

within the cell.  The red areas represent cells with a value of  '0',  which DO NOT contain

a LiDAR point.   In the example  below it  is  easy to  see  that  there  is  a  body of  water

running through this  area,  which is  the  cause  of  the  red  cells  with  a  '0'  value.   If  the

'Minimum Zero Count' option was used when running this  tool,  the areas of  contiguous

'0' cells (the water body) would return a null value instead of a '0' value. 
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The 'LiDAR Spatial Distribution Verification' export will also output a results text file (*.

txt) every time it is used.  This text file will be output to the same location as the

JPEG 2000 (the location specified by the user in the output directory browse box). 

The text file will be named beginning with the date, time, and '...

LiDAR_Spatial_Distribution_Verification_Results.txt'.  This allows each *.txt created to

be unique.  For example, the file seen in the screen shot below was produced on July

17, 2014 at 3:55 pm.  The text file will contain the following information: the number of

cells with a '0' value, the number of cells with a '1' value, and the number of value '1'

cells as a percentage of the total number of cells.  This last value will be the

percentage of passing cells.  This percentage needs to be 90% or above to be in

compliance with the USGS specifications mentioned above.  The screen shot below

shows an example of the information contained in the text file.
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5) Color By for LiDAR Raster: This option creates a fast JPEG 2000 raster from the loaded

LiDAR data.  This is the only option for 'Grid Type' when the selected export type is 'Grid -

LiDAR Raster JPEG 2000'.  The output raster cells can be colored by Class, Intensity,

Elevation - Throughout, Elevation - Repeat, or RGB values.

The appearance of the raster can be set to emulate either a Point View (default) or TIN View

rendering by using the checkbox to the right of the 'Color By for LiDAR Raster' drop-down list.

This checkbox control can be used with any of the 'Color By ...' selections except RGB.

When the drop-down is set to 'Elevation - Repeat', the 'Color Cycle ' button is enabled

allowing the same control as when viewing LAS data by 'Elevation --> Repeat'.  See the

Elevation Repeat  topic for details on controlling the display.

'Data Type' - MARS® is capable of 32-bit Float, 32-bit Signed Integer, 16-bit Unsigned Integer, and 8-

bit Unsigned Integer formats for export, depending on the Grid Type being exported.  'Float 32' is the

only option for the 'Elevation' Grid Type.  'Unsigned 16' is the default for the 'Intensity' Grid Type (

exception:  when the export type is 'Grid - Cloud Optimized GeoTIFF Intensity', the 'Data Type'

defaults to 'Unsigned 8').  'Int 32' is the only option available for 'Flightline Separation - JPEG 2000'

exports (which use the 'Color by Collection Scan Separation' Grid Type), and the 'LiDAR Spatial

Distribution Verification GRID - JPEG 2000' Grid Type.

880
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'Lower Left (LL) Coordinate Shift' - when checked, forces the coordinates of the lower-left origin of
an exported Grid to be a value that is evenly divisible by the chosen Cell Size (see above).

Algorithm - Depending on the export type, the user has the option on how to calculate cell values.

'Closest Point to Cell Centroid' (enabled only for the 'Intensity' Grid Type) uses the intensity value from

the Lidar point closest to the cell's centroid (XY distance) to set the value for that cell; 'Grid from TIN'

builds a Grid from a virtual (RAM-based) TIN, then determines each cell's value by checking the TIN at

the cell center's XY value.  The remaining options find the one point in the cell whose value meets the

option's description and assigns that value to the cell.

Fill Gap - Depending on the export type, the user has the option on how (or whether) to fill voids

which are found in the LiDAR data.  Both the 'Fast Fill' and 'TINned Surface Fill' options are used to

prevent NODATA values.  If the 'Fast Fill' radio button is selected, MARS® will use horizontal 'striping'

from the last known elevation value of the input class points (see Filters tab ) for each row of cells

in the void area.  The 'TINned Surface Fill' option aids in hydro-flattening by spanning across data voids

to find points in the input classes.  These points are used to create a flat TIN across the void.   The

'Maximum distance to fill' option sets a maximum distance (in project units) for spanning a void when

either of the fill options is selected.  For the 'TINned Surface Fill' option, an additional value called

'Internal Buffer Size for TINned Surface' should be set to mitigate tinning errors across Virtual Tiles

(see Auto Calculate Virtual Tile Size  sub-topic).  NODATA values will exist beyond this distance.

Input Data Type (Auto boundary algorithm): The boundary of the LiDAR data will be automatically

detected and a NODATA value will be assigned to the raster cells that fall outside the boundary.  The

detection methods vary depending on whether the input LAS data is in 'Swath' or 'Tile' (the default)

format.  Swath data is assumed to have only one Point Source ID (PSID), also called collection scan

number, per file, and adjacent swaths will overlap each other.  Tile data may have one or more PSIDs
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per file, and adjacent tiles will not have any overlap.  Note that there may be overlap within a tile, as

when two or more swaths fall within a tile's boundary.  The correct choice of input type is important in

avoiding gaps in the exported grids within the project area.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.5.8 Contours tab

Contour Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Contours tab allows the user to specify how exported contour shapefiles will be created and

attributed.

'Contours' tab: The 'Contours' tab allows the user to set the contour interval, minimum contour length,

set index contours and level, group, and color for the exported contours.  If settings inside the export

window have been previously saved, they can be loaded by clicking the 'Load Settings from File'

button and navigating to the saved *.xml file.  To save new settings, click the 'Save Settings to File'

button and an *.xml can be created for later use.  Please see the screen shot below followed by a

description of the options available.
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Algorithm: 'TIN' - Builds a virtual TIN and generates the contours from that surface.  This method is

more exact but can create jagged looking contours.

Algorithm: 'Grid' - Builds a grid from the TIN.  The grid cell size can be specified and the number of

passes of the Gaussian smoothing mechanism can also be specified by the user.  The option to

create a virtual grid inside this MARS® function allows the user to create a smooth grid file which, in

turn, will create aesthetically pleasing (smooth) contour lines.  The RAM-based, virtual grid also

allows for quicker production.

Use Max TIN Edge Length: This option is applicable to both algorithm options: 'TIN' or 'Grid'. In the
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case of the 'Grid' algorithm, the software will create a TIN to assist in the creation of the grid.  The

maximum TIN edge length to be used in export may be specified here.

Contour Interval: Choose the vertical unit value of the interval between contour lines.  For example,

a value of 2 will place contour lines every 2 project units of elevation.

Minimum Contour Length: Set a minimum contour length for contour generation.  Longer

minimum contour lengths can minimize noise in the contour data.  Shorter minimum contour

lengths, while more accurate, can generate contours where there is noise in the LiDAR data.

Index Contour: Select the indexing required for the project.  Index contours appear in the LAS Map

View as thicker (bolder) contour lines to allow the user to more easily visualize elevation intervals.

Shapefile Format: 2D or 3D - Choose the desired format.  2D will create an elevation attribute only

for each feature, while 3D will create an elevation attribute and store Z-values internally at each

vertex.  3D files require approximately twice the storage space as 2D.

Line Cleanup: Perform cleanup - This option determines whether or not MARS® will attempt to

clean up unnecessary vertices (see next setting) and exclude contours from the export that have

self-intersections or other topology problems.  When unchecked, all generated contours will be

included in the exported shapefile.  When checked, contours with topology errors will be exported to

a separate shapefile (using the same naming scheme as the 'good' file, but with 'removed' appended

to the file name) located within a sub-folder named 'Removed.'  When necessary, this folder will be

created in the 'Output Directory'.

Line Cleanup: Clean tolerance - The clean tolerance setting in the 'Contour' tab lets the user set

the distance between vertices of contour line work which will be 'cleaned'.  This tool only functions

on the interior of a tile/project and will not 'clean' line work at tile/project edges.  The default

tolerance setting is 0.01 units.  This tool will look for contour lines with vertices which are 0.01 units

or less apart and connect them, cutting off unneeded line work.  In the example below, the two

vertices indicated are less than 0.01 units apart.  Rather than keep the sharply jutting area of the

contour line intact, the software will create a more aesthetically pleasing contour line by deleting
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this unneeded line work.  The tolerance may be set to any value but, the larger the value, the more

cleaning will be done.  This may result in more contours being moved to the 'Removed' sub-folder,

as described in the previous setting.

Line Cleanup: Edge-tie tolerance - The edge-tie tolerance setting in the Contour tab allows the

user to set the distance between ends of two contour lines which will be joined or 'tied' during

export.  This tool only functions on the tile edge and will not join contour lines in any other area. 

The default edge-tie tolerance setting is 2 units.  This tool will look for contour line ends which are 2

units or less apart at the tile edge and connect them, creating one unbroken contour line.  In the

example below, two contours have reached the tile edge and have been cut at the tile edge.  This

occurs because a project is often processed by tile.  Because the ends of the two contours are 2

units or less apart and occur at the tile edge, they will be joined. 
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'DGN/Shapefile Attributes' section: Allows the user to set the levels, groups, and colors of CAD

and shapefile features.  The 'level' attribute is important to the proper operation of the Depression

Coder  tool.

Edge-tie directory of existing shapefile: This option allows the user to point to an existing folder

containing contour shapefiles.  This folder cannot be the same as the output folder - if a different

folder is not  specified, a warning message will be displayed, as seen below.  The existing contours 

MUST contain an 'Elv' attribute field with the elevation values populated for each contour.  This

allows the program to 'edge-tie' each contour line being exported to contours in previously-created

shapefiles.  Often, contours lines are cut when data is dissected into tiles.  The elevation of contour

lines created separately in these tiles may not match up when tiles are placed back together to

create a single dataset.  This option inside the contour interface creates a scenario in very few

contours will be left 'dangling' or not connecting properly with the continuing contour line in another

tile.

Once parameters have been set in all the export window tabs, click 'Export' to export the data.
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4.5.9 Projection tab

Projection Options

Merrick Advanced Remote Sensing (MARS
®

) Software

The Projection tab can be used to define the projection that the data is currently in.  This tool does 

NOT perform any conversion or transformation.  The ‘Projection’ tab is available only in the export

interface when the  3D Image, Grid - IMG, Grid - LAS, Grid - TIFF, or LAS export types are chosen. 

When LiDAR data containing projection information is loaded into MARS® and one of the above-

mentioned export types is chosen, the available projection information will automatically be populated

in the ‘Projection’ tab of the export dialog.

'Projection' tab: If the coordinate reference system data is not automatically entered in the

'Projection' tab, then the user may manually enter any missing or desired information for the export,

including the horizontal and vertical units.  To browse for coordinate system definitions, follow the

procedure outlined in the 'Add CRS Info (to LAS Files)' topic in the Coordinate Conversion  section

of this help file.  When either the 'LAS' or 'Grid - LAS' export type is being used, the coordinate system

tag will be written as WKT (Well-Known Text).

More information about each of the sections and settings on this tab can be found in the Export/

Extract Tab  help topic.

If settings inside the export window have been previously saved, they can be loaded by clicking the

'Load Settings from File' button and navigating to the saved *.xml file.  To save new settings, click

the 'Save Settings to File' button and an *.xml can be created for later use.

252
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Projection tab when exporting to 'LAS':

The 'Coordinate System' selection window is seen below:
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When all other parameters have been set for the export, click the 'Export' button.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6 Data Navigation

Data Navigation

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® supports two primary navigation modes; a 2D View  (orthographic) and a 3D View

(perspective).  Both modes allow for either point cloud or TIN rendering of LAS data.

Note: For fast navigation of large datasets, it is recommended that the user work  in the ‘Points’ (point

cloud) graphic display mode. Typically, the best approach is to navigate to a specific area-of-interest

and then switch to the TIN mode, which will reduce the amount of processing necessary to create a

surface over a very large area. Attempting to TIN large areas is very computationally 'expensive' and

takes longer as TIN'ing is done on the fly by MARS®. 
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4.6.1 Bookmarks

Bookmarks Functions

Merrick Advanced Remote Sensing (MARS
®

) Software

Bookmarks: Bookmarks can be used to mark a certain place in the data. The bookmark tools can be

found on the Navigation Tab . By saving a bookmark, the user will be able to click on the bookmark

name in the future and be taken to the location in the data that the particular bookmark was placed.

Bookmarks are convenient when editing to be able to pick up editing in a particular spot, to save a place

where re-work needs to be done, or as a point of reference for another user.

  To create or save a bookmark for future reference, choose this option. The

user will be shown a Bookmark Creation interface to name and save the bookmark.  Click on the

'OK' button or press the 'Enter' key on the keyboard to commit the save.

  To visit a saved bookmark, use this option. A list of saved bookmarks will

appear. Choose the needed bookmark and click 'OK' to view the bookmark placement. 
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  To delete a saved bookmark, use this option. A list of all saved

bookmarks will appear.  Choose the bookmark to be deleted by highlighting it and choose'

Delete' at the bottom of the window.
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See also:

Navigation Tab

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.2 Cross-Section/Profile

Cross-Section/Profile View

Merrick Advanced Remote Sensing (MARS
®

) Software

232



Tools and Functions 817

© 2000-2023 Merrick & Company

The cross-section/profile tools are most commonly used to generate cross-section data (both LiDAR

and breakline data) and are also useful for evaluating data for calibration (collection scan and/or

mission alignment) errors. LiDAR point display may be toggled off in the LAS Map View without

affecting the point display in the Cross-Section/Profile view. Note that as the cursor is moved in the

Cross-Section/Profile window, a white 'X' symbol will move in sync within the cross-section/profile box

in the LAS Map View window.  This aids the user in determining what areas of the data are being

observed at any given time.

 Place Profile Line- Draws cross-sections with a fixed cut depth, and works only in 2D -

orthographic mode. The tool uses a two-point compilation: to start, click once to place one side of the 

cross-section/profile, click again to place the other side of the cross-section/profile. The first time this

cross-section/profile tool is used a new cross-section/profile window will open. There are adjustable

default settings and special controls for this tool:

Default #1 - The LAS Map View and cross-section/profile windows will tile

automatically; the default is for the cross-section/profile window to appear to the right

of the 2D LAS Map View window. To change the default go to the Options Tab  and

click the 'Miscellaneous' button. The setting may be changed in the 'Arrange Cross-

Section/Profile window' section.

Default #2 - The cross-section/profile width defaults to 10 units. To change the

default go to the Options Tab  and click the 'Miscellaneous' button. Entering a

new value into the 'Default cut area depth' text box will change the default depth.

Default #3 - The cross-section/profile cut area can be moved forward and backward

('broomed') in the 2D View window. The default value of this movement is 75%,

meaning that the forward motion will be  75% of the cross-section/profile's width,

518

518



MARS® v2023.1           User Manual818

© 2000-2023 Merrick & Company

leaving a 25% overlap. This percentage can be changed by going to the Options Tab

 and clicking the 'Miscellaneous' button. The 'Forward/back percentage' radio

buttons available are 25%, 50%, 75%, 90%, or 100%.

Cross-Section/Profile Movement #1 - The cross-section/profile cut area can be

dragged to a new location. Select and drag the cut area in the 2D View window.

Cross-Section/Profile Movement #2 - For stepping the cross-section/profile cut

area forward and back ('brooming'), use the UP  and DOWN  arrows. The step

size movement is controlled by Default #3.

Cross-Section/Profile Movement #3 - If the 2D View window is selected, the 'Keep

Cut Area in Map View Centered'  tool will

keep the cross-section/profile cut area centered in the middle of the LAS Map View

window. To disable this and allow the cut area to move independently from the

window, click the 'Keep Cut Area in Map View Centered' tool to toggle it off while

the 2D View window is active. If the cross-section/profile window is the active window,

the 'Keep Profile Centered'  tool will try to estimate a

ground elevation and automatically adjust the window to that elevation. In steep

terrain or near tall buildings this feature can fail. To disable this and allow the cross-

section/profile to move without automatic elevation adjustment, click the 'Keep

Profile Centered' tool to toggle it off while the cross-section/profile window is active.

Cross-Section/Profile Movement #4 - The cross-section/profile cut area can be

rotated in the 2D View window. The cut area will rotate around its center node. Rolling

the mouse scroll wheel rotates the cross-section/profile.

 Place Adjustable Profile Line- Draws cross-sections without a fixed cut depth, and works

518
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only in 2D - orthographic mode. The tool has a three-point compilation: to start, click once to place

one side of the cross-section/profile, click again to place the other side of the cross-section/profile,

and click a third time to set the cut depth (width) of the profile. The first time this cross-section/profile

tool is used a new cross-section/profile window will open. There are adjustable default settings and

special controls for this tool:

Default #1 - The LAS Map View and cross-section/profile windows will tile

automatically; the default is for the cross-section/profile window to appear to the right

of the LAS Map View window. To change the default go to the Options Tab  and

click the 'Miscellaneous' button. The setting may be changed in the 'Arrange Cross-

Section/Profile window' section.

Default #2 - The cross-section/profile cut area can be moved forward and backward

('broomed') in the 2D View window. The default value of this movement is 75%,

meaning that the forward motion will  be 75% of the cross-section/profile's width,

leaving a 25% overlap. This percentage can be changed by going to the Options Tab

 and clicking the 'Miscellaneous' button. The 'Forward/back percentage' radio

buttons available are 25%, 50%, 75%, 90%, or 100%.

Cross-Section/Profile Movement #1 - The cross-section/profile cut area can be

dragged to a new location. Select and drag the cut area in the 2D View window.

Cross-Section/Profile Movement #2 - For stepping the cross-section/profile cut

area forward and back ('brooming'), use the UP  and DOWN  arrows. The step

size movement is controlled by Default #2.

Cross-Section/Profile Movement #3 - If the 2D View window is selected, the 'Keep

Cut Area in Map View Centered'  tool will

keep the cross-section/profile cut area centered in the middle of the LAS Map View

518
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window. To disable this and allow the cut area to move independently from the

window, click the 'Keep Cut Area in Map View Centered' tool to toggle it off while

the 2D View window is active. If the cross-section/profile window is the active window,

the 'Keep Profile Centered'  tool will try to estimate a

ground elevation and automatically adjust the window to that elevation. In steep

terrain or near tall buildings this feature can fail. To disable this and allow the cross-

section/profile to move without automatic elevation adjustment, click the 'Keep

Profile Centered' tool to toggle it off while the cross-section/profile window is active.

Cross-Section/Profile Movement #4 - The cross-section/profile cut area can be

rotated in the 2D View window. The cut area will rotate around its center node. Rolling

the mouse scroll wheel rotates the cross-section/profile.

 Keep Profile Centered - In the cross-section/profile window, the 'Keep

Profile Centered' tool keeps data centered vertically in the window. If the cross-section/profile window

is the active window, the 'Keep Profile Centered' tool will try to estimate a ground elevation and

automatically adjust the window to that elevation. In steep terrain or near tall buildings this feature can

fail. To shut this off and allow the cross-section/profile to move without automatic elevation adjustment,

click the 'Keep Profile Centered' to toggle it off while the cross-section/profile window is active.

 Keep Cut Area in Map View Centered - This tool keeps the

cut area box centered vertically and horizontally in the LAS Map View window.  To shut this off and

allow the cut area box to move independently from the window, click the 'Keep Cut Area in Map View

Centered' button to toggle it off.  When the 'Keep Cut Area in Map View Centered' tool is not active,

the cross-section/profile window can be dragged with the 'Pan'  tool to the user's area of
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interest.

The Cross-Section/Profile Tab  has several features which work with the cross-section and profiling

tools. The 'Vertical Scale' slider bar, the profile by collection scan or combined, the sizes of the LiDAR

points in relation to their distance from the viewer, as well as the cross-section/profile depth can all be

changed.

    

 Current Depth: Allows the user to define the cut depth of the cross-section/profile window.

 Show Point Size: Resizes the point display within the cross-section/profile

window. When toggled on, the LiDAR points nearest to the viewer side of the cut area are

relatively larger, and points on the far side are relatively smaller.

 Profile Combined: Displays a combined single line profile of all points.

 Profile by Collection Scan: Displays a separate profile line for each collection scan.

 Cross Section: Displays a cross-section view of the LiDAR points in the cross-section/profile

window.

 Vertical Scale: Allows the user to adjust the

238
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vertical scale (relative to the horizontal one) by moving the slider bar back and forth or by typing

the desired scale into the scale text box. The '1x' button resets the scale to 1:1, the original or

'true' scale.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.3 Fit to View

Fit to View Function

Merrick Advanced Remote Sensing (MARS
®

) Software

 Fit View: Zooms out to the project’s furthest extents (all loaded data). This tool, found on the

Navigation Tab  or the Quick Access Toolbar , will only function in the LAS Map View window

and is disabled for use in the Cross-Section/Profile window.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.4 Jump To

Jump To Functions

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® provides three methods to quickly navigate to a specific area of interest.  These buttons are

found on the Navigation Tab :

232 62
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: Allows the user to navigate to a specific X, Y coordinate.

: Allows the user to navigate to the extent of a specific tile. In order to use this tool, a

tile shapefile (*.shp) with a unique attribute field must be loaded into MARS®.

: Allows the user to navigate to a specific check point location. In order to use

this tool, a check points file (*.csv) with an ID column must be loaded into MARS®.
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See also:

Navigation Tab

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.5 Link to Google Earth

Link to Google Earth Function

Merrick Advanced Remote Sensing (MARS
®

) Software

 Link to Google Earth: If either Google Earth© or Google Earth Pro© is installed, it will

open in a separate window and auto-navigate to the location that is displayed in the LAS Map View

window.

When the tool is enabled, it will check to see if Coordinate Reference System (CRS) information is

defined for either the loaded LAS data or in the 'Data Layer' properties.  If not, the following message

232
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will appear:

Google Earth and Google Earth Pro are copyright 2019 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.6 Pan

Pan Function

Merrick Advanced Remote Sensing (MARS
®

) Software

 Pan: Allows the user to navigate across the loaded data and/or imagery.

To use the 'Pan' function, click the ‘Pan’ button on the Navigation Tab  (or use the shortcut key

'Q'), then left-click and drag the mouse to navigate in any direction.  Panning can also be done in most

situations by using a push-and-hold technique with the mouse wheel and then moving the mouse. 

See additional panning methods in the 'Miscellaneous' section of the Options Tab .

232
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© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.7 Previous/Next View

Previous/Next View Functions

Merrick Advanced Remote Sensing (MARS
®

) Software

 Previous View: Allows the user to return to the last display view.

 Next View: Allows the user to jump to the next display view. (Note: the user can only jump to

the next display view if the previous button was used prior)

© 2000-2023 Merrick & Company. All Rights Reserved.

4.6.8 Zoom In/Out

Zoom Functions

Merrick Advanced Remote Sensing (MARS
®

) Software

There are several ways to zoom in and out.
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Zoom In:

1. Choice #1 - While in the 'Pan' mode ( ), hold down the CTRL key and use the left mouse

button to drag a rectangle. This area will now zoom in to fill the window extent.

2. Choice #2 - Select the 'Zoom In Window' button  from the Navigation Tab  or the Quick

Access Toolbar . Click and hold the left mouse button to drag a rectangle. View will be

zoomed to fill this area.

3. Choice #3 - While in the 'pan' mode ( ), hold down the right mouse button and move the

mouse backward. Pushing the mouse forward while holding the right mouse button down zooms

out.

4. Choice #4 - Roll the scroll button on the mouse away from the computer (backward) to zoom in to

the data.

5. Choice #5 - If a tile shapefile is loaded, double-clicking on a tile will zoom to the extent of that tile.

6. Choice #6 - To zoom in by a fixed amount (25%), select the '+' (plus) key on the keyboard/numeric

keypad or click the 'Zoom in 25%' button  on the Navigation Tab  or the Quick Access

Toolbar .

Zoom Out:

1. Choice #1 - While in the 'Pan' mode ( ), hold down the SHIFT key and use the left mouse
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button to drag a rectangle. View will be zoomed out from the drawn rectangle.

2. Choice #2 - Select the 'Zoom Out Window' button  from the Navigation Tab  or the

Quick Access Toolbar . Click and hold the left mouse button to drag a rectangle. View will be

zoomed out from the drawn rectangle.

3. Choice #3 - While in the 'pan' mode ( ), hold down the right mouse button and move the

mouse forward. Pulling the mouse backward while holding the right mouse button down zooms

in.

4. Choice #4 - Roll the scroll button on the mouse toward the computer (forward) to zoom out from the

data.

5. Choice #5 - To zoom out by a fixed amount (25%), select the '-' (minus) key on the keyboard/

numeric keypad or click the 'Zoom out 25%' button  on the Navigation Tab  or the Quick

Access Toolbar .

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7 Data Viewing

Data Viewing

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® can rapidly display LiDAR datasets and supports easy navigation in 2D and 3D modes. The
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following list outlines the data visualization and navigation capabilities of MARS®.

LiDAR Data Rendering

• Color by Elevation  : Renders LiDAR data by elevation.

• Color by Intensity  : Renders LiDAR data by intensity.

• Color by Classification  : Renders LiDAR data by data classification.

• Color by Return  : Renders LiDAR data by return.

• Color by Collection Scan  : Renders LiDAR data by collection scan.

Color by Ground Color  : Renders user-defined ground class(es) by RGB values and all other

points by classification. RGB values stored with the points will be used if no imagery is loaded.

• Color by RGB  : Uses the R(ed), G(reen), B(lue) values stored for each LiDAR point to render

the point cloud or TIN as a pseudo-image.

• Color by Imagery (Fusion)  : Fuses RGB values from Raster into the LiDAR points.

Blend with Intensity  : This tool will display LiDAR points by intensity and allow the user to
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blend these intensity images with other 'color by' views. The user may view intensity blended with

elevation, classification, collection scan, return, user data, or with Z delta. There is no terrain relief

when viewing LiDAR data by intensity alone, yet the ability to view intensity along with another value

may allow the user to view the data more efficiently. Please see the examples below for further

explanation. 

In the screen shot below, the LiDAR data is being viewed by return only. By viewing only

the return values, it is impossible to know which characteristic in the terrain the first

return (blue) and second return (red) data corresponds to. 

The screen shot below is of the same area, but the ‘Blend with Intensity’ tool has been

utilized with the return values in the LiDAR data. It is now easy to see that the first

return data (blue) corresponds to areas with roads and buildings whereas the second

return data (red) corresponds to areas containing trees.
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Color by Hillshade  : This tool will color an elevation float grid by hillshade on the fly. This tool

is only available when a float grid has been loaded into MARS® and can be used in 3D in conjunction

with a float grid (*.flt) file. For more information on loading a float grid into MARS®, please see the

Convert Float Grid  section. To read more about the Color by Hillshade  tool, please select the

link to this topic.

Color by Z Delta  : This tool will color the points in the LiDAR data by the vertical difference in

collection scans.  See the Color by Z Delta  topic for more details.

Color by User Data  : Displays LiDAR points rendered by values stored in the 1-byte 'User

Data' field which can contain any type of data at the user's discretion.  This field has often been

used to store Auto-Gain Control values at the time the particular point in question was recorded in

the system. These AGC values, specific to Leica sensors, tell the user how the system was

attempting to center the intensity histogram at the time of collection.

• Points  : Renders the LiDAR data as points.

• TIN  : Renders the LiDAR data as a TIN (surface).

2D Data Navigation

655 859
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MARS® has many 2D data navigation tools. The following list outlines all of the application’s 2D

navigation functions:

• Orthographic  : Orthographic (2D) mode zoom tools and mouse controls are different than

Perspective (3D) mode tools. The following tools can be used in 2D mode:

Fit to View  : To zoom out to the full extent of the project.

 Previous View  : To go back to the previous zoom.

 Next View  : To return back to the original zoom after the 'Previous View' button has

been used.

 Pan  : Can be used only while in 2D view. Click and hold the left mouse button and

drag the display to a new location to pan across it.
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 Zoom In Window  : Drag a rectangle to zoom in to the specified area.

 Zoom Out Window  : Drag a rectangle to zoom out.

 Zoom in 25%  : To zoom in by a factor of 25%.

 Zoom out 25%  : To zoom out by a factor of 25%.

See Also

2D Navigation

3D Data Navigation

MARS® has many 3D data navigation tools also. The following list outlines all of the application’s 3D

navigation functions:

• Perspective  : Perspective (3D) mode zoom tools and mouse controls are different than

835
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Orthographic (2D) mode tools. Points may be edited while in 3D mode, and the Undo and Redo

buttons on the  Edit/Filter Tab  function in 3D editing. Most editing should be completed in 2D

mode, but if the editor is having difficulty understanding where the ground surface is, 3D mode can be

a useful tool that allows the  viewer to 'fly' around the data and reclass or edit specific points. Be

aware that the data must be viewed at 100% density in 2D before using the 3D application for

editing. If points are not shown at 100% density the user may possibly edit data which is not visible

while viewing points at less than 100% resolution. The following tools can also be used in 3D mode:

Rotating around a central node: First select the 'Pan'  button. Then click and hold

the left mouse button. The data will rotate around a central node. Practice rotating the data

around by sliding the mouse up and down or left and right while holding the left mouse button

down.

Zooming In/Out: First select the 'Pan'  button. Then click and hold the right mouse

button to zoom into and away from the central node. Practice zooming with the data by

sliding the mouse forward and backward while holding the right mouse button down.

Pan through/around data: Click and hold both mouse buttons to pan through the data.

See Also

3D Navigation

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.7.1 2D View

2D View

Merrick Advanced Remote Sensing (MARS
®

) Software

The 2D view is also known as 'Orthographic View'.  By default, MARS® utilizes the 2D view when first

loading data.

Moving in 2D:

MARS® supports several data navigation options. The user can utilize the following methods to zoom

and pan, which are described below:

Zoom In/Out Window: Click the ‘Zoom In Window’  button or the 'Zoom

Out Window'  button on the Navigation Tab  or the Quick Access

Toolbar . Click and hold the left mouse button to drag a rectangle. The view will

zoom to the defined area.

Zoom In/Out 25%: Click the 'Zoom In 25%'  button or the 'Zoom Out 25%'

 button on the Navigation Tab  or the Quick Access Toolbar .

Mouse Zoom: Click and hold the right mouse button while moving the mouse

backward to zoom in. Pushing the mouse forward while holding the right mouse

232
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button down will cause the display to zoom out. The user can also use the scroll

button on the mouse to zoom in/out.

CTRL-Zoom: Depress the CTRL key and use the left mouse button to drag a

rectangle. The view will zoom to the defined area.

Tile Click: If a tile shapefile is loaded into the project, the user may double-click

within a tile to zoom to the extent of the desired tile.

To pan, make sure the ‘Pan’  button is selected on the Navigation Tab  or the Quick

Access Toolbar . Click and hold the left mouse button to pan through the data.

Click the ‘Fit to View’  button on the  Navigation Tab  or the Quick Access Toolbar  to

zoom to the extent of the project.

See Also:

Navigation Overview

3D View  

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.2 3D View

3D View

Merrick Advanced Remote Sensing (MARS
®

) Software

232
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The 3D view is also known as 'Perspective View'. Points may be edited while in 3D mode, and the

Undo and Redo buttons on the Edit/Filter Tab  function in 3D editing. Most editing should be

completed in 2D mode or in the Cross-Section/Profile window, but if the editor is having difficulty

understanding where the ground surface is, 3D mode can be a useful tool that allows the  viewer to 'fly'

around the data and reclass or edit specific points. Be aware that the data must be viewed at

100% point density in 2D before using the 3D application for editing. If points are not shown at

100% density the user may possibly edit data which is not visible while viewing points at a lower

resolution.

Tutorial on 3D Navigation

1. Select the '2D View'  button and the 'Points'  button.

2. Observe the resolution percentage (%) at the bottom of the window. Zoom in far enough to

achieve 100% resolution.

3. TIN the data by selecting the 'TIN'  button on the View Tab . To view only the

LiDAR points data, proceed to the next step. To fuse the LiDAR data with loaded imagery,

select the 'Color by Imagery (Fusion)'  button.

4. Select the 'Place Target'  button to pick the point of rotation within the data displayed

(the nearest LiDAR point will be used). The target position may be reset at any time for a
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different perspective view.

5. Select the '3D View'  button. This will lock the current data resolution (point density),

so first ensure that the displayed resolution is sufficient. (Note: To change resolution,

temporarily switch back to 2D mode.)

6. Click and hold with the left mouse button to rotate around the data.

7. Click and hold with the right mouse button (forward or back) to zoom in/out.

8. Click and hold both mouse buttons to pan through the data.

9. Data will redraw at different rates depending on the amount of data displayed. The redraw

operation takes the longest in the TIN graphic display.

10. Select the 'Place Eye'  button to pick a viewing location. For example, if the target

location chosen with the 'Place Target'  button is on a street below a skyscraper, select

the 'Place Eye' button and pick the top of the skyscraper. The result will be a view looking from

the top of the skyscraper to the street below.

11. MARS® is also capable of vertically rescaling data while in 3D View mode. Above the slider

bar on the View Tab  is a vertical scale text box that allows entry of an exact scale value.

Type in the scale (relative to horizontal) at which the data is to be viewed and press 'Enter' on

192
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the keyboard. The '1x ' button will revert back to a 1:1 scale.   The Vertical

Scale Slider inside the Cross-Section/Profile  window is only for use in that window and will

not rescale data in the LAS Map View window.

Ex: Data scaled at 0.5

Ex: Data scaled at 2

146
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To return to the original or 'true' scale, either enter '1' in the scale text box, or click on the '1x'

button. 

12. Select the 'Points'  button. Select the '2D View'  button and then the 'Fit

to View'  button to return to the default display settings.

Moving in 3D:
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1. To Rotate - Click and hold the left mouse button. Moving the mouse will tilt and rotate the

data around a central node. Practice tilting and rotating the data by sliding the mouse forward

and back or left and right while holding the left mouse button down.

2. Zoom - Click and hold the right mouse button. Moving the mouse forward and back will zoom

in and out from the central node. Practice zooming with the data by sliding the mouse forward

and back while holding the right mouse button down.

3. Pan - Click and hold both mouse buttons. Moving the mouse will pan through the data.

See Also

Navigation Overview

2D View

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.3 Bit Flag Display

Bit Flag Display

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Bit Flag Display Settings' tool , found on the View Tab , allows for LiDAR point

rendering to be controlled by the point-level status of several bit flags: Synthetic, Model Key-point,

Withheld, Overlap (also referred to as 'Overage'), Edge of Collection Scan, Scanner Channel, and Scan

Direction.  By default, points flagged as 'Withheld' are not displayed ('Off').  All other bit flag types are

initially set to 'Ignore Status' -  meaning that the points will be displayed whether or not the bit flag for

813
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that particular type is set to 'True' - or, in the case of Scanner Channel and Scan Direction, all

possible values are checked on.  For the upper portion of the interface, if 'Only On' is chosen only the

points with that bit flag set to 'True' will be visible.  If multiple bit flag types are set to 'Only On', only

points with all corresponding bit flags set to 'True' will be displayed.  For example, if 'Model Key-point'

and 'Overlap' are both set to 'Only On', only those points with both bit flags set to 'True" will be visible.

The 'Off' option is used to turn off those points that have the corresponding bit flags set to 'True'. 

Unlike 'Only On', however, points will be turned off when any one of the bit flags is set to 'True' for

types using the 'Off' option.  For example, if both 'Synthetic' and 'Overlap' are set to the 'Off' option,

any points with either of those bit flags set to 'True' will be turned off.  The 'Scanner Channel' and Scan

Direction' settings operate independently of the other bit flag settings - they simply toggle certain

channels and/or directions on or off regardless of the other bit flag settings.

Only those points that are visible will participate in the 'Rendering Method' (Point or TIN) or the

'Perspective" (2D or 3D) view.  These settings can be made independently in both the LAS Map View

and Cross-Section/Profile windows, except for the 'Scanner Channel' and 'Scan Direction' settings

which are ignored in the Cross-Section/Profile window.  To view by the new settings without closing

the tool after making changes, click the 'Apply' button.  To save a display configuration beyond the

current MARS® session, click the 'Make Defaults' button.
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4.7.4 Blend with Intensity

Blend with Intensity

Merrick Advanced Remote Sensing (MARS
®

) Software

To see data colored by intensity blended with another 'color by' rendering option, click on the 'Blend

with Intensity'  button on the View Tab . 

The 'Blend with Intensity'  tool displays LiDAR points by intensity and allows the user to blend
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this with other 'color by' views.  Intensity may be blended with elevation, classification,  return,

collection scan, ground color, or user data.  There is no terrain relief when viewing LiDAR data by

intensity alone, but the ability to view intensity along with another rendering option may allow the data

to be viewed more efficiently.  Please see the examples below for further explanation. 

In the example below, the LiDAR data is being viewed by return only.  By viewing only

the return values, it is impossible to know which characteristics in the terrain the first

return (blue) and second return (red) data correspond to. 

The example below is of the same area, but the ‘Blend with Intensity’ tool has been

utilized with the return values in the LiDAR data.  It is now easy to see that the first

return data (blue) corresponds to areas with roads and buildings whereas the second

return data (red) corresponds to areas containing trees.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.7.5 Color by Classification

Color by Classification

Merrick Advanced Remote Sensing (MARS
®

) Software

LAS files are variable length records that contain up to 256 different data classifications, which can be

displayed in any color combination. Raw data is typically unclassified, therefore all points are

displayed in a single color. Most completed projects will contain a minimum of two classes; ground

(Class 2) and unclassified (Class 1). The point data may be reclassified into any of the available data

classifications, which may represent various above-ground features (ex. buildings, vegetation, roads,

transmission lines, etc.).

Click the 'Color by Classification' button  on the View Tab  to view the points by

classification.  Pressing 'Ctrl-C' on the keyboard will also cause the LiDAR data to be colored by

classification.

To view the list of data classifications, click the ‘View Classification’ button  on

the View Tab . The following dialog will appear when the active window is LAS Map View.  (A

complete description and example of the interface when the Cross-Section/Profile window is active

can be found in the 'Display Selection' section of the View Tab  topic.)  With this interface, the

user can control settings for the display of a particular class, the color representing an individual

class, and how that class will be displayed during TIN rendering.

192

192
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To display all ground including Model Key-points, click the 'Ground (All)' button followed by the 'OK'

button.  Note that all bit-flagged points - including Model Key-points - can be controlled for display by

using the 'Bit Flag' display settings tool  found on the View Tab .192
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To view the ground points as a surface model, click on the ‘TIN’  button. The bare-earth

surface is displayed as follows:

From the ‘Classifications Display Settings’ dialog  , click ‘High Vegetation’ (Class 5) to display

the canopy data points. Then click on 'OK'. The bare-earth and canopy data classes are displayed as

follows:
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To view the data in 3D mode, click the ‘3D Perspective'  button on the View Tab . Use the

‘Pan’  function on the Navigation Tab  or the Quick Access Toolbar  to rotate the

dataset. Please note that the user must return to 2D View mode to update the display to a higher

resolution or a different coverage area than the current 3D view.

192
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For more details on the 'Classifications Display Settings' interface, see the 'Display Selection |

Classification' section of the View Tab  topic or the Displaying Data  topic.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.6 Color by Collection Scan

Color by Collection Scan

Merrick Advanced Remote Sensing (MARS
®

) Software

Airborne LiDAR data is collected by flying straight, parallel lines over the intended project area. Each of

these individual lines is called a 'collection scan'. LiDAR data can be viewed in MARS® by collection

192 1609
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scan, each uniquely colored for display purposes. Coloring the LiDAR data by collection scan allows

the user to identify gaps in the collected dataset or easily see boresighting corrections that need to be

made.

To view the data colored by collection scan, click the 'Color by Collection Scan' button  on the

View Tab . Hitting Ctrl-L on the keyboard will also cause the LiDAR to be colored by collection

scan. 

The following image shows the LiDAR point cloud data rendered by collection scan.

192
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 Collection Scan Direction: The Collection Scan Direction tool allows the user to view the

direction in which each collection scan was acquired. To use this tool, click on the Collection Scan

Direction button. When the tool is turned on, this button is orange in its display. The collection scan

direction will be indicated with arrows pointing in the direction of acquisition. Each arrow is also color-

coded to match the color of the corresponding collection scan data. 

The example below shows five collection scans color-coded in white, pink, yellow, purple, and green.

This example shows the same five color-coded collection scan direction arrows with the LiDAR data

turned off.

See Also
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'Edit Collection Scan Display' section of the View Tab

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.7 Color by Fusion

Color by Imagery (Fusion)

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® supports the fusion of LiDAR and imagery for photo-realistic display purposes. For this type of

display, the RGB values from the imagery pixels are temporarily applied to the closest LiDAR point for

rendering. To utilize this rendering style, click on the ‘Color by Imagery (Fusion)’  button on

the View Tab  with both LiDAR point data and imagery loaded and displayed. The user can also view

the data by Fusion by pressing Ctrl-F on the keyboard. Data can only be displayed by Fusion in the

LAS Map View window, not in the Cross-Section/Profile window. 

The following image displays the LiDAR points fused with color digital imagery in ‘Points’ 

mode. The darker vertical band on the right side is an area of single collection scan coverage.

192
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The following image displays the LiDAR points fused with color digital imagery in ‘TIN’  mode.
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The following image depicts a TINned surface rendered by Fusion in 3D (perspective) mode. To view the

data in 3D mode, click the ‘3D’  button on the View Tab . Use the ‘Pan’  function

on the Navigation Tab  or the Quick Access Toolbar  to rotate the dataset. Please note that the

user must return to 2D View mode to update the display to a higher resolution or a different coverage

area than the current 3D view.

192
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4.7.8 Color by Ground Color

Color by Ground Color

Merrick Advanced Remote Sensing (MARS
®

) Software

This rendering method is similar to 'Color by Imagery (Fusion)' except that only the user-specified

ground class(es) are fused with the loaded imagery or stored RGB values. For this type of display, the

RGB values from the imagery are temporarily applied to the closest ground-classed LiDAR point for
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rendering. If no imagery is loaded, RGB values stored with the ground-classed points will be used.  To

utilize this rendering style, click on the ‘Color by Ground Color’  button on the View Tab

with both LiDAR point data and imagery turned on. A selection interface (see below) will appear where

those classes that represent ground can be selected. Data can only be displayed by Ground Color in

the LAS Map View window, not in the Cross-Section/Profile window. 

The following image displays the LiDAR ground-classed points fused with color digital imagery in

‘Points’  mode.

192
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The following image displays the LiDAR ground-classed points fused with color digital imagery in ‘TIN’

 mode.
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The following image depicts a TINned surface rendered by Ground Color in 3D (perspective) mode. To

view the data in 3D mode, click the '3D’  button on the View Tab . Use the ‘Pan’ 

function on the Navigation Tab  or the Quick Access Toolbar  to rotate the dataset. Please note

that the user must return to 2D View mode to update the display to a higher resolution or a different

coverage area than the current 3D view.

192
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4.7.9 Color by Hillshade

Color by Hillshade

Merrick Advanced Remote Sensing (MARS
®

) Software

To see data rendered as a hillshade, click on the 'Color by Hillshade'   button on the View Tab

. This tool is enabled only when a gridded, elevation Float Grid has been loaded into MARS®.

To load a Float Grid into MARS®, first select the 'Add Float Grid' button on the Project/Data

192
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Preparation Tab . Navigate to the float grid (*.flt) to be loaded and select it. Click 'Open'. 

    

The loaded float grid can now be seen in the Table of Contents. Please see the 'Float Grids' layer

section for more information about using float grid files inside the table of contents.

Once a gridded, elevation float grid (*.flt) is loaded into MARS®, the 'Color by Hillshade'  tool may

be applied to the data.  Click on the Color by Hillshade button, choose the desired sun angle settings

and  a hillshade will be calculated and displayed. Because the hillshade is being calculated and

displayed 'on the fly,' display can sometimes be slow. The resulting display can also be viewed in 3D

View . Please note that loaded LAS files will not function with the Color by Hillshade tool.

Only gridded, elevation float grids (*.flt) will work with this tool. 

162

79

836



Tools and Functions 861

© 2000-2023 Merrick & Company

The example below shows a gridded, elevation float grid colored by hillshade.

 

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.10 Color by Return

Color by Return

Merrick Advanced Remote Sensing (MARS
®

) Software

The LiDAR data can be viewed by its return values. The returns are colored dark blue to indicate first

returns, red for second returns, yellow for third returns, and so on through all 15 possible returns

(depending on the version of LAS data loaded).  See the 'Display Selection: Return' section of the View

Tab  help topic for more info and a legend of all colors used for return value rendering.192
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To view the LiDAR points by return value, click the ‘Color by Return’ button  on the View Tab

.  Using the 'Ctrl-R' keyboard shortcut will also cause the LiDAR to be colored by return.  The following

image shows LiDAR points rendered by their return value.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.11 Color by RGB

Color by RGB

Merrick Advanced Remote Sensing (MARS
®

) Software

192
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 Color by RGB: uses the R(ed), G(reen), B(lue) values stored for each LiDAR point to render the

point cloud or TIN as a pseudo-image. 

Beginning with LAS spec 1.2, RGB values can be stored in an LAS file on a point-by-point

basis.  The Near Infrared (NIR) band values can also be stored beginning with LAS v1.4.  When

the 'Color by RGB' rendering method is used, those visible color values are used in the display.

The data can then be viewed in 2D, 3D, or cross-section/profile, and in either point cloud or TIN

display.  If no RGB(N) values exist within the loaded LiDAR data and imagery is available (either

traditional rasters or WMS imagery), a new set of LiDAR data can be exported using the RGB

(N) values from the imagery as follows:

1.) To be able to use this tool properly, first the user must have BOTH an image and an LAS file

for the same area loaded into MARS®. 

2.) Next, the user must export the data. See the screen shot below for the export parameters

needed to use the 'Color by RGB' tool.

Designate an output directory for the LAS file. 

Make sure the 'Type' of export is 'LAS'. 

In the 'LAS Options' section, choose a 'Point Data Record Format' that can store

RGB(N) values: either 7 or 8 (if the imagery is 4-band).

In the section labeled 'Write RGB(N) values from' select the 'Image' radio button for

this example. This option will allow the RGB(N) values of the loaded image(s) to be

stored with the exported LAS point data. The other two RGB(N) options are explained

in the LAS Export  topic.

Click on the 'Layout' tab and create a name for the exported data in the 'File' text box.

Click 'Export' at the bottom of the interface.

710
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4.) To view the RGB data, close the current project in MARS® and open a new, empty project, or

unload the current data.

5.) Open the newly exported file by clicking on the top half of the 'Add LAS Files' button on the

Project/Data Preparation Tab , and navigate to the output folder that was chosen for the

export. Select the file and click 'Open'. 

6.) Now select the 'Color by RGB' button  and the LAS file will appear rendered by the

RGB values stored with the points. To view the data more easily, click the 'TIN'  button.

This data can also be viewed in 3D as shown below.

162
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4.7.12 Color by User Data

Color by User Data

Merrick Advanced Remote Sensing (MARS
®

) Software

 Color by User Data: Displays LiDAR points rendered by values stored in the 1-byte 'User Data'

field which can contain nearly any type of data depending on the settings of the post-processing

software that created the LAS file.  Among other applications, this field has been used to store Auto-

Gain Control values at the time each collected point was recorded by the sensor.  These AGC values,

specific to Leica sensors, tell the user how the system was attempting to center the intensity

histogram at the time of collection.  Another possible use is the storage of a value denoting the
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confidence that the post-processing software has in classifying points as noise.

Below is an example of LAS data colored by User Data when AGC values are stored.

The Inspect button  can show the User Data value of a particular point.  Click on the Inspect

button and click on the point for which information is needed.  The chosen point will flash twice and

then remain highlighted in white at a larger symbol size to identify itself.
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4.7.13 Color by Z Delta

Color by Z Delta

Merrick Advanced Remote Sensing (MARS
®

) Software

 Color by Z Delta (not available with Evaluation license): This tool will color the points in the

LiDAR data by the vertical difference between adjacent collection scans.  To see how this tool is used

for QA/QC procedures, please see the Color By Z Delta Analysis  section.1568



MARS® v2023.1           User Manual868

© 2000-2023 Merrick & Company

Clicking the 'Color by Z Delta' button will bring up the 'Z Delta Colors Options' window. 

Increment: Specify here how many elevation units should be between each of the four

principal colors.

Complete color cycle: This text box will automatically update to tell the user how many total

vertical units will be included in the complete color cycle (four colors).

Using average TIN: If this check box is used, the Z-Delta will be determined using the

average TIN value of all collection scans. 

Pick a collection scan as reference: This drop-down box is automatically populated with

the collection scan numbers of the collection scans shown in the LAS Map View at the time

the 'Color by Z Delta' button was clicked.  If the user would like to have the Z-Delta be

determined for the overlap areas of collection scans adjacent to one particular collection scan,
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then this option should be used.  Make sure the 'Using average TIN' check box is unchecked if

using this option.

Display cut off value: The user has the option of entering a Z-Delta value in this text box

which would be considered out of the realm of possibility.  For example, in one collection scan

a car may have been parked beside the road when the LiDAR points were collected, causing

some of the returns to be from the top of the car.  In the next (adjacent) collection scan the

car is absent, and LiDAR points were collected from the road which was beneath the car. 

Because the two collection scans collected slightly different data, they will vary vertically in

this area.  The 'Color by Z Delta' tool will bring this discrepancy to the user's attention.  An

entry in the 'Display cut off value' text box tells the process to ignore data areas with a greater

Z-Delta.  Entering a value of '4' for example, the Z-Delta between a car on the side of the road

vs. no car on the side of the road will be ignored and no data coloration will be applied in this

area.

Example: The data in the screen shot below has been properly boresighted.  The user has chosen a

collection scan as a reference compared to any overlapping collection scans, and an increment of

0.15 units.  The results show that most of the ground points are green - this means that the Z-Delta in

these overlap areas is less than or equal to 0.15 units.  The areas of yellow show a Z-Delta between

0.15 and 0.30 units, the areas of orange show a Z-Delta between 0.30 and 0.45 units, and the red

areas show a Z-Delta between 0.45 and 0.60 units.  These areas of yellow, orange, and red should be

QC'ed carefully to make sure that the larger Z differences are explainable. 
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4.7.14 Displaying Contours

Displaying Contours

Merrick Advanced Remote Sensing (MARS
®

) Software

Contours can be generated for any selected viewing area that is zoomed in on the data at 100% point

density. To see the density percentage, check the left side of the Status Bar . Contours will update

dynamically with editing point classifications and will recalculate when panning or zooming in the LAS

Map View window. To learn how to use this tool, see the Contouring Tutorial .

Note: This tool is only for displaying contours 'virtually'. By having the ability to contour on-the-fly this

tool is useful for determining how the contours will look  when they are exported. It is also used in the

boresighting of LiDAR data, because the user can contour by collection scan and thus see the

158
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misalignment between collection scans. Use this tool to visually determine the appropriate settings.

MARS® can easily export contours as shapefiles; however, contours CANNOT BE EXPORTED

USING THIS TOOL. To export contours go to the Data Export  topic or to the Contouring Tutorial

and enter the settings into the dialog to export contours. To view more about the contour options

settings, please see the 'Virtual Contours Options' topic in the Analysis Tab  section.

The virtual contouring tools can be found on the Analysis Tab

:

 ‘Options’: This interface is used to set the contouring options such as the contour

interval, minimum contour length, index contours, and which classifications will be included in

the contouring.

658 1643
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 To learn more about the options in this interface, please visit the 'Virtual Contours Options' topic in

the Analysis Tab  section.

 ‘Area to Display’: Allows the user to draw a box to define the area to be

contoured, and is enabled only if the point density is 100%.

 ‘Clear Display’: Click to remove contour lines from the LAS Map View display.

Another way to toggle contours on/off within the visible extent is to press 'C' on the keyboard.

 ‘Toggle On/Off': This button toggles the contour lines on and off. Another way to

toggle contours on/off within the visible extent is to press 'C' on the keyboard. Contours can only

be viewed when the area for contour generation has been zoomed into at 100% density, or by

using the 'Lock to view 100%' tool on the View Tab . To see the density percentage, check

488
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the left side of the Status Bar .

To view the data in 3D mode, click the ‘3D Perspective’  button on the View Tab . Use the

‘Pan’  function on the Navigation Tab  or the Quick Access Toolbar  to rotate the

dataset. Please note that the user must return to 2D View mode to update the display to a higher

resolution or a different coverage area than the current 3D view.

158
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4.7.15 Displaying Grids

Displaying Grids

Merrick Advanced Remote Sensing (MARS
®

) Software

A grid defines geographic space as an array of equally sized square cells arranged in rows and

columns. The 'Build Elevation'  tool and the 'Build Intensity' 

tool are used to 'virtually' simulate the effects of the gridding tools on elevation data in MARS®. This

will not affect the loaded data or any other grids that are exported. These tools create virtual grids, so

no files are being generated upon gridding an area. The purpose of these tools is for display only. The

tools are used to visually derive the settings that will be applied when exporting LAS data to the

various grid types. This simulation tool allows the user to define grid cell size, grid generation method,

and the grid display type.

MARS® can export the following grid formats, Float Grids (FLT) , ASCII Grids , ENVI Elevation

Grids , ENVI Elevation and Class Grids , and TIFF Grids . For more information about how to

export data, please see the  Data Export  topic.

The virtual gridding tools can be found on the Analysis Tab  :

 Options: Allows the user to choose the size of the cells in the grid, how the grid is

691 688
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displayed, and which classifications are used to generate the grid.

 Build Elevation: Allows the user to create an elevation grid by dragging a box

around the area to be gridded. This tool is meant to be used only after setting the virtual grid

options with the 'Options'  button.

 Build Intensity: Allows the user to create an intensity grid by dragging a box

around the area to be gridded. This tool is meant to be used only after setting the virtual grid

options with the 'Options'  button.

 Smooth Data: Applies a smoothing algorithm to the gridded surface.

 Build Normals: Generates normal vectors for each cell. Also known as a surface

normal, a normal vector is a three-dimensional vector which is perpendicular to the surface.
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 Clear Display: Allows the user to clear any grid. 

How to Display A Grid:

1.) Zoom to the area to be gridded. 

2.) Click on the 'Options' button  .  Set the parameters of the interface for use. 

Grid Spacing: This will be the cell size for each cell in the gridded area.

Grid Generation: The user can specify here whether the grid should be built from a virtual

TIN, from the min Z point of the cell, or from the max Z point of the cell.

Classifications Included: Click the 'Select' button to choose which classifications will be

included in the grid generation. Typically, only ground classes are used.

3.) Click 'OK' to set the parameters of the grid.

4.) Choose to build either an Elevation Grid or an Intensity Grid by setting the appropriate rendering

option on the View Tab  (  or ), then clicking on the appropriate button on the

'Analysis' tab

 (  or ).

5.) Left-click the mouse and drag the cursor starting in the upper-left corner of the area to be gridded.

Drag a box to the lower-right corner of the area and release the mouse button. The grid will be

automatically generated at this time.  The LiDAR data can now be turned off to see the grid

better. 

6.) If need be, use the 'Smooth Data'  button to smooth over the gridded data, and/

or use the 'Build Normals'  button to generate normal vectors for each cell.

192



Tools and Functions 877

© 2000-2023 Merrick & Company

7.) Use the '3D' button  to view the grid in perspective view.

8.) To remove the grid, click on the 'Clear Display' button. 

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.16 Elevation

Color by Elevation

Merrick Advanced Remote Sensing (MARS
®

) Software
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To see data colored by relative elevation, click on the 'Color by Elevation'  button on the View

Tab , or press Ctrl-E on the keyboard.

By default, MARS® displays LiDAR point data by elevation, as shown in the following image. In this

rendering mode, the LiDAR data is colored based on its elevation values. In all cases, the “hotter”

colors like white and red represent the higher terrain, while the lower elevations are rendered with

“cooler” colors like dark blue and magenta.

The following image shows the LiDAR point cloud data rendered by relative elevation.

The following image shows a TINned surface of LiDAR data, rendered by elevation.

192
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The following image depicts a TINned surface colored by elevation in 3D (perspective) mode. To view

the data in 3D (perspective) mode, click the ‘ 3D’  button on the View Tab . Use the ‘Pan’

 function on the Navigation Tab  or the Quick Access Toolbar  to rotate the dataset.

Please note that the user must return to 2D View mode to update the display to a higher resolution or a

different coverage area than the current 3D view.

192
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See also  Elevation Rescale , Elevation Throughout , and Elevation Repeat .

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.17 Elevation Repeat

Elevation Repeating Color Cycles

Merrick Advanced Remote Sensing (MARS
®

) Software

Color cycles are used to alter the surface rendering for manual editing activities. By modifying the color

cycle parameters, the user is able to visualize the surface for manual editing and where corrections

885 886 880
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need to be made to the classified dataset. To view a LiDAR surface, the user must display only

Ground (typically class 2) and Model Key-points (typically class 8), set the rendering style to display

the LiDAR points by elevation  , and select the TIN mode  to generate a surface.

The following image shows the TINned LiDAR surface prior to modifying the default color cycles

display. In general, modifying the color cycle settings allow the user to identify areas with small

changes in elevation, where manual editing if most often necessary.

To update the color cycle parameters, the user can either press the ‘Z’ button on the keyboard, or
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click the 'Elevation Coloration Options' button  and choose the 'Repeat' option to open

the following dialog:

To update the elevation increment, type in a new value (must be greater than zero) in the ‘Increment’

text box. This parameter allows the user to define the number of units between the principal color

changes.
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The user may also update the number of color gradations by typing a new value in the ‘Number of

Colors’ section. This value controls how many colors are used within each elevation increment.

Once the use has input the new values, the color bar will update based on the new parameters. To

make the specified settings the new default settings, click on the 'Make Defaults' button.

To view the changes to the color cycle parameter in the LAS Map View window, click ‘OK’. The

following image displays the new color cycle rendering, based on the new parameters. The elevation

repeat display option is also available in the Cross-Section/Profile window. To color the cross-section/

profile window by elevation repeat, follow the directions just described for the LAS Map View window.
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Make sure the cross-section/profile window is active (highlighted in yellow) by clicking on its tab before

making coloration changes. The shortcut 'Z' key will also bring up the 'Elevation Repeat Colors

Options' dialog for the cross-section/profile window. The settings inside this dialog will be applied to

both the cross-section/profile window and the LAS Map View window. 

Recommended Color Cycle Settings

The following list represents typical color cycle settings based on the client’s contour interval

requirement.
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Contour
Interval

Cycles

1 foot 3-10

2 feet 4-10

5 feet 5-10

1/2 meter 1-10

1 meter 2-10

See also:

Elevation

Elevation Rescale

Elevation Throughout

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.18 Elevation Rescale

Elevation Color Rescaling

Merrick Advanced Remote Sensing (MARS
®

) Software

By default the elevation color display is set to 'Rescale'. Pan around in the sample data and notice that

the elevation colors displayed are constantly rescaled for the data contained in the current extent of

the LAS Map View window. This can be set by clicking the 'Elevation Coloration Options' button

 on the View Tab  and choosing the 'Rescale' option from the drop-down list.

See also:
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Elevation

Elevation Throughout

Elevation Repeat

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.19 Elevation Throughout

Elevation Color Throughout

Merrick Advanced Remote Sensing (MARS
®

) Software

To hold the Elevation coloring constant while panning through the data use the 'Elevation

Throughout' option.  This is enabled by clicking the 'Elevation Coloration Options' button

 on the View Tab  and choosing the 'Throughout' option from the drop-down list.  Pan

around through any loaded LAS data and notice that the coloration values are held constant

regardless of extent.

See also:

Elevation

Elevation Rescale

Elevation Repeat

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.7.20 Intensity

Color by Intensity

Merrick Advanced Remote Sensing (MARS
®

) Software

To see data colored by intensity, click on the 'Color by Intensity'  button on the View Tab , or

press Ctrl-I on the keyboard.

LiDAR data can be viewed by intensity, which is a quantitative measure of the intensity for each return.

 For 16-bit data the intensity values range from 0 to 65535, where 0 represents the darkest reflections

(ex. new asphalt) and 65535 represents the brightest reflections (ex. white rooftop).

The following image shows the LiDAR point cloud data rendered by intensity.

192
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The following image shows a TINned surface of LiDAR data, rendered by intensity.

The following image depicts a TINned surface colored by intensity in 3D (perspective) mode.  To view

the data in 3D mode, click the ‘3D’  button on the View Tab .  Use the ‘Pan’ 

function on the Navigation Tab  or the Quick Access Toolbar  to rotate the dataset.  Please note

that the user must return to 2D View mode to update the display to a higher resolution or a different

coverage area than the current 3D view.

192
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See also Intensity Gray-scale Only , Intensity Color Extremes , and Intensity Equalize .

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.21 Intensity Color Extremes

Intensity Displayed in Color Extremes

Merrick Advanced Remote Sensing (MARS
®

) Software

This setting, one of the choices in the Coloration Options | Intensity  drop-down list, allows all

892 889 890
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extreme low and high intensity values to be displayed in color.  When selected, a control pops up to

allow the low and high thresholds to be entered.  For example, if 58000 is entered as the 'High

threshold' and 10 is entered as the 'Low threshold', all points with intensity values of 58000 or higher

will be rendered in blue and all points with intensity values of 10 or lower will be rendered in yellow.

See the 'Coloration Options | Intensity'  section of the View Tab  topic for a description

of intensity values.  The user must select the 'Color by Intensity'  button to be able to see the

effect of this option.

See also:

Intensity

Intensity Gray-scale Only

Intensity Equalize

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.22 Intensity Equalize

Intensity Equalize
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Merrick Advanced Remote Sensing (MARS
®

) Software

To use the Intensity Equalize option, click the 'Coloration Options | Intensity' button  on

the View Tab and check the 'Equalize" box.

Equalize: By default the intensity color display is set to 'Equalize'.  Using this option, the intensity

display will be equalized every time the user moves around the project, zooming in or out, or viewing

different areas.  This tool will take the intensity ranges within the LAS Map View window and use a

histogram stretch on the data so the data is more defined and can be viewed more easily.  This tool

works similarly to the Elevation Rescale  option, but with intensity value data.

Ex: Below is an example of color extreme intensity data with the Equalize option checked on.  Notice

the detail of the data at all extents.

Ex: Below is an example of color extremes intensity data with the Equalize option checked off.  There

is less detail in the same data at the same zoom level as the screen shot above.

885
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See also:

Intensity

Intensity Gray-scale Only

Intensity Color Extremes

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.23 Intensity Gray-scale Only

Intensity Displayed as Gray Scale

Merrick Advanced Remote Sensing (MARS
®

) Software

Intensity values rendered in gray-scale is the default mode of displaying intensity data.  See the 

'Coloration Options | Intensity'  section of the View Tab  topic for a description of

887
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intensity values.  The user must select the 'Color by Intensity'  button on the View Tab  to be

able to see the effect of this option.

See also:

Intensity

Intensity Color Extremes

Intensity Equalize

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.24 LiDAR/Imagery Transparency

LiDAR/Imagery Transparency

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'LiDAR/Imagery Transparency'  slider bar is used to control the

transparency of the LiDAR data loaded over an image file. Move the slider bar back and forth to see

how the LiDAR can be made anywhere from 0 (left side of slider) to 100% (right side of slider)

transparent. The transparency of the LiDAR data controls how much of the underlaying imagery is

seen. This is helpful in checking the co-registration of datasets or identifying features in corresponding

datasets.

The following examples show the effect of moving the slider to the left (LiDAR) position...

192
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...to the center position...
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...and to the right (Image) position.
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4.7.25 Lock to view 1%

Lock to view 1%

Merrick Advanced Remote Sensing (MARS
®

) Software

 Lock to view 1%: This tool, found on the View Tab , locks on only the 'thinned points,' the

minimum set of points that can be displayed for loaded LAS files.  This can speed up panning

192
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and zooming operations while the area of interest is being determined.  The density percentage

indicator on the left side of the Status Bar  shows the percentage of points which are

currently being displayed.

 

Note that the actual percentage of points displayed may be less than 1% depending on the data

loaded.

© 2000-2023 Merrick & Company. All Rights Reserved. 

4.7.26 Lock to view 100%

Lock to view 100%

Merrick Advanced Remote Sensing (MARS
®

) Software

 Lock to view 100%: This tool, found on the View Tab , is intended for hand editing purposes,

when using the Flood Fill  utility, and when displaying virtual contours.  The density

percentage on the left side of the Status Bar  tells the user the percentage of points which

are currently being displayed. 

 

Hand editing should be done ONLY when viewing points at 100% density.  It is easy for the

editor to zoom in/out or lose/gain point density frequently throughout the hand editing process

by maneuvering around the project, and this tool allows the editor to lock the point density of the

display at 100% regardless of zoom level.

If navigation is slowed too much with this tool enabled, toggle it off, move to the desired area, and re-

158
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enable the tool.  The tool will reset to the 'off' mode when all loaded LAS files are removed and must be

manually toggled back on (if desired) after new data is loaded.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.7.27 Point Density

Point Density

Merrick Advanced Remote Sensing (MARS
®

) Software

Point Density slider bar: This control, found on the View Tab , changes the point density in the

LAS Map View window. The user must be zoomed in to at least 4% before the slider bar will

take effect. The point density slider bar does not work inside the Cross-Section/Profile

window. To TIN  the data being viewed, the slider bar must be set to the far left. If the

bar is not set to 0 before the TIN button is clicked, an error window will appear.

Ex: Point Density set at 'Less' position  to allow data to be rendered by TIN

 . 

192
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Ex: Point Density set at 'More' position  .  TINning cannot be done at this

setting.
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The actual percentage of points being displayed (point density) can be found on the left side of the 

Status Bar . As the Point Density slider bar is moved left or right, this percentage will change

accordingly. 

In the example below, the slider bar is set to display fewer points. In this case, 9% of the points are

being displayed.

158
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In the example below, the slider bar is set to display more points. In this case, 33% of the points are

being displayed.
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4.7.28 Show Breakline Vertices

Show Breakline Vertices

Merrick Advanced Remote Sensing (MARS
®

) Software

 Show Breakline Vertices (available with Production license only): This tool, found on both

the View Tab  and the Breaklines Tab , symbolizes the vertices for all loaded breaklines,

and labels each with the ID number stored in the shapefile attribute table.

 

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.7.29 Vertical Scale

Vertical Scale

Merrick Advanced Remote Sensing (MARS
®

) Software

Vertical Scale slider bar:  MARS® is capable of vertically rescaling data while in

3D View  mode in the LAS Map View window. The slider can be dragged to the right

(exaggerate) or left (de-exaggerate) from its center position.  Above the slider bar is a vertical

scale text box that allows entry of an exact scale value.  Type in the scale (relative to

horizontal) at which the data is to be viewed and press 'Enter' on the keyboard. The minimum

value is 0.01 and the maximum is 1000. The '1x ' button will revert back to a 1:1 scale.

A separate vertical scale control is located on the Cross-Section/Profile Tab  (and the optional

Cross-Section/Profile toolbar) for use in the Cross-Section/Profile  window.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8 Data Utilities

Data Utilities

Merrick Advanced Remote Sensing (MARS
®

) Software

For any LAS Tools (including 'Add Spatial Index') that allow files to be pathed out without

836
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loading them in the Table of Contents in MARS®, an up-conversion prompt will appear when

executing the tool if the LAS files do not meet the minimum MARS® compliancy requirements.

This prompt is described in the Project/Data Preparation Tab  topic.

MARS®  includes a variety of tools and functions to aid in the exploitation and analysis of LiDAR data.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.1 Add Spatial Index

Add Spatial Index

Merrick Advanced Remote Sensing (MARS
®

) Software

To use the 'Add Spatial Index' tool, please visit the Project/Data Preparation Tab  topic or follow the

instructions below.

NOTE:  For best stability and faster performance, LAS files that have been spatially indexed in an

older version (v2019.3 or earlier) should be re-indexed using version 2020.0 or later of MARS®.

This can be done quickly in two steps using the multi-threaded 'Add Spatial Index' tool - the 'Fast

Remove Index' option followed by the 'Add Spatial Index' option.  See the paragraph immediately

before the screen shot of the tool interface for more information.  Also note that issues may occur

with LAS files if they are spatially indexed in a newer version of MARS® and then have their

index records removed in an older version.

162
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Add Spatial Index: This tool  is found on the Project/Data Preparation Tab  and

performs a spatial index on one or more LAS files to enable MARS® to read and display the point data.

It can add spatial index information, remove it (which may be necessary for using the files in other

software), or mark any existing spatial index records as superseded.  There are two ways to use 'Add

Spatial Index':

1) Add LAS files to MARS®

If LAS v1.4 data without the necessary spatial indexing is among the files selected to

be loaded into MARS®, the user will be provided a list of those files and three options for

handling them:

162
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a) Choosing 'Spatially Index LAS Files and Add Them to Project' will permanently prepare the

data (by modifying the file header) for viewing.  This process may be multi-threaded by

entering a number greater than 1 in the 'Number of threads to use' text box before clicking the

'Spatially Index...' button.  Please note the explanatory text in the interface (see above)

concerning multi-threading.  For best performance, there should be a minimum of eight (8) GB

of RAM available (not just installed) per thread.  Multi-threading the Spatial Indexing functions

across a USB 2.0 connection is not recommended as the intensive file reads/writes (disk I/O)

may cause hangs or slower overall performance than single-threading.  USB 3.0 or later can
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be used, but may be limited in performance depending on the access speed of the external

drive.

A second window will appear with options for File Source / Point Source ID numbering.

Depending on the user's preference or requirements, the files can be sequentially

renumbered (in the order listed in the original window) by choosing the 'Assign collection

scan numbers to all files' radio button and entering a starting number, or they can be

indexed with no changes to any collection scan numbering they already have by

choosing the 'Retain existing collection scan numbering for all files' radio button.  The



MARS® v2023.1           User Manual908

© 2000-2023 Merrick & Company

'Retain' option is the default.  Please read the method descriptions and caution

statement before proceeding. 

If using the 'Assign' option, please note that LAS version 1.4 files are limited to

collection scan numbers of 1 to 65,535.  Keep this limit and the total number of files in

mind when entering a starting number.

After the choice has been made, click 'OK' to start the indexing and a status bar

window will pop up.  During this time, all files will be tested for empty 'System Identifier'

header fields, and if found, will have this field populated with 'OTHER' (see the LAS file
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specifications on the ASPRS LAS File Format website).  Files with values already in

place will not have this field altered.  When complete, the files will be loaded. 

b) Choosing 'No Change to LAS Files and Add Them to Project' will temporarily prepare the

data for the current session of MARS®.  When indexed in this manner, no changes are made

to the file header and the data will need to be re-indexed (either permanently or temporarily) if

it is later loaded into another MARS® session.

c) Choosing 'Ignore (Will not Add Them into Project)' will cancel the loading of any files without

spatial indexing, but will load any previously indexed ones that were part of the original

selection.

2) Using the Add Spatial Index interface - This method will modify the LAS files when spatial index

information is added, removed, or superseded.

To bring up the interface, click the 'Add Spatial Index ' button on the Project/Data

Preparation Tab . 

Navigate to the files to be spatially indexed by clicking on the 'Add' button. Files may

be removed from the list by highlighting them and clicking on the 'Remove Selected' or

'Remove All' buttons.

If adding spatial indexing, choose one of the 'Collection scan options':

Incremental: Assigns sequential collection scan numbers to each LAS

file in the list to be spatially indexed. Using this option will overwrite any

existing collection scan numbering in the LAS files.  Enter the desired

starting number in the 'Starting collection scan number' text box, keeping

in mind that LAS version 1.4 can have collection scan numbers of 1 to

65,535.  If multi-channel files are being processed, check the 'Group Multi-

162
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Channel LAS files (one number per group)' box to have the same collection

scan number assigned to each file in the group.  The tool requires that

files in a multi-channel group be named identically starting with the

letter 'L' except for a unique digit denoting the channel number

following the mandatory letter 'C' - for example, 'L1-1-140324_A-C1_r.

las and 'L1-1-140324_A-C2_r.las' - for this collection scan numbering

method to work.

No Assign - Keep the collection scan number of every point: No

changes are made to collection scan numbering that may exist in the LAS

files.  This is the default.

Set all files to one collection scan number: Assigns only one

collection scan number to all listed files.  This option will overwrite any

existing collection scan numbering in the LAS files.  Enter the desired

number in the 'Starting collection scan number' text box, keeping in mind

that LAS version 1.4 files are limited to collection scan numbers of 1 to

65,535.

WKT: This area shows any existing WKT-based coordinate reference system

definition for the added files and allows the information to be edited.  Changes made

here will be applied only when adding spatial indexing.  See the procedure outlined in

the 'Add CRS Info (to LAS Files)' topic in the Coordinate Conversion  section of this

help file for details.

Multi-Threading: The 'Add Spatial Index' tool is capable of multi-threading the indexing

process.  To multi-thread (which may shorten the processing time), enter the desired

number of threads up to the maximum available for the computer in the text box.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not

just installed) per thread.  Multi-threading the Spatial Indexing functions across a

252
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USB 2.0 connection is not recommended as the intensive file reads/writes (disk I/O)

may cause hangs or slower overall performance than single-threading.  USB 3.0 or

later can be used, but may be limited in performance depending on the access speed

of the external drive.

Class options: This option allows a second spatial index to be created based on all

classes EXCEPT the one(s) listed in the 'Majority Classes' box.  Click the 'Select'

button to choose the desired majority classes.  When one or more of the chosen

classes are turned off using the Classification   button on the

View Tab , performance is increased during display-related operations such as pan

and zoom.  In addition, a higher percentage of the available point cloud will be

displayed for a given window extent.  If more than one class was chosen as a

majority class during 'Add Spatial Index', the performance boost will be highest when

all majority classes are turned off.

VLR/EVLR options: The 'Remove all VLRs/EVLRs before spatial indexing' option

(unchecked by default) can be used to completely remove all Variable Length and/or

Extended Variable Length Records (not just indexing records) from the LAS files

listed in the 'Files to spatial index' box during the 'Add Spatial Index' process.  This

function works only when adding indexing, not when using the 'Remove Spatial Index'

or 'Fast Remove Index' buttons.

Note:  All files will be tested for empty 'System Identifier' header fields and, if found,

will have this field populated with 'OTHER' (see the LAS file specifications on the 

ASPRS LAS File Format website).  Files with values already in place will not have

this field altered.

Click 'Add Spatial Index' to index the data, or 'Remove Spatial Index' to delete any

existing spatial index records.  Removal will make LAS file sizes a little smaller, but

will cause the files to be unloadable in future MARS sessions unless they are re-

192
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indexed.  The 'Fast Remove Index' button will mark all indexing records as

superseded (ignored) without actually deleting them.  As with complete removal, this

makes the files unreadable in future MARS sessions unless they are re-indexed, but

the re-indexing process will be much faster.  Either of the removal options may be

helpful in loading data into other lidar software.  Neither the 'Remove Spatial Index'

function nor the 'Fast Remove Index' function will make any changes to collection

scan numbering.
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When a spatial indexing or removal of spatial indexing is successfully completed,

MARS® will alert the user with the following messages:

         

         

Clicking the 'Clear' button near the bottom of the interface will empty the 'Status' area so

that more files can be spatially indexed.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.2 Advanced Profiler

Advanced Profiler Tool

Merrick Advanced Remote Sensing (MARS
®

) Software
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 Advanced Profiler: This tool, found on the Export/Extract Tab , will create equally-spaced

profile lines along a centerline at an interval specified by the user. This tool will perform on any

polyline shapefile loaded into MARS®. There are three ways to use this tool: 1) Using and

showing only the centerline with no profile lines, 2) using and showing both the centerline and

profile lines, and 3) using and showing only the profile lines with no centerline.

Parameters:

Centerline Shapefile: Click 'Browse' to navigate to the centerline file to be used. This

centerline file may be any polyline shapefile (.shp); for example - a road centerline, a stream

centerline, or a river centerline.

Source Classifications: Choose the 'Select' button to define which classifications will be

used when creating the profile lines. To create an advanced profile line based on the ground

surface, choose only those classes that represent the ground - typically Class 2 (Ground). 

Keep in mind that ground may exist in other classes, depending on the project data.

Interval along the Centerline: The interval between profile lines (lines perpendicular to the

original centerline shapefile) can be defined by the user here. A larger number indicates more

space (horizontal units) between profile lines.

Profile Distance from the Centerline: The user may specify the distance the profile line

(which is perpendicular to the centerline) will extend from the centerline on both the right and

left sides.

Draping Algorithm: The user may choose to show and create the advanced profile by TIN or

Grid. Using the Grid option allows the user to further define the grid cell size and to apply a

Gaussian smoothing mechanism to the grid if need be.

Save Draped Centerline: Checking this option will saved the draped centerline as well as

the perpendicular profiles which lie along that line. When this option is not checked, MARS®

saves only the profiles perpendicular to the centerline and not the draped centerline itself.

460
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Cut Depth: This is the total width of the buffer (in project units) used to check for LiDAR

points around the profile lines. Smaller values will speed processing and allow for longer input

centerlines, but accuracy may suffer if there are not enough points in the Source

Classifications in this buffer area.

Output Options: Choose the output type - 'Save As Shapefile' for a 3D shapefile, 'Save As

CSV' for a file of XYZ values that can be opened in Excel, or 'Save As DXF (2D Cross Section

and Centerline)' for engineering use in a CAD program. Use the 'Browse' button to the right of

the 'Output Shapefile', 'Output CSV file', or 'Output DXF File' text box and navigate to the

output folder the advanced centerline shapefile, CSV file, or DXF file should be saved in. Name

the new file, and click 'Save'. For the 'DXF' option, make the appropriate entries in the 'Number

of Columns', 'X Step', 'Z Step', 'Vertical Exaggeration', and 'Beginning Station Number' text

boxes. The effect of these five parameters can be seen in the examples at the bottom of this

page.

Using the Advanced Profiler tool:

1) First use the 'Draw 2D Centerline' tool on the Vector Creation Tab  to create a 2D

shapefile centerline line along an area which is to be profiled. Do this by selecting the 'Draw

2D Centerline'  button and then left-clicking along the desired line.

Right-click to end the centerline. In the examples below, the 2D centerline was drawn along

a river.

2) To save this 2D centerline for use in the Advanced Profiler tool, click on the 'Save 2D

Shapefile'  button. At this time, the 2D centerline just created will be unloaded

from MARS®, but will be saved in the output folder which was specified by the user.

3) Click on the 'Advanced Profiler'  button to bring up the interface. The parameters inside
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the interface are described above. Choose the particular settings which are needed and

click 'OK' when finished. When an advanced profile is saved, a *.prj (projection definition file)

is created if the projection information is known for the source LAS data, and if the output

type is Shapefile. Please see the bottom of this section for more information on the three (3)

different uses of this tool. 

4) When the advanced profile has been created, the user will be notified with one of the following

pop-up messages (depending on the output type):

      for shapefile or CSV     -- or --    

     for DXF

5) The advanced profiler has now created a 3D shapefile, CSV file of XYZ values, or 2D DXF file

and stored it in the folder, and with the name, designated by the user. To load a newly

created shapefile in MARS®, click on the 'Add Reference Shapefiles' button on the

Project/Data Preparation Tab . The shapefile will appear in the Table of Contents under

the 'Vectors' layer, and can be viewed in either 2D or 3D. To open the CSV file, use Excel or

a text editor. To view the output of the 2D DXF file option, load the file in any CAD or GIS

program that can read DXF files.

6) To remove a loaded shapefile from MARS®, right-click on the file in the Table of Contents and

choose 'Remove'. 
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The three uses of the Advanced Profiler tool:

1) Below is an example of the advanced profiler being used in 3D and showing only the

centerline with no profile lines. The corresponding settings are also shown in the 'Advanced

Profiler' interface. The most important settings are to enter a '0' in both the 'Left Side' and 'Right

Side' text boxes. This tells MARS® to create profile lines with a length of '0' (zero), which would

create no profile lines at all. Make sure the 'Save Draped Centerline' option is chosen to create

the 3D centerline shapefile.
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2) Below is an example of the advanced profiler being used in 3D and showing both a centerline

and the profile lines associated with it. The corresponding settings are also shown in the

'Advanced Profiler' interface. The most important settings in this case are to enter an integer in

both the 'Left Side' and 'Right Side' text boxes and in the 'Interval Along the Centerline' text box.

This will create the profile lines perpendicular to the centerline. Make sure the 'Save Draped

Centerline' option is chosen to also create the 3D centerline.
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3) Below is an example of the advanced profiler tool being used in 3D and showing only the

profile lines with no centerline. The corresponding settings are also shown in the 'Advanced

Profiler' interface. The most important settings in this example are to enter an integer in both the

'Left Side' and 'Right Side' text boxes and in the 'Interval Along the Centerline' text box. This will

create profile lines. Make sure the 'Save Draped Centerline' option is unchecked so a 3D

centerline will not be created.
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CSV Output: 

The table excerpt below shows the formatting of the CSV file output.  The first column is the

feature number, then X, Y, and Z in the last column.  Feature number is based on start to end of

the centerline used to generate the profile info.  For example, if only the centerline is saved

(example 1 of 'The three uses of the Advanced Profiler tool:' topic, above), the feature

number will be the same for all XYZ values of the centerline.  If both the centerline and the

transects (profile lines) are saved (example 2, above), the transects will be numbered from the

beginning of the centerline to its end (as it was compiled) and the final feature number will be

the centerline itself.  If only the transects are saved (example 3, above), they will be numbered

from the beginning of the centerline to its end as mentioned above.
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DXF Output:

Below are examples of the output when the 'Save As DXF' option is chosen.  The first image

shows the complete DXF with the profiles drawn at every 10 feet along the centerline ('Interval

Along the Centerline' setting), starting in the lower left corner and proceeding to the right.  Note

the ten columns of profiles as per the 'Number of Columns' setting in the interface.
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A detail view of one profile from the above DXF is shown below.  As per the parameters in the

interface, the 'X Step' is 10 units (vertical tan-colored lines with blue annotation), the 'Z Step' is 2

units (horizontal tan-colored lines with green annotation), and the 'Vertical Exaggeration' is set

to 1 (one vertical unit per one horizontal unit).  The blue vertical line represents the position of

the centerline, and the 'Left Side' and 'Right Side' values in the interface are set to 75 units.  The

red line shows the actual elevations of the profile line at this particular station (K0+000.00 units

along the centerline - this is the beginning of the centerline where the first profile was created). 

The 'Beginning Station Number' can be set as needed, and the calculated values will be shown

in the lower-right of each profile.
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4.8.3 Convert Check Points CSV to 3D Shapefile

Convert Check Points CSV to 3D Shapefile

Merrick Advanced Remote Sensing (MARS
®

) Software

To use the Convert Check Points CSV to 3D Shapefile tool, found on the Vector Creation Tab , follow

the instructions below:

This tool allows a CSV file of check points to be converted to a 3D point shapefile.  The shapefile format

provides for easier and more complete analysis of the check points in GIS software.  The source CSV

must be in the following format before the conversion tool can be run:

The first row of the CSV file must contain column headers and not actual check point values. 

The headers do not have to be named as shown in the example above, but the information must

be in that order.  The fifth and sixth columns are required if the file is to be converted to a

shapefile, but values for those columns are optional.  The fifth column is for a description (such

as park ing lot, intersection, etc.) and the sixth column is for the NVA (Non-Vegetated Vertical

Accuracy) and/or VVA (Vegetated Vertical Accuracy) status of the points.  For the sixth column

(NVA / VVA status), any value that is not stored exactly as VVA or vva (not case specific) or is

362
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empty will be interpreted as NVA.

To convert, browse to and select the CSV file, then browse to the desired path and enter a file

name (without the .shp extension).  Next, browse to and select the horizontal projection system

- this will allow the proper PRJ file to be written when the shapefile is generated.  The same

interface that is used for other coordinate reference system tools will appear (below, right).  See

the GeoCalc  and GeoEdit  help topics for more information on selecting a system.

    

Only one CSV file can be converted at a time.  When the settings are complete, click the

1585 1591
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'Convert' button.  If the tool does not find all the required columns present in the input CSV file, a

warning message will appear.

The completion message will appear when processing is finished.  

After loading the resulting shapefile in the Check Points  layer of the Table of Contents, the

attribute table can be viewed and edited by right-clicking the entry and selecting 'Attributes'.

128
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The Check Points shapefile can now be used in running a Check Point Report , or as input to

the USGS QC Module  beginning with version 2.1.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.4 Create Tile Scheme

Creating a Tile Scheme

Merrick Advanced Remote Sensing (MARS
®

) Software

To use the Create Tile Scheme tool, found on the Vector Creation Tab , follow the instructions below:

Create Tile Scheme: This option  allows the user to create a unique tile layout.  The newly

created tile layout will be found under the 'Tiles'  layer in the Table of Contents  where only one

shapefile can be loaded at a time.  If a tile shapefile is already loaded under the 'Tiles' layer, it will be

1221

1219

362
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removed and the new tile layout will be loaded in its place automatically.

Output Shapefile: Click the 'Browse' button to designate an output folder and name

for the tile shapefile being created.  Once this is completed, click 'Save'.  When a tile

shapefile is generated, a *.prj (projection definition file) is created if the projection

information is known for the source LAS data. 

Tile Size: Specify an X and Y length for the sides of each tile.  A larger number in

either text box will denote a larger tile.

Tile Starting Number: Choose a number for the Tile Name labeling to start at.  The

tiles will be named upward from the number specified (for example, if 100 is the

starting number, tiles numbered 101, 102, 103, 104... will follow).

Start Coordinate: If the user would like to specify the coordinate at which the tile

layout should start, check the 'Specify the start coordinate' check box.  The X and Y
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coordinates may be specified in the text boxes following this option.  After specifying

the coordinates, the user may further define which corner of the created tile layout

that the coordinates will represent.  The user may choose from: Lower Left, Upper

Left, Upper Right, Lower Right.

Add the Result to Project: Checking this box option will load the new tile layout to

the project after it is created.  If a tile shapefile is already loaded into MARS® under

the 'Tiles' tab and this option is checked, the shapefile already in MARS® will be

removed and the new tile shapefile will take its place under the 'Tiles' tab.  If this box

is left unchecked, the new shapefile will not be loaded into MARS® upon creation, but

it can be found in the output folder.

Tile numbering from top to bottom: If this box is checked, the tiles will be labeled

starting at the top left tile of the tiling layout and count upward, labeling tiles from left

to right.  When the end of the row is reached, the labeling will continue on the second

row from the top on the left most tile and continue from left to right.  If this box is left

unchecked, tile labeling will begin in the bottom right tile in the tiling layout.  Tiles will

be labeled counting upward from left to right.  When the end of the row is reached,

labeling will continue in the second row from the bottom in the left most tile and count

upward from the left end tile to the right end tile.  See the screen shots below for

visual examples.

EX: The following is an example of tile labeling with the 'Tile numbering from top to bottom'

option chosen.
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EX: The following is an example of tile labeling without the 'Tile numbering from top to bottom'

option chosen.
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Use extents rather than points: Checking this option will produce an MBR

rectangular tile layout that incorporates the extents of the data.  In this case, some

tiles in the tile layout that is produced may be empty tiles.  To create a tile layout

which only creates tiles which carry data, uncheck this option. 

Ex. Tile layout created with the 'Use extents rather than points' option checked.  Some empty

tiles are produced to make the tiling layout rectangular.
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Ex. Tile layout created with the 'Use extents rather than points' option unchecked.  Empty tiles

are avoided and the tiling layout is produced based on LiDAR points instead of the data extents.
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Calculate LAS Statistics, and save to Attribute Table: This option allows the user

to create statistics for each LAS tile.  By choosing this option, the user will make the

'Class Statistics' option available - the classes to be included in the statistics can

then be selected.  This option will populate the following statistics in the output tile

shapefile attribute table:

ID: A uniquely generated ID number for each tile created.

TName: The TName is a uniquely-generated tile name with a starting

number specified by the user.

AREA: The area in square project units of a particular tile.

ALLPCOUNT: A count of the total number of points within a particular

tile.

DENSITY: The point density in points per square unit (using first
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returns only).

AVG_GSD: The average GSD (ground sample distance).

X_MIN: The x axis (easting) minimum within a particular tile.

X_MAX: The x axis (easting) maximum within a particular tile.

Y_MIN: The y axis (northing) minimum within a particular tile.

Y_MAX: The y axis (northing) maximum within a particular tile.

Z_MIN: The z axis (elevation) minimum within a particular tile.

Z_MAX: The z axis (elevation) maximum within a particular tile.

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular

tile.

COLL_SCAN: A listing of the different collection scan numbers which

overlay a particular tile.

GPS_MIN: The GPS time (timestamp) minimum found within a

particular tile.

GPS_MAX: The GPS time (timestamp) maximum found within a

particular tile.

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various

intensity value statistics.

RETURN_0: The number of ‘other’ returns found within a particular tile

(returns that are missing or have incorrect point family info).

RETURN_1 through RETURN_15: The number of first returns through

fifteenth returns (listed in individual attribute fields) found within a

particular tile.

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found

within a particular tile.

MKP: The number of points bit-flagged as ‘Model Key-point’ found
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within a particular tile.

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within

a particular tile.

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a

particular tile.

Class0 through Class255: The number of points in each class (listed in

individual attribute fields) is recorded per tile.

ClassWH0 through ClassWH255: The number of Withheld bit-flagged

points in each class (listed in individual attribute fields) is

recorded per tile.

iShape: A MARS®-specific value that is not relevant for the user.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every tile will be omitted from the final attribute table to simplify

analysis.

It is also possible to view the statistics of attributes in a shapefile.  The user may view

the statistics of a single attribute, the statistics of an entire row or column, or the

statistics of an entire table. Highlight the attributes of which statistics are to be

viewed, right-click and choose 'Statistics'.  The resultant table will tell the user the

following statistics: the row count, minimum, maximum, sum, mean (average),

median, and mode of every attribute.  To select multiple attributes for statistic viewing

at once, use the 'Shift' or 'Ctrl' keys on the keyboard.  In the example below, the

user is choosing to view the statistics of six rows of data for the 'ALLPCOUNT' field. 

The resulting statistics are also shown below.
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© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.5 Flood Fill

Flood Fill Tool

Merrick Advanced Remote Sensing (MARS
®

) Software
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Flood Fill: This tool , found on the Analysis Tab , creates a virtual flood fill graphic that

allows the user to view areas of the loaded LAS data which would be inundated during a flood.  To use

this tool, click on the 'Flood Fill' button and the 'Flood Fill' dialog box will appear.  The user may specify

the water elevation (MSL) to analyze by entering a value in the 'Elevation' text box or by using the

'Elevation' slider to simulate different flood levels.  The user may also choose the color and transparency

of the flood fill graphic.  When all the selections have been made or when changing any of the

parameters, click 'Display' to see the results.  If the data is not already being rendered in TIN mode, the

tool will change to, and stay in, that mode.  The density of the LiDAR data currently being displayed, as

shown on the left side of the Status Bar  , will affect the accuracy of the TIN and,

therefore, the flood fill.  To obtain the most accurate results, the data should be viewed at 100% density.

 In 2D viewing mode, imagery may be used to aid in the flood analysis, but will be temporarily toggled off

when switching to 3D viewing mode.

It is also possible to save the flood fill shoreline to a 3D shapefile. Check this option and choose a

shapefile path and name to create a 3D shapefile, then click 'Save.'  To dismiss the flood fill graphic,

click 'Cancel' in the dialog box.

The examples below show the difference in flooding effects that can be expected at different water

surface elevations. The example on the left is flooding up to an elevation of 5263 feet. The example on

the right shows flooding up to 5277 feet. Note that the chosen fill color will change appearance

depending on the way the data is colored. 

488
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Another example of the Flood Fill tool in a 3D view:
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4.8.6 Hyperlink

Hyperlink Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

 Hyperlink: The Hyperlink tool, found under the 'Miscellaneous Options' section of the View Tab

, is associated with the 'Add EO File' tool which is located on the Project/Data Preparation

Tab  tab.  In order to use the Hyperlink tool, an EO file must be loaded into MARS® along with

its associated imagery path.  For more information concerning adding an EO file, please see the 

Project/Data Preparation Tab  topic.  Once an EO file is loaded into MARS® the Hyperlink

button will become enabled.  The purpose of the Hyperlink tool is to provide the user with a way to

display an aerial image associated with a particular EO event point.  The EO file is displayed as a

3D point shapefile and each point, or event, in the EO shapefile is associated with imagery. 

Because it is displayed as a shapefile, it is also possible to change the display settings of an EO

file by right-clicking on the file inside the Table of Contents and choosing 'Properties'.  The

resulting 'EO File Properties' window will allow the user to change the color and size of the point

shapefile and will also allow the user to display labels. 

192
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 When the user selects a point with the Hyperlink button toggled on, the associated image is then

brought up in the Windows default viewing program.  Below is an example of the imagery which

will appear when an EO event point is selected.  If the user selects a point from an EO file linked

to RGB nadir imagery, this is the imagery which will be displayed.  The same methodology

applies for linking to CIR nadir, forward-facing, and aft-facing imagery.

It is possible to display multiple EO files at once in MARS®.  The Hyperlink tool will only display

imagery with an associated EO file which is currently displayed in MARS®.  For example, if the

user has a  separate EO file loaded for the CIR nadir, RGB nadir, forward-facing, and aft-facing

imagery, it can be difficult to select the proper EO event file to bring up only one type of imagery. 

By using the options within the Vectors  layer of the Table of Contents  to turn off the display92 64
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of EO files which are not currently needed, it is much easier to select the proper point for display. 

It is possible to save all loaded EO files, paths to imagery, and any raster files which may be

loaded to a MARS® project file (*.mpd) for use at a later time.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.7 Inspect

Inspect Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

 Inspect: This utility displays the attribute information of a single displayed LiDAR point, virtual

contour line, check point, or shapefile feature (including breaklines), and it can be used in 2D View

or in the Cross-Section/Profile  window.  The 'Inspect' tool can be found on the View Tab , Cross-

Section/Profile Tab , and the Analysis Tab .  For LiDAR data, the chosen point will flash twice

and then remain highlighted in white at a larger symbol size to identify itself when selected for

inspection.  If a Cross-Section/Profile window is open, the point may be chosen in either view, and will

be highlighted in both views.  The one exception to this is in the Cross-Section/Profile window, where

the Inspect tool will identify the file name and collection scan number rather than a point when the data

is viewed in Profile by Collection Scan mode.

For virtual contours, a pop-up will display with the chosen contour's elevation.  For displayed check

points, the selected point will be highlighted as defined in the 'Selected Feature Highlighting' section of

the 'Display' interface on the Options Tab , and a pop-up will display the point's ID, XYZ values and

(if stored), a description, the point's NVA / VVA status, and the survey date of the point.  For displayed

shapefiles (other than those loaded as tile layouts) and breaklines, the selected feature will be

835
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highlighted as defined in the 'Selected Feature Highlighting' section of the 'Display' interface on the 

Options Tab , and a Properties table will be displayed with X, Y, and Z (if 3D) information.

The following information is displayed for an inspected v1.4 PDRF 8 LiDAR point using Adjusted GPS

Time (note that some fields are dependent on the data collected and the post-processing software

used).  Other LAS versions and PDRFs will vary from this example.

Parent file path and point source ID (PSID) number

X coordinate

Y coordinate

Z coordinate

Timestamp (Seconds of GPS Week, GPS Week Number, UTC time, local machine

time, local date, and Julian day)

Intensity value (pulse return magnitude, values 0 - 255)

Data Classification (0 – 255) and description

Bit Flag status for Synthetic, Key-point, Withheld, and Overlap (not stored for pre-

LAS v1.4 data)

Return number (pulse return number out of number of discrete returns for a given

outgoing pulse)

File position

User Data

Scan Angle and legacy Scan Angle Rank (angle from nadir - including aircraft roll -

that the point was output from the scanner.  Negative is to the left as scanner moves

forward, positive is to the right).

Scan Direction (value = 0 for scanner mirror moving right to left as scanner moves

forward, value = 1 for left to right)

518
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Edge of Collection Scan

Scanner Channel (single channel sensors will have all values set to 0)

Red (color value in 16-bit format)

Green (color value in 16-bit format)

Blue (color value in 16-bit format)

Infrared (color value in 16-bit format)

Elevation information is displayed when a virtual contour line is inspected.  To inspect a virtual contour,

make sure the 'Inspect' tool is toggled on, and then hold the 'Ctrl' key on the keyboard while clicking

on the contour line to be inspected.  The 'Ctrl' key instructs MARS® to select the closest feature,
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other than a LiDAR point, for inspection.  The following window will appear when a virtual contour line is

inspected.

To select a displayed check point for inspection, make sure the 'Inspect' tool is toggled on and click

on the desired check point (the LAS data may need to turned off to avoid selecting a LiDAR point

instead).  The selected point will be highlighted, and the window that opens will display the point's ID,

XYZ values and (if stored), a description, the point's NVA/VVA type, and the survey date of the point. 

Windows copy-and-paste controls can be used in the resulting pop-up window.
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To select a displayed reference shapefile (polyline or point) or breakline shapefile for inspection, make

sure the 'Inspect' tool is toggled on, and then hold the 'Ctrl' key on the keyboard while clicking on the

feature to be inspected.  This instructs MARS® to select the closest feature, other than a LiDAR point,

for inspection.  The selected line or point will be highlighted, and the window that appears displays X,

Y, (and Z-values for a 3D shapefile) for the nearest vertex (polyline) or the point.  For example, in the

example below it may be difficult to select the white shapefile points for inspection among the dense

LiDAR data.  Hold the 'Ctrl' key and use the inspect tool in close vicinity of one the white shapefile

points to select it for inspection.  It is also possible to copy information from the resulting pop-up

window when using the 'Inspect' tool.
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Click on the 'X' in the upper-right corner of any 'Point Properties' or 'Polyline Properties' window to

close it.  To unselect the 'Inspect' tool and return the chosen feature to its original symbol and/or

color, right-click the mouse.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.8.8 Inspect RGB(N)

Inspect RGB(N) Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

 Inspect RGB(N) Tool: This utility, found under the 'Miscellaneous Options' section of the View

Tab  and on the Analysis Tab , allows the user to select individual pixels and display the RGB(N)

- Red-Green-Blue and, if present, NIR - values from the loaded imagery data.  One common use of the

tool is to define RGB(n) values for the RGBNI Value Filter .  This tool will only work on RGB or RGB

(N) imagery (not ENVI rasters) and is only available to use when imagery is loaded into MARS®.

To use this tool, click in the desired location on the imagery. Once the user has selected a target, the

‘Inspect RGB(N)' dialog (see below) will be displayed, showing the RGB(N) values from the selected

pixel.  3-band imagery will display 'N/A' for the 'N' field.  Additional locations can be selected without

closing the pop-up.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.9 LAS File Properties

LAS File Properties

192 488
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Merrick Advanced Remote Sensing (MARS
®

) Software

Viewing the Properties of LAS Files: To see the properties of any LAS file, first highlight (select)

the file, then right-click and choose 'Properties'. A listing of properties will be displayed for

informational purposes including: the complete path and file name, File Source ID, the Number of

Points, the Point Data Record Format, the Number of Bytes per point record, the GPS Time and WKT

Format (Global Encoding), the LAS Version, the System Identifier, the File Creation Day (Julian Day)

and Year, the Header Size, the Number of Variable Length and Extended Variable Length Records,

the Offset to Data Point (the first point record), and the Min, Max, Offset, and Scale of each of the

coordinates: X, Y, and Z. All known coordinate reference system (CRS) data is displayed near the

bottom if the file has this information defined. The 'EVLRs' button presents a scrollable list of all the

Extended Variable Length Records that the file contains, showing the total record count as well as the

'user ID', 'description', 'record ID', and 'length after header' info (in that order) for each record.  It is also

possible to highlight, right-click, and copy data from the resulting 'LAS File Properties' window.
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4.8.10 Line-of-Sight Display

Line-of-Sight Display

Merrick Advanced Remote Sensing (MARS
®

) Software

Line-of-Sight Display: MARS® supports the display of a source/target line-of-sight display (while in

3D perspective viewing mode only) for analysis purposes.  The two buttons for this function can be

found under the 'Miscellaneous Options' section of the View Tab .192
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 Place Target: Allows the user to define a target location for an 'on-the-fly' line-of-sight display.

With LAS data rendered in a 3D (Perspective) view, click on the 'Place Target' button and then

click on a location in the data display.  The data display will re-center around that point.  Next,

click on the 'Place Eye' button (see below) and then click on a location in the data display that

will be the observer's location.

 Place Eye: Allows user to define a point of origin (viewer location) for an 'on-the-fly' line-of-sight

display after a target location has been established (see above).  With LAS data rendered in a

3D (Perspective) view and a target location already chosen, click on the 'Place Eye' button and

then click on a location in the data display that will be the observer's location.

Example:

The user must select an area of interest and then change to 3D View  mode to use this tool. First,

the user must define the line-of-sight target by clicking the ‘Place Target’ button  on the View

Tab  and defining a target location by clicking the mouse. The user must then define the point of

origin (source) for the line-of-sight display by clicking the ‘Place Eye’ button  and selecting a

location by clicking the mouse. Once both locations have been defined, the LAS Map View display will

update to show the view from 'eye' to 'target.'

836
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© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.11 MARS® Task Manager

MARS® Task Manager

Merrick Advanced Remote Sensing (MARS
®

) Software

MARS® Task Manager: The task manager, found on the Tools Tab , will allow the user to monitor

and/or end multiple MARS® processes at once. To end a process, highlight it and it will appear in the

'Process Name to End' text box. Click on the 'End Process' button to end the chosen process. The

390
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session (instance) of MARS® that is running the Task Manager cannot be ended.  The 'Refresh' button

allows the user to refresh the 'MARS® Task Manager' without closing and re-opening the tool - ending a

process will cause an automatic refresh.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.12 Measure

Measure Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

This tool allows the user to measure horizontal and vertical distances based on the project’s units of

measure (English or Metric). This tool can be used in the LAS Map View window while in 2D View ,

and in the  Cross-Section/Profile  window.  The measuring vector may be (optionally) snapped to the

closest LiDAR points from each end.  To toggle snapping on/off, go to the 'Miscellaneous Options'

835
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interface on the Options Tab  and use the checkbox in the 'Snapping Option' section.  The current

status of the snapping function is displayed on the Status Bar .

To use this utility in the LAS Map View window, click the ‘Measure’ button  on the Quick Access

Toolbar , the View Tab , or the Cross-Section/Profile Tab . To determine a horizontal distance

measurement, click and hold the left mouse button, drag the mouse to the target, and release the left

mouse button to view the results (represented by the red line in the graphic below). The following

information is displayed for each measurement in the LAS Map View window:

Length in units

Easting component

Northing component

Heading

518
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To determine horizontal and vertical measurements in the Cross-Section/Profile  window, click and

hold the left mouse button, drag the mouse to the target, and release the left mouse button to view

results (represented by red line in graphic below). The following information is displayed for each

measurement in the Cross-Section/Profile window:

Length in units

Horizontal component

Vertical component

Slope Angle in degrees

146
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4.8.13 Pick Tiles

Pick Tiles Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

 Pick Tiles: This tool is used to select a single tile or multiple tiles for Project/Data
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Preparation , Export/Extract , or Edit/Filter  activities. The button is disabled until a polygonal

shapefile is loaded into MARS® as a tile layout. The 'Pick Tiles' tool will only work on data loaded as a

tile shapefile. See the 'Add Tile Shapefile' section of the Project/Data Preparation Tab  topic for

information on loading a tile layout. This tool works only in 2D View . 

The 'Pick Tiles' tool allows the user to load a tile layout shapefile and then select a single tile or

multiple tiles to be processed. The selected tiles will then appear selected in the attribute table

representing the shapefile. To view the attribute file, right-click on the file in the 'Tiles' layer of the Table

of Contents  and choose 'Attributes'. Conversely, it is possible to use the attribute table to select

tiles from the shapefile.  Use the 'Shift' and/or 'Ctrl' keys on the keyboard to select the appropriate tile

(s). The selected tile(s) will then appear selected in the LAS Map View window on the tile layout itself.

'Pick Tiles': To use the 'Pick Tiles' tool, select the  button. Move the cursor over tiles to be

exported and left-click. Using the tool, draw a box over many tiles and they all will be selected, or use

the 'Ctrl' key on the keyboard to select single tiles without losing the ones already selected. 

162 460 268
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The following image shows an example of three selected tiles, which are outlined in bold when chosen.

MARS® will keep a count of the tiles being chosen and the total number of tiles in the tile layout and

display them as a ratio on the Status Bar .

The following image displays the selected tiles with tile names displayed. To see the tile name

attributes, right-click on the file in the Table of Contents  and select 'Properties', then choose the

appropriate name attribute (ex. TName) in the 'DB Field for Labeling' drop-down box. Check the box

which says 'Display Label', change the 'Font Size' if desired, and click 'OK'. The labels will be displayed

in the same color as the tile outlines, and the selected tiles will remain outlined in bold. The user's

preference for the 'DB Field for Labeling' option will be stored by this tool until the MARS® application is

closed. The field chosen will be synced with the same parameter in the 'Load LAS Files on Selected

Tiles' option when adding LAS data.  To read more concerning the 'Add LAS Files on Selected Tiles'

158
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option, please view the Project/Data Preparation Tab  topic. Once the desired tiles are selected, an

Export , Extract , Batch Process Tiles , or Add LAS Files | From Selected Tiles  process

can be started.

 

Tile Selection Methods

• Individual: To select an individual tile, use the ‘Pick Tiles’ tool to click on the desired tile.

• Multiple: To select multiple tiles, depress the CTRL key and use the ‘Pick Tiles’ tool to choose the

desired tiles.

• Drag Box: For large areas, use the ‘Pick Tiles’ tool to click and drag a box. All tiles touched by the

drag box will be selected. Additional tiles can be added to the selection set by holding down the

CTRL key and clicking within the desired tile(s).

• To unselect tiles: In some cases, it may be easier to use the drag box to select a large area of tiles

and unselect the few that are not needed. To unselect tiles, make sure the 'Pick Tiles' button is

active, then hold the 'Ctrl' button on the keyboard and click on the tiles to be unselected.  To

162
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unselect all tiles, click outside of any tiles while the 'Pick Tiles' button is active.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.14 Populate Statistics on Tile Scheme

Populating Statistics on Tile Scheme Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

To use the 'Populate Statistics on Tile Scheme' tool, please visit the Analysis Tab  topic.  The user

must already have lidar data and a tile layout loaded in MARS® in order to use this tool.  Another way to

populate statistics on a tile layout is to have the statistics generated at the same time the tile layout is

generated.  To populate statistics in this way, please see the Create Tile Scheme  topic. 

Populate Statistics on Tile Scheme: This tool  will create a new shapefile in the

same folder as the input tile layout, and it will contain newly calculated attribute fields for statistics

including first returns, tile area, average GSD (ground sample distance), point density (points per square

unit), and many more.  An interface will appear where the classes to be included in the statistics

calculations can be selected.  Multi-threading is also available to shorten the processing time.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.

Clicking 'OK' will start the process, and the status can be tracked with the progress bar at the left side of

the Status Bar .

488
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When the processing is complete, a pop-up window will appear showing the complete path and file name

of the new tile layout (with statistics included).  The new shapefile will have the same name as the

original shapefile, except that appended onto the end of the file name will be  “…_With_LAS_Statistics”.

When the new tile shapefile is generated, a *.prj (projection definition file) will be created if the projection

information is known for the source LAS data.  The original shapefile will not be overwritten.  Once the

user has run the ‘Populate Statistics on Tile Scheme’ tool, the newly created shapefile will need to be

loaded into MARS® - it is not loaded automatically. 

The following statistics will be generated for each tile layout when the 'Populate Statistics on Tile
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Scheme' tool is used, and they may be viewed in the attribute table of the resulting tile shapefile:

ID: A uniquely generated ID number for each tile.

TName: A uniquely created tile name (or number) used for many

program functions.

AREA: The area in square project units of a particular tile.

ALLPCOUNT: A count of the total number of points within a particular

tile.

DENSITY: The point density in points per square unit (using first

returns only).

AVG_GSD: The average GSD (ground sample distance).

X_MIN: The x axis (easting) minimum within a particular tile.

X_MAX: The x axis (easting) maximum within a particular tile.

Y_MIN: The y axis (northing) minimum within a particular tile.

Y_MAX: The y axis (northing) maximum within a particular tile.

Z_MIN: The z axis (elevation) minimum within a particular tile.

Z_MAX: The z axis (elevation) maximum within a particular tile.

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular

tile.

COLL_SCAN: A listing of the different collection scan numbers which

overlay a particular tile.

GPS_MIN: The GPS time (timestamp) minimum found within a

particular tile.

GPS_MAX: The GPS time (timestamp) maximum found within a

particular tile.

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various

intensity value statistics.
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RETURN_0: The number of ‘other’ returns found within a particular tile

(returns that are missing or have incorrect point family info).

RETURN_1 through RETURN_15: The number of first returns through

fifteenth returns (listed in individual attribute fields) found within a

particular tile.

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found

within a particular tile.

MKP: The number of points bit-flagged as ‘Model Key-point’ found

within a particular tile.

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within

a particular tile.

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a

particular tile.

Class0 through Class255: The number of points in each class (listed in

individual attribute fields) is recorded per tile.

ClassWH0 through ClassWH255: The number of Withheld bit-flagged

points in each class (listed in individual attribute fields) is

recorded per tile.

ClassMK0 through ClassMK255: The number of Model Key-Point bit-

flagged points in each class (listed in individual attribute fields) is

recorded per tile.

iShape: A MARS®-specific value that is not relevant for the user.

NOTE that 'RETURN_<nn>,' 'Class<nnn>,' and 'ClassWH<nnn>' fields that are

zeroed out for every tile will be omitted from the final attribute table to simplify

analysis.
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Please see the Populate Statistics on Tile Scheme  topic for additional information.

© 2000-2023 Merrick & Company. All Rights Reserved.

4.8.15 Shifting LAS Files

Shifting LAS Files Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

The MARS LAS Shifter can be accessed from the 'XYZ Shift' button on the Coordinate Conversion Tab

 (affects all loaded data), or by choosing the 'Shift' button at the top of the Table of Contents

(affects only those files that are selected, or highlighted, under the LAS layer).

MARS LAS Shifter: This tool is used to shift LAS data in six (6) different directions:

1. East (a positive shift in the Translation East text box) 

2. West (a negative shift in the Translation East text box) 

3. North (a positive shift in the Translation North text box)

4. South (a negative shift in the Translation North text box)

5. Higher in Elevation (a positive shift in the Elevation Adjustment box)

6. Lower in Elevation (a negative shift in the Elevation Adjustment box)

If the user chooses to shift files by using the table of contents, it is possible to select more than one

LAS file at a time and apply the necessary shifts to them. Use the 'Shift' key on the keyboard to

select more than one file in a  row, or use the 'Ctrl' key on the keyboard to select several files in

random order. The selected files will all have the same shifts, specified by the user in the 'MARS LAS

Shifter' interface, applied to them.

 ** NOTE: If multiple shifts are applied to a single project, the effect is cumulative. Each shift

963
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is applied to the existing XYZ offset in the header.**

              

An OFF file (*.off) will be created for each file that is shifted storing the X, Y, and Z offsets that existed in

the file before the shift was processed.  These 'offset' files will be created with the same name and in the

same folder as their corresponding LAS file(s).  They are used with the Report LAS Shift  tool (on the

Coordinate Conversion Tab ) as a baseline.  If the *.off files are moved, renamed, or deleted, they will

be recreated the next time the MARS LAS Shifter is run, but with the then-current offsets used as

baselines.

© 2000-2023 Merrick & Company. All Rights Reserved.
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4.8.16 Snapshot

Snapshot Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

 Snapshot: This tool, found on the Tools Tab , creates a screen capture of the display

in the LAS Map View window that is saved to a user-defined folder.  Format options include:

georeferenced TIFF (with TFW world file), georeferenced JPEG (with JGW world file), BMP, GIF, PNG,

or WMF.   The upper-left and lower-right corners of the TIFF or JPG format files are determined by the

extent of the LAS Map View window. This utility works while in 2D View  or 3D View . 

'Snapshot' is also a quick way to determine what graphics card is installed in the computer.

Once the 'Snapshot' button  is clicked, the following dialog is displayed.  Navigate to the

desired folder , enter the file name to use, and click 'Save'.  Click the 'OK' button to complete the

save and exit the utility.

390
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The following image is an example of an LAS Map View window snapshot in 2D.
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The following image is an example of an LAS Map View window snapshot in 3D.

The following image is an example of a snapshot while raster data is loaded.
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4.8.17 Statistics by Area

Statistics by Area Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

Statistics by Area: This tool , found on the Analysis Tab , allows the user to drag a box

or create a user-drawn polygon over an area of LAS data to display statistics for that area.  To use

'Normal dragbox' mode, left-click for a starting location, drag the mouse to define the opposite corner,

and release the mouse button to define the area.  For 'User-drawn polygon' mode, left-click to create

the vertices of the polygon, and right-click to close from the last vertex placed back to the starting

vertex.  The results, which include most of the categories found in a full statistical analysis (see 

Populate Statistics on Tile Scheme ), appear in a scrollable pop-up window with an option for saving

to a text file.  All results and statistics compiled are limited to only those classes, returns, collection

scans, and bit flag types that are displayed at the time the area of interest is defined.  To check

multiple areas, close the results window and drag or draw a new area.  To switch between the drag-

box and user-drawn polygon methods, close the results window and click on the tool button to be

prompted for the desired method.  The tool remains active until dismissed by pressing the 'Esc' key on

the keyboard, so multiple areas can easily be checked and the results saved if needed.

488
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4.8.18 Viewshed

Viewshed Tools

Merrick Advanced Remote Sensing (MARS
®

) Software

Viewshed Grid generation: Viewsheds are available for use with LAS data and MrSID Compressed
LiDAR data while in 2D mode only.
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   Define Area: Create a viewshed by clicking on the 'Viewshed - Define Area' button  .

Left-click inside the LAS Map View window (2D view only) where the viewshed is to start. While

holding the left button, drag the mouse to the place where the viewshed is to end and release.

The Viewshed options window will appear and give the user the ability to change the properties

of the viewshed and, optionally, to save it. By checking the 'Field of View' box, the user can

switch the field of view from 'Azimuth' (if the box remains unchecked) to 'Degrees' and

'Direction' (if the box is checked). The user can specify a radius, grid cell size, and can even

specify an invisible or visible output file name to save. The Viewshed tool displays a 2-color grid

to indicate the visibility of the user-defined field of view.  Once generated, the viewshed may be

viewed in 2D or 3D. The red areas of the viewshed represent areas which the 'viewer' would not

be able to see from the starting point that was defined. The green areas represent areas which

the 'viewer' would be able to see from the starting point that was defined. This color-coded

display helps the user to understand where elevation changes, trees, or buildings may be. This

tool is commonly used for security purposes, but can also be applied to land development and

urban visualization activities.  Note that the maximum distance (radius) that can be

generated depends on available RAM, density of LAS data, field of view, and grid cell

size.

Parameters

• Field Of View:  When checked, enables manual entry of the 'Degrees' and 'Direction' of the

desired field of view.

• Degrees:  Enabled when 'Field Of View' is checked. This value defines the angular width of

the area to be studied.  Valid values are 1 - 360.
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• Direction:  Enabled when 'Field Of View' is checked. This value represents the azimuth of

the viewshed centerline in degrees. The width of the view ('Degrees') will be centered

around this vector.  It is automatically populated in the Viewshed options dialog (but can be

modified) once the user has defined the vector for the viewshed.

• Azimuth Start: Enabled when 'Field Of View' is unchecked.  This is the starting value for the

horizontal component of the user-defined viewshed direction. Valid values range from 0 –

360, with 0 as the default value.

• Azimuth End: Enabled when 'Field Of View' is unchecked.  This is the ending value for the

horizontal component of the user-defined viewshed direction. Valid values range from 0 –

360, with 360 as the default value.

• Radius: This value represents the radius length of the viewshed. This value is automatically

populated in the Viewshed options dialog (but can be modified) once the user has defined

the vector for the viewshed.

• View Point X & Y: These values represent the XY origin of the defined viewshed. This value is

automatically populated in the Viewshed options dialog (but can be modified) once the user

has defined the vector for the viewshed.

• View Point Height: The height value above the surface for the XY origin.  A higher value will

allow the 'viewer' to see more area within the viewshed.

• Grid Cell Size: This value represents the grid cell size of the displayed viewshed grid and the

saved grids (both visible and invisible).

• Save results into files:  When checked, allows the user to save the results of the viewshed

analysis as LAS grids.

• Output Viewshed Grid File: This parameter allows the user to specify where the output files

will be written.

Viewshed Options Dialog
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In the Viewshed display below, the data which would be visible to the viewer if standing in the area

defined as the center of the viewshed is colored green. The areas which would be invisible to the

viewer if standing in the center of the viewshed are represented by red. The display shown below is in

3D and is rendered in TIN.
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Display Options: By clicking the 'Viewshed - Display Options' button  , the user has the

option of displaying both visible and invisible data, only visible data, only invisible data, and viewing any

of the data choices by TIN rendering. The user can also remove the viewshed grid completely and

release it from memory. In the Viewshed display, the data which would be visible to the viewer if

standing in the area defined as the center of the viewshed is colored green. The areas which would be 

invisible to the viewer if standing in the center of the viewshed are represented by red. 
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4.8.19 Volumetrics

Volumetrics Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

Volumetrics: This tool , found on the Analysis Tab , performs cut-and-fill analysis on a

LiDAR dataset using various user-defined surfaces, boundaries, and values for reference.  It is designed

to be used on datasets where ground has been classified separately from other points.  Accuracy of

results is affected by the 'Voxel Size' (volume pixel, or 3D cell) entered - smaller sizes will produce more

accurate results but will take longer to process.  If a material weight is known, it can be entered in the

'Optional Parameters' section of the interface so that total weight of cut and/or fill can be calculated.  For

example, if the area being analyzed consists of bare soil and the weight is known to be 75 pounds per

cubic foot (assuming the LiDAR project units are in feet), the total cut volume and/or total fill volume will

be multiplied by the 'Weight per cubic unit' value to determine total cut and/or fill weight.  An additional

488
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option allows the results displayed in the pop-up window (below, right) to be saved as a text file. 

Interface settings can be saved to an XML file ('Save Settings to File') for later use ('Load Settings from

File').

There are several methods available to run a volumetric analysis.  Note that whether loaded or referenced
in the 'Folder' entry, Dataset 1 will always be the data being analyzed and reported on.

LAS Dataset: Uses a second LAS dataset or a discrete set of classes from Dataset 1 as a
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reference surface.  The data to be analyzed (Dataset 1) must be loaded in MARS®; Dataset 2

(if used) must be pathed out using the 'Folder' browse button (all LAS files in the selected

folder will be used, so make sure it contains only the data that is to be compared with the

loaded dataset).  If using classes only from Dataset 1 (e.g., finding the volume of a building),

the Source Classifications for Dataset 1 would be the ground class(es) and the Source

Classifications for the Reference Surface would be the building class(es).  If using a second

dataset as a reference, the same classified feature(s) (e.g., ground points) chosen as the

'Source Classifications' for Dataset 1 must exist as one or more classes in Dataset 2, and

must be selected using the 'Source Classifications' 'Select' button.  A polygon must be

digitized to delineate the analysis area, and all referenced datasets must completely cover the

extent of that polygon.

User Digitized Reference Surface: Uses a digitized, draped polygon drawn on Dataset 1,

which must be loaded in MARS®.  The draping will be done on a virtual surface built from the

selected 'Source Classifications', and vertices with derived Z-values will be created along the

polygon outline depending on the 'Sampling' interval entered.  These vertices will be used to

create a TIN that will be compared to Dataset 1 for the digitized polygon area.  A shorter

'Sampling' distance (e.g., 'Every 3 Units' instead of 5) will result in a more accurate analysis,

but will take longer to process. 

User Defined Base Elevation Value: Uses a defined base elevation value, or both base and

upper elevation values for strata analysis.  The digitized polygon becomes a planar surface or

surfaces at the entered elevation or elevations.  Dataset 1 must be loaded in MARS®.  Note

that for strata analysis, only a 'Cut' volume will be calculated.

Existing Polygon Shapefile: Uses a pre-existing polygon shapefile that covers some or all of

Dataset 1, which must be loaded in MARS®.  The shapefile can be 3D or 2D - a 2D file will be

draped as in 'User Digitized Reference Surface' (above).
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Area Selection section:

When all parameters are set, click the 'Digitize a polygon from MARS view' button to draw a polygon

around the area of interest.  The 'Existing Polygon Shapefile' method does not require a user-digitized

polygon, nor does the "Selected Polygons' option in the 'Area Selection' section.  Left-click the mouse

to create the start point and vertices, and right-click to close the polygon from the last vertex created

back to the start point.  Once the polygon is complete and a 'Voxel Size' has been entered, click the

'Calculate' button to begin processing.  To use the 'Selected Polygons' method for determining analysis

areas, first load a polygonal shapefile as a Tile layout (see the 'Add Tile Shapefile' topic in the Project/

Data Preparation Tab  section of this Help Topics file).  Select one or more polygons to analyze by

clicking the 'Select Polygons' button and clicking in the desired polygon(s).  The outlines of selected

polygons will change to a thicker line type to indicate that they have been selected.  Multiple polygons

can be selected by holding down the 'Ctrl' key while selecting, or by dragging a box through the

polygons.  Selected polygons can be unselected by holding down the 'Ctrl' key and clicking in the

polygon.  Click outside of the loaded polygon shapefile to unselect all.  When finished selecting, click

the 'Calculate' button to begin processing.  A results pop-up similar to one of the examples below will

appear when the analysis is finished.

    Results from a digitized polygon using a single User Defined Base       Results from
multiple selected polygons using an elevation range 
    Elevation Value (cut and fill both analyzed, 'Weight entered)       (strata analysis,
cut volume only, no 'Weight' entered)

162



Tools and Functions 983

© 2000-2023 Merrick & Company

                   



MARS® v2023.1           User Manual984

© 2000-2023 Merrick & Company

When the results pop-up is closed, a completion message will appear:
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Optional Parameters section:

Total Cut/Fill Weight values will be shown only if a 'Weight per cubic unit' entry is made.  If the 'Save

results to text file' box is checked, a file like the one shown below will be saved based on the name and

path chosen in the 'Browse' box.  When this option is used, a settings XML file will be saved

automatically in the same path.

Sample of text file created when 'Save results to text file' box is checked.
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5 Data Classification (Manual & Batch)

5.1 Filter Action

Discrete Filter Use

Merrick Advanced Remote Sensing (MARS
®

) Software

The MARS® filter action module provides sophisticated filter algorithms for reclassifying LiDAR points.

The MARS® filter action module contains 31 filter functions which can be used individually or as part of

a macro within a batch script. To use these tools, go to the Edit/Filter Tab .

Building Filter      Change Bit Flags Filter      Consistent Return Filter      Ditch and

Berm Filter      Elevation Filter      ENVI Reclass Filter      Extreme High Filter

Extreme Low Filter      Ground      Ground Distance Filter      Height From Surface

Filter      Intensity Filter     Isolated Point Filter       Max Grid Filter       Median Grid

Filter       Min Grid Filter

Model Key-point Filter      Percolate Filter      Plane Analysis Filter      Reclassify Filter

     Return Filter      RGBNI Value Filter      Scan Angle Filter      Slope Filter     

Smart Clip Filter

Smooth Grid Filter      Smooth Max Grid Filter      Smooth Min Grid Filter      

Timestamp Filter      XY Distance Filter         XYZ Distance Filter

MARS® applies the data filtering algorithms to those LiDAR points (source classification) matching the

parameters of the filter function. LiDAR points meeting those criteria are reclassified to the specified

target classification. In addition, all filter functions have a set of one or more source classifications that
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identify the pool of candidate points for each instance of a filter function.

PLEASE NOTE that the default values that exist in all filters are based on projects in U.S. feet.  For

project data in meters, these values will need to be converted appropriately.  Also, the examples

shown for each filter are based on LAS v1.4, PDRF 6 (or higher) data, except the Model Key-point

Filter which is currently based on older LAS v1.2 data that uses a separate class for the Target points.

The various classes used in the examples were chosen for visual clarity and may not necessarily

reflect typical classes that would be used for the filter type.

In addition, some filter functions have a third set of classifications that may be specified. The third

classification, also known as the reference classification, may be used to build a reference surface, or

to seed a filter algorithm. There will be specific documentation regarding the reference surface

classification if the selected filter (ex. Height From Surface filter) has this additional parameter.

Optional comments may be added to the Comments box at the bottom of each filter's interface.  These

comments will be saved if the filter is added to a macro as part of a batch script.  Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.

The user may also manually reclassify LAS  files to enhance the quality of the LiDAR dataset.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.1 Building Filter

Building Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

1661
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The Building Filter uses an algorithm that literally identifies buildings from the ground up.  The filter

only looks for buildings in areas that are void of ground-classed points - the non-ground points can be

in any class. 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A classified dataset including ground and at least one other class.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage allows for a more precise output from the filter but requires a longer

running time.

268
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Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters: 

Minimum area in detected building surface: The minimum planar surface area required for the

surface to be considered as significant. Minimum area value is in square units (ex. 300 square feet).

The minimum area requirement applies to the planar surface built from 'Source Classifications'

points.

Minimum number of triangles in detected building surface: The minimum number of triangles

required in a flat surface (a surface represented by contiguous TIN triangles) for the surface to be

considered as significant. The minimum number of triangles applies to the flat surface built from

'Source Classifications' points.

Maximum slope variance amongst triangles in building surface (in degrees): The maximum

slope difference in degrees for any two TIN triangles on the planar surface.

LiDAR GSD: The Ground Sample Distance in project units of the collected LiDAR data.

Delta Z allowed for post reclass process: The maximum allowable perpendicular distance that a

candidate point can be from the plane of the roof surface. 

Minimum roof height above ground: The minimum elevation difference between the roof height of

candidate features and the adjacent ground surface.

Options to Remove Isolated Points

Spherical Radius: MARS® will search inside the user defined spherical radius distance (along

the X, Y and Z axes) for candidate points. Points outside this radius that meet the other criteria

are kept in the source class. This parameter is used in conjunction with 'Fewer Than' (below).
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Fewer Than: The number of points in a cluster to be considered when applying the 'Spherical

Radius' test (above).

Ground Classifications: The classification(s) that the ground surface is in.

Example Filter Use:

Before: In the example below, the dataset has only Class 2 (ground - orange) and Class 1

(unclassified - gray). Using the TIN rendering function, the user can more easily identify possible

buildings in the unclassified areas.

Manually Using the Filter: To use the Building Filter to extract buildings from other classes, choose

it from the 'Filter Action' drop-down list on the Edit/Filter Tab .

Next, click on the 'Filtering Options'  button to define the filter settings.

268



Data Classification (Manual & Batch) 991

© 2000-2023 Merrick & Company

'Building Filter Options' Dialog: The 'Building Filter Options' interface gives the user several options

for specifying the filter's action. The Source Classification(s), Target Class, Step Size, and Overlap

can be set as in other filters. Unique to this filter is the option to choose a minimum area and a

minimum number of triangles in a detected building surface, a maximum slope variance amongst

triangles in a building surface, the ground sample distance, the difference in elevation allowed for post-

reclass processing, the minimum above-ground roof height, and the desired values for excluding

isolated points.

In this example, the source classification will be Class 1: Unclassified, as all the non-ground points

are in this classification. The target class will be Class 6: Building. The default settings for step size

(100) and overlap percentage (30) will work for most projects but can be changed as desired. The

default settings for 'Minimum area in a detected building surface', 'Minimum number of triangles in a

detected building surface', and the remaining filter-specific settings will also be used for this example.

The ground classification will be set as Class 2: Ground (All) which includes Model Key-points. Click 

'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected
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Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, the building points are now properly reclassified as Class 6 (dark blue),

while the remaining Class 1 (gray) points are unchanged. This filter should reduce the amount of

manual (hand) editing that needs to be completed by 80 to 90%.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.2 Change Bit Flags Filter

Change Bit Flags Filter
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Merrick Advanced Remote Sensing (MARS
®

) Software

The Change Bit Flags Filter modifies the status (set/on or clear/off) of several of the bit flags that can

be used with LAS v1.4 data:  Synthetic, Model Key-point, Withheld, and Overlap.  Specifically, this

filter can be used only with LAS v1.4, Point Data Record Format (PDRF) 6 or higher data.  It can

optionally reclass those points whose bit flag values have been modified, and its function can be

limited to a single collection scan.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: Specifies which class(es) of points will be used as a source in identifying

the proper points to have their bit flag status modified and, optionally, be reclassified.

Reclass Modified Points: When checked, reclasses only those points whose bit flags have been

modified to the 'Target Class'.

Target Class: If the 'Reclass Modified Points' option is checked on, the class to which the

Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

268
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100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Not applicable for this filter.

Bit Flag Modification Options: The four bit flags whose status can be changed are listed here.

Either 'Set' or 'Clear' can be selected for each flag.  If, for example, 'Set' is chosen for 'Withheld' and

all 'Source Classification' points within the area to be filtered already have the 'Withheld' bit flag set,

no action will be taken on those points.

Use All Collection Scans: When checked, all collection scans within the defined area will be

included in the modification.  If unchecked, an individual 'Collection Scan Number' must be

entered for filtering.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Example Filter Use:

Before: In the example below, a section of Class 0 (gray) points east of the river needs to to be set as

Withheld and re-classed to Class 23 (pink).
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Manually Using a Single Filter: To use the Change Bit Flags Filter to modify the bit flag status of

specified points and, optionally, reclassify those points to a single Target Class, choose it from the

'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Change Bit Flags Filter Options Dialog: The 'Change Bit Flag Options' interface gives the user

several options in specifying the filter. The Source Classifications and Step Size can be adjusted as in

other filters. For optional reclassifying, the Target Class can be set. If not all collection scans are to be

included, a specific collection scan can be identified by number.

268
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In this example, the Source Classification can be all classes, since all points are currently in Class 0:

Created, Never Classified (gray). To set this, choose the 'All Classifications On' button when

selecting classes for the Source Classifications. The Target Class for the modified points will be Class

23: Reserved (pink), so the 'Reclass Modified Points' box must be checked to allow the Target Class

to be selected.  The default setting of 3000 for Step Size will work for most projects, so it will be used

for this example. The 'Set' box is checked for 'Withheld' and all other bit flags are to be left as is, so

neither the 'Set' nor 'Clear' boxes are checked for them. All collection scans are to be modified, so the

'Use All Collection Scans' box will remain checked. Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data.

After:

After running the filter, the modified points now have their 'Withheld' bit flag set

Below, the Bit Flag Display Settings  have been changed to allow the Withheld points (now

assigned

   (on), making them invisible, and have been reclassified to Class 23 (Reserved).

   to Class 23) to be seen in pink.

         

841
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5.1.3 Consistent Return Filter

Consistent Return Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Consistent Return Filter reclassifies points based on their source class and return value and a

minimum distance from points with other return values. Specifically, a point is reclassified if its return

value and the return values of all nearby points match the user-defined return value set. For example,

source class points in the search radius with non-matching return values will not be reclassified, while

source class points in the search radius with matching return values will be reclassified. For more
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about return values, read the description under the Return Filter.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Returns are not listed only as 1st return, 2nd return, etc., but rather are identified in the context of how

many total returns were recorded from the laser pulse (e.g., 1st of 3 returns).  Any combination of

these return values can be specified. (There are 36 possible values for a laser capable of sensing 8

returns from a single laser pulse.)  To aid in the specification of the desired return values, there are

shortcuts for describing some of the commonly used sets of possible return values.  These are:

All returns: Displays all possible return values, including Unknown.

Single returns: Displays 1st of 1 return.

First (including single) returns: Displays 1st return of any number of total returns.

First but not single returns (first of many): Displays only 1st return of any 2

through 15 total returns.

Last including single returns (1st of 1, 2nd of 2, 3rd of 3, ...): Displays only last

returns of any number of total returns.

Last but not single returns (last of many): Displays only 2nd of 2 returns, 3rd of 3

returns, and so on through 15th of 15 returns.

Intermediate: Displays only returns that are neither the first nor the last return.

User-specified returns: Allows selection from an array of return values.

1102
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Please see the 'Display Selection: Return' section of the View Tab  Help Topic for complete

return selection options.

Requirements: 

Points with at least two different return values.  This filter cannot be used unless the data to be

filtered contains valid point family (discrete return) information.  A pop-up warning will be displayed if

this information is not present in the LAS files.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

192

1209



Data Classification (Manual & Batch) 1003

© 2000-2023 Merrick & Company

Return value set: Those return values (within the source class or classes) that will define candidate

points to be reclassed based on meeting the 'Search radius' value (below).

Search radius: The minimum distance (in horizontal units) a candidate point must be from points

(of any class) having return values not listed in the 'Return value set'.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the first example below, there are several different return values as shown. The second

example shows that all points are currently Class 1: Unclassified.



MARS® v2023.1           User Manual1004

© 2000-2023 Merrick & Company

Manually Using a Single Filter: To use the Consistent Return Filter to classify clusters of points

based on return values, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Consistent Return Filter Options Dialog: The 'Consistent Return Filter Options' interface gives the

user several options in specifying the filter. The source classification, target class, step size, and

overlap can be adjusted as in other filters. Unique to this dialog and filter is the option to choose a

return value set and to specify a search radius. The option to filter by collection scan is also available. 

In this example, the source classification will be Class 1, as all the points are currently unclassified.

The target classification will be Class 2: Ground. The default settings for 'Step Size' and 'Overlap' will

268
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work for most projects, so they will be left at their default settings of 100 and 30 respectively. The

'Return value set' will be set to 'Single returns' as they are the most numerous return type and will

work well for this example. The default search radius of 25 units will be used for this example. Click 

'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.classified data.

After: After running the filter, any Single Return points which are more than 25 units from points with

other than Single Return values are re-classified as Class 2: Ground. Due to the existence of First (of

many) Returns and Second Returns in the middle of the example area, there is a 25 unit buffer placed

around those points in which all Single Return source points remain in Class 1.

268
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5.1.4 Ditch and Berm Filter

Ditch and Berm Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Ditch and Berm Filter looks for ground-void areas at the top of berms and bottom of ditches and

attempts to fill them from source class points that meet certain user-defined criteria.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.268
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To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements: 

Classified ground plus at least one other classification.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter is added and saved to a batch script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid Cell Size: The size of the virtual grid (in horizontal units) that will be built to search for ground-

268
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void areas.

Minimum area (number of cells): The minimum number of adjacent cells that contain no ground

points.  A smaller number will produce more candidate points.

Delta Z allowed: The maximum difference in elevation allowed between candidate points.  A larger

number will produce more candidate points.

Number of points required within a cell meeting Delta Z criterion: The minimum number of

points that must fall within the defined Delta Z range in each virtual cell.  A smaller number will

produce more candidate points

Ground Classifications: The classification(s) that the ground surface is in.

Example Filter Use:

Before: In the example below, there are many points at the bottom of the ditch that are incorrectly

classified as Class 1: Unclassified (gray) instead of the correct Class 2: Ground (orange).  The Ditch

and Berm filter will reclassify these to ground using the current ground points as a reference.

Manually Using a Single Filter: To use the Ditch and Berm Filter to add points to ground, choose it

from the 'Filter Action' drop-down list on the Edit/Filter Tab . 268



MARS® v2023.1           User Manual1010

© 2000-2023 Merrick & Company

Next, click on the 'Filtering Options'  button to define the filter settings.

Ditch and Berm Filter Options Dialog: The 'Ditch and Berm Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique to this dialog and filter are the settings for Grid Cell Size,

Minimum area (number of cells), Delta Z allowed, Number of points required within a cell meeting Delta

Z criterion, and Ground Classifications. 

In this example, the Source classification will be Class 1, as all the non-ground points are currently

unclassified. The Target classification will be Class 2: Ground, as the candidate points that meet the

set parameters will be added to the ground class. The default settings for step size and overlap will

work for most projects, so they will be left at their default settings of 100 and 30, respectively. The

'Grid Cell Size' of 3 indicates that a 3 x 3 unit virtual grid will be built to look for ground-void areas. A

good starting point for this value is the GSD (ground sample distance) of the data being filtered. 

'Minimum area (number of cells)' is the minimum number of adjacent cells that currently have no

ground points in them.  A smaller number will return more candidate points from the Source class and

vice versa.  'Delta Z' is the maximum difference in elevation allowed between candidate points in the

Source class.  'Number of points required within a cell meeting Delta Z criterion' is the minimum

number of points that must fall within the defined Delta Z range in each virtual cell.  A smaller number

will return more candidate points from the Source class and vice versa.  Click 'OK' to save the

settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, nearly all of the ground points that were previously in Class 1 have been

268
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correctly reclassed as ground (Class 2).

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.5 Elevation Filter

Elevation Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Elevation Filter reclassifies LAS points based on their absolute elevation (Z) value. (If the user

is interested in classifying points within a certain height from any surface, please use the Height From

Surface  filter). The user may select any one of three elevation modes: 'Above' (a specified elevation),

'Below' (a specified elevation), or 'Between' (two specified elevations). 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

1051
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. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of 100

means that processing will occur in areas of 100 units x 100 units. In general, the larger the step

size the faster the filter will run, but more RAM is used as step size increases. The default step size

suggested for most projects using this filter is 100.

Overlap (%): Not applicable for this filter.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Above Mode: Reclassifies all points above the upper elevation value.

Below Mode: Reclassifies all points below the lower elevation value.

Between Mode: Reclassifies all points between the lower and upper elevation values.

Above and Below Mode: Reclassifies all points above and below specified elevation values.

Upper Limit: Upper elevation value (in project units).

268
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Lower Limit: Lower elevation value (in project units).

Example Filter Use:

Before: In the example below, the data has all been reclassified to Class 1: Unclassified (gray) to

make this example easier to see and understand. Also, a profile of the data is used to find that

elevations in this area range from just less than 5200 units at the lowest to about 5400 units at the

highest.

Manually Using a Single Filter: To use the Elevation Filter to classify data based on its absolute

elevation, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 268
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Next, click on the 'Filtering Options'  button to define the filter settings.

Elevation Filter Options Dialog: The 'Elevation Filter Options' interface gives the user several

options in specifying the filter. The source classification, target class, step size, and overlap can be

adjusted as in other filters. Unique to this dialog and filter is the option to reclassify points on either

side of an elevation range or between two elevations. This filter can also reclass points above or below

a particular elevation.

In this example, the source classification will be Class 1, as all the points are currently unclassified.

The target classification will be Class 10 (yellow). The default settings for step size and overlap will

work for most projects, so they will be left in their original settings of 100 and 0 respectively. In this

example, the user chose to reclassify points between the elevations of 5293 units and 5364 units.

Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, the points which are between the elevations of 5293 and 5364 units have

been reclassified to Class 10 (yellow). This 71 unit elevation range can be seen in the 2D orthographic

view window as well as in the Cross-Section/Profile window.

268
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5.1.6 ENVI Reclass Filter

ENVI Reclass Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The ENVI Reclass Filter allows LAS points to be reclassified based on an ENVI classification data

set. ENVI data sets require two files: a header file (.hdr) and a data file (.dat). The filter works in a

similar fashion to the RGB component filter except it reclassifies based on a specific ENVI class

instead of RGB component ranges. When operating interactively, MARS® uses the currently displayed

ENVI data set. When operating in batch mode, the user must specify an ENVI header file name.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A header file (*.hdr).

A data file (*.dat).

268
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General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of 100

means that processing will occur in areas of 100 units x 100 units. In general, the larger the step

size the faster the filter will run, but more RAM is used as step size increases. The default step size

suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size).

More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

ENVI Source File: Browse to the ENVI file (.dat) that will serve as the source file.

ENVI Classes: Selects which class in the ENVI data set should be used.

Search Radius: Search radius will be automatically populated based on ENVI raster pixel size.

Example Filter Use:

Before: In the example below, the user has hyperspectral imagery which has identified several

different types of vegetation. The area of yellow represents hyperspectral Class 28: High Density
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Grass. The filter will be used to reclass all the Class 5 (High Vegetation) points within 15 units of this

high density grass.

The screen shot below represents the unaltered hyperspectral data in LAS point format. The points are

being shown by classification to demonstrate that only Class 5: High Vegetation has been defined so

far.
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Manually Using a Single Filter: To use the ENVI Reclass Filter to reclassify points based on an

ENVI classification data set, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

ENVI Reclass Filter Options Dialog: The 'ENVI Reclass Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique to this dialog and filter is the requirement to navigate to an

ENVI source file, define the search radius, and select the ENVI classes to be used in the filter.
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In this example, the source classification will be Class 5: High Vegetation, as seen in the example of

LAS point classification above. The target class will be Class 15 (magenta). The default settings for

step size and overlap are sufficient for this example and they will be left at 100 and 30 respectively.

The ENVI source file has been defined and the ENVI class which is to be identified in the filter has

been specified (Class 28: High Density Grass). The search radius will be left at 15 since the user is

looking to reclassify all points within 15 units of the high density grasses. Click 'OK' to save the

settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data.

After:  After the ENVI reclass filter has been run, it is possible to see the areas of points around the

Class 28: High Density Grass (yellow) which have been reclassified to Class 24 (magenta). Points

from source Class 5 have been reclassified to Class 24 if they fall within 15 units of any point

classified as the hyperspectral Class 28.

The screen shot below is another example of the reclassification of points as seen above. In this

example below, the hyperspectral data has been turned off to make it easier to view the change in

classification of the LAS points. All of the magenta points (Class 24) are within 15 units of a

hyperspectral Class 28 point.
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5.1.7 Extreme High Filter

Extreme High Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Extreme High Filter is intended to reclassify points that have a uniquely high elevation. Only

points in the source data classification are considered. In the simplest case (max_group_size = 1), a

point is reclassified if all other points within the search_radius are elev_diff lower than the point

under consideration. When max_group_size is greater than one, a point is reclassified if all but the
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max_group_size points are elev_diff lower than the point under consideration.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

Extremely high point(s) which are not true canopy (ex: a bird, airplane, or dense cloud cover).

A single source class.

A single target class.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size suggested for most projects using this filter is 500.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

268
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Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Search radius: Specifies the search distance from a point under consideration to search for similar

elevation points.

Elevation difference: Maximum elevation distance a comparison point can be lower than the point

under consideration.

Maximum number of points in a group: Maximum number of points in a group of points with

similar elevation that will be reclassified. The default value is 1.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, there is a cluster of canopy points far above the rest of the canopy that

is not valid - they are not part of the true canopy. The LiDAR system could be showing returns from a

bird, an airplane, or even dense cloud cover. The extreme high filter can be used in this instance to

separate and filter these points to a more proper classification which will not be in the final, deliverable

dataset. In this example, Class 25 will be used. The example below shows a random point about 14

units above the ground which stands alone. This return was most likely a bird and is not true canopy.
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Manually Using a Single Filter: To use the Extreme High Filter to correct this mistake, choose it

from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Extreme High Filter Options Dialog: The 'Extreme High Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique to this dialog and filter is the option to choose a search

radius, elevation difference, and maximum number of points in a group.

268
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In this example, the source classification will be Class 5: High Vegetation, as the single high point

shown above is classified as High Vegetation (Class 5). The target classification will be Class 25, as

mentioned above. The default settings for step size, overlap, and search radius will work for most

projects, so they will be left in their original settings of 500, 30, and 25 respectively. An elevation

difference of 10 will be used. The Measure  tool was used to calculate the distance above the true

ground surface (14 vertical units) and a setting of 10 will be sufficient for the filter to identify the point.

The maximum number of points in a group will be set to 5 to make sure the entire cluster of points will

be filtered, and not only a single high point. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

956
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Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.classified data.

After: After running the filter, the point is now properly classified as Class 25 (gray). 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.8 Extreme Low Filter

Extreme Low Filter

Merrick Advanced Remote Sensing (MARS
®

) Software
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The Extreme Low Filter is intended to reclassify points that have a uniquely different and low

elevation. Only points in the source classification set are considered. In the simplest case (

max_group_size=1), a point is reclassified if all other points within the search_radius are elev_diff

higher than the point under consideration. When max_group_size is greater than one, a point is

reclassified if all but max_group_size points are elev_diff higher than the point under consideration.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

 

Requirements:

Extremely low point(s) which are not needed to make a true ground surface.

A single source class.

A single target class.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default
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step size suggested for most projects using this filter is 500.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Search radius: Distance from a point under consideration to look for similar elevation points.

Elevation difference: Maximum amount a comparison point can be higher than the point under

consideration.

Maximum number of points in a group: Maximum number of points in a group of points with

similar elevation that will be reclassified. Default is 1.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, there is a cluster of ground points far below the rest of the ground

surface that is not valid - they are not part of the true ground surface. The extreme low filter can be

used in this instance to separate and filter these points to their proper classification, which would be

'Class 7: Low Point (Noise)'. 
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Manually Using a Single Filter: To use the Extreme Low Filter to correct this mistake, choose it

from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Extreme Low Filter Options Dialog: The 'Extreme Low Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique to this dialog and filter is the option to choose an elevation

difference, the maximum number of points in a group, as well as a search radius.

In this example, the source classification will be Class 2: Ground, as the cluster of low points shown
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above are classified as Ground (Class 2). The target classification will be Class 7: Low Point (Noise),

as this is the proper classification for these points. The default settings for step size, overlap, and

search radius will work for most projects, so they will be left in their original settings of 500, 30, and 25

respectively. An elevation difference of 10 will be used. The Measure  tool was used to calculate the

distance below the true ground surface (13 vertical units) and a setting of 10 should be sufficient for

the filter to identify the points. The maximum number of points in a group will be set to 10 to make

sure the entire cluster of points will be filtered, and not only a single low point. Click 'OK' to save the

settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

956
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Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.classified data.

After: After running the filter, the cluster of points is now properly classified as Class 7: Low Point

(Noise). 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.9 Ground Filter

Ground Filter
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Merrick Advanced Remote Sensing (MARS
®

) Software

The Ground Filter reclassifies LAS points to ground based on algorithms and routines that are part of

the LAStools software suite.  Unlike the other 30 discrete filters, it is limited in application to the

'Filter Region' method of manual editing (designed for relatively small areas), and therefore cannot be

part of a macro or batch script XML.

Use of the Ground Filter requires that at least part of the LAStools suite ('lasground_new.exe' and '

lasground_new64.exe') be present on the local computer or in an accessible network location that can

be pathed out.  The minimum required version of LAStools for use in MARS® will contain a

'CHANGES.txt' file dated November 8, 2018, or later.  The LAStools suite can be downloaded at no

charge, but licensing is required to use the classification routines in a commercial, government, or

production environment.  Unlicensed use in any setting may cause data corruption!  As taken from

the rapidlasso GmbH website, "Note that the output of the unlicensed version can be slightly

distorted after certain point limits are exceeded."  Please contact rapidlasso GmbH by e-mail directly

at info@rapidlasso.com for general information including questions about licensing and allowable use,

or see the rapidlasso GmbH website for details.  For pricing information, go to http://rapidlasso.com/

pricing.  Licenses are available for the entire LAStools suite, or the one component needed for this

'Ground Filter' can be licensed separately at a reduced cost.  All licensing, pricing, and payment is

handled directly between the end user and rapidlasso GmbH - Merrick & Company has no

involvement at this level.

Remember that unlicensed use is limited (by rapidlasso GmbH) to testing and/or evaluation only.  A

license purchased for the Quick Classifications  batch filtering tool will authorize this filter as well.

License Status:

Licensed Unlicensed
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lasground_new.exe and lasground_new64.exe files
needed:

The LAS data to be re-classified must be loaded in order to use this filter.  To begin, select 'Ground'

from the 'Filter Action' drop-down list on the Edit/Filter Tab .  Next, click the 'Filtering Options'

button  to set the parameters of the filter.  A window will appear where both the

data units and the path to the LAStools executable file(s) and the license file (if purchased) must be

set.    The LAStools software suite can be downloaded from a link on this interface.  The minimum

required version of LAStools for use in MARS® contains a 'CHANGES.txt' file dated November 8,

2018, or later.

 

The data units must be set each time the filter is used - a correct entry is critical to the operation and

results of the classification routines.  The path to the LAStools files will be stored for future use, but

can be updated if the location of the files is ever changed.  If the units are not selected or the path

entered does not contain the 'lasground_new.exe' and 'lasground_new64.exe' files, the following

messages will appear when the 'OK' button is clicked:
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When the data units are entered and a valid LAStools path exists, click 'OK' to bring up the 'Ground
Filter Options' interface.  The interface consists of two Filter Settings tabs:
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Source/Target Classes tab:  The Source and Target classes are selected here.  By default, all 256

classes are included in the 'Source Classifications', but this can be changed by clicking the

'Select' button.  A default value of '2' is set for the 'Target Ground Class'.  This is based on the

ASPRS standard class for ground, but it can be modified by clicking the appropriate 'Select'

button(s).

Ground Filter Options tab:  This interface has a 'Help' link in the upper-left corner that goes directly

to the LAStools read-me file for 'lasground'.  The parameters on this tab are explained in the

read-me file, which is updated and maintained solely by rapidlasso GmbH.  This read-me file
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is based on an earlier (but very similar) iteration of the ground classification executable.  As of

the release date of this version of MARS®, LAStools was not yet hosting a read-me file for the

'lasground_new.exe' executable that is used in this filter.  However, it is available in the

downloaded LAStools suite package as 'lasground_new_README.txt'.  All the controls and

entries on this tab feed directly into the arguments of the LAStools 'lasground_new.exe' file.

When all settings have been made, click the 'OK' button in the lower-right corner of the

interface.  If a license for LAStools has not been purchased or is not present in the path to the

executable files, the following warning message will appear immediately after clicking 'Run':

If a license exists, or if 'Yes' is clicked when there is no license, filtering can begin.  On the View Tab

, set the Rendering Option to 'Color by Classification' .  This will allow the changes made by

the filter to be  visible.  Click the 'Filter Region' button and drag a box over the area to be filtered.

The cursor will indicate that processing is taking place - the larger the area dragged, the longer the

filtering will take.  The routine temporarily buffers the defined area by 100 feet or 33 meters (depending

on the units selected) and uses that expanded area for processing to improve accuracy.  However,

only those points within the original defined drag box will be reclassed.  When complete, the following

message will appear:
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After dismissing this message, the LAS Map View window will refresh, and additional areas can then

be dragged using the same settings.  To change the filter's parameters, click the 'Filtering Options'

button, make the modifications, and click 'OK'.  The 'Filter Region' button will stay active so that a

new drag box can immediately be defined using the new settings.

Below is an example of the Ground Filter's results, using the sample LAS file that is installed with 

MARS®.  All points were first manually re-classed to Class 0 (Created, Never Classified) for clarity.

However, this is not necessary if all classes are used as 'Source Classifications' on the 'Source/

Target Classes' tab of the 'Ground Filter Option'.  The default settings were used on the 'Ground Filter

Options' tab: Land Type of 'City'; Terrain Ruggedness of 'Default / slight variations in terrain'; and Lidar

Return Use for Input Seeding of 'Last returns only'.  No entries were made or changed on the interface

for this example.

Before - all points in Class 0

After - Ground in Class 2 (orange), remainder in Class 1 (dark gray)
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Note that sections of large flat-roofed buildings will often be classed as ground since they consist of
last returns only and are the lowest points within the extent of the building's outline.

 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.10 Ground Distance Filter

Ground Distance Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Ground Distance Filter is similar to the XY Distance filter, except for two differences: 1) The

Ground Distance filter assumes 'above' or 'below' a surface is perpendicular to the slope of that
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surface.  The XY Distance filter assumes that 'above' or 'below' a surface is above or below the XY

horizontal axis and, 2) the Ground Distance filter will take the slope of the surface into account.  The

Ground Distance filter reclassifies points when they are within a specified ground distance of a point in

the reference classification set.  This filter is more useful than the XY Distance filter in areas with steep

slopes.  Since the XY Distance filter functions purely off of an XY horizontal distance and does not take

the slope of an area into account, it may miss points to be reclassed in these areas.  Since the Ground

Distance filter considers the slope of an area, it measures the user defined distance along the reference

surface and not along the XY horizontal axis.  See the screen shot below for further clarification.  In this

example, it can be seen that the XY distance up a slope will be different than the actual distance along

the surface.  This can skew the user's results in hilly areas if the XY Distance filter is used.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

.  Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.
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Requirements:

A Reference Classification that is not also the Source Classification.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time.  For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units.  In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases.  The default

Step Size suggested for most projects using this filter is 500.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

).  More Overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments.  Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script .  Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Reference Classifications: The point classification(s) that the Source Classifications data is

compared against to find points to reclassify based on the specified parameters.

Ground Distance: Distance requirement for determining candidate points.  Candidate points must

be within this distance of a Reference Classification point, as projected onto the gridded surface

created from the Reference Classification set.
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Height Requirement

No limit: Specifies no requirement in 'normal' (perpendicular) height distance from the

gridded reference surface.

Maximum limit: Specifies a requirement that points that are reclassified are at most

max_diff higher in elevation than the nearby reference point.  Height is measured

perpendicular to the ground surface. This value can be negative.

Minimum limit: Specifies a requirement that points that are reclassified are at least

min_diff higher in elevation than the nearby reference point.  Height is measured

perpendicular to the ground surface. This value can be negative.

Both max and min limit: Specifies that both Maximum and Minimum height

distance values will be used.

Angle Requirement

No limit: Specifies no requirement in angle divergence from the slope of the gridded

reference surface.

Maximum limit: Specifies a requirement that points that are reclassified are at most

max_angle higher than the nearby reference point.  Angles are measured from the

ground surface. This value can be negative.

Minimum limit: Specifies a requirement that points that are reclassified are at least

min_angle higher than the nearby reference point.  Angles are measured from the

ground surface. This value can be negative.

Both max and min limit: Specifies that both Maximum and Minimum limit angle

values will be used.

Ground Slope Parameters

Grid cell size: The grid cell size for the reference slope grid.

Number of passes of grid smoothing: The grid smoothing count for the slope grid,

which is the number of times a grid is smoothed before the slope values are
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calculated.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, the user wishes to reclassify any ground point (Class 2, orange) within

15 units of any vegetation (Class 5, green) to Class 10 (yellow).  This particular area has a steep slope

which makes this filter a better choice for more accurate reclassifications than the 'XY Distance' filter.

Manually Using a Single Filter: To use the Ground Distance Filter to reclassify all Source points

when they are within the specified parameters as compared to the gridded reference surface, choose it

from the 'Filter Action' drop-down list on the Edit/Filter Tab . 268
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Next, click on the 'Filtering Options'  button to define the filter settings.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

Ground Distance Filter Options Dialog: The 'Ground Distance Filter Options' interface gives the

user several options in specifying the filter.  The Source Classification(s), Target Class, Step Size, and

Overlap percentage can be adjusted as in other filters.  Unique features to this filter include the ability

to choose a Reference Classification(s), specify a Ground Distance for measurements against the

Reference Classification set, as well as the Height and Angle Requirements of the points to be

reclassified.  Adjustments to the Grid cell size can be made, and the filter is also capable of running a

Gaussian smoothing algorithm on the grid created.

In this example, the Source Classification will be Class 2: Ground (orange).  The Target Class has

been set to Class 10 (yellow).  The default settings for Step Size and Overlap will be used for this

example.  The Reference Classification will be set to Class 5: High Vegetation, and the Ground

Distance has been set to 15 units, because this is the class from which the user wishes to measure

15 units to determine candidate points.  No limits of elevation or angles have been set to allow for the

hilly setting in this example.  The Grid cell size has been set to 10 and no Gaussian smoothing effect

is to be applied to the gridded surface.  Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter
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Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: The results can be seen below.  Any ground point (orange) within 15 units of a reference class

point (green) has been reclassified to Class 10 (yellow).  The filter has taken the ground distance and

slopes into consideration in the hilly areas.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.11 Height From Surface Filter

Height From Surface Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Height From Surface Filter reclassifies points that are at a specified elevation above or below a

surface (if the user is interested in classifying points by their absolute elevation (Z-value), please use

the Elevation  filter). To do this, a surface (either a grid or TIN) is built from the points of the surface

classification. In the filter dialog, the reference surface classifications are specified within the Height

From Surface filter options dialog (see below). In a macro filter script, the reference surface

classifications are specified in the 'Surface Classifications' XML element nested within the Height From

Surface filter element.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A source class(es).

A reference class(es).

General Parameters:

1012
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Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Classification: The class to which the Source points that meet all criteria for each range in

the 'Elevation Difference Requirement' table are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size (when the surface type is constructed as a grid) suggested for most projects using this filter is

100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Elevation Difference Requirement

Maximum Z: Specifies a requirement that points that are reclassified are at most

max_diff higher in elevation than the grid surface. This value can be negative.

Minimum Z: Specifies a requirement that points that are reclassified are at least

min_diff higher in elevation than the grid surface. This value can be negative.

Use slope: If the user chooses this option, the height perpendicular to the surface will be measured

and used.

Surface type constructed as reference: Flag indicating the type of surface. False means build a
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TIN surface, true means build (and possibly smooth) a gridded surface.

TIN Options

Limit TIN triangle size via edge length: By checking this option the user chooses

to limit the TIN triangle size by limiting the edge length of any side of the triangle.

Maximum triangle edge length: Enabled when the above option is checked.

Specify the maximum triangle edge length to be used here.

Grid Options

Grid cell size: This value specifies the size of the cells of the grid. Used only if grid

is specified as surface type.

Number of passes of grid smoothing: This value specifies how many times

Gaussian smoothing is applied to the gridded surface. Used only if grid is specified

as the surface type.

Fill Gap:  The user has the option to fill voids which are found in the LiDAR data. If

the 'Fill Gap' field is checked, MARS® will create as many grid cells in the gap as

possible. This option is used to prevent NO DATA values. During the creation of the

output grid, this option will allow the user to continue, or TIN, the surface across data

voids. 

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Reference Classification Set

Reference Surface Classifications: The point classifications that are used to create the temporary

comparison surface. Attribute of 'class' specifies one or more classifications, comma separated.

Example Filter Use:



MARS® v2023.1           User Manual1054

© 2000-2023 Merrick & Company

Before: In the example below, the user has found an area with varying elevations. The example data

below includes cars, vegetation, and a large building. The user wishes to reclassify points that are a

specified elevation above or below a surface (in this case, the ground). In this example, the cars and

building will be defined from the vegetation based upon the height of the particular features above the

ground. 

 

Manually Using a Single Filter: To use the Height From Surface Filter to reclassify points that are a

specified elevation above or below a surface, choose it from the 'Filter Action' drop-down list on the

Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.
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Height From Surface Filter Options Dialog: The 'Height From Surface Filter Options' interface gives

the user several options in specifying the filter. The source classification, target class, step size, and

overlap can be adjusted as in other filters. Unique to this dialog and filter is the option to specify a

reference surface classification, and choose elevation difference requirements to set the parameters of

the filter. Other options include 'Use slope', TIN options or grid options, and a filter by collection scan

option.

In this example, the source classification will be Class 5: High Vegetation, as all of the features that

need to be reclassified are currently classed as High Vegetation. The default settings for step size and

overlap will work for most projects, so they will be left in their original settings of 100 and 30

respectively. The reference surface classification will be Class 2: Ground as this is the surface from

which the heights of the vegetation, cars, and buildings need to be measured. In many cases, the

reference surface classification is the ground (including Model Key-points). A minimum Z requirement

will be set at 35 units and a separate maximum Z requirement will be set at 6 units. A target class of

24 (pink) will be used to represent any point up to 6 units above the ground. These points will likely be

cars. A target class of 6 (dark blue) will be used to represent any point higher than 35 units above the

ground. These points will likely be buildings. Most points between 6 units and 35 units above the

ground will be trees and will stay in Class 5: High Vegetation. The user has also chosen to use the

Grid option so that the grid cell size can be specified to 3. Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After:  After the filter has been run, it is easy to see that the cars (up to 6 units above the ground

surface) were identified and the points reclassified to Class 24 (pink). The tallest parts of the building

(more than 35 units above the ground surface) were identified also and those points were reclassed to

Class 6 (dark blue). The points between 6 and 35 units above the ground were left alone and are still

most properly classed as Class 5.
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5.1.12 Intensity Filter

Intensity Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Intensity Filter filter reclassifies LAS points based on the value of the intensity attribute. The user

may select the upper and lower intensity values and the filter will reclassify all points with values within

this range to the target classification.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data with intensity values (attributes).

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

268

268



Data Classification (Manual & Batch) 1059

© 2000-2023 Merrick & Company

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size suggested for most projects using this filter is 100.

Overlap (%): Not applicable for this filter.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Intensity Range: The range (inclusive) of intensity values to be reclassified. Possible intensity

values are 0 (zero) through 65535.

Example Filter Use:

Before: In the example below, the LAS data is colored by intensity value. Low values of intensity

indicate a darker, less-reflective surface such as a road or parking lot. Higher values of intensity

indicate a very reflective or bright surface such as the metal roof of a building or the roof of a white car.

In this case, the user would like to classify the road points.
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Manually Using a Single Filter: To use the Intensity Filter to classify points based on their intensity

attribute value, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Intensity Filter Options Dialog: The 'Intensity Filter Options' interface gives the user several options

in specifying the filter. The source classification, target class, and step size can be adjusted as in

other filters. Unique to this dialog and filter is the option to choose an intensity value range within

which source points will be reclassified.

All LAS data in this particular data set is classified as Class 1 (gray), so this will be the source

classification for this filter. The user wishes to classify the road by using intensity values, and so the

target classification could be any class; in this example it will be Class 7 (magenta). The default value

of 100 for the step size will be used for this particular example. Using the Inspect  tool, the user

268
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finds that the intensity values of the road points range from about 1200 to about 9000, so this will be

the range entered into the filter. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, all source points whose intensity values are between 1200 and 9000

have been reclassified to Class 7 (magenta). Note that many non-road points were also reclassified

since many other features can fall between the selected intensity value limits.
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5.1.13 Isolated Point Filter

Isolated Point Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Isolated Point Filter reclassifies an LAS point or a small group of points when there is no other

point of a specified reference class within a user-defined spherical radius (this radius includes the X, Y,

and Z axes).

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab
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.  Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time.  For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units.  In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases.  The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments.  Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script .  Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Reference Classifications: The point classifications that the unfiltered data is compared against to

find the proper points to reclassify.

268
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Spherical Radius: The software will search inside the user defined spherical radius distance (along

X, Y and Z axis) for a point of the reference classification.  If one is not found, the source point will

be reclassified to the Target Classification.

Fewer Than: This user defined setting allows the user to account for clusters of isolated points

rather than only single points.  If the user would like the filter to search for and reclassify clusters of

'Fewer Than __ Other Points' that specification may be made here.  For example, the filter will

search for and reclassify points in clusters fewer than 7 points if '7' is the number specified in this

option.  The availability of this option is especially useful for highly sensitive LiDAR equipment which

may collect points on items like flying birds or dust particles -- items which are considered random

high points in the LiDAR data set. 

Example Filter Use:

Before: In the example below the user has several single and one small cluster of random high,

isolated points.  These points are currently classified as Class 1: Unclassified (gray).  The Isolated

Point filter will be able to find and reclassify points such as these to a unique user-defined class.

Manually Using a Single Filter: To use the Isolated Point filter to classify points, choose it from the
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'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Isolated Point Filter Options Dialog: The 'Isolated Point Filter Options' interface gives the user

several options in specifying the filter.  The source classification, target class, step size, and overlap

can be adjusted as in other filters.  Unique to this dialog and filter is the option to choose a reference

classification, spherical radius, and the option to reclassify clusters of points.

The random high points which need to be reclassified in this dataset are currently in Class 1 (gray), so

this will be the source classification for this filter.  The user wishes to classify these points to a unique

class, in this case Class 10 (yellow).  The default value of 3000 for the step size and 30% for the

overlap will be used for this particular example.  The reference classification will also be Class 1

(gray).  The default value of 25 units will be used for the spherical search radius.  The user has

decided to also reclass small clusters of points, specifically clusters of fewer than 7 points (6 points or

less). Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, the isolated single points and small clusters of points are now classified

as Class 10 (yellow).
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5.1.14 Max Grid Filter

Max Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Max Grid Filter finds the highest single point - or, optionally, group of points - in each grid cell

that matches the Source classification set. The filter then reclassifies those points to the Target

classification.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.
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Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 1000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: This value specifies the size of the cells of the grid in project units.

Number of points per cell to reclass: The default is '1', but more can be reclassed if desired.

Filter by collection scan: Filtering can be done by collection scan by checking this option.

1209



Data Classification (Manual & Batch) 1069

© 2000-2023 Merrick & Company

Example Filter Use:

Before: In the example below, the user wishes to reclassify the highest point in each grid cell from the

source classification, Class 1: Unclassified (gray), to the target classification, Class 10 (yellow).

Manually Using a Single Filter: To use the Max Grid Filter to reclassify the highest point(s) in each

grid cell, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Max Grid Filter Options Dialog: The 'Max Grid Filter Options' interface gives the user several

options in specifying the filter. The source classification, target class, step size, and overlap can be

adjusted as in other filters. Unique to this dialog and filter is the option to choose a grid cell size and

the number of high points in each cell to be reclassed. The larger the grid cell size, the fewer points

which will be reclassified. The user may also check the 'Filter by collection scan' option which will filter
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the data by collection scan rather than by tile or selected area.

In this example, the source classification will be Class 1: Unclassified (gray), as the whole data set is

currently unclassified. The target classification will be Class 10 (yellow). The default settings for step

size and overlap will work for most projects, so they will be used for this example. The grid cell size

will be set to 5, and the number of points per cell will be left at the default of '1', to reclassify a single

maximum elevation source point in each 5 x 5 unit grid cell. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data.

After: After running the filter, the highest point in every 5 by 5 unit grid cell has been reclassified to

Class 10 (yellow).  This explains the evenly spaced appearance of the reclassified points. The Class 1

points have been turned off in the display below to allow the reclassified points to be seen more easily.

 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.15 Median Grid Filter

Median Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Median Grid Filter finds the median elevation point of each grid cell that matches the source

classification set. The filter reclassifies the median elevation point (one per grid cell) to the target
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classification.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 1000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored
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permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: This value specifies the size of the cells of the grid in project units.

Filter by collection scan: Filtering can be done by collection scan by checking this option.

Example Filter Use:

Before: In the example below, the user wishes to reclassify the median elevation point in each grid

cell from the source classification, Class 1: Unclassified (gray), to the target classification, Class 11

(red).

Manually Using a Single Filter: To use the Median Grid Filter to reclassify the median elevation

point in each grid cell, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 
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Next, click on the 'Filtering Options'  button to define the filter settings.

Median Grid Filter Options Dialog: The 'Median Grid Filter Options' interface gives the user several

options in specifying the filter. The source classification, target class, step size, and overlap can be

adjusted as in other filters. Unique to this dialog and filter is the option to choose a grid cell size. The

larger the grid cell size, the fewer points which will be reclassified. The user may also check the 'Filter

by collection scan' option which will filter the data by collection scan rather than by tile or selected

area.

In this example, the source classification will be Class 1: Unclassified (gray), as the whole data set is

currently classified as Class 1. The target classification will be Class 11 (red). The default settings for

step size and overlap will work for most projects, so they will be used for this example. The grid cell

size will be set to 5, to reclassify the median elevation grid point in each 5 x 5 unit grid cell. Click 'OK'

to save the settings
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Choosing the Area to be Filtered: NNow that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, the median elevation point in every 5 by 5 unit grid cell has been

reclassified to Class 11 (red).  This explains the evenly spaced appearance of the reclassified points.

The Class 1 points have been turned off in the display below to allow the reclassified points to be seen

more easily.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.16 Min Grid Filter

Min Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Min Grid Filter finds the lowest point - or, optionally, points - of each grid cell that matches the

Source classification set. The filter reclassifies those points to the Target classification.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of 100

means that processing will occur in areas of 100 units x 100 units. In general, the larger the step

size the faster the filter will run, but more RAM is used as step size increases. The default step size
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suggested for most projects using this filter is 1000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text here

and that text will remain for the remainder of the MARS® session, and will be stored permanently if

the filter  is added and saved to a filter macro script . Note that the reserved XML characters <, >,

%, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: This value specifies the size of the cells of the grid in project units.

Number of points per cell to reclass: The default is '1', but more can be reclassed if desired.

Filter by collection scan: Filtering can be done by collection scan by checking this option.

Example Filter Use:

Before: In the example below, the user wishes to reclassify the lowest point in each grid cell of a

virtual grid from the source classification, Class 1: Unclassified (gray), to the target classification,

Class 7: Low Point (pink).

1209



MARS® v2023.1           User Manual1078

© 2000-2023 Merrick & Company

Manually Using a Single Filter: To use the Min Grid Filter to reclassify the lowest point(s) in each

grid cell, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Min Grid Filter Options Dialog: The 'Min Grid Filter Options' interface gives the user several options

in specifying the filter. The source classification, target class, step size, and overlap can be adjusted

as in other filters. Unique to this dialog and filter is the option to choose a grid cell size and the

number of low points in each cell to be reclassed. The larger the grid cell size, the fewer points which

will be reclassified. The user may also check the 'Filter by collection scan' option which will filter the

data by collection scan rather than by tile or selected area.

In this example, the source classification will be Class 1: Unclassified, as the whole data set is
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currently unclassified. The target classification will be Class 7 (pink), as this is the proper

classification for these minimum points. The default settings for step size and overlap will work for

most projects, so they will be used for this example. The grid cell size will be set to 10, and the

number of points per cell will be left at the default of '1', to reclassify a single minimum elevation point

in each 10 x 10 unit grid cell. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.
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After: After running the filter, the lowest point in every 10 by 10 unit grid cell has been reclassified to

Class 7.  This explains the evenly spaced appearance of the reclassified points. The Class 1 points

have been turned off in the display below to allow the reclassified points to be seen more easily.

 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.17 Model Key-point Filter

Model Key-point Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Model Key-point Filter creates a new, thinned dataset from ground (surface) points by searching

for the highest and lowest points in a user-defined area. Further specifications are made by the user to

describe an elevation tolerance for other source points which will be considered for reclassification. The
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minimum density of the 'thinned' surface can also be determined by the user.

The filter is currently designed to output to a unique class and does not set the Model Key-point bit

flag to 'on' for those reclassified points.  A future release of MARS® will have a re-written Model Key-

point Filter that will leave the candidate ground points in Class 2 and set their Model Key-point bit flag

to 'on'.  In the interim, LAS v1.4, PDRF 6 (or higher) compliant data can be created by using this

workflow:  1. Use this filter to temporarily output to a unique class per the instructions below.  2. Use

the 'Class to Bit Flag' tool (found under the 'Bit Flag Settings' drop-down on the Tools Tab ) to set

the Key-point Bit Flag to 'on' for the temporary points class.  3. Use the Reclassify  Filter  to set the

temporary points class back to Class 2 (ground).  All ground points will now be on Class 2 with the

Model Key-points flagged appropriately.

 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A final, hand-filtered ground surface.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

390
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Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default step

size suggested for most projects using this filter is 100.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter-Specific Parameters:

Use points every: This option allows the user to specify the minimum density of the new surface

classification. For example, if the user would like to have at least one model key-point every 20

horizontal units, set the 'Use points every:' setting to 20. This option will guarantee a minimum

density of points even in flat areas where few points would typically be reclassified. 

Tolerance above: This setting specifies how far above the source classification (surface) a point

may be to be considered for reclassification. All reclassified points will be outside of the elevation

tolerances defined by the user. The elevation tolerances allow the user to control the accuracy of the

model key-point surface.

Tolerance below: This setting specifies how far below the source classification (surface) a point

may be to be considered for reclassification. All reclassified points will be outside of the elevation

tolerances defined by the user. The elevation tolerances allow the user to control the accuracy of the

model key-point surface.

Example of Filter Use:

BEFORE: In the example below the user has a final, hand-filtered area of ground points on which to run
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the Model Key-point filter. The ground surface is currently in Class 2: Ground (orange) and the display

of all other classifications has been turned off. The Model Key-point filter will provide a less dense

dataset than the original ground surface.

 

Manually Using a Single Filter: To use the Model Key-point filter to classify points, choose it from

the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

268
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Model Key-point Filter Options Dialog: The 'Model Key-point Filter Options' interface gives the user

several options to specify. The source classification, target class, and step size can be set as in other

filters. Unique to this dialog and filter are the options to specify the minimum density of the new

surface classification and the elevation tolerances for determining candidate points to be reclassified.

The hand-filtered ground surface points are currently in Class 2: Ground (orange), so this will be the

source classification for this filter. The user wishes to reclassify some points in this surface as Model

Key-points, so Class 8: Reserved will be the target classification. The default value of 100 units for the

step size will be used for this particular example. The 'Use points every:' option will be kept at its

default setting of 10. This ensures that at least one point in every 10 horizontal units will be reclassed

from the Ground class to Model Key-point class. The default settings for elevation tolerance will also

be used. These settings specify that only points more than 0.2 vertical units above or below the

ground surface will be considered for reclassification. 
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

AFTER: After running the filter, the highest and lowest ground points from Class 2, within the elevation

tolerances, have been reclassified. The "Use points every" setting ensures that there is at least one

Model Key-point (red, below) in every 10 units.
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5.1.18 Percolate Filter

Percolate Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Percolate Filter targets a sparse set of points of a certain classification and adds - or percolates

- more points to this set, thereby gradually making the surface built from this classification set more

dynamic (greater number of points and greater undulation in elevation). This filter is typically used to

build a more complete ground surface given some sparse initial ground point set. The Percolate filter

reclassifies points in the source classification set that are relatively low (or high when the 'Invert' option

is used) without exceeding limits on the steepness of a surface made from the target class.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

268



Data Classification (Manual & Batch) 1087

© 2000-2023 Merrick & Company

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

A ground surface or other planar surface.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

This should be an existing surface class, typically Class 2: Ground.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

268
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Terrain angle: Maximum slope of the ground surface.

Step angle: Maximum incremental slope change created in the ground surface. The angle is

computed by measuring the angle between the new point, the nearest existing point, and the TIN

triangle below the point under consideration.

Step distance: Maximum distance a filtered point can be above the current surface. The distance is

computed by measuring the perpendicular line from the point under consideration to the underlying

TIN triangle.

Invert: When chosen, this option allows the user to percolate points from above, rather than from

below.

Density: The user may choose from three density options: 1. No limit in density. 2. A density of one

point every user-defined number of square units. 3. A user-defined number of points per 1000 square

units.

Filter by collection scan: The user has the ability to filter by collection scan by checking this
option.

Example Filter Use:

Before: In the example below, the user would like to percolate the ground surface. A Min Grid Filter

 with a grid cell size of 40 units has already been run on the data below to provide seeding (or

starting) data for the Percolate Filter. The small number of ground points (orange) are barely visible

within the unclassified (gray) data. The Percolate Filter will be used to create more ground points by

referencing the small number of ground points which currently exist.
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Manually Using a Single Filter: To use the Percolate Filter to increase the density of the ground

points, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Now, click on the 'Filtering Options'  button to define the filter settings.

Percolate Filter Options Dialog: The 'Percolate Filter Options' interface gives the user several

options in specifying parameters for the filter. The source classification, target class, step size, and

overlap can be adjusted as in other filters. Unique to this filter's dialog is the option to choose the

terrain angle of the TIN which the filter will use to find surface points, the step distance, the step angle,

the choice to invert the percolate filter, and the option to specify the density of the points percolated.
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In this example, the source classification will be Class 1 (gray), as most of the data set is currently

unclassified. The target classification will be Class 2: Ground (orange).The default settings for Step

Size and Overlap will work for most projects, so they will be used for this example. The Terrain angle

and Step angle will be set to 85 and 25 respectively, allowing more angling in the surface since the

area in question is relatively hilly. The Step distance has been set to 3. Finally, the filter has been set

to percolate, or create, a point density of one point every 20 square units. Click 'OK' to save the

settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After the filter has been run, there are many more ground points visible in the filtered area. The

Percolate Filter has taken the ground points which already existed and used them to increase the

density of ground points in the area specified by the user. 
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In the cross-section example below, it is easier to see the results of the Percolate Filter. The filter has

accurately reclassified the ground in most cases. A few stray ground points can be seen in the

vegetation above the ground, but these are easily removed either by hand editing or by use of another

filter.

If the ground points are turned on while all other points are turned off and the surface is then TINned, it

is now possible to see the beginning of a ground surface.
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5.1.19 Plane Analysis Filter

Plane Analysis Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Plane Analysis Filter is designed to find and reclassify groups of LAS points that form planar

surfaces. This filter functions differently than the Building filter because it is capable of specifying

different angles of planar surfaces such as roofs. This tool does not require a reference surface to

separate features.
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For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.
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Filter Specific Parameters:

Min Area: This value represents the minimum area required for inclusion into the Plane Analysis

tool. Any planar feature with an area less than this value will be ignored. This value is in the same

units as the LAS data (ex. feet or meters).

Grid Resolution: This parameter sets the cell size of the grid created for feature extraction. This

value is in the same units as the LAS data with a default value of 1. The grid resolution is defined for

the sliding array of 5x5 grid cells on which the Planar Analysis algorithm operates. The grid

resolution should be set to approximately what the GSD (ground sample distance) is.

Minimum Number of Cells to Calculate Slope (3 to 25): Specifies the minimum number of cells

from the 5x5 grid array to qualify the centroid cell as a planar point. This value must be greater than

3 and less than 25.

Minimum Std Z Error: Specifies the minimum standard Z error for an acceptable least squares

plane solution.

Maximum Angle: Specifies the maximum angle of interest in degrees. LAS points associated with

planar features at angles greater than this value will not be reclassified.

Minimum Angle: Specifies the minimum angle of interest in degrees. LAS points associated with

planar features at angles less than this value will not be reclassified.

Example Filter Use:

Before: In the example below, the user wishes to classify buildings from Class 5: High Vegetation

(green) to Class 6: Building (dark blue). 
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Manually Using a Single Filter: To use the Plane Analysis Filter to classify planar (flat) features,

choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Plane Analysis Filter Options Dialog: The 'Plane Analysis Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique to this dialog is the option to define a min area, a grid

resolution, the number of cells that should be used to calculate slope, the max Z error, and the

minimum and maximum angle of the plane. 

268
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In this example, Class 5: High Vegetation will be the source classification since the buildings are

currently classed as high vegetation. The target class will be Class 6: Building. The step size, overlap,

and min area defaults will be used for this example. The grid resolution has been set to 5. The grid

resolution should be set to approximately match the ground sample distance of the data, and in the

example data the GSD is just under 5 units. The default values in the Plane Analysis Options section

can be left as is. Click 'OK' to save the settings.

 

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected
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Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: The filter has done a decent job of picking out the flat, planar surfaces of buildings and roofs in

this example. Any Class 5 point matching the criteria as stated in the Plane Analysis Filter Options

interface has been reclassified as a Class 6 building point.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.20 Reclassify Filter

Reclassify Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Reclassify Filter reclassifies all points from the source classification(s) to the target

classification. There are no additional parameters with this filter.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

268
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step size suggested for most projects using this filter is 3000.

Overlap (%): Not applicable for this filter.

Use All Collection Scans: When checked, all collection scans will be included in the reclass.  If

unchecked, an individual collection scan number must be entered for filtering.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Example Filter Use:

Before: In the example below, all classifications are to be turned to Class 1: Unclassified (gray).
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Manually Using a Single Filter: To use the Reclassify Filter to reclassify all points to a single target

class, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Reclassify Filter Options Dialog: The 'Reclassify Filter Options' interface gives the user several

options in specifying the filter. The source classification, target class, and step size can be adjusted

as in other filters.

In this example, the source classification will be all classes. To set this, choose the 'All

Classifications On' button when selecting classes for the source classification. The target

classification will be Class 1: Unclassified (gray). The default setting for step size will work for most

projects, so it will be used for this example. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this
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project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, all classes have been reclassified to Class 1 (gray).

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.21 Return Filter

Return Filter
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Merrick Advanced Remote Sensing (MARS
®

) Software

The Return Filter reclassifies source points that match the specified return value requirement. See

also Consistent Return Filter .

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Returns are not listed only as 1st return, 2nd return, etc., but rather are identified in the context of how

many total returns were recorded from the laser pulse (e.g., 1st of 3 returns).  Any combination of

these return values can be specified. (There are 36 possible values for a laser capable of sensing 8

returns from a single laser pulse.)  To aid in the specification of the desired return values, there are

shortcuts for describing some of the commonly used sets of possible return values.  These are:

All returns: Displays all possible return values, including Unknown.

Single returns: Displays 1st of 1 return.

First (including single) returns: Displays 1st return of any number of total returns.

First but not single returns (first of many): Displays only 1st return of any 2

through 15 total returns.

Last including single returns (1st of 1, 2nd of 2, 3rd of 3, ...): Displays only last

returns of any number of total returns.

Last but not single returns (last of many): Displays only 2nd of 2 returns, 3rd of 3

returns, and so on through 15th of 15 returns.

1000
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Intermediate: Displays only returns that are neither the first nor the last return.

User-specified returns: Allows selection from an array of return values.

Please see the 'Display Selection: Return' section of the View Tab  Help Topic for complete

return selection options.

Requirements:

LAS data with discrete return values.  This filter cannot be used unless the data to be filtered

contains valid point family (discrete return) information.  A pop-up warning will be displayed if this

information is not present in the LAS files.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 1000.

Overlap (%): Not applicable for this filter.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

192
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Filter Specific Parameters:

Return value set: Comma-separated list of return value specifications. Each item in the list will be

a string in the form ‘R/T’ where R is the return number and T is the total number of returns.

Example Filter Use:

Before: In the example below, the user would like to reclassify all single returns to ground since the

specified area does not contain any vegetation, buildings or other above-ground objects and is most

likely  all ground.

Manually Using a Single Filter: To use the Return Filter to reclassify all points with specific return

values to a single target class, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab

. 
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Next, click on the 'Filtering Options'  button to define the filter settings.

Return Filter Options Dialog: The 'Return Filter Options' interface has several parameters to control

the filter's operation. The source classification, target class, and step size can be adjusted as in other

filters. Unique to this filter is the ability to choose specific return values and reclass only source points

with those values.

In this example, the source classification will be Class 1: Unclassified (gray) as the sample data is all

unclassified. The target classification will be Class 2: Ground (orange). The default setting for step

size will work for most projects, so it will be used for this example. In choosing the return values for

reclassification, the user may click one of the quick-set radio buttons on the left to make their

selection, or the user can choose each return value individually with the check boxes on the right side

of the interface. Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, all single returns have been reclassified to Class 2. Because this area

was so flat and did not contain any above-ground objects, every return was a single return and

therefore, the entire filtered area is now classified as ground.
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5.1.22 RGBNI Value Filter

RGBNI Value Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The RGBNI Value Filter reclassifies LAS points based on the RGBN (Red, Green, Blue, NIR) values

of a co-located imagery file, or the RGBN and Intensity values stored at the point level for an LAS file

with Point Data Record Formats 7 (RGB) or 8 (RGBN).  This filter operates on RGB or RGBN (NIR)

imagery only and will not work on hyperspectral imagery; however, the filter will function with single

band or gray-scale imagery.  To use this filter, select or enter a target value and variance range for

each of the color components.  Depending on the 'Value Source' being used, any Source
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Classification LiDAR points within the user-defined 'Search radius' of an image pixel with the specified

component values, or any Source Classification LiDAR points meeting the specified component values

will be reclassified to the Target Class.  Please see the underlined note below in the 'RGBNI Value

Filter Options Dialog' section regarding the use of this tool with WMS imagery.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

Classified LAS data.

Co-located RGB or RGBN imagery is required unless the loaded LAS data has a PDRF where

RGBN values are stored at the point level (PDRFs 7 or 8).  (Please see the underlined note below in

the 'RGBNI Value Filter Options Dialog' section regarding the use of this tool with WMS imagery.)

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time.  For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units.  In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases.  The default

268
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step size suggested for most projects using this filter is 1000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

).  More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments.  Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter is added and saved to a filter macro script .  Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Value Source: This setting determines the source (either 'Raster Imagery' or 'LiDAR Points') that

will be used to populate the 'Target Values' when the 'Pick Values' button is clicked.  For the 'Raster

Imagery' option,  the 'Search radius' must be set to evaluate candidate Source Class points based

on their proximity in project units to any pixels whose RGBN values fall within the range and

variance populated for all channels.  When single-band (grayscale) imagery is being used, check the

'Single-band Image' box to populate and use Target Values for the Red/Grayscale channel only.

Pick Values: Allows the user to choose color values based on a raster image pixel or color and

intensity values from a specific LiDAR point, depending on the 'Value Source' selected.  For the

'Raster Imagery' option, at least one image must be loaded and checked on for display.  The image

(s) must contain 8-bit color values to be used with this filter.  For the 'LiDAR Points' option, the

loaded LiDAR data must be in PDRF 7 (RGB) or 8 (RGBN).  (Please see the underlined note below

in the 'RGBNI Value Filter Options Dialog' section regarding the use of this tool with WMS imagery.)

Use Red: This is the target color value for the Red channel.  The user can define the target

component value within the range (0 – 65535) with an allowable variance value.  Together, these

values form the data reclassification criteria for the Red component of the filter when either multi-

band 'Raster Imagery' or 'LiDAR Points' is the 'Value Source'.  If the 'Single-band Image' box is
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checked for the 'Raster Imagery' option, this channel is used for the Grayscale values - 0 (pure

black) to 65535 (pure white).

Use Green: This is the target color value for the Green channel.  The user can define the target

component value within the range (0 – 65535) with an allowable variance value.  Together, these

values form the data reclassification criteria for the Green component of the filter.

Use Blue: This is the target color value for the Blue channel.  The user can define the target

component value within the range (0 – 65535) with an allowable variance value.  Together, these

values form the data reclassification criteria for the Blue component of the filter.

Use NIR: This is the target 'color' value for the Near Infrared channel.  The user can define the target

component value within the range (0 – 65535) with an allowable variance value.  Together, these

values form the data reclassification criteria for the Near Infrared component of the filter.

Use Intensity: This is the target intensity value.  This component is available to use only when the

'LiDAR Points' option is selected.  The user can define the target component value within the range

(0 – 65535) with an allowable variance value.  Together, these values form the data reclassification

criteria for the Intensity value component of the filter.

Example Filter Use:

Before: In the example below, the user would like to reclassify Building (Class 6) points based upon

the RGB values of the large blue-colored building roof (right graphic, top center) in the loaded LiDAR

data.  Intensity values are not being used in this example.

LAS data rendered by Class:

   LAS data rendered by RGB values:
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Manually Using a Single Filter: To use the RGBNI Value Filter to reclassify points based on user-



Data Classification (Manual & Batch) 1113

© 2000-2023 Merrick & Company

specified values, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

RGBNI Value Filter Options Dialog:  The 'RGBNI Value Filter Options' interface gives the user

several options in setting the parameters of the filter.  The source classification, target class, step

size, and overlap can be specified as in other filters.  Unique features to this filter include the ability to

select the desired components (red, green, blue, NIR, and intensity), as well as the exact values (with

an optional variance range) for each of these components.  The 'Pick Values' button with the 'Raster

Imagery' option selected allows the user to choose the color values from a pixel of the loaded

imagery.  The 'Search radius' setting determines how far away from the selected pixel the candidate

Source Class points can be.  The interface will disappear until a pixel is clicked on, and then reappear

with the RGBN values from that pixel populated in the 'Target Values' section.  Please note that the

accuracy of the returned RGBN values when WMS imagery is loaded is dependent on the current

resolution of the image.  A single set of interpolated RGBN values can cover a large area on the

image when viewed at a reduced resolution (wide extent).  The 'Pick Values' button with the 'LiDAR

Points' option selected allows the user to choose the color and intensity values from a specific LiDAR

point.  Points should first be rendered by RGBN values to aid in selection.  The interface will disappear

until a LiDAR point is clicked on, and then reappear with the RGBN values of that point populated in

the 'Target Values' section.  Target values and variances can also be entered manually without using

the 'Pick Values' button.  Click 'OK' to save the settings and exit the filter options window.

Below are examples of the filter options dialog when PDRF 7 LiDAR data is loaded and the 'LiDAR

Points' option is being used.  Class 6: Building (dark blue) is being reclassified to Class 64: User

Definable (white) based on LiDAR point RGB values.  The 'Pick Values' button will be used to select

268



MARS® v2023.1           User Manual1114

© 2000-2023 Merrick & Company

a blue-colored building point from the loaded LAS data.  Class 6 points whose RGB values fall within

the 'Target Values' ranges will be reclassified to Class 64.

Before selecting a LiDAR point with the 'Pick Values' button:      After

selecting a LiDAR point and modifying the variance values:
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.
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After: After running the filter, the blue building points with the RGB values and ranges specified have

been reclassified from Class 6 (dark blue) to Class 64 (white).  Since not all the blue-colored building

points are the same shade of blue, expanding the variance values would reclass more of them.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.23 Scan Angle Filter

Scan Angle Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Scan Angle Filter is made to be used with the 'Convert SBET to Shapefile' tool (found on the

Vector Creation Tab ). The Scan Angle filter is capable of using an SBET file which has been

converted into a 3D shapefile to reclassify certain sets of points. Remember that the 3D shapefile
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used in this filter represents the SBET, and this is the actual path of the plane in flight. The LiDAR

data, represented by the ground beneath the plane, is collected at different angles in relation to the

plane. See the diagram below for further explanation:

This filter is capable of reclassing points based on that angle, called the scan angle. In the diagram

above, the points collected on the ground at the bottom of the blue arrow represent a different scan

angle than those points collected on the ground at the bottom of either of the red arrows. This filter can

reclass points based solely on their scan angle or, more accurately, their scan angle rank. The user

may enter several different parameters based on minimum and maximum scan angle ranks, resulting

in several different classes of points each representing a separate scan angle rank range. The output

of this filter can be used to run statistics of density per class or to run statistics based on the density

of the scan angle rank ranges. 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab
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. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LiDAR data.

Although this filter can reclassify data based on a 3D shapefile representing an SBET, a 3D SBET

shapefile is not required to use this filter.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters: 

SBET Shapefile: This filter is capable of using a previously created 3D shapefile converted from an

268
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SBET file. To create this shapefile, please see the 'Convert SBET to Shapefile' tool located on the 

Vector Creation Tab . Once this file has been created, use this section of the interface to point to

this file to be used in the filter. Make sure to check the box marked 'Use SBET Shapefile' if an

SBET shapefile will be used in the filter. If this box remains unchecked, the filter will read the scan

angle rank from the LiDAR points and reclass these points to the Target Class based on the angle

requirements specified.

Angle Difference Requirement: This section of the interface allows the user to enter one or many

different minimum and maximum angle requirements for reclassification. The filter is capable of

reclassifying multiple different scan angle rank ranges to discrete classes.  Values can be positive

or negative (representing each direction from nadir), but must be between -90 and 90.  LAS v1.4

PDRF 6 or higher data stores both the newer scan angle (-15000 to 15000) and legacy scan angle

rank (-90 to 90) values per point.  The easier-to-understand scan angle rank values in degrees from

nadir are used by this filter.

Minimum Angle: Enter the minimum angle requirement for the desired scan angle

rank range (inclusive).

Maximum Angle: Enter the maximum angle requirement for the desired scan angle

rank range (not inclusive).

Target Class: The class to which the Source points that meet all criteria of the filter

are assigned. Each minimum and maximum angle requirement range can (and

should) be reclassified to a separate target class. 

Example Filter Use:

Before: In the example below, the LiDAR data associated with the 3D shapefile has not yet been

classified. All points are currently in Class 1: Unclassified (gray). The 3D shapefile representing the

SBET was used in this case and can be seen in white. 
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Manually Using a Single Filter: To use the Scan Angle Filter to reclass points based on their scan

angle rank, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Scan Angle Filter Options Dialog: The 'Scan Angle Filter Options' interface gives the user several

options in specifying the filter. The source classification, step size, and overlap can be adjusted as in

other filters. Unique to this dialog and filter is the option to use a 3D shapefile representing an SBET

file for reclassification, and the ability to specify certain scan angle rank ranges for reclassification into

multiple discrete classes. 

In this example, the source classification will be Class 1: Unclassified, as the LiDAR data being used
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in this example has not yet been classified. The default settings for step size and overlap will work for

most projects, so they will be used for this example. The user has chosen to apply a 3D SBET

Shapefile and so has checked the option called 'Use SBET Shapefile'. The 3D shapefile which

represents the SBET file has been pathed out in the 'Browse...' box in the 'SBET Shapefile' section.

Scan angle ranks can have negative and positive values as described above, and in this example the

scan angle ranks will be split into 5 degree increment ranges except on either side of 0 (zero). Scan

angle ranks between -20 and -15 degrees and +15 to +20 degrees are both to be reclassified to Class

10 (yellow), scan angle ranks between -15 and -10 degrees and +10 to +15 degrees are both to be

reclassified to Class 3 (green), scan angle ranks between -10 and -5 degrees and +5 to +10 degrees

are both to be reclassified to Class 11 (red), and scan angle ranks between -5 and 0 degrees and 0

to +5 degrees are both to be reclassified to Class 6 (dark blue). Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.
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After: After running the filter, it can be seen that the points in each defined range have been reclassed

based on their scan angle rank. Points with scan angle ranks closest to 0 (-5 to 0, and 0 to +5) have

been reclassed to Class 6 (dark blue). Points with scan angle ranks between -5 and -10 and +5 to +10

degrees have been reclassed to Class 11 (red), and so on as described above.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.24 Slope Filter

Slope Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Slope Filter reclassifies source LiDAR points to a specified target class based on them falling

within a user-defined range of minimum and maximum angles for the slope they occupy.  This filter is

designed for general identification, not exact analysis.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A classified LiDAR dataset.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

268
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step size suggested for most projects using this filter is 1000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage allows for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters: 

Slope Requirement Minimum: To be considered for reclassification, the source points must exist

on a slope of at least this angle (in degrees).

Slope Requirement Maximum: To be considered for reclassification, the source points must

exist on a slope of no more than this angle (in degrees).

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Each minimum and maximum slope requirement range can (and should) be reclassified to a

separate target class.

Grid cell size: The cell size (in horizontal project units) of the virtual grid built to determine slope

angles.  A smaller value provides more detail, but takes longer to process.

Example Filter Use:

Before: In the example below, the dataset has only Class 2 (ground - orange) including Model Key-

points. Using the TIN rendering function, sloped areas can be more easily identified.
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Manually Using the Filter: To use the Slope Filter to classify points based on the angle of the slope

they occupy, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

'Slope Filter Options' Dialog: The 'Slope Filter Options' interface gives the user several options for

specifying the filter's action. The Source Classification(s), Target Class, Step Size, and Overlap can

be set as in other filters. Unique to this filter are the settings for a minimum and maximum slope angle

(in degrees), and the virtual grid cell size used to determine the slope of the source points.

In this example, the source classification will be Class 2: Ground (All). The target class will be Class

50 to aid in viewing the results below. The default settings for step size (1000) and overlap percentage
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(30) will work for most projects but can be changed as desired. The Minimum and Maximum slope

angles are set to 15 and 20, respectively. The Grid cell size will be left at the default value, 100.  Click 

'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data..

After: After running the filter, the area of the 100 foot virtual grid containing points that are on slopes

with angles between 15 and 20 degrees has been reclassified to Class 50 (pink).

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.25 Smart Clip Filter

Smart Clip Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Smart Clip Filter works very similarly to the Scan Angle Filter , but contains a smart clipping

improvement.  This filter will reclass points at varying angles of the Field of View while still ensuring full

coverage.  It does not take into account the values from a corresponding SBET file, as it is intended
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for data collected by the LiDAR sensor's full Field-of-View (FOV) with no roll compensation applied. 

This filter may be useful when calibrating the edge of the Field of View (edges of the LiDAR data)

which can cause problems or errors when modeling.  The illustration below further explains the 'scan

angle value' or 'scan angle rank', which is specified in the filter options interface.  The LiDAR data,

represented by the ground beneath the plane, is collected at different angles in relation to the attitude

of the plane.  See the diagram below for further explanation:

In the diagram above, the points collected on the ground at the bottom of the blue arrow represent a

different scan angle than those points collected on the ground at the bottom of either of the red arrows.

 This filter reclasses points based on their scan angle or, more accurately, their scan angle rank, while

preserving the overlapping collection scan data and ensuring complete coverage.  The user may enter

several different parameters based on minimum and maximum scan angle ranks resulting in several

different classes of points, each representing a separate scan angle rank range.  For example, the

scan angle ranks above may run from -20 degrees (red arrow) to 0 degrees (blue arrow) and then up to

+20 degrees (other red arrow).  This would make the Field of View 40 degrees. 

The Smart Clip filter calculates a boundary of each collection scan (flight line). In the example below,
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two separate collection scans are shown in blue and pink.  The area in which they overlap is colored

gray.  There is a 5 degree overlap in collection scans in this particular area.  If the user chooses to clip

3 degrees from the edge of each collection scan, a gap of 1 degree will be created between these

scans.  The Smart Clip filter will recognize this and clip only 2.5 degrees from each collection scan in

this particular area to avoid creating a gap.  The user may choose to clip out a number of degrees of

data on each side of the Field of View with this tool and not cause data gaps in the process. 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

.  Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

268
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LiDAR data

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Step Size: Specifies how much data the filter will work on at a time.  For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units.  In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases.  The default

step size suggested for most projects using this filter is 100.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

).  More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments.  Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter is added and saved to a filter macro script .  Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters: 

Scan Angle Rank Requirement: This section of the interface allows the user to enter one or many

different minimum and maximum angle requirements for reclassification.  The filter is capable of

reclassifying multiple different scan angle rank ranges to discrete classes.  Values can be positive

or negative (representing each direction from nadir), but must be between -90 and 90.  LAS v1.4

PDRF 6 or higher data stores both the newer scan angle (-15000 to 15000) and legacy scan angle

rank (-90 to 90) values per point.  The easier-to-understand scan angle rank values, in degrees from

nadir, are used by this filter.

Minimum Angle: Enter the minimum angle requirement for the desired scan angle
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rank range (inclusive).

Maximum Angle: Enter the maximum angle requirement for the desired scan angle

rank range (not inclusive).

Target Class: The class to which the Source points that meet all criteria of the filter

are assigned.  Each minimum and maximum angle requirement range can (and

should) be reclassified to a separate target class. 

Example Filter Use:

Before: The example below is shown colored by collection scan.  Notice the overlap area between the

cyan and magenta collection scans.  There is some overlap in this area and no data gaps.  The Smart

Clip filter will be useful in this area to prevent clipping too much data off the edges of the collection

scans and causing a data gap. 
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Manually Using a Single Filter: To use the Smart Clip Filter to reclass points based on their scan

angle rank, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Smart Slip Filter Options Dialog: The 'Smart Clip Filter Options' interface gives the user several

options in specifying the filter.  The source classification, step size, and overlap can be adjusted as in

other filters. Unique to this dialog and filter is the ability to denote certain scan angle rank ranges for

reclassification into multiple discrete classes. 

In this example, the source classification will be Class 1: Unclassified, as the LiDAR data being used

in this example has not yet been classed.  The default settings for step size and overlap will work for

most projects, so they will be used for this example.  In this example, the user has chosen to clip 6

degrees of data off both edges of each collection scan.  To do this, the outermost scan angle ranks (in

this case, scan angle ranks from -26 to -20 and from 20 to 26) are clipped out of the data.  The points

storing scan angle ranks which are specified for clipping will be reclassed from Class 1 (gray) to Class

10 (yellow). Click 'OK' to save the settings.

*** A warning regarding Smart Clip filter use:  ALL angle requirements must be stated within a

single filter instance in a macro, or there will be a risk of creating gaps.***  The Smart Clip filter

will ensure full coverage when all requirements are listed at once in the 'Scan Angle Rank

Requirement' section of the filter, but if separate instances of the filter with separate requirements are

processed on the same data, full coverage of data cannot be guaranteed. 
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data..

After: After running the filter, it can be seen that the source points as defined in the options window
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have been reclassed to Class 10 (yellow) based on their scan angle rank.  In the particular area shown

below the Smart Clip filter preserved data at the edges of these two collection scans rather than

strictly following the input clip percentage.  This prevented gaps in the areas indicated by red arrows. 

If the filter would have continued to clip a full 6 degrees in these areas, this would have produced a no-

data gap since there was not sufficient overlap to clip and reclassify a full 6 degrees of LiDAR data. 

The Smart Clip filter clipped as much data as possible from these areas without creating a gap in

coverage.
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© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.26 Smooth Grid Filter

Smooth Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Smooth Grid Filter builds a grid surface from the points of the source classification. The grid

surface is built by creating a TIN from the source classification points, and then sampling elevations at

each of the grid point coordinates. Next, a Gaussian smoothing function is (optionally) applied,

repeating the smoothing as specified by the 'Number of passes ...' value. Finally, points in the source

classification set are compared to this grid surface and reclassified to the target classification, if they
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meet the elevation difference requirements as specified by the filter parameters.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

268
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permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: The size in project units of the cells of the grid.

Number of passes of grid smoothing: Specifies how many times the Gaussian smoothing routine

is applied to the grid surface.

Elevation Difference Requirement

Exactly at a minimum: Specifies that reclassed points are exactly at a minimum

elevation.

Maximum limit: Specifies that reclassified points are at most this difference in

elevation higher than the grid surface. This value can be negative, in which case it

represents the maximum limit below the grid surface.

Minimum limit: Specifies that reclassified points are at least this difference in

elevation higher than the grid surface. This value can be negative, in which case it

represents the minimum limit below the grid surface.

Both max and min limit: Specifies the software will use both maximum and

minimum parameters set for elevation.

Use slope: If checked, this option will calculate the elevation difference perpendicular ('normal') to

the slope of the grid surface.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, the user would like to create smooth gridded data based on the

1209



Data Classification (Manual & Batch) 1139

© 2000-2023 Merrick & Company

elevation at the center of each grid cell, and reclassify points which are a specific elevation difference

requirement from that gridded surface. This will include trees and other vegetation in this particular

example.

Manually Using a Single Filter: To use the Smooth Grid Filter to reclassify points within a specific

elevation difference from the surface and to smooth the data based on the center of the grid cell,

choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Smooth Grid Filter Options Dialog:  The 'Smooth Grid Filter Options' interface gives the user

several options in specifying the filter. The source classification, target class, step size, and overlap

can be adjusted as in other filters. Unique features to this filter include the ability to select the Grid

cell size and the number of passes of grid smoothing. The user also has the option of specifying the

elevation difference requirements for points to be reclassified. This filter also has the ability to filter by

268
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collection scan, and to use the slope in calculating the elevation difference. Click 'OK' to save the

settings.

In this example, all data is initially classed as Class 1: Unclassified (gray) and filtered points will be

reclassified to Class 5: High Vegetation (green). This makes Class 1 the source class and Class 5 the

target class. Most of the points found above the surface in this example are actually trees, brush, and

other vegetation so the points filtered out of the data will be reclassed to Class 5: High Vegetation.

The default values for step size and overlap will be used for this example. The grid cell size has been

set to 10, meaning a 10 unit by 10 unit area will be defined for each grid cell. The number of Gaussian

smoothing passes has been set to 1. The elevation difference requirement states that any points

which are at least 2 units above the gridded surface should be reclassed to Class 5: High Vegetation.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data.

After: After running the filter, the points more than the minimum elevation difference above the gridded

surface (temporary ground) have been filtered out and reclassified as Class 5: High Vegetation.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.27 Smooth Max Grid Filter

Smooth Max Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Smooth Max Grid Filter builds a grid surface from the maximum elevation points of the source

classification set. Then, a Gaussian smoothing function is applied, repeating the smoothing as

specified by the 'Number of passes ...' value. Finally, points in the source classification set are
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compared to this grid surface and reclassified to the target classification if they meet the elevation

difference requirements as specified by the min_diff and max_diff parameters.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text
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here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: The size of the cells of the grid.

Number of passes of grid smoothing: Specifies how many times Gaussian smoothing is applied

to the grid surface.

Elevation Difference Requirement

Exactly at a minimum: Specifies that reclassed points are exactly at a minimum

elevation.

Maximum limit: Specifies that reclassified points are at most max_diff higher in

elevation than the grid surface. This value can be negative.

Minimum limit: Specifies that reclassified points are at least min_diff higher in

elevation than the grid surface. This value can be negative.

Both max and min limit: Specifies the software will use both maximum and

minimum parameters set for elevation.

Use slope: If checked, this option will calculate the elevation difference perpendicular to the slope of

the grid surface.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, the user would like to create smooth gridded data based on the

maximum elevation point of each grid cell, and reclassify points which are a specific elevation

difference requirement from that gridded surface. This will include reclassifying cars out of the
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vegetation class in this particular example.

Manually Using a Single Filter: To use the Smooth Max Grid Filter to reclassify points within a

specific elevation difference from the surface and to smooth the data based on the highest point of the

grid cell, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Smooth Max Grid Filter Options Dialog:  The 'Smooth Max Grid Filter Options' interface is very

similar to the other two smoothing filters. It gives the user several options in specifying the filter such

as the source classification, target class, step size, and overlap. Unique features to this filter include

the ability to select the grid cell size and the number of passes of grid smoothing. The user also has

the option of specifying the elevation difference requirements for points to be reclassified. By default,

the elevation difference requirement is set at the 'Maximum limit' to select those points with the max
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elevation for smoothing.

In this example, all buildings and cars are classed as Class 5: High Vegetation (green), and filtered

points which represent cars will be reclassified to Class 10 (yellow). This makes Class 5 the source

class and Class 10 the target class. Most of the points found above the surface in this example are

actually buildings or cars, which can be separated by their elevation difference from the surface. The

default values for step size and overlap will be used for this example. The grid cell size has been set to

20, meaning a 20 unit by 20 unit area will be defined for each grid cell. The elevation difference

requirement states that any points which are at most 10 units below the surface data (which will

include most cars) should be reclassed to Class 10.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will268
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automatically refresh and show the reclassified data.

After: After running the filter, the cars surrounding the building in this example have been classified as

Class 10 (yellow).

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.28 Smooth Min Grid Filter

Smooth Min Grid Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Smooth Min Grid Filter builds a grid surface from the minimum elevation points of the source

classification set. Then, Gaussian smoothing is applied, repeating the smoothing as specified by the

'Number of passes ...' value. Finally, the points in the source classification are compared to the grid

surface and reclassified to the target classification if they meet the elevation difference requirements
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as specified by the min_diff and max_diff parameters.

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored
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permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Grid cell size: The size of the cells of the grid.

Number of passes of grid smoothing: Specifies how many times Gaussian smoothing is applied

to the grid surface.

Elevation Difference Requirement

Exactly at a minimum: Specifies that reclassed points are exactly at a minimum

elevation.

Maximum limit: Specifies that reclassified points are at most max_diff higher in

elevation than the grid surface. This value can be negative.

Minimum limit: Specifies that reclassified points are at least min_diff higher in

elevation than the grid surface. This value can be negative.

Both max and min limit: Specifies the software will use both maximum and

minimum parameters set for elevation.

Use slope: If checked, this option will calculate the elevation difference perpendicular to the slope of

the grid surface.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Example Filter Use:

Before: In the example below, the user would like to create smooth gridded data based on the

minimum elevation point of each grid cell, and reclassify points which are a specific elevation difference

requirement from that gridded surface. This will include trees and other vegetation in this particular

example.
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Manually Using a Single Filter: To use the Smooth Min Grid Filter to reclassify points within a

specific elevation difference from the surface and to smooth the data based on the lowest point of the

grid cell, choose it from the 'Filter Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

Smooth Min Grid Filter Options Dialog:  The 'Smooth Min Grid Filter Options' interface is very

similar to the other two smoothing filters offered. It gives the user several options in specifying the filter

such as the source classification, target class, step size, and overlap. Unique features to this filter

include the ability to select the grid cell size and the number of passes of grid smoothing. The user

also has the option of specifying the elevation difference requirements for points to be reclassified. By

default, the elevation difference requirement is set at the 'Minimum limit' to select those points with the

min elevation for smoothing. Click 'OK' to save the settings.

268



MARS® v2023.1           User Manual1152

© 2000-2023 Merrick & Company

In this example, all data is classed as Class 1: Unclassified (gray) and filtered points will be

reclassified to Class 5: High Vegetation (green). This makes Class 1 the source class and Class 5 the

target class. Most of the points found above the surface in this example are actually trees, brush, and

other vegetation so the points filtered out of the data will be reclassed to Class 5: High Vegetation.

The default values for step size and overlap will be used for this example. The grid cell size has been

set to 20, meaning a 20 unit by 20 unit area will be defined for each grid cell. The number of Gaussian

smoothing passes has been set to 1. The elevation difference requirement states that any points

which are at least 10 units above the surface data should be reclassed to Class 5: High Vegetation.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: After running the filter, the points above the ground have been filtered out and reclassified as

Class 5: High Vegetation.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.29 Timestamp Filter

Timestamp Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The Timestamp Filter uses stored timestamp values as a parameter in the reclassification of data. 

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

LAS data with timestamp values stored at the point level. If the LAS data uses the preferred

'Adjusted GPS Time' as the stored time type, the filter reads those adjusted timestamps and

ignores the 'Seconds of the GPS Week' values that are also stored at the point level. If the LAS data

uses the older 'GPS Week Time' format, then the filter will read the 'Seconds of the GPS Week'

values.

General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

268

268



Data Classification (Manual & Batch) 1155

© 2000-2023 Merrick & Company

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 100.

Overlap (%): Not applicable for this filter.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Above Mode: Reclassifies all source points with timestamp values later than the specified Lower

Limit value.

Below Mode: Reclassifies all source points with timestamp values earlier than the specified Upper

Limit value.

Between Mode: Reclassifies all source points with timestamp values between the specified Lower

and Upper Limit values.

Upper Limit: When using Below Mode or Between Mode, this is the latest timestamp value to be

considered.

Lower Limit: When using Above Mode or Between Mode, this is the earliest timestamp value to be

considered.

Example Filter Use:

Before: In the example below, the user wishes to reclassify all the points between two timestamp

values. Several LAS files are loaded for this example.
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Manually Using a Single Filter: To use the Timestamp Filter to reclassify all points with specific

timestamp values to a single target class, choose it from the 'Filter Action' drop-down list on the Edit/

Filter Tab .

Next, click on the 'Filtering Options'  button to define the filter settings.

Timestamp Filter Options Dialog: The 'Timestamp Filter Options' interface gives the user several

options in specifying the parameters of the filter. The source classification, target class, step size, and

overlap can be adjusted as in other filters. Unique features to this filter include the ability to select

which LAS points are reclassified by choosing Above, Below, or Between two timestamp values. The

Upper Limit and Lower Limit entry boxes are used to set the timestamp range.
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In this example, the source classification will be Class 1: Unclassified (gray) because the sample data

set is unclassified. The target classification will be Class 7 (magenta). The default settings for step

size and overlap will work for most projects, so they will be used for this example. Timestamp values

were found using the Inspect  tool, and the points to be reclassified have timestamp values between

171124100 and 171124604. Click 'OK' to save the settings.

Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

943
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After: After running the filter, all source points with timestamp values between the specified Lower and

Upper Limit have been reclassified to Class 7 (magenta). 

© 2000-2023 Merrick & Company. All Rights Reserved.

5.1.30 XY Distance Filter

XY Distance Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The XY Distance Filter reclassifies points that are within a specific horizontal distance of a point in the

reference classification set. The radius distance measured when using this tool is measured
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only in an XY (horizontal) distance. This tool is very similar to the Ground Distance tool, except that

the ground distance tool measures distance along the ground surface and slope. For more information,

please see the Ground Distance Filter .

For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A reference classification that is not also the source classification.

1043
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General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

XY Distance: User-defined distance requirement for reclassified points. Reclassified points must

be within xy_distance of the reference classification point.

Height Requirement

No limit: Specifies no requirement in elevation.

Maximum limit: Specifies a requirement that points that are reclassified are at most

max_diff higher in elevation than the nearby reference point. Height is measured

perpendicular to the ground surface. This value can be negative.

Minimum limit: Specifies a requirement that points that are reclassified are at least

min_diff higher in elevation than the nearby reference point. Height is measured
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perpendicular to the ground surface. This value can be negative.

Both max and min limit: Specifies the software will use both maximum and

minimum parameters set for elevation.

Angle Requirement

No limit: Specifies no requirement in angle.

Maximum limit: Specifies a requirement that points that are reclassified are at most

max_angle higher than the nearby reference point. Angles are measured from the

ground surface. This value can be negative.

Minimum limit: Specifies a requirement that points that are reclassified are at least

min_angle higher than the nearby reference point. Angles are measured from the

ground surface. This value can be negative.

Both max and min limit: Specifies the software will use both maximum and

minimum angle parameters.

Filter by collection scan: The user has the ability to filter by collection scan by checking this

option.

Reference Classification Set

Reference Classifications: The point data classification used to compare the unfiltered data

against to find points to reclassify based on XY distance proximity. *Note: If the source and

reference classification sets are the same, the XY Distance filter will not include the class of the

point being measured from as a candidate for reclassifying itself. This is an automatic assumption

of the filter.

Example Filter Use:

Before: In the example below, the user is attempting to separate vegetation within 25 horizontal units
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from a building, from vegetation which is farther away.

Manually Using a Single Filter: To use the XY Distance Filter to reclassify all points that are within

a specific horizontal distance of a point in the reference classification set, choose it from the 'Filter

Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.

XY Distance Filter Options Dialog: The 'XY Distance Filter Options' interface gives the user several

options in specifying the filter. The source classification, target class, step size, and overlap can be

adjusted as in other filters. Unique features to this filter include the ability to choose a reference

classification, specify an XY distance from the reference classification set, and the elevation

requirements and angle requirements of the points to be reclassified.

In this example, the source classification will be Class 5: High Vegetation (green) because the user is
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only interested in high vegetation which is within 25 horizontal (XY) units from a building. The target

classification will be Class 10 (yellow). The default settings for step size and overlap will work for most

projects, so they will be used for this example. The reference classification is Class 6: Building (dark

blue) because the user is interested only in points which are within 25 horizontal units from this

particular class. There is no elevation requirement so that all vegetation within the specified distance

from a building point will be reclassed to Class 10. There is no angle requirement restriction for the

same reason. Click 'OK' to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter
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Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: When the filter is finished running it is possible to see all of the areas in which vegetation was

within 25 horizontal units of a building. These areas have been colored yellow to represent Class 10,

as intended.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.1.31 XYZ Distance Filter

XYZ Distance Filter

Merrick Advanced Remote Sensing (MARS
®

) Software

The XYZ Distance Filter reclassifies points that are within a specific spherical distance of a point in

the reference classification set.  In the example below, a red circle with a 25 unit radius is centered

over the corner of a building.  Any source class points (Class 5: High Vegetation in this example) within

a 25 unit radius of any reference class points (Class 6: Building) will be reclassified to Class 10.  Each

reference class point is tested individually for source class points within the specified radius, so the

virtual sphere is moved from point to point until all reference class points in the area being filtered have

been tested.
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For details on adding this filter to a macro within a batch script, see the 'Create/Edit Batch Script'

section in the Edit/Filter Tab  topic.

To use this filter on loaded data, choose it in the 'Filter Action' drop-down list on the Edit/Filter Tab

. Click the 'Filtering Options'  button, which will bring up the appropriate

interface to enter in the desired settings.

Requirements:

A reference classification(s) that is not also the source classification(s).
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General Parameters:

Source Classifications: The user will specify here which class(es) of points will be used as a

source in identifying the proper points to be reclassified.

Target Class: The class to which the Source points that meet all criteria of the filter are assigned.

Step Size: Specifies how much data the filter will work on at a time. For example, a step size of

100 means that processing will occur in areas of 100 units x 100 units. In general, the larger the

step size the faster the filter will run, but more RAM is used as step size increases. The default

step size suggested for most projects using this filter is 3000.

Overlap (%): Specifies the amount of overlap percentage to be used between steps (see Step Size

). More overlap percentage can allow for a more precise output from the filter but requires a longer

running time.

Comments: This area of the filter allows the user to enter any desired comments. Type any text

here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the filter  is added and saved to a filter macro script . Note that the reserved XML

characters <, >, %, &, ', " cannot be used in the Comments box.

Filter Specific Parameters:

Spherical Distance: User-defined distance requirement for reclassified points. Reclassified points

must be within xyz_distance of the reference classifications points.

Filter by collection scan: The user has the ability to filter by collection scan line by checking this

option.

Reference Classification Set

Reference Classifications: The point data classification(s) used to compare the unfiltered

1209



Data Classification (Manual & Batch) 1169

© 2000-2023 Merrick & Company

(source) data against to find points to reclassify based on XYZ distance proximity. *Note: If the

source and reference classification sets are the same, the XYZ Distance filter will not include the

class of the point being measured from as a candidate for reclassifying itself. This is an automatic

assumption of the filter.

Example Filter Use:

Before: In the example below, the user is attempting to separate high vegetation within 25 units of a

building from vegetation which is farther away.

Manually Using a Single Filter: To use the XYZ Distance Filter to reclassify all points that are within

a specific spherical distance of all points in the reference classification set, choose it from the 'Filter

Action' drop-down list on the Edit/Filter Tab . 

Next, click on the 'Filtering Options'  button to define the filter settings.
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XYZ Distance Filter Options Dialog: The 'XYZ Distance Filter Options' interface gives the user

several options in specifying the filter. The source classifications, target class, step size, and overlap

can be adjusted as in other filters. Unique features to this filter include the ability to choose a

reference classification(s), specify an XYZ distance (radius) from the reference classification set, and

filter by collection scan.

In this example, the source classification will be Class 5: High Vegetation (green) because the user is

only interested in high vegetation which is within 25 spherical units from a building. The target

classification will be Class 10 (yellow). The default settings for step size and overlap will work for most

projects, so they will be used for this example. The reference classification is Class 6: Building (dark

blue) because the user is interested only in points which are 25 spherical units from this particular

class. The Spherical Distance has been specified as 25 units for the reasons stated above. Click 'OK'

to save the settings.
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Choosing the Area to be Filtered: Now that the filter options have been specified for use in this

project, the user can define the area in which the filter should run.  To do this, click on the 'Filter

Region' , 'Filter Digitized Polygon' , or 'Filter Selected

Polygons'  button.  The different operation of these tools is described in

the Edit/Filter Tab  help topic.  The LAS Map View and Cross-Section/Profile windows will

automatically refresh and show the reclassified data.

After: When the filter is finished running it is possible to see all of the high vegetation which is within

25 spherical units of a building. These points have been colored yellow to represent Class 10, as

intended.  The remaining green points within 25 spherical units of the buildings are Class 4: Medium

Vegetation, which was not chosen as a Source Class.
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© 2000-2023 Merrick & Company. All Rights Reserved.

5.2 Extraction Tools

Extraction Tools

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The extraction tools are not available with the Evaluation license.
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The MARS® extraction tools provide sophisticated filter algorithms for reclassifying LiDAR points and/

or creating feature-bounding shapefile polygons. The tools consist of four (4) extraction functions which

can be used individually. To use these tools, go to the Export/Extract Tab . 

Area by Slope      Building Polygons      Canopy Density      Class Polygons

MARS® applies the data filtering algorithms to those LiDAR points (source classification) matching the

parameters of the tool function. LiDAR points meeting those criteria are reclassified to the specified

target classification. In addition, all tool functions have a set of one or more source classifications that

identify the pool of candidate points for each instance of use.  For all but the 'Canopy Density' tools,

shapefiles are produced including a *.prj (projection definition file) if the projection information is known

for the source LAS data.

PLEASE NOTE:   the default values that exist in all four extraction tools are based on projects in U.S.

feet.  For project data in meters, these values will need to be converted appropriately.

Optional comments may be added to the Comments box at the bottom of each extraction tool's

interface.  These comments will be saved if the extraction tool is added to a macro as part of a batch

script.  Note that the reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.

The user may also manually reclassify LAS  files to enhance the quality of the LiDAR dataset.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.2.1 Area by Slope

Area by Slope Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The extraction tools, including 'Area by Slope', are not available with the Evaluation

license.

The ‘Area by Slope’ extraction tool in MARS® is designed to analyze the slope of the ground in any

particular area.  This tool may be used to determine areas meeting specific slope criteria and output

polygons to a 3D shapefile.  Uses include well pad sites, landing zones, and other land base

applications that need to determine the most logical sites given user-specified criteria.

For details on adding this extraction tool to a macro within a batch script, see the 'Create/Edit Batch

Script' section in the Edit/Filter Tab  topic.

To use this extraction tool on loaded data, choose  from the 'Extraction Tool'

drop-down list on the Export/Extract Tab .  Click the 'Extraction Options'  button, which

will bring up the appropriate interface to enter the desired settings.

Requirements:

Ground class(es)

An output path and shapefile name (shapefile name is ignored when used in a macro script - in this
case, naming is determined by the 'Output' tab settings in the Batch Process Tiles  tool.)
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Filter Specific Parameters: 

Source Classifications: The source classification designated is the class which will be tested for

slope by this tool.  In most cases this is the ground class: Class 2.  If optionally re-classing points,

the source classification will be the class(es) of points to be reclassed to the Target Class.

Reclass Interior Points: Choose this option if the source points inside the resulting shapefile's

polygons should be reclassed.  When this option is chosen, the 'Target Class' becomes available. 

When used as part of a macro script with the Batch Process Tiles  tool, this option will create

new LAS files in the path specified for that tool.  The output shapefiles will be in the path specified

below (Path).

Target Class: This option is available only when the 'Reclass Interior Points' option is chosen.  The

'Target Class' option allows the user to specify what class the points chosen from the source

classification(s) should be reclassified to.

Step Size: The user may specify here how much data the extraction tool will work on at a time.

For example, a step size of 100 means that processing will occur in areas of 100 units x 100 units.

In general, the larger the step size the faster the filter will run, but more RAM is used for larger step

sizes.  The default step size suggested for most projects using this tool is 100.

Overlap (%) : The user may specify the percentage of overlap to be used between adjacent 'Step

Size' areas.  More overlap percentage allows for a more precise output from the filter but requires a

longer running time.

Path:  In this area the user can specify an output folder where the resulting shapefile(s) (*.shp) will

be stored.  This must be specified before the tool can be run.  If this tool is used multiple times

within a Batch Script , or in combination with the 'Building Polygons' and/or 'Class

Polygons' tools, be sure to use unique output folders for each instance to avoid overwriting

files!

Shapefile Name:  The user specifies the desired shapefile name here.  When this tool is used as

1209
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a step in a macro script that is called by the Batch Process Tiles  tool, the shapefile names will

match the LAS file naming convention that is set in the batch tool's 'Output' tab.  In that case, the

entry box can be left blank.

Add the result to project: If checked, adds the resulting shapefiles as reference shapefiles under

the 'Vectors' layer.  This option is ignored when the tool is used in a Batch Script .

Desired Slope: This user-defined value determines the target slope for the extraction tool.  For

example, when attempting to find flat areas of ground (a slope of 0), a 0 is entered here and the

resulting polygons will show areas with no slope.

Slope Deviation: This value is the amount of tolerance the user wants to allow in deviation from the

'Desired Slope'.  This value is entered in degrees.  For example, if the user is looking for an area

with a slope of 3 degrees or less a '0' would be entered in the 'Desired Slope' text box, and a '3'

would be entered in the 'Slope Deviation' text box.

Exclusion Classifications: Selecting a class(es) here will allow the user to exclude certain points

from being included in the polygons generated during extraction.  For example, the user may not

want to include areas of vegetation or buildings (typically Classes 3, 4, 5, and 6) within an open area

being analyzed.

Minimum Diameter: This value, chosen by the user, dictates the minimum diameter of an area to

be included in the extraction.

Comments: This area of the extraction tool allows the user to enter any desired comments.  Type

any text here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the extraction tool is added and saved to a filter macro script .  Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.

1209
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Figure 1: 'Area by Slope Options' interface

Once the user has defined all of the required parameters, an area can be specified for extraction by

using the ‘Extraction by Region'  button to click-drag a rectangular area-of-interest (AOI).

When the extraction has completed and the new *.shp file is written to the specified directory, it will be

loaded into the current MARS® project if the 'Add the result to project' box was checked.  If not, it can be
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loaded manually at a later time as a Reference Shapefile .

Figure 2: In this example, the Area by Slope tool demonstrates its capabilities to find areas of ground

meeting the user-defined parameters.  The user has specified 3 different sizes of open area to be found

in this example.  The blue areas have the smallest 'Minimum Diameter' defined by the user, and so are

the most numerous.  The red areas have intermediate values and represent less areas available then

the blue with the given limitations, but more areas available than the green.  The green areas represent

areas with the largest 'Minimum Diameter' values, and so are the least numerous. 

In this example all three areas were given the same specifications for slope - the only difference was the

specification for 'Minimum Diameter'.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.2.2 Building Polygons

Building Polygons Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The extraction tools, including 'Building Polygons', are not available with the Evaluation

license.

The 'Building Polygons' extraction tool in MARS® is designed to place polygons around a specified

class. The difference between the building polygons tool and the class polygons tool is that the building

tool takes into account the class and the elevation of the points, whereas the class polygon tool is only

concerned with the class of the points in the extraction. This tool may be used to determine areas

meeting specific criteria and output user-defined polygons to a 3D shapefile.

For details on adding this extraction tool to a macro within a batch script, see the 'Create/Edit Batch

Script' section in the Edit/Filter Tab  topic.

To use this extraction tool on loaded data, choose  from the 'Extraction Tool'

drop-down list on the Export/Extract Tab . Click the 'Extraction Options'  button, which

will bring up the appropriate interface to enter the desired settings.

Requirements:

Building class(es)
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Ground class(es)

An output path and shapefile name (shapefile name is ignored when used in a macro script - in this

case, naming is determined by the 'Output' tab settings in the Batch Process Tiles  tool.)

Filter Specific Parameters: 

Reclass interior points: Choose this option if the source points inside the resulting shapefile's

polygons should be reclassed. When this option is chosen, the 'Source Classifications' option

becomes available.  When used as part of a macro script with the Batch Process Tiles  tool, this

option will create new LAS files in the path specified for that tool.  The output shapefiles will be in

the path specified below (Path).

Source Classifications: The source classification is only needed if the 'Reclass interior points'

option is chosen. If re-classing points, the source classification will be the class(es) of points to be

reclassed to the Target Class.

Target Class: If the 'Reclass interior points' option is chosen, the 'Target Class' option allows the

user to specify what class the points chosen from the source classification should be reclassified

to. If the 'Reclass interior points' option is not chosen, the target class will be building class, or the

class which should be surrounded by the extraction polygons.

Step Size: The user may specify here how much data the extraction tool will work on at a time. For

example, a step size of 100 means that processing will occur in areas of 100 units x 100 units. In

general, the larger the step size the faster the filter will run, but more RAM is used for larger step

sizes. The default step size suggested for most projects using this tool is 100.

Overlap (%) : The user may specify the percentage of overlap to be used between adjacent 'Step

Size' areas. More overlap percentage allows for a more precise output from the filter but requires a

longer running time.

Path:  In this area the user can specify an output folder where the resulting shapefile(s) (*.shp) will

be stored. This must be specified before the tool can be run.  If this tool is used multiple times
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within a Batch Script , or in combination with the 'Area by Slope' and/or 'Class Polygons'

tools, be sure to use unique output folders for each instance to avoid overwriting files!

Shapefile Name:  The user specifies the desired shapefile name here.  When this tool is used as

a step in a macro script that is called by the Batch Process Tiles  tool, the shapefile names will

match the LAS file naming convention that is set in the batch tool's 'Output' tab.  In that case, the

entry box can be left blank.

Add the result to project: If checked, adds the resulting shapefiles as reference shapefiles under
the 'Vectors' layer.  This option is ignored when the tool is used in a Batch Script .

Max TIN Edge Length: The maximum length of a TIN edge to qualify as an input into the creation

of the grid used in the analysis.

Minimum Area:  This value, determined by the user, dictates the minimum area (minimum size of

a polygon) which may be included in the analysis. No area less than the value defined here will be

encircled with a polygon and included in the analysis.

Cell Size: This parameter sets the cell size of the grid created for feature extraction. This value is in

the same units as the LAS data (ex. English or Metric) with a default value of 1. The cell size should

be set to approximately what the GSD (ground sample distance) is.

Building Classes: The user should specify the building class in this text box. In most cases this

will be Class 6: Building.

Ground Classes: The user should specify the ground class in this text box. In most cases this will

be Class 2: Ground.

Square Boundary: This option will attempt to square the corners of the polygons created during

extraction. It is possible that some points within the polygons will not be classed as building and

some points outside the polygons will, since squaring causes a generalization of the polygon

shape. 

Single Gutter Polygon: Checking this option will provide one polygon around each building around

the top edges of the building. Unselecting this option will result in 2 polygons around each building:

one around the top edges of the building and one of the footprint of the building. See Figures 1 and
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2 below for further explanation.

Figure 1: The 'Single Gutter Polygon' option is chosen in this example (shapefile shown in yellow),

resulting in a single polygon around the top edges of each building.

Figure 2: The 'Single Gutter Polygon' option is NOT chosen in this example (shapefile shown in

red), resulting in two polygons being created for each building. The first polygon outlines the top

edges of the building and the second polygon outlines the footprint of the building. When
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uncheck ing the 'Single Gutter Polygon' option, it is important to make sure the correct ground

class has been entered into the analysis tool because the footprint polygon will be placed at the

elevation of the ground points.

Comments: This area of the extraction tool allows the user to enter any desired comments. Type

any text here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the extraction tool is added and saved to a filter macro script . Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.
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Figure 3: 'Building Polygons Options' interface

Once the user has defined all of the required parameters, an area can be specified for analysis by using

the ‘Extraction by Region'  button to click-drag a rectangular area-of-interest (AOI). When

the extraction has completed and the new *.shp file is written to the specified directory, it will be loaded

into the current MARS® project if the 'Add the result to project' box was checked.  If not, it can be loaded
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manually as a Reference Shapefile .

Figure 4: A properly created building polygon shapefile.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.2.3 Canopy Density

Canopy Density Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The extraction tools, including 'Canopy Density', are not available with the Evaluation

license.
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The ‘Canopy Density’ extraction tool in MARS® is designed to analyze canopy points above the ground

and provide a display of the density of a vertical column. This is done by counting the number of returns

within a user-defined voxel.  A voxel is a volume pixel (Figures 1 and 2 below), which means it is

literally a volume of area defined by the tool dialog’s ‘Horizontal Grid Cell Size’ squared, multiplied by

the ‘Interval Size’ value (X x Y x Z).  

Figure 1: A series of voxels in a random stack. A single voxel is highlighted.

 

10 

10 
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5 

  

Figure 2: Individual voxel.

For example, in the Canopy Density dialog (Figure 3 below), the voxel is defined as 10 units in the X,

10 units in the Y, and 5 units in the Z direction for a total volume of 500 cubic units. This tool counts the

number of returns within each voxel and writes the results to an ENVI (*.DAT) data file. The results can

be used to characterize canopy density and other meaningful quantitative vegetation metrics. The user

can also define the desired elevation values within the ‘Elevation Difference Requirement’ section of

the ‘Canopy Density‘ dialog, which allows them to specify elevation limit values for their analysis.



Data Classification (Manual & Batch) 1187

© 2000-2023 Merrick & Company

For details on adding this extraction tool to a macro within a batch script, see the 'Create/Edit Batch

Script' section in the Edit/Filter Tab  topic.

To use this extraction tool on loaded data, choose  from the 'Extraction Tool'

drop-down list on the Export/Extract Tab . Click the 'Extraction Options'  button, which

will bring up the appropriate interface to enter the desired settings.

Requirements:

Ground class(es)

Canopy class(es)

An output path and file name

Filter Specific Parameters: 

'Elevation Difference Requirement' Section: The user can enter settings here which would

restrict the extraction tool to certain vertical limits. Maximum and Minimum limits can be set

individually, or both limits can be used to define a particular volume between the two.

Horizontal Grid Cell Size: The horizontal grid cell size determines the horizontal dimension of the

voxels. As seen in Figure 2 (above), the Horizontal Grid Cell Size would be 10.

Create Vertical Intervals: The user can choose to 'Create Vertical Intervals' for the voxel by

checking this box. When this option is chosen, the 'Interval Size (Z)' becomes available for the user

to specify. The 'Interval Size (Z)' determines the vertical dimension of the voxels. As seen in Figure 2

(above), the Interval Size (Z) would be 5.

Fixed Number of Intervals: The user can also choose to use a 'Fixed Number of Intervals' which
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would limit the number of voxels to a particular height, also limiting the number of 'bands' available to

be viewed in the 'Hyperspectral Option' dialog of ENVI. For example, if the user were to specify a

'Fixed Number of Intervals' to be set at 5 and the 'Interval Size' was also set at 5, then the total area

in which the canopy density analysis would be run would be 25 units in height and offer 5 different

bands for viewing in the 'Hyperspectral Option' interface of ENVI. Each voxel layer offers one band to

be viewed.

Ground Classes: The user will specify here which points will be used as a reference in identifying

the canopy points. The ground class is usually Class 2: Ground, which represents the bare earth

points.

Canopy Classes: The point class(es) chosen here will be the points on which the extraction tool is

run. Typically, classes 3, 4, and 5 are all canopy classes (Low, Medium, and High Vegetation

respectively).

Use First Returns Only: The user should check this box if first returns are the only returns (for

canopy) to be used in the extraction. The Canopy Density tool will ignore points that are any other

return value.

ENVI Output File: In this area the user must define an output folder for the resulting ENVI (*.dat) file

to be stored in and give the new file a name. This must be specified before the tool can be run.

Average density by collection scans: This box is checked by default. Results from the Canopy

Density tool can be extremely skewed by the collection scan overlap regions since the data in

these regions are roughly twice the density of the non-overlapping areas. The 'Average density by

collection scans' option computes the density statistics per collection scan and then averages the

results in the overlap regions for the output of the final ENVI .dat file creation.

Reclass Options: These controls are currently disabled and setting them will have no affect on the

input LAS data or the output raster.

Comments: This area of the analysis tool allows the user to enter any desired comments. Type any

text here and that text will remain for the remainder of the MARS® session, and will be stored
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permanently if the extraction tool is added and saved to a filter macro script . Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.

Figure 3: 'Canopy Density Analysis Options' interface

Once the user has defined all of the required parameters, an area can be specified for analysis by using
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the ‘Extraction by Region'  button to click-drag a rectangular area-of-interest (AOI). The

'Extraction by Polygon' and 'Extraction from Selected Polygons' options may also be used, but only one

polygon can be selected for the latter option. When the extraction has completed and the new ENVI file

is written to the specified directory, it can be loaded into the current MARS® project as a Raster .

This raster type can also be viewed in ENVI or ArcGIS software.

To view the properties of the ENVI raster, right-click the file in the Table of Contents and choose 

'Properties' to display the ‘Hyperspectral Option’ dialog (Figure 4).

Figure 4: The 'Hyperspectral Option' interface.

The following image (Figure 5) shows the ENVI rendered by the ‘Rainbow’ palette, where the ‘hotter’

colors indicate more returns than the ‘cooler’ colors. In fact, each square represents the voxel element

(in 2D) with the number of returns embedded as an integer value.
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Figure 5: 'Ground' level band results in Rainbow.

Using the ‘Band to Display’ drop-down list, the user can select the specific voxel band to display. In

the following example (Figures 6a and 6b), the user has selected ‘Zone 4’, which corresponds to the

voxels that are between 15.00 – 19.99 units above the ground surface.

Figure 6a: MARS® Hyperspectral Options dialog – Zone 4 band display.
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Figure 6b: 'Zone 4' level band results.

The user may also change the ENVI file rendering to ‘Grayscale’ (Figure 7) or ‘Spectrum’ (Figure 8).
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Figure 7: 'Ground' level band results in Grayscale.

Figure 8: 'Ground' level band results in Spectrum.

© 2000-2023 Merrick & Company. All Rights Reserved.

5.2.4 Class Polygons

Class Polygons Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  The extraction tools, including 'Class Polygons', are not available with the Evaluation

license.

The ‘Class Polygons' extraction tool in MARS® is designed to place polygons around any specific class
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in any particular area. The difference between the building polygons tool and the class polygons tool is

that the building tool takes into account the class and the elevation of the points, whereas the class

polygon tool is only concerned with the class of the points in the extraction. This tool may be used to

determine areas meeting specific class criteria and output polygons to a 3D shapefile. Uses include

placing polygons around tree canopies, determining low confidence areas, and even using return value to

eliminate edge matching requirements in ortho procedures.

For details on adding this extraction tool to a macro within a batch script, see the 'Create/Edit Batch

Script' section in the Edit/Filter Tab  topic.

To use this extraction tool on loaded data, choose  from the 'Extraction Tool'

drop-down list on the Export/Extract Tab . Click the 'Extraction Options'  button, which

will bring up the appropriate interface to enter the desired settings.

Requirements:

Source class(es)

An output path and shapefile name (shapefile name is ignored when used in a macro script - in this
case, naming is determined by the 'Output' tab settings in the Batch Process Tiles  tool.)

Filter Specific Parameters: 

Source Classifications: The source classifications designated are the classes which will be

targeted for extraction by this tool. In most cases this is a canopy, or vegetation, class - usually

Class 3: Low Vegetation, Class 4: Medium Vegetation, and/or Class 5: High Vegetation are used.

Step Size: The user may specify here how much data the extraction tool will work on at a time. For
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example, a step size of 100 means that processing will occur in areas of 100 units x 100 units. In

general, the larger the step size the faster the filter will run, but more RAM is used for larger step

sizes. The default step size suggested for most projects using this tool is 100.

Overlap (%) : The user may specify the percentage of overlap to be used between adjacent 'Step

Size' areas. More overlap percentage allows for a more precise output from the filter but requires a

longer running time.

Path:  In this area the user can specify an output folder where the resulting shapefile(s) (*.shp) will

be stored. This must be specified before the tool can be run.  If this tool is used multiple times

within a Batch Script , or in combination with the 'Area by Slope' and/or 'Building

Polygons' tools, be sure to use unique output folders for each instance to avoid overwriting

files!

Shapefile Name:  The user specifies the desired shapefile name here.  When this tool is used as

a step in a macro script that is called by the Batch Process Tiles  tool, the shapefile names will

match the LAS file naming convention that is set in the batch tool's 'Output' tab.  In that case, the

entry box can be left blank.

Add the result to project: If checked, adds the resulting shapefiles as reference shapefiles under
the 'Vectors' layer.  This option is ignored when the tool is used in a Batch Script .

Maximum TIN Edge Length: The maximum length of a TIN edge to qualify as an input into the

creation of the grid used in the extraction.

Minimum Area:  This value dictates the minimum area (minimum size of a polygon) which will be

included in the extraction. No area less than the value specified here will be encircled with a polygon

and included in the extraction.

Cell Size: This parameter sets the cell size of the grid created for feature extraction. This value is in

the same units as the LAS data (ex. English or Metric) with a default value of 1. The cell size should

be set to approximately equal the GSD (ground sample distance).

Exclusion Classifications: Selecting a class(es) here will allow the user to exclude certain points

from being included in the polygons generated during extraction. For example, the user may not

1209
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want to include the area of a building (typically Class 6) within a stand of trees.

Comments: This area of the extraction tool allows the user to enter any desired comments. Type

any text here and that text will remain for the remainder of the MARS® session, and will be stored

permanently if the extraction tool is added and saved to a filter macro script . Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Comments box.

  

Figure 1: 'Class Polygons Options' interface

Once the user has defined all of the required parameters, an area can be specified for extraction by

1209
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using the ‘Extraction by Region'  button to click-drag a rectangular area-of-interest (AOI).

When the extraction has completed and the new *.shp file is written to the specified directory, it will be

loaded into the current MARS® project if the 'Add the result to project' box was checked.  If not, it can be

loaded manually as a Reference Shapefile .

Figure 2: The Class Polygons tool is being used in the example above to create polygons around low

confidence areas. The polygons display the areas of a project in which the ground is

obscured and LiDAR penetration is low.

© 2000-2023 Merrick & Company. All Rights Reserved.
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5.3 Quick Classifications

Quick Classifications

Merrick Advanced Remote Sensing (MARS
®

) Software

Quick Classifications:  This filtering method - written, distributed, and licensed by rapidlasso GmbH

- uses algorithms and routines that are part of the LAStools software suite to classify ground and,

optionally, high vegetation and buildings.  This tool is found on the Edit/Filter Tab .  Its use requires

that at least part of the LAStools suite ('lasground_new.exe' and 'lasground_new64.exe' at a minimum)

be present on the local computer or in an accessible network location that can be pathed out.  The

minimum required version of LAStools for use in MARS® will contain a 'CHANGES.txt' file dated

November 8, 2018, or later.  The LAStools suite can be downloaded at no charge, but licensing is

required to use the classification routines in a commercial, government, or production environment.  

Unlicensed use in any setting may cause data corruption!  As taken from the rapidlasso GmbH

website, "Note that the output of the unlicensed version can be slightly distorted after certain point

limits are exceeded."  Please contact rapidlasso GmbH by e-mail directly at info@rapidlasso.com for

general information including questions about licensing and allowable use, or see the rapidlasso

GmbH website for details.  For pricing information, go to http://rapidlasso.com/pricing.  Licenses are

available for the entire LAStools suite, or the components needed for the 'Quick Classifications' tool

can be licensed separately at a reduced cost.  All licensing, pricing, and payment is handled directly

between the end user and rapidlasso GmbH - Merrick & Company has no involvement at this level.

Note that a license purchased for the 'Quick Classifications' tool will authorize the Ground Filter

tool as well.

If the vegetation and building filtering option will be used:

Either two or four additional executable files (*.exe) - depending on the license status - from the 
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LAStools suite must be in the path entered as in the example shown in the first graphic following the '

License Status' table.  Both 'lasclassify.exe' and 'lasclassify64.exe' are needed with or without a

license, while 'lasheight.exe' and 'lasheight64.exe' are additionally required when no license is present.

 Remember that unlicensed use is limited (by rapidlasso GmbH) to testing and/or evaluation only.

License Status:

Licensed Unlicensed

lasground_new.exe and lasground_new64.exe files
needed:

lasclassify.exe and lasclassify64.exe files needed: 1 1

lasheight.exe and lasheight64.exe files needed: N/A 1

   1 - required only

if the vegetation and building filtering option is used.

As implemented in MARS®, 'Quick Classifications' is used to produce tiled, classified LAS files based

on an existing tile layout shapefile.  The tool takes unclassified or partially classified data as the input

and creates  tiled files with ground points and unclassified points, with an option to also classify

buildings and high vegetation once ground is known.  The input data will not be altered with this tool.

The LAS data to be re-classified must be loaded along with a polygonal tile shapefile that has the

same coordinate reference system definition.  Once these are loaded, click the 'Quick Classifications'

button  to get started.  A window will appear where both the data units and the

path to the LAStools executable files and the license file (if purchased) must be set.  The LAStools

software suite can be downloaded from a link on this interface.  The minimum required version of 

LAStools for use in MARS® contains a 'CHANGES.txt' file dated November 8, 2018, or later.
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The data units must be set each time the tool is used - a correct entry is critical to the operation and

results of the classification routines.  The path to the LAStools files will be stored for future use, but

can be updated if the location of the files is ever changed.  If the units are not selected, or the path

entered to the LAStools folder does not exist, or the path entered does not contain the minimum

required LAStools files, the following messages will appear when the 'OK' button is clicked:

                    

When the data units are entered and a valid LAStools path exists, click 'OK' to bring up the main
'Quick Classifications' interface.  The interface consists of four tabs:
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Filter Settings tab:  The Source and Target classes are selected here.  By default, all 256 classes

are included in the 'Source Classifications', but this can be changed by clicking the 'Select'

button.  Likewise, defaults are set for the 'Target Ground Class' as well as the optional 'Target

Vegetation Class' and 'Target Building Class'.  These are based on the ASPRS standard

classes for these features, but they can be modified by clicking the appropriate 'Select' button

(s).  For info regarding the 'Ground Filter Options' and 'Vegetation and Building Filter Options'

tabs, see below.

Output tab:

Field for Tile Name: Select an attribute field with unique values for the output tile naming.

Suffix: Optionally, specify a suffix to be appended to the tile name for the output files.



Data Classification (Manual & Batch) 1205

© 2000-2023 Merrick & Company

        NOTE:  The naming convention selected will be applied to all output LAS files.  

Output Directory: Browse to select an output folder where the final processed tiled LAS files

will be stored.

Save to Local Option: When the 'Output Directory' is a network location, temporary local disk

space can be used to speed up processing.  Select this option by checking the box and then

specify a temporary local folder with sufficient free space.  The 'Temporary Folder' specified 

WILL NOT be the final output folder, but rather is a local directory which can be used to speed

up the processing.  The output data will be moved to the 'Output Directory' when all processing

is complete.  NOTE:  Most versions of Windows prohibit an application's output of files

to the root directory of drives.  It is strongly recommended that a sub-folder be used for

this option.

Tiles tab:

Tiles Selection: The 'Use selected tiles' check box is checked on by default. Keep this box

checked if the tiles which are to be processed have been selected in the tile layout.  If the user

would like to run 'Quick Classifications' on other (specified) tiles, enter those tile names (using

the 'Field for Tile Name' attribute) into the 'Tile Names' text box separated by commas.

Options tab:

Tile Edge Buffer: The default value, as recommended by rapidlasso GmbH, is '30' when the

data units have been set to 'Meters'.  When 'US Survey Feet or International Feet' is set, the

value is automatically converted to 98.424 units.  In either case, this value can be modified. 

This buffer will be added during processing to improve the results, and cut back to the original

tile boundary when processing is finished.

Existing Files: The 'Skip' radio button can used as a safeguard if for some reason processing

is stopped (e.g., power failure, computer shuts down, an error occurs, etc.).  When the user

starts processing again, checking this button will cause the software to skip any tiles which

already exist in the specified output folder.  Tiles which have already been processed will not
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be run again and the software will process only those tiles which are not found in the output

folder.  (For this reason it is suggested that if processing stops for any reason, the user should

go into the output folder and delete the last tile that was processed based on the timestamp. 

This tile may not be complete, but since the tile name exists in the output folder it would

otherwise be skipped.)  The 'Overwrite' radio button will cause the software to start processing

from the beginning and silently overwrite all the files in the output folder.

Upon completion, unload input data and load output data: This option is self-explanatory.

General interface options:

'Multi-Threading' section: To help speed up processing, multi-threading is available for this

tool.  Enter any number of threads from 2 to the maximum number available in the text box.  If

‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed)

per thread.

The 'Filter Settings' tab is further divided into 'Source/Target Classes' (see description and upper-left

graphic, above), 'Ground Filter Options', and 'Vegetation and Building Filter Options'.  By default, the

'Perform vegetation and building filter classification processing' box is checked on the ''Vegetation and

Building Filter Options' tab.  To use this option, 'lasclassify.exe' (as described near the top of this

topic) must exist in the specified LAStools path.  The latter two interfaces (shown below) have 'Help'

links in the upper-left corners that go directly to the LAStools read-me files for 'lasground' and

'lasclassify', respectively.  The parameters on these tabs are explained in those read-me files, which

are updated and maintained solely by rapidlasso GmbH.  The 'lasground' read-me file is based on an

earlier (but very similar) iteration of the ground classification executable.  As of the release date of this

version of MARS®, LAStools was not yet hosting a read-me file for the 'lasground_new.exe'

executable that is used in this batch filter tool.  However, it is available in the downloaded LAStools

suite package as 'lasground_new_README.txt'.  All the controls and entries on this tab feed directly
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into the arguments of the LAStools 'lasground_new.exe' file.  All the controls and entries within the

red boxes (see below) feed directly into the arguments of the LAStools executables.  When all

settings have been made, click the 'Run' button in the lower-right corner of the interface.
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If a license for LAStools has not been purchased or is not present in the path to the executable files,

the following warning message will appear immediately after clicking 'Run':
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See the notes in the first two paragraphs of this topic regarding unlicensed use.

The following message will appear when the 'Quick Classifications' routine is finished:

© 2000-2023 Merrick & Company. All Rights Reserved.

5.4 Batch Filter/Extraction Processing

Batch Script Processing

Merrick Advanced Remote Sensing (MARS
®

) Software

Multiple filter/extraction algorithms can be aggregated into a macro (or macros) within a batch script. 

Each macro is a collection of filters and/or extraction tools within an XML file that will be run in

sequence over the selected tiles of the project.  There is no limit to the number of macros or filters/

extraction tools within a macro that can be included within a batch script XML file. 

Utilizing this batch processing technique allows the user to filter and/or extract from very large LAS

datasets more quickly by dividing the work among multiple threads and outputting tiles of the filtered

data.  The output of the 'Create/Edit Batch Script'  function is an XML file which is used by the

'Batch Process Tiles' tool to control the filtering/extracting steps.  Within each batch script, the user

must define the macro name(s) and the required parameters for each filter/extraction tool algorithm

268
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within a macro.

 To use batch processing, please follow these steps:

1.) Start by loading the LiDAR data to be processed and a tile layout shapefile.  Batch processing

must have a tile shapefile loaded so that the desired tiles can be chosen for processing.  To

load a tile shapefile, go to the 'Project/Data Preparation ' tab and click 'Add Tile Shapefile '.

Browse to the required shapefile and select 'Open'.

2.) Once a tile shapefile is loaded, go to the 'Edit/Filter ' tab and use the 'Pick Tiles' tool to select

the tiles which will have the batch script run on them.  (To learn more about how to select tiles,

see the Pick Tiles  utility.)

3.) Next, select the 'Batch Process Tiles'  button on the same tab.

4.) The 'Batch Process Tiles' dialog box will appear.  Select and specify the parameters (see below)

on each of the individual tabs and at the bottom of the interface.

162
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Output tab:

Field for Tile Name: Select an attribute field with unique values for the output tile naming.

Prefix and/or Suffix: Optionally, specify a prefix and/or suffix to be appended to the tile name

for the output files.

        NOTE:  The naming convention selected will be applied to all output LAS files as well as

any shapefiles that are created when the 'Area by Slope', 'Building Polygons', and/or 'Class

Polygons' extraction tools are used in a script.  

Output Directory: Browse to select an output folder where the final processed tiled LAS files
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will be stored. 

        NOTES:

1. When a macro script contains only the extraction tool 'Class Polygons', no tiled LAS

files will be produced in this folder as the tool produces only shapefiles that will be

stored in the path specified on the 'Class Polygons' options interface.

2. When a macro script contains only the extraction tools 'Area by Slope' and/or

'Building Polygons', no tiled LAS files will be produced in this folder unless the

'Reclass Interior Points' option is used on the tool's options interface.

3. Any shapefiles that are created when the 'Area by Slope', 'Building Polygons', and/or

'Class Polygons' extraction tools are used in a script will be written to the folders

specified on those tools' options interfaces, not the 'Output Directory' where the tiled

and filtered LAS files will be stored.  Always use unique output folders for each

instance of these extraction tools within a script to avoid overwriting files!

'Save to Local Option' section: When the 'Output Directory' is a network location, temporary

local disk space can be used to speed up processing.  Select this option by checking the box

and then specify a temporary local folder with sufficient free space.  The 'Temporary Folder'

specified WILL NOT be the output folder, but rather is a local directory which can be used to

speed up the batch processing.  The final output data will be moved to the 'Output Directory'

when all processing is complete.  NOTE:  Most versions of Windows prohibit an

application's output of files to the root directory of drives.  It is strongly recommended

that a sub-folder be used for this option.

'LAS Options' section: Choose between three 'Point Data Record Format' choices - 6, 7, or

8.  Data will be output in the same GPS time format as the input data unless the input data is

in mixed format (GPS Week Time and Adjusted GPS Time).  In this case, a pop-up message

will offer two options:  1) continuing with the process, in which case the output data will all be

in GPS Week Time or, 2) canceling so that the GPS Week Time data can first be converted to
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Adjusted GPS Time using the 'GPS Time Conversion ' tool on the Tools  tab.

Tiles tab:

'Tiles Selection' section: The 'Use selected tiles' check box is checked on by default. Keep

this box checked if tiles which are to be processed have been selected in the tile layout.  If the

user would like to run the script on other (specified) tiles, enter those tile names (using the

'Field for Tile Name' attribute) into the 'Tile Names' text box separated by commas.

Script/Filters tab:

'Script / Filters' section: Choose a custom batch script or use a discrete built-in filter.  If the

user checks the 'Use Batch Script' box then the 'Batch Script full path' and the 'Macro Name'

will need to be defined.  Choose this box only if there is an XML file already created and ready

to use.  (In many cases this will be the XML containing a macro used to test data for filtering

with the debug tools on the Edit/Filter Tab ).  To browse to a script which has already been

created, use the '...' (ellipsis) button to the right of the 'Batch Script full path' text box and

navigate to the XML file.  Once this path has been defined, the user can choose the 'Macro

Name' (if the script contains more than one macro) to be used from the drop-down box which

will be populated when the 'Batch Script full path' is defined.  If there is no script XML already

created, the 'Use Batch Script' box must be unchecked.  When this box is unchecked, the

'Built-in Filter' option becomes available.  Choose a built-in method for filtering from the drop-

down list.

Options tab:

Tile Edge Buffer: The user may choose to add a buffer to each tile as it is processed.  The

buffer (in project units) will be added during processing and cut back to the original tile

boundary when processing is finished.  A larger buffer will more accurately process the data

around the edges of the tiles, but will take longer to run.  A typical default buffer size is 50 -

100 units.

'Existing Files' section: The 'Skip' radio button can used as a safeguard if for some reason

572 390
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processing is stopped (e.g., power failure, computer shuts down, an error occurs, etc.).  When

the user starts processing again, checking this button will cause the software to skip any tiles

which already exist in the specified output folder.  Tiles which have already been processed

will not be run again and the software will process only those tiles which are not found in the

output folder.  (For this reason it is suggested that if processing stops for any reason, the user

should go into the output folder and delete the last tile that was processed based on the

timestamp.  This tile may not be complete, but since the tile name exists in the output folder it

would otherwise be skipped.)  The 'Overwrite' radio button will cause the software to start

processing from the beginning and silently overwrite all the files in the output folder.

General interface options:

'Multi-Threading' section: To help speed up batch processing, multi-threading is available for

this tool, but only when running a batch script (XML) - single thread processing is used when

an individual filter has been chosen.  Enter any number of threads from 2 to the maximum

number available in the text box.  If ‘1’ is entered in the text box, it is equivalent to single-

threading the process.  For best performance, there should be a minimum of eight (8) GB of

RAM available (not just installed) per thread.

5.) When all the parameters have been set, click the 'Run' button to start processing.  The progress

bar will not become active until the first tile has been completed.  This is because the software

will estimate the total amount of time for processing based on the time per tile.  The elapsed

time and estimated time remaining for processing will also be shown below the progress bar.
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6.) When processing is complete, a log file will be created in the same folder that was specified for the

output tiles.  This output log stores the details of the batch process such as the total elapsed

time, the list of tiles handled by each thread (threads will be shown as 'Process 0' through

'Process <n>'), the time it took to run each tile, the filters/extraction tools run on each tile, and

how long it took each filter/extraction tool to run on each tile.  See below for an example of an

output log:

=============== Pr ocess 7 ================

Ti l e Li s t :  9, 16

St ar t ed at :  3: 24: 44 PM Wednesday,  December  11,  2013

Pr ocess i ng t i l e:  9 

Readi ng XML compl et e wi t h t ot al  f unct or s  of  8.

Ti l e# 1/ 2 Fi l t er # 1/ 8 Rec l ass i f yFi l t er :  0 s

Ti l e# 1/ 2 Fi l t er # 2/ 8 Ret ur nFi l t er :  0 s

Ti l e# 1/ 2 Fi l t er # 3/ 8 Mi nGr i dFi l t er :  0 s

Ti l e# 1/ 2 Fi l t er # 4/ 8 Hei ght Fr omSur f aceFi l t er :  0 s

Ti l e# 1/ 2 Fi l t er # 5/ 8 Rec l ass i f yFi l t er :  0 s

Ti l e# 1/ 2 Fi l t er # 6/ 8 Per col at eFi l t er :  6 s

Ti l e# 1/ 2 Fi l t er # 7/ 8 Per col at eFi l t er :  6 s

Ti l e# 1/ 2 Fi l t er # 8/ 8 Rec l ass i f yFi l t er :  0 s

Tot al  El apsed t i me f or  t he t i l e:  15 s

Pr ocess i ng t i l e:  16 

Readi ng XML compl et e wi t h t ot al  f unct or s  of  8.

Ti l e# 2/ 2 Fi l t er # 1/ 8 Rec l ass i f yFi l t er :  0 s

Ti l e# 2/ 2 Fi l t er # 2/ 8 Ret ur nFi l t er :  0 s

Ti l e# 2/ 2 Fi l t er # 3/ 8 Mi nGr i dFi l t er :  0 s

Ti l e# 2/ 2 Fi l t er # 4/ 8 Hei ght Fr omSur f aceFi l t er :  1 s

Ti l e# 2/ 2 Fi l t er # 5/ 8 Rec l ass i f yFi l t er :  0 s

Ti l e# 2/ 2 Fi l t er # 6/ 8 Per col at eFi l t er :  10 s

Ti l e# 2/ 2 Fi l t er # 7/ 8 Per col at eFi l t er :  8 s

Ti l e# 2/ 2 Fi l t er # 8/ 8 Rec l ass i f yFi l t er :  0 s
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Tot al  El apsed t i me f or  t he t i l e:  20 s

Ended at :  3: 25: 21 PM Wednesday,  December  11,  2013

Tot al  El apsed t i me:  36 s

================================================

St ar t ed at :  3: 24: 44 PM Wednesday,  December  11,  2013

Ended at :  3: 25: 36 PM Wednesday,  December  11,  2013

Tot al  El apsed t i me:  51 s

© 2000-2023 Merrick & Company. All Rights Reserved.

6 Quality Control

Quality Control

Merrick Advanced Remote Sensing (MARS
®

) Software

Quality Control (QC) Tools

QA/QC Methodologies

The MARS® software suite can be used extensively to analyze and monitor data collection activities and

client data deliveries.  The following quality control methodologies represent only a portion of the overall

quality control procedures available with MARS®, but these tools do provide a quick and accurate

assessment of potential data quality issues.  The following is a list of the most frequently used QA/QC

procedures:
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Check Point Report

Color By Collection Scan Separation Analysis

Color By Z Delta Analysis

Contour By Collection Scan Analysis

Cross-Section/Profile Analysis

Swipe Raster Over LiDAR Tool

Coverage Tracking Tools

Swath shapes to overlap JP2

QC Module (on the QA/QC Tab ):

USGS 2022 rev. A QC Module

USGS 2021 rev. A QC Module

USGS 2020 rev. A QC Module                

USGS 2.1 QC Module

USGS 1.3 QC Module

1221

1555

1568

1570

1575

1581

1582

1582

457

1269

1302

1336

1370

1404
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USGS 1.2 QC Module

USGS 1.0 QC Module

LiDAR Workflow QC   (LiDAR Data Checks and LiDAR Calibration Checks)

Voronoi Density Reporting

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1 Check Point Report

Check Point Report

Merrick Advanced Remote Sensing (MARS
®

) Software

Overview

Part I - TIN/Grid Elevation Calculation Method

A typical LiDAR project (one that includes collection of ground features) can be checked for vertical

accuracy in MARS® using the methods and standards described in the ASPRS Positional Accuracy

Standards for Digital Geospatial Data, (EDITION 1, VERSION 1.0), published in November 2014.

For LiDAR data that has been corrected for systematic errors, the project’s derived ground surface can

be validated against the ground check points via the Check Point Report utility within MARS®.  This

tool verifies the accuracy requirements for the LiDAR data and serves as a critical tie between project

control and coordinate systems.  MARS® allows the user to specify the desired Quality Level/Vertical

Accuracy Class for the statistical analysis of the check points.  The report compares the accuracy of

the remotely collected data with the known points on the ground, which can help uncover data integrity

issues within the dataset.

1436

1465

1493

1534

http://www.asprs.org/a/society/committees/standards/Positional_Accuracy_Standards.pdf
http://www.asprs.org/a/society/committees/standards/Positional_Accuracy_Standards.pdf


MARS® v2023.1           User Manual1222

© 2000-2023 Merrick & Company

Check points must be stored either in a *.CSV file or a 3D point shapefile (created in MARS®), and

have the following formats: 

1.  A CSV-format file consisting of ID,  X,  Y,  Z,  Desc (optional),  N_V  (optional),  and Collection Date

(optional) with seven (7) columns in the following order:

ID  -  unique  identifier  for  each  individual  check  point.   Any  10-character

(maximum) name can be used for this field.

X,  Y,  Z  -  check  point  easting,  northing,  and  elevation.   Any  10-character

(maximum) unique names can be used for these fields.

Desc  -  optional  description  of  check  point  (often  location  related,  such  as

park ing lot or intersection).   Any 10-character (maximum) name can be used

for this field.  This column (with a name in the first  row) must  be present  even

if no  descriptions  are  used.   If  used,  not  every  row (point  record)  in  the  file

needs a value for this field.

N_V  -  optional  NVA  (Non-Vegetated  Vertical  Accuracy)  or  VVA  (Vegetated

Vertical  Accuracy)  type  of  the  check  point.   Any  10-character  (maximum)

name can be used for this  field.   This  column  (with  a  name  in  the  first  row)

must  be  present  even  if  no  types  are  used.   If  used,  not  every  row  (point

record)  in  the  file  needs  a  value  for  this  field.   Any  value  that  is  not  stored

exactly as VVA (not case specific) or is empty will be interpreted as NVA.

Collection Date - the date that  each check point  was surveyed.   This  column

(with a name in the first  row) must  be present  even if no dates  are populated.

 If used, not every row (point record) in the file needs a value for this  field.   The

date format  must  be either MM/DD/YYYY or YYYY-MM-DD to be interpreted

correctly.
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The first  row of the file must  contain column headers  (labels) and not  actual check point  values.   As

mentioned above, the headers do not have to be named as shown in the examples, but must be in that

order.   All  columns must  be present  and labeled in the first  row,  although  records  for  the  fifth,  sixth,

and seventh columns are not required to be populated.

2.  A 3D point shapefile with the following structure:

If  a  shapefile  is  used,  it  must  be  created  in  MARS®  using  the  'Convert  Check  Points  CSV  to  3D

Shapefile' tool on the Vector Creation Tab .

ID - unique identifier for each individual check point

X - check point Easting

Y - check point Northing

Z - check point Elevation

Desc - optional description of check point  (often location related).   Not  every

row (point record) in the file needs a value for this attribute.

Type -  optional  NVA  (Non-Vegetated  Vertical  Accuracy)  or  VVA  (Vegetated

Vertical Accuracy) status  of the check point.   Not  every  row (point  record) in

the file needs a value for this attribute.  Any value that is not stored exactly  as

362
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VVA (not case specific) or is empty will be interpreted as NVA.

Coll_date - optional survey date of check point.  Not every row (point record) in

the file needs a value for this attribute.

Comments - optional field for additional comments of any kind

Include - Boolean checkbox whose status determines whether or not  the point

will be included in calculations and reporting

To generate a check point report, the project LAS data and corresponding check points file must first

be loaded.  For best results, it is recommended that classified data be used, with ground points in a

discrete class.  

For fastest processing, use a computer that has a discrete, high-end graphics card when the LAS

dataset to be loaded is several hundred GBs or more in size.  For this tool, rendering power is more

important than CPU speed, the number of processor threads, or the amount of installed RAM.  Load

the LAS data - when complete, uncheck the 'LAS' layer in the Table of Contents but be sure to leave

the boxes checked on for all individual LAS file entries in the layer.  With the LAS data display now

turned off, load the check points file.  Now continue with the steps listed below .

The number of significant figures which will appear in the Check Point Report can be controlled by the

user.  To modify this number, go to the Options Tab  and click the 'Miscellaneous' button.  In the

interface that appears (below), see the 'Check Point Report Options' section.

Note that points flagged as 'Withheld', regardless of classification, will not be used in this tool.

1225
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To run the Check Point Report utility, follow these steps:

1. After loading the project LAS data and the check points file, click the ‘Check Point Report’ button

 on the QA/QC Tab .  Each time a check point report is created, the user can select

which point classification(s) to include in the report calculations, what method of elevation calculation

should be used, and what the vertical unit of the project data is.  By default, Ground (Class 2) is

checked on, however the user can make other selections depending on the data.  When Class 2

(Ground) is included, the status of the Model Key-point bit flag, if present, is ignored.  In other words,

all Class 2 ground points will be included, whether or not they have the Model Key-point bit flag set.

Next, ensure that the 'Elevation Calculation Method' is set to 'TIN/Grid'.  This is the most common

method (and the default) and is used for analysis of a ground surface.  (For the infrequently-used

457
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'Closest Point' method, see the Check Point Report: Closest Point Calculation Method  help topic.) 

Finally, choose the 'Vertical Unit for Loaded Points' from the drop-down list.  Note that this option

has no default to ensure that the correct units are always chosen.  Click 'OK' when finished.

         

1260
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2. The ‘Check Point Report’ interface will appear (below).  For the 'TIN/Grid' method, the results of the

default TIN method analysis will be presented based on the default QL1/QL2 10.0-cm Vertical

Accuracy Class.  The TIN method is the most accurate way to compare a LiDAR ground surface to the

check points.  The interface contains project accuracy statistics in the ‘Statistics for NVA Points of

Project’ section, a comparison of those statistics to the chosen accuracy class in the 'Standards'

section, and the 'Statistics per Check Point’ info in the table at the bottom of the window.  Note that
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project data in U.S. Survey Feet or International Feet are internally converted to metric values for

comparison to the Requirement table and Standards section.

3. Make any necessary changes: Many parameters can be changed from their default or original

settings including the Quality Level/Vertical Accuracy Class to be tested against, the specific TIN or

Grid method when the 'TIN/Grid' Elevation Calculation Method was chosen during the initial options

selection, the Search Radius for finding lidar points around each check point, the 'Classifications

Included' (representing ground), and the exclusion of one or more check points (see Step 4).
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When the Grid method is selected, additional parameters will appear for 'Grid Cell Size' and 'Gaussian

Smoothing Count', as shown below.

See the Inputs Section  topic for details on the Search Radius setting.

4. Turn Off Selected Pt / Turn On Selected Pt: When a 3D point shapefile is used as the check

points input, the status of the 'Include' field checkbox determines whether or not a particular point is

used in calculations and reporting.  Points that are unchecked in the shapefile when the report is run

will remain unchecked in the results table.  Individual points can also be manually checked (included in

the analysis) or unchecked (excluded) in the table at the bottom of the check point report simply by

clicking the corresponding check box.  In addition, multiple points can be selected using standard

Windows controls and then turned on/off.  Clicking in the blank space to the left of a row will select that

row.  Clicking and dragging the cursor through the blank spaces of multiple adjacent rows will select all

rows within the drag area.  Likewise, clicking a row, holding down the 'Shift' key, and clicking another

row higher or lower in the table will select all rows between, inclusive.  Clicking the blank areas for

individual rows while holding down the 'Ctrl' key will select only those rows, and 

1244
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5. Recalculate: If any of the items listed in Steps 3 and 4 have been changed, click the ‘Recalculate’

button to process the check points with the new parameters.  Switching the specific 'Elevation

Calculation Method' from 'TIN' to 'Grid' (or back) will cause the 'Recalculate' button to change from

black to blue font as a reminder.

6. Hide: This option allows the user to hide the check point report without actually closing it.  Closing

the report would require it to regenerate the information provided if it were needed to be viewed again. 

To bring the hidden check point report back up, click the 'Check Point Report' button on the QA/QC

Tab  again.  The report window is redisplayed immediately with the values previously generated.

7. Close: To completely close (rather than hide) the check point report, click on the 'Close' button.  To

view the report again, it will need to be regenerated by clicking the ‘Check Point Report’ button on

the QA/QC Tab  to start the process over.

8. Save Report... : To save the check point report to a comma-separated value (CSV) file and a

separate PDF file, click on the ‘Save Report...’ button, navigate to the desired folder, enter a filename,

and click the ‘Save’ button.  If the LiDAR data is being displayed, it will switch to Intensity rendering

for a screen capture that is made for the PDF version of the report.  A 2D point shapefile of the check

points that are turned on (included) in the report will also be saved in the output folder.

9. Redraw Thematically: Use this button to show 'Z Error' values per check point thematically.  All

other data besides the check points can be turned off in the Table of Contents to more easily view this

display.  Red squares represent negative error (surrounding LiDAR surface lower than check point) and

green squares represent positive error (surrounding LiDAR surface higher than check point).  The

magnitude of the error is shown by the relative size of the square - the larger the square, the larger the

'Z Error'.  To return to the previous display, click the button in the same location, which will now be

457
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labeled 'Redraw Normal'.
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10. Histogram: This button presents a histogram of the 'Z Error' for the NVA points with the amount of

error on the X-axis and the number of occurrences within specified error ranges on the Y-axis.  If there

are VVA points in the loaded check points CSV file, a 'VVA' button will be available at the bottom to

switch to a separate histogram for those points.  The Histogram window also contains a button labeled

'Redraw Thematically', but it functions differently in this location than the button described in item 9,

above.  In this case, clicking it will apply a color ramp to the default-yellow bars in the histogram, better

differentiating the amounts of Z-error.  The color ramp uses up to 24 discrete shades, ranging from red

for the largest amount of negative Z-error, to green for near-zero Z-error, to magenta for the largest

amount of positive Z-error.  In the LAS Map View window (main MARS® view), the check points that fall

within each of the Histogram error ranges (bars) will be displayed in the same color as the bars

themselves.  Clicking the 'Back' button on either histogram display will return to the interactive report

window.

11. Data Sorting: Click any of the column headings (e.g., Z Error) in the ‘Statistics per Check Point’

table to sort the data in ascending or descending order for that column.

12. Jump to Display: To view any of the individual check points in the LAS Map View window, double-

click anywhere in that row within the ‘Statistics per Check Point’ table.  The selected check point will

be centered in the LAS Map View window.

Part II - Closest Point Elevation Calculation Method

The 'Closest Point' option will report the Delta Z (elevation difference) rather than the Z Error of the 'TIN/

GRID' method described above.  With this option, the user is also given the horizontal and straight line

vector (angle) distance from each check point to its comparison LiDAR point.  A LiDAR project such
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as a collection for power line towers, conductors, and attachment points can be checked for vertical

accuracy in MARS® using this method, which compares each check point to its closest LiDAR point

using radial distance to determine the point to be analyzed.

For LiDAR data that has been corrected for systematic errors, the project’s check points can be

validated against any selected class(es) of LiDAR points via the Check Point Report utility within

MARS®.  This tool verifies the accuracy requirements for the LiDAR data and serves as the critical tie

between project control and coordinate systems.  The report compares the accuracy of the remotely

collected data with the known check points, which can help uncover data integrity issues within the

dataset.

Check points must be stored in a *.CSV file and have the following format: 

Columns for ID, X, Y, Z, Desc where:

ID - unique identifier for each individual check point

X, Y, Z - check point location and elevation

Desc - optional description of check point (often location related).

The first row of the file must  contain column headers  and not  actual check point  values.   The headers

do not  have to be named as  shown  in  the  info  above,  but  must  be  in  that  order.   Optionally,  a  fifth

column can be added to the file to store a description (such as  top of  tower,  bottom  insulator,  etc.).

 Not every row (point record) in the file needs values for this optional column.

Example Check Point file (minimum info required):                                               

Example Check Point file (with optional description column):

ID,X,Y,Z                                                                                                       

          ID,X,Y,Z,Desc
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101,3134317.70,1697177.02,5217.69                                                              

         101,3134317.70,1697177.02,5217.69,pk_lot

102,3134166.64,1696104.25,5243.59                                                              

         102,3134166.64,1696104.25,5243.59,road

103,3134317.54,1695249.07,5211.17                                                              

         103,3134317.54,1695249.07,5211.17,field

104,3135486.86,1695195.46,5193.72                                                              

         104,3135486.86,1695195.46,5193.72,sidewalk

105,3135148.81,1697032.31,5192.97                                                              

         105,3135148.81,1697032.31,5192.97,road

To generate a check point report, the project LAS data and corresponding check points file must first

be loaded.  The number of significant figures which will appear in the Check Point Report can be

controlled by the user.  To modify the number of significant figures, go to the Options Tab  and click

the 'Miscellaneous' button.  In the interface that appears (below), see the 'Check Point Report

Options' section.

Note that points flagged as 'Withheld', regardless of classification, will not be used in this tool.

518



MARS® v2023.1           User Manual1236

© 2000-2023 Merrick & Company

To run the Check Point Report utility, please follow these steps:

1. After loading the project LAS data and the check points file, click the ‘Check Point Report’ button

 on the QA/QC Tab .  Each time a check point report is created, the user can select

which point classification(s) to include in the report calculations, what method of elevation calculation

should be used, and what the vertical unit of the project data is.  By default, Ground (Class 2) is

checked on, however the user will likely want to make a different selection(s) for this method depending

on the data.  For example, Class 20 (Conductor Attachment) is selected in the options interface shown

below.

Next, ensure that the 'Elevation Calculation Method' is set to 'Closest Point'.  Finally, choose the

'Vertical Unit for Loaded Points' from the drop-down list.  Note that this option has no default, to

457
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ensure that the correct units are always chosen.  Click 'OK' when finished.
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2. The ‘Check Point Report’ interface will appear (below) and the results of the analysis will be

presented.  The interface contains project accuracy statistics in the ‘Statistics for Project’ section,

and the 'Statistics per Check Point’ info in the table at the bottom of the window.  Note that there are

no USGS or ASPRS standards for this elevation calculation method.  The option to display the full path

to all loaded LAS files is controlled by the 'Display LAS file path' check box found directly below the

list of LAS files.  The status of this check box will also affect the (optional) saved check point reports
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(see Step 8).

3. Make any necessary changes: Three parameters can be changed from their default or original

settings: the 'Classifications Included' (see Step 1), the Search Radius for closest point, and the

exclusion of one or more check points (see Step 4).  See the Inputs Section  topic for details on the

Search Radius setting.

4. Turn Off Selected Pt / Turn On Selected Pt: Individual points can be checked (included in the

analysis) or unchecked (excluded) in the table at the bottom of the check point report simply by

1261
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clicking the corresponding check box.  In addition, multiple points can be selected using standard

Windows controls and then turned on/off.  Clicking in the blank space to the left of a row will select that

row.  Clicking and dragging the cursor through the blank spaces of multiple adjacent rows will select all

rows within the drag area.  Likewise, clicking a row, holding down the 'Shift' key, and clicking another

row higher or lower in the table will select all rows between, inclusive.  Clicking the blank areas for

individual rows while holding down the 'Ctrl' key will select only those rows, and 

5. Recalculate: If any of the items listed in Step 3 has been changed, click the ‘Recalculate’ button

to process the check points with the new parameters.

6. Hide: This option allows the user to hide the check point report without actually closing it.  Closing

the report would require it to regenerate the information provided if it were needed to be viewed again. 

To bring the hidden check point report back up, click the 'Check Point Report' button on the QA/QC

Tab  again.  The report window is redisplayed immediately with the values previously generated.

7. Close: To completely close (rather than hide) the check point report, click on the 'Close' button.  To

view the report again, it will need to be regenerated by clicking the ‘Check Point Report’ button on

the QA/QC Tab  to start the process over.

8. Save Report...: To save the check point report to a comma-separated value (CSV) file and a

separate PDF file, click on the ‘Save Report...’ button, navigate to the desired folder, enter a filename,

and click the ‘Save’ button.  If the LiDAR data is being displayed, it will switch to Intensity rendering

for a screen capture that is made for the PDF version of the report.

9. Redraw Thematically: Use this button to show 'Z Error' values per check point thematically.  All

other data besides the check points can be turned off in the Table of Contents to more easily view this

457
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display.  Red squares represent negative error (closest point lower than check point) and green

squares represent positive error (closest point higher than check point).  The magnitude of the error is

shown by the relative size of the square - the larger the square, the larger the 'Z Error'.  To return to the

previous display, click the same button which will now be labeled 'Redraw Normal'.
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10. Data Sorting: Click any of the column headings (e.g., 'Delta Z') in the ‘Statistics per Check

Point’ table to sort the data in ascending or descending order for that column.

11. Jump to Display: To view any of the individual check points in the LAS Map View window, double-

click anywhere in that row within the ‘Statistics per Check Point’ table.  The selected check point will

be centered in the LAS Map View window.

Please review the topics below for explanations of the values and messages displayed in the Check

Point Report interface.

See Also

TIN/Grid Calculation Method

Closest Point Calculation Method

Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.1 TIN/Grid Calculation Method

Check Point Report: TIN/Grid Calculation

Method

Merrick Advanced Remote Sensing (MARS
®

) Software

See

1243

1260

1267
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Check Point Report Overview

Inputs Section

Statistics for NVA Points of Project Section

Statistics per Check Point Section

Closest Point Calculation Method

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.1.1 Inputs Section

Check Point Report: Inputs Section (TIN/Grid)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Inputs' Section of the Check Point Report:

Note:  The loaded check point CSV or shapefile file used in the report calculations will be listed at

the very top of the interface.

USGS LBS 2.1 Quality Level / Vertical Accuracy Class (Requirement table): This is the target

root mean squared error (RMSEz) value for the project, which defines the Vertical Accuracy Class

requirement.  During the calculation of the check point statistics, comparisons are made to the

RMSEz value to see if it meets the desired accuracy requirements.  To achieve the target accuracy

requirements, the calculated RMSEz value is compared to the target value to determine if the LiDAR

surface at each check point is within an acceptable margin of error to be displayed in green font in

the 'Standards' section.

1221

1244

1247

1254

1260



Quality Control 1245

© 2000-2023 Merrick & Company

Elevation Calculation Method: There are two (2) elevation calculation methods for this version of

the check point report: TIN and Grid.  The default method, ‘TIN’, complies with FEMA requirements,

as described in the FEMA guidelines for LiDAR Mapping.  Under this method, a TIN is created

around each check point, using LiDAR points from the selected class(es) within a search radius of

five times (5x) the Ground Sample Distance (as determined through testing).  Then the one triangle

that covers the check point being tested is selected.  The XY location on the surface of this triangle

that matches the check point XY location provides the elevation value.  This elevation value is a linear

interpolation of the elevations of the three (3) TIN vertices or, more clearly stated, it is the point in 3D

space on the TIN triangle at the check point's XY coordinates.  The second method, 'Grid', allows

check point report statistics to be created using a virtual grid built with the same parameters that will

be used to create raster and contour deliverables.  This method is not available when the loaded LAS

data is auto-detected as Lat/Long (Geographic).  Options when using the 'Grid' method include the

'Grid Cell Size' and the 'Gaussian Smoothing Count' (number of passes).  As with raster and contour

creation, the more the data is smoothed, the more accuracy is lost.

         

http://www.fema.gov/plan/prevent/fhm/lidar_4b.shtm
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Search Radius for 3 points (TIN): This value is calculated from the loaded LAS data.  The default

value is five times (5x) the Ground Sample Distance (as determined through testing) but can be

modified.  Too small of a value will result in some check points not being compared to their

surrounding LAS data - this may be the case when the 'Points with Coverage' value in the 'Statistics

for NVA Points of Project' section is less than the 'Check Points' count, causing some points in the

'Statistics per Check Point' section to have mostly blank values.  Too large of a value may result in

overly-long processing times.

Classifications Included: This list box shows which data classifications are to be used to calculate

elevation.  Only those data classifications that are displayed in the box will be included in the

elevation calculation.  When Class 2 (Ground) is included, the status of the Model Key-point bit flag,

if present, is ignored.

LAS Files - Count: This section shows a list of all LAS files loaded into the project and their count.

An option to display the complete file path is available.  The status of this 'Display LAS file path'

check box will also affect the (optional) saved check point reports (see Finishing the Check Point

Report ).1267
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See Also

Check Point Report Overview

Statistics for NVA Points of Project Section

Statistics per Check Point Section

Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.1.2 Statistics for NVA Points of Project Section

Check Point Report: Statistics for NVA Points of

Project Section (TIN/Grid)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Statistics for NVA Points of Project' Section of the Check Point Report:

Statistics for NVA Points of Project (in data units):

TIN method                                                                        
                                          Grid method

1221
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Check Points: This is the total number of check points in the project.

Points with Coverage: This is the number of check points with an elevation value that can be

computed from nearby LiDAR data.  More specifically, when computing the Z elevation from a TIN,

this is the number of check points where a covering triangle is found.

NVA Points: The total count of all check points identified in the file as NVA (located in non-

vegetated areas) or not defined - unidentified check points are assumed to be NVA.  Only these

points are used in calculating the results shown in the 'Statistics for NVA Points of Project' and

'Statistics for Project - Standards' sections of the tool, except for the 'Vegetated Vertical Accuracy

(VVA) at the 95th Percentile' result.

VVA Points: The total count of all check points identified in the file as VVA (located in vegetated
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areas).  These points are used to calculate the results for the 'Vegetated Vertical Accuracy (VVA) at

the 95th Percentile' item in the 'Standards' section.

Average Vertical Error: For all check points with LiDAR coverage, this is the average of the ‘Z

Error’ values shown in the 'Statistics per Check Point' table.  An absolute value more than 25% of

the specified RMSE (Vertical Accuracy Class), when compared in the same units, will be displayed

in red font.

'Shift all loaded points to the negated average vertical error and recalculate' button: This

button will modify all loaded LAS files by adding an opposite Z shift (vertical) to the header of those

files, causing the 'Average Vertical Error' value to be set to 0 (zero).

Maximum Vertical Error: For all check points with LiDAR coverage, this is the highest positive ‘Z

Error’ value.

Median Vertical Error: For all check points with LiDAR coverage, this is the median of the ‘Z

Error’ values.

Minimum Vertical Error: For all check points with LiDAR coverage, this is lowest negative ‘Z

Error’ value.

Standard Deviation of Vertical Error: This is the standard deviation of the ‘Z Error’ for the check

point values.

Skewness of Vertical Error: This is a measure of symmetry or asymmetry within a data set, in

this case the vertical (Z) errors.  The distribution is considered symmetrical if skewness is close to
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zero (between -0.5 and 0.5) and the mean is nearly equal to the median.  Calculated values outside

this range will be displayed in red font.

Kurtosis of Vertical Error: The measure of relative 'peakedness' or flatness of a distribution

compared with a normally distributed data set. Positive kurtosis indicates a relatively peaked

distribution near the mean while negative kurtosis indicates a flat distribution near the mean.  The

distribution is considered normal if the kurtosis is between -3 and 3.  Calculated values outside this

range will be displayed in red font.

Statistics for Project - Standards (TIN method):

Note:  The 'DEM' column in the above screen capture shows the values calculated when a virtual

(RAM-based) grid of the selected lidar point class(es) is created to compare with the check points. 

The grid cell size is determined by the Vertical Accuracy Class value selected in the Requirement

table (see Inputs Section ).  These values are calculated only when a Vertical Accuracy Class that

has a corresponding USGS Quality Level associated with it is selected.  Cell sizes are taken from the

USGS NGP Lidar Base Specification Version 2.1 (Table 6).  For example, for projects in U.S. Survey

Feet the cell size used for the 10.0-cm Vertical Accuracy Class (QL2) is 2 feet.

1244
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Non-vegetated Vertical Accuracy (NVA) RMSEz: This is the RMSE of the Z-values from the

TINned data as compared to the NVA check points.  There will be a value in the 'TIN' column (see

screen capture, above) only if at least one check point is identified as NVA.  A green value indicates

compliance with the Vertical Accuracy Class value selected in the Requirement table (see Inputs

Section ); a red value indicates non-compliance.

Non-vegetated Vertical Accuracy (NVA) at the 95% Confidence Level: There will be a value in

the 'TIN' column only if at least one check point is identified as NVA.  This value is the RMSE Z-

value multiplied by a factor based on the confidence level.  For the 95% confidence level, the

multiplication factor is 1.96.  A green value in the 'TIN' column indicates compliance with the Vertical

Accuracy Class value selected in the Requirement table; a red value indicates non-compliance.

This value will be identical to the 'FGDC/NSSDA Vertical Accuracy at the 95% Confidence

Level' value.

Vegetated Vertical Accuracy (VVA) at the 95th Percentile: There will be a value in the 'TIN'

column only if at least one check point is identified as VVA.  A green value in the 'TIN' column

indicates compliance with the Vertical Accuracy Class value selected in the Requirement table; a 

red value indicates non-compliance.

FGDC/NSSDA Vertical Accuracy at the 95% Confidence Level: This value, derived from the

RMSE of Z for the NVA check points, is the vertical accuracy as defined in Geospatial Positioning

Accuracy Standard, Part 3, National Standard for Spatial Data Accuracy, FGDC-STD-007.3-1998.  It

is the RMSE value multiplied by a factor based on the confidence level.  For the 95% confidence

level, the multiplication factor is 1.96.  There will be a value in the 'TIN' column only if at least one

check point is identified as NVA.  This value will be identical to the  'Non-vegetated Vertical

Accuracy (NVA) at the 95% Confidence Level' value.

1244
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Testing statement: This statement is displayed only when using the 'TIN' elevation calculation

method.  It summarizes the Vertical Accuracy Class selected and the resulting NVA and VVA

vertical accuracy statistics as taken from the first three of the four values described immediately

above.  If no VVA check points exist in the loaded check points file, accuracy values will be

summarized only for NVA.

Statistics for Project - Standards (Grid method):

Note:  The 'USGS DEM' column in the above screen capture shows the values calculated when a

virtual (RAM-based) grid of the selected lidar point class(es) is created to compare with the check

points.  The grid cell size is determined by the Vertical Accuracy Class value selected in the

Requirement table (see Inputs Section ).  These values are calculated only when a Vertical

Accuracy Class that has a corresponding USGS Quality Level associated with it is selected.  Cell

sizes are taken from the USGS NGP Lidar Base Specification Version 2.1 (Table 6).  For example, for

projects in U.S. Survey Feet the cell size used for the 10.0-cm Vertical Accuracy Class (QL2) is 2

feet.

Non-vegetated Vertical Accuracy (NVA) RMSEz: This is the RMSE of the Z-values from the

1244
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virtually gridded data as compared to the NVA check points.  There will be a value in the 'Grid'

column only if at least one check point is identified as NVA.  Since the 'Grid Cell Size' and

'Gaussian Smoothing Count' (number of passes) can be set by the user, the calculated value in the

'Grid' column (see screen capture, above) is displayed in black font - it is not tied to any standards.

Non-vegetated Vertical Accuracy (NVA) at the 95% Confidence Level: There will be a value in

the 'Grid' column only if at least one check point is identified as NVA.  Since the 'Grid Cell Size' and

'Gaussian Smoothing Count' (number of passes) can be set by the user, the calculated value in the

'Grid' column is displayed in black font - it is not tied to any standards.

Vegetated Vertical Accuracy (VVA) at the 95th Percentile: There will be a value in the 'Grid'

column only if at least one check point is identified as VVA.  Since the 'Grid Cell Size' and

'Gaussian Smoothing Count' (number of passes) can be set by the user, the calculated value in the

'Grid' column is displayed in black font - it is not tied to any standards.

FGDC/NSSDA Vertical Accuracy at the 95% Confidence Level: This value, derived from the

RMSE of Z for the check point sample, is the vertical accuracy as defined in Geospatial Positioning

Accuracy Standard, Part 3, National Standard for Spatial Data Accuracy, FGDC-STD-007.3-1998.  It

is the RMSE value multiplied by a factor based on the confidence level.  For the 95% confidence

level, the multiplication factor is 1.96.

See Also

Check Point Report Overview

Inputs Section

Statistics per Check Point Section
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Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.1.3 Statistics per Check Point Section

Check Point Report: Statistics per Check Point

Section (TIN/Grid)

Merrick Advanced Remote Sensing (MARS
®

) Software

See

TIN

Grid

See Also

Check Point Report Overview

Inputs Section

Statistics for NVA Points of Project Section

Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.1.3.1  TIN

Check Point Report: Statistics per Check Point
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Section (TIN)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Statistics per Check Point' Section of the Check Point Report (TIN method):

ID - This is the ID (string or label) of the check point, as found in the first column of the check point

file.  If a point's row is checked on, that point is included in project statistics - otherwise it is

excluded from analysis.

Note: Double-click ing on a point's row will put that check point in the center of the LAS Map

View window.

X - This is the X (easting) coordinate of the check point, as found in the second column of the check

point file.

Y - This is the Y (northing) coordinate of the check point, as found in the third column of the check

point file.
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TIN Coverage - To determine an elevation representative of the LiDAR data at the XY location of

each check point, a TIN is created using filtered LiDAR points within the specified search radius

distance (as auto-calculated or manually set) of the check point location.  A TIN triangle may or

may not cover the check point location.  If a TIN was made that covers, then this field is set to “Yes”

- otherwise it is set to “No”.

Z of Check Pt. - This is the Z-value (elevation) of the check point, as found in the fourth column of

the check point file.

Z from LiDAR - The Z-value of the data, as computed from nearby LiDAR points. There are several

ways of calculating this value. Currently, the method implemented is to create a TIN using filtered

(bald earth) LiDAR points within 100 units of the check point location. Then, one triangle in the TIN

is found which covers, in two dimensions, the XY location. The three points of this triangle are used

to calculate a height. More specifically, a location on the 3D triangle is found with the XY

coordinates of the check point. The Z-value of this location is the Z-value used, as this represents a

linearly interpolated value for the elevation from the three TIN points.

NVA / VVA - This is the optional NVA (non-vegetated vertical accuracy) or VVA (vegetated vertical

accuracy) status of each check point, as found in the sixth column of the check point file.  Missing

values are interpreted as NVA.

Z Error - The difference between the Z-value of the check point and the Z-value computed from the

LiDAR data.  A value more than three (3) times the calculated 'Standard Deviation of Vertical Error'

will cause the entire row for that check point to be displayed in red font.
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Min. Z - When computing the Z elevation from a TIN, this is the Z of the lowest LiDAR point of the

three (3) points in the covering triangle.

Median Z - When computing the Z elevation from a TIN, this is the median Z-value for the three (3)

LiDAR points that describe the covering triangle.

Max. Z - When computing the Z elevation from a TIN, this is the Z of the highest LiDAR point of the

three (3) points in the covering triangle.

Intensity - Calculated intensity of the TIN at the check point XY location.

Scan Angle - Calculated scan angle (LAS v1.4 data) or scan angle rank (pre-LAS v1.4 data) of the

TIN at the check point XY location.

Returns - The return values of the three (3) surrounding LiDAR points used in TIN formation are

listed here.

Description - This is the optional description of each check point, as found in the fifth column of the

check point file.

See Also

Grid

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.1.1.3.2  Grid

Check Point Report: Statistics per Check Point

Section (Grid)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Statistics per Check Point' Section of the Check Point Report (Grid method):

ID - This is the ID (string or label) of the check point, as found in the first column of the check point

file.  If a point's row is checked on, that point is included in project statistics - otherwise it is

excluded from analysis.

Note: Double-click ing on a point's row will put that check point in the center of the LAS Map

View window.

X - This is the X coordinate of the check point, as found in the second column of the check point

file.
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Y - This is the Y coordinate of the check point, as found in the third column of the check point file.

TIN Coverage - To determine an elevation representative of the LiDAR data at the XY location of

each check point, a TIN is first created using filtered LiDAR points within the specified search radius

distance (as auto-calculated or manually set) of the check point location.  A TIN triangle may or

may not cover the check point location.  If a TIN was made that covers, then this field is set to “Yes”

- otherwise it is set to “No”.  The Grid is then built from the TIN.

Z of Check Pt. - This is the Z-value of the check point, as found in the fourth column of the check

point file.

Z from LiDAR - The Z-value of the data, as computed from nearby LiDAR points. Currently, the

method implemented is to create a TIN using filtered (bald earth) LiDAR points within 100 units of

the check point location. Then, one triangle in the TIN is found which covers, in two dimensions, the

XY location. The three points of this triangle are used to calculate a height. More specifically, a

location on the 3D triangle is found with the XY coordinates of the check point. The Z-value of this

location is the Z-value used, as this represents a linearly interpolated value for the elevation from the

three TIN points.

NVA / VVA - This is the optional NVA (non-vegetated vertical accuracy) or VVA (vegetated vertical

accuracy) status of each check point, as found in the sixth column of the check point file.  Missing

values are interpreted as NVA.

Z Error - The difference between the Z-value of the check point and the Z-value computed from the

LiDAR data.



MARS® v2023.1           User Manual1260

© 2000-2023 Merrick & Company

Min. Z - Not applicable for this method.

Median Z - Not applicable for this method.

Max. Z - Not applicable for this method.

Intensity - Not applicable for this method.

Scan Angle - Not applicable for this method.

Returns - Not applicable for this method.

Description - This is the optional description of each check point, as found in the fifth column of the

check point file.

See Also

TIN

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.2 Closest Point Calculation Method

Check Point Report: Closest Point Calculation
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Method

Merrick Advanced Remote Sensing (MARS
®

) Software

See

Check Point Report Overview

Inputs Section

Statistics for Project Section

Statistics per Check Point Section

TIN/Grid Calculation Method

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.2.1 Inputs Section

Check Point Report: Inputs Section (Closest

Point)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Inputs' Section of the Check Point Report:

Note:  The 'Closest Point' method is not available when the loaded LAS data is auto-detected as

Lat/Long (Geographic).

Note:  The loaded check point CSV or 3D point shapefile used in the report calculations will be

listed at the very top of the interface.
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Classifications Included: This list box shows which data classifications are to be used to calculate

elevation.  Only those data classifications that are displayed in the box will be included in the elevation

calculation.  When Class 2 (Ground) is included, the status of the Model Key-point bit flag, if present,

is ignored.

Search radius for closest point: This value is calculated from the loaded LAS data.  The default

value is three times (3x) the Ground Sample Distance (as determined through testing) but can be

modified.  Too small of a value will result in some check points not being compared to their

surrounding LAS data - this may be the case when some or all points in the 'Statistics per Check

Point' section have mostly blank values.  Too large of a value may result in overly-long processing

times.

LAS Files - Count: This section shows a list of all LAS files loaded into the project and their count.

An option to display the complete file path is available.  The status of this 'Display LAS file path' check

box will also affect the (optional) saved check point reports (see Finishing the Check Point Report ).

See Also

Check Point Report Overview

Statistics for Project Section

Statistics per Check Point Section
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Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.2.2 Statistics for Project Section

Check Point Report: Statistics for Project

Section (Closest Point)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Statistics for Project' Section of the Check Point Report:

Check Points: This is the total number of check points in the project.

Average Slope Distance: This is the average of all the 'Slope Distance' values from the 'Statistics

per Check Point' table.  Slope Distance is the length of the hypotenuse of the triangle formed with

'Delta Z' and 'Horizontal Error' as the two legs.

1267
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Maximum Slope Distance: This is the maximum of all the 'Slope Distance' values from the

'Statistics per Check Point' table.

Median Slope Distance: This is the median calculated from all the 'Slope Distance' values in the

'Statistics per Check Point' table.

Minimum Slope Distance: This is the minimum of all the 'Slope Distance' values from the

'Statistics per Check Point' table.

Average Delta Z: This is the average of all the 'Delta Z' (elevation difference) values from the

'Statistics per Check Point' table.  Positive values mean the check point is lower than its closest

LiDAR point; negative values mean the check point is higher than its closest LiDAR point.

Average Delta X: This is the average of all the 'Delta X' (easting difference) values from the

'Statistics per Check Point' table.  Positive values mean the check point is west of its closest LiDAR

point; negative values mean the check point is east of its closest LiDAR point.

Average Delta Y: This is the average of all the 'Delta Y' (northing difference) values from the

'Statistics per Check Point' table.  Positive values mean the check point is south of its closest

LiDAR point; negative values mean the check point is north of its closest LiDAR point.

Average Horizontal Error: This is the average of all the 'Horizontal Error' values from the 'Statistics

per Check Point' table.  Horizontal Error is the absolute value of the 2D radial distance from the each

check point to its closest LiDAR point.

See Also



Quality Control 1265

© 2000-2023 Merrick & Company

Check Point Report Overview

Inputs Section

Statistics per Check Point Section

Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.2.3 Statistics per Check Point Section

Check Point Report: Statistics per Check Point

Section (Closest Point)

Merrick Advanced Remote Sensing (MARS
®

) Software

'Statistics per Check Point' Section of the Check Point Report:

ID - This is the ID (string or label) of the check point, as found in the first column of the check point

1221
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file.  If a point's row is checked on, that point is included in project statistics - otherwise it is

excluded from analysis.

Note: Double-click ing on a point's row will put that check point in the center of the LAS Map

View window.

X - This is the X (easting) coordinate of the check point, as found in the second column of the check

point file.

Y - This is the Y (northing) coordinate of the check point, as found in the third column of the check

point file.

Z of Check Pt. - This is the Z-value (elevation) of the check point, as found in the fourth column of

the check point file.

Z from LiDAR - The Z-value (elevation) of the LiDAR data, as stored for the closest lidar point in the

selected class(es).

Delta Z - The difference between the Z-value of the check point and the Z-value of the closest LiDAR

point.

Horizontal Error - The absolute value of the 2D radial distance from the each check point to its

closest LiDAR point.

Slope Distance - The length of the hypotenuse of the triangle formed with 'Delta Z' and 'Horizontal

Error' as the two legs.



Quality Control 1267

© 2000-2023 Merrick & Company

Delta X - The easting difference between each check point and its closest LiDAR point.  Positive

values mean the check point is west of its closest LiDAR point; negative values mean the check

point is east of its closest LiDAR point.

Delta Y - The northing difference between each check point and its closest LiDAR point.  Positive

values mean the check point is south of its closest LiDAR point; negative values mean the check

point is north of its closest LiDAR point.

Description - This is the optional description of each check point, as found in the fifth column of the

check point file.

See Also

Check Point Report Overview

Inputs Section

Statistics for Project Section

Finishing the Check Point Report

© 2000-2023 Merrick & Company. All Rights Reserved.

6.1.3 Finishing the Check Point Report

Check Point Report: Finishing the Check Point

Report

Merrick Advanced Remote Sensing (MARS
®

) Software
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Finishing the Check Point Report:

The values displayed in the Check Point Report window can be saved to both a comma separated

value (CSV) file and a PDF file.  The CSV file can be opened with a spreadsheet application (e.g.,

Microsoft Excel).  The PDF report will additionally contain the NVA and VVA histograms and a screen

capture of the the thematically-rendered Z errors.  In addition, a 2D point shapefile of the check points

that are turned on (included) in the report will be saved in the output folder.  To generate the permanent

check point reports, follow these steps:

Click the ‘Save Report...’ button.

Navigate to the desired folder, enter a filename, and click the ‘Save’ button.  The CSV and

PDF reports, and the 2D point shapefile will all be given the same name.

The user may also wish to hide the Check Point Report window but have it quickly available for further

viewing.  To do this:

Click the ‘Hide’ button.

Once hidden, the user can view the Check Point Report dialog again by clicking the ‘Check

Point Report’ button on the QA/QC Tab .  The window will be made visible again without

any lengthy data reprocessing.

The 'Close' button will completely close the Check Point Report and remove any calculations stored in

RAM.

See Also

Check Point Report Overview

TIN/Grid Calculation Method

Closest Point Calculation Method
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.2 USGS 2022 rev. A QC Module

USGS 2022 rev. A QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP LBS - 2022 rev. A' QC Module (available at the Explorer QC and Production license

levels) can be accessed in a drop-down list as shown ...

  

... after clicking the QC Module button  on the QA/QC Tab .

A newer version of the USGS Lidar Base Specification (2023 rev. A) was published shortly before the

date of this MARS release - a drop-down tool for it will be added to the next release.  

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.2.1 General Information

USGS 2022 rev. A QC Module - General

Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP LBS - 2022 rev. A' quality control (QC) module in MARS® is to provide

an automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification 2022 rev. A from the U.S. Geological Survey (USGS).  The content of USGS NGP LBS

2022 rev. A (August 2023) can be downloaded as a PDF.

Note that points flagged as 'Withheld', regardless of classification, will not be used in any

processing for this tool with the following exceptions:  tests DPH-12 and DPH-14 (see the Data

Processing/Handling Tab  topic).

There are 22 possible tests that can be run in the USGS 2022 rev. A QC Module.  The user can

customize QC tasks by selecting the individual QC standards that they wish to analyze.  The results of

the point cloud, check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed

and Summary - which include a one-page test results summary table, supporting raster analysis

images, tabular data, charts, and other statistical information.  See the Final Reports  sub-topic for

more information.

The USGS 2022 rev. A QC Module tests are divided into Collection  and Data Processing/Handling

 tabs as categorized in the USGS specifications document.  Please note that for non-quantitative
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tests a visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2021 rev. A , USGS 2020 rev. A ,

USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP - Version 1.2 , and USGS

NGP - Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and

the Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or

Production (MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license

for an additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Classified (final filtered) LAS data (typically as tiled files)

Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) that includes a

100-meter (or equivalent in other units) buffer, with at least one attribute field that contains

unique values

LiDAR Check Points (CSV or SHP file format)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-8 Smooth Surface Precision

(intraswath), DPH-10 Check Points, and DPH-11 Absolute Vertical Accuracy.  Many tests require the

existence or generation of swath LAS data files.  If any of these tests are selected to be run, a warning

prompt will appear when the 'Run' button is clicked.  Use the 'Browse' button to the right of the

'Generated Swaths' entry box to select a folder of existing project swaths, or a folder in which swaths will

be generated from the tiled data.  Optionally, check the 'Keep generated swaths when complete' box to
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retain the existing or generated swaths at the end of the processing.

A matrix chart PDF of input data and available tests can be accessed by clicking the 'Input

Requirement Matrix' button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of

any input shapefile or LiDAR Check Points CSV / SHP file.

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 2022 rev. A QC Module, just

as it must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data

pathed out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

1277
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Multi-threading

A multi-threading option can be found on the USGS 2022 rev. A QC Module interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 2022 rev. A QC Module
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When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  Depending on the

'Output Folder' and 'Generated Swaths' folder selected (see Input Tab  for details), and whether data

exists in these folders from previous runs of this USGS 2022 rev. A QC Module, one or more of the

following pop-up messages may appear.  Reusing 'Statistics', 'Generated Swaths', and/or the 'Generated

Footprints Shapefile' will save processing time, but be sure that no changes have been made to any of

the input datasets before reusing any previously generated data.  To guarantee a completely 'fresh' run,

empty the 'Output Folder' and 'Generated Swaths' folders before running this module.

1.

A 'Yes' answer will reuse previously generated statistics in the output folder path for both tiled and

swaths data.  Answering 'No' here will allow the 'Statistics' folder to be overwritten, and MARS® will then

check to see if LAS data exits in the 'Generated Swaths' folder as selected on the Input Tab .  If there

is data, the following message will appear:

2.

1277 1281
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The user must decide if the pre-existing data is the correct generated swath data for the testing to be

conducted, and must ensure that no other LAS data exists in that folder.  If these conditions are true,

click 'Yes' - the 'Keep generated swaths when complete' box on the Input Tab  will be checked if it is

not already, and processing will continue.  If 'No' is clicked, the following message will appear:

3.

Clicking 'OK' for this message will clear out the selected 'Generated Swaths' folder and regenerate the

swaths as described in the Input Tab  section.  Finally, a check is done for an existing swath

footprints shapefile in the output folder path:

4.

After clicking either 'Yes' or 'No', a pop-up may appear if any selected tests require data that has not

been pathed out on the Input Tab .  Dismiss the pop-up by clicking 'OK' and either uncheck the tests

that don't have supporting data or supply the path/name to the required file(s).  Click 'Run' again to re-

start the above pre-checks.

1277
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While running, the individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain

active, and a 'Cancel' button will appear if the user wants to terminate the process (note that the

cancellation may take several minutes).  However, no changes can be made to any entries on the tabs

once the 'Run' button is clicked.  There are two progress bars at the bottom of the interface - one for the

current step and one for the overall processing.  To the right of the 'Current Step' bar, information about

the current test number and total tests to be run will be displayed.  Tests may appear out of order and

the same test number may be displayed more than once due to grouping similar tasks together for

efficiency.  Any data and imagery loaded in the Table of Contents will be removed after the 'Run'

button is clicked, and the 'LAS Map View' window will be cleared once the USGS 2022 rev. A QC

Module begins the screen capture portion of the processing.

Settings Files

Every time the USGS 2022 rev. A QC Module is run, MARS® will generate an XML file containing the

settings used in the processing.  This file will be saved in the Output Folder specified on the Input Tab

.  Each unique *.xml file name will contain the date and time that the module run was started as

seen in the example below.  For example, this particular run was started at 9:11:17 am on April 27,

2022.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 2022 rev. A QC Module runs.  After opening the USGS 2022 rev. A QC

Module interface, click the 'Load Settings from File' button and navigate to an existing settings file to be

used.  Any individual parameters on any of the the interface tabs can be changed as needed before

starting the processing.  In addition, a settings file can be created and saved for future use without

actually running the USGS 2022 rev. A QC Module - make all the parameter entries on the various tabs

and click the 'Save Settings to File' button when finished.  Navigate to a folder to store the file as it will

not automatically be stored in the chosen Output Folder like it is when the module is actually run.

1277
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6.2.2 Input Tab

USGS 2022 rev. A QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab

This tab is where all input data is pathed out, and includes entry fields for the Project Name and
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optional Description, an optional Corporate (or organization) Logo that will appear on each page of the

final reports, Output Folder, and Output PDF File Name.  At a minimum - and depending on the

specific tests to be run - the Classified LAS data, Lidar Check Points and DPA Boundary, or Tile

Scheme must be included, along with a Project Name, Output Folder, and Output PDF File Name. 

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources - a unique Output Folder should also be used. 

Note that when both the Classified LAS data and Tile Scheme are used as inputs, the extents of the

tiled files in the Classified LAS Folder must match the extents of the tiles in the Tile Scheme.

Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines

whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

Depending on the test(s) selected, a 'Generated Swaths' folder may need to be pathed out and, unless

there is LAS data already in the path, swaths will be automatically created in it by assembling files from

identical Point Source IDs found in the Classified LAS (tiled) data.  For example, all points in all tiles in

the 'Classified LAS Folder' that have a Point Source ID of 503 will be combined into one generated swath

named CS_00503.las (the 'CS' tag refers to 'Collection Scan').  These swaths are used as input for the

following tests:  C-2, C-3, C-4, C-5, C-6, DPH-8, and DPH-9.1.  An option to 'Keep generated swaths

when complete' is available to save time for additional QC Module runs that will use the same data, and/

or to preserve the LAS data for any other purpose.  Do not use the same folder for the 'Generated

Swaths' and the 'Output Folder' - this may cause the output results to be deleted.  Also, if using pre-

existing swath data that is not classified, some tests will not produce complete results.

The generated swaths will be used to create a swath footprints polygon shapefile in a sub-folder named
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'Swath_footprints' in the selected Output Folder.  Attributes for beginning & ending Adjusted GPS

Times (GPS_MIN and GPS_MAX) for each swath - along with many other useful attributes - will be

stored for each swath footprint polygon.

If a 'Tile Scheme' and/or 'DPA Boundary' (Defined Project Area) shapefile is pathed out, unique-value

attribute fields must be chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname'

field for the 'DPA Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values

that exactly match the file names of the tiled files in the Classified LAS Folder.  The attribute values for

both of these shapefiles are used for identifying the tabular results of various tests in the final reports.

If a polygon shapefile exists for water bodies (or any type of known exclusion areas), it can be pathed

out using the 'Browse' button to the right of the 'Exclusion Shapefile ' entry box.  These areas will be

omitted from the testing and analysis for tests C-4, C-5, C-6, DPH-9.1, and DPH-15 (see the Collection

Tab  and Data Processing/Handling Tab  topics).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification 2022 rev. A.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

2022 rev. A QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-10 Check Points and

DPH-11 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

1281 1285
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This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option.

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).1295
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6.2.3 Collection Tab

USGS 2022 rev. A QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab

Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are
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checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section/

paragraph in the USGS NGP Lidar Base Specification 2022 rev. A in which they are referenced.  Note

that the following descriptions of what is created for these tests pertain primarily to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show tiled lidar coverage to the extent of the defined project

area (DPA) boundary.  A screen capture of the lidar tiled data with the DPA boundary

superimposed is created for review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of multiple discrete lidar

returns in the LAS data.  Screen captures colored by the various return values, along with tables

of the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity values in

the LAS data.  Histograms, screen captures colored by intensity, and tables are created for

review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this section is to report on the lidar point density and nominal point spacing by

generated swath file.  Averages by swath files (not including overlap), project boundary polygons

(including swath overlap), and aggregate project boundary polygons (including swath overlap) are

reported in a table for review, along with a frequency distribution chart of density/spacing results.

1295
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 'Point Density' and 'NPS' values at the individual swath level are color-coded to indicate

compliance (green) or non-compliance (red) with the selected USGS specifications.

C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close

inspection must be done on the results to determine if the lidar coverage was collected and

processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or

1277
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tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first listed example of lidar spatial distribution violations - problems in flight planning

or flight execution.  A close inspection must be done on the results to determine if the lidar

spatial distribution was collected and processed to meet the intended specifications.  A raster

of compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created

for review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-

null cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells.  

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will improve the ratio of passing (green) cells to the total of all passing

and failing (red) cells, and cut down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow

depth map (by default) and other weather and land-area data for the extent of the lidar collection

at the time of acquisition.

1277
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1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.2.4 Data Processing/Handling Tab

USGS 2022 rev. A QC Module - Data Processing/

Handling Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab
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Check boxes and options for tests DPH-1 through DPH-16 are located on this tab.  By default, all tests

except DPH-9.2 are checked ON to be run and can be controlled by the 'Check All On / Off' buttons near

the upper-right, or by checking/unchecking the individual boxes for the tests.  (Note that two previous

tests no longer exist:  DPH-2 Report on Waveform Data and DPH-13 Use of the LAS Overlap Flag.

 DPH-2 was dropped for this USGS specification, and DPH-13 was dropped beginning with the 2021 rev.

A  specification.  Overlap bit-flagged points are no longer accepted for USGS data deliveries, and the

existence of the Overlap bit flag will be reported in test DPH-14 Point Classification so that corrective

steps can be taken.

Tests are generally named for the section and paragraph in the USGS NGP Lidar Base Specification

2022 rev. A in which they are referenced.  Note that the following descriptions of what is created for

1302
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these tests pertain primarily to the Detailed PDF report (see Final Reports ).  Summary PDF reports

contain a condensed version of the aggregate results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, general

information, and elevation by class test results for each tiled file.  Tables are created for review

for all four sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity' (reported on

per dataset), and 'Point Count with Bad Return Info'.  For 'WKT', fail codes are shown

as needed and those codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, Number of Duplicate Points, and Return

Counts in LAS Header.

In the Informational sub-section (DPH-1.3), the following items are reported on per

file: GPS Time min, GPS Time max, Extended Scan Angle, Scan Angle Rank,

Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

In the Elevation by Class sub-section (DPH-1.4), each tiled file is listed with the

classifications that exist for it along with the minimum and maximum elevations (Z

values) for each of those classes.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as

appropriate.  Red items will be promoted to the top of the tables.  This test also generates a
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polygon shapefile of the tiles with hundreds of attributes populated for analysis and to aid in error

correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar tiled

data.  A table of types (either Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the lidar tiled data.  A

table of horizontal and vertical datum names and associated EPSG codes is created for review.

File names are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications regarding the presence of datums.  Red items will be promoted to the top

of the table.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the

lidar tiled data.   A table of coordinate reference system names, Geoid Model names, and

associated EPSG codes is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar tiled data.  A table of horizontal and vertical units (by file) is created for review.  File names

963
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are color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications regarding the presence of both horizontal and vertical units and their adherence to

the user-input units values.  Red items will be promoted to the top of the table.

DPH-7 Report on File Source ID

The purpose of sub-section DPH-7.1 is to report on the File Source ID values for the lidar tiled

data.  A table of File Source ID values is created for review, with the specification being that File

Source IDs shall be set to zero (0) for tiled data.  File Source IDs are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-8 Smooth Surface Precision (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations

within hard surfaced areas (for example, parking lots or large rooftops).  The slope of areas

selected for testing can be limited by using the 'Slope limit' entry box - the default is set to '3'

degrees.  Test areas are initially established by intersecting the Tile Scheme with the Non-

Vegetated Area (NVA) Check Points to determine which tiles will be used to clip out portions of

the generated swaths for analysis.  Each of these tile/swath testing areas is further refined by

the 'Slope limit' and is also limited to clusters of single returns.  An elevation value difference

raster for each of these tile/swath test areas is created for review.  The raster cells are color-

coded to indicate compliance (green) or non-compliance (red) with the USGS specifications.  In

addition, an attributed polygon shapefile is produced in the DPH-8 output sub-folder for the area

of each raster, with one feature (polygon) for each sample area, per USGS requirements.  The

table shown here is from the USGS NGP Lidar Base Specification 2022 rev. A document - it

lists the allowable 'Smooth surface repeatability, RMSDz' values (in meters) for the four defined
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Quality Levels:

DPH-9.1 Overlap Consistency (interswath)

The purpose of this section is to show graphics of two distinct flight line separation rasters for all

of the data processed - a Measurable raster and a Swath Separation Image raster.  These

images show the vertical separation of flight lines by thematically coloring the separation

magnitude on a color ramp based on absolute distance.  This color thematic rendering is

modulated by intensity to show land cover features.  Color-coded elevation difference rasters of

the overlap areas are created for review, along with a frequency distribution chart of relative

accuracy RMSDz values of the Measurable raster pixels.  An attributed polygon shapefile is

also produced in the DPH-9_1 output sub-folder with one feature (polygon) for each test area,

per USGS requirements.  The table shown here is from the USGS NGP Lidar Base

Specification 2022 rev. A document - it lists the allowable 'Swath overlap difference, RMSDz'

values (in meters) for the four defined Quality Levels:

For the Measurable separation raster, overlap areas are further refined before analysis by

creating clusters of single-return data at a minimum distance from any multiple-return data,

thereby ensuring that the areas analyzed are open and void of canopy cover, buildings, or other
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obstacles.  Additionally, only areas of less than 10 degree slope are analyzed.  

For the Swath Separation Image raster (SSI), all returns are used and no cut-off is applied to the

maximum elevation difference shown.  In addition to a project-wide mosaicked raster, individual

tiled SSI rasters are produced and stored in a sub-folder named 'SSI' found in the 'DPH_9_1'

output folder.  Multiple area-named sub-folders will be created if the Defined Project Area (DPA

Boundary) shapefile consists of more than one polygon (e.g., 'Area1,' 'Area2,' etc.).  The final

PDF reports will indicate multiple DPA boundaries if present.

There are two user-definable settings for the SSI raster portion of this test:

1. an option to choose either TIN (the default) or Grid as the basis for the difference

calculations in the raster (please see the notes in the DPH-9.1 section of the interface regarding

TIN vs Grid).  A text box     displays the raster cell size multiple to be used based on

the 'Quality Level' selected on the Input Tab .

2. an option for which returns - 'All' (the default), 'Single', or 'Last' - are used in the

creation of the raster.  Note that the current USGS specifications allow for any of these options

to be used. 

DPH-9.2 Data Quality Measure - Overlap Consistency (interswath)

This section reports on an additional test not currently listed in the USGS NGP LBS 2022 rev. A

specification. The reason for its inclusion is to prepare for expected future integration of the

USGS/ASPRS led development of interswath Data Quality Measure (DQM) and introduce the

usage of DQM testing to the lidar community.  This test is unchecked by default.

DQM analysis and reporting is intended to quantify the relative horizontal and vertical

errors observed between conjugate features in the overlapping regions of lidar data.

This test produces tabular data, an RMSDz frequency distribution chart and raster, and a

scatterplot of Point-to-Plane distances across the scan field of view.
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Much more information on DQM can be found in the links below:

- General documentation: https://www.asprs.org/wp-content/uploads/
LidarInterswath_CleanCopyASPRSV2.pdf

- Equations: https://edcftp.cr.usgs.gov/project/rst/DQM/DQMDocumentation.docx

- Operational Testing: https://edcftp.cr.usgs.gov/project/rst/DQM/DQM_Operational_Testing%
202017-2-7.pptx

- Executable: https://edcftp.cr.usgs.gov/?dir=project/rst/DQM  

DPH-10 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)

against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing

point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS

/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a TIN of the lidar ground data, along with a bar chart showing error

distribution; a table of NVA check points with point-by-point error and descriptive information as

compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along with a bar chart

1221
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showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a DEM grid of the lidar ground data, along with a bar chart showing

error distribution; point shapefiles of the check points with attributes including the Z value of the

surface and the Z error at each point's location; and screen captures of both the NVA and VVA

check points rendered thematically using color and relative error size on an Intensity view

background of the tiled lidar data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar tiled data.  A statement of total Withheld point count by class for all files is created

for review, along with a screen capture of the Withheld-flagged points for the tiled data.

DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the lidar tiled data.  A table of points by classification is

created for review, with any counts greater than zero (0) shown in red font for Classes 0, 7, and

18 (unless those points are bit-flagged as Withheld) to indicate non-compliance with the USGS

specifications.  If some Class 0, 7, and/or 18 points are flagged as Withheld but some are not,

those points counts will be shown in black with a red background.  Additionally, any points in

any classifications that are bit-flagged as Overlap will be reported in red font as this bit flag is no

longer used for USGS data deliveries.

Model Key-points (if present) must be in either Class 2 (Ground) or in Class 8 (Reserved) and

the appropriate bit flag must be set to 'on'.  If Class 2 is used for Model Key-points, there can be

no points in Class 8.  If Class 8 is used for Model Key-points, all points must be bit-flagged

appropriately and there can be no points in Class 2 bit flagged as Model Key-point.  Any

violations of these Model Key-points requirements will be shown in red font.
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Minimum required classes per the USGS specifications have their point totals in bold font.

Note, however, that some datasets may not have Low noise points (Class 7), Water points

(Class 9),  Bridge deck points (Class 17), High noise points (Class 18), Ignored ground points

(Class 20), Snow points (Class 21), or Temporal exclusion points (Class 22), depending on the

nature of the project.  Also, additional classes may be required on specific projects - non-zero

counts for these classes will be displayed with a yellow background.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes (including point count per Class)

populated for analysis and to aid in error correction (see Populate Statistics on Tile Scheme

topic for details).  The shapefile will be stored in the 'Statistics\Tile' sub-folder that is created in

the Output Folder as pathed out on the Input Tab .  If test DPH-1 Report on LAS Format is

also being run, the shapefile will be created during that test.

DPH-15 Report on Classification Consistency

The purpose of this section is to show a bare earth surface hillshade raster for classification

consistency inspection.  A bare earth hillshade screen capture is created for a visual review.

DPH-16 Report on Tiles

The purpose of this section is to report on the unallowed presence of polygon overlap in the

project tiling scheme.  A table of tiles by name/number with approximate width, approximate

height, and overlap status is created for review.  Overlap reported as 'True' will be shown in red

font.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.2.5 Final Reports

USGS 2022 rev. A QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 2022 rev. A QC Module is written to two (2) PDF files – Detailed and Summary -

that contain the results of the point cloud, check points, and tile scheme analysis.  A one-page test

results summary table can be found immediately after the title page of each report, followed by the

individual test sections.  At the end of the individual test sections in the Detailed report, a page titled

'Time Spent On Each Step' will be created to show processing times in tabular and chart formats.

All tabular results are shown in Meters and also in either US Survey Feet or International Feet,

depending on the project units chosen on the Input Tab .  If either Meter or US Survey Feet is

selected, results will be listed as 'Meter/US Survey Feet'.  If International Feet is selected, results will be

listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_2022_All' but can be changed before running the module.  'Summary_' will be

appended to the summary report file name.  Both reports can be found in the Output Folder that was

chosen on the Input Tab .

Once processing is complete, the detailed report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for each of the 22 tests that can be run.  If any tests were unchecked by the user, a

1277
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listing of Skipped Tests will be appended to the end of both PDF reports followed by a printout of the

Input Requirement Matrix (see Input Datasets in the General Information  topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

2022 rev. A QC Module will also generate several raster images (JPEG and JPEG 2000 format),

shapefiles, and optional KML files that support the visual review of the analysis results.  The Output

Folder will also contain sub-folders named for each test that was run.  These will hold any rasters,

shapefiles, tables, interim PDFs, etc., that were created and used to build the final reports.  These sub-

folders can be deleted if no longer needed after the module has completed and the final PDFs are

generated. 

Sample Report Pages:

1270
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.3 USGS 2021 rev. A QC Module

USGS 2021 rev. A QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP LBS - 2021 rev. A' QC Module (available at the Explorer QC and Production license

levels) can be accessed in a drop-down list as shown ...
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... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.3.1 General Information

USGS 2021 rev. A QC Module - General

Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP LBS - 2021 rev. A' quality control (QC) module in MARS® is to provide

an automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification 2021 rev. A from the U.S. Geological Survey (USGS).  The content of USGS NGP LBS

457
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2021 rev. A (June 2021) can be downloaded as a PDF.

Note that points flagged as 'Withheld', regardless of classification, will not be used in any

processing for this tool with the following exceptions:  tests DPH-12 and DPH-14 (see the Data

Processing/Handling Tab  topic).

There are 23 possible tests that can be run in the USGS 2021 rev. A QC Module.  The user can

customize QC tasks by selecting the individual QC standards that they wish to analyze.  The results of

the point cloud, check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed

and Summary - which include a one-page test results summary table, supporting raster analysis

images, tabular data, charts, and other statistical information.  See the Final Reports  sub-topic for

more information.

The USGS 2021 rev. A QC Module tests are divided into Collection  and Data Processing/Handling

 tabs as categorized in the USGS specifications document.  Please note that for non-quantitative

tests a visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2020 rev. A ,

USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP - Version 1.2 , and USGS

NGP - Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and

the Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or

Production (MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license

for an additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Classified (final filtered) LAS data (typically as tiled files)

1319
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Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) that includes a

100-meter (or equivalent in other units) buffer, with at least one attribute field that contains

unique values

LiDAR Check Points (CSV or SHP file format)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-8 Smooth Surface Precision

(intraswath), DPH-10 Check Points, and DPH-11 Absolute Vertical Accuracy.  Many tests require the

existence or generation of swath LAS data files.  If any of these tests are selected to be run, a warning

prompt will appear when the 'Run' button is clicked.  Use the 'Browse' button to the right of the

'Generated Swaths' entry box to select a folder of existing project swaths, or a folder in which swaths will

be generated from the tiled data.  Optionally, check the 'Keep generated swaths when complete' box to

retain the existing or generated swaths at the end of the processing.

A matrix chart PDF of input data and available tests can be accessed by clicking the 'Input

Requirement Matrix' button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of
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any input shapefile or LiDAR Check Points CSV / SHP file.

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 2021 rev. A QC Module, just

as it must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data

pathed out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

Multi-threading

1310
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A multi-threading option can be found on the USGS 2021 rev. A QC Module interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 2021 rev. A QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  Depending on the

'Output Folder' and 'Generated Swaths' folder selected (see Input Tab  for details), and whether data

exists in these folders from previous runs of this USGS 2021 rev. A QC Module, one or more of the

following pop-up messages may appear.  Reusing 'Statistics', 'Generated Swaths', and/or the 'Generated

Footprints Shapefile' will save processing time, but be sure that no changes have been made to any of

the input datasets before reusing any previously generated data.  To guarantee a completely 'fresh' run,

empty the 'Output Folder' and 'Generated Swaths' folders before running this module.

1.

1310 1314
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A 'Yes' answer will reuse previously generated statistics in the output folder path for both tiled and

swaths data.  Answering 'No' here will allow the 'Statistics' folder to be overwritten, and MARS® will then

check to see if LAS data exits in the 'Generated Swaths' folder as selected on the Input Tab .  If there

is data, the following message will appear:

2.

The user must decide if the pre-existing data is the correct generated swath data for the testing to be

conducted, and must ensure that no other LAS data exists in that folder.  If these conditions are true,

click 'Yes' - the 'Keep generated swaths when complete' box on the Input Tab  will be checked if it is

not already, and processing will continue.  If 'No' is clicked, the following message will appear:

3.

Clicking 'OK' for this message will clear out the selected 'Generated Swaths' folder and regenerate the

swaths as described in the Input Tab  section.  Finally, a check is done for an existing swath

footprints shapefile in the output folder path:

1310
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4.

After clicking either 'Yes' or 'No', a pop-up may appear if any selected tests require data that has not

been pathed out on the Input Tab .  Dismiss the pop-up by clicking 'OK' and either uncheck the tests

that don't have supporting data or supply the path/name to the required file(s).  Click 'Run' again to re-

start the above pre-checks.

While running, the individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain

active, and a 'Cancel' button will appear if the user wants to terminate the process (note that the

cancellation may take several minutes).  However, no changes can be made to any entries on the tabs

once the 'Run' button is clicked.  There are two progress bars at the bottom of the interface - one for the

current step and one for the overall processing.  To the right of the 'Current Step' bar, information about

the current test number and total tests to be run will be displayed.  Tests may appear out of order and

the same test number may be displayed more than once due to grouping similar tasks together for

efficiency.  Any data and imagery loaded in the Table of Contents will be removed after the 'Run'

button is clicked, and the 'LAS Map View' window will be cleared once the USGS 2021 rev. A QC

Module begins the screen capture portion of the processing.

Settings Files

Every time the USGS 2021 rev. A QC Module is run, MARS® will generate an XML file containing the

settings used in the processing.  This file will be saved in the Output Folder specified on the Input Tab

1310
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.  Each unique *.xml file name will contain the date and time that the module run was started as

seen in the example below.  For example, this particular run was started at 3:06:13 pm on September

13, 2021.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 2021 rev. A QC Module runs.  After opening the USGS 2021 rev. A QC

Module interface, click the 'Load Settings from File' button and navigate to an existing settings file to be

used.  Any individual parameters on any of the the interface tabs can be changed as needed before

starting the processing.  In addition, a settings file can be created and saved for future use without

actually running the USGS 2021 rev. A QC Module - make all the parameter entries on the various tabs

and click the 'Save Settings to File' button when finished.  Navigate to a folder to store the file as it will

not automatically be stored in the chosen Output Folder like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.3.2 Input Tab

USGS 2021 rev. A QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab

1310
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This tab is where all input data is pathed out, and includes entry fields for the Project Name and

optional Description, an optional Corporate (or organization) Logo that will appear on each page of the

final reports, Output Folder, and Output PDF File Name.  At a minimum - and depending on the

specific tests to be run - the Classified LAS data, Lidar Check Points and DPA Boundary, or Tile

Scheme must be included, along with a Project Name, Output Folder, and Output PDF File Name. 

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources - a unique Output Folder should also be used. 

Note that when both the Classified LAS data and Tile Scheme are used as inputs, the extents of the

tiled files in the Classified LAS Folder must match the extents of the tiles in the Tile Scheme.
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Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines

whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

Depending on the test(s) selected, a 'Generated Swaths' folder may need to be pathed out and, unless

there is LAS data already in the path, swaths will be automatically created in it by assembling files from

identical Point Source IDs in the Classified LAS (tiled) data.  For example, all points in all tiles in the

'Classified LAS Folder' that have a Point Source ID of 503 will be combined into one generated swath

named CS_00503.las (the 'CS' tag refers to 'Collection Scan').  These swaths are used as input for the

following tests:  C-2, C-3, C-4, C-5, C-6, DPH-8, and DPH-9.1.  An option to 'Keep generated swaths

when complete' is available to save time for additional QC Module runs that will use the same data, and/

or to preserve the LAS data for any other purpose.  Do not use the same folder for the 'Generated

Swaths' and the 'Output Folder' - this may cause the output results to be deleted.  Also, if using pre-

existing swath data that is not classified, some tests will not produce complete results.

The generated swaths will be used to create a swath footprints polygon shapefile in a sub-folder named

'Swath_footprints' in the selected Output Folder.  Attributes for beginning & ending Adjusted GPS

Times (GPS_MIN and GPS_MAX) for each swath - along with many other useful attributes - will be

stored for each swath footprint polygon.

If a 'Tile Scheme' and/or 'DPA Boundary' (Defined Project Area) shapefile is pathed out, unique-value

attribute fields must be chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname'

field for the 'DPA Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values

that exactly match the file names of the tiled files in the Classified LAS Folder.  The attribute values for

both of these shapefiles are used for identifying the tabular results of various tests in the final reports.
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If a polygon shapefile exists for water bodies (or any type of known exclusion areas), it can be pathed

out using the 'Browse' button to the right of the 'Exclusion Shapefile ' entry box.  These areas will be

omitted from the testing and analysis for tests C-4, C-5, C-6, DPH-9.1, and DPH-15 (see the Collection

Tab  and Data Processing/Handling Tab  topics).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification 2021 rev. A.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

2021 rev. A QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-10 Check Points and

DPH-11 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

1314 1319
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enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option.

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.3.3 Collection Tab

USGS 2021 rev. A QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab
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Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section/

paragraph in the USGS NGP Lidar Base Specification 2021 rev. A in which they are referenced.  Note

that the following descriptions of what is created for these tests pertain primarily to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show tiled lidar coverage to the extent of the defined project

1328
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area (DPA) boundary.  A screen capture of the lidar tiled data with the DPA boundary

superimposed is created for review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of multiple discrete lidar

returns in the LAS data.  Screen captures colored by the various return values, along with tables

of the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity values in

the LAS data.  Histograms, screen captures colored by intensity, and tables are created for

review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this section is to report on the lidar point density and nominal point spacing by

generated swath file.  Averages by swath files (not including overlap), project boundary polygons

(including swath overlap), and aggregate project boundary polygons (including swath overlap) are

reported in a table for review, along with a frequency distribution chart of density/spacing results.

 'Point Density' and 'NPS' values at the individual swath level are color-coded to indicate

compliance (green) or non-compliance (red) with the selected USGS specifications.

C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close
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inspection must be done on the results to determine if the lidar coverage was collected and

processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or

tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first listed example of lidar spatial distribution violations - problems in flight planning

or flight execution.  A close inspection must be done on the results to determine if the lidar

spatial distribution was collected and processed to meet the intended specifications.  A raster

of compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created

for review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-
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null cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will improve the ratio of passing (green) cells to the total of all passing

and failing (red) cells, and cut down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow

depth map (by default) and other weather and land-area data for the extent of the lidar collection

at the time of acquisition.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.3.4 Data Processing/Handling Tab

USGS 2021 rev. A QC Module - Data Processing/

Handling Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab

Check boxes and options for tests DPH-1 through DPH-16 are located on this tab.  By default, all tests
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except DPH-2 and DPH-9.2 are checked ON to be run and can be controlled by the 'Check All On / Off'

buttons near the upper-right, or by checking/unchecking the individual boxes for the tests.  (Note that

there is no longer a DPH-13 test - this test for Overlap/Overage points was dropped for the current

specification.  Overlap bit-flagged points are no longer accepted for USGS data deliveries, and the

existence of the Overlap bit flag will be reported in test DPH-14 Point Classification so that corrective

steps can be taken.

Tests are generally named for the section and paragraph in the USGS NGP Lidar Base Specification

2021 rev. A in which they are referenced.  Note that the following descriptions of what is created for

these tests pertain primarily to the Detailed PDF report (see Final Reports ).  Summary PDF reports

contain a condensed version of the aggregate results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, general

information, and elevation by class test results for each tiled file.  Tables are created for review

for all four sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity' (reported on

per dataset), and 'Point Count with Bad Return Info'.  For 'WKT', fail codes are shown

as needed and those codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, Number of Duplicate Points, and Return

Counts in LAS Header.

In the Informational sub-section (DPH-1.3), the following items are reported on per
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file: GPS Time min, GPS Time max, Extended Scan Angle, Scan Angle Rank,

Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

In the Elevation by Class sub-section (DPH-1.4), each tiled file is listed with the

classifications that exist for it along with the minimum and maximum elevations (Z

values) for each of those classes.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as

appropriate.  Red items will be promoted to the top of the tables.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes populated for analysis and to aid in error

correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .

DPH-2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the lidar tiled data.  A

statement of waveform data file count is created for review.  This test is unchecked by default.

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar tiled

data.  A table of types (either Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the lidar tiled data.  A

table of horizontal and vertical datum names and associated EPSG codes is created for review.

File names are color-coded to indicate compliance (green) or non-compliance (red) with the
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USGS specifications regarding the presence of datums.  Red items will be promoted to the top

of the table.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the

lidar tiled data.   A table of coordinate reference system names, Geoid Model names, and

associated EPSG codes is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar tiled data.  A table of horizontal and vertical units is created for review.  File names are

color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications regarding the presence of both horizontal and vertical units.  Red items will be

promoted to the top of the table.

DPH-7 Report on File Source ID

The purpose of sub-section DPH-7.1 is to report on the File Source ID values for the lidar tiled

data.  A table of File Source ID values is created for review, with the specification being that File

Source IDs shall be set to zero (0) for tiled data.  File Source IDs are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-8 Smooth Surface Precision (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations



Quality Control 1323

© 2000-2023 Merrick & Company

within hard surfaced areas (for example, parking lots or large rooftops).  The slope of areas

selected for testing can be limited by using the 'Slope limit' entry box - the default is set to '3'

degrees.  Test areas are initially established by intersecting the Tile Scheme with the Non-

Vegetated Area (NVA) Check Points to determine which tiles will be used to clip out portions of

the generated swaths for analysis.  Each of these tile/swath testing areas is further refined by

the 'Slope limit' and is also limited to clusters of single returns.  An elevation value difference

raster for each of these tile/swath test areas is created for review.  The raster cells are color-

coded to indicate compliance (green) or non-compliance (red) with the USGS specifications.  In

addition, an attributed polygon shapefile is produced in the DPH-8 output sub-folder for the area

of each raster, with one feature (polygon) for each sample area, per USGS requirements.  The

table shown here is from the USGS NGP Lidar Base Specification 2021 rev. A document - it

lists the allowable 'Smooth surface repeatability, RMSDz' values (in meters) for the four defined

Quality Levels:

DPH-9.1 Overlap Consistency (interswath)

The purpose of this section is to show graphics of two distinct flight line separation rasters for all

of the data processed - a Measurable raster and a Swath Separation Image raster.  These

images show the vertical separation of flight lines by thematically coloring the separation

magnitude on a color ramp based on absolute distance.  This color thematic rendering is

modulated by intensity to show land cover features.  Color-coded elevation difference rasters of

the overlap areas are created for review, along with a frequency distribution chart of relative

accuracy RMSDz values of the Measurable raster pixels.  An attributed polygon shapefile is

also produced in the DPH-9_1 output sub-folder with one feature (polygon) for each test area,
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per USGS requirements.  The table shown here is from the USGS NGP Lidar Base

Specification 2021 rev. A document - it lists the allowable 'Swath overlap difference, RMSDz'

values (in meters) for the four defined Quality Levels:

For the Measurable separation raster, overlap areas are further refined before analysis by

creating clusters of single-return data at a minimum distance from any multiple-return data,

thereby ensuring that the areas analyzed are open and void of canopy cover, buildings, or other

obstacles.  Additionally, only areas of less than 10 degree slope are analyzed.  

For the Swath Separation Image raster (SSI), all returns are used and no cut-off is applied to the

maximum elevation difference shown.  In addition to a project-wide mosaicked raster, individual

tiled SSI rasters are produced and stored in a sub-folder named 'SSI' found in the 'DPH_9_1'

output folder.

There are two user-definable settings for the SSI raster portion of this test: 1.) an option to

choose either TIN or Grid (the default) as the basis for the difference calculations in the raster

(please see the notes in the DPH-9.1 section of the interface regarding TIN vs Grid), and; 2.) an

option for which returns - 'All' (the default), 'Single', or 'Last' - are used in the creation of the

raster.  Note that the current USGS specifications allow for any of these options to be used. 

DPH-9.2 Data Quality Measure - Overlap Consistency (interswath)

This section reports on an additional test not currently listed in the USGS NGP LBS 2021 rev. A
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specification. The reason for its inclusion is to prepare for expected future integration of the

USGS/ASPRS led development of interswath Data Quality Measure (DQM) and introduce the

usage of DQM testing to the lidar community.  This test is unchecked by default.

DQM analysis and reporting is intended to quantify the relative horizontal and vertical

errors observed between conjugate features in the overlapping regions of lidar data.

This test produces tabular data, an RMSDz frequency distribution chart and raster, and a

scatterplot of Point-to-Plane distances across the scan field of view.

Much more information on DQM can be found in the links below:

- General documentation: https://www.asprs.org/wp-content/uploads/
LidarInterswath_CleanCopyASPRSV2.pdf

- Equations: https://edcftp.cr.usgs.gov/project/rst/DQM/DQMDocumentation.docx

- Operational Testing: https://edcftp.cr.usgs.gov/project/rst/DQM/DQM_Operational_Testing%
202017-2-7.pptx

- Executable: https://edcftp.cr.usgs.gov/?dir=project/rst/DQM  

DPH-10 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)

against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing
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point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS

/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a TIN of the lidar ground data, along with a bar chart showing error

distribution; a table of NVA check points with point-by-point error and descriptive information as

compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a DEM grid of the lidar ground data, along with a bar chart showing

error distribution; point shapefiles of the check points with attributes including the Z value of the

surface and the Z error at each point's location; and screen captures of both the NVA and VVA

check points rendered thematically using color and relative error size on an Intensity view

background of the tiled lidar data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar tiled data.  A statement of total Withheld point count by class for all files is created

for review, along with a screen capture of the Withheld-flagged points for the tiled data.

DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the lidar tiled data.  A table of points by classification is

created for review, with any counts greater than zero (0) shown in red font for Classes 0, 7, and

18 (unless those points are bit-flagged as Withheld) to indicate non-compliance with the USGS

specifications.  If some Class 0, 7, and/or 18 points are flagged as Withheld but some are not,

those points counts will be shown in black with a red background.  Additionally, any points in

any classifications that are bit-flagged as Overlap will be reported in red font as this bit flag is no
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longer used for USGS data deliveries.

Model Key-points (if present) must be in either Class 2 (Ground) or in Class 8 (Reserved) and

the appropriate bit flag must be set to 'on'.  If Class 2 is used for Model Key-points, there can be

no points in Class 8.  If Class 8 is used for Model Key-points, all points must be bit-flagged

appropriately and there can be no points in Class 2 bit flagged as Model Key-point.  Any

violations of these Model Key-points requirements will be shown in red font.

Minimum required classes per the USGS specifications have their point totals in bold font.

Note, however, that some datasets may not have Low noise points (Class 7), Water points

(Class 9),  Bridge deck points (Class 17), High noise points (Class 18), Ignored ground points

(Class 20), Snow points (Class 21), or Temporal exclusion points (Class 22), depending on the

nature of the project.  Also, additional classes may be required on specific projects - non-zero

counts for these classes will be displayed with a yellow background.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes (including point count per Class)

populated for analysis and to aid in error correction (see Populate Statistics on Tile Scheme

topic for details).  The shapefile will be stored in the 'Statistics\Tile' sub-folder that is created in

the Output Folder as pathed out on the Input Tab .  If test DPH-1 Report on LAS Format is

also being run, the shapefile will be created during that test.

DPH-15 Report on Classification Consistency

The purpose of this section is to show a bare earth surface hillshade raster for classification

consistency inspection.  A bare earth hillshade screen capture is created for a visual review.

DPH-16 Report on Tiles

The purpose of this section is to report on the unallowed presence of polygon overlap in the

project tiling scheme.  A table of tiles by name/number with approximate width, approximate
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height, and overlap status is created for review.  Overlap reported as 'True' will be shown in red

font.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.3.5 Final Reports

USGS 2021 rev. A QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 2021 rev. A QC Module is written to two (2) PDF files – Detailed and Summary -

that contain the results of the point cloud, check points, and tile scheme analysis.  A one-page test

results summary table can be found immediately after the title page of each report, followed by the

individual test sections.  At the end of the individual test sections in the Detailed report, a page titled

'Time Spent On Each Step' will be created to show processing times in tabular and chart formats.

All tabular results are shown in Meters and also in either US Survey Feet or International Feet,

depending on the project units chosen on the Input Tab .  If either Meter or US Survey Feet is

selected, results will be listed as 'Meter/US Survey Feet'.  If International Feet is selected, results will be

listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_2021_All' but can be changed before running the module.  'Summary_' will be

appended to the summary report file name.  Both reports can be found in the Output Folder that was

1310
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chosen on the Input Tab .

Once processing is complete, the detailed report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for each of the 23 tests that can be run.  If any tests were unchecked by the user, a

listing of Skipped Tests will be appended to the end of both PDF reports followed by a printout of the

Input Requirement Matrix (see Input Datasets in the General Information  topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

2021 rev. A QC Module will also generate several raster images (JPEG and JPEG 2000 format),

shapefiles, and optional KML files that support the visual review of the analysis results.  The Output

Folder will also contain sub-folders named for each test that was run.  These will hold any rasters,

shapefiles, tables, interim PDFs, etc., that were created and used to build the final reports.  These sub-

folders can be deleted if no longer needed after the module has completed and the final PDFs are

generated. 

Sample Report Pages:

1310
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6.4 USGS 2020 rev. A QC Module

USGS 2020 rev. A QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP LBS - 2020 rev. A' QC Module (available at the Explorer QC and Production license
levels) can be accessed in a drop-down list as shown ...
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... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.4.1 General Information

USGS 2020 rev. A QC Module - General

Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP LBS - 2020 rev. A' quality control (QC) module in MARS® is to provide

an automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification 2020 rev. A from the U.S. Geological Survey (USGS).  The content of USGS NGP LBS
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1269



MARS® v2023.1           User Manual1338

© 2000-2023 Merrick & Company

2020 rev. A (August 2020) can be downloaded as a PDF.

Note that points flagged as 'Withheld', regardless of classification, will not be used in any

processing for this tool with the following exceptions:  tests DPH-12 and DPH-14 (see the Data

Processing/Handling Tab  topic).

There are 24 possible tests that can be run in the USGS 2020 rev. A QC Module.  The user can

customize QC tasks by selecting the individual QC standards that they wish to analyze.  The results of

the point cloud, check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed

and Summary - which include a one-page test results summary table, supporting raster analysis

images, tabular data, charts, and other statistical information.  See the Final Reports  sub-topic for

more information.

The USGS 2020 rev. A QC Module tests are divided into Collection  and Data Processing/Handling

 tabs as categorized in the USGS specifications document.  Please note that for non-quantitative

tests a visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP - Version 1.2 , and USGS

NGP - Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and

the Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or

Production (MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license

for an additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Classified (final filtered) LAS data (typically as tiled files)
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Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) that includes a

100-meter (or equivalent in other units) buffer, with at least one attribute field that contains

unique values

LiDAR Check Points (CSV or SHP file format)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-8 Smooth Surface Precision

(intraswath), DPH-10 Check Points, and DPH-11 Absolute Vertical Accuracy.  Many tests require the

existence or generation of swath LAS data files.  If any of these tests are selected to be run, a warning

prompt will appear when the 'Run' button is clicked.  Use the 'Browse' button to the right of the

'Generated Swaths' entry box to select a folder of existing project swaths, or a folder in which swaths will

be generated from the tiled data.  Optionally, check the 'Keep generated swaths when complete' box to

retain the existing or generated swaths at the end of the processing.

A matrix chart PDF of input data and available tests can be accessed by clicking the 'Input

Requirement Matrix' button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of
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any input shapefile or LiDAR Check Points CSV / SHP file.

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 2020 rev. A QC Module, just

as it must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data

pathed out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

Multi-threading
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A multi-threading option can be found on the USGS 2020 rev. A QC Module interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 2020 rev. A QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  Depending on the

'Output Folder' and 'Generated Swaths' folder selected (see Input Tab  for details), and whether data

exists in these folders from previous runs of this USGS 2020 rev. A QC Module, one or more of the

following pop-up messages may appear.  Reusing 'Statistics', 'Generated Swaths', and/or the 'Generated

Footprints Shapefile' will save processing time, but be sure that no changes have been made to any of

the input datasets before reusing any previously generated data.  To guarantee a completely 'fresh' run,

empty the 'Output Folder' and 'Generated Swaths' folders before running this module.

1.
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A 'Yes' answer will reuse previously generated statistics in the output folder path for both tiled and

swaths data.  Answering 'No' here will allow the 'Statistics' folder to be overwritten, and MARS® will then

check to see if LAS data exits in the 'Generated Swaths' folder as selected on the Input Tab .  If there

is data, the following message will appear:

2.

The user must decide if the pre-existing data is the correct generated swath data for the testing to be

conducted, and must ensure that no other LAS data exists in that folder.  If these conditions are true,

click 'Yes' - the 'Keep generated swaths when complete' box on the Input Tab  will be checked if it is

not already, and processing will continue.  If 'No' is clicked, the following message will appear:

3.

Clicking 'OK' for this message will clear out the selected 'Generated Swaths' folder and regenerate the

swaths as described in the Input Tab  section.  Finally, a check is done for an existing swath

footprints shapefile in the output folder path:
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4.

After clicking either 'Yes' or 'No', a pop-up may appear if any selected tests require data that has not

been pathed out on the Input Tab .  Dismiss the pop-up by clicking 'OK' and either uncheck the tests

that don't have supporting data or supply the path/name to the required file(s).  Click 'Run' again to re-

start the above pre-checks.

While running, the individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain

active, and a 'Cancel' button will appear if the user wants to terminate the process (note that the

cancellation may take several minutes).  However, no changes can be made to any entries on the tabs

once the 'Run' button is clicked.  There are two progress bars at the bottom of the interface - one for the

current step and one for the overall processing.  To the right of the 'Current Step' bar, information about

the current test number and total tests to be run will be displayed.  Tests may appear out of order and

the same test number may be displayed more than once due to grouping similar tasks together for

efficiency.  Any data and imagery loaded in the Table of Contents will be removed after the 'Run'

button is clicked, and the 'LAS Map View' window will be cleared once the USGS 2020 rev. A QC

Module begins the screen capture portion of the processing.

Settings Files

Every time the USGS 2020 rev. A QC Module is run, MARS® will generate an XML file containing the

settings used in the processing.  This file will be saved in the Output Folder specified on the Input Tab
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.  Each unique *.xml file name will contain the date and time that the module run was started as

seen in the example below.  For example, this particular run was started at 2:10:22 pm on September 9,

2021.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 2020 rev. A QC Module runs.  After opening the USGS 2020 rev. A QC

Module interface, click the 'Load Settings from File' button and navigate to an existing settings file to be

used.  Any individual parameters on any of the the interface tabs can be changed as needed before

starting the processing.  In addition, a settings file can be created and saved for future use without

actually running the USGS 2020 rev. A QC Module - make all the parameter entries on the various tabs

and click the 'Save Settings to File' button when finished.  Navigate to a folder to store the file as it will

not automatically be stored in the chosen Output Folder like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.4.2 Input Tab

USGS 2020 rev. A QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out, and includes entry fields for the Project Name and

optional Description, an optional Corporate (or organization) Logo that will appear on each page of the

final reports, Output Folder, and Output PDF File Name.  At a minimum - and depending on the

specific tests to be run - the Classified LAS data, Lidar Check Points and DPA Boundary, or Tile

Scheme must be included, along with a Project Name, Output Folder, and Output PDF File Name. 

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources - a unique Output Folder should also be used. 

Note that when both the Classified LAS data and Tile Scheme are used as inputs, the extents of the

tiled files in the Classified LAS Folder must match the extents of the tiles in the Tile Scheme.
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Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines

whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

Depending on the test(s) selected, a 'Generated Swaths' folder may need to be pathed out and, unless

there is LAS data already in the path, swaths will be automatically created in it by assembling files from

identical Point Source IDs in the Classified LAS (tiled) data.  For example, all points in all tiles in the

'Classified LAS Folder' that have a Point Source ID of 503 will be combined into one generated swath

named CS_00503.las (the 'CS' tag refers to 'Collection Scan').  These swaths are used as input for the

following tests:  C-2, C-3, C-4, C-5, C-6, DPH-8, and DPH-9.1.  An option to 'Keep generated swaths

when complete' is available to save time for additional QC Module runs that will use the same data, and/

or to preserve the LAS data for any other purpose.  Do not use the same folder for the 'Generated

Swaths' and the 'Output Folder' - this may cause the output results to be deleted.  Also, if using pre-

existing swath data that is not classified, some tests will not produce complete results.

The generated swaths will be used to create a swath footprints polygon shapefile in a sub-folder named

'Swath_footprints' in the selected Output Folder.  Attributes for beginning & ending Adjusted GPS

Times (GPS_MIN and GPS_MAX) for each swath - along with many other useful attributes - will be

stored for each swath footprint polygon.

If a 'Tile Scheme' and/or 'DPA Boundary' (Defined Project Area) shapefile is pathed out, unique-value

attribute fields must be chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname'

field for the 'DPA Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values

that exactly match the file names of the tiled files in the Classified LAS Folder.  The attribute values for

both of these shapefiles are used for identifying the tabular results of various tests in the final reports.
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If a polygon shapefile exists for water bodies (or any type of known exclusion areas), it can be pathed

out using the 'Browse' button to the right of the 'Exclusion Shapefile ' entry box.  These areas will be

omitted from the testing and analysis for tests C-4, C-5, C-6, DPH-9.1, and DPH-15 (see the Collection

Tab  and Data Processing/Handling Tab  topics).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification 2020 rev. A.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

2020 rev. A QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-10 Check Points and

DPH-11 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is
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enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option.

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.4.3 Collection Tab

USGS 2020 rev. A QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab
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Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section/

paragraph in the USGS NGP Lidar Base Specification 2020 rev. A in which they are referenced.  Note

that the following descriptions of what is created for these tests pertain primarily to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show tiled lidar coverage to the extent of the defined project

area (DPA) boundary.  A screen capture of the lidar tiled data with the DPA boundary
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superimposed is created for review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of multiple discrete lidar

returns in the LAS data.  Screen captures colored by the various return values, along with tables

of the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity values in

the LAS data.  Histograms, screen captures colored by intensity, and tables are created for

review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this section is to report on the lidar point density and nominal point spacing by

generated swath file.  Averages by swath files (not including overlap), project boundary polygons

(including swath overlap), and aggregate project boundary polygons (including swath overlap) are

reported in a table for review, along with a frequency distribution chart of density/spacing results.

 'Point Density' and 'NPS' values at the individual swath level are color-coded to indicate

compliance (green) or non-compliance (red) with the selected USGS specifications.

C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close

inspection must be done on the results to determine if the lidar coverage was collected and
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processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or

tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first listed example of lidar spatial distribution violations - problems in flight planning

or flight execution.  A close inspection must be done on the results to determine if the lidar

spatial distribution was collected and processed to meet the intended specifications.  A raster

of compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created

for review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-

null cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

1344



MARS® v2023.1           User Manual1352

© 2000-2023 Merrick & Company

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will improve the ratio of passing (green) cells to the total of all passing

and failing (red) cells, and cut down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow

depth map (by default) and other weather and land-area data for the extent of the lidar collection

at the time of acquisition.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.4.4 Data Processing/Handling Tab

USGS 2020 rev. A QC Module - Data Processing/
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Handling Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab

Check boxes and options for tests DPH-1 through DPH-16 are located on this tab.  By default, all tests

except DPH-2 and DPH-9.2 are checked ON to be run and can be controlled by the 'Check All On / Off'

buttons near the upper-right, or by checking/unchecking the individual boxes for the tests.  Tests are

generally named for the section and paragraph in the USGS NGP Lidar Base Specification 2020 rev. A in
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which they are referenced.  Note that the following descriptions of what is created for these tests pertain

primarily to the Detailed PDF report (see Final Reports ).  Summary PDF reports contain a

condensed version of the aggregate results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, general

information, and elevation by class test results for each tiled file.  Tables are created for review

for all four sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity' (reported on

per dataset), and 'Point Count with Bad Return Info'.  For 'WKT', fail codes are shown

as needed and those codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, Number of Duplicate Points, and Return

Counts in LAS Header.

In the Informational sub-section (DPH-1.3), the following items are reported on per

file: GPS Time min, GPS Time max, Extended Scan Angle, Scan Angle Rank,

Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

In the Elevation by Class sub-section (DPH-1.4), each tiled file is listed with the

classifications that exist for it along with the minimum and maximum elevations (Z

values) for each of those classes.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as
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appropriate.  Red items will be promoted to the top of the tables.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes populated for analysis and to aid in error

correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .

DPH-2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the lidar tiled data.  A

statement of waveform data file count is created for review.  This test is unchecked by default.

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar tiled

data.  A table of types (either Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the lidar tiled data.  A

table of horizontal and vertical datum names and associated EPSG codes is created for review.

File names are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications regarding the presence of datums.  Red items will be promoted to the top

of the table.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the

lidar tiled data.   A table of coordinate reference system names, Geoid Model names, and

associated EPSG codes is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

963
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promoted to the top of the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar tiled data.  A table of horizontal and vertical units is created for review.  File names are

color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications regarding the presence of both horizontal and vertical units.  Red items will be

promoted to the top of the table.

DPH-7 Report on File Source ID

The purpose of sub-section DPH-7.1 is to report on the File Source ID and Point Source ID

values for the lidar tiled data.  A table of File Source ID values is created for review, with the

specification being that File Source IDs shall be set to zero (0) for tiled data.  File Source IDs

are color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications.  Red items will be promoted to the top of the table.  In addition, sub-section 

DPH-7.2 reports on Swath Geographic Locations to indicate possible problems when a given

swath (generated based on Point Source IDs) exists in more than one contiguous geographic

location.  This may occur if a large water body (or other no-data area) crosses the swath to

separate the 'footprint' into two or more non-contiguous polygons.

DPH-8 Smooth Surface Precision (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations

within hard surfaced areas (for example, parking lots or large rooftops).  The slope of areas

selected for testing can be limited by using the 'Slope limit' entry box - the default is set to '3'

degrees.  Test areas are initially established by intersecting the Tile Scheme with the Non-

Vegetated Area (NVA) Check Points to determine which tiles will be used to clip out portions of
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the generated swaths for analysis.  Each of these tile/swath testing areas is further refined by

the 'Slope limit' and is also limited to clusters of single returns.  An elevation value difference

raster for each of these tile/swath test areas is created for review.  The raster cells are color-

coded to indicate compliance (green) or non-compliance (red) with the USGS specifications.  In

addition, an attributed polygon shapefile is produced in the DPH-8 output sub-folder for the area

of each raster, with one feature (polygon) for each sample area, per USGS requirements.  The

table shown here is from the USGS NGP Lidar Base Specification 2020 rev. A document - it

lists the allowable 'Smooth surface repeatability, RMSDz' values (in meters) for the four defined

Quality Levels:

DPH-9.1 Overlap Consistency (interswath)

The purpose of this section is to show graphics of two distinct flight line separation rasters for all

of the data processed - a Measurable raster and a Swath Separation Image raster.  These

images show the vertical separation of flight lines by thematically coloring the separation

magnitude on a color ramp based on absolute distance.  This color thematic rendering is

modulated by intensity to show land cover features.  Color-coded elevation difference rasters of

the overlap areas are created for review, along with a frequency distribution chart of relative

accuracy RMSDz values of the Measurable raster pixels.  An attributed polygon shapefile is

also produced in the DPH-9_1 output sub-folder with one feature (polygon) for each test area,

per USGS requirements.  The table shown here is from the USGS NGP Lidar Base

Specification 2020 rev. A document - it lists the allowable 'Swath overlap difference, RMSDz'

values (in meters) for the four defined Quality Levels:
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For the Measurable separation raster, overlap areas are further refined before analysis by

creating clusters of single-return data at a minimum distance from any multiple-return data,

thereby ensuring that the areas analyzed are open and void of canopy cover, buildings, or other

obstacles.  Additionally, only areas of less than 10 degree slope are analyzed.  

For the Swath Separation Image raster (SSI), all returns are used and no cut-off is applied to the

maximum elevation difference shown.  In addition to a project-wide mosaicked raster, individual

tiled SSI rasters are produced and stored in a sub-folder named 'SSI' found in the 'DPH_9_1'

output folder.

There are two user-definable settings for the SSI raster portion of this test: 1.) an option to

choose either TIN or Grid (the default) as the basis for the difference calculations in the raster

(please see the notes in the DPH-9.1 section of the interface regarding TIN vs Grid), and; 2.) an

option for which returns - 'All' (the default), 'First', or 'Last' - are used in the creation of the raster.

 Note that the USGS specifications call for all returns to be used. 

DPH-9.2 Data Quality Measure - Overlap Consistency (interswath)

This section reports on an additional test not currently listed in the USGS NGP LBS 2020 rev. A

specification. The reason for its inclusion is to prepare for expected future integration of the

USGS/ASPRS led development of interswath Data Quality Measure (DQM) and introduce the

usage of DQM testing to the lidar community.  This test is unchecked by default.
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DQM analysis and reporting is intended to quantify the relative horizontal and vertical

errors observed between conjugate features in the overlapping regions of lidar data.

This test produces tabular data, an RMSDz frequency distribution chart and raster, and a

scatterplot of Point-to-Plane distances across the scan field of view.

Much more information on DQM can be found in the links below:

- General documentation: https://www.asprs.org/wp-content/uploads/
LidarInterswath_CleanCopyASPRSV2.pdf

- Equations: https://edcftp.cr.usgs.gov/project/rst/DQM/DQMDocumentation.docx

- Operational Testing: https://edcftp.cr.usgs.gov/project/rst/DQM/DQM_Operational_Testing%
202017-2-7.pptx

- Executable: https://edcftp.cr.usgs.gov/?dir=project/rst/DQM  

DPH-10 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)

against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing

point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS

/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart
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showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a TIN of the lidar ground data, along with a bar chart showing error

distribution; a table of NVA check points with point-by-point error and descriptive information as

compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a DEM grid of the lidar ground data, along with a bar chart showing

error distribution; point shapefiles of the check points with attributes including the Z value of the

surface and the Z error at each point's location; and screen captures of both the NVA and VVA

check points rendered thematically using color and relative error size on an Intensity view

background of the tiled lidar data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar tiled data.  A statement of total Withheld point count by class for all files is created

for review, along with a screen capture of the Withheld-flagged points for the tiled data.

DPH-13 Use of the LAS Overlap Flag

The purpose of this section is to list the presence and quantities of points flagged as Overlap for

all the lidar tiled data.  A statement of total Overlap point count for all classes/all files is created

for review, along with a screen capture of the Overlap-flagged points for the tiled data.

DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the lidar tiled data.  A table of points by classification is

created for review, with any counts greater than zero (0) shown in red font for Classes 0, 7, and

18 (unless those points are bit-flagged as Withheld) to indicate non-compliance with the USGS

specifications.  If some Class 0, 7, and/or 18 points are flagged as Withheld but some are not,

those points counts will be shown in black with a red background.
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Model Key-points (if present) must be in either Class 2 (Ground) or in Class 8 (Reserved) and

the appropriate bit flag must be set to 'on'.  If Class 2 is used for Model Key-points, there can be

no points in Class 8.  If Class 8 is used for Model Key-points, all points must be bit-flagged

appropriately and there can be no points in Class 2 bit flagged as Model Key-point.  Any

violations of these Model Key-points requirements will be shown in red font.

Minimum required classes per the USGS specifications have their point totals in bold font.

Note, however, that some datasets may not have Low noise points (Class 7), Water points

(Class 9),  Bridge deck points (Class 17), High noise points (Class 18), Ignored ground points

(Class 20), Snow points (Class 21), or Temporal exclusion points (Class 22), depending on the

nature of the project.  Also, additional classes may be required on specific projects - non-zero

counts for these classes will be displayed with a yellow background.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes (including point count per Class)

populated for analysis and to aid in error correction (see Populate Statistics on Tile Scheme

topic for details).  The shapefile will be stored in the 'Statistics\Tile' sub-folder that is created in

the Output Folder as pathed out on the Input Tab .  If test DPH-1 Report on LAS Format is

also being run, the shapefile will be created during that test.

DPH-15 Report on Classification Consistency

The purpose of this section is to show a bare earth surface hillshade raster for classification

consistency inspection.  A bare earth hillshade screen capture is created for a visual review.

DPH-16 Report on Tiles

The purpose of this section is to report on the unallowed presence of polygon overlap in the

project tiling scheme.  A table of tiles by name/number with approximate width, approximate

height, and overlap status is created for review.  Overlap reported as 'True' will be shown in red

963
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font.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.4.5 Final Reports

USGS 2020 rev. A QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 2020 rev. A QC Module is written to two (2) PDF files – Detailed and Summary -

that contain the results of the point cloud, check points, and tile scheme analysis.  A one-page test

results summary table can be found immediately after the title page of each report, followed by the

individual test sections.  At the end of the individual test sections in the Detailed report, a page titled

'Time Spent On Each Step' will be created to show processing times in tabular and chart formats.

All tabular results are shown in Meters and also in either US Survey Feet or International Feet,

depending on the project units chosen on the Input Tab .  If either Meter or US Survey Feet is

selected, results will be listed as 'Meter/US Survey Feet'.  If International Feet is selected, results will be

listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_2020_All' but can be changed before running the module.  'Summary_' will be

appended to the summary report file name.  Both reports can be found in the Output Folder that was

chosen on the Input Tab .

1344
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Once processing is complete, the detailed report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for each of the 24 tests that can be run.  If any tests were unchecked by the user, a

listing of Skipped Tests will be appended to the end of both PDF reports followed by a printout of the

Input Requirement Matrix (see Input Datasets in the General Information  topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

2020 rev. A QC Module will also generate several raster images (JPEG and JPEG 2000 format),

shapefiles, and optional KML files that support the visual review of the analysis results.  The Output

Folder will also contain sub-folders named for each test that was run.  These will hold any rasters,

shapefiles, tables, interim PDFs, etc., that were created and used to build the final reports.  These sub-

folders can be deleted if no longer needed after the module has completed and the final PDFs are

generated. 

Sample Report Pages:

1337
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6.5 USGS 2.1 QC Module

USGS 2.1 QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP - Version 2.1' QC Module (available at the Explorer QC and Production license
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levels) can be accessed in a drop-down list as shown ...

... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.5.1 General Information

USGS 2.1 QC Module - General Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP - Version 2.1' quality control (QC) module in MARS® is to provide an

automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification Version 2.1 from the U.S. Geological Survey (USGS).  The content of USGS NGP Lidar

457
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Base Specification Version 2.1 (October 2019) can be downloaded as a PDF.

Note that points flagged as 'Withheld', regardless of classification, will not be used in any

processing for this tool with the following exceptions:  tests DPH-12 and DPH-14 (see the Data

Processing/Handling Tab  topic).

There are 24 possible tests that can be run in the USGS 2.1 QC Module.  The user can customize QC

tasks by selecting the individual QC standards that they wish to analyze.  The results of the point cloud,

check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed and Summary -

which include a one-page test results summary table, supporting raster analysis images, tabular data,

charts, and other statistical information.  See the Final Reports  sub-topic for more information.

The USGS 2.1 QC Module tests are divided into Collection  and Data Processing/Handling

tabs as categorized in the USGS specifications document.  Please note that for non-quantitative tests a

visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 1.3 , USGS NGP - Version 1.2 , and USGS NGP -

Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an

additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Classified (final filtered) LAS data (typically as tiled files)

Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

1387
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values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) that includes a

100-meter (or equivalent in other units) buffer, with at least one attribute field that contains

unique values

LiDAR Check Points (CSV or SHP file format)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-8 Smooth Surface Precision

(intraswath), DPH-10 Check Points, and DPH-11 Absolute Vertical Accuracy.  Many tests require the

existence or generation of swath LAS data files.  If any of these tests are selected to be run, a warning

prompt will appear when the 'Run' button is clicked.  Use the 'Browse' button to the right of the

'Generated Swaths' entry box to select a folder of existing project swaths, or a folder in which swaths will

be generated from the tiled data.  Optionally, check the 'Keep generated swaths when complete' box to

retain the existing or generated swaths at the end of the processing.

A matrix chart PDF of input data and available tests can be accessed by clicking the 'Input

Requirement Matrix' button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of



MARS® v2023.1           User Manual1374

© 2000-2023 Merrick & Company

any input shapefile or LiDAR Check Points CSV / SHP file.

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 2.1 QC Module, just as it

must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data pathed

out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

Multi-threading

1378
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A multi-threading option can be found on the USGS 2.1 QC Module tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 2.1 QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  Depending on the

'Output Folder' and 'Generated Swaths' folder selected (see Input Tab  for details), and whether data

exists in these folders from previous runs of this USGS 2.1 QC Module, one or more of the following pop-

up messages may appear.  Reusing 'Statistics', 'Generated Swaths', and/or the 'Generated Footprints

Shapefile' will save processing time, but be sure that no changes have been made to any of the input

datasets before reusing any previously generated data.  To guarantee a completely 'fresh' run, empty the

'Output Folder' and 'Generated Swaths' folders before running this module.

1.
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A 'Yes' answer will reuse previously generated statistics in the output folder path for both tiled and

swaths data.  Answering 'No' here will allow the 'Statistics' folder to be overwritten, and MARS® will then

check to see if LAS data exits in the 'Generated Swaths' folder as selected on the Input Tab .  If there

is data, the following message will appear:

2.

The user must decide if the pre-existing data is the correct generated swath data for the testing to be

conducted, and must ensure that no other LAS data exists in that folder.  If these conditions are true,

click 'Yes' - the 'Keep generated swaths when complete' box on the Input Tab  will be checked if it is

not already, and processing will continue.  If 'No' is clicked, the following message will appear:

3.

Clicking 'OK' for this message will clear out the selected 'Generated Swaths' folder and regenerate the

swaths as described in the Input Tab  section.  Finally, a check is done for an existing swath

footprints shapefile in the output folder path:

1378
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4.

After clicking either 'Yes' or 'No', a pop-up may appear if any selected tests require data that has not

been pathed out on the Input Tab .  Dismiss the pop-up by clicking 'OK' and either uncheck the tests

that don't have supporting data or supply the path/name to the required file(s).  Click 'Run' again to re-

start the above pre-checks.

While running, the individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain

active, and a 'Cancel' button will appear if the user wants to terminate the process (note that the

cancellation may take several minutes).  However, no changes can be made to any entries on the tabs

once the 'Run' button is clicked.  There are two progress bars at the bottom of the interface - one for the

current step and one for the overall processing.  To the right of the 'Current Step' bar, information about

the current test number and total tests to be run will be displayed.  Tests may appear out of order and

the same test number may be displayed more than once due to grouping similar tasks together for

efficiency.  Any data and imagery loaded in the Table of Contents will be removed after the 'Run'

button is clicked, and the 'LAS Map View' window will be cleared once the USGS 2.1 QC Module

begins the screen capture portion of the processing.

Settings Files

Every time the USGS 2.1 QC Module is run, MARS® will generate an XML file containing the settings

used in the processing.  This file will be saved in the Output Folder specified on the Input Tab .

1378
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Each unique *.xml file name will contain the date and time that the module run was started as seen in

the example below.  For example, this particular run was started at 4:06:51 pm on May 18, 2020.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 2.1 QC Module runs.  After opening the USGS 2.1 QC Module interface,

click the 'Load Settings from File' button and navigate to an existing settings file to be used.  Any

individual parameters on any of the the interface tabs can be changed as needed before starting the

processing.  In addition, a settings file can be created and saved for future use without actually running

the USGS 2.1 QC Module - make all the parameter entries on the various tabs and click the 'Save

Settings to File' button when finished.  Navigate to a folder to store the file as it will not automatically be

stored in the chosen Output Folder like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.5.2 Input Tab

USGS 2.1 QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum - and

depending on the specific tests to be run - the Classified LAS data, Lidar Check Points and DPA

Boundary, or Tile Scheme must be included, along with a Project Name, Output Folder, and Output

PDF File Name.  Each Input Dataset should be in a separate folder to ensure proper operation

and to avoid confusion when pathing out the various sources - a unique Output Folder should

also be used.  Note that when both the Classified LAS data and Tile Scheme are used as inputs, the

extents of the tiled files in the Classified LAS Folder must match the extents of the tiles in the Tile

Scheme.
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Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines

whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

Depending on the test(s) selected, a 'Generated Swaths' folder may need to be pathed out and, unless

there is LAS data already in the path, swaths will be automatically created in it by assembling files from

identical Point Source IDs in the Classified LAS (tiled) data.  For example, all points in all tiles in the

'Classified LAS Folder' that have a Point Source ID of 503 will be combined into one generated swath

named CS_00503.las (the 'CS' tag refers to 'Collection Scan').  These swaths are used as input for the

following tests:  C-2, C-3, C-4, C-5, C-6, DPH-8, and DPH-9.1.  An option to 'Keep generated swaths

when complete' is available to save time for additional QC Module runs that will use the same data, and/

or to preserve the LAS data for any other purpose.  Do not use the same folder for the 'Generated

Swaths' and the 'Output Folder' - this may cause the output results to be deleted.  Also, if using pre-

existing swath data that is not classified, some tests will not produce complete results.

The generated swaths will be used to create a swath footprints polygon shapefile in a sub-folder named

'Swath_footprints' in the selected Output Folder.  Attributes for beginning & ending Adjusted GPS

Times (GPS_MIN and GPS_MAX) for each swath - along with many other useful attributes - will be

stored for each swath footprint polygon.

If a 'Tile Scheme' and/or 'DPA Boundary' (Defined Project Area) shapefile is pathed out, unique-value

attribute fields must be chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname'

field for the 'DPA Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values

that exactly match the file names of the tiled files in the Classified LAS Folder.  The attribute values for
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both of these shapefiles are used for identifying the tabular results of various tests in the final reports.

If a polygon shapefile exists for water bodies (or any type of known exclusion areas), it can be pathed

out using the 'Browse' button to the right of the 'Exclusion Shapefile ' entry box.  These areas will be

omitted from the testing and analysis for tests C-4, C-5, C-6, DPH-9.1, and DPH-15 (see the Collection

Tab  and Data Processing/Handling Tab  topics).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification Version 2.1.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

2.1 QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-10 Check Points and

DPH-11 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

1382 1387
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space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.5.3 Collection Tab

USGS 2.1 QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab
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Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section/

paragraph in the USGS NGP Lidar Base Specification Version 2.1 in which they are referenced.  Note

that the following descriptions of what is created for these tests pertain primarily to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show tiled lidar coverage to the extent of the defined project

1396
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area (DPA) boundary.  A screen capture of the lidar tiled data with the DPA boundary

superimposed is created for review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of multiple discrete lidar

returns in the LAS data.  Screen captures colored by the various return values, along with tables

of the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity values in

the LAS data.  Histograms, screen captures colored by intensity, and tables are created for

review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this section is to report on the lidar point density and nominal point spacing by

generated swath file.  Averages by swath files (not including overlap), project boundary polygons

(including swath overlap), and aggregate project boundary polygons (including swath overlap) are

reported in a table for review, along with a frequency distribution chart of density/spacing results.

 'Point Density' and 'NPS' values at the individual swath level are color-coded to indicate

compliance (green) or non-compliance (red) with the selected USGS specifications.

C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close
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inspection must be done on the results to determine if the lidar coverage was collected and

processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or

tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first listed example of lidar spatial distribution violations - problems in flight planning

or flight execution.  A close inspection must be done on the results to determine if the lidar

spatial distribution was collected and processed to meet the intended specifications.  A raster

of compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created

for review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-
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null cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

When possible, using the 'Exclusion Shapefile' option described in the Input Tab  topic will

create a more accurate raster result than the 'Minimum Zero Count' method.  In either case, the

cells flagged as NODATA will improve the ratio of passing (green) cells to the total of all passing

and failing (red) cells, and cut down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow

depth map (by default) and other weather and land-area data for the extent of the lidar collection

at the time of acquisition.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.5.4 Data Processing/Handling Tab

USGS 2.1 QC Module - Data Processing/Handling

Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab

Check boxes and options for tests DPH-1 through DPH-16 are located on this tab.  By default, all tests
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except DPH-2 and DPH-9.2 are checked ON to be run and can be controlled by the 'Check All On / Off'

buttons near the upper-right, or by checking/unchecking the individual boxes for the tests.  Tests are

generally named for the section and paragraph in the USGS NGP Lidar Base Specification Version 2.1

in which they are referenced.  Note that the following descriptions of what is created for these tests

pertain primarily to the Detailed PDF report (see Final Reports ).  Summary PDF reports contain a

condensed version of the aggregate results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, general

information, and elevation by class test results for each tiled file.  Tables are created for review

for all four sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity' (reported on

per dataset), and 'Point Count with Bad Return Info'.  For 'WKT', fail codes are shown

as needed and those codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, Number of Duplicate Points, and Return

Counts in LAS Header.

In the Informational sub-section (DPH-1.3), the following items are reported on per

file: GPS Time min, GPS Time max, Extended Scan Angle, Scan Angle Rank,

Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

In the Elevation by Class sub-section (DPH-1.4), each tiled file is listed with the

classifications that exist for it along with the minimum and maximum elevations (Z

1396



Quality Control 1389

© 2000-2023 Merrick & Company

values) for each of those classes.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as

appropriate.  Red items will be promoted to the top of the tables.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes populated for analysis and to aid in error

correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .

DPH-2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the lidar tiled data.  A

statement of waveform data file count is created for review.  This test is unchecked by default.

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar tiled

data.  A table of types (either Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the lidar tiled data.  A

table of horizontal and vertical datum names and associated EPSG codes is created for review.

File names are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications regarding the presence of datums.  Red items will be promoted to the top

of the table.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the
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lidar tiled data.   A table of coordinate reference system names, Geoid Model names, and

associated EPSG codes is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar tiled data.  A table of horizontal and vertical units is created for review.  File names are

color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications regarding the presence of both horizontal and vertical units.  Red items will be

promoted to the top of the table.

DPH-7 Report on File Source ID

The purpose of sub-section DPH-7.1 is to report on the File Source ID and Point Source ID

values for the lidar tiled data.  A table of File Source ID values is created for review, with the

specification being that File Source IDs shall be set to zero (0) for tiled data.  File Source IDs

are color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications.  Red items will be promoted to the top of the table.  In addition, sub-section 

DPH-7.2 reports on Swath Geographic Locations to indicate possible problems when a given

swath (generated based on Point Source IDs) exists in more than one contiguous geographic

location.  This may occur if a large water body (or other no-data area) crosses the swath to

separate the 'footprint' into two or more non-contiguous polygons.

DPH-8 Smooth Surface Precision (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations

within hard surfaced areas (for example, parking lots or large rooftops).  The slope of areas
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selected for testing can be limited by using the 'Slope limit' entry box - the default is set to '3'

degrees.  Test areas are initially established by intersecting the Tile Scheme with the Non-

Vegetated Area (NVA) Check Points to determine which tiles will be used to clip out portions of

the generated swaths for analysis.  Each of these tile/swath testing areas is further refined by

the 'Slope limit' and is also limited to clusters of single returns.  An elevation value difference

raster for each of these tile/swath test areas is created for review.  The raster cells are color-

coded to indicate compliance (green) or non-compliance (red) with the USGS specifications.  In

addition, an attributed polygon shapefile is produced in the DPH-8 output sub-folder for the area

of each raster, with one feature (polygon) for each sample area, per USGS requirements.  The

table shown here is from the USGS NGP Lidar Base Specification Version 2.1 document - it

lists the allowable 'Smooth surface repeatability, RMSDz' values (in meters) for the four defined

Quality Levels:

DPH-9.1 Overlap Consistency (interswath)

The purpose of this section is to show graphics of two distinct flight line separation rasters for all

of the data processed - a Measurable raster and a Swath Separation Image raster.  These

images show the vertical separation of flight lines by thematically coloring the separation

magnitude on a color ramp based on absolute distance.  This color thematic rendering is

modulated by intensity to show land cover features.  Color-coded elevation difference rasters of

the overlap areas are created for review, along with a frequency distribution chart of relative

accuracy RMSDz values of the Measurable raster pixels.  An attributed polygon shapefile is

also produced in the DPH-9_1 output sub-folder with one feature (polygon) for each test area,

per USGS requirements.  The table shown here is from the USGS NGP Lidar Base
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Specification Version 2.1 document - it lists the allowable 'Swath overlap difference, RMSDz'

values (in meters) for the four defined Quality Levels:

For the Measurable separation raster, overlap areas are further refined before analysis by

creating clusters of single-return data at a minimum distance from any multiple-return data,

thereby ensuring that the areas analyzed are open and void of canopy cover, buildings, or other

obstacles.  Additionally, only areas of less than 10 degree slope are analyzed.  

For the Swath Separation Image raster (SSI), all returns are used and no cut-off is applied to the

maximum elevation difference shown.  In addition to a project-wide mosaicked raster, individual

tiled SSI rasters are produced and stored in a sub-folder named 'SSI' found in the 'DPH_9_1'

output folder.

There are two user-definable settings for the SSI raster portion of this test: 1.) an option to

choose either TIN or Grid (the default) as the basis for the difference calculations in the raster

(please see the notes in the DPH-9.1 section of the interface regarding TIN vs Grid), and; 2.) an

option for which returns - 'All' (the default), 'First', or 'Last' - are used in the creation of the raster.

 Note that the USGS specifications call for all returns to be used. 

DPH-9.2 Data Quality Measure - Overlap Consistency (interswath)

This section reports on an additional test not currently listed in the NGP USGS LBS v 2.1

specification. The reason for its inclusion is to prepare for expected future integration of the
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USGS/ASPRS led development of interswath Data Quality Measure (DQM) and introduce the

usage of DQM testing to the lidar community.  This test is unchecked by default.

DQM analysis and reporting is intended to quantify the relative horizontal and vertical

errors observed between conjugate features in the overlapping regions of lidar data.

This test produces tabular data, an RMSDz frequency distribution chart and raster, and a

scatterplot of Point-to-Plane distances across the scan field of view.

Much more information on DQM can be found in the links below:

- General documentation: https://www.asprs.org/wp-content/uploads/
LidarInterswath_CleanCopyASPRSV2.pdf

- Equations: https://edcftp.cr.usgs.gov/project/rst/DQM/DQMDocumentation.docx

- Operational Testing: https://edcftp.cr.usgs.gov/project/rst/DQM/DQM_Operational_Testing%
202017-2-7.pptx

- Executable: https://edcftp.cr.usgs.gov/?dir=project/rst/DQM  

DPH-10 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)

against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing

point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS
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/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a TIN of the lidar ground data, along with a bar chart showing error

distribution; a table of NVA check points with point-by-point error and descriptive information as

compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along with a bar chart

showing error distribution; a table of VVA check points with point-by-point error and descriptive

information as compared to a DEM grid of the lidar ground data, along with a bar chart showing

error distribution; point shapefiles of the check points with attributes including the Z value of the

surface and the Z error at each point's location; and screen captures of both the NVA and VVA

check points rendered thematically using color and relative error size on an Intensity view

background of the tiled lidar data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar tiled data.  A statement of total Withheld point count by class for all files is created

for review, along with a screen capture of the Withheld-flagged points for the tiled data.

DPH-13 Use of the LAS Overlap Flag

The purpose of this section is to list the presence and quantities of points flagged as Overlap for

all the lidar tiled data.  A statement of total Overlap point count for all classes/all files is created

for review, along with a screen capture of the Overlap-flagged points for the tiled data.

DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the lidar tiled data.  A table of points by classification is

created for review, with any counts greater than zero (0) shown in red font for Classes 0, 7, and

18 (unless those points are bit-flagged as Withheld) to indicate non-compliance with the USGS
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specifications.  If some Class 0, 7, and/or 18 points are flagged as Withheld but some are not,

those points counts will be shown in black with a red background.

Model Key-points (if present) must be in either Class 2 (Ground) or in Class 8 (Reserved) and

the appropriate bit flag must be set to 'on'.  If Class 2 is used for Model Key-points, there can be

no points in Class 8.  If Class 8 is used for Model Key-points, all points must be bit-flagged

appropriately and there can be no points in Class 2 bit flagged as Model Key-point.  Any

violations of these Model Key-points requirements will be shown in red font.

Minimum required classes per the USGS specifications have their point totals in bold font.

Note, however, that some datasets may not have Low noise points (Class 7), Water points

(Class 9),  Bridge deck points (Class 17), High noise points (Class 18), Ignored ground points

(Class 20), Snow points (Class 21), or Temporal exclusion points (Class 22), depending on the

nature of the project.  Also, additional classes may be required on specific projects - non-zero

counts for these classes will be displayed with a yellow background.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes (including point count per Class)

populated for analysis and to aid in error correction (see Populate Statistics on Tile Scheme

topic for details).  The shapefile will be stored in the 'Statistics\Tile' sub-folder that is created in

the Output Folder as pathed out on the Input Tab .  If test DPH-1 Report on LAS Format is

also being run, the shapefile will be created during that test.

DPH-15 Report on Classification Consistency

The purpose of this section is to show a bare earth surface hillshade raster for classification

consistency inspection.  A bare earth hillshade screen capture is created for a visual review.

DPH-16 Report on Tiles

The purpose of this section is to report on the unallowed presence of polygon overlap in the
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project tiling scheme.  A table of tiles by name/number with approximate width, approximate

height, and overlap status is created for review.  Overlap reported as 'True' will be shown in red

font.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.5.5 Final Reports

USGS 2.1 QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 2.1 QC Module is written to two (2) PDF files – Detailed and Summary - that

contain the results of the point cloud, check points, and tile scheme analysis.  A one-page test results

summary table can be found immediately after the title page of each report, followed by the individual

test sections.  At the end of the individual test sections in the Detailed report, a page titled 'Time Spent

On Each Step' will be created to show processing times in tabular and chart formats.

All tabular results are shown in Meters and also in either US Survey Feet or International Feet,

depending on the project units chosen on the Input Tab .  If either Meter or US Survey Feet is

selected, results will be listed as 'Meter/US Survey Feet'.  If International Feet is selected, results will be

listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_2_1_All' but can be changed before running the module.  'Summary_' will be

1378
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appended to the summary report file name.  Both reports can be found in the Output Folder that was

chosen on the Input Tab .

Once processing is complete, the detailed report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for each of the 24 tests that can be run.  If any tests were unchecked by the user, a

listing of Skipped Tests will be appended to the end of both PDF reports followed by a printout of the

Input Requirement Matrix (see Input Datasets in the General Information  topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

2.1 QC Module will also generate several raster images (JPEG and JPEG 2000 format), shapefiles, and

optional KML files that support the visual review of the analysis results.  The Output Folder will also

contain sub-folders named for each test that was run.  These will hold any rasters, shapefiles, tables,

interim PDFs, etc., that were created and used to build the final reports.  These sub-folders can be

deleted if no longer needed after the module has completed and the final PDFs are generated. 

Sample Report Pages:

1378
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.6 USGS 1.3 QC Module

USGS 1.3 QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP - Version 1.3' QC Module (available at the Explorer QC and Production license
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levels) can be accessed in a drop-down list as shown ...

  

... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear. 

© 2000-2023 Merrick & Company. All Rights Reserved.

6.6.1 General Information

USGS 1.3 QC Module - General Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP - Version 1.3' quality control (QC) module in MARS® is to provide an

automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification Version 1.3 from the U.S. Geological Survey (USGS).  The primary intent of this USGS

lidar specification is to create consistency across all of USGS’s National Geospatial Program (NGP)
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funded lidar data collections, in particular those undertaken in support of the 3D Elevation Program

(3DEP).  As mentioned in the specification, "Unlike most other lidar data procurement specifications,

which largely focus on the products derived from lidar data such as the bare-earth digital elevation model

(DEM), this specification places particular emphasis on the handling of the source lidar data."  Note that

points flagged as 'Withheld', regardless of classification, will not be used in any processing for

this tool with the following exceptions:  tests DPH-12 and DPH-14 (see the Data Processing/

Handling Tab  topic).

There are 24 possible tests that can be run in the USGS 1.3 QC Module.  The user can customize QC

tasks by selecting the individual QC standards that they wish to analyze. The results of the point cloud,

check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed and Summary -

which include a one-page test results summary table, supporting raster analysis images, tabular data,

charts, and other statistical information.  See the Final Reports  sub-topic for more information.

For a copy of the USGS NGP Lidar Base Specification Version 1.3 (February 2018), please click this

link to access the PDF file (approximately 4.5 MB).  This document explains the requirements and

expectations of each test.  The USGS 1.3 QC Module tests are divided into Collection  and Data

Processing/Handling  tabs and are ordered to match the USGS specifications document.  Please

note that for non-quantitative tests a visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.2 , and USGS NGP -

Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an
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additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Classified (final filtered) LAS data (typically as tiled files)

Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) with at least one

attribute field that contains unique values

LiDAR Check Points (CSV or SHP file)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-10 (Check Points) and DPH-11

(Absolute Vertical Accuracy).  A matrix chart PDF of input data and available tests can be accessed by

clicking the 'Input Requirement Matrix' button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of

any input shapefile or LiDAR Check Points CSV / SHP file.
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Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 1.3 QC Module, just as it

must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data pathed

out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

Multi-threading

A multi-threading option can be found on the USGS 1.3 QC Module tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

1412
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control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 1.3 QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  Depending on the

'Output Folder' and 'Generated Swaths' folder selected (see Input Tab  for details), and whether data

exists in these folders from previous runs of this USGS 1.3 QC Module, one or more of the following pop-

up messages may appear.  Reusing 'Statistics', 'Generated Swaths', and/or the 'Generated Footprints

Shapefile' will save processing time, but be sure that no changes have been made to any of the input

datasets before reusing any previous data.  To guarantee a completely 'fresh' run, empty the 'Output

Folder' and 'Generated Swaths' folder before running this module.

1.

A 'Yes' answer will assume that any 'Generated Swaths' data is to be reused as well, and MARS® will

1412 1416
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proceed to the next data check, testing for existing generated footprints shapefile data (skip to graphic #

4 - 'Do you want to use previously generated footprints shapefile?', below).

Answering 'No' here will allow the 'Statistics' folder to be overwritten, and MARS® will then check to see

if LAS data exits in the 'Generated Swaths' folder as selected on the Input Tab .  If there is data, the

following message will appear:

2.

The user must decide if the pre-existing data is the correct generated swath data for the testing to be

conducted, and must ensure that no other LAS data exists in that folder.  If these conditions are true,

click 'Yes' - the 'Keep generated swaths when complete' box on the Input Tab  will be checked if it is

not already, and processing will continue.  If 'No' is clicked, the following message will appear:

3.

Clicking 'OK' for this message will clear out the selected 'Generated Swaths' folder and regenerate the

swaths as described in the Input Tab  section.

1412
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4.

After clicking either 'Yes' or 'No', a pop-up may appear if any selected tests require data that has not

been pathed out on the Input Tab .  Dismiss the pop-up by clicking 'OK' and either uncheck the tests

that don't have supporting data or supply the path/name to the required file(s).  Click 'Run' again to re-

start the above pre-checks.

While running, the individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain

active, and a 'Cancel' button will appear if the user wants to terminate the process (note that the

cancellation may take several minutes).  However, no changes can be made to any entries on the tabs

once the 'Run' button is clicked.  There are two progress bars at the bottom of the interface - one for the

current step and one for the overall processing.  To the right of the 'Current Step' bar, information about

the current test number and total tests to be run will be displayed.  Tests may appear out of order and

the same test number may be displayed more than once due to grouping similar tasks together for

efficiency.  Any data and imagery loaded in the Table of Contents will be removed after the 'Run'

button is clicked, and the 'LAS Map View' window will be cleared once the USGS 1.3 QC Module

begins the screen capture portion of the processing.

Settings Files

Every time the USGS 1.3 QC Module is run, MARS® will generate an XML file containing the settings

used in the processing.  This file will be saved in the Output Folder specified on the Input Tab .

Each unique *.xml file name will contain the date and time that the module run was started as seen in

1412
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the example below.  For example, this particular run was started at 10:22:27 am on June 18, 2018.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 1.3 QC Module runs.  After opening the USGS 1.3 QC Module interface,

click the 'Load Settings from File' button and navigate to an existing settings file to be used.  Any

individual parameters on any of the the interface tabs can be changed as needed before starting the

processing.  In addition, a settings file can be created and saved for future use without actually running

the USGS 1.3 QC Module - make all the parameter entries on the various tabs and click the 'Save

Settings to File' button when finished.  Navigate to a folder to store the file as it will not automatically be

stored in the chosen Output Folder like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.6.2 Input Tab

USGS 1.3 QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum - and

depending on the specific tests to be run - the Classified LAS data, Lidar Check Points and DPA

Boundary, or Tile Scheme must be included, along with a Project Name, Output Folder, and Output

PDF File Name.  Each Input Dataset should be in a separate folder to ensure proper operation

and to avoid confusion when pathing out the various sources - a unique Output Folder should

also be used.  Note that when both the Classified LAS data and Tile Scheme are used as inputs, the

extents of the tiled files in the Classified LAS Folder must match the extents of the tiles in the Tile

Scheme.
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Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines

whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

A 'Generated Swaths' folder must be pathed out and, unless there is LAS data already in the path,

swaths will be automatically created in it by assembling files from identical Point Source IDs in the

Classified LAS data.  For example, all points in all tiles in the 'Classified LAS Folder' that have a Point

Source ID of 503 will be combined into one generated swath named CS_00503.las (the 'CS' tag means

'Collection Scan').  These swaths are used as input for some of the tests (see the final PDF reports for

details).  An option to 'Keep generated swaths when complete' is available to save time for additional QC

Module runs that will use the same data, and/or to preserve the LAS data for any other purpose.  Do not

use the same folder for the 'Generated Swaths' and the 'Output Folder' - this may cause the output

results to be deleted.  Also, if using pre-existing swath data that is not classified, some tests will

not produce complete results.

The generated swaths will be used to create a swath footprints polygon shapefile in a sub-folder named

'Swath_footprints' in the selected Output Folder.  Attributes for beginning & ending Adjusted GPS

Times (GPS_MIN and GPS_MAX) for each swath - along with many other useful attributes - will be

stored for each swath footprint polygon.

If a 'Tile Scheme' and/or 'DPA Boundary' (Defined Project Area) shapefile is pathed out, unique-value

attribute fields must be chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname'

field for the 'DPA Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values

that exactly match the file names of the tiled files in the Classified LAS Folder.  The attribute values for



Quality Control 1415

© 2000-2023 Merrick & Company

both of these shapefiles are used for identifying the tabular results of various tests in the final reports. 

Unless an optional custom BPA (Buffered Project Area) boundary shapefile is pathed out, MARS® will

generate a 100-meter BPA boundary for test C-1 (see Collection Tab ).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification Version 1.3.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

1.3 QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-10 Check Points and

DPH-11 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

1416
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temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.6.3 Collection Tab

USGS 1.3 QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab
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Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section

and paragraph in the USGS NGP Lidar Base Specification Version 1.3 in which they are referenced.

Note that the following descriptions of what is created for these tests pertain primarily to the Detailed

PDF report (see Final Reports ).  Summary PDF reports contain a condensed version of the

aggregate results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show tiled lidar coverage to the extent of a 100 meter buffer

beyond the defined project area boundary.  A screen capture of the lidar tiled data with the DPA

1430
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(defined project area) and BPA (buffered project area) boundaries superimposed is created for

review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of multiple discrete lidar

returns in the LAS data.  Screen captures colored by the various return values, along with tables

of the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity values in

the LAS data.  Histograms, screen captures colored by intensity, and tables are created for

review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this sub-section C-4 is to report on the lidar point density and nominal point

spacing by generated swath file.  Averages by swath files (not including overlap), project

boundary polygons (including swath overlap), and aggregate project boundary polygons

(including swath overlap) are reported in a table for review, along with a frequency distribution

chart of density/spacing results.  'Point Density' and 'NPS' values are color-coded to indicate

compliance (green) or non-compliance (red) with the selected USGS specifications.

In addition, the results of supplemental point density testing methods are presented in the

(optional) sub-section C-4.2.  These include Nyquist Sampling (using a grid cell size that is 2x

the required NPS), and grid cell sizes of 1m, 10m, 100m, and 1km.  These supplementary

results are presented in both raster and tabular form, with and without overlap bit-flagged points

included. 
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C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close

inspection must be done on the results to determine if the lidar coverage was collected and

processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

The other option is 'Exclusion Shapefile', where a pre-existing polygon shapefile of allowable

exclusion areas can be pathed out so that all the raster cells within those polygons will be set

to a value of NODATA.  Using this option, when feasible, will create a more accurate raster

result than the 'Minimum Zero Count' method.  In either case, the cells flagged as NODATA will

cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or
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tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first listed example of lidar spatial distribution violations - problems in flight planning

or flight execution.  A close inspection must be done on the results to determine if the lidar

spatial distribution was collected and processed to meet the intended specifications.  A raster

of compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created

for review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-

null cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells.  The

other option is 'Exclusion Shapefile', where a pre-existing polygon shapefile of allowable

exclusion areas can be pathed out so that all the raster cells within those polygons will be set

to a value of NODATA.  Using this option, when feasible, will create a more accurate raster

result than the 'Minimum Zero Count' method.  In either case, the cells flagged as NODATA will

improve the ratio of passing (green) cells to the total of all passing and failing (red) cells, and cut

down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow
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depth map (by default) and other weather and land-area data for the extent of the lidar collection

at the time of acquisition.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.6.4 Data Processing/Handling Tab

USGS 1.3 QC Module - Data Processing/Handling

Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab
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Check boxes and options for tests DPH-1 through DPH-16 are located on this tab.  By default, all tests

are checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right,

or by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section

and paragraph in the USGS NGP Lidar Base Specification Version 1.3 in which they are referenced.

Note that the following descriptions of what is created for these tests pertain primarily to the Detailed

PDF report (see Final Reports ).  Summary PDF reports contain a condensed version of the

aggregate results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, general

information, and elevation by class test results for each tiled file.  Tables are created for review

1430
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for all four sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity' (reported on

per dataset), and 'Point Count with Bad Return Info'.  For 'WKT', fail codes are shown

as needed and those codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, Number of Duplicate Points, and Return

Counts in LAS Header.

In the Informational sub-section (DPH-1.3), the following items are reported on per

file: GPS Time min, GPS Time max, Extended Scan Angle, Scan Angle Rank,

Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

In the Elevation by Class sub-section (DPH-1.4), each tiled file is listed with the

classifications that exist for it along with the minimum and maximum elevations (Z

values) for each of those classes.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as

appropriate.  Red items will be promoted to the top of the tables.  This test also generates a

polygon shapefile of the tiles with hundreds of attributes populated for analysis and to aid in error

correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .

DPH-2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the lidar tiled data.  A

963
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statement of waveform data file count is created for review.

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar tiled

data.  A table of types (either Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the lidar tiled data.  A

table of horizontal and vertical datum names and associated EPSG codes is created for review.

File names are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications regarding the presence of datums.  Red items will be promoted to the top

of the table.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the

lidar tiled data.   A table of coordinate reference system names, Geoid Model names, and

associated EPSG codes is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar tiled data.  A table of horizontal and vertical units is created for review.  File names are

color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications regarding the presence of both horizontal and vertical units.  Red items will be

promoted to the top of the table.
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DPH-7 Report on File Source ID

The purpose of sub-section DPH-7.1 is to report on the File Source ID and Point Source ID

values for the lidar tiled data.  A table of File Source ID values is created for review, with the

specification being that File Source IDs shall be set to zero (0) for tiled data.  File Source IDs

are color-coded to indicate compliance (green) or non-compliance (red) with the USGS

specifications.  Red items will be promoted to the top of the table.  In addition, sub-section 

DPH-7.2 reports on Swath Geographic Locations to indicate possible problems when a given

swath (generated based on Point Source IDs) exists in more than one contiguous geographic

location.  This may occur if a large water body (or other no-data area) crosses the swath to

separate the 'footprint' into two or more non-contiguous polygons.

DPH-8 Smooth Surface Precision (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations

within hard surfaced areas (for example, parking lots or large rooftops).  The slope of areas

selected for testing can be limited by using the 'Slope limit' entry box - the default is set to '3'

degrees.  Test areas are initially established by intersecting the Tile Scheme with the Non-

Vegetated Area (NVA) Check Points to determine which tiles will be used to clip out portions of

the generated swaths for analysis.  Each of these tile/swath testing areas is further refined by

the 'Slope limit' and is also limited to clusters of single returns.  An elevation value difference

raster for each of these tile/swath test areas is created for review.  The raster cells are color-

coded to indicate compliance (green) or non-compliance (red) with the USGS specifications.  In

addition, an attributed polygon shapefile is produced in the DPH-8 output sub-folder for the area

of each raster, with one feature (polygon) for each sample area, per USGS requirements.  The

table shown here is from the USGS NGP Lidar Base Specification Version 1.3 document - it

lists the allowable 'Smooth surface repeatability, RMSDz' values (in meters) for the four defined
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Quality Levels:

DPH-9.1 Overlap Consistency (interswath)

The purpose of this section is to show a graphic of the flight line separation raster for all of the

data processed.  This grid/image shows the vertical separation of flight lines by thematically

coloring the separation magnitude on a color ramp based on absolute distance.  This color

thematic rendering is modulated by intensity to show land cover features.  A color-coded

elevation difference raster of the overlap areas is created for review, along with a table of relative

accuracy RMSDz values for those areas and a frequency distribution chart of the values.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  An attributed polygon shapefile is also produced in the DPH-9_1 output

sub-folder with one feature (polygon) for each test area, per USGS requirements.  The table

shown here is from the USGS NGP Lidar Base Specification Version 1.3 document - it lists the

allowable 'Swath overlap difference, RMSDz' values (in meters) for the four defined Quality

Levels:
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Before analysis, overlap areas are further refined by either:  1) creating clusters of single-return

data at a minimum distance from any multiple-return data, thereby ensuring that the areas

analyzed are open and void of canopy cover, buildings, or other obstacles.  This is the default

method, and all classes are initially selected.  2) limiting the data to be analyzed to the ground

classification (Class 2 by default).  Another class (or classes) may be selected if ground is not

in Class 2.  

There are two other user-definable settings for this test: An option to save the elevation

difference raster that is used to calculate the RMSDz values in a TIFF file format, and an option

to choose either TIN or Grid as the basis for the difference calculations.  The TIFF raster allows

for individual cell inspection of elevation difference values.  The TIN/Grid selector (TIN by default)

determines the method used to calculate the elevation differences.  Please see the notes on

this option in the DPH-9.1 section of the interface.

DPH-9.2 DQM - Overlap Consistency (interswath)

This section reports on an additional test not currently listed in the NGP USGS LBS v 1.3. The

reason for its inclusion is to prepare for expected future integration of the USGS/ASPRS led

development of interswath Data Quality Measures (DQM) and introduce the usage of DQM

testing to the lidar community.
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DQM analysis and reporting is intended to quantify the relative horizontal and vertical

errors observed between conjugate features in the overlapping regions of lidar data.

This test produces tabular data, an RMSDz frequency distribution chart and raster, and a

scatterplot of Point-to-Plane distances across the scan field of view.

Much more information on DQM can be found in the links below:

- General documentation: https://www.asprs.org/wp-content/uploads/
LidarInterswath_CleanCopyASPRSV2.pdf

- Equations: https://edcftp.cr.usgs.gov/project/rst/DQM/DQMDocumentation.docx

- Operational Testing: https://edcftp.cr.usgs.gov/project/rst/DQM/DQM_Operational_Testing%
202017-2-7.pptx

- Executable: https://edcftp.cr.usgs.gov/?dir=project/rst/DQM  

DPH-10 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)

against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing

point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS

/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart
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showing error distribution; a table of NVA check points with point-by-point error and descriptive

information as compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along

with a bar chart showing error distribution; a table of VVA check points with point-by-point error

and descriptive information as compared to a DEM grid of the lidar ground data, along with a bar

chart showing error distribution; point shapefiles of the check points with attributes including the

Z value of the surface and the Z error at each point's location; and screen captures of both the

NVA and VVA check points rendered thematically using color and relative error size on an

Intensity view background of the lidar data - NVA with the swath data and VVA with the tiled

data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar tiled data.  A statement of total Withheld point count for all classes/all files) is

created for review, along with screen captures of the Withheld-flagged points for the tiled data.

DPH-13 Use of the LAS Overlap Flag

The purpose of this section is to list the presence and quantities of points flagged as Overlap for

all the lidar tiled data.  A statement of total Overlap point count for all classes/all files is created

for review, along with screen captures of the Overlap-flagged points for the tiled data.

DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the lidar tiled data.  A table of points by classification is

created for review, with any counts greater than zero (0) shown in red font for Class 0 (unless

those points are bit-flagged as Withheld) to indicate non-compliance with the USGS

specifications.  If some Class 0 points are flagged as Withheld but some are not, those points

counts will be shown in black with a red background.  Any points outside of Class 2 (Ground)

that are flagged as Model Key-points will also be shown in red font.  Minimum required classes
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per the USGS specifications have their point totals in bold font.  Note, however, that some

datasets may not have Low noise points (Class 7), Water points (Class 9),  Bridge deck points

(Class 17), High noise points (Class 18), Ignored ground points (Class 20), Snow points (Class

21), or Temporal exclusion points (Class 22), depending on the nature of the project.  Also,

additional classes may be required on specific projects - non-zero counts for these classes will

be displayed with a yellow background.  This test also generates a polygon shapefile of the tiles

with hundreds of attributes (including point count per Class) populated for analysis and to aid in

error correction (see Populate Statistics on Tile Scheme  topic for details).  The shapefile will

reside in the 'Statistics' sub-folder that is created in the Output Folder as pathed out on the

Input Tab .  If test DPH-1 Report on LAS Format is also being run, the shapefile will be

created during that test.

DPH-15 Report on Classification Consistency

The purpose of this section is to show a bare earth surface hillshade raster for classification

consistency inspection.  A bare earth hillshade screen capture is created for a visual review.

DPH-16 Report on Tiles

The purpose of this section is to report on the unallowed presence of polygon overlap in the

project tiling scheme.  A table of tiles by name/number with approximate width, approximate

height, and overlap status is created for review.  Overlap reported as 'True' will be shown in red

font.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.6.5 Final Reports

USGS 1.3 QC Module - Final Reports
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Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 1.3 QC Module is written to two (2) PDF files – Detailed and Summary - that

contain the results of the point cloud, check points, and tile scheme analysis.  A one-page test results

summary table can be found immediately after the title page of each report, followed by the individual

test sections.  At the end of the individual test sections in the Detailed report, a page titled 'Time Spent

On Each Step' will be created to show processing times in tabular and chart formats.

All tabular results are shown in Meters and also in either US Survey Feet or International Feet,

depending on the project units chosen on the Input Tab .  If either Meter or US Survey Feet is

selected, results will be listed as 'Meter/US Survey Feet'.  If International Feet is selected, results will be

listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_1_3_All' but can be changed before running the module.  'Summary_' will be

appended to the summary report file name.  Both reports can be found in the Output Folder that was

chosen on the Input Tab .

Once processing is complete, the detailed report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for each of the 24 tests that can be run.  If any tests were unchecked by the user, a

listing of Skipped Tests will be appended to the end of both PDF reports followed by a printout of the

Input Requirement Matrix (see Input Datasets in the General Information  topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

1412
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1.3 QC Module will also generate several raster images (JPEG and JPEG 2000 format), shapefiles, and

optional KML files that support the visual review of the analysis results.  The Output Folder will also

contain sub-folders named for each test that was run.  These will hold any rasters, shapefiles, tables,

interim PDFs, etc., that were created and used to build the final reports.  These sub-folders can be

deleted if no longer needed after the module has completed and the final PDFs are generated. 

Sample Report Pages:
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.7 USGS 1.2 QC Module

USGS 1.2 QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software
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The 'USGS NGP - Version 1.2' QC Module (available at the Explorer QC and Production license

levels) can be accessed in a drop-down list as shown ...

  

... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.4

LAS files.  If earlier versions of LAS data are pathed out, a pop-up warning will appear. 

© 2000-2023 Merrick & Company. All Rights Reserved.

6.7.1 General Information

USGS 1.2 QC Module - General Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP - Version 1.2' quality control (QC) module in MARS® is to provide an

automated tool for verifying compliance of LAS v1.4 lidar point cloud datasets to the Lidar Base

Specification Version 1.2 from the U.S. Geological Survey (USGS).  The primary intent of this updated

457
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USGS lidar specification is to create consistency across all of USGS’s National Geospatial Program

(NGP) funded lidar data collections, in particular those undertaken in support of the National Elevation

Dataset (NED) and the 3D Elevation Program (3DEP).  Unlike most other “lidar specs,” which focus on

the derived bare-earth digital elevation model (DEM) product, this specification primarily focuses on the

collection, processing, and handling of the source lidar point cloud data.  Note that points flagged as

'Withheld', regardless of classification, will not be used in any processing for this tool with the

following exceptions:  tests DPH-12 and DPH-14 (see the Data Processing/Handling Tab  topic).

There are 26 possible tests that can be run in the USGS 1.2 QC Module.  The user can customize QC

tasks by selecting the individual QC standards that they wish to analyze. The results of the point cloud,

check points, and tile scheme analysis are contained in two (2) PDF reports – Detailed and Summary -

along with supporting raster analysis images, tabular data, and other statistical information.  See the 

Final Reports  sub-topic for more information.

For a copy of the USGS NGP Lidar Base Specification Version 1.2 (November 2014), please click this

link to access the PDF file (approximately 2.1 MB).  This document explains the requirements and

expectations of each test.  The USGS 1.2 QC Module tests are divided into Collection  and Data

Processing/Handling  tabs and are ordered to match the USGS specifications document.  Please

note that for non-quantitative tests a visual inspection of the data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , and USGS NGP -

Version 1.0  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an
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additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Swath LAS data (also referred to as collection scan)

Classified (final filtered) LAS data (typically as tiled files)

Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name attribute whose

values exactly match the file names of the Classified data files.  In addition, the tiles in the Tile

Scheme must match the extents of the tiled files in the Classified LAS data.

DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) with at least one

attribute field that contains unique values

LiDAR Check Points (CSV or SHP file)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if a LiDAR Check

Points file is not available, the module will not be able to run tests DPH-11.2 (Report on Check Points)

and DPH-11.3 (Report on Absolute Vertical Accuracy).  A matrix chart PDF of input data and available

tests can be accessed by clicking the 'Input Requirement Matrix' button at the top of the module

interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of
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any  input shapefile, SBET file, or LiDAR Check Points CSV or SHP file.

Swath (also referred to as flight line or collection scan) and Classified (also

referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 1.2 QC Module, just as it

must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data pathed

out in the 'Swath LAS Folder' or 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add

Spatial Index' process, the following window will pop up to explain the options.  See also Add Spatial

Index .  Multi-threading the Spatial Indexing functions across a USB 2.0 connection is not

recommended as the intensive file reads/writes (disk I/O) may cause hangs or slower overall

performance than single-threading.  USB 3.0 or later can be used, but may be limited in performance

depending on the access speed of the external drive.

If the 'Add Spatial Index to original files' option is chosen (the 'permanent' indexing option), a second

1443
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dialog will open when the 'OK' button is clicked:

This window allows new collection scan numbers to be assigned to the files.  The default is to retain

existing numbering.

Multi-threading

A multi-threading option can be found on the USGS 1.2 QC Module tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the
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process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 1.2 QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  A pop-up may appear

if any selected tests require data that has not been pathed out on the Input Tab .  While running, the

individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain active, and a

'Cancel' button will appear if the user wants to terminate the process (note that the cancellation may

take several minutes).  However, no changes can be made to any entries on the tabs once the 'Run'

button is clicked.  There are two progress bars at the bottom of the interface - one for the current step

and one for the overall processing.  To the right of the 'Current Step' bar, information about the current

test number and total tests to be run will be displayed.  Tests may appear out of order and the same

test number may be displayed more than once due to grouping similar tasks together for efficiency.  

Any data and imagery loaded in the Table of Contents will be removed after the 'Run' button is

clicked, and the 'LAS Map View' window will be cleared once the USGS 1.2 QC Module begins

the screen capture portion of the processing.

Settings Files

Every time the USGS 1.2 QC Module is run, MARS® will generate an XML file containing the settings

used in the processing.  This file will be saved in the Output Folder specified on the Input Tab .

Each unique *.xml file name will contain the date and time that the module run was started as seen in

the example below.  For example, this particular run was started at 11:28:47 am on July 22, 2016.
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This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 1.2 QC Module runs.  After opening the USGS 1.2 QC Module interface,

click the 'Load Settings from File' button and navigate to an existing settings file to be used.  Any

individual parameters on any of the the interface tabs can be changed before starting the processing.  In

addition, a settings file can be created and saved for future use without actually running the USGS 1.2

QC Module - make all the parameter entries on the various tabs and click the 'Save Settings to File'

button when finished.  Navigate to a folder to store the file as it will not be stored in the chosen Output

Folder automatically like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.7.2 Input Tab

USGS 1.2 QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum - and

depending on the specific tests to be run - either the Swath LAS or Classified LAS data must be

included, along with a Project Name, Output Folder, and Output PDF File Name.  Each Input

Dataset should be in a separate folder to ensure proper operation and to avoid confusion when

pathing out the various sources - a unique Output Folder should also be used.

Unlike the original USGS 1.0 QC Module, which relies on the user specifying if and how multi-channel

data is stored in the files to be tested, this version reads the files that are pathed out and determines
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whether multi-channel data exists based on Scanner Channel bit flag values that are present in the data.

 Modifications to the testing methods and results are then made automatically.

If a 'Tile Scheme' and/or 'Project Boundary' shapefile is included, unique-value attribute fields must be

chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname' field for the 'Project

Boundary' shapefile).  For the 'Tile Scheme', the 'DB Field' selected must have values that exactly

match the file names of the tiled files in the Classified LAS Folder.  The attribute values for both of these

shapefiles are used for identifying many of the tabular results in the final reports.  Unless an optional

custom BPA (Buffered Project Area) boundary shapefile is pathed out, MARS® will generate a 100-meter

BPA boundary for test C-1 (see Collection Tab ) and test DPH-10 (see Data Processing/Handling Tab

).

The 'Quality Level' section is directly related to the levels defined in the USGS NGP Lidar Base

Specification Version 1.2.  By default, 'QL2 (10.0 cm RMSEz)' is selected as this is the most common

quality level requirement for USGS-related data deliveries.  The selection made here determines the

standards to be met (and the methodologies to be used) for a large part of the testing done in the USGS

1.2 QC Module.

LiDAR Check Points, in a CSV or 3D shapefile format, are needed for tests DPH-11.2 Check Points and

DPH-11.3 Absolute Vertical Accuracy.  See the 'Overview' section of the Check Point Report  Help

Topic for more details on the check points.

Make sure the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.
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The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local

disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.7.3 Collection Tab

USGS 1.2 QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab

Check boxes and options for tests C-1 through C-7 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section
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and paragraph in the USGS NGP Lidar Base Specification Version 1.2 in which they are referenced.

Note that the following descriptions of what is created for these tests pertain only to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

C-1 Report on Collection Area

The purpose of this section is to show swath and tiled lidar coverage to the extent of a 100

meter buffer of the defined project area boundary.  Screen captures of the lidar swath and tiled

data with the DPA (defined project area) and BPA (buffered project area) boundaries

superimposed are created for review.

C-2 Report on Returns

The purpose of this section is to report on the presence and quantities of lidar returns in the LAS

swath and tiled data.  Screen captures colored by the various return values, along with tables of

the return values, are created for review.  Empty return columns can indicate a collection or

processing problem dealing with lidar return attribute information.

C-3 Report on Intensity

The purpose of this section is to report on the presence and quantities of lidar intensity in the

LAS swath and tiled data.  Histograms, screen captures colored by intensity, and tables are

created for review.

C-4 Report on Nominal Pulse Spacing (NPS)

The purpose of this section is to report on the lidar point density and nominal point spacing by

swath file.  Averages by swath files (not including overlap), project boundary polygons (including

swath overlap), and aggregate project boundary polygons (including swath overlap) are reported

in a table for review.  'Point Density' and 'NPS' values are color-coded to indicate compliance (

green) or non-compliance (red) with the USGS specifications.

1459
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C-5 Report on Data Voids

The purpose of this section is to show graphically where possible lidar data voids are located. 

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser pulse back to the receiver, lidar occlusions caused by objects above ground

like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to isolate

the first example of lidar data voids - a lack of coverage at the time of collection.  A close

inspection must be done on the results to determine if the lidar coverage was collected and

processed to meet the intended specifications.  A raster of compliant (green cells), non-

compliant (red cells), and null data areas (black cells) is created for review, along with an

optional KML file for use with Google Earth1.  Note that the KML file cannot be created when the

input data straddles two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells. 

The other option is 'Exclusion Shapefile', where a pre-existing polygon shapefile of allowable

exclusion areas can be pathed out so that all the raster cells within those polygons will be set

to a value of NODATA.  Using this option, when feasible, will create a more accurate raster

result than the 'Minimum Zero Count' method.  In either case, the cells flagged as NODATA will

cut down on the time needed to investigate failing (red) cells.

C-6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable lidar spatial distributions

are located.  Lidar spatial distribution can be affected by problems in flight planning (e.g.,

incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong headwinds or
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tailwinds), a lack of coverage at the time of collection, water bodies not reflecting the laser beam

back to the receiver, lidar occlusions caused by objects above ground like tall buildings, etc. 

Not all lidar spatial distribution violations are truly problematic.  The intention of this test is to

isolate the first example of lidar spatial distribution violations - problems in flight planning or flight

execution.  A close inspection must be done on the results to determine if the lidar spatial

distribution was collected and processed to meet the intended specifications.  A raster of

compliant (green cells), non-compliant (red cells), and null data areas (black cells) is created for

review (sub-section C-6.1), along with a table of compliant cells as a percentage of all non-null

cells per file (sub-section C-6.2), and an optional KML file for use with Google Earth1.  The

tabular results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

Besides the KML creation option, there are two other user-definable settings: 'Minimum Zero

Count to set NODATA value' and 'Exclusion Shapefile'.  The first allows a minimum count of

adjacent empty cells to be entered so that the test will flag those clusters of raster cells as

NODATA (black) rather than failing (red).  A hypothetical example would be allowable void areas

such as water bodies, where each feature would cover an area of at least 20 adjacent cells.  The

other option is 'Exclusion Shapefile', where a pre-existing polygon shapefile of allowable

exclusion areas can be pathed out so that all the raster cells within those polygons will be set

to a value of NODATA.  Using this option, when feasible, will create a more accurate raster

result than the 'Minimum Zero Count' method.  In either case, the cells flagged as NODATA will

improve the ratio of passing (green) cells to the total of all passing and failing (red) cells, and cut

down on the time needed to investigate the failing cells.

C-7 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow
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depth map for the extent of the lidar at the time of collection.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.7.4 Data Processing/Handling Tab

USGS 1.2 QC Module - Data Processing/Handling

Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab
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Check boxes and options for tests DPH-1 through DPH-17 are located on this tab.  By default, all tests

are checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right,

or by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section

and paragraph in the USGS NGP Lidar Base Specification Version 1.2 in which they are referenced.

Note that the following descriptions of what is created for these tests pertain only to the Detailed PDF

report (see Final Reports ).  Summary PDF reports contain a condensed version of the aggregate

results, usually without reference to individual files.

DPH-1 Report on LAS Format

The purpose of this section is to show a table of LAS 1.4 compliance, file integrity, and

informational test results for each swath and tiled file.  Tables are created for review for all three
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sub-sections:

In the Compliance sub-section (DPH-1.1), the following items are reported on per file:

'LAS Version/PDRF', 'System ID', 'Legacy Point Count', 'Legacy Return Counts',

'PSID/FSID Match', 'Global Encoding', 'VLRs / EVLRs', 'WKT', 'Intensity', and 'Point

Count with Bad Return Info'.  For 'WKT', fail codes are shown as needed and those

codes are described at the bottom of the report page. 

In the File Integrity sub-section (DPH-1.2), the following items are reported on per

file: Number of Points Outside Extent, Offset To Point Data, Offset To EVLR, Number

of Points, Number of Points by Return, and Number of Duplicate Points.

In the Informational sub-section (DPH-1.3), the following items are reported on per

file: (Xmin, Ymin, Zmin), (Xmax, Ymax, Zmax), Extended Scan Angle, Scan Angle

Rank, Scanner Channel, Scan Direction, Edge of Flight Line, User Data, Counts for

Synthetic, Key-points (also known as Model Key-points), Withheld, and Overlap.

The tabular results are color-coded in sub-sections DPH-1.1 and DPH-1.2 to indicate

compliance (green) or non-compliance (red) with the USGS or ASPRS specifications, as

appropriate.  Red items will be promoted to the top of the tables.

DPH-2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the lidar swath and

tiled data.  A statement of waveform data file count is created for review.

DPH-3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the lidar swath

and tiled data.  A table of types (Adjusted GPS Time or GPS Week Time) is created for review. 

The results are color-coded to indicate compliance (green) or non-compliance (red) with the

USGS specifications.  Red items will be promoted to the top of the table.

DPH-4 Report on Datums
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The purpose of this section is to show the datums of the LAS files for the lidar swath and tiled

data.  A table of horizontal and vertical (if present) datum names and associated EPSG codes is

created for review.  File names are color-coded to indicate compliance (green) or non-

compliance (red) with the USGS specifications regarding the presence of horizontal datums.  As

the USGS does not require vertical coordinate information in the NGP Lidar Base Specification

Version 1.2, missing vertical datums will not be flagged unless some files in the dataset do have

that info.  In that case, a yellow bar in the 'Vertical Datum' column will indicate those files that

are missing it.  Red items will be promoted to the top of the table, followed by any yellow bar

items.

DPH-5 Report on Coordinate Reference System

The purpose of this section is to show the coordinate reference systems of the LAS files for the

lidar swath and tiled data.   A table of coordinate reference system names and associated

EPSG codes is created for review.  File names are color-coded to indicate compliance (green)

or non-compliance (red) with the USGS specifications.  Red items will be promoted to the top of

the table.

DPH-6 Report on Units of Reference

The purpose of this section is to show the horizontal and vertical units of the LAS files for the

lidar swath and tiled data.  A table of horizontal and vertical (if present) units is created for

review.  File names are color-coded to indicate compliance (green) or non-compliance (red) with

the USGS specifications regarding the presence of horizontal units.  As the USGS does not

require vertical coordinate information in the NGP Lidar Base Specification Version 1.2, missing

vertical units will not be flagged unless some files in the dataset do have that info.  In that case,

a yellow bar in the 'Vertical Unit' column will indicate those files that are missing it.  Red items

will be promoted to the top of the table, followed by any yellow bar items.

DPH-7 Report on File Source ID
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The purpose of this section is to report on the File Source ID and Point Source ID values for the

lidar swath data.  Note that sub-swaths of original swaths (see DPH-9) may violate the unique

values specification described in this test.  A table of File Source ID and Point Source ID values

is created for review.  File names are color-coded to indicate compliance (green) or non-

compliance (red) with the USGS specifications.  Red items will be promoted to the top of the

table.

DPH-8 Report on Point Families

The purpose of this section is to report on the presence and integrity of point families for the

lidar swath and tiled data.  A table is created for review.  File names are color-coded to indicate

compliance (green) or non-compliance (red) with the USGS specifications.  Red items will be

promoted to the top of the table.

DPH-9 Report on Swath File Size

The purpose of this section is to show the file sizes of the LAS files for the lidar swath data.  A

table with multiple size units is created for review.

DPH-10 Report on Collection Scan Coverage

The purpose of this section is to show collection scan overlap.  Lack of overlap would be

displayed as black polygons or slivers between collection scans.  A screen capture of the lidar

swath data with the BPA (buffered project area) boundary superimposed is created for review.

DPH-11.1.1 Smooth Surface Repeatability (intraswath)

The purpose of this section is to evaluate smooth surface repeatability by measuring departures

from planarity of single returns from hard planar surfaces, normalizing for actual variation in the

surface elevation.  Repeatability of only single returns is then assessed at multiple locations

within hard surfaced areas (for example, parking lots or large rooftops).  An elevation value

difference raster for each swath is created for review.  The raster cells are color-coded to
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indicate compliance (green) or non-compliance (red) with the USGS specifications.

DPH-11.1.2 Overlap Consistency (interswath)

The purpose of this section is to show a graphic of the flight line separation raster for all of the

data processed.  This grid/image shows the vertical separation of flight lines by thematically

coloring the separation magnitude on a color ramp based on absolute distance.  This color

thematic rendering is modulated by intensity to show land cover features.  A color-coded

elevation difference raster of the overlap areas is created for review, along with a table of relative

accuracy RMSDz values for those areas.  Only overlap areas are shown in the raster.

There are three user-definable settings for this test: An option to save the elevation difference

raster that is used to calculate the RMSDz values in a TIFF file format, a classes participating

selector, and an option to choose either TIN or Grid as the basis for the difference calculations. 

The TIFF raster allows for individual cell inspection of elevation difference values.  The class

selector, which defaults to all classes used for a typical unfiltered swath workflow, allows for

choosing ground only points if the swath data being tested has been filtered.  Lastly, the TIN/

Grid selector (TIN by default) determines the method used to calculate the elevation differences.

 Please see the notes on this option in the DPH-11.1.2 section of the interface.

DPH-11.2 Check Points

The purpose of this section is to show check points (NVA and VVA).  A screen capture of the

non-vegetated (shown in yellow) and vegetated (shown in green) check points with the DPA

(defined project area) superimposed is created for review, along with a table of check point and

boundary area statistics.

DPH-11.3 Absolute Vertical Accuracy

The purpose of this section is to report on the absolute vertical accuracy of the lidar data by

testing for NVA (Nonvegetated Vertical Accuracy) and VVA (Vegetated Vertical Accuracy)
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against surveyed ground check points.  A special version of the 'Check Point Report'  tool is

used for this test with the USGS specifications and ASPRS Positional Accuracy Standards pre-

set internally.  Several items are created for review - a table of check point information listing

point types (NVA / VVA), along with overall Z error values and statistics in a color-coded (PASS

/ FAIL) format where applicable; a table of NVA check points with point-by-point error and

descriptive information as compared to a TIN of the lidar ground data, along with a bar chart

showing error distribution; a table of NVA check points with point-by-point error and descriptive

information as compared to a RAM-based virtual grid (DEM grid of the lidar ground data, along

with a bar chart showing error distribution; a table of VVA check points with point-by-point error

and descriptive information as compared to a DEM grid of the lidar ground data, along with a bar

chart showing error distribution; point shapefiles of the check points with attributes including the

Z value of the surface and the Z error at each point's location; and screen captures of both the

NVA and VVA check points rendered thematically using color and relative error size on an

Intensity view background of the lidar data - NVA with the swath data and VVA with the tiled

data.

DPH-12 Use of the LAS Withheld Flag

The purpose of this section is to list the presence and quantities of points flagged as Withheld

for all lidar swath and tiled data files.  A statement of total Withheld point count for Class 0 (all

swaths/tiles), as well as all classes and all swaths/tiles, is created for review, along with screen

captures of the Withheld-flagged points for both the swath and tiled data.

DPH-13 Use of the LAS Overlap Flag

The purpose of this section is to list the presence and quantities of points flagged as Overlap for

all lidar swath and tiled data files.  A statement of total Overlap point count for all classes and

all swaths/tiles is created for review, along with screen captures of the Overlap-flagged points for

both the swath and tiled data.

1221
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DPH-14 Point Classification

The purpose of this section is to report total numbers of points (and certain bit flag counts in

some cases) for each class within the tile based LAS files.  A table of points by classification

(from the tiled data) is created for review, with any counts greater than zero (0) shown in red font

for Class 0 (unless those points are bit-flagged as Withheld) to indicate non-compliance with the

USGS specifications.  If some Class 0 points are flagged as Withheld but some are not, those

points counts will be shown in black with a red background.  Any points outside of Class 2

(Ground) that are flagged as Model Key-points will also be shown in red font.  Minimum required

classes per the USGS specifications have their point totals in bold font.  Note, however, that

some datasets may not have Low Noise points (Class 7), Water points (Class 9), Ignored

ground (near a breakline) (Class 10 or Class 20), Bridge decks (Class 17), or High noise (Class

18), depending on the nature of the project.  Also, additional classes may be required on

specific projects - non-zero counts for these classes will be displayed with a yellow background.

DPH-15/DPH-16 Reports on Classification Accuracy and Consistency

The purpose of the DPH-15 section is to overlay a 1km x 1km tile scheme over the bare earth

surface hillshade product to use for ground filter QC inspection.  The purpose of the DPH-16

section is to show the bare earth surface hillshade product for classification consistency

inspection.  Bare earth hillshade screen captures are created for a visual review.

DPH-17 Report on Tiles

The purpose of this section is to report on the unallowed presence of skew and/or polygon

overlap in the project tile scheme.  A table of tiles by name/number with skew, width, height,

and overlap is created for review.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.7.5 Final Reports

USGS 1.2 QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 1.2 QC Module is written to two (2) PDF files – Detailed and Summary - that

contain the results of the point cloud, check points, and tile scheme analysis.  All tabular results are

shown in Meters and either US Survey Feet or International Feet, depending on the project units chosen

on the Input Tab .  If either Meter or US Survey Feet is selected, results will be listed as 'Meter/US

Survey Feet'.  If International Feet is selected, results will be listed as 'Meter/International Feet'.

The reports will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'QC_1_2_All' but can be changed before running the module.  'Summary_' will be

appended to the summary report file name.  Both reports can be found in the Output Folder that was

chosen on the Input Tab .  Once processing is complete, the detailed report will open automatically if

the computer has software installed to read and display PDF files.  The following Sample Report

Pages are representative of the analysis results for each of the 24 tests that can be run.  If any tests

were unchecked by the user, a listing of Skipped Tests will be appended to the end of both PDF reports

followed by a printout of the Input Requirement Matrix (see Input Datasets in the General Information

 topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

1.2 QC Module will also generate several raster images (JPEG and JPEG 2000 format), shapefiles, and

optional KML files that support the visual review of the analysis results.  The Output Folder will also

contain sub-folders named for each test that was run.  These will hold any rasters, shapefiles, tables,

1443
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interim PDFs, etc., that were created and used to build the final reports.  These sub-folders can be

deleted if no longer needed after the module has completed and the final PDFs are generated. 

Sample Report Pages:
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.8 USGS 1.0 QC Module

USGS 1.0 QC Module

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'USGS NGP - Version 1.0' QC Module (available at the Explorer QC and Production license

levels) can be accessed in a drop-down list as shown ...



MARS® v2023.1           User Manual1466

© 2000-2023 Merrick & Company

  

... after clicking the QC Module button  on the QA/QC Tab .

Note that the 'USGS NGP LBS - 2022 rev. A ' option is the latest lidar specification adopted by the

USGS.

This version of the USGS QC Module is intended for, and will run only on, ASPRS version 1.3 or

earlier LAS files.  If LAS v1.4 data is pathed out, a pop-up warning will appear.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.8.1 General Information

USGS 1.0 QC Module - General Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'USGS NGP - Version 1.0' quality control (QC) module in MARS® is to provide an

457
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automated tool for verifying compliance of LAS v1.0 - LAS v1.3 LiDAR point cloud datasets to the Lidar

Base Specification Version 1.0 from the U.S. Geological Survey (USGS).  The primary intent of the

USGS LiDAR specification is to create consistency across all of USGS’s National Geospatial Program

(NGP) funded LiDAR data collections, in particular those undertaken in support of the National Elevation

Dataset (NED) and the 3D Elevation Program (3DEP).  Unlike most other “LiDAR specs,” which focus on

the derived bare-earth digital elevation model (DEM) product, this specification places unprecedented

emphasis on the handling of the source LiDAR point cloud data.

There are 30 possible tests that can be run in the USGS 1.0 QC Module.  The user can customize QC

tasks by selecting the individual QC standards that they wish to analyze.  The results of the point cloud,

check points, and tile scheme analysis are contained in two (2) PDF reports – detailed and summary -

along with supporting raster analysis images, tabular data, shapefiles, and other statistical files.  See

the Final Reports  sub-topic for more information.

For a copy of the USGS NGP Lidar Base Specification Version 1.0 (August 2012), please click this link

to access the PDF file (approximately 10.9 MB).  This document explains the requirements and

expectations of each test.  The USGS 1.0 QC Module tests are organized and numbered to match the

USGS specifications document.  Please note that for non-quantitative tests a visual inspection of the

data may still be required.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , and USGS NGP -

Version 1.2  tools, the LiDAR Data Checks  and LiDAR Calibration Checks  tools, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an

1490
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additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Boresighted Swath Data (LAS)

Classified LiDAR files (LAS)

Project Tile Scheme (Esri-compatible polygon shapefile) with a unique tile number/name

attribute

Project Boundary file (Esri-compatible polygon shapefile) with at least one attribute field that

contains unique values

Smoothed Best Estimate of Trajectory (SBET) file (as an Esri point shapefile) which includes

the flight date

LiDAR Check Points (CSV file)

Note that each test requires one or more of the inputs listed above.  The module will run only those QC

analysis tests that are supported by the available input datasets/files.  For example, if an SBET file is

not available, the module will not be able to analyze the scan angle violations or link to the NOAA

website for collection conditions.  A matrix chart PDF of input data and available tests can be accessed

by clicking the “Input Requirement Matrix” button at the top of the module interface.

Each Input Dataset should be in a separate folder to ensure proper operation and to avoid

confusion when pathing out the various sources.

Also note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of
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any  input shapefile, SBET file, or LiDAR Check Points CSV file.

Boresighted (also referred to as swath, flightline, or collection scan) and

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the USGS 1.0 QC Module, just as it

must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data pathed

out in the 'Boresighted LAS Folder' or 'Classified LAS Folder' (see Input Tab ) has not been through

the 'Add Spatial Index' process, the following window will pop up to explain the options.  See also Add

Spatial Index .  Multi-threading the Spatial Indexing functions across a USB 2.0 connection is not

recommended as the intensive file reads/writes (disk I/O) may cause hangs or slower overall

performance than single-threading.  USB 3.0 or later can be used, but may be limited in performance

depending on the access speed of the external drive.

If the 'Add Spatial Index to original files' option is chosen (the 'permanent' indexing option), a second

1472
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dialog will open when the 'OK' button is clicked:

This window allows new collection scan numbers to be assigned to the files.  The default is to retain

existing numbering.

Multi-threading

A multi-threading option can be found on the USGS 1.0 QC Module tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the
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process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Running the USGS 1.0 QC Module

When all necessary entries have been made on the Input , Collection , and Data Processing/

Handling  tabs, click the 'Run' button in the lower-right to begin the processing.  A pop-up may appear

if any selected tests require data that has not been pathed out on the Input Tab .  While running, the

individual tabs can be viewed, the 'Help' and 'Input Requirement Matrix' buttons remain active, and a

'Cancel' button will appear if the user wants to terminate the process (note that the cancellation may

take several minutes).  However, no changes can be made to any entries on the tabs once the 'Run'

button is clicked.  There are two progress bars at the bottom of the interface - one for the current step

and one for the overall processing.  To the right of the 'Current Step' bar, information about the current

test number and total tests to be run will be displayed.  Tests may appear out of order and the same

test number may be displayed more than once due to grouping similar tasks together for efficiency.  

Any data and imagery loaded in the Table of Contents will be removed after the 'Run' button is

clicked, and the 'LAS Map View' window will be cleared once the USGS 1.0 QC Module begins

the screen capture portion of the processing.

Settings Files

Every time the USGS 1.0 QC Module is run, MARS® will generate an XML file containing the settings

used in the processing.  This file will be saved in the Output Folder specified on the Input Tab .

Each unique *.xml file name will contain the date and time that the module run was started as seen in

the example below.  For example, this particular run was started at 10:05:09 am on July 15, 2016.

1472 1476
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This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between USGS 1.0 QC Module runs.  After opening the USGS 1.0 QC Module interface,

click the 'Load Settings from File' button and navigate to an existing settings file to be used.  Any

individual parameters on any of the the interface tabs can be changed before starting the processing.  In

addition, a settings file can be created and saved for future use without actually running the USGS 1.0

QC Module - make all the parameter entries on the various tabs and click the 'Save Settings to File'

button when finished.  Navigate to to a folder to store the file as it will not be stored in the chosen 

Output Folder automatically like it is when the module is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.8.2 Input Tab

USGS 1.0 QC Module - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum - and

depending on the specific tests to be run - either the Boresighted LAS or Classified LAS data must be

included, along with a Project Name, Output Folder, and Output PDF File Name.  Each Input

Dataset should be in a separate folder to ensure proper operation and to avoid confusion when

pathing out the various sources - a unique Output Folder should also be used.

The 'Multi-Channel Options' drop-down  in the 'LAS Files' section
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should be used as follows:

'No multi-channel data' (the default) should be used when the project to be tested was collected by a

single-channel sensor (the most common type).

'Channels stored as files' should be used when data is stored as one file per channel for each swath (for

example, a pair of files per swath for a dual-channel sensor).  By default, the naming convention

expected for multi-channel files (assuming a two-channel system) is L#-<filename>-C1_r.las and L#-

<filename>-C2_r.las, where # is the same collection scan number and the two channels are identified by

'C1' and 'C2' near the end of the file name.  In this example, the two channels of collection scan '23'

would then be named 'L23-1-140529A-C1_r.las' and 'L23-1-140529A-C2_r.las'.

'Multiple classes representing channels' should be used when the data to be tested stores one channel's

points in one class (for example, class 1), and the other channel's points in a different class (for

example, class 3) in the same swath file.  This will allow the creation and testing of separate 'virtual' LAS

files to obtain proper results.  This example assumes a dual-channel sensor and post-processing

software such as those produced by Leica.

'Scanner channel bit flag used' should be selected when the swath files have multi-channel data stored

using the Scanner Channel bit flag available with LAS v1.4 files using a Point Data Record Format of 6 or

higher.  In a dual-sensor setup, bit flag values are typically 0 and 1 for the two channels. 

If a 'Tile Scheme' and/or 'Project Boundary' shapefile is included, unique-value attribute fields must be

chosen (e.g., a 'Tilename' field for the 'Tile Scheme' shapefile, and an 'Areaname' field for the 'Project

Boundary' shapefile).  These attribute values are used for identifying many of the tabular results in the

final reports.

When SBET (Smoothed Best Estimate of Trajectory) files are included, they must be in Esri-compatible

point shapefile format.  MARS® includes a tool to convert true SBET files into the shapefile format

including an attribute field for Flight Date that is required for tests 1.7 and 1.12.  This tool, 'Convert SBET
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to Shapefile', is found on the Vector Creation Tab .

The entry for 'Required NPS (Nominal Pulse Spacing) in data units' must be in horizontal project units

and can be derived from the point density using this formula: NPS = 1/vDensity (i.e., the inverse of the

square root of the point density).

Make sure the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the tests!  Choices in the drop-down are

Meter, US Survey Feet, and International Feet.

The optional 'Class(es) Expected' box in the 'Misc Input' section allows for a selection of the classes the

user expects to be in the Classified LAS data to be entered.  This can then be compared to the actual

existing classes reported on in test 0.0 (Collection Tab ).

LiDAR Check Points, in a CSV file format, are needed for the two accuracy tests, 1.8 and 2.13.  See the

'Overview' section of the Check Point Report  Help Topic for more details on the check points.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option.  The 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local
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disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  New final reports will be produced in either case (see Final Reports  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.8.3 Collection Tab

USGS 1.0 QC Module - Collection Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab

1490
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Check boxes and options for tests 0.0 through 1.12 are located on this tab.  By default, all tests are

checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section

and paragraph in the USGS NGP Lidar Base Specification Version 1.0 in which they are referenced.

0.0 Report on LAS Statistics

The purpose of this section is to show detailed LAS statistics that MARS typically reports on

but are not entirely covered by the USGS NGP Lidar Base Specification Version 1.0.  A user

may find this useful by inspecting the values for expected ranges, values, etc., and looking for

outliers that would indicate an acquisition or processing error.  This test is run on the Classified
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LAS (tiled) data.

By default all classes are selected, but the option exists to choose specific classes by clicking

the 'Select' button.

1.1 Report on Returns

The purpose of this section is to report on the presence and quantities of LiDAR returns in the

LAS swath data.  Empty return columns can indicate a collection or processing problem dealing

with LiDAR return attribute information.  The test is divided into 'Swath Data' and 'Tiled Data'

sections.

1.2 Report on Intensity

The purpose of this section is to report on the presence and quantities of LiDAR intensity in the

LAS swath data.  It is important to understand that 8-bit intensity LiDAR systems have a valid

intensity range from 0-255, and 12-bit intensity LiDAR systems have a valid intensity range from

0-4095.  The test is divided into 'Swath Data' and 'Tiled Data' sections.

1.3 Report on Point Density and NPS per Collection Scan

The purpose of this section is to report on the LiDAR point density and nominal point spacing by

swath file.  Averages by swath files (not including overlap), project boundary polygons (including

swath overlap), and aggregate project boundary polygons (including swath overlap) are reported.

This test is run on the Boresighted LAS (swath) data.

1.4 Report on Point Density and NPS per Tile

The purpose of this section is to report on the LiDAR point density and nominal point spacing by

tiled file.  Point densities and NPS by tile are calculated by including any overlapping swath data

within each tile.  These statistics are for tiled LAS files.  Not all LAS files fill tiles completely,
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especially along project boundaries.  This may skew the calculated density and NPS values for

partially filled tiles.  This test is run on the Classified LAS (tiled) data.

1.5 Report on Data Void

The purpose of this section is to show graphically where possible LiDAR data voids are located.

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser beam back to the receiver, LiDAR occlusions caused by objects above

ground like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to

isolate the first example of LiDAR data voids - a lack of coverage at the time of collection.  A

close inspection must be done on the results to determine if the LiDAR coverage was collected

and processed to meet the intended specifications.  This test is run on the Boresighted LAS

(swath) data and is combined with test 1.6 due to their related nature and similar testing

options.

There are several options that can be set or modified for this test.  The 'Minimum Zero Count to

set NODATA value' checkbox and entry box will allow the user to specify a quantity of adjacent

empty cells that can exist before the cells are designated as 'NODATA' rather than void of data.

Cells marked as void in areas where no data is expected will skew the results.  For example,

assume a nominal pulse spacing of 2.5 feet, which will use a 10 foot cell size (10 x 10) for this

test due to the USGS specification that the raster cells be 4 times (4x) NPS.  If the project area

is covered by ponds that are a minimum of 500 square feet in area (for example), it is likely that

many cells will have no points.  Since water typically absorbs laser energy, there is no

expectation that returns will be collected for these ponds.  Therefore, rather than have possibly

dozens or hundreds of cells marked void that should not be part of the results, a Minimum Zero

Count of '5' could be entered for this option which will result in all empty cells in adjacent

groupings of 5 or more being marked as 'NODATA' and omitted from the final results.  If a



MARS® v2023.1           User Manual1480

© 2000-2023 Merrick & Company

polygon shapefile exists for these water bodies (or any type of known exclusion areas), an even

better method is to browse to it using the 'Exclusion Shapefile' option.  Cells that fall wholly or

partially within the polygon boundaries will be designated as 'NODATA'.  The minimum 'Number

of points required in cell' to meet the USGS specification is 1, the default, but this can be

changed for other needs.

A KML file can be created of void areas to be used with Google Earth1 to investigate the voids.

This requires that the 'Horizontal Projection EPSG Code' of the data be known.  When the data

has this information defined, it will be stored in the files and the EPSG Code box will be

populated accordingly.  If the data is undefined but the horizontal projection system is known,

the EPSG Code can be found by clicking the 'Select' button to the right of the entry box and

searching the Coordinate System Datasource.  For example, the EPSG Code for 'NAD83

(HARN) / Colorado Central' State Plane Zone in U.S. Survey Feet is '2877'.

1.6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable LiDAR spatial

distributions are located.  LiDAR spatial distribution can be affected by problems in flight

planning (e.g., incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong

headwinds or tailwinds), a lack of coverage at the time of collection, water bodies not reflecting

the laser beam back to the receiver, LiDAR occlusions caused by objects above ground like tall

buildings, etc.  Not all LiDAR spatial distribution violations are truly problematic.  The intention

of this test is to isolate the first example of LiDAR spatial distribution violations - problems in

flight planning or flight execution.  A close inspection must be done on the results to determine

if the LiDAR spatial distribution was collected and processed to meet the intended

specifications.  This test is run on the Boresighted LAS (swath) data and is combined with

test 1.5 due to their related nature and similar testing options.
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The same options used for test 1.5 Report on Data Voids are available for this test, plus one

additional option.  The cell size used for the Spatial Distribution grid may be modified from the

USGS specification of 2 times (2x) the NPS by checking the box labeled 'Use custom cell size

for 1.6' and entering a value in the 'Custom cell size' entry box.  Be aware that any deviation

from the 2 times NPS value will make this test non-compliant with the USGS specification.

1.7 Report on Scan Angle

The purpose of this section is to show graphically where the LiDAR scan angle exceeds the

specified limitation, measured in degrees on either side of nadir (+/- angles with respect to 0

degrees where 0 degrees is straight down or plumb).  This test is run on the Boresighted LAS

(swath) data.

By default the Minimum and Maximum Angles are set to -20 and 20 (respectively) based on the

USGS specification, but other values may be entered in the text boxes. 

1.8 Report on Vertical Accuracy

The purpose of this section is to report on the fundamental vertical accuracy of the LiDAR data

measured against surveyed ground check points.  This reports only the Fundamental Vertical

Accuracy (FVA).  This test is run on the Classified LAS (tiled) data.

This test is identical to the Check Point Report  that can be run independently from the QA/

QC Tab .  If available, Classified LAS (tiled) data is used to compare to the check points -

otherwise, the test will use Boresighted LAS (swath) data.  The accuracy Requirement

defaults to a Vertical Accuracy of '0.8' (achievable contour interval) at the 95% confidence level,

but other options are available (see the Check Point Report  Help Topic and its Inputs

Section  sub-topic).  Remember that the achievable contour interval value is in the 'Reporting
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Horizontal Units', as defined on the Input Tab .  The 'Source Classifications' default to 'Class

(es)' 2 (Ground) and 8 (Model Key-points), but if Classified LAS (tiled) data is not available this

should be set to All classes.

1.9.1 Report on Relative Accuracy

The purpose of this section is to show a graphic of the flight line separation raster for all of the

data processed.  This grid/image shows the vertical separation of flight lines by thematically

coloring the separation magnitude on a color ramp based on absolute distance.  This color

thematic rendering is modulated by intensity to show land cover features.  If there is no flight

line overlap, the raster is displayed as grayscale intensity alone.  When either the 'Measurable

RMSDz FSR' or 'Both' option is selected, the relative accuracy RMSDz values are reported in a

table following the Measurable raster in the final PDF report.  This test is run on the

Boresighted LAS (swath) data.

This test is nearly identical to the 'Flightline Separation - JPEG 2000' export type and most

details about the various settings can be found in the Flightline Separation - JPEG 2000  sub-

topic of the 'Export Type tab' topic (lower half of page) and the Grid tab  sub-topic of the

'Export Type tab' topic (paragraph 3, Color by Collection Scan Separation).  This area of the

Help Topics  file is found under the MARS® Tools  | Data Export  section.

As implemented in the QC Module, however, there are a few minor differences.  In addition to

the option of choosing either a 'Regular FSR' or a 'Measurable RMSDz FSR' (described here

), both FSR types  can be created for this test.  When either the 'Measurable RMSDz FSR' or

'Both' option is chosen, the 'Search radius for single return clustering' value will be automatically

set to 10 times the 'Required NPS' value as entered on the 'Input' tab.  This value can be

changed if necessary.  The 'Cell Size' will be automatically calculated at 3 times (3x) the NPS
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value entered on the Input Tab  for best results, but can be modified.  All 'Classes' are

selected by default since the test is run on Boresighted LAS (swath) data, but the 'Select

Classes' button can be used to make changes.  Also, only last returns are selected by default

to comply with the USGS specification, but the 'Select Returns' button can be used to make

changes.  Testing will be done by creating a virtual TIN by default, but a Grid option is available

(note the disclaimer to the right of the radio buttons).

1.9.2 Test individual swaths for internal relative vertical accuracy using inbound and outbound

scan values

The purpose of this section is to show a graphic of the relative vertical accuracy within each

flight line, individually.  This is done by comparing the inbound and outbound scan lines to each

other as two separate surfaces and then generating a vertical separation raster from their TIN

deltas.  This is displayed by thematically coloring the separation magnitude on a color ramp

based on absolute distance.  Good LiDAR data should have a consistent green coloration

across the flight line (perpendicular to flight), ignoring warmer colorations due to above ground

surface features.  Small color variations are to be expected.  The purpose of this test is to find

problematic data indicated by warming color variation trends away from the center of the scan

line.  Flight lines that have inconsistent colorations from the center towards the edges of the

flight line would highlight the possibility of a sensor or internal calibration problem, usually an

incorrect encoder latency value.  Note:  data from sensors that do not store differentiating Scan

Direction values cannot be used to create rasters for this test (current Riegl airborne sensors are

an example of this).  An explanation of the absence of rasters will be listed in the PDF report for

this test section.  This test is run on the Boresighted LAS (swath) data.

1.10 Report on Collection Scan Coverage and Sidelap

The purpose of this section is to show flight line overlap (including sidelap).  Lack of flight line

1472



MARS® v2023.1           User Manual1484

© 2000-2023 Merrick & Company

overlap would be displayed as black polygons or slivers between flight lines.  This test is run on

the Boresighted LAS (swath) data.

1.11 Report on Collection Area

The purpose of this section is to show LiDAR coverage to the extent of a 100 meter buffer of the

project boundary.  This test is run on the Boresighted LAS (swath) data.

By default the 'Buffer Distance for Project Boundary' value is set to 330 ('Reporting Horizontal

Units' in US Survey Feet or International Feet on the Input Tab ), or to 100 ('Reporting

Horizontal Units' in Meters on the Input Tab ), to comply with the USGS 100 meter

specification, but other values can be entered in the text box.

1.12 Report on Collection Conditions

The purpose of this section is to provide a hyperlink to a NOAA website that shows the snow

depth map (by default) for the extent of the LiDAR collection at the time of acquisition.  Note:

Other collection condition requirements are also listed in the USGS specification but may not

be available to view with this reporting tool.

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.8.4 Data Processing/Handling Tab

USGS 1.0 QC Module - Data Processing/Handling

Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Data Processing / Handling Tab

Check boxes and options for tests 2.1 through 2.16 are located on this tab.  By default, all tests are
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checked ON to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or

by checking/unchecking the individual boxes for the tests.  Tests are generally named for the section

and paragraph in the USGS NGP Lidar Base Specification Version 1.0 in which they are referenced.

2.1 Report on LAS Format

The purpose of this section is to show the LAS version for the LiDAR data.  The test is divided

into 'Swath Data' and 'Tiled Data' sections.

2.2 Report on Waveform Data

The purpose of this section is to show the presence of waveform data for the LiDAR data.  The

test is divided into 'Swath Data' and 'Tiled Data' sections.

2.3 Report on GPS Time Type

The purpose of this section is to show the GPS time type within the LAS files for the LiDAR

data.  The test is divided into 'Swath Data' and 'Tiled Data' sections.

2.4 Report on Datums

The purpose of this section is to show the datums of the LAS files for the LiDAR data.  The test

is divided into 'Swath Data' and 'Tiled Data' sections.

2.5 Report on Projection Type

The purpose of this section is to show the projections of the LAS files for the LiDAR data.  The

test is divided into 'Swath Data' and 'Tiled Data' sections.

2.6 Report on Units

The purpose of this section is to show the horizontal and vertical units of the LAS files for the
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LiDAR data.  The test is divided into 'Swath Data' and 'Tiled Data' sections.

2.7 Report on Swath File Size

The purpose of this section is to show the files sizes of the LAS files for the LiDAR data.  This

test is run on the Swath LAS data.

2.8 Report on File Source ID

The purpose of this section is to report on the File Source ID and Point Source ID values for the

LiDAR data.  Note that sub-swaths of original swaths (created for Test 2.7 compliance) may

violate the unique values specification described in this test.  This test is run on the Boresighted

LAS (swath) data.

2.9 Report on Point Families

The purpose of this section is to report on the presence and integrity of point families for the

LiDAR data.  The test is divided into 'Swath Data' and 'Tiled Data' sections.

2.10 Report on Swath Coverage

The purpose of this section is to show the presence and extent of all LiDAR data files.  This test

is run on the Boresighted LAS (swath) data.

2.11 Report on Noise Classes and Withheld Points

The purpose of this section is to list the presence and quantities of noise and withheld points for

all LiDAR data files.  The test is divided into 'Swath Data' and 'Tiled Data' sections.

By default the classes for Noise and Withheld points are 7 and 11, respectively, as they are

typically used for these purposes in LAS v1.0 through v1.3 files, but other classes can be
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selected.

2.12 Report on Overlap Points

The purpose of this section is to list the presence and quantities of overlap and unclassified

points for all LiDAR swath data files.  The test is divided into 'Swath Data' and 'Tiled Data'

sections.

By default the class for Overlap points is 12, as it is typically used for this purpose in LAS v1.0

through v1.3 files, but another class(es) can be selected.

2.13 Report on Positional Accuracy Validation

The purpose of this section is to compare the fundamental vertical accuracy of the LiDAR swath

data and the tiled data measured against surveyed ground check points.  The reason for this

comparison is to ensure that inappropriate steps were not taken after the filtering process to

"warp" the tiled LiDAR data to check points.  The check point statistics of each dataset should

look very similar, with only constant offsets as differences or variations due to the filtering

process.  The test is run as a comparison of the 'Swath Data' and 'Tiled Data'.

The accuracy requirement defaults to a Vertical Accuracy of '0.8' (achievable contour interval) at

the 95% confidence level, but other options are available (see the Check Point Report  Help

Topic and its Inputs Section  sub-topic).  Remember that the achievable contour interval value

is in the 'Reporting Horizontal Units', as defined on the Input Tab .  An option to create a

separation raster (JPEG 2000) between the Boresighted and Classified Data - 'Run relative

accuracy check ...' - is checked on by default.  This will be reported as 2.13.2 in the final reports.

By default the classes to be used in the tabular phase of the testing (2.13.1) are 'All' for the

Boresighted Data since it is usually not classified, and 2 (Ground) and 8 (Model Key-points) for
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the Classified Data, but other classes can be selected.  All classes of the 'Classified' data are

automatically used for the relative accuracy raster to make it easier to interpret.

2.14 Report on Classification Accuracy - Hillshade

The purpose of this section is to overlay a 1km x 1km tile scheme over the bare earth surface

hillshade product to use for ground filter QC inspections.  This test is run on the Classified LAS

(tiled) data and is combined with test 2.15 due to their related nature and identical class selection

options.

By default the classes for ground points are 2 (Ground) and 8 (Model Key-points), as they are

typically used for these purposes in LAS v1.0 through v1.3 files, but another class(es) can be

selected.

.

2.15 Report on Classification Consistency - Hillshade

The purpose of this section is to show the bare earth surface hillshade product for classification

consistency inspection.  This test is run on the Classified LAS (tiled) data and is combined with

test 2.14 due to their related nature and identical class selection options.

By default the classes for ground points are 2 (Ground) and 8 (Model Key-points), as they are

typically used for these purposes in LAS v1.0 through v1.3 files, but another class(es) can be

selected.

2.16 Report on Tiles

The purpose of this section is to report on the unallowed presence of skew and/or polygon overlap

in the project tile scheme.  This test is run on the Tile Scheme selected on the Input Tab .1472
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.8.5 Batch Tab

USGS 1.0 QC Module - Batch Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Batch Tab

This tab has not been implemented.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.8.6 Final Reports

USGS 1.0 QC Module - Final Reports

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of the USGS 1.0 QC Module is written to two (2) PDF files – detailed and summary - that

contain the results of the point cloud, check points, and tile scheme analysis.  The reports will be

named using the entry in the Output PDF File Name box on the Input Tab .  The default name is

'QC_1_0_All' but can be changed before running the module.  'Summary_' will be appended to the

1472
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summary report file name.  Both reports can be found in the Output Folder that was chosen on the

Input Tab .  Once processing is complete, the detailed report will open automatically if the computer

has software installed to read and display PDF files.  The following Sample Report Pages are

representative of the analysis results for each of the 30 tests that can be run.  If any tests were

unchecked by the user, a listing of Skipped Tests will be appended to the end of both PDF reports

followed by a printout of the Input Requirement Matrix (see Input Datasets in the General Information

 topic).

In addition to the two PDF reports of the point cloud, check points, and tile scheme analysis, the USGS

1.0 QC Module will also generate several raster images (JPEG and JPEG 2000 format), shapefiles, and

optional KML files that support the visual review of the analysis results.  The Output Folder will also

contain sub-folders named for each test that was run.  These will hold any rasters, shapefiles, tables,

interim PDFs, etc., that were created and used to build the final reports.  These sub-folders can be

deleted if no longer needed after the module has completed and the final PDFs are generated. 

Sample Report Pages:

1472
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.9 LiDAR Workflow QC

LiDAR Workflow QC

Merrick Advanced Remote Sensing (MARS
®

) Software

The two LiDAR Workflow QC tools, LiDAR Data Checks  and LiDAR Calibration Checks , can be

accessed in a drop-down list as shown ...
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... after clicking the QC Module button  on the QA/QC Tab .  These tools are available only

with an 'Explorer QC' or 'Production' level license.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.1 1 LiDAR Data Checks

1 LiDAR Data Checks

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'LiDAR Workflow QC - 1 LiDAR Data Checks' tool - part of the MARS® QC Module - is a set of tests

that are designed to check swath LAS data.
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© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.1.1 General Information

1 LiDAR Data Checks - General Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'LiDAR Data Checks' quality control tool in MARS® is to provide an automated

method for verifying the expected data attributes, coverage, point density, and relative accuracy of a

LiDAR point cloud dataset.

There are 12 possible tests that can be run in the 'LiDAR Data Checks' module.  The user has the ability

to customize QC tasks by selecting the individual tests that they wish to run.  Any points flagged as

Withheld are ignored for all tests.  A 'pre-filtering' option is included to re-classify High and Low Noise

points by comparing their elevations to USGS Digital Elevation Models (DEMs), assigning them the

Withheld bit flag at the same time.  (Merrick & Company does not guarantee the accuracy of the

DEMs stored by the USGS!)

The results of the point cloud analysis are contained in a detailed PDF report along with supporting
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raster analysis images, tabular data, charts, shapefiles, and other statistical files.  See the Final Report

 sub-topic for more information.

Note that points flagged as 'Withheld', regardless of classification, will not be used in any

processing for this tool.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP -

Version1.2 , and USGS NGP - Version 1.0  tools, the LiDAR Calibration Checks  tool, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an

additional fee.

Input Datasets

These are the datasets and files needed to run the 'LiDAR Data Checks' tool:

Swath Data (LAS) - required

Project Boundary file (in the form of a polygon shapefile) with at least one attribute field that

contains unique values - optional

Optionally, an Exclusion Shapefile can be pathed out on the Input Tab  for polygon areas that should

be ignored in the processing.  This may include water polygons and/or other known void areas.

Note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of

any input shapefile.

Swath (also referred to as flight line or collection scan) Data Preparation

LAS data must be spatially indexed before it can be tested with the LiDAR Data Checks tool, just as it
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must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data pathed

out in the 'Swath LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index' process,

the following prompt window will pop up (see also Add Spatial Index ).

Clicking 'OK' will bring up the 'File Source/Point Source ID Numbering and WKT' interface, with the

'Assign collection scan numbers to all files' option selected and a default starting value of '1' entered. 

The option or the starting ID number can be changed as needed.
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Read the information on this interface carefully before continuing with indexing.

Additionally, the Coordinate Reference System WKT string, if it exists for the input LAS data, will be

displayed in the 'WKT' box on the interface. If it does not exist (blank) or  is incorrect, it can be added or

edited by clicking the 'Edit' button to the right of the entry box.
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See the 'Add CRS Info (to LAS Files)' section in the Coordinate Conversion Tab  help topic for

details on using this interface.

Multi-threading

A multi-threading option can be found on the LiDAR Data Checks tool interface.  It speeds up processing

by using a specified amount of a computer’s CPU processing power.  The multi-threading control can be

found at the lower-left corner of the interface.  By default, the text box will show the maximum number of

threads the computer has available for processing.  Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For best

performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per thread.
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Running the LiDAR Data Checks tool

When all necessary entries have been made on the Input  and Processing  tabs, click the 'Run'

button in the lower-right to begin the processing.  A pop-up may appear if any selected tests require data

that has not been pathed out on the Input Tab .  While running, the individual tabs can be viewed, the

'Help' button remains active, and a 'Cancel' button will appear if the user wants to terminate the process

(note that the cancellation may take several minutes).  However, no changes can be made to any entries

on the tabs once the 'Run' button is clicked.

There are two progress bars at the bottom of the interface - one for the current step and one for the

overall processing.  To the right of the 'Current Step' bar, information about the current test number and

total tests to be run will be displayed.  Tests may appear out of order and the same test number may be

displayed more than once due to grouping similar tasks together for efficiency.  Any data and imagery

loaded in the Table of Contents will be removed after the 'Run' button is clicked, and the 'LAS

Map View' window will be cleared once the LiDAR Data Checks tool begins the screen capture

portion of the processing.

Settings Files

Every run of the LiDAR Data Checks tool will generate an XML file containing the settings used in the

processing.  This file will be saved in the Output Folder specified on the Input Tab .  Each unique *.

xml file name will contain the date and time that the tool run was started as seen in the example below.

For example, this particular run was started at 1:46:39 pm on April 27, 2022.

1501 1506

1501
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This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between runs.  After opening the LiDAR Data Checks tool interface, click the 'Load Settings

from File' button and navigate to an existing settings file to be used.  Any individual parameters on any of

the the interface tabs can be changed before starting the processing.  In addition, a settings file can be

created and saved for future use without actually running the tool - make all the parameter entries on the

various tabs and click the 'Save Settings to File' button when finished.  Navigate to a folder to store the

file as it will not be stored in the chosen Output Folder automatically like it is when the tool is actually

run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.1.2 Input Tab

1 LiDAR Data Checks - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum, the

Swath LAS data must be included, along with the Required Aggregate Nominal Pulse Density (ANPD),

Number of (collection) passes to meet the Required ANPD, a Project Name, Output Folder, and

Output PDF File Name.  Multi-channel data will be automatically detected and processed based on

Scanner Channel bit flag values in the LAS files.

If a 'Project Boundary' shapefile is included, a unique-value attribute field must be chosen (e.g., an

'Areaname' field for the 'Project Boundary' shapefile).  These attribute values are used for identifying
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many of the tabular results in the final report.

The entry for 'Required ANPD (Aggregate Nominal Pulse Density)' must be in PPSM (points per

square meter), regardless of the actual units that the input data is in.

The 'Number of passes to meet the Required ANPD' entry box defaults to '1'.  This is the correct value for

a typical airborne project using a single sensor with standard flightline sidelap of 20-30%.  Examples of

variations include (but are not limited to) a configuration where two separate sensors are collecting

simultaneously with 20-30% sidelap, and where two separate sensors are collecting simultaneously with

55% sidelap - entry box values of '2' and '4' (respectively) would be appropriate in those cases.  The title

page of the final PDF report  will show this information.

Both the 'Horizontal Data Units' and 'Vertical Data Units' drop-downs must be set to match the data

being tested.  This is critical to the correct operation and reporting of the tests!  Choices in the

drop-down are Meter (default), US Survey Feet, and International Feet.

If a polygon shapefile exists for water bodies (or any type of known exclusion areas), it can be pathed

out using the 'Browse' button to the right of the 'Exclusion Shapefile ' entry box.  These areas will be

omitted from the testing and analysis for tests DC3, DC4, DC5/DC6, DC7, DC11, and DC12 (see 

Processing Tab ).  Also, any class(es) selected with the 'Exclusion Classes' control will be ignored

for all tests.

An option to clean up potential High and/or Low Noise points before running any tests can be enabled by

checking the box labeled 'Use USGS DEMs for noise pre-filtering'.  This can improve overall run time for

the tool as well as produce cleaner and more useable test results by setting points that meet user-

defined criteria to Withheld and reclassing them to Low Noise (Class 7) or High Noise (Class 18), as

1514
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appropriate.  They will then be omitted from processing for all tests that are chosen to be run.  The

workflow for this pre-filtering option is as follows:

1. Any one of nine Land Cover/Terrain combinations can be selected from the radio button

matrix, based on the input data to be tested.  This selection will populate the entry boxes below the

selection buttons with pre-determined values (in meters) for how far any lidar point must be below and/or

above a DEM of the project area in order to be considered noise.  The DEMs, stored and maintained by

the USGS, will be automatically downloaded during processing and stored with the input LAS swaths to

cover the extent of the project and are used for all elevation comparisons.

2. Each point in the input LAS data is compared to the corresponding DEM cell's elevation

value.  Points that are outside of the 'Below' limit are reclassified as Low Noise (Class 7); points outside

of the 'Above' limit and reclassified as High Noise (Class 18).  Both classes are then assigned the

Withheld point bit flag.

3. This pre-filtered LAS data is then used as the input for the chosen tests with all Withheld

points ignored.

If the reclassification/bit flag assignment does not seem to be appropriate for the dataset (i.e., points

that appear to represent valid features have been set to Withheld), the input LAS data can be 'reset' to

its original status.  Also, if the horizontal correlation between the lidar data and the DEM(s) is more than

a few meters off, the data should be reset and the pre-filtering option should not be used (the data and

downloaded DEM(s) can be viewed together in MARS® to check the registration).  Using the 'Clear Bit

Flag' tool in the 'Bit Flag Settings' drop-down on the Tools Tab , browse to the input data, check the

'Withheld' box in the lower-left of the tool, check the 'Reassign to new class' box, select '0' (zero) as the

'Target Class', and click the 'Clear Bit Flags' button.  In any case, Merrick & Company does not

guarantee the accuracy of the DEMs stored by the USGS! 

Regardless of whether this option is checked on, a preliminary step (internally known as 'Step 0') will be

performed silently as soon as the 'Run' button is clicked.  This step finds all existing Class 18 (High

390
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Noise) points in the input swaths and sets the Withheld bit flag to 'On' - these points are then ignored for

all tests.  Although this step will make for a cleaner dataset, it can add time to the overall processing. 

To omit this step, select the 'Skip' option in the 'Existing Files' section of the Input Tab  before

running.  The 'Skip' option is further explained below in the final paragraph.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing. To use this option, check the 'Use temporary local disk

space to speed up processing' option. The 'Temporary Folder' browse box will become available. Browse

to any local folder which has space available in it. The interface will then tell the user how much space is

required and how much free space is in the folder the browse box is pointing to. If there is enough disk

space, the QC Module process will use the local space to speed up processing. If the user checks the

box labeled 'Use temporary local disk space to speed up processing', but does not point to a temporary

folder in the text box an error message will appear as seen below. The 'Use temporary local disk space

to speed up processing' option cannot be used without a temporary folder established.  NOTE:  Most

versions of Windows prohibit an application's output of files to the root directory of drives.  It is

strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

1501
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run.  A new final report will be produced in either case (see Final Report  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.1.3 Processing Tab

1 LiDAR Data Checks - Processing Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Processing Tab

1514



Quality Control 1507

© 2000-2023 Merrick & Company

Options for tests DC0 through DC12 are located on this tab.  By default, all tests except DC0 are

checked ON to be run and can be controlled by the 'Check All On' and 'Check All Off' buttons near the

upper-right, or by checking/unchecking the individual boxes for the tests.  Test DC9 will be run only if

multi-channel LAS data is detected (based on Scanner Channel bit flag values).

DC0 Set Withheld bit flag for Class 18 noise points

This option (unchecked by default) will clean up the testing results and potentially improve

performance by setting all Class 18 points in the Input  swaths to Withheld.  The input

swaths will be silently overwritten.  If this step has been performed previously on the input

swaths, it can be unchecked for subsequent processing runs to save time.

DC1 Report on Returns

The purpose of this section is to report on the presence and quantities of LiDAR returns in the

LAS swath data.  Empty return columns can indicate a collection or processing problem dealing

with LiDAR return attribute information.

DC2 Report on Intensity

The purpose of this section is to report on the presence and quantities of LiDAR intensity in the

LAS swath data.  This is done for each scan direction independently and also combined.  Note

that the intensity values have been normalized to 16-bit as required by the LAS version 1.4

specification.  It is important to understand that 8-bit intensity LiDAR systems have a valid native

intensity range from 0-255, and 12-bit intensity LiDAR systems have a valid native intensity

range from 0-4095.

DC3 Report on Point Density and NPS per Collection Scan

The purpose of this section is to report on the LiDAR point density and nominal point spacing by

1501
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swath file.  Values for individual swaths and a project average (not including overlap) are reported

in tabular form, and a frequency distribution chart of density/spacing results is produced.  By

default, the center 95% of the swath width is tested to avoid the artificially higher densities

present at the edges of collection scans for many sensors.  This value can be modified as

needed in the 'Approximate percentage of swath to test' entry box.  In the results table, 'Point

Density' and 'NPS' values are color-coded at the individual swath level to indicate compliance (

green) or non-compliance (red) with the 'Required ANPD (Aggregate Nominal Pulse Density)' as

entered on the 'Input' tab.  NOTE - if an 'Exclusion Shapefile' is included on the Input Tab , all

polygons within it will be omitted from testing and analysis for this step.

DC4 LiDAR Point Density Float Grid creation

The purpose of this section is to present a raster of relative point density using last returns only,

based on a cell size of 1-meter or 3.2808 US Feet depending on the project data units selected.

 The result is color-coded using a red to magenta color ramp - red cells are the least dense and

magenta cells are the most dense.  Black cells indicate no last return points were found.  A

frequency distribution chart is also created to aid in the analysis of the results.  Several

statistics are compiled on this page of the final report.  NOTE - if an 'Exclusion Shapefile' is

included on the Input Tab , all polygons within it will be omitted from testing and analysis for

this step.

DC5 Report on Data Void

The purpose of this section is to show graphically where possible LiDAR data voids are located.

Data voids can be caused by a lack of coverage at the time of collection, water bodies not

reflecting the laser beam back to the receiver, LiDAR occlusions caused by objects above

ground like tall buildings, etc.  Not all data voids are problematic.  The intention of this test is to

isolate the first example of LiDAR data voids - a lack of coverage at the time of collection.  A

1501
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close inspection must be done on the results to determine if the LiDAR coverage was collected

and processed to meet the intended specifications.  This test is combined with test DC6 due to

their related nature and similar testing options.  NOTE - if an 'Exclusion Shapefile' is included on

the Input Tab , all polygons within it will be omitted from testing and analysis for this step.

There are several options that can be set or modified for this test.  The 'Minimum Zero Count to

set NODATA value' checkbox and entry box will allow the user to specify a quantity of adjacent

empty cells that can exist before the cells are designated as 'NODATA' rather than void of data.

Cells marked as void in areas where no data is expected will skew the results.  For example,

assume a nominal pulse spacing of 2.5 feet, which will use a 10 foot cell size (10 x 10) for this

test (4x NPS).  If the project area is covered by ponds that are a minimum of 500 square feet in

area (for example), it is likely that many cells will have no points.  Since water typically absorbs

laser energy, there is no expectation that returns will be collected for these ponds.  Therefore,

rather than have possibly dozens or hundreds of cells marked void that should not be part of the

results, a Minimum Zero Count of '5' could be entered for this option which will result in all empty

cells in adjacent groupings of 5 or more being marked as 'NODATA' and omitted from the final

results.  Cells that fall wholly or partially within any of the polygon boundaries will be designated

as 'NODATA'.  The minimum 'Number of points required in cell' defaults to '1', but this can be

changed.

A KML file can be created of void areas to be used with Google Earth1 to investigate those

areas.  This requires that the 'Horizontal Projection EPSG Code' of the data be known.  When

the data has this information defined, it will be stored in the files and the EPSG Code box will be

populated accordingly.  If the data is undefined but the horizontal projection system is known,

the EPSG Code can be found by clicking the 'Select' button to the right of the entry box and

searching the Coordinate System Datasource.  For example, the EPSG Code for 'NAD83

1501
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(HARN) / Colorado Central' State Plane Zone in U.S. Survey Feet is '2877'.  The KML option is

unchecked by default.  Note that the KML file cannot be created when the input data straddles

two or more projection zone boundaries.

DC6 Report on Spatial Distribution

The purpose of this section is to show graphically where unacceptable LiDAR spatial

distributions are located.  LiDAR spatial distribution can be affected by problems in flight

planning (e.g., incorrect scan frequency / pulse rate pairing) or flight execution (e.g., strong

headwinds or tailwinds), a lack of coverage at the time of collection, water bodies not reflecting

the laser beam back to the receiver, LiDAR occlusions caused by objects above ground like tall

buildings, etc.  Not all LiDAR spatial distribution violations are truly problematic.  The intention

of this test is to isolate the first example of LiDAR spatial distribution violations - problems in

flight planning or flight execution.  A close inspection must be done on the results to determine

if the LiDAR spatial distribution was collected and processed to meet the intended

specifications.  This test is combined with test DC5 due to their related nature and similar

testing options.  NOTE - if an 'Exclusion Shapefile' is included on the Input Tab , all polygons

within it will be omitted from testing and analysis for this step.

The same options used for test DC5 Report on Data Void are available for this test, plus one

additional option.  The cell size used for the Spatial Distribution grid may be modified from the

default '2x NPS' by checking the box labeled 'Use custom cell size for DC6' and entering a value

in the 'Custom cell size' entry box.  Note that if the 'Create KML ...' option is (optionally)

checked, the KML file cannot be created when the input data straddles two or more projection

zone boundaries.

DC7 Report on Relative Accuracy

1501
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The purpose of this section is to show a graphic of the flight line separation raster for all of the

data processed.  This grid/image shows the vertical separation of flight lines by thematically

coloring the separation magnitude on a color ramp based on absolute distance.  This color

thematic rendering is modulated by intensity to show land cover features.  If there is no flight line

overlap, the raster is displayed as grayscale intensity alone.  NOTE - if an 'Exclusion Shapefile'

is included on the Input Tab , all polygons within it will be omitted from testing and analysis

for this step.

This test is nearly identical to the 'Flightline Separation - JPEG 2000' export type when run with

the 'Measurable RMSDz FSR' option, and most details about the various settings can be found

in the Flightline Separation - JPEG 2000  sub-topic of the 'Export Type tab' topic (lower half of

page) and the Grid tab  sub-topic of the 'Export Type tab' topic (paragraph 3 Color by

Collection Scan Separation).  This area of the Help Topics  file is found under the MARS®

Tools  | Data Export  section.

As implemented in the QC Module, however, there are a few differences.  The 'Cell Size' will be

automatically calculated at 3 times (3x) the NPS value for best results, as determined from the

required density entered on the Input Tab , but can be modified.  All 'Classes' are selected by

default since the test is run on Swath LAS data, but the 'Select Classes' button can be used to

make changes.  Also, only last returns are selected by default, but the 'Select Returns' button

can be used to make changes.  Testing will be done by creating a virtual Grid by default, but a

TIN option is available (note the disclaimer to the right of the radio buttons).

DC8 Test individual swaths for internal relative accuracy using inbound and outbound scan

values

The purpose of this section is to show a graphic of the relative vertical accuracy within each
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flight line, individually.  This is done by comparing the inbound and outbound scan lines to each

other as two separate surfaces and then generating a vertical separation raster from their deltas.

 This is displayed by thematically coloring the separation magnitude on a color ramp based on

absolute distance - 0 to 2 cm (or the foot equivalent) is green, 2 to 4 cm is yellow, 4 to 6 cm is

orange, and greater than 6 cm is red.  Good LiDAR data should have a consistent green

coloration across the flight line (perpendicular to flight), ignoring warmer colorations due to

above-ground surface features.  Some small color variations are to be expected. The purpose of

this test is to find problematic data indicated by warming color variation trends away from the

center of the scan line.  Flight lines that have inconsistent colorations from the center towards

the edges of the flight line would highlight the possibility of a sensor or internal calibration

problem, usually an incorrect encoder latency value.  Testing will be done by creating a virtual

Grid by default, but a TIN option is available (note the disclaimer to the right of the radio

buttons).

DC9 Test individual channels for channel-to-channel misalignment 

The purpose of this section is to check the channel-to-channel sensor calibration of a multi-

channel LiDAR system to ensure proper 3D alignment within a single swath.  During this step,

each channel is processed as a separate collection scan and compared to its paired channel. 

A surface-to-surface vertical separation is calculated per swath between the two channels.  The

results are then thematically rendered in the output rasters, one for each swath.  Testing will be

done by creating a virtual Grid by default, but a TIN option is available (note the disclaimer to the

right of the radio buttons).  This test is run only if multi-channel data is detected based on

Scanner Channel bit flag values, so it does not need to be unchecked for single channel

datasets.

DC10 Report on Collection Scan Coverage and Sidelap
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The purpose of this section is to show flight line overlap (including sidelap).  Lack of flight line

overlap would be displayed as black polygons or slivers between flight lines.

DC11 Shaded Relief Raster - Hillshade

The purpose of this section is to present a first return digital surface model for all of the data

processed to more easily see unexpected high and low areas and other anomalies.  By default

all classes are selected for this raster, but the 'Select Classes' button can be used to make

changes.  NOTE - if an 'Exclusion Shapefile' is included on the Input Tab , all polygons within

it will be omitted from testing and analysis for this step.

DC12 Elevation Range Raster

The purpose of this section is to create a thematic raster displaying the range of elevations

present in a cell whose size is a user-supplied multiplier of the NPS (Nominal Pulse Spacing) for

the input data - the default value is '50'.  The NPS is automatically calculated in the Horizontal

Data Units as selected on the Input Tab , based on the user-supplied ANPD (Aggregate

Nominal Pulse Density).  A histogram stretch is done with the highest and lowest 5% of the

range values discarded and the remainder split into 24 equal-range groups that are each

assigned a unique color in the final JPEG 2000 raster.  A float grid is also generated that stores

the actual numeric range value for each cell.  Those values can be inspected in ArcGIS or

another software package that reads the numeric cell values.  This test can be helpful in pointing

out where extreme high and/or low points are present that may need to be reclassified or flagged

as Withheld.  NOTE - if an 'Exclusion Shapefile' is included on the Input Tab , all polygons

within it will be omitted from testing and analysis for this step.

 

1  --  Google Earth is copyright 2023 Google LLC.  All rights reserved.
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6.9.1.4 Final Report

1 LiDAR Data Checks - Final Report

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of this LiDAR Data Checks tool is written to a detailed PDF file that contains the test-by-test

results of the point cloud analysis.  At the end of the individual test sections, a page titled 'Time Spent

On Each Step' will be created to show processing times in tabular and chart formats.  The report will be

named using the entry in the Output PDF File Name box on the Input Tab .  The default name is

'LDC_All' but can be changed before running the tool.   The report can be found in the Output Folder

that was chosen on the Input Tab .  Once processing is complete, the report will open automatically if

the computer has software installed to read and display PDF files.  The following  Sample Report

Pages are representative of the analysis results for the 11 tests that can be run.

In addition to the PDF report of the point cloud analysis, the tool will also generate several raster images

(JPEG and JPEG 2000 format) and shapefiles that support the visual review of the analysis results.  The 

Output Folder will also contain sub-folders named for each test that was run.  These will hold any

rasters, shapefiles, tables, interim PDFs, etc., that were created and used to build the final report. 

These sub-folders can be deleted if no longer needed after the tool has completed and the final PDF is

generated. 

Sample Report Pages:

1501
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6.9.2 2 LiDAR Calibration Checks

2 LiDAR Calibration Checks

Merrick Advanced Remote Sensing (MARS
®

) Software
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The 'LiDAR Workflow QC - 2 LiDAR Calibration Checks' tool - part of the MARS® QC Module - is a set of

tests that are designed to check swath or tiled LAS data.

  

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.2.1 General Information

2 LiDAR Calibration Checks - General

Information

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the 'LiDAR Calibration Checks' quality control tool in MARS® is to provide an automated

method for verifying correct LiDAR collection system function by testing the relative accuracy and

channel alignment (when applicable) of a LiDAR point cloud dataset.

There are three (3) possible tests that can be run in the 'LiDAR Data Checks' module.  The user has the

ability to customize QC tasks by selecting the individual tests that they wish to run. The results of the

point cloud analysis are contained in a detailed PDF report along with supporting raster analysis images,

tabular data, and charts.  See the Final Report  sub-topic for more information.  Note that points

flagged as 'Withheld', regardless of classification, will not be used in any processing for this tool.

1529
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Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP -

Version 1.2 , and USGS NGP - Version 1.0  tools, the LiDAR Data Checks  tool, and the

Voronoi Density Reporting  tool - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an

additional fee.

Input Datasets

These are the datasets and files needed to run all tests:

Swath Data (LAS)  -or-  Tiled Data (LAS) derived from swath data 

Project Boundary file (Esri-compatible polygon shapefile) with at least one attribute field that

contains unique values

Note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of

any input shapefile.

Swath (also referred to as flight line or collection scan) or Tiled (also referred to

as classified or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the LiDAR Calibration Checks tool, just

as it must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data

pathed out in the Swath 'LAS Folder' or Classified 'LAS Folder' (see Input Tab ) has not been through

the 'Add Spatial Index' process, the following window will pop up (see also Add Spatial Index ).
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Clicking 'OK' will bring up the 'File Source/Point Source ID Numbering' interface.  If Swath Data is being

pathed out, the 'Assign collection scan numbers to all files' option will be selected and a default starting

value of '1' entered (below, left).  If Tiled Data is being pathed out, the 'Retain existing collection scan

numbering for all files' option will be selected (below, right).  The option or the starting ID number can be

changed as needed.  Read the information on this interface carefully before continuing with indexing.
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Multi-threading

A multi-threading option can be found on the LiDAR Calibration Checks tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing.  Leave as is, or enter a lower

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.
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Running the LiDAR Calibration Checks tool

When all necessary entries have been made on the Input  and Processing  tabs, click the 'Run'

button in the lower-right to begin the processing.  A pop-up will appear if any selected tests require data

that has not been pathed out on the Input Tab .  If 'Swath Data' (the default) is used as the input and

either the 'Measurable RMSDz FSR' or 'Both' option is selected for test CC1 on the Processing  tab,

the tool will check for pre-existing filtered swath data to save time.  This data - filtered to contain only

buffered single returns to ensure accuracy - could exist from either a previous run of this tool or test

DPH-9.1 in the USGS NGP - Version 2.1  tool.  To be reused, it must be in a folder named

'Filtered_LAS' directly under the input swath path.

If Tiled Data is used, the tool will first export all points in the tiles to individual collection scan files based

on each point's Point Source ID number, then use that data for testing.   While running, the individual

tabs can be viewed, the 'Help' button remains active, and a 'Cancel' button will appear if the user wants

to terminate the process (note that the cancellation may take several minutes).  However, no changes

can be made to any entries on the tabs once the 'Run' button is clicked.  There are two progress bars at

the bottom of the interface - one for the current step and one for the overall processing.  To the right of

the 'Current Step' bar, information about the current test number and total tests to be run will be

displayed.  Tests may appear out of order and the same test number may be displayed more than once

due to grouping similar tasks together for efficiency.  Any data and imagery loaded in the Table of

Contents will be removed after the 'Run' button is clicked, and the 'LAS Map View' window will

be cleared once the LiDAR Calibration Checks tool begins the screen capture portion of the

processing.

1522 1525

1522

1525

1370



MARS® v2023.1           User Manual1522

© 2000-2023 Merrick & Company

Settings Files

Every LiDAR Calibration Checks tool run in MARS® will generate an XML file containing the settings

used in the processing. This file will be saved in the Output Folder specified on the Input Tab .  Each

unique *.xml file name will contain the date and time that the tool run was started as seen in the

example below. For example, this particular run was started at 12:21:59 pm on April 28, 2022.

This file can be renamed as needed and loaded for future runs to cut down on data entry and ensure

consistency between runs.  After opening the LiDAR Calibration Checks tool interface, click the 'Load

Settings from File' button and navigate to an existing settings file to be used.  Any individual parameters

on any of the the interface tabs can be changed before starting the processing.  In addition, a settings

file can be created and saved for future use without actually running the tool - make all the parameter

entries on the various tabs and click the 'Save Settings to File' button when finished.  Navigate to a folder

to store the file as it will not be stored in the chosen Output Folder automatically like it is when the tool

is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.2.2 Input Tab

2 LiDAR Calibration Checks - Input Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab
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This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final reports, Output Folder, and Output PDF File Name.  At a minimum, the

Swath LAS or Classified LAS (tiled) data must be included, along with the Required Nominal Pulse

Spacing (NPS), a Project Name, Output Folder, and Output PDF File Name.  Multi-channel data will

be automatically detected based on Scanner Channel bit flag values in the LAS files, unless 'Tiled Data'

is being used for the input and the 'Using user data as channel info' box is checked.

When using multi-channel 'Tiled Data', the channel numbers are often stored in the User Data section of

the LAS file headers when the tiles are produced from the original swath data in some third-party
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software packages.  In this case, checking the box for 'Using user data field as channel info' will

automatically group multi-channel files together based on identical Point Source IDs found in the tiled

datasets.  The tool will build collection scan files from the tiled data using these Point Source IDs and

the channel info and use these created files for testing.  Unless the 'Keep collection scan files' box is

checked and a storage folder is pathed out, these collection scan files will be deleted after the tool has

completed.  In either case, the tiled data is not altered in any way.

If a 'Project Boundary' shapefile is included, a unique-value attribute field must be chosen (e.g., an

'Areaname' field for the 'Project Boundary' shapefile).  These attribute values are used for identifying

some of the tabular results in the final report.

The entry for 'Required NPS (Nominal Pulse Spacing)' - otherwise known as GSD (Ground Sample

Distance) - must be in horizontal project units and can be derived from the point density using this

formula: NPS = 1/vDensity (i.e., the inverse of the square root of the point density).

Make sure the 'Reporting Horizontal Units' and 'Reporting Vertical Units' are set to match the data being

tested.  This is critical to the correct operation and reporting of the tests!  Choices in the drop-down

are Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing. To use this option, check the 'Use temporary local disk

space to speed up processing' option. The 'Temporary Folder' browse box will become available. Browse

to any local folder which has space available in it. The interface will then tell the user how much space is

required and how much free space is in the folder the browse box is pointing to. If there is enough disk

space, the QC Module process will use the local space to speed up processing. If the user checks the
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box labeled 'Use temporary local disk space to speed up processing', but does not point to a temporary

folder in the text box an error message will appear as seen below. The 'Use temporary local disk space

to speed up processing' option cannot be used without a temporary folder established.  NOTE:  Most

versions of Windows prohibit an application's output of files to the root directory of drives.  It is

strongly recommended that a sub-folder be used for this option. 

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only those test results that were incomplete or omitted in a previous

run.  A new final report will be produced in either case (see Final Report  sub-topic).

© 2000-2023 Merrick & Company. All Rights Reserved.

6.9.2.3 Processing Tab

2 LiDAR Calibration Checks - Processing Tab

Merrick Advanced Remote Sensing (MARS
®

) Software

The Processing Tab
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Options for tests CC1 through CC3 are located on this tab.  By default, all three tests are checked ON

to be run and can be controlled by the 'Check All On / Off' buttons near the upper-right, or by checking/

unchecking the individual boxes for the tests.  Test CC3 will be run only if multi-channel LAS data is

detected (based on Scanner Channel bit flag values).

'Exclusion Classes'

Any class(es) selected here will be ignored for all tests.

CC1 Report on Relative Accuracy

The purpose of this section is to show a graphic of the flight line separation raster for all of the
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data processed.  This grid/image in the final PDF report  shows the vertical separation of

flight lines by thematically coloring the separation magnitude on a color ramp based on absolute

distance.  This color thematic rendering is modulated by intensity to show land cover features. 

For the Measurable FSR option, only overlap areas are shown in the raster.  The relative

accuracy RMSDz values for each overlap area are reported in a table and a frequency

distribution chart following the raster(s).

This test is nearly identical to the 'Flightline Separation - JPEG 2000' export type and most

details about the various settings can be found in the Flightline Separation - JPEG 2000  sub-

topic of the 'Export Type tab' topic (lower half of page) and the Grid tab  sub-topic of the

'Export Type tab' topic (paragraph 3, Color by Collection Scan Separation).  This area of the

Help Topics  file is found under the MARS® Tools  | Data Export  section.

As implemented in the QC Module, however, there are a few differences.  In addition to the

option of choosing either a 'Regular FSR' or a 'Measurable RMSDz FSR' (described here ),

both FSR types can be created for this test in a single run.  The 'Cell Size' will be automatically

calculated at 3 times (3x) the NPS values entered on the Input Tab  for best results, but can

be modified.  All 'Classes' are selected by default, but the 'Select Classes' button can be used

to make changes.  Only last returns are selected by default, but the 'Select Returns' button can

be used to make changes.  Also, for the 'Measurable RMSDz FSR'  output, an option exists to

use either clusters of single returns or existing ground classes to define the areas to be tested.

When the 'Using clusters of single returns' option is chosen, the 'Search radius for single return

clustering' value will be automatically set to 10 times the 'Required NPS' value as entered on the

'Input' tab.  This value can be changed if necessary.  Testing will be done by creating a virtual

TIN by default, but a Grid option is available (note the disclaimer to the right of the radio

buttons).
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CC2 Test individual swaths for internal relative vertical accuracy using scan direction flags

The purpose of this section is to show a graphic of the relative vertical accuracy within each

flight line, individually.  This is done by comparing the opposing scan directions to each other as

two separate surfaces and then generating a vertical separation raster from their TIN deltas.  The

result is displayed by thematically coloring the separation magnitude on a color ramp based on

absolute distance.  Good LiDAR data should have a consistent green coloration across the flight

line (perpendicular to flight), ignoring warmer colorations due to above ground surface features. 

Small color variations are to be expected.  The purpose of this test is to find problematic data

indicated by warming color variation trends away from the center of the scan line.  Flight lines

that have inconsistent colorations from the center towards the edges of the flight line would

highlight the possibility of a sensor or internal calibration problem, usually an incorrect encoder

latency value.  The relative accuracy RMSDz is reported in the bottom left of each page. 

Testing will be done by creating a virtual TIN by default, but a Grid option is available (note the

disclaimer to the right of the radio buttons).

CC3 Test individual channels for channel to channel misalignment

The purpose of this section is to check the channel-to-channel sensor calibration of a multi-

channel LiDAR system to ensure proper 3D alignment within a single swath.  During this step,

each channel is processed as a separate collection scan and compared to its paired channel. 

A surface-to-surface vertical separation is calculated per swath between the two channels.  The

results are then thematically rendered in the output rasters, one for each swath.  Testing will be

done by creating a virtual TIN by default, but a Grid option is available (note the disclaimer to the

right of the radio buttons).  This test is run only if multi-channel data is detected, based on

Scanner Channel bit flag values.
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6.9.2.4 Final Report

2 LiDAR Calibration Checks - Final Report

Merrick Advanced Remote Sensing (MARS
®

) Software

QC Reporting

The output of this LiDAR Calibration Checks tool is written to a detailed PDF file that contains the

results of the point cloud analysis.  The report will be named using the entry in the Output PDF File

Name box on the Input Tab .  The default name is 'LCC_All' but can be changed before running the

tool.  The report can be found in the Output Folder that was chosen on the Input Tab .  Once

processing is complete, the report will open automatically if the computer has software installed to read

and display PDF files.  The following Sample Report Pages are representative of the analysis results

for the three (3) tests that can be run.

In addition to the PDF report of the point cloud analysis, the tool will also generate several raster images

(JPEG and JPEG 2000 format) and shapefiles that support the visual review of the analysis results.  The 

Output Folder will also contain sub-folders named for each test that was run.  These will hold any

rasters, shapefiles, tables, interim PDFs, etc., that were created and used to build the final report. 

These sub-folders can be deleted if no longer needed after the tool has completed and the final PDF is

generated. 

Sample Report Pages:
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6.10 Voronoi Density Reporting

Voronoi Density Reporting

Merrick Advanced Remote Sensing (MARS
®

) Software

The 'Voronoi Density Reporting' tool (available at the Explorer QC and Production license levels) can
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be accessed in the a drop-down list as shown ...

  

... after clicking the QC Module button  on the QA/QC Tab .

© 2000-2023 Merrick & Company. All Rights Reserved.

6.10.1 General Information

Voronoi Density Reporting

Merrick Advanced Remote Sensing (MARS
®

) Software

Purpose and Description

The purpose of the Voronoi Density Reporting tool in the MARS® QC Module is to provide an accurate

and unbiased method for reporting lidar point cloud density.  In summary, this is done by first creating a

TIN (triangulated irregular network) - a set of adjacent, non-overlapping triangles constructed from all the

lidar points in the input dataset.  The mid-point of each triangle leg is calculated, and non-overlapping

polygons are generated by connecting those mid-points such that each polygon contains only one point

and each point is contained by only one polygon.  The area of each polygon is determined, and the
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inverse of each area is stored as the density value.

The results of the point cloud density testing are contained in a PDF report, including a summary of the

process, a frequency distribution chart with statistical information, and density and pass/fail assessment

rasters.  See the Final Reports  sub-topic for more information.

Licensing

The entire MARS® QC Module - including this tool, the USGS 2022 rev. A , USGS 2021 rev. A ,

USGS 2020 rev. A , USGS NGP - Version 2.1 , USGS NGP - Version 1.3 , USGS NGP -

Version 1.2 , and USGS NGP - Version 1.0  tools, and the LiDAR Data Checks  and LiDAR

Calibration Checks  tools - is enabled in either the Explorer QC (MARSEXQC) or Production

(MARSPROD) license versions, and it can be added to the Explorer (MARSEXPL) license for an

additional fee.

Input Datasets

A folder of Classified (final filtered) LAS data (typically as tiled files) is required to run the test. 

Additionally, a DPA Boundary (defined project area, as an Esri-compatible polygon shapefile) that

includes a 100-meter (or equivalent in other units) buffer, and with at least one attribute field that

contains unique values, can optionally be included to confine the testing and results to the project's

boundary.

Note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path,

Project Name, Description, Corporate Logo file name, Output PDF File Name, or as part of the name of

any input shapefile.

Classified (also referred to as tiled or delivery) Data Preparation

LAS data must be spatially indexed before it can be tested with the Voronoi Density Reporting tool, just
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as it must be before it can be displayed and utilized in other MARS® functions.  If any of the LAS data

pathed out in the 'Classified LAS Folder' (see Input Tab ) has not been through the 'Add Spatial Index'

process, the following window will pop up to explain the options (see also Add Spatial Index ).  Multi-

threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-

threading.  USB 3.0 or later can be used, but may be limited in performance depending on the access

speed of the external drive.

Multi-threading

A multi-threading option may be found on the Voronoi Density Reporting tool interface.  It speeds up

processing by using a specified amount of a computer’s CPU processing power.  The multi-threading

control can be found at the lower-left corner of the interface.  By default, the text box will show the

maximum number of threads the computer has available for processing. Leave as is, or enter a lower

1539

904



MARS® v2023.1           User Manual1538

© 2000-2023 Merrick & Company

number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of RAM available (not just

installed) per thread.

Settings Files

Every run of Voronoi Density Reporting in MARS® will generate an XML file containing the settings used

in the processing.  This file will be saved in the Output Folder specified on the Input Tab .  Each

unique *.xml file name will contain the date and time that the tool run was started as seen in the

example below.  For example, this particular run was started at 5:44:29 pm on January 18, 2022.

This file can be renamed as needed and loaded for future testing to cut down on data entry and ensure

consistency between Voronoi Density Reporting runs.  After opening the Voronoi Density Reporting

interface, click the 'Load Settings from File' button and navigate to an existing settings file to be used. 

Any individual parameters on either of the the interface tabs can be changed before starting the

processing.  In addition, a settings file can be created and saved for future use without actually running

the Voronoi Density Reporting tool - make all the parameter entries on the two tabs and click the 'Save

Settings to File' button when finished.  Navigate to a folder to store the file as it will not be stored in the

chosen Output Folder automatically like it is when the tool is actually run.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.10.2 Input Tab

Voronoi Density Reporting

Merrick Advanced Remote Sensing (MARS
®

) Software

The Input Tab

This tab is where all input data is pathed out and general settings are made, and includes entry fields for

the Project Name and optional Description, an optional Corporate (or organization) Logo that will appear

on each page of the final report, Output Folder, and Output PDF File Name.  The Classified LAS
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(tiled) data must be included and a Quality Level (expected/required density) must be selected, along

with a Project Name, Output Folder, and Output PDF File Name.

If a 'DPA Boundary' (Defined Project Area) shapefile is pathed out, a unique-value attribute field must be

chosen (e.g., an 'Areaname' field).  The attribute values for this shapefile is used for identifying the

results of the test in the final report.

The 'Quality Level' section is taken from the levels defined by the USGS NGP Lidar Base Specification

as a reference - by default, 'QL2 (>= 2 ppsm)' is selected.  The selection made here determines the

points per square meter (ppsm) density standard to be met (and the methodologies to be used) for the

testing done in the Voronoi Density Reporting tool.  Other densities can be entered by using the

advanced options on the Collection Tab .

Ensure that the 'Horizontal Data Units' and 'Vertical Data Units' are set to match the data being tested.  

This is critical to the correct operation and reporting of the test!  Choices in the drop-down are

Meter (default), US Survey Feet, and International Feet.

The 'Use temporary local disk space to speed up processing' option allows the user to save the results

in the specified output folder (typically a network location), but use local disk space from another

specified directory to speed up processing.  To use this option, check the 'Use temporary local disk

space to speed up processing' option - the 'Temporary Folder' browse box will become available. 

Browse to any local folder which has space available in it.  The interface will then tell the user how much

space is required and how much free space is in the folder the browse box is pointing to.  If there is

enough disk space, the QC Module process will use the local space to speed up processing.  If the user

checks the box labeled 'Use temporary local disk space to speed up processing', but does not point to a

temporary folder in the text box an error message will appear as seen below.  The 'Use temporary local
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disk space to speed up processing' option cannot be used without a temporary folder established.  

NOTE:  Most versions of Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that a sub-folder be used for this option.

The 'Existing Files' section allows for a complete overwrite of existing data in the Output Folder

('Overwrite' radio button, selected by default), or a 'Skip' option that will preserve completed test results

from a previous run and write out only a new final PDF report.  Regardless of the option used, a PDF file

of the results will be created as described in the Final Report  help topic.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.10.3 Collection Tab

Voronoi Density Reporting

Merrick Advanced Remote Sensing (MARS
®

) Software

The Collection Tab
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Options for test V-1 are located on this tab.  Make sure the box labeled 'V-1 Voronoi Density Reporting'

remains checked.

If changes to any of the test's settings are needed, check the box labeled 'Enable changes to advanced

options':

'Classes' -- by default all classes are included in the density testing, but this can be modified

by clicking the 'Select Classes' button and making the desired changes.  Regardless of the

classes selected, points that have the Withheld bit flag set will not be included in testing.

'Select Returns' -- last returns (including single returns) will be used by default, but 'First



Quality Control 1543

© 2000-2023 Merrick & Company

including single returns' and 'All returns' are also available as options.

'Include overlap bit flagged points' --  by default points with the Overlap bit flag set are

included in testing, but can be ignored by unchecking the box.  Omitting these points will

produce a more accurate result of the density that a single swath can produce, but requires

that overlap points be appropriately bit-flagged.

'Minimum Voronoi polygon area for setting to NO DATA for water bodies' --  by default,

Voronoi polygons that are five (5) square meters or larger in size (indicating areas of very low

point density) will be set to 'NO DATA' (black) rather than colorized based on the actual

density value.  This minimum area can be edited as needed, and is applied even in the

absence of a pathed-out 'Exclusion Shapefile' (see below).  'NO DATA' areas are not used to

calculate density statistics and will not impact the 'pass/fail' raster results.

'Required point density' -- the default value is 2 ppsm, but can be modified to test for any

required density.

'Modify maximum density cut-off' --  defaults to four (4) times the input ppsm (either from a

selected QL on the Input Tab  or as entered in the setting described above).  Density

values above this limit are aggregated into a single color band (white) in the 'V-1.2' raster.

'Exclusion Shapefile' --  allows a polygon shapefile to be selected that will create an exclusion

area in the dataset being tested, to avoid meaningless rasterized results in areas known to be

low (or no) density.  For example, a shapefile of water body outlines can be pathed out to

avoid having those areas tested and reported on.  The polygon areas will be set to 'NO

DATA' (appearing as black in the raster) rather than being colored as red, orange, or yellow
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cells that might indicate a collection issue.  'NO DATA' areas are not used to calculate

density statistics and will not impact the 'pass/fail' raster results.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.10.4 Final Report

Voronoi Density Reporting

Merrick Advanced Remote Sensing (MARS
®

) Software

Density Reporting

The output of this tool is written to a PDF file that contains the results of the point cloud density

analysis.  At the end of the report, a page titled 'Time Spent On Each Step' will be created to show

processing times for the sub-sections  of the test in tabular and chart formats.

The report will be named using the entry in the Output PDF File Name box on the Input Tab .  The

default name is 'Voronoi_Density' but can be changed before running the tool.  The report can be found in

the Output Folder that was chosen on the Input Tab .

Once processing is complete, the final report will open automatically if the computer has software

installed to read and display PDF files.  The following Sample Report Pages are representative of the

analysis results for the density testing.

The report contains a summary description of the measurement methodology and three output items: a
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frequency distribution chart that plots point density results and presents statistics of the density

distribution; a point density thematic raster consisting of cells that are 0.5 x NPS (nominal pulse

spacing) as derived from the input denity requirement, colorized based on the density values from the

underlying Voronoi polygons, and a 'pass/fail' raster using cells that are 100 x NPS to quickly show

areas that may need further investigation for insufficient density. 

In addition to the PDF report of the point cloud analysis, the Output Folder will contain a sub-folder

named 'V_1' where the two raster images (JPEG 2000 format) mentioned above are available for a more

detailed visual review of the analysis results.  These rasters, along with other result info, are used to

create the final report.  This sub-folder can be deleted if no longer needed after the tool has completed

and the final PDF is generated. 

Sample Report Pages:
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6.11 Raster QC

Raster QC Tool

Merrick Advanced Remote Sensing (MARS
®

) Software
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Description and Purpose

The purpose of the Raster QC tool (available at the Explorer QC and Production license levels) is to

provide an automated tool for verifying the format, structure, and contents of DEM (Digital Elevation

Model), MSHR (Maximum Surface Height Raster), and Intensity rasters.  All rasters are expected to be

in GeoTIFF format.  Any combination of the three types of rasters (stored in separate folders) can be

tested in a single session.  In addition, testing of water body flatness can be done if polygonal 3D

breaklines are included with the inputs.  See the Inputs section below for more details.

The output of this tool is a report in TXT format and one or more attributed tile-based shapefiles for each

of the input raster datasets.  Each output shapefile will be an enhanced copy of the input Tile Scheme

shapefile (described below) with attributes populated specific to the dataset it represents.  Individual tile

point shapefiles will be generated for any tile(s) where the raster contains one or more NODATA cells. 

See the Output section below for more details.

Inputs

A minimum of one of the three possible raster types must be selected to run the tool.  Each raster type

must be in a different folder (any sub-folders are ignored), and must adhere to a specific naming format

with a '.tif' extension.  For the DEMs, the file names must begin with 'DEM_'; for MSHRs, the names

must begin with 'MSHR_'; for Intensity rasters, the names must begin with 'INT_'.  For example, one

tile's rasters might be named 'DEM_111ABC.tif, 'MSHR_111ABC.tif', and 'INT_111ABC.tif'.

In addition, a Tile Scheme and a DPA (Defined Project Boundary), both in polygon shapefile format,

must be supplied.  The Tile Scheme must contain an attribute that is populated with the unique names

of the rasters.  For example, if the DEM rasters are named 'DEM_111ABC.tif', 'DEM_222ABC.tif',

'DEM_333ABC.tif', etc., there must be an attribute populated with '111ABC', '222ABC', '333ABC', etc. 



MARS® v2023.1           User Manual1550

© 2000-2023 Merrick & Company

There should be a one-to-one correlation between the Tile Scheme shapefile and the raster files in each

input dataset.  In other words, if the Tile Scheme contains 657 uniquely named tile features, there must

be 657 matching rasters for each dataset that will be tested. 

For the Optional Breaklines testing, the format must be a 3D, polygonal shapefile (Polygon Z or Polygon

ZM).

Note that the reserved XML tag characters <, >, %, &, ', " cannot be used as part of a folder path or as

part of the name of any input shapefile.

Note also that all input rasters and shapefiles (including optional breaklines) must be in the same

coordinate reference system.
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Usage

At least one type of supported raster must be supplied in the 'Input Raster Folders' section of the tool

interface.  Use the 'Browse...' buttons to the right of each raster type to navigate to and select a folder

containing the rasters to be tested.  Use the 'Browse...' buttons to the right of the 'Tile Scheme' and

'DPA Boundary' entry boxes in the 'Shapefiles' section to select those required shapefiles.  Select the

attribute field that contains the unique raster file names in the Tile Scheme shapefile using the 'DB Field

(Required)' drop-down list.  Use the 'Browse...' button to the right of the 'Shapefile for 3D breaklines for

water bodies' entry box to include water body breaklines for the optional raster flatness testing.

Minimum and Maximum elevation values for any cell are pre-populated with '-999' and '15000'

respectively, but these can be changed as needed for each project.  MARS® is unit-less, so use values

that make sense for the project area and coordinate system units.  These values will be used to flag

possible problem elevations in the final reports.

Finally, select an Output Folder for the final text file reports and shapefiles using the 'Browse...' button to

the right of the entry box.

When all needed entries have been made, click the 'Run' button to begin the processing - a progress bar

is located directly above this button.  A 'Report Completed' message will appear when the tool is

finished.

Output

In the selected Output Folder, one text file report will be generated for each of the tested datasets.  For

the DEM dataset, this final report will be named 'DEM_report.txt'.  The MSHR and Intensity reports will

be named accordingly.  Folders will also be created in the output folder for each of the raster types, and
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a NODATA sub-folder will be created under each of these.  In other words, in the main Output Folder

there will be a 'DEM' folder with a 'DEM_NODATA' sub-folder.  The DEM_NODATA sub-folder will contain

individual point shapefiles for any tiles whose associated rasters ('DEM_<tilename>.tif') have one or more

cells populated as NODATA, with a point placed at the center of each NODATA cell.  This same folder

structure will be created for the MSHR and Intensity rasters with corresponding naming.

For the DEM dataset only, an additional sub-folder named 'Non_Flat_points' will be created if a 'Shapefile

for 3D breaklines for water bodies' has been supplied.  This sub-folder will store a point shapefile for each

tile that contains one or more locations where the Z-values of the breakline vertices differ from the cell's

value covering that vertex.  Additionally, elevation corrections are automatically made to the DEM

rasters (when possible), and any corrected rasters will be stored in a new sub-folder named

'Raster_QC_tool_corrections' in the path of the original input DEM rasters.  The original rasters are not

altered.  

For the report files, the format will look similar to the following sample (from a DEM report):

Each section will list the name of the value being tested, with the next line(s) showing the actual value
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and the raster file count.  For example, in the above sample report the first section is reporting on File

Format.  The only value found is 'Valid COG' (meaning Cloud Optimized GeoTIFF) and both DEM rasters

in the input dataset have that value.  For the final section displayed in the sample, both rasters have

1000 Rows and 1000 Columns.

The reported values for DEM rasters are:  File Format, Compression Type, Pixel Type, Ground Grid Cell

Size, Rows and Columns, Compound Spatial Reference System, Horizontal Reference System EPSG,

Vertical Reference System EPSG, Horizontal Datum and EPSG, Horizontal Spatial Reference Units,

Vertical Datum and EPSG, Vertical Spatial Reference Units, NODATA Values Set/Not Set in Headers,

NODATA Values Found in Header, Suspect Values Found Below <min elev set by user>, Suspect

Values Found Above <max elev set by user>, Minimum Elevation Value for the Project, Maximum

Elevation Value for the Project, and Non-flat  Water Body Breaklines.

The reported values for MSHR rasters are:  File Format, Compression Type, Pixel Type, Ground Grid

Cell Size, Rows and Columns, Compound Spatial Reference System, Horizontal Reference System

EPSG, Vertical Reference System EPSG, Horizontal Datum and EPSG, Horizontal Spatial Reference

Units, Vertical Datum and EPSG, Vertical Spatial Reference Units, NODATA Values Set/Not Set in

Headers, NODATA Values Found in Header, Suspect Values Found Below <min elev set by user>,

Suspect Values Found Above <max elev set by user>, Minimum Elevation Value for the Project, and

Maximum Elevation Value for the Project.

The reported values for Intensity rasters are:  File Format, Compression Type, Pixel Type, Ground Grid

Cell Size, Rows and Columns, Projected Spatial Reference System and EPSG, Horizontal Datum and

EPSG, Horizontal Spatial Reference Units, NODATA Values Set/Not Set in Headers, NODATA Values

Found in Header, Minimum Intensity Value for the Project, and Maximum Intensity Value for the Project.

~~~~~~~~~~~~~~~~~~~~



MARS® v2023.1           User Manual1554

© 2000-2023 Merrick & Company

In addition to the text file reports, an enhanced version of the input Tile Scheme shapefile will be

generated for each tested dataset.  These project-wide shapefiles will also be stored in the selected

Output Folder.  For the DEM dataset, this shapefile will be named 'DEM_tile_layout.shp'.  The MSHR

and Intensity shapefiles will be named accordingly.

Each tile feature (record) in the shapefile will be attributed with the values from the report, and the

attribute fields will be in the same order as the corresponding sections of the report.

The attributes (limited to 10 character field names) for the DEM shapefile are:  <tile_name from input

shapefile>, File_Formt, Compr_Type, Pixel_Type, Grd_Cell_Sz, Rows_Cols, Compd_SRS, Proj_EPSG,

Vert_EPSG, Horz_Datum, Horz_Units, Vert_Datum, Vert_Units, NODATA_Sts, NODATA_Val,

Susp_Lo_Z, Susp_Hi_Z, Min_Elev, Max_Elev, Diff_Elev, ZDiff_Err, and NODATA_YN.  If one or more

non-flat DEM point shapefiles were generated, a lone attribute will be named ZDiff_Err.

The attributes (limited to 10 character field names) for the MSHR shapefile are:  <tile_name from input

shapefile>, File_Formt, Compr_Type, Pixel_Type, Grd_Cell_Sz, Rows_Cols, Compd_SRS, Proj_EPSG,

Vert_EPSG, Horz_Datum, Horz_Units, Vert_Datum, Vert_Units, NODATA_Sts, NODATA_Val,

Susp_Lo_Z, Susp_Hi_Z, Min_Elev, Max_Elev, Diff_Elev, ZDiff_Err, and NODATA_YN.

The attributes (limited to 10 character field names) for the Intensity shapefile are:  <tile_name from input

shapefile>, File_Formt, Compr_Type, Pixel_Type, Grd_Cell_Sz, Rows_Cols, Proj_SRS, Proj_EPSG,

Horz_Datum,  HDATM_EPSG, Horz_Units, NODATA_Sts, NODATA_Val, Min_Inten, Max_Inten, and

NODATA_YN.
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Multi-threading

A multi-threading option is available on the Raster QC tool interface.  It speeds up processing by using a

specified amount of a computer’s CPU processing power.  By default, the box will show the maximum

number of threads the computer has available for processing.  Leave as is, or enter a lower number of

threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the process.  For

best performance, there should be a minimum of eight (8) GB of RAM available (not just installed) per

thread.

Licensing

The Raster QC tool is enabled in either the Explorer QC (MARSEXQC) or Production (MARSPROD)

license versions, and it can be added to the Explorer (MARSEXPL) license for an additional fee.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.12 Color By Collection Scan Separation Analysis

Color By Collection Scan Separation Analysis

Merrick Advanced Remote Sensing (MARS
®

) Software

Color By Collection Scan Separation Analysis

Another QA/QC tool available in MARS® is the 'Color by Collection Scan Separation' option found on

the Grid Tab  in the export interface when either the 'Flightline Separation - JPEG 2000' or 'Flightline783
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Separation - Tiled GeoTIFF' export type is selected.  Images are generated based on the relative

elevation differences between LiDAR data in overlapping/sidelapping areas.  The overlap area differences

are color coded, allowing immediate detection of relative vertical accuracy problems.  The non-

overlapping areas will show Intensity  gridded data for reference purposes only.  These export types

are useful for rapidly assessing the consistency of the LiDAR dataset's height and can be useful in

boresighting.  Over hard surfaces (such as roads) the user can expect the vertical height (elevation) of

points within the same 'cell' to be very similar regardless of the LiDAR collection scan from which the

data originates.  Differences are an indicator of a potential mission anomaly (typically a GPS/IMU

problem) or a post-processing data adjustment issue.  In areas such as forests or fields, where

vegetation growth varies according to the time of year, understandable error may be seen.  The overlaid

collection scan separation coloration will have a 50% transparency set so that the output raster will still

have some feature definition visibility from the background Intensity layer.  For more information on the

use of this tool, please see the Export Grid Tab  section.

Analysis Steps

The 'Color By Collection Scan Separation' option can be a useful tool for evaluating boresighted data

and the overall quality of the project’s sensor alignment.  The following steps outline how to generate

data colored by collection scan separation, which provide the user with a useful methodology for

identifying boresighting issues within a LiDAR dataset.

i. 'Flightline Separation - JPEG 2000' export type:

This methodology is typically utilized for a quick analysis of an entire LiDAR dataset and is intended

to support QA/QC activities.

a) With the lidar data and tile layout shapefile loaded, click either the 'Export' button

887

783
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 (Single File export of the entire loaded dataset), or the 'Export Area'

button  (User-defined Box) to select the area which will be colored by

collection scan separation. (For more information on the use of these tools,

please see the Data Export  section.)  Select 'Flightline Separation - JPEG

2000' from the drop-down list of export types and click the 'OK' button.

b) When the export interface opens, click on the 'Output' tab and browse to an 'Output

Directory' to specify where the raster should be exported. The 'Use temporary

local disk space to speed up processing' option allows the exported raster to

be written to the specified 'Output Directory', but uses local disk space to

speed up processing.  A typical situation for this option is when the 'Output

Directory' is a network location.  To use this option, check the 'Use temporary

local disk space to speed up processing' box.  Browse to any local folder which

has available space - the export interface will display how much space is

required (for Single File layout raster exports) and how much free space is in

the selected folder.  If there is enough disk space, the export process will use

the local space to speed up processing.  If the 'Use temporary local disk space

to speed up processing' box is checked but a temporary folder is not specified,

an error message will appear as seen below.  NOTE:  Most versions of

Windows prohibit an application's output of files to the root directory of

drives.  It is strongly recommended that an actual folder be used for this

option. 

658
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An additional option in the lower part of the 'Output' tab allows for producing a

measurable vertical separation value (RMSDz) for the collection scan

separation by limiting the analysis to areas of single returns.  See the Flightline

Separation - JPEG 2000  export topic for more details).  

c) Select the classifications, returns, and collection scans for export on the 'Filters' tab.

At least one class, return type, and collection scan must be selected for export

to take place.  By default, all classes and collection scans are used, but only

Last Return points.  If the ‘Measurable RMSDz FSR’ option is used (see the 

Flightline Separation - JPEG 2000  topic), then Single Returns are used

instead.  Note that 'Withheld' bit-flagged points are excluded by default from

this export type.

d) The 'Multi-Threading' option is available for this export type.  It speeds up export by

using a specified amount of a computer’s CPU processing power.  By default,

the text box will show the maximum number of threads the computer has

available for processing.  Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of

RAM available (not just installed) per thread.

668
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e) There are several settings and options on the 'Grid' tab.  The user also has the

option to 'Create Z Diff TIFF file used to calculate RMSDZ' by checking the

labeled box.  This option creates an elevation TIFF grid of the resulting RMSD
Z

calculation.  Click on the 'Colors Options' button to define the elevation

increment and color representation options as seen in the screen shots below,

then click 'OK.'

Elevation increment: Specify here how many elevation units should be between
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principal colors.  To test against the USGS LiDAR specification (for example, less

than or equal to 8cm Z difference), a value of '0.08' should be entered for projects in

meters so that green raster cells would show compliance with the specification -

yellow, orange, and red would not.  Projects in feet should use a value of '0.26'.

Use Intensity Threshold: Check this box to set high and low intensity value ranges.

Pixels meeting these criteria will be rendered in magenta and blue, respectively, and

will be displayed on top of collection scan separation rendered pixels.

Stretch Intensity: Uncheck to disable intensity stretching for the background image

of the raster. 

Display cutoff value: The user has the option of entering a unit value in this text box

which would be considered out of the realm of possibility.  For example, in one

collection scan a car may have been present from which LiDAR returns were

collected.  In the next collection scan the car is absent, and LiDAR points were

collected from the road which was beneath the car.  Because the two collection

scans collected slightly different data, they will vary vertically in this area.  The

'Display cutoff value' text box will tell the software to ignore data outside this value

range.  In this way entering a value of '1.0' meters, for example, the vertical

discrepancy between a car versus no car will be ignored.  A good starting point for

this value is 10 times the ‘Elevation increment’.

Transparency (0-100): The user can set the transparency of the collection scan

separation coloration over the output raster.  The default value is set to 50. As stated

in the interface itself, a value of 0 would show no intensity image and only show the

collection scan separation coloration.  A value of 100 would show the intensity image

only and show no collection scan separation coloration.

By default, a TIN will be created from which the final raster is made.  As noted on the
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interface, this method is the most accurate but also the slowest.  Using the Grid option

can save time but may produce false excess-separation values depending on the area's

terrain.

When all settings have been made on all tabs, click on the 'Export' button to export the

data by collection scan separation.  

Example: The Color by Collection Scan Separation grid type has been used on the data

below which is shown as a JPEG 2000 raster image.  The collection scan overlap is

represented by the colored sections of data.  There is a cross scan included in this

example which runs East-West rather than the North-South pattern of the main

collection scans.  The areas between overlaps are shown in intensity-only (gray-scale)

rendering.  

Example: As defined by the user in the 'Collection Scan Separation Colors Options'
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window, the colors in the example below represent varying amounts of elevation (Z)

difference.  Green represents areas with the least amount of Z difference between the

collection scans, whereas red areas indicate the largest amounts of Z difference. 

These red (and even orange) areas are indicators of possible problems with the GPS,

IMU, or post-processing data adjustment.  In this example, the Color by Collection Scan

Separation tool has colored a lake red.  For this particular project, the East-West cross

scan was flown a month after the other collection scans and the red coloration is

explained by the water level of the lake being different for each flight date.  On the other

hand, the road by the lake should be at the same elevation in both collection scans. 

The road is green, indicating that the cross scan and overlapping North-South collection

scan are properly boresighted. 

There will be one raster file exported to the specified output folder unless the 'Create Z

Diff TIFF file used to calculate RMSDZ' option was checked for export, in which case

an elevation TIFF grid and a TXT file (with numeric results) will also be saved:

1.) A JPEG 2000 raster image, or *.jp2, which will allow the user to
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access the collection scan separation results as a raster image.  The

user must remember that this thematic rendering represents values of

separation between two collection scans and is not representative of

distance values.  An example of a JPEG 2000 raster image may be

seen above.

2.) An Elevation TIFF Grid, or *.tif, file which will contain the EXACT

values of separation for each colored cell in the collection scan

separation export (JPEG 2000, above).  This file is only saved if the

user has checked the 'Create Z Diff TIFF file used to calculate

RMSDZ' option on the 'Grid' export tab.

3.) A *.txt (or text) file, which will contain the numerical results of the

collection scan separation export including the calculated RMSDZ

value.  Below is a screen shot of a sample .txt file. This file is only

created if the user has checked the 'Create Z Diff TIFF file used to

calculate RMSDZ' option on the 'Grid' export tab.  This TXT file is

always created and saved when the 'Measurable RMSDz FSR' option

(on the "Export Type' tab) is used (see the Flightline Separation - JPEG

2000  topic).

The resulting JPEG 2000 raster file can be automatically loaded in MARS® when the

export is complete if the box for that option has been checked on the Options  tab.

ii. 'Flightline Separation - Tiled GeoTIFF' export type:

As the name of the export implies, this methodology is typically utilized for a tile-by-tile analysis in

support of QA/QC activities.

668
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a) With the lidar data and tile layout shapefile loaded, click the 'Export' button 

to see the drop-down list of export types.  Select 'Flightline Separation - Tiled

GeoTIFF' from the drop-down list of export types and click the 'OK' button.

b) When the export interface opens, click on the 'Output' tab and browse to an 'Output

Directory' to specify where the tiled raster(s) should be exported. The 'Use

temporary local disk space to speed up processing' option allows the exported

raster(s) to be written to the specified 'Output Directory', but uses local disk

space to speed up processing.  A typical situation for this option is when the

'Output Directory' is a network location.  To use this option, check the 'Use

temporary local disk space to speed up processing' box.  Browse to any local

folder which has available space - the export interface will display how much

space is required and how much free space is in the selected folder.  If there is

enough disk space, the export process will use the local space to speed up

processing.  If the 'Use temporary local disk space to speed up processing' box

is checked but a temporary folder is not specified, an error message will appear

as seen below.  NOTE:  Most versions of Windows prohibit an application's

output of files to the root directory of drives.  It is strongly recommended

that an actual folder be used for this option. 
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c) Select the classifications, returns, and collection scans for export on the 'Filters' tab.

At least one class, return type, and collection scan must be selected for export

to take place.  By default, all classes and collection scans are used, but only

Last Return points.  Note that 'Withheld' bit-flagged points are excluded by

default from this export type.

d) The 'Multi-Threading' option is available for this export type.  It speeds up export by

using a specified amount of a computer’s CPU processing power.  By default,

the text box will show the maximum number of threads the computer has

available for processing.  Leave as is, or enter a lower number of threads to be

used.  If ‘1’ is entered in the text box, it is equivalent to single-threading the

process.  For best performance, there should be a minimum of eight (8) GB of

RAM available (not just installed) per thread.

e) There are several settings and options on the 'Grid' tab.  Click on the 'Colors

Options' button to define the elevation increment and color representation

options as seen in the screen shots below, then click 'OK.'
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Elevation increment: Specify here how many elevation units should be between

principal colors.  To test against the USGS LiDAR specification (for example, less

than or equal to 8cm Z difference), a value of '0.08' should be entered for projects in

meters so that green raster cells would show compliance with the specification -

yellow, orange, and red would not.  Projects in feet should use a value of '0.26'.

Use Intensity Threshold: Check this box to set high and low intensity value ranges.

Pixels meeting these criteria will be rendered in magenta and blue, respectively, and

will be displayed on top of collection scan separation rendered pixels.

Stretch Intensity: Uncheck to disable intensity stretching for the background image

of the raster. 

Display cutoff value: The user has the option of entering a unit value in this text box

which would be considered out of the realm of possibility.  For example, in one
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collection scan a car may have been present from which LiDAR returns were

collected.  In the next collection scan the car is absent, and LiDAR points were

collected from the road which was beneath the car.  Because the two collection

scans collected slightly different data, they will vary vertically in this area.  The

'Display cutoff value' text box will tell the software to ignore data outside this value

range.  In this way entering a value of '1.0' meters, for example, the vertical

discrepancy between a car versus no car will be ignored.  A good starting point for

this value is 10 times the ‘Elevation increment’.

Transparency (0-100): The user can set the transparency of the collection scan

separation coloration over the output raster.  The default value is set to 50. As stated

in the interface itself, a value of 0 would show no intensity image and only show the

collection scan separation coloration.  A value of 100 would show the intensity image

only and show no collection scan separation coloration.

By default, a Hybrid of TIN (for ground points) and Grid (for non-ground points) is used

in creating the final rasters to give the best combination of usability and speed.  TIN and

Grid can also be selected individually.  As noted on the interface, the TIN method is

generally the most accurate but also the slowest.  However, it may introduce some

undesirable raster artifacts if there are outlier points from a swath that are at a greater-

than-normal-spacing distance from the rest of the swath they belong to.  Using the Grid

option can save time but may produce false excess-separation values depending on the

area's terrain.

When all settings have been made on all tabs, click on the 'Export' button to export the

data by tiled collection scan separation.



MARS® v2023.1           User Manual1568

© 2000-2023 Merrick & Company

© 2000-2023 Merrick & Company. All Rights Reserved.

6.13 Color By Z Delta Analysis

Color By Z Delta Analysis

Merrick Advanced Remote Sensing (MARS
®

) Software

Color By Z Delta Analysis

Another QA/QC tool available in MARS® is the 'Color by Z Delta' option found in the 'Rendering

Options' section of the View Tab  (not available with Evaluation license).  This tool is a virtual

(visual only) version of the 'Color By Collection Scan Separation'  tool and will color the points in the

LiDAR data by the vertical difference in collection scans.

For more information on the use of this tool, please see the Color By Z Delta  section.

Analysis Steps

The 'Color By Z Delta' option can be a useful tool for evaluating boresighted data and the overall quality

of the project’s sensor alignment.  The following steps outline how to generate data colored by Z-Delta

(∆), which provide the user with a useful methodology for identifying boresighting issues within a LiDAR

dataset.  This methodology is typically utilized for a quick analysis of a small area of LiDAR data and is

intended to support QA/QC activities.

Step 1- Data Loading: Load LiDAR dataset (ex. LiDAR, imagery, tiles, check points, etc.) into MARS®.  

Step 2- Data Rendering: Zoom in to an area where there is an overlap of collection scans (use the 'Color

by Collection Scan' rendering option  ).  Look for structures that are covered by a minimum of two

192
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collection scans, which are rendered in separate colors for identification purposes.

Step 3- Z Delta Colors Options: Click the 'Color By Z Delta'   button on the View Tab  and

enter the desired Z-Delta options.  To learn more about each aspect of this interface, please visit the 

Color By Z  Delta  section of the help.  Make sure to choose a collection scan as a reference.  This

drop-down box will be automatically populated with the collection scans currently being displayed in the

LAS Map View window.  Choose 'OK' and the data currently displayed will be colored by Z-Delta.

Step 5- Visual Analysis: The user will be able to quickly determine if the swath data has been properly

boresighted and processed by visually inspecting the colors that are generated.    

Example: The data in the screen shot below has been properly boresighted.  The user has chosen a

collection scan as a reference compared to any overlapping collection scans, and an increment of

0.15 units.  The results show that most of the ground points are green - this means that the Z-Delta in

these overlap areas is less than or equal to 0.15 units.  The areas of yellow show a Z-delta between

0.15 and 0.30 units, the areas of orange show a Z-delta between 0.30 and 0.45 units, and the red

areas show a Z-delta between 0.45 and 0.60 units.  These areas of yellow, orange, and red should be

QC'ed carefully to make sure that the larger Z differences are explainable.

192
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If the 'Increment' value was set properly, areas indicated as green when using this tool indicate excellent

to good sensor calibration, data accuracy, and boresighting.  Areas of yellow, orange, or red indicate

poor sensor calibration, substandard data accuracy, and/or possible boresighting issues.

© 2000-2023 Merrick & Company. All Rights Reserved.

6.14 Contour By Collection Scan Analysis

Contour By Collection Scan Analysis

Merrick Advanced Remote Sensing (MARS
®

) Software

Contour by Collection Scan Analysis

Another QA/QC tool available in MARS® is the ‘Contour by Collection Scan’ option within the Contour

Options dialog (not available with Evaluation license). This tool generates individual contour lines

based on the collection scans within the area-of-interest, which can help the user determine the overall
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accuracy of the collection scans in relation to each other.

This method of contour generation is an option within the ‘Contour Options’ dialog, which can be

launched by clicking the ‘Options'  button in the 'Virtual Contours' section of the Analysis

Tab .

Analysis Steps

The ‘Contour by Collection Scan’ option can be a useful tool for evaluating calibrated collection scan

data and the overall quality of the project’s sensor alignment. The following steps outline how to generate

contours by collection scan, which provide the user with a useful methodology for identifying data quality

issues within a LiDAR dataset. This methodology is typically utilized for a quick analysis of LiDAR data

488
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and is intended to support QA/QC activities.

Step 1- Data Loading: Load LiDAR dataset (ex. LiDAR, imagery, tiles, check points, etc.) into MARS®.

Step 2- Data Rendering: Change the default point rendering to ‘Color by Classification’ , which

will display all of the LiDAR data classifications. Click the ‘Classification’  button

on the  View Tab  to launch the ‘Classifications Display Settings’ dialog, which can be used to

toggle the data classifications display. Click the ‘Ground (All)’ button to render Class2, which is

typically used for ground. Zoom in to an area where there is an overlap of collection scans. Click the 

‘TIN’  button on the ribbon to switch from a point display to a TIN display to view the data more

easily.

192
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Step 3- Contouring Options: Click the ‘Options’  button on the Analysis Tab  and enter

the desired contouring options including selecting the ‘Contour by Collection Scan’ radio button. To

generate ‘ad  hoc' contours, click the ‘Area to Display’  button and drag a box over

the area of interest. This action will cause MARS® to generate a set of contours for each of the available

488
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collection scans (see the figure below), which provides the user with a method to visually examine the

resulting contours.

Step 4- Visual Analysis: The user will be able to quickly determine if the data has been properly

calibrated and post-processed by visually inspecting the proximity of the collection scan contours.    

Collection  scan  contours  that  are  very  close  in  proximity  with  each  other  indicate  excellent  sensor

calibration and data accuracy.  Collection scan  contours  that  diverge  or  have  a  large  spatial  difference

indicate poor sensor calibration and substandard data accuracy.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.15 Cross-Section/Profile Analysis

Cross-Section/Profile Analysis

Merrick Advanced Remote Sensing (MARS
®

) Software

Cross-Section/Profile Analysis

MARS® includes functionality to create and display a cross-section/profile view of a LiDAR dataset or

breakline data, which provides the user with the ability to view a cross-section or profile of the area of

interest. The profile functions of the tool are useful in evaluating data for calibration (collection scan/

mission alignment) and generating cross-section data for export.

MARS® Cross-Section/Profile & LAS Map View windows-- Rendered by 'Profile Combined' .
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To generate a new cross-section/profile, the user may click either the ‘Place Cross-Section Line’

 or ‘Place Adjustable Cross-Section Line’  buttons on the Cross-Section/Profile Tab .  

By selecting the ‘Place Cross-Section Line’ option, the user is prompted to define a starting point and

end point for the desired cut area. This option includes a default cross-section/profile cut depth of 10

units. To modify the default cut depth, click the 'Miscellaneous' button on the Options Tab , which

will display the following dialog:

MARS® Miscellaneous Options dialog

238
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Enter the desired depth for the cross-section/profile cut in the 'Default cut area depth' text box. It is

also possible to change the way the cross-section/profile window will appear in relation to the LAS Map

View window. To have the windows tile horizontally, as shown throughout this section, select the 

'Horizontally' radio button. To have the cross-section/profile window tile vertically (side by side) with the

LAS Map View window, choose the 'Vertically' radio button.

Selecting the ‘Place Adjustable Cross-Section Line’  option, the user is prompted to define a

starting point, end point, and cross-section/profile cut depth for the desired cross-section/profile.

Below, the optional MARS® Cross-Section/Profile Edit Toolbar is shown.  It is enabled by check ing the

box labeled 'Show toolbar in cross-section window' in the 'Miscellaneous Options' interface shown above.

 This toolbar has most of the frequently used editing tools so that the user can have other tabs active
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and still have easy access to the tools.

For operational instructions of the Cross-Section/Profile edit  toolbar within MARS®,  please  refer  to  the

Cross-Section/Profile Window  section.

Analysis Steps

The cross-section/profile tool can be useful for evaluating calibrated collection scan data and the overall

quality of the project’s sensor alignment. The following steps outline how the cross-section/profile tool is

used to identify data quality issues within a LiDAR dataset. This methodology is typically utilized for a

quick analysis of LiDAR data and is normally used in conjunction with the Check Point Report tool.

Step 1 - Data Loading: Load LiDAR dataset (ex. LiDAR, imagery, tiles, check points, etc.) into MARS®.

Change the default point rendering to ‘Color by Collection Scan’ , which will display the individual

collection scans. To learn more about data loading, please visit Setting up a Project .

Step 2 - Collection Scan Rendering: Zoom in to an area where there is an overlap of collection scans (an

example is shown below). Look for structures that are covered by a minimum of two collection scans,

which are rendered in separate colors for identification purposes.  

Step 3 - Cross-Section/Profile Generation: Click the ‘Place Profile Line’  button to activate the

cross-section/profile tool. Draw a cross-section/profile line across a building (see the example below).
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Step 4 - Profile Rendering: Highlight the cross-section/profile window and click the ‘Profile by

Collection Scan’  button on the Cross-Section/Profile Tab  to change the display to individual

profile lines colored by collection scan.
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Step 5- Visual Analysis: Using the ‘Measure’  tool to calculate the approximate distance between

collection scans, the user will be able to quickly determine if the data has been properly calibrated and

post-processed. Those areas with a large difference between the collection scans indicate data

accuracy issues for this portion of the dataset.  

In short, collection scans that are coincident or very close (in proximity with each other) indicate

excellent sensor calibration and data accuracy. Collection scans that diverge and have a large difference

between them suggest poor sensor calibration and are indicative of datasets with poor accuracy.

© 2000-2023 Merrick & Company. All Rights Reserved.
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6.16 Swipe Raster Over LiDAR Tool

Swipe Raster Over LiDAR Tool

Merrick Advanced Remote Sensing (MARS
®

) Software

Another QA/QC tool available in MARS® is the 'Swipe Raster Over LiDAR' tool found on the View Tab

. Both a raster image (or images) and LiDAR data must be loaded to use this tool. When checking

the alignment of these two data types, it is most advantageous to have the LiDAR data in TIN mode. 

 Swipe Raster Over LiDAR: This tool allows the user to move imagery over LiDAR data for rapid

viewing of the alignment between the two. 

The MARS® window below shows the Swipe Raster Over LiDAR tool work ing between imagery

and LiDAR.

192
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6.17 Coverage Tracking Tools

Coverage Tracking Tools

Merrick Advanced Remote Sensing (MARS
®

) Software

Coverage Tracking Tools (available with Production license only):

The Coverage Tracking function, found on the QA/QC Tab , makes a polygon shapefile noting where

the user has been in the project.  This helps to document which areas of a project have editing

coverage. For example, when going into coverage check, the user would be able to distinguish what
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areas have been checked versus not checked.  These tools work like a recorder in that the user is

capable of starting recording, leaving the tool running while performing coverage checks to record

movement, and then stopping recording.  The user can also save the recorded data for later use.

 Stop Recording: Select this button to stop the recording process.  At this time, the

user’s movements across a project will no longer be noted in the shapefile created when the

tracking path is saved.

 Start Recording: Use this tool when coverage checking, editing, or during any other

activity where it is useful for the user to track movements across the project.  Clicking the ‘Start

Recording’ button will start the process of recording the user's movements across the data.

 Save Recording to Shapefile: When the user has started and stopped a recording

tracking the movements across a project, the recording can then be saved as a polygon

shapefile.  When a tracking   shapefile is saved, a *.prj (projection definition file) is created if the

projection information is known for the source LAS data.  This shapefile will show the areas in

which the user has visited.  This can be useful in double checking that a project area has been

fully examined. .

Ex: Each rectangle represents an area of the LAS Map View window and the data that was viewed

inside that area.  With this coverage check ing tool, it is easy to see that all of the data below has

been viewed and no area was left unchecked.
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6.18 Swath shapes to overlap JP2 Tool

Swath shapes to overlap JP2

Merrick Advanced Remote Sensing (MARS
®

) Software

This tool, found on the Tools Tab  under the 'Format Conversion' drop-down, is available with Explorer

QC and Production licenses only.  It converts a folder of swath footprint shapefiles into a JPEG 2000

raster to allow faster and more complete coverage checking.  Browse to and select the folder containing

the swath footprint shapefiles (these must be polygons), and select the output file name and location. 

The 'Required ANPD' (Aggregate Nominal Pulse Density) must be input, and the 'Horizontal Units' (e.g.,
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Meters or US Survey Feet) must be selected from the drop-down list to ensure the proper cell size is

used in the raster creation.

The output raster uses the same color coding as the 'Flight Line Overlap' raster in test DC10.1 of the 

Lidar Data Checks  tool:

© 2000-2023 Merrick & Company. All Rights Reserved.

7 3-D Coordinate Transformation

7.1 GeoCalc

GeoCalc

Merrick Advanced Remote Sensing (MARS
®

) Software
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For any LAS tools (including 'GeoCalc') that allow files to be pathed out without loading them

in the Table of Contents in MARS®, an up-conversion prompt will appear when executing the

tool if the LAS files do not meet the minimum MARS® compliancy requirements.  This prompt

is described in the Project/Data Preparation Tab  topic.

The 'GeoCalc' tool allows for the transformation of LAS data to different horizontal coordinate systems,

horizontal and/or vertical datums, height models, and units.  The tool reads from both the 'built-in' list

of coordinate information and an optional custom list that can be created using GeoEdit .  It is

assumed that the user has a work ing knowledge of geodesy and coordinate systems/map projections

when using this tool.  GeoCalc can take advantage of multi-threading to make processing faster.

Click the 'GeoCalc' button  on the Coordinate Conversion Tab :

1. Add the LAS file(s) to be converted by choosing the 'Add' button and navigating to the

appropriate files.  The 'Count' feature in the lower-right corner of the 'Translate Files'

section counts the number of files listed in the 'Translate Files' text box and is for

informational purposes only.

2. The tool allows for removal of single or multiple files, or removing all files at once.  To remove

every file which has been added to the tool, choose the 'Remove All' button. To remove

multiple, but not all, files use the shift key on the keyboard to make multiple selections

and choose the 'Remove' button.  To remove a single file, highlight that file and choose

the 'Remove' button.

3. Select the input and output horizontal coordinate system, datum, units and Epoch Date.  To

help find the correct coordinate system, consider using the search engine at the bottom

of the coordinate system window.  Recently used systems can be found by selecting

the ' *Recent* ' layer name in the left pane of the 'Select Coordinate System from
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Datasource' interface.  All recent folder entries can be cleared by right-clicking the '

*Recent* ' layer name in the left pane and choosing the 'Clear Recent Object History'

pop-up button.  Individual recent folder entries can be cleared by right-clicking on the

entry in the list to be removed and choosing 'Remove From Recent' in the context menu

that appears.  The Epoch Date option is not required for GeoCalc, but it is designed to

be used with certain datums - it is up to the user to understand when Epoch Dates

should be used.  If they are to be used, check the box next to 'Epoch Date' and edit the

date as appropriate (below, left).  Another option is to click the drop-down arrow at the

right of the entry box and a calendar will appear for the user to choose the correct date

(below, right).  In calendar mode, any item that turns blue when hovered over can be

clicked on to speed the selection process, or the left and right arrows bracketing the

month and year can be used to ahead/back one month at a time.

                  

4. Optional - Select the input and output vertical system, datum, and units. Vertical references

are not required but if used, both the Input and Output must be selected.  However, if

they are not used, the Z-value (height) of all output points will be set to 0.  To carry

over Z-values when no vertical change is being made, set both the 'Input Vertical

Reference' and 'Output Vertical Reference' to the same system and units.



MARS® v2023.1           User Manual1588

© 2000-2023 Merrick & Company

To help find the correct coordinate system, reference, datum, transformation, or linear

units, consider using the search engine at the bottom of each Datasource window.  If

the desired entry is listed in red, that indicates the supporting file or files needed for the

conversion are missing from the correct folder.  Right-click on the system name and

choose 'Download Missing Files' (if available) to obtain the file directly from Blue Marble

Geographics and have it automatically installed in the correct folder (requires an Internet

connection).  Once this is complete, the entry name will change to black and can then

be used.

5. Like many other MARS® tools, the GeoCalc tool is also capable of multi-threading.  The

'Multi-Threading | Number of threads to use' text box in the 'Misc Options' section

will automatically be populated with the maximum number of threads available on the

particular computer in use.  A lower number of threads can be entered as needed.  A

value of '1' is equivalent to single-thread processing.  For best performance, there should
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be a minimum of eight (8) GB of RAM available (not just installed) per thread.

6. Choose an 'Output File Folder' for the translated files to be stored in.  If no 'Output File Folder'

is selected, a prompt asking for confirmation of an overwrite will appear.  A 'No'

response will allow a new path to be chosen for the transformed data before continuing.

7. At this point, the settings can be saved to an XML file for later use if a translation is not going

to be run at this time.  Once all entries are confirmed, click the 'Save Settings to File'

button at the bottom of the interface and a browse window will appear where the path

and file name can be entered.  Click 'Save' in this window to store the settings file - if a

Horizontal and/or Vertical Transformation needs to be chosen (depending on the

translation entries that were made), the appropriate selection window(s) will appear. 

When those selections have been made, the file will be saved.  The GeoCalc interface

stays open to allow for other settings to be entered and saved, or the actual translation

can be run at this time.  Any number of settings files can be saved.  Settings files can

be loaded at a later time - even in a different MARS® session - populating all the

settings except the list of files to be translated.  To load a previously saved settings file,

click the 'Load Settings from File' button directly below the 'Save Settings to File'

button and browse to the settings file to be used.  Click 'Open' in the browsing window

to load the settings.

8. Click 'Translate'.  If needed based on the entries made in the interface, Horizontal and/or

Vertical Transformation selection windows will appear.  The translation will begin once

those selections have been made.  A settings file is saved automatically whenever a

translation is run - even if one was saved manually just before - and the file will be stored

in the 'Output File Folder' specified in step 7, above.  This file will be named by GeoCalc

as 'Settings_GeoCalc_yyyymmdd_hhmmss.xml' and can be loaded for use later in the

same way as manually saved settings files can.

9. The 'Current File' progress bar will show the user the progress of the file currently being
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translated (only visible when in single-thread mode), while the 'Overall' progress bar will

show the user the progress of the entire translation being processed.

10. Click the 'Cancel' button to stop processing at any time.

When processing is finished the following message will appear:
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Version 1.4 LAS files with the preferred PDRFs of 6 or higher will be output with projection

information stored in WKT (Well-Known Text) format in an Extended Variable Length Record

(EVLR) for each file.

© 2000-2023 Merrick & Company. All Rights Reserved.

7.2 GeoEdit

GeoEdit

Merrick Advanced Remote Sensing (MARS
®

) Software

NOTE:  It is expected that the user has a sufficient understanding of geodesy and map

projections to properly use this tool and the GeoCalc  tool.

  

The GeoEdit tool is meant to process a translation on a single point to test the coordinate conversion

and make sure the source is converting to a known target. Once it is proven that the conversion is

working properly, the GeoCalc  tool can be used to convert an entire project's LAS data.  This tool is

also used to create and edit custom coordinate system definitions.

The left side of the GeoEdit tool is where the user enters the original projection information (the 'From:'

side). The right side of the interface is where the user specifies what projection system the new data is

to be converted to (the 'To:' side). In the example farther down this page, the 'Convert ' button would

convert Colorado Central State Plane data to UTM Zone 13N. The GeoEdit tool also allows the user to

define custom coordinate systems, horizontal and vertical datums, and height models.  These are

stored in a separate file ('custom.xml') in the C:\MARS\Data\ folder which GeoCalc will then read along

with the original installed coordinate system information.  To share any custom-defined systems with

1585
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another MARS® installation, the 'custom.xml' and 'geodata_82.xvw' files must be copied to the

additional computer(s) in the C:\MARS\Data\ folder.  Be careful to not overwrite any custom files that

the other computer may already contain.

Glossary Terms to Understand:

Projection: The process of going from geographic (latitude and longitude - spherical) data to a
projected coordinate system (flat 2D surface).

Reprojection: Converting from one projection system to another.

Datum Transformation: Transforming from one datum to another. This could be a vertical or
horizontal transformation.

Horizontal: (example: NAD 83 to NAD 27)

Vertical: (example: Ellipsoidal Height to NAVD 88 Height)

Unit Transformation: Converting from one unit to another (example: U.S. Survey Feet to Meters).

Using GeoEdit:

Click the 'GeoEdit' button  on the Coordinate Conversion Tab :

1. Add the coordinate information Data Source to be used for the conversion.  The default file is

'C:\MARS\Data\geodata_82.xml.'  It includes all built-in systems plus any custom made

systems from an optional "custom.xml" file (see "Creating and saving custom coordinate

systems", below).  At this time it is not necessary to use the "Load" button.

2. Specify the conversion by entering: a.) input and output Coordinate Systems, b.) input and

output Vertical Reference (optional) and, c.) Coordinate Point Definition values.  Recently used

systems can be found by selecting the ' *Recent* ' layer name in the left pane of the 'Select

Coordinate System from Datasource' interface. All recent entries can be cleared by right-clicking
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the ' *Recent* ' layer name in the left pane and choosing the 'Clear Recent Object History' pop-

up button.

'Coordinate System' Input and Output sections:

Select Coord Sys: Choose the coordinate systems for both input and output from

the pop-up windows.

Change Datum: The datum can be (optionally) modified for input and/or output from

the pop-up windows.

Epoch Date: The Epoch Date option is not required for GeoEdit, but it is designed to

be used with certain datums - it is up to the user to understand when Epoch Dates

should be used.  If they are to be used, check the box next to 'Epoch Date' and edit

the date as appropriate (below, left).  Another option is to click the drop-down arrow

at the right of the entry box and a calendar will appear for the user to choose the

correct date (below, right).  In calendar mode, any item that turns blue when hovered

over can be clicked on to speed the selection process, or the left and right arrows

bracketing the month and year can be used to ahead/back one month at a time.

          

'Vertical Reference' Input and Output sections (optional):

Select Vertical Ref: Choose the vertical reference systems for both input and output

from the pop-up windows.



MARS® v2023.1           User Manual1594

© 2000-2023 Merrick & Company

Change Datum: The datum can be (optionally) modified for input and/or output from

the pop-up windows.

If the desired vertical system is listed in red, that indicates the grid file needed for the conversion

is missing from the correct folder.  Right-click on the system name and choose 'Download

Missing Files' to obtain the file directly from Blue Marble Geographics and install it automatically

in the correct folder.  Once this is complete, the system name will change to black and may be

used.

'Coordinate Point Definition' input and output sections (these will appear once input and

output Coordinate Systems are chosen): 

Northing: Enter the value of the Northing coordinate (Y coordinate) to be converted.

Easting: Enter the value of the Easting coordinate (X coordinate) to be converted. The

units for Northing and Easting (U.S. Survey feet in the example below) can be

changed by clicking on the 'Change Units' button.

Height: This optional field is only available if a Vertical Reference has been set. Enter

the elevation value (Z-value) to be converted. The vertical units (U.S. Survey feet in the

example below) can be changed by clicking on the 'Change Vert Units' button.

Scale Factor at Point: The scale factor at the origin. This represents the ratio of

distance on the projection (grid) to distance on the surface of the earth (ground). This
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option is only available for some coordinate systems.

Convergence: Convergence is the angle between the geographic north direction and

the grid north direction. The earth is spherical (3D) and so the geographic north

direction would differ from the 2D grid north direction at an angle called 'convergence'. 

This option is only available for some coordinate systems.

3. Click 'Convert ' and the coordinates are translated into the system in the right half of the

'Coordinate Point Definition' section.

Creating and saving custom coordinate systems:
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To create custom coordinate systems (such as local or county-based), click on the 'Edit' button at the

top of the interface.  The following window will appear, containing all definitions from both the original

installed data source ('geodata_82.xml') and any custom data source ('custom.xml').

Navigate to a coordinate system that the custom one will be based on (e.g., a county-based system

may be based on a UTM system).  Highlight the source system in the right pane and click the 'Copy

Object' button .

 

In the window that pops up, give the custom system a descriptive name on the 'Identification' tab.  The
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optional 'Remarks' section can be edited at this time, also.  Next, click on the 'Definition' tab to make

the desired changes to the system's parameters.

 Finally, click 'OK' and after the window is dismissed, the new coordinate system will appear in the

'Edit Datasource' list.  The blue text (and lack of a lock icon) indicates that it was not part of the

original list of coordinate systems.  Click 'Save' to create (or edit if already created) the custom XML

file.  The 'Edit Datasource' and 'MARS GeoEdit' windows can now be closed, and the new definition will

be available to GeoCalc .  To edit this new definition, highlight it in the 'Edit Datasource' window and

click the 'Edit Object' button .  Make the desired changed on the 'Identification' and 'Definition'

tabs, click 'OK', and then click 'Save' in the 'Edit Datasource' window. 

1585



MARS® v2023.1           User Manual1598

© 2000-2023 Merrick & Company

© 2000-2023 Merrick & Company. All Rights Reserved.

8 Tutorials

8.1 Starting MARS®

Starting MARS®

Merrick Advanced Remote Sensing (MARS
®

) Software

When starting the MARS® application, a prompt will appear if accessing a floating network license that

contains multiple features (license types). 

Network License Selection: Upon MARS® start up, the 'Network License Selection' window appears

after a few seconds to select a license for use when more than one license type is available in a

floating network configuration.  Information about each available license will include the license type,

major version number, the number of available licenses, and who the license(s) are being used by if

they are not available.  Only one license type can be chosen at a time from the list for any given client

computer.  Any additional instances of MARS® will be at that same license level.  An example of the

'Network License Selection' window prompt is shown below.
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MARS® installation includes two helpful documents called 'MARS Performance' and 'MARS QA QC'.  To

reach these documents after installing MARS®, please go to the 'MARS' program group in 'All Apps'

from the Windows 'Start' button.  The 'MARS QA QC' document offers insight into most of the QA and

QC functions the software offers and a brief description of how to use each tool.  The 'MARS

Performance' document lists and  describes the features and options which increase the speed and

performance of the software.

© 2000-2023 Merrick & Company. All Rights Reserved.

8.2 Setting Up a Project

Setting Up a Project

Merrick Advanced Remote Sensing (MARS
®

) Software

Starting with this version of MARS®, there are minimum requirements for any LAS files being loaded in

the Table of Contents, or pathed out for processing with any of the standalone tools where LAS data

does not need to be loaded first.  A 'permission to up-convert' prompt will appear if the LAS data does

not meet these minimums.  See the Project/Data Preparation Tab  topic for details.

Supported Types of Elevation Data: MARS® natively supports elevation data in the

LAS and MrSID Compressed LiDAR file formats (See the ASPRS Online Website).  All

elevation data can be loaded into MARS®, however data that is not in either of these

formats will need to be converted in MARS® by using the 'Convert ' tool located on
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the Project/Data Preparation Tab .  This tool converts various types of elevation data

file formats into LAS for the purpose of efficient viewing in MARS®.  The following list

shows the supported elevation data formats that can be converted: (Inquire to MARS®

Technical Support Information  to have extra elevation formats enabled for loading.)

ASCII (*.txt, *.csv, *.xyz, *.dat, *.grd)

Esri ASCII Grid (*.asc)

Float Grid (*.flt, *.hdr)

GeoTIFF or TIFF (*.tif, *.tif / *.tfw)

Supported Types of Imagery: MARS® provides the user with the ability to overlay and

fuse imagery with LiDAR data.  The following list shows the supported image formats: 

(Inquire to MARS® Technical Support Information  to have extra image formats

enabled for loading.)

ER Mapper (*.ecw)

TIFF (*.tif, *.tfw)

NITF (*.ntf)

JPEG (*.jpg) & JPEG 2000 (*.jp2)

ERDAS (*.img)

MrSid (*.sid)

ENVI Raster Grid (*.dat, *.hdr)

PNG (*.png)

WMS (Web Map Service)  --  requires an Internet connection

MARS® has the GDAL (Generic Data Abstraction Libraries www.

gdal.org) embedded and can support any image format

supported by GDAL.
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1. To create a MARS® project, first open the application by double-clicking on the MARS

® shortcut  on the desktop or use the Windows 'Start' button to go to All Apps

and click on  in the 'MARS' program group.  The application will

automatically open to a new, empty project.  If a new project is needed at any point

while MARS® is already open, click 'New" on the File Tab  and answer 'Yes' to the

'Do you want to save your project?' prompt.  MARS® will save the current project,

close it, and a new, empty project will open.  Only one document may be open at a

time.

2. The Table of Contents and Breaklines windows will both automatically be open in the

MARS® project with the Table of Contents  window on top.  To toggle between the

two windows, click on the appropriate tab at the top of the window.

160

64



MARS® v2023.1           User Manual1602

© 2000-2023 Merrick & Company

3. To add the included sample data to a new project, go to the Project/Data Preparation

Tab  and click on the upper-half of the 'Add LAS Files' button.  Browse to the

sample data folder C:\MARS\Sample_Data.  To load the sample .las file, choose

'MARS_Sample_LiDAR.las' and then click 'Open'.

4. To add the sample RGB imagery to the project, click on the upper half of the 'Add

Images' button (on the same tab).  Browse again to the sample data folder (C:

\MARS\Sample_Data) and open the .ecw raster file.
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   Now check that the image file has been loaded by unchecking the 'LAS' layer in the

Table of Contents .  Imagery can also be toggled on and off the same way using

the 'Rasters' layer checkbox.  The ability to check and uncheck files to be displayed

is helpful when more than one raster is loaded in the 'Rasters' layer.

With both LiDAR and image data checked on, use the 'LiDAR/Image Transparency'

 slider bar on the View Tab  to give priority to one or the other.

Left-click and drag the slider bar back and forth (or click on a location along the line) to

see how this function works.  This is helpful in checking the co-registration of datasets

or identifying features in corresponding datasets.

LiDAR priority
Image priority

64

192



MARS® v2023.1           User Manual1604

© 2000-2023 Merrick & Company

         

5. To add a tile layout shapefile to the project, click on the 'Add Tile Shapefile' button

on the Project/Data Preparation Tab .  Browse to the sample folder (C:

\MARS\Sample_Data) and select 'MARS_Sample_Project_Tiles.shp.  By adding

162
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vector (shapefile) data using with this button, the layout will be loaded under the 'Tiles'

layer in the Table of Contents.

    

6. To load a shapefile as a reference layer (but not as a tile layout) click on the 'Add

Reference Shapefiles' button.  This method of adding data is used to load any type

of shapefile - polygon, point, or line (including breaklines if needed only as a

reference).  The loaded data will appear under the 'Vectors' layer in the Table of

Contents.
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7. Check Points can be added to the project by clicking on the 'Add Check Points

Files' button.  Browse to the sample data folder (C:\MARS\Sample_Data) and add the

check points file 'MARS_Sample_Check_Pts.csv' to the project.  This file will appear

under the 'Check Points' layer in the Table of Contents.
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   Verify that the check points have been added to the project by unchecking the 'LAS'

and 'Rasters' layers in the Table of Contents.  Individual entries under a data layer can

be unchecked without affecting other entries. 

8. Now save the project by going to the File Tab  and clicking on 'Save'.  Navigate to

the desired folder, give the project a name, and click the 'Save' button.  The project

file (Tutorial_Project.mpd in this example) will be created with relative paths stored

to the entries for each layer.  The Table of Contents status (expanded or collapsed) is

also saved.

     

160
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If the user attempts to exit MARS® without saving the open project, a prompt will

appear as seen below. 

The user may then choose to save the project, close MARS® without saving, or

choose 'Cancel' and return to the project.  Now that a project has been set up and

saved, proceed to the next tutorial  (Displaying Data ) to learn about the different

ways data can be displayed.

© 2000-2023 Merrick & Company. All Rights Reserved.
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8.3 Displaying Data

Displaying Data

Merrick Advanced Remote Sensing (MARS
®

) Software

Now that a MARS® project has been set up, follow this tutorial to learn how to render and navigate

through data in different ways.  If the project file saved in the previous tutorial is not already open, go to

the File Tab  and click 'Open'.  Navigate to the folder where the project was saved, select the file,

and open it.  Make sure that the 'LAS' and 'Tiles' layers and their entries are checked on, and

uncheck the 'Rasters' and 'Check Points' layers.

Table of Contents: As seen briefly in the Setting up a Project  tutorial, the Table of Contents

allows for the addition, removal, and manipulation of datasets.  Display colors for most shapefile

entries and other vector types can be modified by double-clicking the symbol between the checkbox

and the entry name.  See the Table of Contents  section to learn more about this tool.

160
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Using the layer and entry checkboxes in the Table of Contents , the user may control the display of

data in any combination.

Start with the data being viewed in 2D View  mode by clicking the 2D button  on the View

Tab  .  Zoom in to the data by clicking on the 'Zoom In Window' button on either the Navigation

Tab  or the Quick Access Toolbar  and moving the cursor to the upper left extent of the area to

be viewed (see Zoom In/Out  for more information on these tools).  Left-click and drag to the

lower right extent of the data to be viewed and then release the mouse button.  The scroll button on

64
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the mouse also allows the user to zoom in/out, as does right-clicking the mouse and dragging

forward or backward.  Notice that as the user zooms in/out on the data, the percentage of LiDAR

points displayed changes.  This percentage can be viewed on the left side of the Status Bar .

This example shows that the user is currently zoomed in to 33% points density

displayed.

Zoom in until the percentage of points displayed equals 100%.  All points in the LiDAR dataset

(within the extent of the LAS Map View window) are now visible.  Practice zooming in and out with

both of the 'Window" tools and also the '25%' tools to see how they affect the data view and the

point density being displayed.  Then, use the 'Pan'  button to move laterally through the

data.  Now try the 'Previous View'  and 'Next View'  buttons to move between

views.

To view the data in 3D View  mode (also known as perspective view), click the 3D button 

on the View Tab .  Any displayed imagery will be temporarily turned off while in 3D mode, but will

reappear when switching back to 2D.  Navigation in 3D mode is considerably different than in 2D: 

1. Using the 'Pan' tool, click and hold the left mouse button.  Move the cursor around to

158
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see how the data pivots around the center of the view. 

2. With the 'Pan' tool still active, click and hold both mouse buttons simultaneously.

Now move the cursor and notice that the data moves more like a normal pan

without losing the particular perspective in which the data is currently being

viewed. 

3. Click and hold only the right mouse button and move the mouse forward to zoom out

and backward to zoom in.  To view a different area in 3D, first switch back to 2D

and pan or zoom to the desired extent, then click the '3D' button. 

Click the 2D button to return to the standard 2D view, and display the full extent of the data by

clicking the 'Fit to View'  button on the Navigation Tab  or Quick Access Toolbar .

Working with Tile Shapefiles: This part of the tutorial will use the tile shapefile that was loaded

and saved in the previous topic, Setting up a Project .  Before continuing, uncheck the 'LAS' layer

in the Table of Contents.

When a tile shapefile is loaded, the user can zoom to a single tile by double-clicking

within that tile.  This action can be disabled by unchecking the 'Double-click to zoom to

tile extent' box near the top of the 'Miscellaneous Options' interface found on the 

Options Tab .

The 'GIS File Properties' window will display the full path and name of the tile shapefile,

and allow the user to change the line thickness, the outline and fill colors, the font size

of the displayed label, and the labeling field (information which comes from the

232 62
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shapefile's attribute table).  The user may choose whether or not to display a label by

checking or unchecking the box next to this option.  The labeling field can be changed

in the 'GIS File Properties' window.  In the 'Table of Contents', right-click on the tile

shapefile in question and choose 'Properties'.  Under the 'DB Field for Labeling'

drop-down box, choose 'TName' to show the tile names.  The user's preference for the

'DB Field for Labeling' option will be stored by this tool until the MARS® application is

closed.  The user may also choose to color fill the shapefile.  If the user chooses to fill a

shapefile, the transparency of the fill may be adjusted using the slider bar provided.  To

force the tile shapefile to display on top of other layers, check the box next to 'Display

On Top.'

This tool is also linked to the only other tool in MARS® which allows the user to choose

the DB field for labeling: the 'Add LAS Files | From Selected Tiles' option.  This

option may be found by clicking on the bottom half of the 'Add LAS Files' button on

the Project/Data Preparation Tab .  These two tools are synced and reflect the same

choice in 'DB Field for Labeling'.  For example, if the user selects the DB labeling field

'TName' in the 'GIS File Properties' window, this choice will be reflected automatically in

the 'Add LAS Files | From Selected Tiles' option and vice versa.  To read more

concerning the 'Add LAS Files | From Selected Tiles' option, please view the Project/

Data Preparation  topic.

162
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Viewing and Editing Attributes; Zooming to Shapefile Record : To view or edit a

shapefile's attribute table, right-click on the shapefile in the table of contents and select 

'Attributes'.  The attribute table will open in a new window.  It is possible to use the

attribute table to select tiles or polygons (or points / polylines) from the shapefile by

clicking at the far left of the desired record (row).  Use the 'Shift' and/or 'Ctrl' keys on

the keyboard the select the multiple polygons/tiles.  There is a linked selection between

the polygons selected and the corresponding rows (features) in the attribute table. 

Polygons or tiles selected using the 'Pick Tiles' utility will show up as selected, or

highlighted, inside the attribute table and vice versa.  Tiles or polygons selected in the

attribute table will be highlighted in the LAS Map View window.

.   
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It is possible to edit the attribute table of a shapefile by adding new fields, changing the

values of fields, or deleting fields.  The only exception is the 'iShape' field, which cannot

be edited.  To add a new field (column) to the attribute table, click on the 'Add Field'

button at the top of the window.  The 'Add Field' window will appear and the user may

specify the structure of the new field as follows: 

Creating a New Field:

1) First, give the new field a name in the 'Field Name' text box.  The attribute

table will display up to ten (10) characters in the column heading.

2) Then define the 'Field Type' to be used in the new column. 

3) Define the 'Width' of the column.  The width defines how many characters

will be stored for the field's values.  For example, if the user chooses a Width

of 6, only that many characters will be saved when the field is populated.  If

the user exceeds the amount of allowable characters while editing in the

attribute table, a warning will appear letting the user know that the field width
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has been exceeded. 

4) If the defined field type is 'Double,' the 'Number of Decimals' text box will

be available to the user.  If the user enters more decimal places in a value than

the definition allows, the decimal places will be rounded and truncated upon

saving.

5) Click the 'Save' button at the top of the window to make permanent.

Editing a Field:

Click at the left end of a row to see the corresponding feature highlighted in the

LAS Map View window.  To edit any attribute information, double-click on the

appropriate attribute and make the necessary changes.  When finished, click on

the 'Save' button at the top left of the window to save the modified information. 

The user will receive a prompt confirming the data was saved inside the

shapefile.  This ability may be very useful when editing data to keep track of

tiles or areas which have or have not been edited, for example.
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It is also possible to view the statistics of attribute values in a shapefile.  The

user may view the statistics of a single attribute (column), for one or more tiles

(rows) or the entire table.  Highlight the records (rows) for which statistics are to

be viewed, right-click on the desired column header, and choose 'Statistics'.

The resultant pop-up will show the user the following statistics: the row count,

minimum, maximum, sum, mean (average), and median of the chosen attribute.

 To select multiple rows for statistic viewing at once, use the 'Shift' or 'Ctrl'

keys on the keyboard.  In the example below, the user is choosing to view the

statistics of the entire 'ALLPCOUNT' column.
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Lastly, it is possible to zoom to a particular record in a shapefile from within the

attribute table.  To use this function, highlight the desired row in the attribute

table by clicking to the far left.  Then right-click anywhere in that row and

choose 'Zoom to.'  The selected tile or polygon will fit to the LAS Map View

window.
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Deleting a Field:

To delete an attribute field right-click on the column heading ('temp_field' in the

example below) and choose 'Remove Field', then click 'Save' to make

permanent.  The field and all information contained in it will be deleted.  The

'iShape' field cannot be deleted.
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 Display Selection | Classification: This tool, found on the View Tab , allows

the user to set specific classifications to be displayed.  This interface works by checking or

unchecking the boxes in the 'Display' column next to the respective classes to turn on or off

their display.  A checked box means that classification will be displayed.  The tool also allows

the colors and descriptions associated with classes to be edited and, optionally, saved as

settings files for specific projects/uses.  Individual settings files can be created, saved, and

loaded (as XML files) to allow for an unlimited number of settings combinations.  Note that the

reserved XML characters <, >, %, &, ', " cannot be used in the Description field.

192
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There are two different versions of the interface - one when the LAS Map View window is active

(see above), and one when the Cross-Section/Profile window is active.  Each will affect the

display only for its corresponding window.  Changes made to the colors or descriptions for

classes in either interface will, however, carry over to the other interface the next time it is

opened.  The LAS Map View interface allows the user to choose specific classifications for
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viewing, and to change their colors and descriptions.  (A complete description and example of

the interface when the Cross-Section/Profile window is active can be found in the 'Display

Selection' section of the View Tab  topic.)  Check/uncheck the 'Display' boxes for the

classes to be viewed/hidden.  The shortcut buttons at the bottom of the interface offer quick

settings: The 'All Classifications On/Off' buttons will turn all classes on/off.  The 'Ground (All)'

button will turn on Class 2 only and will, by default, include those ground points that are bit-

flagged as Model Key-points.  Separate Bit Flag display settings for all bit flag types can be

found in the 'Bit Flag' display settings tool  below.  Additionally, the user can change

the color representing a class (double-click on a 'Color' box to change it), the 'Description'

used for a class (highlight the text and then click on it), and how that class will be displayed (as

'Point' or 'TIN') when the LAS Map View window is using the TIN Rendering Method (see below).

 For Point/TIN rendering, the individual boxes may be checked per class, or the shortcut buttons

'All Classes as Points' and 'All Classes as TINs' may be used.  Note that the interface Class/

Description combinations are correct for LAS v1.4, Point Data Record Format (PDRF) 6 or

higher per the ASPRS specification.  An unlimited number of settings files may be created

and saved for later use ('Save Settings to File' and 'Load Settings from File').  These files

can save the display status, class color and description, and Point/TIN status for each class.

For more details on the 'Classifications Display Settings' interface, see the 'Display

Selection | Classification' section of the View Tab  topic, or the Color by Classification

topic.

192
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The following seven rendering methods have their buttons on the View Tab  
:

 Color by Elevation : Displays LiDAR points colored by elevation.  The color ramp is relative

and, by default, changes as the user zooms in or out.  Within the current view extent, white

points are the highest elevations and magenta the lowest.  To view more information about

rendering LiDAR data by elevation, please visit the section on data viewing by Elevation .

 Color by Intensity : Displays LiDAR points colored by intensity value.  In a 16-bit scale, a

value of 0 is shown as black; a value of 65535 is shown as white.  To view more information

about rendering LiDAR data by intensity, please visit the sections on data viewing by Intensity

, Gray-scale Only  intensity, Color Extremes  intensity, or Equalizing  intensity.

192
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 Color by Classification : Displays LiDAR points colored by classification.  To view more

information about rendering LiDAR data by classification, please visit the section on data viewing by 

Classification .

845
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 Color by Return : Displays LiDAR points rendered by return value.  In a dataset with discrete

return values, like the one seen below, returns are colored dark blue to indicate a single return

or 1st of many returns, red to indicate the 2nd of many returns, yellow to indicate the 3rd of

many returns, and green to indicate the 4th of many returns.  To view more information about

coloring LiDAR data by return, please visit the section on data viewing by Return .

861
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 Color by Collection Scan : Displays LiDAR points rendered by collection scan.  To view

more information about coloring LiDAR data by collection scan, please visit the section on data

viewing by Collection Scan .

849
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 Color by Ground Color:  Displays the user-specified ground class(es) using the RGB values

of loaded imagery, both in point and TIN display modes.  All other points are rendered by their

classification values.  This tool works in both 2D View  and 3D View  modes.  To view more

information about rendering ground-classed LiDAR data by imagery, please visit the section on

data viewing by Ground Color .
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 Color by Imagery (Fusion):  In point rendering mode, this tool colors each LiDAR point with

the RGB value of the geographically corresponding pixel of the loaded image.  In TIN mode, the

imagery is draped over the TIN for higher resolution display.  This tool is only available for use in

the LAS Map View window and will not function in the Cross-Section/Profile window.  To view

more information about rendering LiDAR data by imagery, please visit the section on data

viewing by Fusion .

852
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NOTE: The remaining rendering options are explained in the View Tab  Help Topic.

 Bit Flag: The 'Bit Flag Display Settings' interface allows for LiDAR point rendering to be

controlled by the point-level status of several bit flags: Synthetic, Model Key-point, Withheld, Overlap

(also referred to as 'Overage'), Edge of Collection Scan, Scanner Channel, and Scan Direction.  See

the 'Bit Flag' topic in the View Tab  section of the Help file for more information.

 Points: Displays LiDAR data as points (point cloud).  Viewing the data by points is the

fastest way to navigate through the data.

192
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The point cloud may also be viewed in 3D or 'perspective' view by clicking the 'Perspective'

 button.  Click the 'Orthographic'  button to return to 2D view.

 TIN: Displays LiDAR data as a TINned surface.  A TIN (Triangulated Irregular Network) is

generated on the fly and, thus, slows down data navigation.  It is recommended to switch to

point mode by choosing the 'Points'  button before trying to navigate around the project

or when viewing a large extent.

The TIN view may also be viewed in 3D or 'perspective' view by clicking the 'Perspective'
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 button.  Click the 'Orthographic'  button to return to 2D view.

3D breaklines are a surface-refining feature in MARS®.  TIN rendering will only respect 3D

breaklines (breaklines with a Z-value) - 2D breaklines will not be recognized by TIN even if they

have an elevation attribute. Breaklines added with the 'Reference Breaklines' option (covering a

previously-edited area, for example) will also be respected.  If a breakline file is loaded in MARS

® as a reference file, the file will be shown in neon green in the Table of Contents (see below).

A neon green line indicates a polyline breakline reference file; a neon green box indicates a

polygon reference file. 
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Below is an example of an area which needs to be corrected with a break line.  The side of this

building should move smoothly from the roof to the ground without any jagged edges.

This next example is the same area, but with a 3D break line loaded.  The break line has made
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the TIN respect the edge of the building and has produced a nice, smooth edge of the building

down to the ground.

© 2000-2023 Merrick & Company. All Rights Reserved. 

8.4 Cross-Sections and Profiles

Cross-Sections and Profiles

Merrick Advanced Remote Sensing (MARS
®

) Software

The cross-section/profile tools will work with both LiDAR data and breakline data.  The cross-section/

profile tools are useful in evaluating data for calibration (collection scan/mission alignment) and

obtaining measurements from elevation data.  This tool first allows the user to see a 'cross-section'

through the data.  A cross-section has more 'depth' than a profile, which is only a linear cut through

the data. Once the data has been cross-sectioned, the 'Place Cross-Section Line'  button or
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the 'Place Adjustable Cross-Section Line'  button may be used to view a cut through a TIN.

Cross-sections and profiles can also be exported.  LiDAR point display may be toggled off in the

LAS Map View without affecting the point display in the Cross-Section/Profile view.

There are two ways of cross-sectioning data.  The cross-section/profile tools are found on the Cross-

Section/Profile Tab .

 Place Cross-Section Line: The place cross-section line requires the user to select only the

length of the cut and the tool will default the cut depth to the value set in the 'Default cut area depth.'

section  of the 'Miscellaneous Options' interface on the Options Tab .  This tool requires two left

mouse clicks during use: one for the start and one for the end of the cut.

 Place Adjustable Cross-Section Line: The place adjustable cross-section line tool requires

the user to select the length and depth of the cut.  This tool requires three mouse clicks for use: one

for the start of the cut, one for the end of the cut, and one to define the depth of the cut.

Either profile tool will open a new window with the user-defined area displayed.  The default

placement of this new window will be to the right of the LAS Map View window.  The position can be

modified by going to 'Arrange Cross-Section/Profile window' section of the 'Miscellaneous Options'

interface on the Options Tab  and selecting either the 'Horizontally' or 'Vertically' radio button.

To use the cross-section/profile tools, follow these steps:

1. Click the ‘View Classification’  button on the View Tab  to display
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the ‘Classifications Display Settings’ dialog.  Turn classes on and off by checking and

unchecking them as desired, then click ‘OK’.  To view the points in the cross-section/profile

window by class, click at the top of the cross-section/profile window to ensure it is the active

window.  Then choose the 'Color by Classification'  button.  The same can be done for

the LAS Map View window by clicking at the top of the window, then selecting the 'Color by

Classification' button.

2. Zoom to any tile with the left mouse button by double-clicking anywhere inside the tile.

The display will zoom to the extents of that particular tile. 

3. Click  the  ‘Place Cross-Section Line’  button on the Cross-Section/Profile Tab

to activate the tool and open a Cross-Section/Profile window.  By default, the cross-section/

profile window will be displayed to the right of the LAS Map View window as the active

window.  To place a new cross-section line, click the left mouse button once to designate

the origin of the cut area, then click the mouse a second time in the desired end location of

the cut area. 

-OR-

4. Click the ‘Place Adjustable Cross-Section Line'  button on the Cross-Section/

Profile Tab  to activate the tool and open a Cross-Section/Profile window.  By default, the

Cross-Section/Profile window will be displayed to the right of the LAS Map View window as

the active window.  To place a new cross-section/profile line with a user-defined cut depth,

click the left mouse button once to designate the origin of the desired cut area, then click the

mouse a second time in the desired end location of the cut area.  Finally, move the mouse to

expand or contract the depth of the cut area, and click the left mouse button a third time to

238
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set that depth.

After either type of cross-section/profile has been created, it can be moved by dragging it in

the LAS Map View window, by using the arrow keys on the keyboard, by using the mouse

scroll wheel, or by clicking the 'Move Cut Ahead/Back' buttons.

5. Note that as the cursor is moved in the Cross-Section/Profile window, a white 'X' symbol

will move in sync within the cross-section/profile cut area box in the LAS Map View window.

This aids the user in determining what areas of the data are being observed at any given

time.  This tool may be disabled by going to the 'Miscellaneous Options' interface on the 

Options Tab .518
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6. In the Cross-Section/Profile window, MARS® defaults to the rendering method called

'Cross-Section' and has a cut depth of ten (10) units when using the 'Place Cross-Section

Line' tool.  The default Cross-Section/Profile window depth is defined in the ‘Cross-Section/

Profile Window’ section of the ‘Miscellaneous Options’ dialog.  Click the 'Miscellaneous'

button on the Options Tab  to bring up this dialog or use the keyboard accelerator 'D' on

the keyboard.  This dialog also allows the user to define the arrangement of the Cross-

Section/Profile window (horizontally or vertically), and the forward\backward step

percentages when moving with the keyboard arrow keys or the 'Move Cut Ahead/Back'

buttons.

518
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7. Activate the Cross-Section/Profile Tab , and go through the following tools with the

created cross-section/profile.

a. To change the depth of the cut in the Cross-Section/Profile window without redefining

the area, enter a new value in the 'Current Depth' text box on the tab.  The current value

will also be displayed on the Cross-Section/Profile window tab.  Any change will take

affect immediately in both windows.  Using the shortcut key 'D' on the keyboard will

bring up the following interface where the value can also be changed:

238
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b. To modify the proportional sizes of the LiDAR points in the Cross-Section/Profile

window, click the ‘Show Point Size’  button.  This action will

cause the points closest to the user to be displayed slightly larger, while those points

at the back of the cross-section/profile cut will be displayed smaller. 

c. To combine the points in the Cross-Section/Profile view across all included

collection scans, click the ‘Profile Combined’  button.  Using this tool in

combination with the ‘Color by Classification’  rendering style allows the user

to assess which data classifications are included in the profile line. When data in the

Cross-Section/Profile window is rendered using 'Profile Combined' the 'Save Profile

Line'  option is available.  This tool allows the user to save the profile line

shown in the Cross-Section/Profile window as a 3D shapefile or a CSV file of XYZ

values.  When the output is a shapefile, it can then be loaded into MARS® as a

reference shapefile and viewed in the LAS Map View window (2D  or 3D  views). 835 836



Tutorials 1641

© 2000-2023 Merrick & Company

d. To render the LiDAR data in the Cross-Section/Profile view by collection scan, click

the ‘Profile by Collection Scan’  button on the Cross-Section/Profile Tab .

This will create one line per collection scan in the Cross-Section/Profile window, and is

very useful for determining the data’s collection scan-to-collection scan alignment. 

Typically, the user can quickly assess the data quality by comparing the profile

alignment of each collection scan.

238
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 e. Turn the profile display back to a cross-section of points by using the 'Cross

Section'  button.

 f. To exaggerate (or de-exaggerate) the scaling of the Cross-Section/Profile window

display, the user can drag the ‘Vertical Scale’  slider bar or type

in the desired scale in the text box.  Click the ‘1x’ button to return the scale to its

normal state.  This tool is normally used to evaluate the ground control (check) points

in relation to the classified LiDAR ground points.  To see more information concerning

the vertical scale slider bar, please see the Cross-Section/Profile Tab  or Cross-

Section/Profile Window  sections.

8. To rotate the cross-section/profile area shown in the Cross-Section/Profile window, click

238
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the 'Rotate Profile' button.  This tool allows the user to rotate the cut area a specified

number of degrees from its current position.  90 degrees is the default value, but any

numerical value may be entered.  Entering a negative value (i.e., -90 degrees) will cause the 

cut area to rotate in a counter-clockwise direction.  Select 'OK' to see the results in both the

LAS Map View window and the Cross-Section/Profile window.  This tool can also be invoked

by using the keyboard accelerator 'R' on the keyboard while the cross-section/profile window

is active.  Small changes in rotation can be made by scrolling the mouse wheel or using the

left and right arrows on the keyboard.

 9. To exit the Cross-Section/Profile display, click the  (close) button on the right side of

the window tab, and the LAS Map View window will maximize to fill the vacated area.

© 2000-2023 Merrick & Company. All Rights Reserved.

8.5 Viewing and Generating Contours

Viewing and Generating Contours

Merrick Advanced Remote Sensing (MARS
®

) Software
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The virtual contour tools are found on the Analysis Tab . In this tutorial the user will learn how to

display contours and export them to shapefiles.  Contours will respect breaklines created in a project

and breaklines loaded as reference files (if Fast TIN is unchecked in the 'Performance Options' on the 

Options Tab ).  Contours may also be created with only breaklines loaded - LAS data does not need

to be loaded. 

1. Make sure the Denver Sample Data (or other LAS data) is loaded.  On the Project/Data Preparation

Tab , click the top half of the 'Add LAS Files' button, then navigate to

C:\MARS\Sample_Data\MARS_Sample_LiDAR.las and click 'Open').  Click the ‘Options’

 button on the Analysis Tab  and the following dialog will appear.  This dialog can be

used to define contours that are created from a TIN or a virtual Grid.  If the 'Grid' option is used, then

the user may further specify the grid cell size and the number of times the grid smoothing algorithm is

run.  The option to create a virtual grid inside the contour options function allows the user to create a

smooth grid file which, in turn, will create aesthetically pleasing and smooth contour lines.  The RAM-

based virtual grid also allows for quicker processing.  There are also options to specify the contour

interval, the frequency of index contours, the minimum contour length, the color in which the contours

488
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are displayed, the data classification(s) used to create contours, and whether or not contours are

generated by collection scan.  The 'Depression Coder' check box should be checked when the user

would like to uniquely symbolize depression contours.  The 'Use Maximum TIN Edge Length' option

allows the user to set a maximum TIN triangle edge length to be used in generating contours, thereby

ignoring areas where LiDAR ground data may be too sparse to create accurate contours.  Enter the

following settings into the dialog and select 'OK'. (To see more about the Contour Options settings,

please see the Analysis Tab  topic.)

         

488
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2. Open the 'Classification Display Settings'  interface on the View Tab , and

click the 'Ground (All)' button.  Notice that this turns on for display only Class 2 -- Ground (including

any ground points flagged as Model Key-points).  Click 'OK'.

192
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3. Ensure that the dataset is being viewed by classification by selecting the 'Color by Classification'

 button on the View Tab .  Now zoom into an area in the sample dataset by using the 'Zoom

In'  tool. MARS® will not show virtual contours unless the user is zoomed in far enough to

192



Tutorials 1649

© 2000-2023 Merrick & Company

show 100% of the LiDAR points, or has enabled the 'Lock to view 100%' button  on the View Tab

.  To see the density percentage, check the area of the status bar at the bottom of the LAS Map

View window immediately to the right of the scale display.

TIN the surface by clicking the  button on the View Tab.  Click the ‘Area to Display’

 button and drag a box over an area to see the contours.  The virtual contours may

be viewed in 2D View  or 3D View .  Click the ‘Options’  button again, change some

of the settings and click on 'OK'. The new settings will be automatically applied to the contour display.

192
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4. Now remove the contours by using the ‘Clear Display’  button.  Once contours are

cleared, select the 'Toggle On/Off'  button at the same view extent and notice that

contours are drawn over all visible data rather than a specified area.  By changing the contour options

again and clicking 'OK' the changes will be applied immediately to the data.

Note: It is not recommended to use the 'Toggle On/Off' tool when panning over large amounts of data

as contours are created 'on the fly,' and production of a large amount of contours may slow down

navigation.  The software will attempt to calculate contours for all data in the extent at any time when

the 'Toggle On/Off' tool is enabled.  It is much faster to pan to the chosen area with the contours

turned off, and then re-create the contours when the pan and/or zoom operation is complete.

5. Click the ‘Options’  button and select the 'Contour by Collection Scan' check box,
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then click 'OK' (this option is not available with an Evaluation license).

The LAS Map View will update automatically to display the contours color-coded by collection scan.  In

this example there are four overlapping collection scans: yellow, purple, green, and magenta.

Note: This must be performed over an area with overlapping collection scans (as in the example below)

for the difference in contouring to be visible.
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The contours can be more easily seen if the LiDAR data is unchecked in the Table of Contents.
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6. Contours can also be exported as polyline shapefiles.  Change the contour options settings as

described above until the desired combination is found.  These settings should be used in Step 10,

below. Select the 'Export Area'  tool on the Export/Extract Tab  and drag a box over the

area to be exported.  From the drop-down list that appears, select 'Contours - Shapefile' and click 'OK'.

The following Export dialog will appear.  Browse to or type in the directory where the file is to be

exported in the 'Output Directory' box.

460
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7. Next select the 'Layout' tab, and give the contour shapefile a name - this is done in the 'File Name'

section.  The default name is 'ExportArea' but can be modified.  Notice that 'User-Defined Box' is the

only layout format available.  This is because the area was defined by the user.  Make sure to specify

whether existing files in the output directory should be overwritten or skipped if the file name already

exists.

8. Click on the 'Filters' tab. Click the 'Select Classes' button to change which classes will be included

in creating the contour export.  To export contours of the bare earth, click the 'Ground (All)' button and
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all classes will be turned off except for 'Class 2 -- Ground (All)'.  Click 'OK', then make sure the 'Using

classification set' option is checked to include the class(es) just specified.

The specific returns and/or collection scans to be included in the export can also be defined.  By

default, all returns and all collection scans are used.  For any other configuration, make sure the 

'Using return set' and/or 'Using collection scans' boxes are checked and click on the 'Select

Returns' and/or 'Select Collection Scans' buttons as needed to make selections.

9. Next, go to the 'Options' tab.  A buffer (in project units) can be set here if desired - this will extend

the area to be exported beyond the user-defined box.  To set a buffer, check the box next to 'Use
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Buffer' and enter the size of the buffer needed around the data.  To export contours without a buffer,

leave the box unchecked.

There is also an option to load the newly-exported data immediately after the export is completed.  To

do this, check the 'Automatically load the product file(s) into the MARS® map window upon completion'

box.

10. Finally, go the 'Contours' tab.  Make sure the 'Every 5th' option is chosen for the 'Index Contour'

setting for this example.  Also, uncheck the 'Perform cleanup' box.

By default, the contours will export as a 2D shapefile.  To export to a 3D shapefile, make sure the '3D'

radio button is checked.  Click the 'Export' button at the bottom of the interface.  The file will now be

exported to the specified output directory.  When contour shapefiles are exported, a *.prj (projection

definition file) is created if the projection information is known for the source LAS data.  Please see the 

Contours Tab  topic for more on these settings.

 

806
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11. If the option to load data upon export was not checked in step 9, add the exported contour file into

MARS® by clicking on the 'Add Reference Shapefiles' button on the Project/Data Preparation Tab

 and browsing to the shapefile to be added.  In the Table of Contents  'Vectors' layer, right-click

on the newly added contour shapefile and choose 'Properties'.  Make the shapefile lines thicker or

change their color to make the contours more visible.  Contours can be labeled for elevation by

checking the 'Display Label' box, choosing 'ELV' from the 'DB Field for Labeling' drop-down box,

and choosing a 'Font Size.'  labeling will be in the same color as the contour lines.  Click 'OK' to apply

these properties.  Make sure the 'Vectors' layer and entry boxes are checked on in the 'Table of

162 64
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Contents' so that the new shapefile can be seen.

Using 3D Breakline Shapefiles to generate Contours

It is also possible to create contours (virtual or exported) using breaklines - both 3D and 2D breaklines

may be used.  The use of breakline shapefiles to create contour lines can result in quicker production

of more precise and aesthetically pleasing contour lines.

The example below shows only model key-points in an area where contours are to be created around a

river.  There is no break line shapefile loaded.

In the example below, contours have been created using the parameters for the above screen shot.  The
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contours lines are cutting back and forth through the water.

In this example, the same area is used to create contours, but a break line shapefile has also been

loaded and can be seen in orange.
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The result is contours that 'respect' the break lines and do not enter the water.
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© 2000-2023 Merrick & Company. All Rights Reserved.

8.6 Manually Editing LiDAR Data

Manually Editing LiDAR Data

Merrick Advanced Remote Sensing (MARS
®

) Software

The hand filter (or manual editing) step is used to clean up any of the mis-classified features left by

automatic filtering.  It is important that the automatic filter performs as effectively as possible in

extracting the bare earth surface or any other features to reduce the amount of hand filter work. 
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Depending on the automatic filter parameters it is typical to see errors on large buildings, mountain

tops, bridges, swamps, and canopy jumps where there is little ground penetration.  To view and modify

these anomalies MARS® has a variety of display and hand-editing tools to quickly repair the surface.

The MARS® Display & Editing tools include:

1. Reclassification tools

a) Source Classification

b) Target Classification

c) Paint Brushes

d) Edit Place Polygon

e) Edit Selected Polygons

f) Edit Line String Above (Cross-Section/Profile window only)

g) Edit Line String Below (Cross-Section/Profile window only)

h) Edit Scrape Above (Cross-Section/Profile window only)

i) Edit Scrape Below (Cross-Section/Profile window only)

2. View and Color by:

a) Elevation (color cycles)

b) Intensity

c) Classification

d) Collection Scan

e) Return

f) Fusion

g) Ground Color

3. Creating Contours on the fly

4. 2D & 3D Views

5. View by Cross-Section/Profile View
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6. Inspect Tool

7. Viewing Specific Classifications

8. View by Points/TIN

9. Coverage Tracking (available with Production license only):

a)  Start Coverage Tracking

b)  Stop Coverage Tracking

c)  Save Tracking to Shapefile

10. Undo and Redo buttons

Hand Filter Procedure:

Performance Options: Due to LAS datasets becoming increasingly larger in file size (frequently

surpassing the available RAM in a computer) as well as the possibility of lost work caused by an

unexpected shutdown of MARS prior to a save operation, the ‘Cache points into available RAM’

option (‘Options’ tab, ‘Performance’ button) has been disabled.  LAS data will be read from disk and

‘live’ edit changes (such as hand filtering) are committed to disk as soon as they occur. 

Additionally, with newer, faster hard drives such as SSD, the performance difference between disk-

based and RAM-based operations is constantly shrinking.

Read LAS points from disk: Allows practically unlimited amounts of LAS data (tested

beyond 1 Terabyte) to be loaded by reading the points directly from disk - either a local

(internal or external) disk, or a network drive location.  Changes made to the LAS files are

automatically saved.

Fast TIN: This option allows the user to improve the display performance of MARS® over small

areas of data when panning and zooming with TIN rendering enabled.  This tool will speed up

the display performance of LiDAR data only and is intended for hand filtering purposes.  
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Break lines will NOT be respected while the 'Fast TIN' option is selected and it should NOT be

used for ANY functions involving break lines.  The shortcut key combination for toggling Fast

TIN is 'Ctrl-T.' 

.

 Lock to view 100%: This tool is intended for hand editing purposes and can be found on the View

Tab .  The user should activate this tool while hand editing to be sure they are editing at 100%

density of points.  Note that in 3D View, the point density must be at (or locked to) 100% before the

paint brush tools will be available.  The percentage shown on the Status Bar  tells the user the

percentage of points which are currently being displayed.  This number will be locked at 100%

regardless of window extent when the user activates the 'Lock to view 100%' tool.

Please see the screen shot below as an example.  The screen shot below shows the user viewing

point density at 100%:

 

In 2D View, hand editing should ONLY be done when the user is viewing points at 100% density.  It is

easy for the editor to zoom in/out or lose/gain point density frequently throughout the hand editing

process by navigating around the project, and this tool allows the editor to lock the point density of the

display at 100%.  To use this tool, zoom into the data to 100% density and then click on the 'Lock to

192
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view 100%' button.  If the user attempts to zoom out to the full extent of the loaded data using the 'Fit

to View' button , or to zoom to a layer in the Table of Contents while this tool is activated,

confirmation prompts will appear as shown below.

         

If the user answers 'No' to either prompt, MARS® will return to the LAS Map View window at the current

extent and the 'Lock to view 100%' tool will remain active.  If 'Yes' is chosen, the user will be able to

zoom out with the 'Lock to view 100%' tool still active, but display performance will be affected. 

Another purpose of the above prompt is to prevent a crash.  MARS® will attempt to display whatever

extent is requested at 100% density when either prompt is answered 'Yes', but this may lead to a

program crash on less-powerful computers.

Systematic Editing:

A shapefile of the tile layout should be loaded to make sure that the editor is not 'wandering' in each

tile.  It is important to follow a systematic path across the LiDAR data when hand filtering to be
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thorough and efficient in finding and correcting errors.

Example: One good approach is scrolling and panning in MARS® using a strict series of four

movements.  The arrows describe the motion for moving around each tile. Each tile is edited in

quadrants.  Starting at the upper left  (1)  , this example shows the editor moving to the upper right  (2)

 , then moving down to the lower right  (3)  , and finally moving left to the lower left  (4) .  Each color in

the screen shot below denotes a separate movement over a tile to edit it.  When the tile is completely

edited, the editor will move down, restarting the process in the upper left corner of the tile below  (5) .

1.) Reclassification Tools

The Edit/Filter Tab , Cross-Section/Profile Window , and (optional) Cross-Section/Profile268 146
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window toolbar are the locations for manual reclassification tools.  The purpose of each tool will

be explained in this section of the tutorial.

Edit/Filter Tab manual editing tools:

Cross-Section/Profile tab manual editing tools:

Optional Cross-Section/Profile window edit toolbar:

a) The 'From Class' tool allows the user to specify which points, when selected, will be

reclassified to a specified target classification.  The user may choose 'ALL', a pre-

defined group of classes by choosing '- Selected -', or choose any one individual

classification from the drop-down list provided.  Choosing 'ALL' or a single class by

number (for example, 1 - Unclassified) does not affect the class choices that may

have been made using the 'Edit Selected Set' button.

When clicking 'Edit Selected Set', the 'Reclass from' window that appears has

options for saving and loading user-defined sets of classes for later use.  To use

these features:  1. Pick the desired classes by checking/unchecking the boxes as

appropriate.  2. Click the 'Create Set' button and enter a set name (Macro Name)

and file name - use the browse button  to navigate to the output folder.  Click '
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Save ' after making all entries.  3. To use this set in either the current MARS®

session or a later one, click the 'Load Set' button and navigate to the saved XML file,

then click 'OK' on the 'Reclass from' window.  Click on the arrow at the right side of

the 'From Class' drop-down list and choose the set name created in step 2.  It will be

listed near the top between the '- Selected -' and '0-Created, Never Classified'

entries.  The class choices in the saved set are independent of any classes chosen

using the 'Edit Selected Set' button. 
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4.  To modify an existing XML file, click the 'Edit Selected Set' button on the Cross-

Section/Profile ribbon or the toolbar, check the boxes for all the desired classes (not

just the new ones) in the 'Reclass From' window, and click the 'Append to Set'

button.  Navigate to an existing XML and enter a new or existing class set (macro)

name - new if creating a different class set, or existing if updating a previously

created one.  Click 'Save ' to overwrite the existing XML file or 'Save As...' to create a

new XML file.  To use the newly modified set of classes follow step 3, above.
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b) The 'To Class' tool allows the user to specify which classification the selected points

will be reclassified to. The user may choose any one individual classification from the

drop-down list provided.

c) Paint Brush tools allow the user to select visible points using three different sized

brush strokes: small , medium , and large .  Points may be edited in 2D

or 3D view in the LAS Map View window, or in the Cross-Section/Profile window. 

Points are selected by clicking or dragging the cursor box over them. To make edits

in 3D the user must be either zoomed in to 100% point density or have the 'Lock to

view 100%' button toggled on - the paint brush buttons will not be available otherwise.

 Once points have been selected using a brush, they will be immediately reclassed

and saved while in 2D View, based on the settings of the 'From Class' and 'To

Class' drop-downs.  In the Cross-Section/Profile window, they can be reclassed after

selection by one of two methods: by setting the From classification and the To

classifications to the proper settings and tapping the space bar (or Enter key) once

the points are selected, or by selecting the class number from the keypad while the

points are selected.  The default setting in MARS® is to allow reclassification based

only on the first digit which limits the re-classification options to classes 0-9.  To

reclass using a two or three digit class number, please see the Options Tab 518
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section concerning the Miscellaneous Options button.

In the screen shot below, the large paint brush has selected the above-

ground points to the right of the tool.  Selected points appear smaller and

in white.

d) The Edit Digitized Polygon tool  is used to reclass visible

points within a custom shaped polygonal area that the user defines.  This tool will

only work  in the LAS Map View window in 2D View mode!  To create a polygon to use

for reclassification, click on the 'Edit Digitized Polygon' button and draw a polygon in

the LAS Map View window by left-clicking for each vertex.  Then right-click the

mouse to finish the polygon and re-class the points inside, based on the settings of

the 'From Class' and 'To Class' drop-downs.

In the example below, the user has classified a building using the Edit

Digitize Polygon tool.  These points have been classified as Class 6:

Building. 
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e)  The Edit Selected Polygons tool  is functional if the user

has a pre-existing polygon shapefile (*.shp) loaded as a Reference Shapefile, and

has selected one or more polygons using the 'Select Polygons' button.  Visible

points within any selected polygons will be reclassed, based on the settings of the

'From Class' and 'To Class' drop-downs.  This tool will only work  in the LAS Map View

window in 2D View mode!  An example use of this tool would be to reclass points at

known building locations.

f) The Edit Line String Above tool  is a user-placed edit line which will reclassify

all the visible points which fall above that line. This tool can ONLY be used in the

Cross-Section/Profile window. Once the proper points are selected, they can be

reclassed by using either the space bar (or Enter key), or by typing the number of

the desired target class into the keypad.
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In the example below, the editor has specified (using the source and

target classification drop-downs) that ALL selected points will be

reclassified to Class 5: High Vegetation points. The editor has drawn an

edit line, and all visible points above this line have been successfully

reclassed.

g) The Edit Line String Below tool  is a user-placed edit line which will reclassify

all the visible points which fall below that line. This tool can ONLY be used in the

Cross-Section/Profile window.  Once the proper points are selected, they can be

reclassed by using either the space bar (or Enter key), or by typing the number of

the desired target class into the keypad. 

In the example below, the editor has specified (using the source and

target classification drop-downs) that ALL selected points will be

reclassified to Class 2: Ground points.  The editor has drawn an edit line,

and all visible points below this line have been successfully reclassed.
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h) The Edit Scrape Above tool  is similar to the 'Edit Line String Above' tool, but

works with a different method of selecting points. This tool can ONLY be used in the

Cross-Section/Profile window. Rather than selecting points above a horizontally

drawn line, this tool appears as a vertical line that selects visible points as it is

dragged over them.  Once the proper points are selected, they can be reclassed by

using either the space bar (or Enter key), or by typing the number of the desired

target class into the keypad.

In the example below, the 'Edit Scrape Above' tool has been dragged

over a section of points and has selected everything which lies above the

start point of the tool. 
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i) The Edit Scrape Below tool  is similar to the 'Edit Line String Below' tool, but

works with a different method of selecting points.  This tool can ONLY be used in the

Cross-Section/Profile window. Rather than selecting points below a horizontally

drawn line, this tool appears as a vertical line that selects visible points as it is

dragged over them.  Once the proper points are selected, they can be reclassed by

using either the space bar (or Enter key), or by typing the number of the desired

target class into the keypad.

In the example below, the 'Edit Scrape Below' tool has been dragged over

a section of points and has selected everything which lies below the start

point of the tool. 
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2) View and Color by (buttons for these next seven methods can be found on the View Tab ):

a) Elevation (color cycles): Viewing the LiDAR data by elevation.  For more

information, please see the section on Elevation .

Elevation color cycles can also be adjusted.  If a hand editor wanted to get a better

192
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understanding of the elevation changes in an area, the color cycle per unit interval could

be changed to help show elevation changes which may interest an editor.

The amount of elevation gain between color changes controls the accuracy with which

the hand editor can see changes.  The more accuracy that is necessary, the narrower

the elevation gain between color changes should be.  A final product with a 1-foot

contour needs smaller-increment color 'cycling' than a 2-foot contour.

Sudden changes in color tell the hand editor where there may be surface anomalies. 

With larger elevation gains per color, fewer sudden color changes occur and less hand

editing will take place.  Controlling the amount of viewable surface errors by 'cycling'

colors at different rates affects the accuracy and time necessary to hand-edit a project.

To bring up the color cycle options window, press 'Z' on the keyboard, or click the

'Coloration Options | Elevation' button on the View Tab  and choose the 'Repeat'

option.

192
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Example: The colors in this image are changing once every 2 feet.  The color 'cycle' is

10 feet. The image is very 'busy' because all data classifications are on.

Example: The colors in this image are changing once every 2 feet as in the example

before.  The color 'cycle' is still 10 feet.  All of the classifications have been turned off,
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except for Class 2 - Ground (final ground surface classification).

Example: The colors have been modified to smooth the abrupt changes between

elevations.  This is controlled by the 'Number of Color Gradation' option.  In this case,

the 'Number of Color Gradations' has been changed from 1 to 10.
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Example: If the color 'cycle' elevation increment is decreased from 2 feet to 1 foot the

amount of sudden color changes that may need to be checked by the hand editor

starts to increase. 

b) Intensity: Viewing the LiDAR data by its intensity values (ranging from 0-65535).  For

more information, please see the section on Intensity .887
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c) Classification: Viewing the LiDAR data by its classification.  For more information,

please see the section on Classification .

d) Collection Scan: Viewing the LiDAR data by collection scan.  There are three

separate collection scans in this image: magenta, yellow, and blue.  For more

information, please see the section on Collection Scan  data.

845
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e) Return: Viewing the LiDAR data by return value.  The returns are colored dark blue

to indicate single return, red to indicate the 2nd of 2 returns, yellow to indicate the

3rd of 3 returns, and green to indicate the 4th of 4 returns.  For more information,

please see the Return  section.

f) Fusion: Displays the LiDAR data fused with the RGB imagery values.  This tool only

861
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works in the LAS Map View window and will not function in the Cross-Section/Profile

window.  For more information, please see the Fusion  section.

g)  Ground Color: Displays the user-specified ground class(es) using the RGB values

of loaded imagery - all other points are rendered by their classification values.  This

tool only works in the LAS Map View window and will not function in the Cross-

Section/Profile window.  For more information, please see the Ground Color

section.

852
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3) Creating Contours on the fly: Contours are generated virtually inside the LiDAR data 'on the fly',

meaning that contours are only generated within the LAS Map View window extent and not for the

project as a whole. The virtual contour buttons can be found on the Analysis Tab .  Contours can

only be created if the user is zoomed in far enough to show 100% of the LiDAR points, or has

enabled the 'Lock to view 100%' button  on the View Tab .  To see the density percentage,

check the left side of the Status Bar .

Contours help to support the placement of breaklines as well as helping an editor more accurately

reclassify data during hand filtering.  Most importantly, contours can help find 'contour jumps'. 

These jumps are typically found in places where surface anomalies are found and usually need

manual reclassification to fix an auto-filter error.  To learn more about virtual contours and the

MARS® tools associated with them, please see the previous tutorial on Viewing and Generating

Contours . 

488

192

158

1643



Tutorials 1685

© 2000-2023 Merrick & Company

Example: 2-foot contours are drawn on a 'Ground' (Class 2) TIN.  Notice the contours

'jumping' at the red arrows.  The contour jumps are caused by misclassified data.

MARS® can contour at different contour intervals and on any classifications. (Note: It is not

recommended to show contours when displaying large amounts of data, as contours are created 'on

the fly' and rendering of a large area of contours may slow down navigation.)

Example: The Contour Options interface.  Bring this up by clicking the 'Options' 

button.
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4) 2D and 3D Views: Typical manual editing is done in 2D View  in the LAS Map View window,

and/or in the Cross-Section/Profile window.  Occasionally, it is useful to look at the point data in 3D

View  to get another perspective in the particular location that is being edited.  These two

perspective buttons can be found on the View Tab . LiDAR points can be viewed in 3D from the

LAS Map View window.  Visible points may be edited while in 3D mode, and the Undo and Redo

buttons on the Edit/Filter Tab  function in 3D editing.  Most editing should be completed in 2D

mode, but if the editor is having difficulty understanding where the ground surface is, 3D mode can

be a useful tool that allows the viewer to 'fly' around the data and reclass or edit specific points.  

Note that the data must be viewed at (or locked to) 100% point density before the paint

brush tools will be available for 3D editing.  100% point density is highly recommended for

835
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editing in 2D mode - if all points are not shown the user may possibly edit data which is not visible

at a lesser density.

a) Example: What is ground and what is canopy?  From the top view (2D in the LAS

Map View window) it may be difficult to determine, but with the cross-section/profiling

tool it is easy to see that the canopy (dark  green) points in the center of the LAS

Map View window represent a bridge.

b) Example: What is ground and what is canopy?  A quick  3D rotation in the LAS Map

View window gives the editor better understanding of where the bridges are.
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5) View by Cross-Section/Profile View: The cross-section/profile window is useful for helping to

analyze the point data and reclassify it only where it is needed.  MARS® has two cross-section/

profiling tools. 

a) The 'Place Cross-Section Line' tool  is a 2-point tool where the first mouse click

defines the start of the cross-section/profile line and the second click determines the length

of the line.  This tool is set at a fixed default depth for more rapid cuts.  The length and depth

of the cross-section/profile is represented by three white lines with a perpendicular dashed

orange line showing which way the cross-section/profile view window is facing.  The user can

rotate the cut area by selecting the left or right directional arrow on the keyboard, or by rolling

the mouse wheel in either direction.  There is also a 'Rotate Profile' tool 

on the Cross-Section/Profile Tab  that allows a specific number of degrees of rotation to be238
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entered (positive or negative) with respect to the current position.  The cut area can be moved

by selecting the up (ahead) or down (back) arrow on the keyboard, or by using the 'Move Cut

Ahead/Back' buttons  on the Cross-Section/Profile tab.  More details on

navigating in the Cross-Section/Profile window are available in the Cross-Section/Profile

topic.

In the example below, the cross-section/profile window is showing a cut area depth of

10 units.  Note the density of the points in the cross-section/profile (right) window.

    

816



MARS® v2023.1           User Manual1690

© 2000-2023 Merrick & Company

b) The 'Place Adjustable Cross-Section Line' tool  is a 3-point tool where the first

mouse click defines the start of the cross-section/profile line, the second click determines

the length of the line, and the third click specifies the depth of the cut area.  The cut area is

represented with the same symbology as in the 'Place Cross-Section/Profile Line' tool.

Navigation is handled the same way as well.

In the example below, the cross-section/profile window is showing a cut area depth of

133.77 units.  Note the increased density of the points in the cross-section/profile (right)

window.
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c) Cross-Section/Profile Tab : When either of the above tools are selected, the Cross-

Section/Profile window opens and the tools become active.  The majority of tools on this tab

are specifically designed for use ONLY inside the Cross-Section/Profile window.  To learn

more about the functions of the tools on this tab, please view the Cross-Section/Profile Tab

 section of this help document.

d) The Vertical Scale Slider tool  on the Cross-Section/Profile tab allows

the user to exaggerate the vertical display (with respect to horizontal) of the points in view. 

(The similar-functioning vertical scale slider on the View Tab  can be used in the LAS Map

View window in 3D View .)  This can be used to find a more exact/refined point selection

with the various editing tools.  Slide the bar to adjust the scale or type the scale into the

scale text box above the '1x' button.  The minimum value is 0.01 and the maximum is 100. 

The vertical scale slider can be reset to the normal 1:1 (vertical to horizontal) ratio by

selecting the '1x' button.  This slider is synchronized with the vertical scale slider on the

optional Cross-Section/Profile Window  toolbar.

6.) The Inspect  tool (2D view or Cross-Section/Profile view) can be helpful when editing.  This

tool can be found on the View Tab , the Cross-Section/Profile Tab , the Analysis Tab , or the

Quick Access Toolbar .  After selecting the tool, click on a LiDAR point for which more information

is needed.  The chosen point will flash twice  and then remain highlighted in white at a larger symbol

size to identify itself.  The information provided by this tool includes: parent file path and point source

ID (PSID), X coordinate, Y coordinate, Z coordinate, timestamp, intensity value, data classification, bit
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flag status, return number, file position, user data (often AGC values), scan angle and scan angle rank

(from nadir), scan direction flag, edge of collection scan, scanner channel flag, and red/green/blue and

(optionally) infrared color values if present.  The 'Inspect' tool also works in the Cross-Section/Profile

window, on virtual contour lines, check points, and reference shapefile features including breaklines. 

When the 'Inspect' tool is enabled, hold down 'Ctrl' on the keyboard and click on any virtual contour or

shapefile feature.  A properties window will appear displaying the details of the feature selected.  It is

possible to copy information from the properties window. Note that for LiDAR data, some fields are

dependent on the data collected, the post-processing software used, and the LAS version and PDRF.  

To dismiss the 'Inspect' tool, right-click the mouse.

7.) Viewing Specific Classifications: When editing, it is sometimes helpful to view only certain

classifications and minimize the 'clutter' of points to only those needed for easier viewing. 

Classifications can be turned on and off individually.  When using the Cross-Section/Profile window,

the classifications selections in the LAS Map View window and the Cross-Section/Profile window are

independent of each other.  For example. the user can view all of the data classifications in the Cross-

Section/Profile window and only the 'Ground' (Class 2) in the LAS Map View window.  A selection

interface will allow the user to modify each view individually.

Example: Only the ground classification is displayed and TINned in the left (LAS map)

view.  In the right (cross-section/profile) window, the data is shown in point mode with

building, canopy, and  ground visible.

-
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Example: The Classifications Display Settings interface for the LAS Map View window. 

                 The Classifications Display Settings interface for the Cross-Section/Profile

window.
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8.) Viewing by Points/TIN: These tools, located on the View Tab , allow the user to switch

between viewing the data in the LAS Map View window as individual points or as a Triangulated

Irregular Network (TIN).  The TIN is hill-shaded for easy viewing.  Switching between these rendering

methods is critical in finding areas that need manual editing.  The TIN viewing mode regenerates every

192
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time the LAS Map View window is changed or points are edited/reclassed.  Some computers,

depending on the amount of RAM available, may perform slower in TIN viewing mode, so switching to

Points view before moving around in the data may help speed up panning and zooming.

Example: The data is TINned and is colored by elevation.  Using the TIN mode, the

areas with sudden color changes are apparent at the black  arrow.  These 'jumps' in the

TINned data show anomalies or errors in classification which need to be corrected

manually.

Example: The 'repairs' are made to the surface.  MARS® automatically refreshes the

LAS Map View every time data is reclassified.
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Example: This example shows the LiDAR in Point view.  Although the user cannot see

individual point errors as would be visible in TIN mode, large areas of 'no data' values

which may be due to an over-zealous auto-filter can be seen.  In this example, the top

of a small hill was mis-classified as canopy in the auto-filter process.  This will require

manual editing to fix.
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Example: The TIN view helps spot hard to find points that were mis-classified in the

auto-filter process.  The hill-shading effect in TIN mode makes the data easier to view.

In the example below it is apparent that a point (located by the yellow arrows) classified

as ground is sitting far below the rest of the ground surface.  In Point rendering mode,

this error would have been difficult to catch.
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9.) Coverage Tracking (available with Production license only): The Coverage Tracking tools (on

the QA/QC Tab ) are intended to make a polygon shapefile noting where the user has been in the

project.  This helps to document which areas of a project have been edited.  For example, when going

into coverage check, the user would be able to distinguish what areas have been checked versus not

checked.  These tools work like a recorder in that the user is capable of starting recording, leaving the

tool running while performing coverage checks to record movement, and then stopping recording.  The

user may also save the recorded data for later reference.

 

 Start Coverage Tracking: Use this tool when coverage checking,

editing, or during any other activity where it is useful for the user to track movements

across the project.  Clicking the ‘Start Recording’ button will start the process of recording

457
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the user's movements across the data.

 Stop Coverage Tracking: Select this button to stop the recording

process.  At this time, the user’s movements across a project will no longer be noted in

the shapefile created when the tracking path is saved.

 Save Tracking to Shapefile: When the user has started and stopped

a recording tracking the movements across a project, the recording can then be saved as

a polygon shapefile.  This shapefile will show the areas which the user has visited.  This

can be useful in double-checking that a project area has been fully examined.

10.) Undo and Redo Tools: If a reclassification is done in error, an undo button is available.  The

undo button can be helpful when complex and confusing areas are being hand edited.  An attempt can

be made to reclassify data and if the attempt fails, click the undo button and try the reclassification

again.

Example: The 'Undo'  button and the 'Redo'  button.

In this first example, a bit of vegetation next to a river has been incorrectly classified as

ground.
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In the next example, the misclassified ground point has been changed to vegetation. 

However, the editor has made a mistake and has accidentally classified the ground below

the vegetation as vegetation. By click ing on the 'Undo'  button, this mistake is

easily reversed and the point classifications that were changed to vegetation will go back

to their original ground value as if the edit was never made.  To reverse an 'undo' action,

click  on the 'Redo'  button and the edit that was made will reappear.  These buttons

appear on the Edit/Filter Tab , the Cross-Section/Profile Tab , and the optional

Cross-Section/Profile  toolbar.

268 238
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The final product is a high-quality 'Bare Earth Model Surface'.  Type I errors have been repaired:

bridges have been removed and canopy anomalies have been fixed.  Cliffs and road-side retaining

walls have been checked for missing points needing reclassification.
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When all the hand editing is done for a project, run a Check Point Report  as a final step to validate

the accuracy of the surface.

If hand editing has shifted the average Z error of the project as a whole, it may be necessary to shift

the LiDAR surface to fit the photo ID control.  Some projects do not need an elevation shift, others will.

Example: Using a global project shifter to shift all the LAS files in an entire project.  This sort of shift

can be done after hand editing is finished and a Check Point Report has been run to determine the

average Z (elevation) error in a project.  To use this shifting tool, go to the Coordinate Conversion Tab

 and click the 'XYZ Shift' button.  Enter the elevation, or Z, error into the 'Elevation Adjustment'

text box to correct the Z error.  ** NOTE: If multiple shifts are applied to a single project, the

1221
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effect is cumulative.  Each shift is applied to the existing XYZ offset in the header.

      

After the elevation shift (if needed) is complete, the project is ready for delivery.  Raw contours are

exported for the soft copy edit process.  New sets of LAS files are created for the client.  The client

LAS contains only the ground (class 2) and canopy (class 5) classifications.  The Check Point Report

is given to the client to validate the accuracy standards of the surface. 

© 2000-2023 Merrick & Company. All Rights Reserved.

8.7 Using Float Grids

Using Float Grids

Merrick Advanced Remote Sensing (MARS
®

) Software

There are three ways to display/use Float Grids in MARS®.  The user may 1) view a float grid (*.flt file)

colored by hillshade on the fly, 2) create a hillshade raster from a float grid (*.flt) file, or 3) export an

LAS file to a hillshade raster or image (this option allows the user to bypass creating a gridded,

elevation float grid file and still create an image or raster file showing hillshade).
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1) View a Float Grid Colored by Hillshade: In order to view a float grid colored by

hillshade, a float grid must first be loaded to MARS®.  For more instructions on loading a float

grid, please see the information below.  To see the gridded, elevation float grid colored by

hillshade, click on the 'Color by Hillshade'   button on the View Tab  once data has

been loaded.  This tool only becomes available when a gridded, elevation float grid has been

loaded into MARS®.  This tool may be used to view a float grid in 3D View . 

To load a float grid to MARS®, click the 'Add Float Grid' button on the Project/Data

Preparation Tab .  Navigate to the float grid (*.flt) to be loaded and select it. Choose

'Open'. 

    

The loaded float grid can now be seen in the table of contents.  Please visit the 'Float

Grids' layer  link for more information about using float grid files inside the table of

contents.

Once a gridded, elevation float grid (*.flt) is loaded into MARS®, the Color by Hillshade
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 tool may be applied to the data.  Click on the Color by Hillshade button, choose

the desired sun angle settings, and a hillshade will be calculated and displayed. 

Because the hillshade is being calculated and displayed 'on the fly,' display can

sometimes be slow.  The resulting display can also be viewed in 3D. Please note that

loaded LAS files will not function with the Color by Hillshade tool.  Only

gridded, elevation float grids (*.flt) will work with this tool. 

The screen shot below shows a gridded, elevation float grid colored by Hillshade.
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2) Elevation Float Grid to Hillshade: This tool can be found on the Tools Tab  as

part of the 'Format Conversion' button.  This tool allows the user to create a hillshade image or

raster from a gridded, elevation float grid (*.flt).  This tool inputs a float grid and is capable of

outputting a JPEG 2000 file, BMP file, IMG file, or float grid file.  It is important to understand

that the output file created by this tool is an image or raster.  It is meant to display quickly,

similar to the performance of a compressed .ecw file.  Because the resulting file is an image or

raster file, this type of file will only work in 2D View  and CANNOT be seen in 3D.

Output folder: Click on the '...' button and navigate to or key in an output folder

for the finished image or raster product.  There must be an output folder specified

to use this tool.  If the user does not designate an output folder, the following

prompt will appear:

 

FLT File: By clicking on the corresponding '...' button, the user may navigate to

a single input *.flt file.  This is the file that will be used to create an image or

raster.  Either the 'FLT File' specification or the 'Folder to Process specification'

must be filled to use this tool.  If the 'FLT File' is not specified and the user

attempts to click on the corresponding 'Convert' button, the following prompt will

appear:

390
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Folder to Process: By clicking on the corresponding '...' button, the user may

navigate to a folder.  Every *.flt file inside the specified folder will be converted to

an image or raster if this option is chosen.  Either the 'FLT File' specification or

the 'Folder to Process specification' must be filled to use this tool.  If the 'Folder

to Process' is not specified and the user attempts to click on the corresponding '

Convert' button, the following prompt will appear:

No Data Value:  If there is a data void in the data set (no information within the

cell), a 'No Data' value is assigned.  Cells with null values will be given a default

value of -999.00 unless otherwise specified.  Enter an integer in the text box for

the No Data Value if another value is preferred.  Note: Water does not reflect

LiDAR points, so water should be considered a No Data area.

Output File Type: The user may specify here which type of product the tool

should output.  The user may choose from outputting a JPEG 2000 file, float grid,

IMG file, or BMP file.  Click on the drop-down to display the choices. 

Result: The 'Result' text box will show the user the processing of the tool.  When
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the file has been converted, the result text box will display that the specified *.flt

file(s) were processed. 

The example below shows the 'Convert Elevation Float Grid to Hillshade' window:

After the conversion has taken place, go to the specified output directory and load

the resulting image or raster file into MARS®.  The file will be renamed with the

same name as the float grid file which was the input *.flt along with '_Hillshade'

appended to the end of the file name.  For example, the 'sample.flt' file which was

the input *.flt in the example above was output as a JPEG 2000 file and named

'sample_Hillshade.jp2'.  Load the newly converted file into MARS® to view it.
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Below is a sample of the newly created 'sample_Hillshade' JPEG 2000 file. 

Because the resulting file is an image file, panning and moving around the data is

much quicker than using the corresponding float grid with hillshade created 'on the

fly'.

3) Exporting LAS Data to Create a Float Grid or Hillshade JPEG 2000

image:  For a description of the 'Export'  or 'Export Area'  tools, please see

the Data Export  section of the help.  If the user wishes to export the entire project which is

loaded into MARS®, use the 'Export' tool.  To export a particular area of a project, please use

the 'Export Area' tool and drag a box over the desired area.  In either case the export interface

appears the same, so use the following screen shots to aid in exporting a Float Grid or Hillshade

image.

Exporting LAS data to create an elevation float grid: 

658
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1) Start by loading the LAS data to be used for the float grid creation.  For

more information on loading LAS data, please see the LAS Files  section

of the Help Topics. 

2) When data has been loaded, choose the 'Export'  or 'Export Area'

 button to see the drop-down list of export types.  'Export Area'

requires that a drag box be created first before the drop-down list appears. 

Select 'Grid - Float Grid' from the list.

3) When the export interface appears, specify an output directory.  The output

directory will be the folder to which the final float grid (*.flt) product can be

found after processing is complete.

 

71
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4) The 'Save to Local Option' on the 'Output' tab is available to improve

performance when the 'Output Directory' is a network location.  To use this

option, check the box and browse to a  'Temporary Folder' location with

sufficient free space.  The 'Temporary Folder' specified WILL NOT be the

output folder (final destination of the float grid produced), and will be cleared

when the export is complete.  NOTE:  Most versions of Windows prohibit

an application's output of files to the root directory of drives.  It is

strongly recommended that an actual folder be used for this option.

5) Under the 'Layout' tab in the Export interface, specify a file name in the

'File' text box for the float grid to be exported. 

6) If any other parameters need to be set for export, please make those entries

in the rest of the tabs located on the export interface (see Data Export ). 

7) When all the settings have been made, click the 'Export' button at the

bottom of the interface to export the file.

8) When the export is complete, the following message will appear.

9) To see the newly created elevation float grid, click the 'Add Float Grid'

658
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button on the Project/Data Preparation Tab .  Navigate to the designated

output folder and load the *.flt file.  Once loaded, the float grid will appear in

the table of contents.  To see more information concerning the use of float

grids in the table of contents, please visit the Float Grids  section of the

help file.  Float grids may be viewed in 2D View  or 3D View .

Exporting LAS data to create a Hillshade JPEG 2000 image: 

1) Start by loading the LAS data which will be needed to create an image.  For

more information on loading LAS data, please see the LAS Files  section

of the help file. 

2) When data has been loaded, choose the 'Export'  or 'Export Area'

 button to see the drop-down list of export types.  'Export Area'

requires that a drag box be created first before the drop-down list appears. 

Select 'Hillshade - JPEG 2000' from the list.

3) When the export interface appears, specify an output directory.  The output

directory will be the folder in which the final JPEG 2000 (*.jp2) product can

be found after processing is complete.
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4) The 'Save to Local Option' on the 'Output' tab is available to improve

performance when the 'Output Directory' is a network location.  To use this

option, check the box and browse to a  'Temporary Folder' location with

sufficient free space.  The 'Temporary Folder' specified WILL NOT be the

output folder (final destination of the float grid produced), and will be cleared

when the export is complete.  NOTE:  Most versions of Windows prohibit

an application's output of files to the root directory of drives.  It is

strongly recommended that an actual folder be used for this option.

5) Under the 'Layout' tab in the Export interface, specify a file name in the

'File' text box for the JPEG 2000 file to be exported. 
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6) If any other parameters need to be set for export, please make those entries

in the rest of the tabs located on the export interface (see Data Export ). 

7) When all the settings have been made, click the 'Export' button at the

bottom of the interface to export the file.

8)  When the export is complete, the following message will appear. 

9)  To see the newly created JPEG 2000 hillshade raster, click on the 'Add

Images' button on the Project/Data Preparation Tab .  Make sure the

'Files of type: JPEG 2000' is selected at the bottom of the 'Open' interface.

Navigate to the output folder designated earlier in the process and load the *.

jp2 file.  An image file (raster) such as a JPEG 2000 renders much faster

when using the pan, zoom in, or zoom out features than a float grid file. 

Once loaded, the image can be found in the table of contents.  To see more

information concerning the use of rasters, or images, in the table of contents

please visit the Raster Files  section of the help file.  This resulting image

may be viewed only in 2D View .

© 2000-2023 Merrick & Company. All Rights Reserved.
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9 Reference Information

9.1 LAS File Specifications

LAS File Specifications

Merrick Advanced Remote Sensing (MARS
®

) Software

The American Society for Photogrammetry and Remote Sensing (ASPRS) is responsible for

developing and updating the specifications to be followed when writing files in the binary LAS format. 

This helps ensure that all laser point cloud files using the LAS extension (*.las) will be readable

across the various software platforms used to display, query, and edit LiDAR data.

For more information on the current LAS specification (LAS 1.4) as well as past specifications going

back to 2003, please use this link to the ASPRS LAS File Format website.

© 2000-2023 Merrick & Company. All Rights Reserved.

9.2 Additional WMS Resources

Additional WMS Resources

Merrick Advanced Remote Sensing (MARS
®

) Software

Some additional resources for WMS imagery are listed here.  Although no guarantee is made about the

working status of these sources, these URLs were functional at the time this help file was compiled. 

This list may be revised from time to time (without prior notice) as new WMS sources are identified or

http://www.asprs.org/Committee-General/LASer-LAS-File-Format-Exchange-Activities.html


Reference Information 1717

© 2000-2023 Merrick & Company

previously existing ones are dropped by their host.

NOTE:  Merrick neither hosts nor maintains any WMS (Web Map Service) image layer sources and is

therefore not responsible for the completeness, accuracy, or frequency of updates of any WMS sources

that may be accessed from within the MARS® program.

USGS (U.S. Geological Survey) Framework WMS:  http://frameworkwfs.usgs.gov/
framework/wms/wms.cgi

© 2000-2023 Merrick & Company. All Rights Reserved.

9.3 Link to Google Earth info

Link to Google Earth

Merrick Advanced Remote Sensing (MARS
®

) Software

Google Earth and Google Earth Pro are copyright 2023 Google LLC.  All rights reserved.

© 2000-2023 Merrick & Company. All Rights Reserved.

9.4 Keyboard Accelerators

Keyboard Accelerators

Merrick Advanced Remote Sensing (MARS
®

) Software

Many functions in MARS® support keyboard shortcuts which speed manipulation and use of the

http://frameworkwfs.usgs.gov/framework/wms/wms.cgi
http://frameworkwfs.usgs.gov/framework/wms/wms.cgi
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application. The following lists contain all of the application’s keyboard accelerators:

Keyboard Accelerator for the Help File:

F1
Open the Help Topics

document for MARS®.

Common Keyboard Accelerators:

Ctrl-
N

New MARS® project (.mpd file).

Ctrl-
O

Open MARS® project (.mpd file). Does not open any other
type of file.

Ctrl-
S

Save MARS® project (.mpd file).

Q Activate 'Pan' tool.

+ Zoom in by a fixed amount (25%). Applies to both '+' on
keyboard and on number keypad. 

- Zoom out by a fixed amount (25%). Applies to both '-' on
keyboard and on number keypad. 

Esc Exit out of any open dialog box.

L Toggle 'Lock to view 100%' tool on/off.

T Toggle between viewing points and viewing a TIN surface.

X Toggle on/off LiDAR points. 

O Toggle on/off orthophotography (imagery).

C Toggle on/off contour lines.

S Toggle on/off shapefiles.

M Toggle 'Measure' tool on/off. To dismiss the 'Measure' tool and
return to 'Pan' mode, press the 'Esc' key.

I Toggle 'Inspect' tool on/off. To dismiss the 'Inspect' tool and
return to 'Pan' mode, right-click the mouse.

Ctrl-
A

Allow display of all LiDAR point classifications.

Ctrl-
K

Allow display of only the model key-points (Class 2 with MKP
bit flag set to 'On').

Ctrl-
G

Allow display of only the ground point classification (2). 

Ctrl-
E

Color points or TIN by elevation.
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Ctrl-
I

Color points or TIN by intensity.

Ctrl-
C

Color points or TIN by classification.

Ctrl-
R

Color points or TIN by return.

Ctrl-
L

Color points or TIN by collection scan.

Ctrl-
J

Color points or TIN by RGB values.

Ctrl-
F

Color points or TIN by imagery RGB values (Color by Imagery
Fusion).

Ctrl-
D

Copy the X, Y (and Z, if available) coordinate values shown at
the right side of the Status Bar to the Windows clipboard,
based on the current cursor location.

Ctrl-
T

Toggle Fast TIN on/off.

Ctrl-
Z

When using 2D drawing tools on 'Vector Creation' tab, allow
undo of last vertex or last point placed (depending on tool
being used).  Also, undo last vertex drawn when creating a
polygon with the 'Filter Digitized Polygon' tool.

Z Open the 'Elevation Repeat Colors Options' interface.

Keyboard Accelerators for Cross-Section/Profile View Manipulation (these

options are only available when the Cross-Section/Profile window is open and selected)

W Activate 'Place Adjustable Cross-
Section Line' tool.

D Set Depth of the cross-section/profile
area.

Up Arrow (
)

Move the cross-section/profile area
forward.

Down
Arrow ( )

Move the cross-section/profile area
backward.

Right Arrow
( )

Rotate the cross-section/profile area
clockwise.

Left Arrow (
)

Rotate the cross-section/profile area
counter-clockwise.

Underscore
( _ )

In the Cross-Section/Profile window,
toggle between 'Cross-Section' and
'Profile by Collection Scan' views.

Ctrl-A Allow display of all LiDAR point
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classifications.

Ctrl-K Allow display of only the model key-
points (Class 2 with MKP bit flag set to
'On').

Ctrl-G Allow display of only the ground point
classification (2). 

Ctrl-E Color points or TIN by elevation.

Ctrl-I Color points or TIN by intensity.

Ctrl-C Color points or TIN by classification.

Ctrl-R Color points or TIN by return.

Ctrl-L Color points or TIN by collection scan.

R

Activate the 'Rotate Profile' window and
allow the user to rotate the cross-
section/profile area a specified number
of degrees.

Keyboard Accelerators for Point Editing in the LAS Map View Window

0-9
Modify the currently selected points to the new classification indicated
by the number key pressed. For example, the '5' key modifies
selected points to the point classification 'High Vegetation'.

G
Activate the 'Edit Place Polygon' tool, which selects all points within
the boundary of the user's manually defined polygon.

Spac
e

Modify the currently selected points to the last target classification
used. For example, if the last classification edited had a value of 6,
pressing the space bar will modify the currently selected points to the
same target classification - 6.

U Unselect all currently selected points.

Ctrl-
H

Allow display of only classification (8).

Ctrl-
M

Allow display of only the ground point classification (2) and the ignored
ground classification (20).

Ctrl-
P

Activate small paintbrush tool for selecting points.

P Activate medium paintbrush tool for selecting points.

Shift-
P

Activate large paintbrush tool for selecting points.

E Activate 'Filter Region' tool.

N Re-use the last polygon created with the 'Filter Digitized Polygon' tool

Esc Leave the current editing mode.

Ctrl-Z Undo the last edit step.
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Ctrl-
Y

Redo an edit step.

Z Open the 'Elevation Repeat Colors Options' interface.

Ctrl- Pan up, using the extent percentage selected in Miscellaneous
Options | Panning Options.

Ctrl- Pan down, using the extent percentage selected in Miscellaneous
Options | Panning Options.

Ctrl- Pan left, using the extent percentage selected in Miscellaneous
Options | Panning Options.

Ctrl- Pan right, using the extent percentage selected in Miscellaneous
Options | Panning Options.

If the user wants to enter a number for any class (0-9, 10-99, or 100-256), go to the Options Tab

and click the 'Miscellaneous' button. In the upper-right corner of this window is the 'Editing Options'

section. Check the box labeled 'Enable two or three digit class keyboard input'. This option

allows the use of 2 or 3 digit classes when using the keyboard accelerators in editing. If LiDAR data

contains classes with 2 or 3 digits, this option can be useful during editing.  Enter the 2 or 3 digit

class, choose 'Enter' on the keyboard, and the points highlighted will be changed to the classification

entered by the user. It is also possible to enter one digit classes while the 'Enable two or three digit

class keyboard input' option is chosen.  Highlight the points to have their classification changed, press

the keyboard number representing the one digit class, and then choose 'Enter' on the keyboard. The

points will then be reclassified. When the  'Enable two or three digit class keyboard input' option is

unchecked, points selected cannot be reclassified to a 2 or 3 digit classes because as soon as one

number is entered (representing a one digit class) the points are automatically reclassified without

hitting the 'Enter' key. For example, the user can select certain LiDAR points needing to be

reclassified and enter '15' on the keyboard with the intent of reclassifying the points to class 15.

Without the 'Enable two or three digit class keyboard input' option chosen, the points selected will be

reclassified to class 1 because this was the first key typed to reclassify data. See the 'Miscellaneous

Options' window below. To view the 'Classifications Display Settings' window, click the 

 button on the View Tab .

518

192
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Keyboard Accelerators for Point Editing in the Cross-Section/Profile Window

0-9
Modify the currently selected points to the new classification indicated by the
number key pressed. For example, the '5' key modifies selected points to the point
classification 'High Vegetation'.

Space 
Modify the currently selected points to the last target classification used. For
example, if the last classification edited had a value of 6, then pressing the space
bar will modify the currently selected points to the same target classification, 6.
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U Unselect all the currently selected points.

/ Activate the 'Edit Scrape Above' tool.

? Activate the 'Edit Scrape Below' tool.

S Activate the 'Line String Above' tool, which selects all points above the user's
manually defined line string.

Shift-S Activate the 'Line String Below' tool, which selects all points below the user's
manually defined line string.

Ctrl-P Activate the small paintbrush tool for selecting points.

P Activate the medium paintbrush tool for selecting points.

Shift-P Activate the large paintbrush tool for selecting points.

E Activate 'Filter Region' tool.

Esc Leave the current editing mode.

Ctrl-Z Undo the last edit step.

Ctrl-Y Redo an edit step.

D   Open the 'Set Cut Depth' window to adjust the cut area depth of the cross-section/
profile tool.

Z   Open the 'Elevation Repeat Colors Options' interface.

R   Activate the 'Rotate Profile' window and allow the user to rotate the cross-section/
profile area a specified number of degrees.

Keyboard Accelerators for Breakline Editing in the LAS Map View Window

Esc Leave the current editing mode or dialog window.

Shift-
Mouse
Click

Holding down the shift key while compiling breaklines will cause the
breakline to snap to the user-designated point. The point to which the
breakline will be snapped will be determined by the feature drop-down
code list. Choose either: 'startendvertex', 'vertex', 'nearestpoint', or
'midpoint'.

Ctrl-
Mouse
Click

Ctrl-Click on a breakline the first time will collect that breakline's Z-
value, and Ctrl-Click a second time will transfer that collected Z-value
to a new breakline point that is currently being compiled.

A
When pressed and released during breakline collection, begins the
creation of an arc (splined curve) in the breakline. The next two left-
clicks will be the center and endpoint of the arc, respectively. 

B Toggle on/off the auto-pan mode.

V Toggle on/off the auto-pan edge markers.

Alt

Holding the 'Alt' key down while in collection mode will allow the user
to pan across the data when auto-pan is turned off. The cursor will
temporarily turn from collection tool to pan tool while the 'Alt' key is
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pressed. 

Ctrl-B Toggle display of breaklines on/off.

Ctrl-M Allow display of only the ground point classification (2) and the
ignored ground classification (20).

Ctrl-T Toggle Fast TIN mode on/off.

Ctrl-Z Undo last vertex drawn when placing a breakline.

Shift-B Quick save of breaklines without confirmation (when path/name has
previously been established).

© 2000-2023 Merrick & Company. All Rights Reserved.

9.5 Glossary of Terms

Glossary of Terms and Acronyms

Merrick Advanced Remote Sensing (MARS
®

) Software

AGL - Above Ground Level

AGPS - Airborne Global Positioning System

ANPD - Aggregate Nominal Pulse Density

ANPS - Aggregate Nominal Pulse Spacing

AOI - Area of Interest

Artifacts - Any feature, whether man-made or system-made, that unintentionally exists in a digital

elevation model.  Buildings, trees, towers, telephone poles or other elevated features

should be removed when depicting a DEM of the bare-earth terrain.

ASPRS - American Society for Photogrammetry and Remote Sensing

Bare Earth - (sometimes referred to as bald earth) Digital elevation data of the terrain, free from

vegetation, buildings, and other man-made structures.  Bare earth data may be modeled

as a DEM or a DTM.
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Boresighting - A LiDAR calibration process that corrects for attitude offsets (pitch, roll, and yaw or

heading in an aircraft setup) affecting the position of the LiDAR sensor, measurement

biases in the sensor itself, and atmospheric conditions during the mission, using a

known reference surface.

Breakline - A linear feature that describes a change in continuity of a surface.  Breaklines are

typically captured along road edges and hydrographic features to assist with the

accurate depiction of contours.

Calibration - Procedures used to identify systematic errors in hardware and software so that the

errors can be corrected in preparation for data collection activities.

Collection Scan - a file of LiDAR points output from a laser scanner.  Also known as a swath, or a

flight line if from an airborne sensor. 

Confidence level - The probability that errors are within a defined range of values.

Contour - A line connecting points of equal elevation.

Contour interval - The difference in Z-value (elevation) between adjacent contours.

Datum - Any quantity or set of quantities that may serve as a basis for calculation of other quantities.

Datum, Horizontal - A geodetic datum specifying the coordinate system to which horizontal control

points are referenced.

Datum, Vertical - A set of fundamental elevations to which other elevations are referred.

DEM (Digital Elevation Model) - An acronym used as a generic term for digital topographic data.  Also

referred to as bare-earth elevations at regularly spaced intervals.

DGN - Bentley MicroStation design file format.

DSM (Digital Surface Model) - Elevation dataset containing accurate X, Y, and Z coordinates of all the

LiDAR system returns.  A DSM contains all of the topographic, planimetric, and

vegetative information of the area.

DTED (Digital Terrain Elevation Data) - Standard elevation datasets of the National Geospatial-

intelligence Agency (NGA), similar to USGS DEMs.
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DTM (Digital Terrain Model) - Similar to a DEM but incorporates significant topographic features on the

land as well as masspoints and breaklines that are irregularly spaced to better

characterize the shape of the terrain.

Elevation - The height above a specific vertical reference.

Ellipsoid - The Earth’s ellipsoid is a biaxial ellipsoid of revolution (defined by its major axis 'a' and its

minor axis 'b') obtained by rotating an ellipse about its minor (shorter) axis.

FGDC - Federal Geographic Data Committee

FOV (Field of View) - The usable area of a LiDAR sensor's pulse pattern.

Geoid - The geoid is the imaginary surface where the oceans would seek mean sea level if allowed to

continue into all land areas so as to encircle the earth.  The geoid undulates up and

down with local variations in the mass and density of the earth.

Grid - A geographic data model that represents information as an array of equally sized square cells.

Grids are the most common structures used for modeling terrain and bathymetric

surfaces.

GSD - Ground Sample Distance (also referred to as NPS - Nominal Pulse Spacing

Horizontal accuracy - Positional accuracy of a dataset with respect to a horizontal datum.

Horizontal error - Magnitude of the displacement of a feature’s recorded horizontal position in a

dataset from its true accurate position, as measured radially and not resolved into X and

Y.

Horizontal post spacing - The smallest distance between two discrete points that can be explicitly

represented in a gridded elevation dataset.

Hydro-enforcement - The removal of elevations from the tops of selected drainage structures (bridges

and culverts) in a DEM, TIN or topographic dataset to depict the terrain under those

structures.

IMU (Inertial Measurement Unit) - Technology that computes the roll, pitch, yaw, and heading of a

moving object, for example a LiDAR sensor or an aerial camera mounted on an aircraft.
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Interpolation - The estimation of Z-values at a point with X/Y coordinates, based on the known Z-

values of surrounding points.

LiDAR (Light Detection And Ranging) - A technology that employs an airborne scanning laser range

finder to produce accurate topographic surveys and store other information about struck

targets.  Also known as ALSM (Airborne Laser Swath Mapping).

LiDAR Intensity - The strength of the returning light pulse being observed. Intensity readings can be

used to produce raster image files that have the appearance of a photographic image. 

Sometimes described as reflectance.

LiDAR Pulse Rate - The number of light pulses emitted per second in a scanning array, reported in

kilohertz (kHz).  Pulse rates for various sensors typically range from 85,000 (85 kHz) to

500,000+ (500 kHz).

LiDAR Returns - The number of signals received back at the sensor per pulse.  Some LiDAR sensors

are capable of receiving up to eight returns per pulse.  Typically, the first and last

returns are most commonly used for mapping applications.  The first return measures

the first object struck.  The last return usually represents the ground unless an

obstruction (dense tree, car, building) obscures penetration to the ground.

Mass points - Irregularly spaced points, each with an X/Y location and a Z-value, used to form a TIN.

NDEP - National Digital Elevation Program

NSSDA - National Standard for Spatial Data Accuracy

PDOP (Position Dilution of Precision) - Measure of the geometrical strength of the GPS satellite

configuration.

Point cloud - A point cloud elevation file is generally a raw data file containing three-dimensional (3D)

point samples, i.e. discrete X/Y points with elevations.

Point density - the number of LiDAR points per square horizontal unit.

Positional accuracy - The accuracy of the position of features, including horizontal and/or vertical

positions.
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Post spacing - The Z-values at regularly spaced intervals of a grid.  The post spacing is usually

specified in units of whole feet or meters.

Profile (aka cross-section) - A vertical view of a surface derived by sampling surface values along a

specified line. In USGS DEMs, profiles are the basic building blocks of an elevation grid

and are defined as one-dimensional arrays, i.e., arrays of n columns by 1 row, where n

is the length of the profile.

RTK (Real-Time Kinematic) - A process or system used in surveying in which a GPS base station re-

broadcasts signals to mobile receivers with very little accuracy loss.

Resolution - Related to the horizontal post spacing and the vertical precision.  Also defined as the

size of the smallest feature that can be represented in a surface or image.

RMSE (Root Mean Square Error) - The square root of the mean (average) of squared errors for a

sample.

Slope - The measure of change in Z-value over distance, expressed either in degrees or as a

percentage.

Surface - A 3D geographic feature represented by computer models built from uniformly or non-

uniformly spaced points with X/Y coordinates and Z-values.

TIN (Triangulated Irregular Network) - A set of adjacent, non-overlapping triangles generated from

irregularly spaced points with X, Y, and Z coordinate values.

USGS - United States Geological Survey, the federal agency responsible for establishing and

maintaining the Lidar Base Specifications used for many lidar product deliveries. 

Vertical accuracy - Measure of the positional accuracy of a dataset with respect to a specified

vertical datum.

Vertical error - The displacement of a feature’s recorded elevation in a dataset from its true or more

accurate elevation.

Voids (aka holidays) - Portions of a digital elevation dataset where no elevation data are available.

Well-defined point - A point that represents a feature for which the horizontal position is known to a
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high degree of accuracy with respect to the geodetic datum.

WKT (Well-Known Text) - A protocol for storing coordinate reference system information.

X-coordinate - The distance along the X-axis from the origin of a 2D or 3D Cartesian coordinate

system.

Y-coordinate - The distance along the Y-axis from the origin of a 2D or 3D Cartesian coordinate

system.

Z-coordinate - The distance along the Z-axis from the origin of a 3D Cartesian coordinate system.

The elevation or height above the vertical datum.

Z-values - The elevations of the 3D surface above the vertical datum at designated X/Y locations.

© 2000-2023 Merrick & Company. All Rights Reserved.
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